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1. Pregled

Konfiguracija sustava

=
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Paket s
bezi¢nim
mikrofonom
UWP-D21
UWP-D22
UWP-D26

MCX-500
Uredaj Multi
Camera Live
Producer

Adapter za
nosac za vise
sucelja
SMAD-P5

Prijemnik
bezi¢nog
mikrofona
URX-P0O3D

Adapter za
nosac

za vise sucelja

SMAD-P3D

SDXC
memorijske kartice

Komplet

adaptera XLR Svjetlo za
XLR-K2M VideozapiS ——— ——
XLR-K3M HVL-LBPC D

=

| | CFexpress Type A Cita¢ CFexpress Type A kartice /
memorijske Cita¢ SD kartice
kartice

BP-U35, BP-U6O, Punjac baterije BC-CU1

Adapter A-mount e 5
LA-EA3 BP-U60T, BP-U70, BC-U1A, BC-U2A Punja¢ za baterije
LA-EA4 BP-U90, BP-U100 (ispéruéuje ze) J
Komplet baterija
E DE ILME-FX6V/ILME-FX6VK
—or— ﬁ — ILME-FX6T/ILME-FX6TK
Objektiv izmjeni¢nu struju
E-mount (priloZen)
T
Mikrofon
ECM-VG1
ECM-MS2

Jedinica daljinskog
upravljaca
RM-30BP

Daljinski upravljac
na drski (prilozen)
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1. Pregled

Polozaj i funkcija dijelova

Lijeva strana i prednja strana

O O~NOUID W IN —

1. Kuka za mjernu traku

Kuka za mjernu traku je u ravnini slikovnog
senzora. Za to¢no mjerenje udaljenosti
izmedu videokamere i objekta upotrijebite
ovu kuku kao referentnu tocku. Kraj mjerne
trake pricvrstite za kuku kako biste izmjerili
udaljenost od objekta.

2. Priklju¢nica za traZilo (stranica 19)

3. lIzlazni otvor za zrak

[Napomenal]
Nemojte prekriti izlazni otvor za zrak.

4. Sklopka za odabir TC IN/OUT
(stranica 34, 107)

5. Priklju¢nica za daljinski upravljac s
drskom (stranica 20)
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6. N (N-oznaka) (stranica 56)
e Pametnim telefonom s funkcijom
NFC dodirnite jedinicu kako biste
uspostavili beZi¢nu vezu.
Neki pametni telefoni s podrskom
za sustave bezi¢nog placanja mozda
ne podrzavaju NFC. Pojedinosti potraZite
u uputama za upotrebu pametnog telefona.
e Komunikacija bliskog polja NFC (Near Field
Communication) unutarnji je komunikacijski
protokol za bezi¢nu komunikaciju bliskih
objekata.

7. Postavljanje daljinskog upravljaca
na drski (stranica 20)

8. Gumb za otpustanje daljinskog upravljaca
na drski (stranica 20)

9. Antena za Wi-Fi

10. Lampica snimanja/signalizacije (sprijeda)
(stranica 34)

Treperi kada je preostali kapacitet medija

za snimanje ili baterije nizak.

11. Sklopka FOCUS (stranica 37)

12. Slikovni senzor

13. Gumb PUSH AUTO FOCUS (stranica 40)
14. Signalni kontakti objektiva

[Napomenal]
Nemojte izravno dirati rukama.

15. Gumb WB SET (postavljanje balansa bijele
boje) (stranica 45)

16. Gumb za otpustanje objektiva
(stranica 22)
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1. Pregled: Polozaj i funkcija dijelova

Desna strana (sprijeda/odozgo/odozdo)

1415117 |19
16 18

1. Gumb Clip Flag (stranica 50, 65)
2. Sklopka HOLD (stranica 93)

3. Gumb za snimanje START/STOP
(stranica 34)

Pritisnite gumb za snimanje START/STOP za

pocletak snimanja. LED lampica svijetli crveno

tijekom snimanja.

Desna strana (straga)

. Kotaci¢ ND VARIABLE (stranica 43)

5. Sklopka ND PRESET/VARIABLE
(stranica 43)

. Gumbi gore/dolje ND FILTER POSITION
(stranica 43)

Indikator ND CLEAR (stranica 43)

8. Gumb ND VARIABLE AUTO (stranica 43)
Pritisnite gumb ND VARIABLE AUTO za pocetak
namjeStanja automatske gustoce ND filtra. LED
lampica svijetli zeleno kada je ukljuceno.

9. Visenamjenski kotaci¢ (stranica 48)
Pritisnite tijekom pregleda slike na trazilu za
prikaz i upravljanje izravnim izbornikom.
Kada se na trazilu prikazuje izbornik, okrecite
kotaci¢ kako biste pokaziva¢ pomicali gore/
dolje za odabir stavki izbornika i postavki.
Pritisnite za primjenu odabrane stavke.

Kada se izbornik ne prikazuje, kotacic¢ takoder
moze sluziti kao dodjeljivi kotacic.

10. Gumb funkcije IRIS (stranica 42)
11. Gumb CANCEL/BACK (stranica 64)
12. Gumb THUMBNAIL (stranica 63)

13. Gumb MENU (stranica 13, 68)

Pritisnite gumb MENU da bi se prikazao zaslon
statusa. Pritisnite i drzite gumb MENU da bi

se prikazao zaslon cijelog izbornika. Pritisnite
gumb tijekom zaslona statusa ili prikaza
zaslona cijelog izbornika za povratak na
prethodni prikaz zaslona.

14. Gumb funkcije ISO/GAIN (stranica 42)

15. Sklopka ISO/GAIN (odabir poja¢anja
signala) (stranica 42)

16. Gumb funkcije WHT BAL (balans
bijele boje) (stranica 45)

17. Sklopka WHT BAL (odabir memorije
za balans bijele boje) (stranica 45)

18. Gumb funkcije SHUTTER (stranica 43)
19. Priklju¢nica za slusalice (stranica 34)

20.Sklopka POWER (stranica 34)
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Desna straznja strana i utor za karticu
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Antena za Wi-Fi
Kotaci¢ AUDIO LEVEL (CH1) (stranica 46)
Sklopka CH1 (AUTO/MAN) (stranica 46)

Gumbi ASSIGN (dodjeljiv) od 1 do 3
(stranica 48)

Unutarnji mikrofon (stranica 46)
rofon za pricanje za snimanje zvukova iz
line.

[Savjet]

Ovaj

mikrofon onemogucen je kada je rucka postavljena

i kada je rucka unutarnjeg mikrofona aktivna

(stra
6.
7.

nica 7).
Gumb DISPLAY (stranica 11)

Ugradeni zvucnik (stranica 34)

10.
1.
12.
13.

14.

15.

Indikator POWER (stranica 34)

Gumb SLOT SELECT (odabir utora za
memorijsku karticu (A)/(B)) (stranica 34)

Sklopka CH2 (AUTO/MAN) (stranica 46)
Kotaci¢ AUDIO LEVEL (CH2) (stranica 46)
Indikator pristupa A (stranica 26)

Utor za CFexpress Type A karticu / SD
karticu (A) (stranica 26)

Utor za CFexpress Type A karticu / SD
karticu (B) (stranica 26)

Indikator pristupa B (stranica 26)
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1. Pregled: Polozaj i funkcija dijelova

Rucka, straznja strana i blok prikljucnice

N P
) a @ 26

1. Prekida¢ HOLD za ru¢ku
Upotrebljava se za onemogucavanje rada
upravljackih elemenata rucke.

2. Gumb za snimanje na ru¢ki START/STOP

3. Rucka unutarnjeg mikrofona

4. Nosac za vise sucelja

® Multi
7 interface Shoe

Za detalje o dodatnoj opremi koju podrzava
nosac za vise sucelja obratite se prodajnom
predstavniku tvrtke Sony.

5. Dodijeljivi kotaci¢ na rucki (stranica 48)

6. Poluga s ru¢kom za zumiranje
(stranica 93)

7. Gumbi ASSIGN (dodjeljivi) od 7 do 8
(stranica 48)

8. Visestruki bira¢ (osmosmjerni D-upravlja¢
i gumbi za primjenu)
9. Nosa¢ dodatne opreme (stranica 7)

10. Otvori za vijak (174 in¢a) za postavljanje
dodatne opreme

Kompatibilni s vijcima 1/4-20 UNC (duljine

6 mm ili kraci).

[Napomenal]

Upotreba vijaka duZih od 6 mm moZe ostetiti vanjsku
povrsinu.

11. Lampica snimanja/signalizacije (straga)
(stranica 34)

12. Gumb BATT RELEASE (stranica 17)

13. Ulaz za zrak

[Napomenal]
Nemojte prekriti ulaz za zrak.

14. Priklju¢ak za komplet baterija
(stranica 17)

15. Priklju¢nica USB-C (stranica 60)

16. Priklju¢nica INPUT2 (ulaz zvuka 2)
(stranica 46)

17. Priklju¢nica INPUT1 (ulaz zvuka 1)
(stranica 46)

18. Sklopka INPUT2 (LINE/MIC/MIC+48V)
(stranica 46)

19. Sklopka INPUT1 (LINE/MIC/MIC+48V)
(stranica 46)

20.0tvori za vijak za vanjske uredaje
Kompatibilni s vijcima M3 (duljine 4 mm ili
kraci).

[Napomenal]

Upotreba vijaka duZih od 4 mm moZe ostetiti vanjsku
povrsinu.

21. Priklju¢nica HDMI OUT (stranica 106)
22.Priklju¢nica SDI OUT (stranica 106)

23. Priklju¢nica TC IN/TC OUT (ulaz/izlaz
vremenskog koda) (stranica 107)

24.Priklju¢nica REMOTE
Za prikljucenje dodatne opreme opce namjene
s priklju¢nicom LANC.

25. Priklju¢nica USB/multi (stranica 108)
26.Priklju¢nica DC-IN (standardni DC
prikljucak) (stranica 18)

Postavljanje nosaca za viSe sucelja

1 Podignite prednji rub opruge nosaca
i povucite oprugu u smjeru suprotnom
od strelice urezane na opruzi.

Opruga nosaca
[ T
<
\ N
\ ‘:@
1
Nosac dodatne opreme

2 Postavite nosac dodatne opreme na
nosac za viSe sucelja, poravnajte utore na
nosacu s odgovarajuc¢im tockama na
drzacu te zategnite Cetiri vijka.
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1. Pregled: Polozaj i funkcija dijelova

3 Umetnite oprugu nosaca u smjeru strelice
tako da dio oblikovan kao slovo postavite
na rub nosaca za vise sucelja.

Nosac¢ dodatne opreme

Uklanjanje nosaca za vise sucelja

Uklonite oprugu nosaca kako je opisano

u 1. koraku pod ,Postavljanje nosaca za vise
sucelja", odvijte Cetiri vijka i uklonite nosac
za vise sucelja.

Postavljanje rucke

Stavite rucku tako da su priklju¢nica rucke

i otvori za vijke poravnati, gurnite unutra

i okrenite vijke za postavljanje rucke

u smjeru kazaljke na satu za postavljanje
rucke na jedinicu.

MoZete i zategnuti vijke za postavljanje rucke
okretanjem u smjeru suprotnom od kazaljke
na satu s pomocu imbus kljuca.

)

o

S

ol

[Napomenal]

Provjerite jesu li dva vijka za postavljanje rucke dobro
zategnuta prije upotrebe rucke. Rucka moZze ispasti s
videokamere ako vijci nisu dobro zategnuti.

Uklanjanje rucke

Uklonite je tako da postupak postavljanja
napravite obrnutim redoslijedom.

Postavljanje poklopca za zastitu
prikljucka za rucku (isporucen)
Tijekom upotrebe videokamere bez rucke

zastitite prikljucak isporuc¢enim zastitnim
poklopcem.

[Savjet]
Pri postavljanju rucke stavite zastitni poklopac na dno
rucke.

Zastita stezaljki prikljucnica

Na nekoriStene priklju¢nice postavite poklopac
kako biste zastitili stezaljke priklju¢nice.

Gornja strana

1. Prikljucak za ruc¢ku

2. Otvori za vijak (1/4 in&a) za postavljanje
dodatne opreme

Kompatibilni s vijcima 1/4-20 UNC (duljine

6 mm ili kradi).

[Napomena]

Upotreba vijaka duzih od 6 mm moZze ostetiti vanjske
dijelove.
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Donja strana TraZilo Daljinski upravlja¢ na drski
Pojedinosti o postavljanju trazila (priloZzeno) Pojedinosti o postavljanju daljinskog
3 potraZite na (stranica 19). upravljaca na drski (priloZen) potraZite
na (stranica 20).
( )
) @) S (@D
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4 5

1 2

1. Otvori za vijke stativa (174", 3/8")
Kompatibilni s vijcima 1/4-20 UNC i 3/8-16
UNC. Postavite stalak (nije obavezno, duljina
vijka 5,5 mm ili manja).

Gumb PEAKING
Gumb ZEBRA
Gumb ASSIGN 9 (dodjeljiv) (stranica 48)

A w2

. Zaslon osjetljiv na dodir

2. 1zlaz za zrak Rad dodirom mozZe se onemoguciti

s pomocu dodjeljivog gumba ili izbornika
(stranica 10).

5. Sklopka MIRROR

[Napomenal]
Nemojte prekriti izlaz za zrak.

Poluga zuma

Gumb ASSIGN 4 (dodjeljiv) (stranica 48)
Dodjeljivi kotaci¢ na drski (stranica 48)
Gumb ASSIGN 6 (dodjeljiv) (stranica 48)
Poluga za okretanje drske (stranica 21)

Gumb za snimanje START/STOP

NowvAawN 2

Visestruki bira¢ (osmosmijerni D-upravljac
i gumbi za primjenu)

8. Gumb ASSIGN 5 (dodjeljiv) (stranica 48)
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1. Pregled

Upotreba zaslona osjetljivog na dodir

Mjere opreza za upotrebu zaslona
osjetljivog na dodir

Trazilo jedinice je zaslon osjetljiv na dodir

kojim moZete upravljati izravno dodirom prsta.

e Zaslon osjetljiv na dodir dizajniran je da se
moze lagano dodirnuti prstom. Nemojte
snazno pritiskati zaslon ili ga dodirivati
ostrim predmetima (Cavao, kemijska
olovka, igla itd).

e Zaslon osjetljiv na dodir mozda nece
reagirati ako se dodiruje u sljede¢im
okolnostima. Imajte na umu da one mogu
dovesti do kvara.

e Upravljanje vr§kom prstiju
e Rad dok drugi predmeti dodiruju
povrsinu
e Rad sa zastitnom folijom ili naljepnicom
e Rad kada su na zaslonu prisutne kapi
vode ili je na zaslonu doslo do pojave
kondenzacije
Rad mokrim ili znojnim prstima

Geste dodirnog zaslona

Dodir
Lagano prstom dodirnite stavku poput ikone ili
stavke izbornika i zatim odmah maknite prst.

Povlacenje
Dodirnite zaslon i prstom povucite do Zeljenog
poloZaja zaslona te zatim maknite prst.

Pomicanje
Dodirnite zaslon i brzo pomaknite prstom
prema gore, dolje, lijevo ili desno.

[Savjet]
Ako se sadrzaj zaslona prikazuje i preko rubova zaslona,
moZete povuci ili pomaknuti sadrzZaj zaslona.

Konfiguracija zaslona osjetljivog
na dodir

Rad zaslona osjetljivog na dodir moZe se
omoguditi/onemoguciti s pomocu funkcije
Touch Operation (stranica 93) u izborniku
Technical.
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1. Pregled

Zaslonski prikaz

Tijekom snimanja (snimanje/pripravnost) i reprodukcije status i postavke videokamere polaZzu se

na sliku prikazanu na trazilu.

Informacije moZete prikazati/sakriti gumbom DISPLAY. Cak i kada je skriven, prikazat c¢e se

tijekom rada izravnog izbornika (stranica 48).

Takoder mozZete odabrati pojedinacno prikazivanje/sakrivanje svake stavke (stranica 87).

Informacije koje se prikazuju na zaslonu tijekom snimanja

(v _8600keHold) (sen04), ([ow Light ND Clees)
:00:00:00)ERETT6)| @F5:8

18 19202122 23 242526 27 28

1. Indikator statusa mreze (stranica 13)
Prikaz statusa povezanosti s mrezom u obliku
ikone.

2. Indikator prijenosa/indikator preostalih
datoteka (stranica 61)

3. Indikator podrugja fokusiranja (stranica 37)
Prikaz podru¢ja fokusa za automatsko fokusiranje.

4. Nacin snimanja, utor A/B, indikator
intervala snimanja Interval Rec
(stranica 49)

Display Znacenje

@®Rec Recording (Nacin
snimanja u 5 sekundi)

Stby Pripravnost za

snimanje

5. Indikator dubine polja

6. Indikator nacina skeniranja pretraznika
(stranica 24)

Ako postoji nepodudaranje veli¢ine kruga

slike objektiva i postavke nacina skeniranja

pretraznika za efektivnu velic¢inu slike,

prikazuje se oznaka 1.

Kada je funkcija Imager Scan Mode

postavljena na FF, oznaka ,C" prikazuje se u

nacinima s uzim kutom gledanja (izrezano).

Do rezanja dolazi u sljedec¢im nacinima.

e Kada je format snimanja 3840x2160 i broj
slicica u sekundi za snimanje u nac¢inu S&Q
Motion 100 fps ili 120 fps

e Kada je funkcija Codec postavljena na RAW ili
RAW & XAVC-l i izlazni RAW format je 3840x2160.

7. Indikator statusa izlaza za RAW
(stranica 55)
Prikaz statusa izlaza RAW signala.

8. Indikator statusa serije UWP-D
(stranica 13)

Prikaz jacine signala razine RF ikonom kada

je uredaj serije UWP-D povezan s nosacem

za vise sucelja konfiguriranim za digitalni

prijenos zvuka.

9. Indikator broja sli¢ica u sekundi za
snimanje za Slow & Quick Motion
(stranica 49)

10. Indikator preostalog kapaciteta baterije/
napona na DCIN (stranica 17)

11. Indikator nacina izo$travanja
(stranica 41)

Sljedece stavke dodane su na prikaz kada je
omogucena funkcija zuma za jasnu sliku.

Display Znacenje

o Omogucena je funkcija zuma
za jasnu sliku

Vrijednost Tijekom primjene funkcije

povecavanja zuma za jasnu sliku

13. Indikator nacina stabilizacije slike

14. Indikator statusa funkcije Rec Control na
izlazu (stranica 106)
Prikaz statusa izlaza kontrolnog signala REC.

15. Indikator fokusiranja (stranica 40)

16. Indikator preostalog kapaciteta medija

Znacenje Display ) . - )
Nacin Focus Hold Focus Hold 17. Indikator nacina za balans bijele boje
Nacin MF MF Display Znacenje
Nacin AF AF Automatski nacin
Nacin Face/eye detection AF (AF/&/0nly/ % /1) — -
Automatski nacin je pauziran
Ikona otkrivanja O Hold
lica/oka W:P Unaprijed postavljeni nacin
Ikona otkrivanja lica/  Only W:A Nacin Memory A
oka pri automatskom W:B Nacin za Memory B
fokusiranju . L
Ikona registriranog Py 18. Prikaz podataka o indikatoru/vremenu
lica vanjskog zakljucavanja vremenskog koda
Ikona pauziranja M . (str:':mlca 3?) . -
automatskog Prikaz "EXT-LK" kada je zaklju¢ano na

fokusiranja tijekom
otkrivanja lica/oka
pri automatskom
fokusiranju”

1) Prikazuje se kada nema registriranog lica i ne
pronalazi se lice, ili kada postoji registrirano lice koje
se ne pronalazi.

12. Indikator poloZaja zuma (stranica 36)
Prikazuje poloZaj zuma u rasponu od O (Siroki
kut) do 99 (telefoto) (ako je postavljen objektiv
koji podrZava prikaz postavke zuma).

Prikaz je moguce promijeniti u indikator

s trakama ili indikator udaljenosti fokusa
(stranica 94).

vremenski kod vanjskog uredaja.
19. Indikator filtra ND (stranica 43)
20.Indikator datoteke kadra (stranica 105)

21. Indikator irisa

Prikaz poloZaja irisa (F vrijednost) (ako je
postavljen objektiv koji podrzava funkciju
prikaza irisa).

22.Indikator upozorenja na razinu
videozapisa

23.Indikator pojacanja signala (stranica 42)
Prikazuje El vrijednost kada je u nacinu Cine El
(stranica 24).
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Display Znacenje

Automatski nacin

Nacin Preset H

Nacin Preset M

Nacin Preset L

%'_EI@

Nacin za privremeno
podesavanje

24.Prikaz naziva isje¢ka (stranica 63)
25.Indikator zatvarac¢a (stranica 43)

26.Indikator na¢ina AE /razine AE
(stranica 42)

27. Indikator libele
Prikaz vodoravne razine do +15° u koracima
od #1°.

28.Mjera¢ razine zvuka
Prikaz razine zvuka na CH1i CH2.
CH3 i CH4 mogu se pratiti na zaslonu statusa.

29.Nadzor videosignala (stranica 50)

Prikaz valnog oblika, vektroskopa i histograma.
Narancasta linija prikazuje postavljenu
vrijednost funkcije zebra.

U nacinu Cine El (stranica 24) prikazuje vrstu
LUT signala koji se prati.

30.Indikator osnovne osjetljivosti/indikator
osnovnog ISO (stranica 42)
U nacinu Custom (stranica 24) prikazuje
postavljenu temeljnu osjetljivost s pomocu
funkcije ISO/Gain/El na zaslonu Main Status
ili ISO/Gain/EI>Base Sensitivity u izborniku
Shooting cijelog izbornika.
U nacinu Cine El (stranica 24) prikazuje
postavljenu temeljnu ISO osjetljivost s pomocu
funkcije ISO/Gain/El na zaslonu Main Status
ili ISO/Gain/ElI>Base ISO u izborniku Shooting
cijelog izbornika.

31. Indikator pomo¢nog prikaza game/LUT
monitora

Prikaz statusa pomocne funkcije prikaza

game. Pomoc¢nu funkciju prikaza game

moguce je ukljucitiZiskljuciti dodjelom funkcije

Gamma Display Assist dodjeljivom gumbu

(stranica 48).

U nacinu Cine El (stranica 24) prikazuje

postavku LUT monitor(stranica 76).

32.Indikator osnovnog izgleda

(stranica 52)
Prikazuje postavku temeljnog izgleda.
U nacinu Cine El (stranica 24) prikazuje
LUT postavku za snimanje videozapisa na
memorijske kartice (stranica 76).

33.Indikator statusa videozapisa proxy

34.Indikator formata snimanja (kodek)
(stranica 77)

Prikaz naziva formata za snimanje na

memorijske kartice.

35.Indikator formata snimanja (broj sli¢ica u
sekundi i metoda skeniranja)

36.Indikator formata snimanja (veli¢ina slike)
(stranica 77)

Prikaz velicine slike za snimanje na

memorijske kartice.

Informacije koje se prikazuju na zaslonu tijekom reprodukcije

Sljedece informacije polaZu se na sliku reprodukcije.

8.
9.

1 2 3 4 5 6 7 8
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Indikator statusa mreze 13. Mjerad razine zvuka

Indikator prijenosa/indikator preostalih Prikaz razine zvuka reprodukcije.

datoteka 14. Indikator temeljnog izgleda
Broj isjecka/ukupan broj isjecaka
Indikator stanja reprodukcije

Indikator formata reprodukcije (broj
sli¢ica u sekundi i metoda skeniranja)

Indikator formata reprodukcije
(velicina slike)

Indikator preostalog kapaciteta baterije/
napona na DCIN

Indikator formata reprodukcije (kodek)

Indikator medija

Ako je memorijska kartica zasti¢ena od
prepisivanja pojavljuje se ikona .

10. Prikaz podataka o vremenu

11. Prikaz naziva isjecka

12. Indikator pomo¢nog prikaza game
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Prikaz ikona

Zaslon statusa

Prikaz ikona za mreZnu vezu

Mrezni nacin rada Status veze Icon
Nacin za pristupnu tocku Radi kao pristupna tocka

Pogreska rada pristupne tocke

Nacin za stanicu

Wi-Fi veza

Ikona se mijenja ovisno o jacini signala

(Cetiri koraka)

LI I W

Wi-Fi je odspojen (ukljucujudi i tijekom

uspostavljanja veze)

Pogreska veze Wi-Fi

Dijeljenje putem USB-a

Spojeno dijeljenje putem USB-a

OF

Odspojeno dijeljenje putem USB-a

Or

Pogreska kod dijeljenja putem USB-a

Ow

Prikaz ikone za seriju UWP-D

Status odasiljaca

Status primanja

Icon

Isklju¢eno

Nema primanja

W

Status normalnog odasiljanja

Receiving

]

(razina prijema (Cetiri koraka))

Status prigusenja

Prijem (prigusen)

Vel

Status upozorenja za preostali kapacitet Receiving w
baterije dls (ikona treperi)
Status upozorenja za prigusenje i Receiving

preostali kapacitet baterije

M (ikona treperi)

Postavke i status videokamere mozete
provjeriti na zaslonu statusa. Postavke stavki

oznacenih zvjezdicom (*) mogu se promijeniti.

Zaslon statusa podrzava rad dodirom.

Prikaz zaslona statusa
e Pritisnite tipku MENU.

Za prebacivanje zaslona statusa

e Okrecite viSenamjenski kotacic.

e Pritisnite visestruki bira¢ prema gore/dolje.
e Povucite zaslon statusa prema gore/dolje.

Sakrivanje zaslona statusa
e Pritisnite tipku MENU.

Za promjenu postavke

Kada se prikazuje zaslon statusa, pritisnite
viSenamjenski kotacic ili viSestruki birac za
omogucavanje odabira stavke za postavljanje
na stranici. Odaberite broj stranice i zatim
pritisnite za prebacivanje stranica.

MoZete odabrati stavke i izravno

s pomocu rada dodirom.

[Napomenal]

MoZete onemoguditi promjene na zaslonu statusa
postavljanjem funkcije Menu Settings >User Menu Only
(stranica 93) u izborniku Technical cijelog izbornika

na On.

Zaslon Main Status

Prikaz glavnih funkcija kamere i slobodnog
prostora na mediju.

Stavka prikaza

Opis

S&Q Frame Rate

Postavka broja slicica
u sekundi za snimanje
Slow & Quick Motion

Frequency/Scan*

Frekvencija sustava i
postavke metode skeniranja

Imager Scan*

Nacin skeniranja slikovnog
senzora

Media Remain

Preostali slobodan prostor

(A) na mediju u utoru A

ND Filter Postavka filtra ND

ISO/Gain/El Postavke za ISO/Gain/
Exposure Index

Base I1SO/ Postavka za Base ISO/Base

Sensitivity* Sensitivity

Codec* Postavka kodeka za
snimanje

Media Remain (B)

Preostali slobodan prostor
na mediju u utoru B

Scene File*

Datoteka kadra koja se
primjenjuje i njene postavke
za File ID

Base Look/LUT*

Postavka za Monitor LUT

Shutter

Postavka brzine zatvaraca ili
kut zatvaraca

Blenda

Postavka irisa

Video Format*

Veli¢ina slike za snimanje na
memorijske kartice

RAW Output
Format*

Veli¢ina slike za RAW izlaz

White Balance

Postavka balansa bijele boje
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1. Pregled: Zaslonski prikaz

Zaslon Camera Status

Prikazuje status razli¢itih unaprijed
postavljenih postavki kamere.

Zaslon Audio Status

Prikaz ulazne postavke, mjeraca razine zvuka i
postavke monitora glasnoce za svaki kanal.

Zaslon Project status

Prikaz osnovnih postavki povezanih
s projektom snimanja.

Zaslon Monitoring Status

Prikaz postavki izlaza za SDI i HDMI.

Stavka prikaza

Opis

White Switch<B>

Postavka B memorije
balansa bijele boje

White Switch<A>

Postavka A memorije
balansa bijele boje

White Switch<P>

Postavka Preset White

ND<Preset>

Postavke Preset1 do 3 za
filtar ND

ISO / Gain<L>*

Postavka za ISO/Gain<L>

Stavka prikaza

Opis

ISO / Gain<M>*

Postavka za ISO/Gain<M>

ISO / Gain<H>*

Postavka za ISO/Gain<H>

Base ISO/ Postavka za Base ISO/Base

Sensitivity* Sensitivity

Zebral Postavka On/Off i razina
funkcije Zebral

Zebra2 Postavka On/Off i razina
funkcije Zebra2

VF Gamma/ Kategorija i krivulja game

Gamma

Scene File* Datoteka kadra koja se

primjenjuje i njene postavke
za File ID

Stavka prikaza Opis Stavka prikaza Opis SDI Signal*  Veli¢ina izlazne slike
CH1  Level Automatsko namjestanje Frequency/Scan* Frekvencija sustava i Info. Postavka ukljucivanja/
Control statusa ukljuceno/isklju¢eno postavke metode skeniranja Disp.* iskljuCivanja zaslona
Level Meter Mjerac razine zvuka Codec* Postavka kodeka za Output Display
Source* Ulazni izvor snimanje Color Postavka prostora boje/
Ref./Sens.* Referentna razina unosa Rec Function Format i postavke Gamut*  status LUT monitora
Wind Postavka filtra za smanjenje omogucenog posebnog HDMI Signal*  Veli¢ina izlazne slike
Filter Suma zbog vjetra na mikrofonu formata snimanja Info. Postavka uklju¢ivanja/
CH2 Level Automatsko namjestanje Simul Rec* Status On/Off funkcije Disp.* iskljucivanja zaslona
Control statusa uklju¢eno/isklju¢eno istovremenog snimanja Output Display
Level Meter Mijerac razine zvuka u dva utora Color Postavka prostora boje/
Source* Ulazni izvor Title Prefix Naslovni dio naziva isjecka Gamut*  status LUT monitora
Ref./Sens.* Referentna razina unosa Imager Scan* Nacin skeniranja slikovnog Emitira- Signal Veli¢ina izlazne slike
Wind Postavka filtra za smanjenje sénzora nje Info. Zaslon Output display
Filter* £uma zbog vjetra na mikrofonu Format Velicina slike za snimanje Zaslon (Iskljuceno (fiksno))
CH3 Level Automatsko namjestanje videozapisa* na memorijske kartice Color Postavka prostora boje/
Control* statusa ukljuceno/isklju¢eno Number Brojcani sufiks naziva isjecka Gamut*  status LUT monitora
Level Meter* Mijera¢ razine zvuka ReZim snimanja* Postavka nacina za snimanje VF Color Postavka funkcije Gamma
Source* Ulazni izvor RAW Output Veli¢ina slike za RAW izlaz Gamut*  Display Assist / Postavka
Ref./Sens.* Referentna razina unosa Format* prost.ora boja / Status LUT
Wind Postavka filtra za smanjenje Proxy Rec* Statu?On/.Off i postavka " monftora
Filter* Suma zbog vjetra na mikrofonu fL_mkc”e gnlmanja Base LOOk./LUT Postavka Bas.,e VL.OOK./LUT
CHA Level Automatsko namjedtanje videozapisa proxy Garpn:a Display !:’os.ta}/.ka u.kljucwa.r.ua/
Control* statusa ukljuceno/iskljuceno Assist zkljucwan.Ja funkcug
amma Display Assist
Level Meter* Mjerac razine zvuka
Source* Ulazni izvor
Ref./Sens.* Referentna razina unosa
Wind Postavka filtra za smanjenje
Filter* Suma zbog vjetra na mikrofonu
Audio Input Postavka razine ulaza zvuka
Level* (glavna jacina zvuka)

HDMI Output CH*

Postavka kanala za izlaz
zvuka za HDMI

Jacina zvuka*

Postavka glasnoce slusalica
/ ugradenog zvucnika

Monitor CH*

Postavka kanala za monitor
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1. Pregled: Zaslonski prikaz

Zaslon Assignable Button Status

Prikaz funkcija dodijeljenih svakome od

dodjeljivih gumba.

Zaslon Battery Status

Prikaz informacija o bateriji i izvoru na DCIN.

Stavka prikaza

Opis

Stavka prikaza

Opis

Detected Battery

Vrsta baterije

Zaslon Media Status

Prikaz preostalog kapaciteta i preostalog
vremena snimanja na mediju za snimanje.

Stavka prikaza

Opis

1

Funkcija dodijeljena gumbu
ASSIGN 1

Remaining

Preostali kapacitet (%)

Charge Count

Broj ponovnih punjenja

Kapacitet Preostali kapacitet (Ah)
Napon Napon baterije (V)
Manufacture Datum proizvodnje baterije
Date

Video Light Prikaz preostalog kapaciteta
Remaining baterije svjetla za

videozapis.

Informacije o

Prikaz ikone medija kada je

Zaslon Network Status

Prikaz statusa mreZne veze.

Stavka prikaza

Opis

BeZi¢ni LAN

Postavke i status veze
s bezicnom mrezom

Power Source

Izvor elektricnog napajanja

Supplied Voltage

Napon izvora napajanja

2 Funkcija dodijeljena gumbu
ASSIGN 2

3 Funkcija dodijeljena gumbu
ASSIGN 3

4 Funkcija dodijeljena gumbu
ASSIGN 4

5 Funkcija dodijeljena gumbu
ASSIGN 5

6 Funkcija dodijeljena gumbu
ASSIGN 6

7 Funkcija dodijeljena gumbu
ASSIGN 7

8 Funkcija dodijeljena gumbu
ASSIGN 8

9 Funkcija dodijeljena gumbu
ASSIGN 9

Gumb Zadrz. Funkcija dodijeljena gumbu

izost. Focus Hold na objektivu

Multi Function Funkcija dodijeljena

Dial viSenamjenskom kotacic¢u

Kotacic¢ na drski

Funkcija dodijeljena
dodjeljivom kotacicu
na drski

Kotaci¢ na rucki

Funkcija dodijeljena
dodjeljivom kotacic¢u
na rucki

mediju A medij za snimanje umetnut Wired LAN Postavke i status veze

u utor A. sa zicnom mrezom LAN
Mijerac Prikaz preostalog kapaciteta Modem Postavke bezi¢ne mreze
preostalog medija za snimanje umetnutog i status veze dijeljenja
kapaciteta na u utor A u obliku postotkaili putem USB-a
mediju A stupcastog grafikona.
Preostalo vrijeme Prikaz procjene preostalog Zaslon File Transfer Status
snimanja na vremena snimanja, pod
mediju A trenutacnim uvjetima, Prikaz informacija o prijenosu datoteka.

na mediju za snimanje
umetnutom u utor
A u minutama.

Stavka prikaza

Opis

Informacije o

Prikaz ikone medija kada je

Auto Upload Status On/Off funkcije Auto
(Proxy) Upload (Proxy)
Job Status Broj preostalih zadataka

(Remain / Total)

i ukupan broj zadataka

mediju B medij za snimanje umetnut
u utor B.

Mijerac Prikaz preostalog kapaciteta

preostalog medija za snimanje

kapaciteta na umetnutog u utor B u obliku

mediju B postotka ili stupcastog

grafikona.

Total Transfer
Progress

Napredak prijenosa svih
zadataka

Default Upload
Server

Naziv odredisnog posluZitelja
za Auto Upload (Proxy)

Preostalo vrijeme
snimanja na
mediju B

Prikaz procjene preostalog
vremena snimanja, pod
trenutacnim uvjetima,

na mediju za snimanje
umetnutom u utor

B u minutama.

Current File
Transfer Progress

Napredak prijenosa
trenutacne datoteke

Current
Transferring

Naziv trenutacno prenosene
datoteke

File Name

Server Address Adresa odredisnog
posluzitelja za prijenos
datoteke

Destination OdrediSna mapa na

Directory odredisnom posluzitelju

za prijenos datoteke
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Upotreba zaslona s postavkama na dodir

Raspored na zaslonu

Stavka Naziv stavke

Gumb Set (primjena)

INPUT1
MIC +48V

INPUT2 Oznaka koja oznacava
MIC +48V

trenutacnu postavku
Int MIC

Pokazivac¢ za odabir postavke
INPUT2 Lo e
MIG +48V (narancasti okvir)

CH1/CH2

Opcije za odabir

Operation
1 Dodirnite stavku za postavljanje. 2 Dodirnite ili povucite postavku za odabir
vrijednosti.
INPUT1 CH4 Input Sel.
MIC +48V off
INPUT1
INPUT2
MIC +48V Off MIC +48V off
INPUT2
Int MIC off MIC +48V
Int MIC
Off
INPUT2
CH1/CH2 CH1/CH2 MIC +48v Internal
. CH1/CH2 [0] ~
Dodir
Pojavljuju se opcije odabira za vrijednost. Pomicanje

3 Dodirnite gumb Set ili pokazivac za odabir
vrijednosti.
Vrijednost je primijenjena i prikaz se vraca
na prethodni zaslon.

[Savjeti]

e Pritisnite gumb CANCEL/BACK za povratak na
prethodnu vrijednost.

e MoZete upotrijebiti viSenamjenski kotaci¢ ili
visestruki birac.

e MoZe se onemogucditi i rad dodirom (stranica 93).
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2. Priprema

|lzvor napajanja

Mozete upotrebljavati komplet baterija

ili izmjeni¢no napajanje adapterom

za izmjenicnu struju.

Iz sigurnosnih razloga upotrebljavajte samo
komplete baterija i adaptere izmjeni¢nu struju
tvrtke Sony navedene u nastavku.

Litij-ionski kompleti baterija
BP-U35 (prilozeno)

BP-U60

BP-U60T

BP-U70

BP-U90

BP-U100

Punjaci baterija
BC-CU1 (priloZzeno)
BC-U1A

BC-U2A

Adapter za izmjenicnu struju (priloZen)

[OPREZ]

Komplete baterija nemojte pohranjivati

na lokacijama izloZzenima izravnoj suncevoj
svjetlosti, plamenu ili visokoj temperaturi.

[Napomene]

e Za napajanje iz izmjeni¢nog izvora upotrebljavajte
priloZeni adapter za izmjenic¢nu struju.

e Prije prikljucenja baterije ili adaptera za izmjenic¢nu
struju sklopku POWER obavezno postavite na Off.
Ako prikljucite sa sklopkom POWER u poloZaju On,
u nekim slucajevima moguce je da se videokamera
ne moZze pokrenuti. Ako videokameru nije moguce
pokrenuti, sklopku POWER postavite u poloZaj
Off i privremeno odspojite bateriju ili adapter za
izmjenicnu struju te pricekajte oko 30 sekundi prije
ponovnog priklju¢enja. (Ako je adapter za izmjeni¢nu
struju priklju¢en dok se videokamera pogoni
kompletom baterija, bez problema se prikljucuje
sa sklopkom POWER u poloZaju On).

Upotreba kompleta baterija

Za postavljanje kompleta baterija umetnite
ga do kraja u nastavak (stranica 7), a zatim

povucite dolje kako bi se pricvrstio.

Za uklanjanje kompleta baterija pritisnite
i zadrzite gumb BATT RELEASE (stranica 7),
pomaknite ga prema gore i zatim izvucite

iz nastavka.

[Napomene]

e Prije postavljanja kompleta baterija napunite bateriju
s pomocu odgovarajuceg punjaca za baterije BC-CU1,
BC-U1Aili BC-U2A.

e Ako komplet baterija punite dok je topao (primjerice
odmah nakon upotrebe) mozda necete u potpunosti
moci napuniti bateriju.

Gumb BATT
RELEASE

Provjera preostalog kapaciteta

Pri snimanju/reprodukciji s kompletom
baterija preostali kapacitet baterije prikazuje
se u trazilu (stranica 11).

Icon Znacenje

:////] 0d 91 % do 100 %
¥///| od 71 % do 90 %
(/| 0od 51 % do 70 %
0d 31% do 50 %
I | 0d 11 % do 30 %
{7 od 0 % do 10 %

Videokamera prikazuje preostali kapacitet
izracunavajudi vrijeme dostupno s kompletom
baterija za nastavak rada s trenutacnom
potroSnjom energije.

Ako je napunjenost kompleta baterija
niska

Ako preostala napunjenost baterije padne
ispod odredene razine tijekom rada (stanje
Low Battery), prikazuje se poruka o niskoj
razini napunjenosti baterije i lampica
snimanja/signalizacije pocinje treperiti kao
upozorenje.

Ako preostala napunjenost baterije padne
ispod razine na kojoj je mogu¢ nastavak rada
(stanje Battery Empty), prikazuje se poruka o
praznoj bateriji.

Zamijenite napunjenim kompletom baterija.

Promjena razina upozorenja

Tvornicki je razina Low Battery postavljena je
10 %, a razina Battery Empty na 3 % napunjene
baterije. Postavke razine upozorenja moguce
je promijeniti s pomocu funkcije Camera
Battery Alarm (stranica 94) u izborniku
Technical cijelog izbornika.

Za promjenu kompleta baterija s pomocu
priloZenog punjaca za baterije (BC-CUT)

1 Adapter za izmjeni¢nu struju (priloZen) prikljucite
na punjac za baterije, a kabel napajanja
(prilozen) na izvor izmjeni¢nog napajanja.

2 Gurnite bateriju unutra i povucite je u
smjeru strelice.
Zaruljica punjenja CHARGE svijetli
narancasto i punjenje zapocinje.

Zaruljica punjenja CHARGE

o— Adapter za izmjenic¢nu struju

— Kabel za napajanje

Zaruljica punjenja CHARGE (narancasto)
Svijetli:Punjenje
Treperi:greSka s punjenjem ili temperatura
premasuje raspon radne temperature
i punjenje je pauzirano
e Kada je u potpunosti napunjena, Zaruljica
punjenja CHARGE punjaca za baterije
iskljucuje se.
e Uvijek upotrebljavajte originalne baterije
tvrtke Sony.
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2. Priprema: Izvor napajanja

Vrijeme punjenja

Priblizno vrijeme (minute) potrebne kada
punite u potpunosti ispraznjen komplet
baterija.

Baterija Potpuno vrijeme
punjenja

BP-U35 120 minuta

[Napomenal]

Ako je adapter za izmjeni¢nu struju odspojen od punjaca
za baterije, a baterija je i dalje spojena na punjac za
baterije, baterija ¢e se poceti prazniti.

Upotreba izmjeni¢nog napajanja

Prikljucenje videokamere na izvor izmjeni¢nog
napajanja omogucuje upotrebu bez brige
0 ponovnom punjenju kompleta baterija.

Kabel za
napajanje

Priklju¢nica DCIN
l [I:I
Adapter za izmjeni¢nu struju
Adapter za izmjenic¢nu struju prikljucite na

priklju¢nicu DCIN na videokameri, a kabel
napajanja (priloZen) na izvor izmjeni¢nog napajanja.

Ako izlazni napon adaptera za
izmjenicnu struju postane prenizak

Ako izlazni napon adaptera za izmjeni¢nu
struju padne ispod odredene razine tijekom
rada (stanje DC Low Voltagel), prikazuje se
poruka koja vas obavjeStava o padu izlaznog
napona adaptera za izmjenicnu struju i
lampica snimanja/signalizacije pocinje
treperiti kao upozorenje.

Ako izlazni napon adaptera za izmjenic¢nu

struju padne na razinu na kojoj nastavak rada
nije moguc (stanje DC Low Voltage2), prikazuje
se poruka koja vas obavjestava o preniskom
izlaznom naponu adaptera za izmjeni¢nu struju.
Ako se to dogodi, adapter za izmjeni¢nu struju
moZda je neispravan. Po potrebi pregledajte
adapter za izmjenic¢nu struju.

Promjena napona upozorenja

Tvornicki je razina DC Low Voltagel
postavljena na 16,5V, a razina DC Low
Voltage2 na 15,5 V. Postavke razine upozorenja
moguce je promijeniti sa Camera DC IN Alarm
(stranica 94) u izborniku Technical.

Adapter za izmjenicnu struju

e Adapter za izmjeni¢nu struju nemojte
upotrebljavati u sku¢enom prostoru,
primjerice izmedu zida i namjestaja.

e Adapter za izmjeni¢nu struju prikljucite
na najblizi izvor izmjeni¢nog napajanja.
Ako se tijekom rada pojavi problem. kabel
napajanja odmah odspojite od izvora
izmjeni¢nog napajanja.

e Metalne dijelove priklju¢ka adaptera za
izmjeni¢nu struju nemojte kratko spajati.

U protivnom ¢e doc¢i do kvara.

e Bateriju nije moguce puniti dok se nalazi na
videokameri, ¢ak i ako je prikljucen adapter
za izmjeni¢nu struju.

e Kada odspajate adapter za izmjeni¢nu struju
iz jedinice, primite prikljucak i izvucite ga.
Povlacenje kabela moZe dovesti do kvara.
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Postavljanje uredaja

Postavljanje mikrofona (prodaje se
zasebno)

1 Stavite mikrofon na stalak za mikrofon.

2 Spojite kabel mikrofona na priklju¢nicu
INPUTT ili INPUT2.

Stalak za
mikrofon

Q/—

INPUT1  INPUT2

3 Stavite kabel mikrofona i drzac kabela
kako je prikazano na dijagramu.

Drzac kabela

[Savjeti]

e Ako ne moZete sigurno spojiti mikrofon, upotrijebite
fiksator koji ste dobili s mikrofonom.

e Ovisno o vrsti postavljenog objektiva, vrh mikrofona
moZe biti vidljiv na slici videokamere. Namjestite
poloZaj mikrofona.

Postavljanje trazila

[Napomena]

TraZilo postavite/uklonite dok je videokamera isklju¢ena.

Postavljanje traZila na prednju stranu
drzaca

1 Umetnite adapter stezaljke za montiranje
traZila na mjesto za postavljanje trazila na
drzac ((®) i okrenite vijak (priloZen)

u smjeru kazaljke na satu kako biste

ga pricvrstili na mjesto (@).

Adapter stezaljke za montiranje moze
se slobodno postaviti u jedinicama pod
kutom od 45°, ali preporucuje se poloZaj
u kojemu je tocka postavljanja odmah
iznad vijka.

Vijak ) 3 Poravnajte oznaku A na videokameri
Adapter s_tezaljvl_<e za s oznakom V¥ na prikljucnici za traZilo
montiranje trazila i umetnite kabel

Provjerite je li oznaka ¥ na vanjskoj strani
prije umetanja priklju¢nice.

2 Postavite stezaljku traZila na adapter
stezaljke za montiranje trazila (@) i
okrenite rucicu za zakljucavanje u smjeru
kazaljke na satu kako biste je pricvrstili na

mijesto (@).

4 Stavite kabel i drzac kabela kako je
prikazano na dijagramu.

[Napomena]

Obavezno dobro zategnite rucicu za zakljucavanje
tijekom upotrebe trazila. Trazilo moZe pasti ako rucica
za zakljucavanje nije dobro zategnuta.

Drzac kabela
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Postavljanje traZila na straznju stranu
drzaca

Na straznjoj strani drzaca ((D) i straznjoj strani
videokamere (@) za postoje dvije tocke za
postavljanje traZila. Postavite traZilo na isti
nacin koji je opisan u odjeljku ,Postavljanje
trazila na prednju stranu drzaca”.

PodeSavanje poloZaja trazila

Nagnite trazilo prema gore/dolje/naprijed/
natrag za namjestanje kuta traZila.

Sklopku MIRROR moZete upotrijebiti da,
primjerice, okrenete sliku kada je gledate

s prednje strane videokamere.

[Savjet]
Kada se jedinica ne upotrebljava ili se prenosi,
preporucuje se da se traZilo pomakne na polozZaj

prikazan na sljedecem dijagramu kako biste ga zastitili.

Uklanjanje trazila

Olabavite rucicu za zakljucavanje trazila
i obrnuto ponovite postupak postavljanja
trazila.

Postavljanje poklopca trazila

Otvorite metalne kopce na poklopcu trazila.

5 Postavite metalnu kopcu na vrhu

poklopca trazila na kuku na vrhu trazila
i postavite metalnu kopcu na dnu
poklopca traZila na dno trazila.

Pric¢vrsne kuke

6 Gurnite plocu za zaklju€avanje poklopca
trazila u smjeru strelice kako biste
zakljucali poklopac trazila u poloZzaj.

blokiranje

Otvaranje poklopca trazila

Povucite donju sredinu poklopca traZila prema
sebi i povucite kako biste otvorili poklopac.

[Napomenal]
Kada pomicete trazilo, drZite tijelo traZila i zatim
ga pomaknite. Nemojte drzati poklopac trazila.

Skidanje poklopca trazila

Otvorite poklopca trazila i skinite poklopac
trazila s trazila.

Postavljanje daljinskog upravljaca
na drski

[Napomenal]
Daljinski upravlja¢ na drski postavite/uklonite
dok je videokamera iskljucena.

1 Spojite kabel na priklju¢nicu daljinskog
upravljaca na drski.




21HR

2. Priprema: Postavljanje uredaja

2 Poravnajte daljinski upravlja¢ na drski
videokamere i montirajte oznaku za
postavljanje na drsku ((¥), postavite drsku
na videokameru i polako je okrenite u
smjeru suprotnom od kazaljke na satu (®).
Cut ¢ete $kljocaj kada sjedne na mjesto.
Oznaka za postavljanje

[Napomenal]

Ako ga ne moZete ispravno postaviti, ponovno ga
postavite bez primjene velike sile na daljinski upravljac
na drski ili videokameru.

3 Umetnite kabel spojen u 2. koraku ispod
proreza daljinskog upravljaca na drski
kako je prikazano na dijagramu.

[Napomena]

Ako kabel nije stavljen ispod proreza, promjena kuta
postavljanja drske moZe dovesti do toga da je na

kabel primijenjena prevelika sila ili kabel moZe zapeti u
mehanizmu okretanja.

Namjestanje kuta daljinskog upravljaca
na rucki

Mozete namjestiti kut daljinskog upravljaca
na drski u rasponu prikazanom na sljedec¢em

dijagramu kako bi odgovarao vasem stilu
snimanja.

Okrenut prema objektivu (najvise 90°)

Okrenut prema straznjoj strani (najvise 83°)

1 Pomaknite polugu za okretanje drike
u poloZaj prikazan na dijagramu i okrenite
drsku dok pritiscete polugu.

2 Maknite prst s poluge za okretanje drske
pokraj zeljenog polozaja.

3 Malo pomaknite drsku sve dok ne Cujete
Skljocaj koji oznacava da je dr3ka sjela na
mjesto.

Kada drska sjedne na mjesto, poluga za
okretanje drske vraca se u izvorni polozaj.

[Napomene]

e Nakon promjene poloZaja uvijek provjerite
je li drska sjela na mjesto.

® Ne moZete namjestiti kut izvan raspona za
namjestanje. Nemojte primjenjivati preveliku
silu tijekom okretanja drske.

Drzanje dr3ke (preporucena metoda)

Ne postoje pravila o tome kako drzati drsku,
ali sljededi primjer prikazuje kako lako rukovati
drskom.

Kada upotrebljavate gumb ASSIGN 5 ili

viSestruki bira¢
‘ @

CA B
A: Upravljajte dodjeljivim kotacicem
na drski s pomocu kaZiprsta.
B: Upravljajte visestrukim biracem
i gumbom ASSIGN 5 s pomocu palca.
C: Cvrsto drZite dréku s pomocu srednjeg
prsta, prstenjaka i malog prsta.
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Kada rukujete zumom

A: Upravljajte polugom zuma s pomocu
kaziprsta i srednjeg prsta.

B: Cvrsto drzite dréku s pomocu palca.

C: Cvrsto drzite dréku s pomocu prstenjaka
i malog prsta.

Skidanje drske

[Napomenal]
Kada skidate drsku, stavite videokameru na ravnu
povrsinu poput stola.

1 Odspojite kabel s priklju¢nice za daljinski
upravljac¢ na drski.

2 Pritisnite i drzite gumb za otpustanje
daljinskog upravljaca na drski
videokamere i okrecite drSku u smjeru
kazaljke na satu sve dok se ne odspoji.

S

Gumb za otpustanje daljinskog
upravljaca na drski

[Savjet]

Moguce je postaviti rozetu i na tocku za postavljanje

drske na jedinici i na odgovarajucu tocku za postavljanje

na drski.

Obratite se dobavljacu tvrtke Sony u pogledu pojedinosti

0 nabavi rozete.

- Na videokameri: 4-546-932- (nije obavezno)

- Na drski: 4-547-089- (nije obavezno)

- Vijci za pri¢vrséivanje*

Na videokameri: 7-627-556- (nije obavezno)
Na drski: 7-627-556- (nije obavezno)

* Za svaku rozetu potrebna su Cetiri vijka (otvori za vijak
oznaceni su krugovima na sljedecem dijagramu).
Upotreba drugih vijaka osim onih koji su navedeni
moZze dovesti do ostecenja vanjske povrsine.

videokameri

Pricvrs¢ivanje objektiva

[OPREZ]

Lecu nemojte ostaviti usmjerenu prema suncu.

Izravna sunceva svjetlost moZze prodrijeti
kroz lec¢u, fokusirati se u videokameri te
uzrokovati poZar.

[Napomene]

e Objektiv postavite/uklonite dok je videokamera
iskljucena.

e Objektiv je precizna komponenta. Objektiv nemojte
odlagati na povrsinu s elementom za montazu
objektiva okrenutim prema dolje. Postavite isporuceni
poklopac za element za montaZzu objektiva.

[Savjet]
Za detalje o objektivima koje podrzava videokamera
obratite se prodajnom predstavniku tvrtke Sony.

Postavljanje objektiva E-mount

1

Skinite poklopac objektiva s videokamere
i objektiva.

Poravnajte oznaku za montiranje objektiva
(bijelo) s videokamerom, paZljivo umetnite
objektiv i zatim objektiv okrenite u smjeru
kazaljke na satu.

Cut cete 3kljocaj kada sjedne na mjesto.

Oznake za montazu (bijele)

[Napomena]
Nemojte pritiskati tipku za otpustanje objektiva prilikom
postavljanja objektiva.

Postavljanje objektiva A-mount

Za primjenu objektiva A-mount postavite
adapter za postavljanje objektiva (u opciji)
i zatim postavite objektiv A-mount.
[Napomena]

Kada upotrebljavate objektiv A-mount, iris se postavlja
ruc¢no, a fokusiranje je postavljeno na MF.

Uklanjanje objektiva

Objektiv uklonite pratedi sljedeci postupak.

1 Pritisnite i drZite gumb za otpustanje
objektiva i okrenite objektiv u smjeru
suprotnom od kazaljke na satu dok
drZite objektiv.

2 Ravnom kretnjom izvucite objektiv.

[Napomene]

e Pri uklanjanju objektiva oznaku za postavljanje
na zabravnom prstenu na objektivu poravnajte
s oznakom za postavljanje na videokameri.

e Rukom cvrsto prihvatite objektiv kako ne bi ispao.

e Ako odmah necete postaviti drugi objektiv, obavezno
postavite poklopac kucista.

Podesavanje irisa na objektivima sa
sklopkom Auto Iris

e Kada je funkcija Auto Iris objektiva
postavljena na AUTO, iris se podesava
automatski, a moguce je i ru¢no
podesavanje na videokameri.

e Kada je funkcija Auto Iris objektiva
postavljena na MANUAL, iris je moguce
podesavati iskljucivo prstenom na objektivu.
Upravljanje irisom na videokameri ne radi.
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Podesavanje fokusa na objektivima
sa sklopkom za fokusiranje

Kada je prekida¢ fokusa na objektivu
postavljen na AF/MF ili AF, fokus se
podesava automatski, a moguce je

i ru¢no podesavanje jedinicom za daljinsko
upravljanje.

Kada je prekidac¢ fokusa na objektivu
postavljen na MF, fokus se podeSava
prstenom na objektivu, a moguce

je i ru¢no podesavanje jedinicom

za daljinsko upravljanje.

[Napomena]

Kada upotrebljavate objektiva A-mount, ru¢no
podesavanje jedinicom za daljinsko upravljanje moze
biti nedostupno.

Kada je prekidac fokusa na objektivu
postavljen na Full MF, fokus je moguce
podesavati iskljucivo prstenom na objektivu.
Upravljanje fokusom na videokameri ne radi.

Postavljanje na stativ

Za pri¢vr§cenje a stativ iskoristite otvore
za stativ na videokameri. Postavljanje
nosaca za stativ na objektiv moze
uzrokovati ostecenje.
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Konfiguriranje osnovnih radnji videokamere

Pri prvom uklju¢enju videokamere ili nakon
potpunog praznjenja rezervne baterije

na trazilu se prikazuje zaslon s pocetnim
postavkama.

Na tom zaslonu postavite datum i vrijeme
unutarnjeg sata.

Time Zone

Funkcijom Time Zone postavlja se vremenska
razlika u odnosu na UTC (koordinirano svjetsko
vrijeme). Promijenite postavku po potrebi.

Postavljanje datuma i vremena

S pomocu visestrukog biraca (stranica 7)

ili visenamjenskog kotacica (stranica 5)
odaberite stavke i postavke, zatim pritisnite
gumb za primjenu viSestrukog biraca

ili viSenamjenski kotaci¢ za primjenu
postavki i pocCetak rada sata.

Postavke datuma, vremena i vremenske
zone nakon zatvaranja zaslona s postavkama
mozete mijenjati sa Clock Set (stranica 99)

u izborniku Maintenance.

[Napomene]

e Ako zbog dugotrajnog nedostatka napajanja (bez
kompleta baterija i napajanja DC IN) dode do
potpunog praznjenja rezervne baterije i gubitka
postavki sata, pri sljede¢em pokretanju videokamere
prikazuje se zaslon s pocetnim postavkama.

e Tijekom prikaza zaslona s pocetnim postavkama
nijedna druga radnja, osim iskljucenja napajanja, nije
dopustena do dovrsetka postavki na ovom zaslonu.

e Videokamera ima ugradenu punjivu bateriju za
spremanje datuma, vremena i drugih postavki ¢ak i
kada je videokamera iskljucena.

Prije snimanja konfigurirajte osnovne radnje
videokamere na zaslonu Project status kako bi
odgovarale primjeni.

a

] Project s
Shooting M

Custom (709)

Frequency/Scan

59.94P

Imager Scan

Codec Video Forma ] tput Format

XAVC-|

Rec Fun
O

Simul Re

Title Prefix Number

000_ 0001

Nacin snimanja

Nacin snimanja mozete mijenjati izmedu
"Custom mode" za prilagodljivo stvaranje
slika na lokaciji "Cine El mode" (kada se
videokamera upotrebljava sli¢no kao filmska
kamera i materijal se razvija u postprodukciji).
Postavite nacin snimanja s pomocu funkcije
Shooting Mode (stranica 14) na zaslonu
Project status.

[Savjet]

Takoder moZete postaviti nacin snimanja s pomocu

funkcije Base Setting >Shooting Mode (stranica 77) na
izborniku Project cijelog izbornika.

Nacin Custom

U nacinu snimanja Custom moZete odabrati

standard videozapisa.

Standard videozapisa moZete postaviti

s pomocu funkcije Base Setting >Target

Display (stranica 77) u izborniku Project

cijelog izbornika.

e SDR(BT.709): Snimanje u skladu sa
standardom za HD emitiranje

e HDR(HLG): Snimanje u skladu sa standardom

sljedece generacije 4K emitiranja
Pojedinosti potrazite u poglavlju
stranica 52.

Nacin Cine El

Kada je nacin snimanja postavljen na nacin Cine
El, odaberite osnovni prostor boje za signal
snimanija i izlazni signal. Ovdje odabrani prostor
boje je prostor boje za videoizlaz kada je
funkcija MLUT isklju¢ena postavljanjem na Off.
Prostor boje mozZete postaviti s pomocu funkcije
Cine El Setting >Color Gamut (stranica 78) u
izborniku Project cijelog izbornika.

e S-Gamut3.Cine/SLog3: Jednostavno
namjestanje skale boje za digitalnu
kinematografiju (DCI-P3).

e S-Gamut3/SLog3: Siroka skala boja tvrtke Sony
koja obuhvaca prostor boje ITU-R BT.2020.

Pojedinosti potrazite u poglavlju

stranica 54.

[Napomene]
e Nacin Cine El ima sljedeca ogranicenja.
o Funkcije koje je nemoguce automatski podesavati
(pracenje)
- White balance (Pode3avanje bijele boje)
- Razina signala
- Shutter
e Funkcije koje nije moguce konfigurirati
- 1SO sensitivity/gain (postavlja se na temeljnu
ISO osjetljivost (nepromjenjivo))
- Postavke izbornika Paint/Look (bez funkcije
Base Look)
- Scene File (onemoguceno)
o Sljedece funkcije dostupne su samo u nacinu Cine El
(stranica 54).
e Exposure Index
e Monitor LUT

Frekvencija sustava

Postavite frekvenciju sustava s pomocu
funkcije Frequency/Scan (stranica 14) na
zaslonu Project status. Ovisno o odabranoj
vrijednosti, videokamera se nakon promjene
moze automatski ponovno pokrenuti.

[Savjet]

Frekvenciju sustava mozZete postaviti i s pomocu funkcije
Rec Format >Frequency (stranica 77) u izborniku

Project cijelog izbornika.

[Napomena]
Tijekom snimanja ili reprodukcije nije moguce
promijeniti frekvenciju sustava.

Imager Scan Mode

Moguce je postaviti efektivnu velicinu

slike i razlucivost slikovnog senzora.
Postavite nacin skeniranja s pomocu funkcije
Frequency/Scan (stranica 14) na zaslonu
Project status.

e FF: Veli¢ina punog kadra.

e S35: Veli¢ina Super 35mm.

[Savjet]

Nacin skeniranja mozete postaviti i s pomocu funkcije

Rec Format >Imager Scan Mode (stranica 77) u
izborniku Project cijelog izbornika.

[Napomene]

e Tijekom snimanja ili reprodukcije nije moguce
promijeniti nacin skeniranja pretraznika.

e Kada je postavljen na S35, format videozapisa
ogranicen je na 1920 x 1080.

Kodek

Postavite kodek s pomocu funkcije Codec
(stranica 14) na zaslonu Project status.

[Savjet]

Kodek mozZete postaviti i s pomocu funkcije Rec Format
>Codec (stranica 77) u izborniku Project cijelog
izbornika.

[Napomenal]
Tijekom snimanja ili reprodukcije nije moguce
promijeniti kodek.



25HR| 2. Priprema: Konfiguriranje osnovnih radnji videokamere

Format videozapisa

Moguce je postaviti format videozapisa
za snimanje. Postavite format videozapisa
s pomocu funkcije Video Format

(stranica 14) na zaslonu Project status.

[Savjet]

Format videozapisa moZete postaviti i s pomocu funkcije
Rec Format >Video Format (stranica 77) u izborniku
Project cijelog izbornika.

[Napomene]

e Tijekom snimanija ili reprodukcije nije moguce
promijeniti format videozapisa.

e Qvisno o postavci formata videozapisa, moguca su
ogranicenja signala s priklju¢nica SDI OUT i HDMI OUT.
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Upotreba memorijskih kartica

Videokamera snima zvuk i videozapise na memorijske kartice CFexpress Type A (dostupne
zasebno) ili SDXC memorijske kartice (dostupne zasebno) koje su umetnute u utore za kartice.
Memorijske kartice upotrebljavaju se i za snimanje proxyja i pohranu/ucitavanje postavki, kao
i tijekom aZuriranja (aZuriranje softvera).

O memorijskim karticama CFexpress Type A

U videokameri upotrebljavajte memorijske kartice Sony CFexpress Type A* “Preporuceni mediji”
(stranica 27).
Detalje o radu s medijima drugih proizvodaca potrazite u uputama za rad s medijem ili se

obratite proizvodacu za informacije.
* Navedene kao ,CFexpress kartice” u ovom dokumentu.

O memorijskim karticama SDXC

U videokameri upotrebljavajte memorijske kartice SDXC* “Preporuceni mediji” (stranica 27).
* Navedene kao ,SD kartice” u ovom dokumentu.
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Preporuceni mediji

Zajamceni radni uvjeti razlikuju se ovisno o postavkama za Rec Format i Recording.

Da: radnja je podrzana
Ne: normalan rad nije zajamcen

Format snimanja CFexpress SDXC
Type A

VPG400 Class10 U1 u3 VSC VSC VSC VSC
V10 V30 V60 Vo0
RAW Out & 4096 x 2160 Normalan nacin 59.94pP Da Ne Ne Ne Ne Ne Ne Da
XAVC-| Class300 50P Da Ne Ne Ne Ne Ne Ne Da
29,97P Da Ne Ne Ne Ne Ne Da Da
25P Da Ne Ne Ne Ne Ne Da Da
24p Da Ne Ne Ne Ne Ne Da Da
23,98P Da Ne Ne Ne Ne Ne Da Da
3840 x 2160 Normalan nacin 59.94P Da Ne Ne Ne Ne Ne Ne Da
Class300 50P Da Ne Ne Ne Ne Ne Ne Da
29,97P Da Ne Ne Ne Ne Ne Da Da
25P Da Ne Ne Ne Ne Ne Da Da
23,98P Da Ne Ne Ne Ne Ne Da Da
S&Q (60 fps ili manje) 59.94P Da Ne Ne Ne Ne Ne Ne Da
50P Da Ne Ne Ne Ne Ne Ne Da
29,97P Da Ne Ne Ne Ne Ne Ne Da
25P Da Ne Ne Ne Ne Ne Ne Da
23,98P Da Ne Ne Ne Ne Ne Ne Da
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Format snimanja CFexpress SDXC
Type A

VPG400 Class10 U1 U3 VSC VSC VSC VSC
V10 V30 V60 Vo0
XAVC-| 4096x2160 Normalan nacin 59.94P Da Ne Ne Ne Ne Ne Ne Da
Class300 50P Da Ne Ne Ne Ne Ne Ne Da
29,97P Da Ne Ne Ne Ne Ne Da Da
25P Da Ne Ne Ne Ne Ne Da Da
24P Da Ne Ne Ne Ne Ne Da Da
23,98P Da Ne Ne Ne Ne Ne Da Da
S&Q (60 fps ili manje) 59.94P Da Ne Ne Ne Ne Ne Ne Da
50P Da Ne Ne Ne Ne Ne Ne Da
29,97P Da Ne Ne Ne Ne Ne Ne Da
25P Da Ne Ne Ne Ne Ne Ne Da
24P Da Ne Ne Ne Ne Ne Ne Da
23,98P Da Ne Ne Ne Ne Ne Ne Da
3840 x 2160 Normalan nacin 59.94pP Da Ne Ne Ne Ne Ne Ne Da
Class300 50P Da Ne Ne Ne Ne Ne Ne Da
29,97P Da Ne Ne Ne Ne Ne Da Da
25P Da Ne Ne Ne Ne Ne Da Da
23,98P Da Ne Ne Ne Ne Ne Da Da
S&Q (60 fps ili manje) 59.94P Da Ne Ne Ne Ne Ne Ne Da
50P Da Ne Ne Ne Ne Ne Ne Da
29,97P Da Ne Ne Ne Ne Ne Ne Da
25P Da Ne Ne Ne Ne Ne Ne Da
23,98P Da Ne Ne Ne Ne Ne Ne Da
S&Q (100 fps, 120 fps) 59.94P Da Ne Ne Ne Ne Ne Ne Ne
50P Da Ne Ne Ne Ne Ne Ne Ne
29,97P Da Ne Ne Ne Ne Ne Ne Ne
25P Da Ne Ne Ne Ne Ne Ne Ne
23,98P Da Ne Ne Ne Ne Ne Ne Ne
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Format snimanja CFexpress SDXC
Type A
VPG400 Class10 U1 U3 VSC VSC VSC VSC
V10 V30 V60 Vo0
XAVC-| 1920x1080 Normalan nacin 59.94P Da Ne Ne Ne Ne Ne Da Da
Class100 50P Da Ne Ne Ne Ne Ne Da Da
29,97P Da Ne Ne Da Ne Da Da Da
25P Da Ne Ne Da Ne Da Da Da
23,98P Da Ne Ne Da Ne Da Da Da
S&Q (60 fps ili manje) 59.94pP Da Ne Ne Ne Ne Ne Da Da
50P Da Ne Ne Ne Ne Ne Da Da
29,97P Da Ne Ne Ne Ne Ne Da Da
25P Da Ne Ne Ne Ne Ne Da Da
23,98P Da Ne Ne Ne Ne Ne Da Da
S&Q (100 fps, 120 fps) 59.94P Da Ne Ne Ne Ne Ne Ne Da
50P Da Ne Ne Ne Ne Ne Ne Da
29,97P Da Ne Ne Ne Ne Ne Ne Da
25P Da Ne Ne Ne Ne Ne Ne Da
23,98P Da Ne Ne Ne Ne Ne Ne Da
S&Q (150 fps, 180 fps) 59.94pP Da Ne Ne Ne Ne Ne Ne Ne
50P Da Ne Ne Ne Ne Ne Ne Ne
29,97P Da Ne Ne Ne Ne Ne Ne Ne
25P Da Ne Ne Ne Ne Ne Ne Ne
23,98P Da Ne Ne Ne Ne Ne Ne Ne
S&Q (200 fps, 240 fps) 59.94P Da Ne Ne Ne Ne Ne Ne Ne
50P Da Ne Ne Ne Ne Ne Ne Ne
29,97P Da Ne Ne Ne Ne Ne Ne Ne
25P Da Ne Ne Ne Ne Ne Ne Ne
23,98P Da Ne Ne Ne Ne Ne Ne Ne
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Format snimanja CFexpress SDXC
Type A

VPG400 Class10 U1 U3 VSC VSC VSC VSC
V10 V30 V60 Vo0

XAVC-L 3840 x 2160 Normalan nacin 59.94P Da Ne Ne Da Ne Da Da Da
420 50P Da Ne Ne Da Ne Da Da Da
29,97P Da Ne Ne Da Ne Da Da Da

25P Da Ne Ne Da Ne Da Da Da

23,98P Da Ne Ne Da Ne Da Da Da

S&Q (60 fps ili manje) 59.94pP Da Ne Ne Da Ne Da Da Da

50P Da Ne Ne Da Ne Da Da Da

29,97P Da Ne Ne Ne Ne Ne Da Da

25P Da Ne Ne Ne Ne Ne Da Da

23,98P Da Ne Ne Ne Ne Ne Ne Da

S&Q (100 fps, 120 fps) 59.94P Da Ne Ne Ne Ne Ne Da Da

50P Da Ne Ne Ne Ne Ne Da Da

29,97P Da Ne Ne Ne Ne Ne Ne Da

25P Da Ne Ne Ne Ne Ne Ne Da

23,98P Da Ne Ne Ne Ne Ne Ne Ne

1920x1080 Normalan nacin 59.94pP Da Ne Ne Da Ne Da Da Da
HD50 50P Da Ne Ne Da Ne Da Da Da
29,97P Da Ne Ne Da Ne Da Da Da

25P Da Ne Ne Da Ne Da Da Da

23,98P Da Ne Ne Da Ne Da Da Da

S&Q (60 fps ili manje) 59.94P Da Da Da Da Da Da Da Da

50P Da Da Da Da Da Da Da Da

29,97P Da Ne Ne Da Ne Da Da Da

25P Da Ne Ne Da Ne Da Da Da

23,98P Da Ne Ne Da Ne Da Da Da

S&Q (100 fps, 120 fps) 59.94P Da Ne Ne Da Ne Da Da Da

50P Da Ne Ne Da Ne Da Da Da

29,97P Da Ne Ne Ne Ne Ne Da Da

25P Da Ne Ne Ne Ne Ne Da Da

23,98P Da Ne Ne Ne Ne Ne Da Da
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Format snimanja CFexpress SDXC
Type A

VPG400 Class10 U1 U3 VSC VSC VSC VSC
V10 V30 V60 Vo0
XAVC-L 1920x1080 S&Q (150 fps, 180 fps) 59.94P Da Ne Ne Ne Ne Ne Da Da
HD50 50P Da Ne Ne Ne Ne Ne Da Da
29,97P Da Ne Ne Ne Ne Ne Ne Da
25P Da Ne Ne Ne Ne Ne Ne Da
23,98P Da Ne Ne Ne Ne Ne Ne Da
S&Q (200 fps, 240 fps) 59.94P Da Ne Ne Ne Ne Ne Da Da
50P Da Ne Ne Ne Ne Ne Da Da
29,97P Da Ne Ne Ne Ne Ne Ne Da
25P Da Ne Ne Ne Ne Ne Ne Da
23,98P Da Ne Ne Ne Ne Ne Ne Da
1920x1080 Normalan nacin 59.94P Da Da Da Da Da Da Da Da
HD35 50P Da Da Da Da Da Da Da Da
29,97P Da Da Da Da Da Da Da Da
25P Da Da Da Da Da Da Da Da
23,98P Da Da Da Da Da Da Da Da
S&Q (60 fps ili manje) 59.94P Da Da Da Da Da Da Da Da
50P Da Da Da Da Da Da Da Da
29,97P Da Ne Ne Da Ne Da Da Da
25P Da Ne Ne Da Ne Da Da Da
23,98P Da Ne Ne Da Ne Da Da Da
S&Q (100 fps, 120 fps) 59.94P Da Ne Ne Da Ne Da Da Da
50P Da Ne Ne Da Ne Da Da Da
29,97P Da Ne Ne Da Ne Da Da Da
25P Da Ne Ne Da Ne Da Da Da
23,98P Da Ne Ne Ne Ne Ne Da Da
S&Q (150 fps, 180 fps) 59.94P Da Ne Ne Da Ne Da Da Da
50P Da Ne Ne Da Ne Da Da Da
29,97P Da Ne Ne Ne Ne Ne Da Da
25P Da Ne Ne Ne Ne Ne Da Da
23,98P Da Ne Ne Ne Ne Ne Da Da
S&Q (200 fps, 240 fps) 59.94P Da Ne Ne Da Ne Da Da Da
50P Da Ne Ne Da Ne Da Da Da
29,97P Da Ne Ne Ne Ne Ne Da Da
25P Da Ne Ne Ne Ne Ne Da Da
23,98P Da Ne Ne Ne Ne Ne Ne Da
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Umetanje memorijske kartice

1 Otvorite poklopac za medije na dijelu s
utorima za kartice.

2 Umetnite memorijsku karticu.
e Kod CFexpress kartica naljepnica je
okrenuta na lijevu stranu.

==y
/

Oznaka

e Kod SD kartica naljepnica je okrenuta
na desnu stranu s nakoSenim rubom
na dnu.
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Indikator pristupa (stranica 6) svijetli
crveno, a potom postaje zelen kada je
kartica upotrebljiva.

[Napomena]

Ako indikator pristupa neprestano treperi crveno i
ne postaje zelen, privremeno iskljucite videokameru
te skinite i ponovno umetnite memorijsku karticu.

3 Zatvorite poklopac za medije.

[Napomene]

e Memorijska kartica, utor za memorijsku karticu i
slikovne datoteke na memorijskoj kartici mogu se
oStetiti ako se kartica pogresno okrenuta prisilno
umetne u utor.

e Kada snimate na medij umetnut u oba utora AiB za
CFexpress Type A kartice / SD kartice, umetnite medij
u oba utora koja se preporucuju za rad s formatom
snimanja.

Izbacivanje memorijske kartice

Otvorite poklopac za medije na dijelu s
utorima za kartice i lagano utisnite memorijsku
karticu kako biste je izbacili.

[Napomene]

o Ako se tijekom pristupa memorijskoj kartici iskljuci
videokamera ili ukloni memorijska kartica, nije
moguce zajamciti cjelovitost podataka na kartici. Svi
podaci snimljeni na karticu mogu biti odbaceni. Prije
iskljucenja videokamere ili uklanjanja memorijske
kartice obavezno provjerite je li indikator pristupa
zelen ili iskljucen.

e Kada uklanjate memorijsku karticu odmah nakon
zavrSetka snimanja, memorijska ce kartica mozda biti
vruca, ali to ne znaci da je doslo do problema.

Formatiranje (inicijalizacija)
memorijskih kartica

Ako se umetne neformatirana memorijska
kartica ili memorijska kartica formatirana
s razlic¢itim specifikacijama, na trazilu se
prikazuje poruka za formatiranje kartice
.Media Needs to be Formatted"”.

Karticu formatirajte sljede¢im postupkom.

1 Odaberite funkciju Format Media
(stranica 86) u izborniku TC/Media
cijelog izbornika.

2 Odaberite Media(A) (utor A) ili Media(B)
(utor B), a zatim odaberite metodu

formatiranja (Full Format ili Quick Format).

Prikazuje se potvrdna poruka.

e Full Format: U potpunosti inicijalizira
medij, ukljucujudi regiju podataka i
informacije o upravljanju podacima.

e Quick Format: Inicijalizira samo podatke
o upravljanju podacima medija.

3 Odaberite Execute.
Tijekom postupka formatiranja prikazuje
se poruka, a indikator pristupa svijetli
crveno.
Po dovrSetku formatiranja prikazuje se
poruka o dovrsetku. Za odbacivanje
poruke pritisnite viSenamjenski kotacic.

[Napomene]

e Formatiranjem memorijske kartice briSu se svi podaci,

ukljucujudi snimljene podatke videozapisa i datoteke
za postavljanje.

e Tijekom izvodenja mogu se pojaviti poruke ovisno
o trajanju procesa formatiranja.

Ako je formatiranje neuspjesno

Memorijske kartice koje videokamera

ne podrzava nije moguce formatirati.
Prikazuje se poruka upozorenja. Pratite upute
kako biste karticu zamijenili podrzanom
memorijskom karticom.

Upotreba kartice SD formatirane
u videokameri u utoru drugog uredaja
Prvo napravite rezervnu kopiju kartice, a zatim

ponovno formatirajte karticu uredaju u kojem
je Zelite upotrebljavati.

Provjera preostalog vremena za
snimanje

Tijekom snimanja (snimanje/pripravnost)
moZete pratiti preostali kapacitet memorijske
kartice u svakom utoru s pomocu indikatora
preostalog medija u utoru A/B na trazilu
(stranica 11).

Preostalo vrijeme za snimanje izracunava

se iz preostalog kapaciteta medija u svakom
utoru i trenuta¢nog formata videozapisa
(brzina snimanja u bitovima), a prikazuje

se u minutama.

Vrijeme zamjene memorijske kartice

e Kada ukupno preostalo vrijeme za snimanje
na obje memorijske kartice postane krace
od 5 minuta, prikazuje se poruka ,Media
Near Full”, lampica snimanja/signalizacije
pocinje treperiti i oglasava se zvucni signal
(izlaz za slusalice) za upozorenje.
Zamijenite s medijem na kojem je dostupan
slobodan prostor.

e Ako nastavite snimati dok se ukupno
preostalo vrijeme za snimanje ne smanji
na nulu, poruka se zamjenjuje s "Media Full"
i snimanje se zaustavlja.

[Napomena]

Na jednu memorijsku karticu moguce je snimiti do oko
600 isjecaka.
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Oporavljanje memorijskih kartica

Ako zbog bilo kojeg razloga dode do pogreske
na memorijskoj kartici, kartica se prije
upotrebe mora oporaviti.

Kada ucitate memorijsku karticu koju treba
oporaviti, na zaslonu trazila prikazuje se
poruka s upitom o oporavku.

Oporavljanje kartice

Okrecite viSenamjenski kotaci¢ (stranica 5)
za odabir funkcije Execute, a potom ga
pritisnite.

Tijekom postupka formatiranja prikazuje
se poruka i status napretka (%), a indikator
pristupa svijetli crveno.

Po dovrSetku oporavka prikazuje se poruka
o dovrsetku.

Ako je oporavak neuspjesan

e Memorijske kartice na kojima je doSlo do
pogreSaka u memoriji nije moguce oporaviti.
Prikazuje se poruka upozorenja. Pratite
upute za zamjenu memorijske kartice.

e Memorijske kartice na kojima je doslo do
pogreSaka u memoriji mozda se mogu
ponovno upotrijebiti nakon ponovnog
formatiranja.

e U nekim slucajevima neke je isjecke moguce
oporaviti, a neke ne. Oporavljene isjecke
moguce je normalno reproducirati.

[Napomene]

e Medije snimljene ovom videokamerom obavezno
oporavite ovom videokamerom.

e Medije snimljene drugim uredajem ili drugom
verzijom videokamere (¢ak i istog modela) moZda se
nece moci oporaviti ovom videokamerom.

o |sjecke krace od 2 sekunde nije moguce oporaviti.
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3. Shooting

Osnovni radni postupak

Osnovno snimanje provodi se po sljede¢em
postupku.

1 Postavite potrebne uredaje i provjerite
imate li napajanje.

2 Umetnite memorijske kartice.

3 Sklopku POWER postavite u polozaj za
ukljucivanje.
Ukljucuje se indikator POWER, a u traZilu
se prikazuje slika kamere.

4 Pritisnite gumb za snimanje START/STOP
(stranica 5).
Ukljucuje se lampica snimanja/
signalizacije i zapocinje snimanje.

5 Za prekid snimanja ponovno pritisnite
gumb za snimanje START/STOP.
Snimanje se zaustavlja, a videokamera
prelazi u nacin STBY (stanje pripravnosti).

[Napomena]

Ako se gumb za snimanje START/STOP pritisne nekoliko
sekundi nakon ukljucenja videokamere, lampica
snimanja/signalizacije ukljucuje se i prikazuje kako je
jedinica u stanju za snimanje, no snimanje na medij
mozda se nece provoditi tijekom prvih nekoliko sekundi,
ovisno o odabranom formatu snimanja.

Prebacivanje izmedu memorijskih
kartica

Kada su umetnute dvije memorijske kartice,
pritisnite gumb SLOT SELECT (stranica 6)

za zamjenu kartica.

Snimanje automatski prelazi na drugu
memorijsku karticu netom prije smanjenja
preostalog kapaciteta snimanja prve kartice na
nulu (prijenosno snimanje). Kada zamijenite
memorijske kartice, kontinuirano snimanje
mozete nastaviti zamjenom pune memorijske
kartice s novom memorijskom karticom.
[Napomena]

Memorijske kartice ne moZete zamijeniti u nacinu za
reprodukciju. Takoder, kontinuirana reprodukcija isjecka
koji se nalazi na medijima u utoru A i utoru B nije
podrzana.

Isjecci (snimljeni podaci)

Kada zaustavite snimanje, videozapis,
zvucni zapis i popratni podaci od pocetka do
zavrsetka snimanja spremaju se kao jedan
Jsjecak” na memorijsku karticu.

Nazivi isjecaka

Naziv svakog snimljenog isjecka
videokamerom automatski se dodjeljuje s
pomocu formata postavljenog u funkciji Clip
Name Format (stranica 86) izbornika TC/
Media cijelog izbornika.

Maksimalno trajanje isjecka

Do Sest sati po isjecku.

Maksimalno trajanje kontinuiranog snimanje
jednako je maksimalnom trajanju isjecka.
Ako vrijeme snimanja prekoraci maksimalno
trajanje isjecka, automatski se stvara novi
isjecak i snimanje se nastavlja. Novi isjecak
na zaslonu s minijaturama prikazuje se kao
zasebni isjecak.

Tijekom prijenosnog snimanja uzastopno se
snima viSe isjecaka, no snimanje se zaustavlja
automatski nakon priblizno 24 sata.

[Napomene]

e Nemojte vaditi memorijsku karticu dok je snimanje
na nju u tijeku. Pri snimanju moZete zamijeniti samo
memorijsku karticu u utoru s isklju¢enim indikatorom
pristupa.

e Kada se preostali kapacitet memorijske kartice na koju
se snima smanji na manje od minute, a u drugom
utoru nalazi se memorijska kartica na koju je moguce
snimati, prikazuje se poruka o skoroj zamjeni utora
"Will Switch Slots Soon". Poruka se uklanja nakon
zamjene utora za memorijsku karticu.

e Prijenosno snimanje mozda nece raditi ako je
preostali kapacitet memorijske kartice maniji od
minute. Za ispravno prijenosno snimanje prije
pocetka snimanja provjerite je li preostali kapacitet
memorijske kartice veci od minute.

e Videozapise izradene funkcijom prijenosnog snimanja
videokamere nije moguce besprijekorno reproducirati
na videokameri.

e Za spajanje videozapisa izradenog funkcijom
prijenosnog snimanja videokamere upotrijebite
softver "Catalyst Browse".

Pradenje zvucnog zapisa

Snimani zvucni zapis moZete pratiti
slusalicama.

Prikljucite slusalice na priklju¢nicu za slusalice
(stranica 5) kako biste pratili snimani

zvucni zapis. Zvucni zapis reprodukcije
(stranica 64) mozZete pratiti na ugradenom
zvucniku (stranica 6) ili sa slusalicama.
Jacinu zvuka koji pratite moZete namjestiti

s pomocu funkcije Volume (stranica 14)

na zaslonu Audio Status ili putem funkcije
Audio Output >Volume (stranica 91)

u izborniku Audio cijelog izbornika.

MozZete odabrati kanal za pracenje putem
funkcije Monitor CH (stranica 14) na zaslonu
Audio Status ili putem funkcije Audio Output
>Monitor CH (stranica 91) u izborniku Audio
cijelog izbornika.

Odredivanje podataka o vremenu

Postavljanje vremenskog koda

Postavite vremenski kod za snimanje
s pomocu funkcije Timecode (stranica 85)
u izborniku TC/Media cijelog izbornika.

Postavljanje korisnickih informacija

Snimljenoj slici moZete dodati
osmeroznamenkasti heksadecimalni broj
kao korisnicke informacije. Korisnicke
informacije takoder mozete postaviti na
trenutacno vrijeme. Postavite pod Users Bit
(stranica 85) u izborniku TC/Media.

Prikaz podataka o vremenu

Vremenski kod za prikaz postavite pod
TC Display (stranica 85) >Display Select

u izborniku TC/Media.

Pritiskom jednog dodjeljivog gumba
(stranica 48) s dodijeljenom funkcijom
DURATION/TC/U-BIT zamjenjuje se prikaz
vremenskog koda, korisnickih informacija
i trajanja u nizu.

Zamjena uvoza/izvoza vremenskog
koda

Unos/izvoz vremenskog koda mozete
zamijeniti sa sklopkom za odabir TC IN/OUT
(stranica 4).

Pojedinosti potraZite u poglavlju

stranica 107.
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3. Snimanje: Osnovni radni postupak

Pregled snimke (Rec Review)

Posljednji snimljeni isjeCak moguce je
pregledati na zaslonu (pregled snimke).
[Napomena]

Funkcija Rec Review nije podrzana ako se format
videozapisa promijeni nakon snimanja isjecka.

Metoda pregleda snimke

Funkciju Rec Review unaprijed dodijelite
jednom dodjeljivom gumbu.

Po zaustavljanju snimanja pritisnite dodjeljivi
gumb (stranica 48) kojem je dodijeljena
funkcija Rec Review. Zapocinje reprodukcija
posljednjeg snimljenog isjecka.

Isjeak se reproducira do zavrsetka, funkcija
Rec Review se zaustavlja, a videokamera vraca
se u nacin STBY (stanje pripravnosti).

Zaustavljanje funkcije Rec Review

Pritisnite dodjeljivi gumb kojem je dodijeljena
funkcija Rec Review ili pritisnite gumb
CANCEL/BACK.

Postavke pregleda snimke

Pocetni poloZaj reprodukcije postavkom

za Rec Review (stranica 93) u izborniku
Technical moZete postaviti na jedan od
sljedecih.

e Posljednje tri sekunde isjecka

e Posljednjih 10 sekundi isjecka

e Pocetak isjecka

[Savjet]

Ako nakon snimanja vise isjecaka Zelite pregledati
odredeni isjecak, pritisnite gumb THUMBNAIL kako biste

prikazali zaslon s minijaturama, a zatim odaberite isjecak
za pokretanje reprodukcije.



3. Shooting

Namjestanje zuma

Zum moZete namijestiti u skladu s uvjetima
snimanja.

Kada je postavljen objektiv s elektri¢nim
zumom, zum moZzete namijestiti s pomocu
poluge zuma na svakoj strani daljinskog
upravljaca na drski ili rucki. Brzina zuma
razlikuje se ovisno o pritisku na polugu.
Videokamera je opremljena funkcijom zuma
koja upotrebljava funkciju obrade signala
slike pod nazivom Clear Image Zoom.

Kada je omogucena funkcija Clear Image
Zoom, zum je podrzan cak i kod objektiva

s fiksnom fokalnom duljinom (glavni).

MoZe se upotrebljavati i za proSirenje raspona
izvan optickog raspona na objektivu s
elektri¢nim zumom.

Maksimalan omjer zuma s pomocu funkcije
Clear Image Zoom varira ovisno o rezoluciji
snimanja.

e Zarezoluciju snimanja QFHD/4K: 1,5x

e Zarezoluciju snimanja HD: 2x

Odabir vrste zuma

Postavite vrstu zumiranja s pomocu funkcije
Zoom >Zoom Type (stranica 93) u izborniku
Technical cijelog izbornika.

Vrsta zumiranja varirat ¢e ovisno

o postavljenom objektivu.

Postavljeni Postavka vrste zumiranja
objektiv Samo Oon(Clear
optic¢ki zum Image Zoom)
Glavni objektiv / Nije podrzan Funkcija zuma
objektiv s rad zuma za jasnu sliku
ru¢nim s pomocu nije podrzana.
zumiranjem poluge.
Objektiv s Samo opticki Podrzane su
elektri¢nim zum funkcije opticki
zumom zumizum za

jasnu sliku.

[Napomene]
e Funkcija zum za jasnu sliku nije podrZzana u sljedec¢im
slucajevima.

- Kada je funkcija S&Q Motion >Frame Rate
(stranica 76) u izborniku Shooting cijelog
izbornika visa od 60 fps

- Kada je funkcija Rec Format >Codec (stranica 77)
u izborniku Project cijelog izbornika postavljena
na RAW ili na opciju koja uklju¢uje RAW

e Rad sklopke za odabir SERVO/MANUAL na objektivu
ponovno postavlja povecanje funkcije Clear Image

Zoom na 1x.

e Tijekom rada funkcije Clear Image Zoom podrucje
izoStravanja postavljeno je na Wide i funkcija Face/

Eye Detection AF je onemogucena.

Postavljanje zumiranja s pomocu rucke

Postavite postavku zumiranja ru¢kom
s pomocu funkcije Handle Zoom
(stranica 93) u izborniku Technical
cijelog izbornika.

Postavljanje smjera prstena za zum

Na nekim E-mount objektivima smjer rotacije
prstena za zum moZe biti obrnut.

Postavite smjer rotacije s pomocu funkcije
Lens >Zoom Ring Direction (stranica 94)

u izborniku Technical cijelog izbornika.
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3. Shooting

Prilagodba fokusa

Uvjetima snimanja fokus je moguce prilagoditi
automatski ili ru¢no.

Rucna prilagodba fokusa
(Manual Focus)

Za ru¢no prilagodavanje fokusa sklopku
FOCUS (stranica 4) postavite u poloZaj
"MAN".

To omogucuje rucno prilagodavanje fokusa

uvjetima snimanja.

Rucno fokusiranje korisno je za sljedece vrste

objekata.

e Objekti na udaljenoj strani prozora
prekrivenog kapljicama vode

e Objekti sa slabim kontrastom u odnosu
na pozadinu

e Objekti udaljeniji od bliskih objekata

[Savjet]

U sljedecim slucajevima moZete upotrebljavati

i automatsko fokusiranje kada je ru¢no namjestanje

u glavnom nacinu rada.

e Kada je osjetljivost na zamjenu objekta pri
automatskom fokusiranju postavljena na 1
(zaklju¢ano)

e Kada je sklopka FOCUS postavljena na polozaj ,AF”

e Priradu prstena za fokusiranje (AF Assist,
stranica 39)

Automatska prilagodba fokusa
(Auto Focus)

Videokamera primjenjuje AF otkrivanje
otklona za vrlo brzo fokusiranje te AF kontrast
za fokusiranje velike to¢nosti.

Kombinacija ove dvije metode za AF osigurava
veliku brzinu i visoku to¢nost automatskog
fokusiranja.

Za automatsko prilagodavanje fokusa sklopku
FOCUS (stranica 4) na videokameri

postavite u polozaj ,AUTO". Ako je objektiv
opremljen sklopkom za odabir fokusiranja,
postavite je u poloZaj "AF/MF" ili "AF". Ako

je sklopka postavljena u poloZzaj "Full MF" ili
"MF", fokusiranjem objektivom nije moguce
upravljati na videokameri (stranica 23).

[Savjet]

Kada je funkcija Focus >AF Assist (stranica 75)

u izborniku Shooting cijelog izbornika ukljucena s

On, tijekom automatskog fokusiranja i dalje je moguce
namjestati fokus prstenom za fokusiranje na objektivu.

[Napomene]

e Potreban je objektiv koji podrZzava automatsko
fokusiranje.

e Qvisno o uvjetima snimanja, mozda nije moguce
postici to¢nost.

o Na objektivu A-mount fokus je nemoguce podesavati
automatski.

Postavljanje podrucja/polozaj
automatskog fokusiranja (Focus Area)

MoZete postaviti ciljno podrucje za
automatsko fokusiranje s pomocu funkcije
Focus >Focus Area (stranica 75) u izborniku
Shooting cijelog izbornika.

Fleksibilni spot:

fokusiranje u odredenu tocku na slici.

Kada je odabrana, odredite polozaj s pomocu
viSestrukog biraca (stranica 7).

Mozete se vratiti u sredisnji polozaj pritiskom
i drzanjem visestrukog biraca.

AF
r A
L J
Zone:

automatski pretrazuje polozaj za fokusiranje
unutar odredene zone.

Kada je odabrana, odredite polozaj s pomocu
viSestrukog biraca (stranica 7).

Mozete se vratiti u sredisnji polozaj pritiskom
i drzanjem visestrukog biraca.

AF
r i
L .l
Siroko:

pri fokusiranju trazi objekt kroz Siroki kut slike.

Okvir se ne prikazuje.

AF

[Savjet]

Istu radnju podrzava dodjeljivi gumb (stranica 48)
kojem je dodijeljena funkcija Focus Area.

MozZete prikazati/sakriti okvir podrucja fokusiranja s
pomocu funkcije Display On/Off >Focus Area Indicator
(stranica 87) u izborniku Monitoring cijelog izbornika.

[Napomene]

e Okvir podrucja fokusiranja nije sakriven kada
primjenjujete gumb DISPLAY.

e Podrucje fokusiranja postavljeno je na Wide tijekom
rada funkcije zuma za jasnu sliku.

Brza promjena podrucja fokusiranja
(Focus Setting)

PoloZaj i velic¢inu podrucja automatskog
fokusiranja tijekom snimanja moguce je brzo
promijeniti dodjelom funkcije Focus Setting
jednom od dodijeljivih gumba (stranica 48).
Radnja se razlikuje ovisno o postavci podrucja
fokusiranja.

Kada je funkcija Focus >Focus Area
(stranica 75) u izborniku Shooting cijelog

izbornika postavljena na Flexible Spot ili Zone
PoloZaj podrucja fokusiranja mijenja

se pritiskom dodjeljivog gumba kojemu

je dodijeljena funkcija Focus Setting

i namjeStanjem s pomocu visestrukog

biraca (stranica 7).

MozZete vratiti polozZaj podrucja fokusiranja

u sredisnji polozaj namjestanjem poloZaja
pritiskom visestrukog biraca.

Veli¢ina podrucja fokusiranja mijenja se
pritiskanjem i zadrzavanjem dodjeljivog
gumba kojem je dodijeljena funkcija Focus
Setting.

Nakon promjene veli¢ine postavite podrucje
fokusiranja pritiskom visestrukog biraca.
Nakon dovrsetka pritisnite dodjeljivi gumb

s funkcijom Focus Setting kako biste se vratili
na pocetni zaslon.
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3. Snimanje: Prilagodba fokusa

Kada je funkcija Focus >Focus Area
(stranica 75) u izborniku Shooting cijelog

izbornika postavljena na Wide

Velic¢inu podru¢ja fokusiranja moguce
promijeniti samo pritiskanjem i zadrZzavanjem
dodjeljivog gumba kojem je dodijeljena
funkcija Focus Setting. PoloZaj je takoder
moguce promijeniti tako da najprije vrstu
promijenite iz Flexible Spot u Zone.

[Savjeti]

e Kada je funkcija Focus >Push AF Mode (stranica 75)
u izborniku Shooting cijelog izbornika postavljena
na Single-shot AF(AF-S) i sklopka FOCUS
(stranica 4) je u polozaju MF, moZete promijeniti
poloZaj podrucja fokusiranja Focus Area(AF-S)
(stranica 75).

e Kada upotrebljavate funkciju zuma za jasnu sliku,

postavka veli¢ine podrucja fokusiranja onemogucena

je i aktivira se rad funkcije automatskog fokusiranja

s prioritetom na sredisnji poloZaj.

Okvir podrucja fokusiranja prikazan je narancastom

bojom kada se podrucje fokusiranja moze promijeniti.

Pomicanje okvira podrucja fokusiranja
s pomocu rada dodirom (dodir podrucja
fokusiranja)

PoloZaj podrucja fokusiranja mozete
promijeniti pritiskom dodjeljivog gumba
(stranica 48) kojemu je dodijeljena funkcija
Focus Setting kako biste promijenili prikaz
podrucja fokusiranja na narancastu boju

i zatim ga moZete pomicati s pomocu rada
dodirom.

Dodirnite zaslon za pomicanje podrucja
fokusiranja tako da je podrucje fokusiranja
centrirano na poloZaj koji ste dodirnuli.
Povucite po zaslonu kako biste pomaknuli
podrucje fokusiranja u poloZaj koji pratite
prstom (stranica 10).

[Savjet]

Rad fokusiranja dodirom moZete omoguciti/

onemoguciti na zaslonu snimanja s pomocu dodjeljivog
gumba kojemu je dodijeljena funkcija Focus Setting.

Dodirnite bilo koji poloZaj

U

Podrucje fokusiranja se pomice, a podrucje
fokusiranja centrirano je na dodirnuti
polozaj.

U

Povucite za pomicanje podrucja
fokusiranja, prateci polozaj prsta

e

[Napomene]
e Ako dodirnete polozaj ili povucete podrucje

fokusiranja u polozaj koji premasuje raspon postavke,

podrucje fokusiranja postavlja se na gornji/donji/
lijevi/desni rub raspona fokusiranja.
e Ova funkcija ne radi u sljede¢im okolnostima.

- Kada je funkcija Touch Operation (stranica 93)
u izborniku Technical cijelog izbornika postavljena
na Off

- Kada je podrucje fokusiranja prikazano sivom
bojom ili se uopce ne prikazuje

Namjestanje funkcije Auto Focus Action
(brzina prijelaza pri automatskom
fokusiranju, osjetljivost na zamjenu
objekta pri automatskom fokusiranju)

Brzina prijelaza pri automatskom fokusiranju
Brzinu otvora fokusiranja kada se objekt
mijenja mozete postaviti s pomocu funkcije
Focus >AF Transition Speed (stranica 75)

u izborniku Shooting cijelog izbornika.

Kada je postavljen na nisku brzinu, fokus

se polako pomice kada se fokusirani

objekt mijenja, $to omogucuje snimanje
dojmljivih slika.

Kada je postavljen na visoku brzinu, fokus se
brzo mijenja izmedu objekata. Objekt koji ude
u kadar trenutacno se fokusira, $to postavku
¢ini idealnom za dokumentaristi¢ko snimanje
koje zahtijeva brzo fokusiranje.

Fokusiranje na udaljeni objekt

\V

[

Tijekom promjene:
1(sporo): Fokusiranje se
provodi sporo

7(brzo): Fokusiranje se
provodi brzo

Fokusiranje na bliski objekt

A 4 4

Fl
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3. Snimanje: Prilagodba fokusa

AF osjetljivost na zamjenu objekta
Osjetljivost za zamjenu objekata moZete
postaviti s Focus >AF Subj. Shift Sens.
(stranica 75) u izborniku Shooting cijelog
izbornika.

Kada je postavljena na malu osjetljivost,
fokus se ne mijenja lako ¢ak ni kada se ispred
fokusiranog objekta pomakne drugi objekt.
Kada je postavljena na veliku osjetljivost, fokus
se mijenja i dodjeljuje prioritet objektu koji
se pomice ispred.

[Savjet]

Ako je funkcija AF Speed/Sens. dodijeljena dodjeljivom
gumbu, stupci razine za namjestanje vrijednosti
prikazuju se sljede¢im redoslijedom svaki put kada
pritisnete gumb zbog ¢ega mozete promijeniti
postavke brzine prijelaza pri automatskom fokusiranju
i osjetljivosti na zamjenu objekta pri automatskom
fokusiranju.

Brzina prijelaza pri automatskom fokusiranju —
Osjetljivost na zamjenu objekta pri automatskom
fokusiranju — Bez prikaza...

AF Subj. Shift Sens.: 1 (zaklju¢ano)

[mmm

Sporo premjestanje fokusa na drugi objekt

AF Subj. Shift Sens.: 5(osjetljivo)

i

Brzo premjestanje fokusa na drugi objekt

Rucna promjena mete fokusiranja
(AF Assist)

Kada je funkcija Focus >AF Assist

(stranica 75) u izborniku Shooting cijelog

izbornika ukljucena s On, tijekom automatskog

fokusiranja i dalje je moguce namjestati

fokus na objekt.

Kada prestanete upotrebljavati rad prstena za

fokusiranje, funkcija automatskog fokusiranja

i dalje fokusira na objekt s pomocu prstena

za fokusiranje (stanje AF Assist).

Nakon upravljanja prstenom za fokusiranje,

pomicanje fokusa na drugi objekt malo je teze,

bez obzira na postavku Focus >AF Subj. Shift

Sens. (stranica 75) u izborniku Shooting

cijelog izbornika.

Stanje AF Assist prekida se kada dode do

sliedecegq:

e Kada objekt koji je fokusiran s pomocu
prstena za fokusiranje vise nije vidljiv

e Pri prebacivanju na ru¢no fokusiranje

e Kada je otkriveno lice

[Savjeti]

e Stanje AF Assist moZe se otkazati upotrebom
dodjeljivog gumba (stranica 48) kojemu je
dodijeljena funkcija Push AF/Push MF.

e Upravljanjem prstenom za fokusiranje Cisti se odabir
registriranog lica.

e U nacinu Face/Eye Only AF automatsko fokusiranje
fokusira se na lice najbliZze polozaju fokusiranja
prstena za fokusiranje.
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3. Snimanje: Prilagodba fokusa

Privremena primjena rucnog
fokusiranja (Push Manual Focus)

U nacinu za automatsko fokusiranje pritisnite
gumb PUSH AUTO FOCUS (stranica 4) kako

biste uz pritisnut gumb mogli ru¢no fokusirati.

Po otpustanju gumba fokusiranje se vraca na
automatsko.

To omogucuje priviemeno zaustavljanje
automatskog fokusiranja te ru¢no fokusiranje
kada nesto Sto nije objekt prode ispred
objekta.

[Savjet]

Istu radnju podrzava dodjeljivi gumb (stranica 48)
kojem je dodijeljena funkcija Push AF/Push MF.

Priviemena primjena
automatskog fokusiranja (Push
Auto Focus)

Upotreba automatskog fokusiranja
za pojedinacno snimanje (Push
Auto Focus (AF-S))

Kada je nacin Focus >Push AF mode
(stranica 75) u izborniku Shooting cijelog
izbornika postavljen na AF, za automatsko
fokusiranje u nacinu ru¢nog fokusiranja
pritisnite gumb PUSH AUTO FOCUS
(stranica 4).

Do fokusiranja dolazi unutar podrucja
fokusiranja postavljenog s pomocu funkcije
Focus >Focus Area (stranica 75) u izborniku
Shooting cijelog izbornika.

Po otpustanju gumba fokusiranje se vraca na
ru¢no.

To je prakti¢no kada tijekom ru¢nog
fokusiranja fokus Zelite polako pomaknuti s
jednog objekta na drugi.

[Savjet]

Istu radnju podrzava dodjeljivi gumb (stranica 48)
kojem je dodijeljena funkcija Push AF/Push MF.

[Napomena]
Funkcija Push Auto Focus ne radi ako je objektiv
postavljen na ruc¢no fokusiranje.

Postavite funkciju Focus >Push AF Mode
(stranica 75) u izborniku Shooting
cijelog izbornika na Single-shot AF(AF-S),
zatim postavite podrucje fokusiranja s
pomocu funkcije Focus >Focus Area(AF-S)
(stranica 75) u izborniku Shooting cijelog
izbornika.
U nacinu za ruc¢no fokusiranje pritisnite gumb
PUSH AUTO FOCUS kako biste automatski
fokusirali velikom brzinom. Fokusiranje se
prekida po otpustanju gumba.
Status fokusiranja prikazuje indikator
fokusiranja.
e Ukljuceno: fokus je nepromjenjiv u polozZaju
fokusiranja.
e Treperi: izvan fokusa. Buduci da fokusiranje
nije automatsko, promijenite kompoziciju
i postavke fokusiranja kako biste postigli
fokus.
Po otpustanju gumba fokusiranje se vraca
na ruc¢no.
To je prakti¢no kada prije pocetka snimanja
Zelite brzo fokusirati objekt.
[Savjeti]
e |stu radnju podrzava dodjeljivi gumb (stranica 48)
kojem je dodijeljena funkcija Push AF/Push MF.
e Funkciju Push AF Mode moZete dodijeliti i dodjeljivom
gumbu (stranica 48).
e Funkciju Focus Area(AF-S) takoder moZete dodijeliti
i dodjeljivom gumbu (stranica 48).
e MozZete prikazati/sakriti okvir podrucja fokusiranja
s pomocu funkcije Display On/Off >Focus Area Ind.
(AF-S) (stranica 87) u izborniku Monitoring cijelog
izbornika.

e Tijekom povecavanja fokus se prilagodava
povecanom dijelu zaslona.

[Napomene]

e Funkcija Push Auto Focus ne radi ako je objektiv
postavljen na ru¢no fokusiranje.

e Okvir podrucja fokusiranja nije sakriven
kada primjenjujete gumb DISPLAY.

Fokusiranje s povecanim
pregledom (Focus Magnifier)

Po tvornic¢kim postavkama funkcija Focus
Magnifier x3/x6 dodijeljena je gumbu ASSIGN
4 na daljinskom upravljacu na drski i gumbu
ASSIGN 7 na rucki (stranica 48).

Pritisnite gumb ASSIGN 4 ili gumb ASSIGN

7 za prebacivanje trazila na zaslon povecanja
za fokusiranje, pri ¢emu je sredina povecana
otprilike tri puta. Ponovno pritisnite gumb
kako biste povecanje povecali na priblizno
Sest puta. Funkcija je prakti¢na pri provjeri
fokusa.

Ponovno pritisnite gumb za povratak

na normalan zaslon.

MoZete pomicati polozaj koji Zelite povecati
tijekom povecanja fokusiranja s pomocu
viSestrukog biraca (stranica 7). Pritiskom
viSestrukog biraca vracate se na sredinu slike.
Kada se tijekom povecanja fokusiranja
upotrebljava funkcija Push Auto Focus (AF), do
fokusiranja dolazi unutar podrucja fokusiranja
postavljenog s pomocu funkcije Focus >Focus
Area (stranica 75) u izborniku Shooting

cijelog izbornika.

Ako tijekom povecanja za fokusiranje
pritisnete automatsko fokusiranje (AF),
fokusiranje se prilagodava povecanom
polozaju zaslona.

[Napomene]

e Snimana slika ili slika koja se izvozi priklju¢kom SDI/

HDMI nije povecana pri povecanju fokusa.

Tijekom povecanja fokusa onemoguceni su gumb

MENU i druge radnje.

e Priisklju¢enju videokamere povecani poloZaj vraca se
u sredinu zaslona.
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3. Snimanje: Prilagodba fokusa

Fokusiranje s pomocu funkcije
otkrivanja lica i oka (Face/Eye
Detection AF)

Videokamera moZe otkriti lica i oci ljudi i zatim
namjestiti fokus na lica i oci u okviru podrucja
fokusiranja.

Ova je funkcija dostupna samo kada je
prilagodba fokusa u nacinu AF ili tijekom
automatskog fokusiranja pritiskanjem.

Kada se otkriju lica, prikazuju se sivi okviri
otkrivanja lica/oka. Kada je moguce
automatsko fokusiranje, okviri postaju bijeli.
Kada su otkrivene oci i fokus je namjesten,

okvir otkrivanja lica/oka prikazuje se na o¢ima.

Kada se otkrije viSe pojedinaca, glavni objekt
odreduje se automatski.

[Savjeti]

e Kada je podrucje fokusiranja postavljeno na Zone ili
Flexible Spot i lica ili o¢i preklapaju se s odredenim
podrucjem fokusiranja, okviri otkrivanja lica/oka

postaju bijeli, a videokamera se fokusira na ta lica/oci.

e Kada se primjenjuje automatsko fokusiranje
pritiskanjem (AF-S), okviri otkrivanja lica/oka na
fokusiranim licima postaju zeleni.

Postavite radnju Face/Eye Detection AF
s pomocu funkcije Focus >Face/Eye Detection
AF (stranica 75) u izborniku Shooting.

Face/Eye Only AF:

Kamera otkriva lica/oci objekata (ljudi)

i fokusira samo njihova lica/o¢i. Dok lice

ili oko nije otkriveno, AF se priviemeno
zaustavlja (MF) i prikazuje se ikona pauziranja
automatskog fokusiranja za nacin Face/

Eye Only AF [ (stranica 11). Ovaj nacin

se primjenjuje samo kada Zelite automatski
fokusirati iskljucivo lica/o¢i.

Face/Eye Priority AF:

Kamera otkriva lica/oci objekata (ljudi) i
dodjeljuje prioritet fokusiranju samo njihovih
lica/ociju. Kada lice ili oci nisu otkriveni,
fokusiranje je u nacinu AF (zadana postavka).

Isklju¢eno:
Funkcija Face/Eye Detection AF je
onemogucena.

[Napomene]

e Tijekom rada funkcije automatskog fokusiranja
pritiskanjem funkcija Face/Eye Priority AF aktivirana
je cak i ako je trenutacno odabrana funkcija Face/Eye
Only AF.

e Kada je sklopka FOCUS postavljena na MAN,
automatsko fokusiranje s otkrivanjem lica/oka
onemoguceno je (osim tijekom rada automatskog
fokusiranja pritiskanjem).

e Ako iskljucite videokameru dok je odabrana
funkcija Face/Eye Only AF, pri sljiedecem ukljucenju
videokamere nacin automatski prelazi na Face/Eye
Priority AF.

e Funkcija Face/eye AF nije podrzana tijekom rada
funkcije zuma za jasnu sliku. Aktivirana je funkcija
Normal AF.

Skrivanje okvira otkrivanja lica/oka

MoZete prikazati/sakriti okvire otkrivanja
lica/oka s pomocu funkcije Display On/Off
>Face/Eye Detection Frame (stranica 87)
u izborniku Monitoring cijelog izbornika.

[Napomenal]

Zeleni okviri otkrivanja lica/oka prikazuju se za lica

i oci koji su u fokusu s pomocu funkcije automatskog
fokusiranja pritiskanjem (AF-S) i nisu skriveni s pomocu
gumba DISPLAY ili kada je funkcija Face/Eye Detection
Frame postavljena na Off.

Fokusiranje na registrirano lice

Tijekom rada funkcije automatskog fokusiranja
s otkrivanjem lica/oka za objekt (osobu)
moguce je registrirati lice za fokusiranje.
Moguce je registrirati samo jedno lice.
Registriranjem lica prebrisuje se postojeca
registracija.

Kada je lice registrirano, okvir otkrivanja
lica/oka mijenja se u dvostruki okvir (okvir
registriranog lica) i prikazuje se ikona
registriranog lica (stranica 11).

Ovisno o kombinaciji registriranog lica

i radnog nacina automatskog fokusiranja

s otkrivanjem lica/oka, u nac¢inu automatskog
fokusiranja s otkrivanjem lica provode

se sljedece radnje.

U nacinu Face/Eye Priority AF:

Ako kamera otkrije registrirano lice, kamera
fokusira to lice. Ako registrirano lice nije otkriveno,
aktivira se automatsko fokusiranje s otkrivanjem
lica.

U nacinu Face/Eye Only AF:

Ako kamera otkrije samo registrirano lice,
kamera fokusira to lice/oko. Dok registrirano
lice nije otkriveno, AF se privremeno
zaustavlja (MF) i prikazuje se ikona pauziranja
automatskog fokusiranja za nacin Face/

Eye Only AF [T (stranica 11). Ovaj nacin

se primjenjuje samo kada Zelite automatski
fokusirati registriranu osobu.

Postavljanje registriranog lica
Pomaknite pokazivac za odabir lica
(narancasta crta) na lice koje Zelite registrirati
s pomocu viSestrukog biraca (stranica 7)
i pritisnite viSestruki birac.

Drugi okviri otkrivanja lica/oka

(sivo)

Okvir
registriranog
H_ lica (dvostruki
s bijeli okvir)

Pokazivac¢ za odabir lica
(narancasti)

Brisanje registriranog lica

Pomaknite pokazivac za odabir lica na
registrirano lice s pomocu visestrukog biraca
(stranica 7) i pritisnite viSestruki birac.
Registrirano lice je izbrisano, okvir otkrivanja
lica/oka postaje jedan okvir, a ikona
registriranog lica uklanja se.

Kada se otkrivaju lica/oci bez prikaza okvira
registriranog lica i pokazivaca za odabir lica
(narancasto), registrirano lice moZe se izbrisati
s dva pritiska viSestrukog biraca.

[Napomene]

e U nacinu AF Assist (stranica 39) odabir registriranog
lica je ociscen.

e Pri upotrebi funkcije zuma za jasnu sliku, nije moguce
upotrebljavati funkciju Face/Eye Detection AF.

e QOvisno o okruZenju snimanja, stanju objekta ili
postavkama, otkrivanje lica/oka moZe biti nemoguce.

e U nekim okruZenjima snimanja moZda necete dobiti
odgovarajudi ucinak ili se drugi objekti mogu otkrivati kao
ljudska lica. U tom slucaju funkciju automatskog fokusiranja
s otkrivanjem lica/oka iskljucite postavljanjem na Off.

e Preporucuje se prije snimanja registrirati lice
pojedinca kojeg Zelite fokusirati.

e Qvisno o frizuri, ukrasima lica, ili ako nije usmjereno izravno
u kameru, registracija lica moZze biti neuspjesna. U tom
slucaju okvir otkrivanja lica/oka moZze se udvostruciti, no ne
prikazuje se ikona registriranog lica i lice nije registrirano.

e Ako je lice vec bilo registrirano, preporucuje se
izbrisati postojece lice i tada registrirati novo lice.

Zamjena rada funkcije automatskog
fokusiranja s otkrivanjem lica/oka s
dodjeljivim gumbom

Funkciju Face/Eye Detection AF dodijelite
dodjeljivom gumbu (stranica 48). Zatim
moZete prebaciti rad funkcije automatskog
fokusiranja s otkrivanjem lica/oka
redoslijedom Face/Eye Priority Af, Face/Eye
Only AF i Off svaki put kada pritisnete gumb.

Postavljanje u izravhom izborniku

Rad funkcije automatskog fokusiranja
s otkrivanjem lica/oka moZete postaviti
i uizravnom izborniku (stranica 48).
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Podesavanje svjetline
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Svjetlinu mozZete prilagoditi podeSavanjem
irisa, razine signala, brzine zatvaraca

i podesavanjem razine svjetline filtrima ND.
Podesavanja je takoder moguce provesti
automatski.

Ciljna razina za automatsko namjestanje
svjetline postavljena je s pomocu funkcije
Auto Exposure (stranica 73) >Level u
izborniku Shooting cijelog izbornika. Funkciju
Auto Exposure Level takoder moZete dodijeliti
dodjeljivom gumbu ili dodjeljivom kotacic¢u
(stranica 48).

[Napomena]

Razinu signala nije moguce podesavati u nacinu Cine
El. Temeljna osjetljivost je fiksna. Takoder, svjetlinu nije
moguce automatski podesavati brzinom zatvaraca.
Automatsko podesavanje svjetline s iris i filtrom ND

je podrzano.

Odabir temeljne osjetljivosti

MoZete birati izmedu dvije vrste temeljne
osjetljivosti na videokameri.

U nacinu Custom mozZete postaviti temeljnu
osjetljivost na High ili Low s pomocu funkcije
Base ISO/Sensitivity na zaslonu Main Status
(stranica 13) ili zaslonu Camera Status
(stranica 14) ili funkciju ISO/Gain/El>Base
Sensitivity (stranica 72) u izborniku

Shooting cijelog izbornika.

U nacinu Cine El moZete postaviti temeljni ISO
na IS0 12800 ili ISO 800 s pomocu funkcije
Base ISO/Sensitivity na zaslonu Main Status
(stranica 13) ili zaslonu Camera Status
(stranica 14) ili funkciju ISO/Gain/El>Base

ISO (stranica 72) u izborniku Shooting

cijelog izbornika.

Preporucuje se odabir Low ili ISO 800 tijekom
uvjeta normalne osvijetljenosti i odabir High ili
ISO 12800 u uvjetima slabije osvijetljenosti.

* Moze se konfigurirati i na zaslonu statusa.

[Savjet]
Funkciju Base ISO/Sensitivity moZete dodijeliti i
dodjeljivom gumbu (stranica 48).

PodeSavanije irisa

Podesavanjem irisa moZete prilagoditi
svjetlinu.

Automatsko podeSavanje irisa

Ova funkcija podesava svjetlinu prema

objektu. Potreban je objektiv koji podrzava iris.

1 Ako je postavljen objektiv s funkcijom
Auto Iris, sklopku postavite na AUTO.

2 Pritisnite i zadrZite gumb funkcije IRIS (E)
kako biste prikazali izravni izbornik
(stranica 48) te odaberite Auto.

[Savjet]
Funkciju Auto Iris takoder moZete dodijeliti
dodjeljivom gumbu (stranica 48).

[Napomena]
Na objektivu A-mount iris je nemoguce
podesavati automatski.

Rucno podesavanje irisa

1 Pritisnite i zadrzite gumb funkcije IRIS (E)
kako biste prikazali izravni izbornik
(stranica 48) te odaberite Manual.

2 Pritisnite gumb funkcije IRIS (E) kako biste
vrijednost irisa prikazali na bijeloj
pozadini.

3 Okrecite viSenamjenski kotaci¢ kako biste
podesili vrijednost.

[Savjeti]

e ViSenamjenski kotaci¢ takoder mozZete
primjenjivati kao kotacic¢ za IRIS (stranica 48)
dodjelom funkcije IRIS viSenamjenskom
kotacicu.

e Funkciju IRIS takoder moZete dodijeliti
dodjeljivom kotacic¢u (stranica 48).

Privremeno automatsko podesavanje

Pritisnite dodjeljivi gumb (stranica 48)
kojemu je dodijeljena funkcija Push Auto
Iris za privremeno automatsko namjestanje
irisa dok je gumb pritisnut.

Po otpustanju gumba iris se vraca

na prethodnu postavku.

[Napomenal]

Kada je sklopka za Auto Iris postavljena na MANUAL,
funkcije videokamere Auto Iris i Push Auto Iris nemaju
ucinak. Ru¢no podesavanje irisa na videokameri nema
ucinak.

Podesavanje razine signala

U ru¢nom nacinu rada Custom podesavanjem
jacine signala moZete prilagoditi svjetlinu.

Automatsko podesavanje jacine signala

Pritisnite i zadrzite gumb funkcije 1ISO/

GAIN (H) kako biste prikazali izravni izbornik

(stranica 48) te odaberite Auto.

[Savjeti]

e |stu radnju moZete provesti u izborniku Shooting
uklju¢enjem funkcije Auto Exposure (stranica 73)
>AGC postavljanjem na On.

e Funkciju AGC takoder moZete dodijeliti dodjeljivom
gumbu (stranica 48).

Rucno podesavanje jacine signala

Jacinom signala moZete upravljati kada

Zelite podesiti ekspoziciju uz fiksnu postavku
ekspozicije ili kada Zelite sprijeciti porast jacine
signala zbog funkcije AGC.

1 Pritisnite i zadrzite gumb funkcije 1ISO/
GAIN (H) kako biste prikazali izravni
izbornik (stranica 48) te odaberite
Manual.

2 Prekidac za ISO/GAIN (1) postavite na H,
M ili L.

[Savjeti]

e Funkciju Push AGC takoder moZete dodijeliti
dodjeljivom gumbu, a funkciju AGC privremeno
postaviti na On pritiskom i zadrZzavanjem gumba.

e MozZete promijeniti unaprijed postavljenu vrijednost
poloZaja svake sklopke s pomocu funkcije 1SO /
Gain<L>/<M>/<H> (stranica 14) na zaslonu Camera
Status ili funkcije ISO/Gain/El >ISO/Gain<H>/<M>/<L>
(stranica 72) u izborniku Shooting cijelog izbornika.
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Upravljanje jaCinom signala (precizno
podesavanje)

1 Pritisnite gumb funkcije ISO/GAIN (H) kako
biste vrijednost jacine signala prikazali na
bijeloj pozadini.

2 Okrecdite viSenamjenski kotacic¢ kako biste
podesili vrijednost.
[Savjet]

Promijenite tvornicki zadanu vrijednost jacine signala
prema postavci sklopke ISO/GAIN ().

Privremeno upravljanje jainom signala
(precizno podesavanje)

Okrecite dodjeljivi kotacic (stranica 48)

kojemu je dodijeljena funkcija ISO/Gain/El

kako biste namjestili vrijednost jacine signala

postavljenu sklopkom ISO/GAIN (1).

To je prakti¢no kada Zelite podesiti ekspoziciju

za jedan korak bez promjene dubine polja.

Namjestena vrijednost jaCine signala prekida

se uklopom sklopke ISO/GAIN (1), promjenom

temeljne osjetljivosti, ukljucenjem funkcije

AGC postavljanjem na On ili isklju¢enjem

napajanja.

[Savjeti]

e Ovu funkciju takoder mozete dodijeliti
viSenamjenskom kotacicu (stranica 48).

e Funkciju Push AGC takoder mozete dodijeliti

dodjeljivom gumbu, a funkciju AGC privremeno
postaviti na On pritiskom i zadrZavanjem gumba.

PodeSavanje razine ekspozicije

Podesavanje zatvaraca

PodeSavanije razine svjetline (filtar ND)

U nacinu Cine El pretpostavlja se kako se
video ulaz s funkcijom MLUT isklju¢enom

s Off snima kao glavni signal. Promjenom
svjetline slike s funkcijom MLUT uklju¢enom
s on za podudaranje s vrijednosti El, rezultat
postprodukcijskog podeSavanja osjetljivosti
ekspozicije moZe se provjeriti tijekom
snimanja.

Vrijednost El moZete promijeniti postavljanjem
sklopke ISO/GAIN (I) na H, M ili L.

[Savjet]

MoZete promijeniti unaprijed postavljenu vrijednost
El svake sklopke s pomocu funkcije ISO/Gain/

El (stranica 14) na zaslonu Camera Status ili

funkcije ISO/Gain/El >Exposure Index<H>/<M>/<L>
(stranica 72) u izborniku Shooting cijelog izbornika.

Precizno podesavanje razine ekspozicije

1 Pritisnite gumb funkcije ISO/GAIN (H) kako
biste vrijednost El prikazali na bijeloj
pozadini.

2 Okrecdite viSenamjenski kotacic¢ kako biste
podesili vrijednost.
[Savjet]

Promijenite tvornicki zadanu vrijednost El prema
postavci sklopke ISO/GAIN (1).

PodeSavanjem zatvaraa moZete prilagoditi
svjetlinu.

Automatsko podesavanje zatvaraca

Pritisnite i zadrZite gumb funkcije SHUTTER (F)
za prikaz izravnog izbornika (stranica 48)

i odaberite Auto kako biste brzinu zatvaraca ili
kut zatvaraca automatski odzivno namjestali
prema svjetlini slike.

[Savjet]

Istu radnju mozZete provesti u izborniku Shooting cijelog

izbornika uklju¢enjem funkcije Auto Exposure >Auto
Shutter (stranica 74) postavljanjem na On.

Rucno podesavanje zatvaraca

1 Pritisnite i zadrZite gumb funkcije
SHUTTER (F) kako biste prikazali izravni
izbornik (stranica 48) te odaberite
Speed ili Angle.

2 Pritisnite gumb funkcije SHUTTER (F) kako
biste vrijednost zatvaraca prikazali na
bijeloj pozadini.

3 Okrecite viSenamjenski kotaci¢ kako biste
podesili brzinu zatvaraca.

[Savjeti]

e Za podeSavanje vremena ekspozicije prema intervalu
kadra odaberite Off u 1. koraku.

e Takoder moZete postaviti kut te podesiti frekvenciju
(stranica 72).

U uvjetima u kojima je svjetlo prejako,
odgovarajudi svjetlinu moZete postaviti
promjenom filtra ND.

Videokamera ima dva nacina za filtre ND. Dva
nacina moZete mijenjati sklopkom ND PRESET/
VARIABLE.

PodeSavanje u tvornicki postavljenom
nacinu

Sklopku ND PRESET/VARIABLE (A) postavite
u polozaj PRESET, a gumbe gore/dolje funkcije
ND FILTER POSITION (B) na jednu od sljedecih
postavki.

Clear: bez filtra ND

1: Prozirnost postavljena funkcijom ND Filter
>Preset1 (stranica 72) u izborniku Shooting
cijelog izbornika.

2: Prozirnost postavljena funkcijom ND Filter
>Preset2 (stranica 72) u izborniku Shooting
cijelog izbornika.

3: Prozirnost postavljena funkcijom ND Filter
>Preset3 (stranica 72) u izborniku Shooting
cijelog izbornika.

Podesavanije u varijabilnom nacinu

Sklopku ND PRESET/VARIABLE (A) postavite
u poloZaj VARIABLE. Gumbe gore/dolje (B)
funkcije ND FILTER POSITION preklapaijte
izmedu CLEAR i On.

Automatsko podesavanije razine svjetline
Filtar Auto ND Filter moZete ukljuciti
postavljanjem na On kako biste omogucili
automatsko podesavanje ekspozicije filtrom
ND.

1 Pritisnite gumb [+] medu gumbima gore/
dolje (B) za ND FILTER POSITION kako biste
ukljucili filtar ND.
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2 Pritisnite i zadrZite gumb (C) za ND
VARIABLE AUTO dok ne odaberete Auto.

Rucno podesavanje razine svjetline

1 Pritisnite gumb [+] medu gumbima gore/
dolje (B) za ND FILTER POSITION kako biste
ukljucili filtar ND.

2 Pritisnite i zadrzite gumb (C) za ND
VARIABLE AUTO dok ne odaberete Manual.

3 Okrecite kotacic (D) za ND VARIABLE kako
biste podesili filtar prozirnosti.

[Savjet]
Filtar ND Filter takoder mozete dodijeliti dodjeljivom
kotacicu (stranica 48).

Privremeno automatsko podesavanje
Funkciju Push Auto ND moZete dodijeliti
dodjeljivom gumbu (stranica 48) i filtar Auto
ND Filter privremeno ukljuciti postavljanjem
na On pritiskanjem i zadrZzavanjem gumba.
Otpustanjem gumba filtar Auto ND ponovno
se postavlja na Off.

Pritisnite gumb [+] medu gumbima gore/dolje
(B) za ND FILTER POSITION kako biste ukljucili
filtar ND.

[Napomena]

Kada se tijekom snimanja uklopi ili isklopi funkcija CLEAR
filtra ND, okvir filtra ND prikazuje se na slici, a u zvuk se
dodaje zvuk rada.

[Savjeti]

e Funkciju CLEAR moZete postaviti okretanjem kotacica
ND VARIABLE (D) prema dolje od ND1/4. Okretanjem
kotacic¢a sa CLEAR prema gore postavlja se ND1/4.
Tu radnju moZete onemogucditi s pomocu funkcije
ND Dial >CLEAR with Dial (stranica 93) u izborniku
Technical cijelog izbornika.

Funkciju ND Filter Position takoder mozZete dodijeliti
dodjeljivom gumbu (stranica 48) te za promjenu
postavke umjesto gumba gore/dolje za ND FILTER
POSITION primijeniti taj gumb.

Unaprijed postavljeni nacin: Clear — Preset1 —
Preset2 — Preset3 — Clear...

Varijabilni nacin: Clear — On — Clear...

e Filtar Auto ND Filter takoder moZete dodijeliti
dodjeljivom gumbu (stranica 48) te pritiskom
gumba filtar Auto ND Filter ukljucivati i iskljucivati
postavljanjem na On i Off.

e Pri snimanju jako osvijetljenog objekta prejako
zatvaranje irisa moze uzrokovati zamucenje zbog
prelamanja, zbog ¢ega slika gubi fokus (uobicajena
pojava na videokamerama). Suzbijanjem ovog efekta
primjenom filtra ND moZete ostvariti bolje rezultate
snimanja.
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PodeSavanje za prirodne boje (White Balance)
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Nacin podeSavanja moZete odabrati tako
da odgovara uvjetima snimanja.

ATW (Auto Tracing White Balance)

Ovom funkcijom balans bijele boje automatski
se podeSava na odgovarajucu razinu.

Balans bijele boje automatski se prilagodava
promjeni temperature boje izvora svjetlosti.
Pritisnite i zadrzite gumb funkcije WHT

BAL (G) kako biste prikazali izravni izbornik
(stranica 48) te odaberite ATW.

MoZete odabrati brzinu namjestanja (pet
koraka) s pomocu funkcije White Setting
>ATW Speed (stranica 74) u izborniku
Shooting cijelog izbornika.

[Savjet]

Trenutacnu postavku balansa bijele moZete zamrznuti
postavljanjem funkcije ATW dodjeljivom gumbu

(stranica 48) te pritiskom dodjeljivog gumba
priviemeno pauzirati nacin ATW.

[Napomene]

e Funkciju ATW nije moguce upotrebljavati u nacinu
Cine El.

e Qvisno o osvjetljenju i uvjetima objekta, podesavanje
na odgovarajucu boju funkcijom ATW moZe biti
nemoguce.

Primjeri:

- Ako jedna boja dominira objektom, poput neba,
mora, tla ili cvijeca.

- Kada je temperatura boje iznimno visoka ili
iznimno niska.

Ako odgovarajudi efekt nije moguce postici zbog

preniske brzine automatskog pracenja funkcijom

ATW ili drugih razloga, izvedite automatski balans

bijele boje.

Rucno podesavanje balansa bijele boje

1 Kada je balans bijele boje postavljen
na nacin ATW, pritisnite i drzite gumb
funkcije WHT BAL (G) kako biste prikazali
izravni izbornik (stranica 48) i odaberite
W:P, W:A ili W:B.

2 Sklopkom WHT BAL (J) odaberite B,
A'ili PRESET.
B: Nacin za Memory B
A: Nacin Memory A
PRESET: Unaprijed postavljeni nacin
[Savjet]
Funkciju ATW moguce je omoguciti za nacin Memory
B postavljanjem funkcije White Setting >White

Switch<B> (stranica 74) u izborniku Shooting cijelog
izbornika na ATW.

Nacin Memory A/Memory B
U ovom nacinu balans bijele podesava se
spremljenu u memoriju A, odnosno memoriju B.

Unaprijed postavljeni nacin

U ovom nacinu temperatura boje prilagodava
se na unaprijed postavljenu vrijednost
(tvornicka postavka je 3200 K).

Promjena zadane unaprijed postavljene
vrijednosti

U unaprijed postavljenom nacinu izravno
moZete promijeniti postojecu unaprijed
postavljenu vrijednost.
Pritisnite i zadrzite gumb funkcije WHT BAL
(G) i uizravnom izborniku odaberite jedno
od sljedeceqg.
Nacin Custom: — 3200K, — 4300K,

— 5600K, — 6300K
Nacin Cine El: — 3200K, — 4300K, — 5500K

[Savjet]

Funkciju Preset White Select takoder moZete dodijeliti

dodjeljivom gumbu (stranica 48) te pritiskom gumba

mijenjati postavku.

Nacin Custom: 3200K — 4300K — 5600K — 6300K
— 3200K...

Nacin Cine El: 3200K — 4300K — 5500K — 3200K...

Promjena temperature boje

1 Pritisnite gumb funkcije WHT BAL (G) kako
biste vrijednost temperature boje prikazali
na bijeloj pozadini.

2 Okredite viSenamjenski kotaci¢ kako biste
podesili vrijednost.

[Savjeti]

e U unaprijed postavljenom nacinu vrijednost mozete
postaviti u jedinicama od 100 K.

e U nacinu rada za memoriju vrijednost moZete
postaviti u koracima od 20 K u rasponu od 2000 K do
5600 K. Vrijednosti iznad 5600 K mogu se postaviti u
intervalima jednakima iznosu promjene boje (mired)
od 5580 K do 5600 K. MoZete namjestiti i vrijednost
nijanse tint s pomocu funkcije White (stranica 74)
>Tint u izborniku Shooting cijelog izbornika.

Izvodenje automatskog balansa
bijele boje

Balans bijele boje koji se sprema u memoriju
A/memoriju B konfigurira se automatski.

1 Odaberite nacin za memoriju A ili nacin za
memoriju B.

2 Postavite bijeli papir (ili drugi predmet) na
lokaciju s izvorom svjetlosti i uvjetima
jednakima onima kojima je izloZzen objekt,
a zatim zumirajte papir kako biste
prikazali bijelu na zaslonu.

3 prilagodba svjetline.
Podesite iris pratedi postupak pod “Ruc¢no
podesavanje irisa” (stranica 42).

4 Pritisnite gumb WB SET (stranica 4).

e Ako se automatski balans bijele boje
izvodi u nac¢inu za memoriju, namjestena
vrijednost sprema se u memoriju (A ili B)
odabranu u 1. koraku.

e Ako se automatski balans bijele boje
izvodi u nacinu ATW, po zavrSetku
podesavanja podesenost balansa bijele
boje vraca se na balans bijele boje
u nacinu ATW.

[Napomena]

Ako je podesavanje neuspjesno, na zaslonu se na oko
tri sekunde prikazuje poruka o pogresci. Ako se poruka
0 pogresci nastavlja pojavljivati nakon uzastopnih
pokusaja postavljanja balansa bijele boje, obratite

se servisnom predstavniku tvrtke Sony.
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Postavljanje zvuka za snimanje

Ulaznim priklju¢nicama, sklopkama

i kotacicima na videokameri moZete odrediti

koji ¢e se zvuk snimati.

Ulazne prikljucnice za vanjski zvuk
i sklopke za odabir

Priklju¢nica INPUT1 (stranica 7)
Priklju¢nica INPUT2 (stranica 7)
Nosac za vise sucelja (stranica 7)
Sklopka INPUT1 (LINE/MIC/MIC+48V)
(stranica 7)

Sklopka INPUT2 (LINE/MIC/MIC+48V)
(stranica 7)

Sklopke za postavljanje razine zvuka

Sklopka CH1 (AUTO/MAN) (stranica 6)
Sklopka CH2 (AUTO/MAN) (stranica 6)
Kotaci¢ AUDIO LEVEL (CH1) (stranica 6)
Kotaci¢ AUDIO LEVEL (CH2) (stranica 6)

Zaslon Audio Status

INPUT1
MIC +48V

INPUT2
MIC +48V

Int MIC

Off

Off

Off

INPUTA

MIC +48V @i

CH1/CH2 0

CH1/CH2

Odabir uredaja za unos zvuka

Postavite unos zvuka s pomocu funkcije
CH1/CH2/CH3/CH4 >Source

(stranica 14) na zaslonu Audio Status ili
funkcije Audio Input >CH1 Input Select na
CH4 Input Select (stranica 90) u
izborniku Audio cijelog izbornika.

Ako upotrebljavate nosac za mikrofon,
XLR adapter ili uredaj UWP (UHF bezi¢ni
mikrofon), odredite funkciju Shoe CH1 ili
Shoe CH2. Detalje a adapteru XLR
potrazite pod “Dodavanje prikljucnica za
unos zvuka” (stranica 47).

[Napomene]

e Zvuk se ne snima u nacinu Interval Rec ili nacinu
Slow & Quick Motion.

e Videokamera ima ugradeni mikrofon za pricanje
za snimanje zvukova iz okoline. MoZe se
upotrebljavati za vremensku sinkronizaciju s
drugom opremom. U takvim slucajevima odredite
Internal MIC.

e Samo unutarnji mikrofon rucke (stranica 7)
postaje aktivan za snimanje zvuka kada je
rucka pri¢vrscena. Kada rucka nije pri¢vrscena,
za snimanje zvukova iz okoline moze
se upotrebljavati mikrofon za pri¢anje
(stranica 6).

e Kada su CH1 Input Select i CH2 Input Select
postavljeni na Internal MIC, razina snimanja zvuka
i za CH1i CH2 namjesta se s pomocu kotacica
AUDIO LEVEL(CH1) (stranica 6). Kada su CH3
Input Select i CH4 Input Select postavljeni na
Internal MIC, razina snimanja zvuka i za CH3 i CH4
namjesta se s pomocu kotaci¢a CH3 Input Level
(stranica 90).

2 Odaberite izvor za unos zvuka.
Sklopke INPUT1/INPUT2 (LINE/MIC/
MIC+48V) postavite na uredaje priklju¢ene
na priklju¢nice INPUT1/INPUT2.

Prikljuceni uredaj Polozaj
sklopke

Izvor vanjskog zvuka LINE

(npr. mikser)

Dinami¢ni mikrofon, MIC

baterijski mikrofon

Mikrofon s +48 V fantom MIC+48V

napajanjem

e Odabirom MIC+48V i povezivanjem
mikrofona nekompatibilnog s izvorom
od 48 V moZzete ostetiti prikljuceni
uredaj. Prije priklju¢enja uredaja
provjerite postavku.

e Ako na priklju¢nicama na koje nisu
prikljuceni uredaji Sum stvara problem,
odgovarajuce sklopke INPUT1/INPUT2
(LINE/MIC/MIC+48V) postavite na LINE.

Automatsko podesavanje razine
snimanja zvuka

Sklopke CH1/CH2 (AUTO/MAN) za kanale
postavite na AUTO za automatsko
podeSavanje.

Kod sklopki CH3/CH4 kontrolu razine zvuka
na zaslonu Audio Status (stranica 14)

ili funkciju Audio Input >CH3 Level Control

i CH4 Level Control u izborniku Audio cijelog
izbornika postavite na Auto (stranica 90).

Rucno podeSavanije razine
snimanja zvuka

Razina snimanja zvuka za CH1/CH2 podesava
se sljedecim postupkom.

1

Sklopke CH1/CH2 (AUTO/MAN) za kanale
postavite na MAN za ru¢no podeSavanje.

2 Tijekom snimanja ili stanja pripravnosti

okrecite kotacice AUDIO LEVEL (CH1)/(CH2)
za odgovarajuce kanale kako biste
prilagodili razinu zvuka.

e Kod sklopki CH3/CH4 kontrolu razine
zvuka CH3/CH4 (stranica 14) na
zaslonu Audio Status ili funkciju Audio
Input >CH3 Level Control ili CH4 Level
Control u izborniku Audio cijelog
izbornika postavite na Manual te zatim
namjestite razinu snimanja zvuka s
pomocu funkcije CH3 Input Level ili CH4
Input Level.

e Razine za od CH1 do CH4 moZete
podesiti kao grupu. Razinu snimanja
mozZete namjestiti s pomocu dodjeljivog
kotacica (stranica 48) kojemu je
dodijeljena funkcija Audio Input Level,
zaslona Audio Status ili s pomocu
funkcije Audio Input >Audio Input Level
u izborniku Audio cijelog izbornika.

[Savjet]
Zaslon Audio Status pogodan je za provjeru razine
ulaznog zvuka (stranica 14).

[Napomene]
e Ovisno o kombinaciji postavki u izborniku Audio,

postavke Audio Input Level mogu biti onemogucene.
Detalje potrazite u dijagramu na stranica 124.

e Videokamera podrZava kombinacije razli¢itih postavki.

Detalje potrazite u dijagramu na stranica 124.
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Dodavanije prikljucnica za unos zvuka

Adapterom XLR-K2M XLR (nije obuhvacen
isporukom) ili adapterom XLR-K3M XLR

(nije obuhvacen isporukom) na videokameru
istovremeno moZete prikljuciti do Cetiri kanala
audio uredaja XLR.

Postavite adapter XLR na podnoZje za vise
sucelja i postavite funkciju CH3 >Source na
Shoe CH1i CH4 >Source na Shoe CH2 na
zaslonu Audio Status (stranica 14). Ili
postavite funkciju Audio Input >CH3 Input
Select na Shoe CH1i CH4 Input Select na Shoe
CH2 u izborniku Audio cijelog izbornika.

Na kanalima za koje je adapter XLR
postavljen za unos onemogucuju se funkcije
videokamere koje se preklapaju. Podesavanje
provedite sklopkama i kotaci¢ima na
adapteru XLR.

[Napomene]

e Videokamera podrZava digitalno audio sucelje od
2 kanala adaptera XLR-K3M.

e Ako su funkcije Audio Input >CH3 Level i CH4 Level u
izborniku Audio postavljene na Audio Input Level, tada
je funkcija Audio Input Level na videokameri umnoZena
razinom koja je namjestena na adapteru XLR.

Funkcija Audio Input Level takoder je onemogucena
kada je adapter XLR postavljen na AUTO.

Kada je odabrana opcija "Through", zvuk se snima na
razini podesenoj adapterom XLR (stranica 125).
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Korisne funkcije

Upotreba izbornika Direct Menu

MoZete provjeriti status i postavke
videokamere prikazane za zaslonu trazila
te izravno odabrati i promijeniti postavke.
Moguce je konfigurirati sljedece stavke.
e Face/Eye Detection AF

SteadyShot

White Mode

Color Temp

Scene File

ND Filter Position / Auto ND Filter

ND Filter Value

Auto lris

Iris Value

AGC

Gain Value

ISO Value

El Gain Value

Auto Shutter

Shutter Value

Auto Exposure Mode

Auto Exposure Level

e S&Q Motion Frame Rate

1 Pritisnite viSenamjenski kotacic¢ ili
dodjeljivi gumb kojem je dodijeljena
funkcija Direct Menu.

Samo stavke na zaslonu moguce je
konfigurirati i odabrati narancastim
pokaziva¢em u izravnom izborniku.

2 Okrecite viSenamjenski kotacic¢ kako biste
pokaziva¢ pomaknuli na stavku s kojom
Zelite raditi, a potom pritisnite
viSenamjenski kotacic.

Prikazuje se izbornik ili se stavka
prikazuje na bijeloj pozadini.

3 Okredite viSenamjenski kotaci¢ za odabir
postavke, a potom ga pritisnite.

Izbornik ili bijela pozadina nestaju,

a prikazuje se nova postavka

s narancastim pokazivacem.

Za napustanje izravnog izbornika pritisnite

dodjeljivi gumb kojemu je dodijeljena

funkcija Direct Menu ili pricekajte tri
sekunde bez provodenja radniji.

[Savjeti]

e |zravne postavke takoder je moguce konfigurirati
pritiskanjem i zadrzavanjem pojedinih gumba
funkcija (stranica 5).

e Kada se stavke prikazuju na bijeloj pozadini,
viSenamjenski kotaci¢ moZe se upotrebljavati
kao dodjeljivi kotacic.

e Za odabir takoder se mozZe primijeniti viSestruki
bira¢ (stranica 9).

Dodjeljivi gumbi/kotacici

Na videokameri se nalazi devet dodjeljivih
gumba (stranica 6, 7, 9) kojima

mozZete dodijeliti funkcije.

Funkcije moZete dodijeliti i viSenamjenskom
kotacicu na videokameri (stranica 5),
dodjeljivom kotacic¢u na rucki (stranica 7) i
dodjeljivom kotacic¢u na daljinskom upravljacu
na drski (stranica 9).

Promjena funkcije gumba

Upotrijebite funkciju Assignable Button
(stranica 79) u izborniku Project cijelog
izbornika.

Na zaslonu Assignable Button Status
(stranica 15) moZete pregledati dodijeljene
funkcije.

Funkcije tvornicki dodijeljene pojedinom

gumbu

Gumb 1 S&Q Motion

Gumb 2 AF Speed/Sens.
Gumb 3 Focus Setting

Gumb 4 Focus Magnifier x3/x6
Gumb 5 Direct Menu

Gumb 6 Off

Gumb 7 Focus Magnifier x3/x6
Gumb 8 Direct Menu

Gumb 9 Video Signal Monitor

Gumb Focus Hold  Focus Hold

Funkcije koje se mogu dodijeliti
Off

Base ISO/Sensitivity
AGC

Push AGC

ND Filter Position
Auto ND Filter

Push Auto ND

Auto Iris

Push Auto Iris

Auto Shutter

Auto Exposure Level
Backlight

Reflektor

Preset White Select
ATW

ATW Hold

AF Speed/Sens.
Focus Setting

Focus Area

Focus Area(AF-S)
Face/Eye Detection AF
Push AF Mode

Push AF/Push MF
Focus Hold

Focus Magnifier x3/x6
Focus Magnifier x3
Focus Magnifier x6
S&Q Motion
SteadyShot

Rec

Rec Review

Clip Flag OK

Clip Flag NG

Clip Flag Keep

Color Bars

Tally [Front]
DURATION/TC/U-BIT
Display

Lens Info

Video Signal Monitor
Marker

VF Adjust

VF Mode

Gamma Display Assist
Peaking

Zebra

Volume

Thumbnail (Slic¢ica)
Touch Operation
Handle Zoom

NFC

Auto Upload (Proxy)
Direct Menu

User Menu

Menu

Promjena funkcije kotacica

MozZete promijeniti funkciju viSenamjenskog
kotacica na videokameri, dodjeljivog kotacica
na drski ili dodjeljivog kotacic¢a na rucki.

Za visefunkcijski kotacic¢ postavite s Multi
Function Dial (stranica 81) >Default Function
u izborniku Project.

Tvornicki postavljena opcija je Off.
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Funkcije dodjeljive visefunkcijskom kotacicu
e Off

ISO/Gain/El

IRIS

Auto Exposure Level

Audio Input Level

[Napomenal]
Postavka ne onemogucena dok se prikazuje izbornik.

Za dodijeljivi kotacic postavite s pomocu
funkcije Assignable Dial (stranica 81)

u izborniku Project cijelog izbornika.
Tvornicki postavljena funkcija za sve je IRIS.
[Savjet]

Dodijeljivi kota¢i¢ RM-30BP (nije obavezno) slijedi
postavku Grip/Remote Dial.

Funkcije dodijeljene dodjeljivom kotacicu
na rucki

Off

ISO/Gain/El

ND Filter

IRIS

e Auto Exposure Level

e Audio Input Level

e Multi Function Dial

Funkcije dodijeljene dodjeljivom kotacicu
na drski

Off

ISO/Gain/El

ND Filter

IRIS

Auto Exposure Level

e Audio Input Level

Na zaslonu Assignable Button Status
(stranica 15) mozete pregledati dodijeljene
funkcije.

Slow & Quick Motion

Kada je format snimanja (stranica 77) postavljen na sljedece vrijednosti, broj slicica u sekundi
za snimanije i broja slic¢ica u sekundi za reprodukciju.

Format snimanja

Brzina prijenosa

Frekvencija Nacin skeniranja  Kodek Format
sustava pretraznika videozapisa
59.94/50/29.97/ FF RAW 3840x2160P 1-60
25/23.98 RAW i XAVC-I 3840x2160P 1-60
XAVC-| 4096x2160P 1-60
3840x2160P 1-60,100, 120
1920x1080P 1-60, 100, 120,
150, 180, 200, 240
XAVC-L 3840x2160P 1-60, 100, 120
1920x1080P 1-60, 100, 120,
150, 180, 200, 240
S35 XAVC-| 1920x1080P 1-60, 100, 120
XAVC-L 1920x1080P 1-60,100, 120
24 FF XAVC-I 4096x2160P 1-60
Nacin Slow & Quick Motion moZete ukljuciti/ [Napomene]

iskljuciti pritiskanjem dodjeljivog gumba
(stranica 48) kojem je dodijeljena funkcija
S&Q Motion.

Broj sli¢ica u sekundi za snimanje moZete
postaviti pritiskanjem i zadrZzavanjem gumba.

e Nacin Slow & Quick Motion nije moguce postaviti
tijekom snimanja, reprodukcije ili tijekom prikaza
zaslona s minijaturama.

e U nacinu Slow & Quick Motion snimanje zvuka nije
podrzano.

e Funkcija automatskog fokusiranja, funkcija
automatskog irisa i funkcija automatskog zatvaraca
onemogucena je u nacinu Slow & Quick Motion.
Medutim, funkcija automatskog fokusiranja moZe se
upotrebljavati kada je broj slicica u sekundi postavljen
na sljedece.

Frekvencija sustava Brzina prijenosa

59,94/29,97/23,98 30, 60, 120, 240

50/25 25,50, 100, 200

o Detalje o upotrebi izlaza RAW potraZite pod
stranica 55.

Snimanje videozapisa s prekidima
(Interval Rec)

Funkcija videokamere Interval omogucuje
snimanje ubrzanih videozapisa u internu
memoriju videokamere. Funkcija predstavlja
ucinkovit nacin snimanja sporih objekata.
Po pokretanju snimanja videokamera
automatski snima odredeni broj slicica
u odredenom vremenskom intervalu.
Interval snimanja (Interval Time)

e

Broj okvira u jednoj snimci
(Number of Frames)

Kada je omogucena funkcija Interval Rec, prije
pocetka snimanja automatski se ukljucuje
svjetlo za videozapis HVL-LBPC (u opciji)

koje omogucuje snimanja slika u uvjetima
stabilnog svjetla i temperature boje (funkcija
prethodnog osvjetljavanja).

[Napomene]

o Razlicite posebne funkcije snimanja, kao sto je
Interval Rec, nije moguce primjenjivati istovremeno.
Ako se tijekom primjene funkcije Interval Rec
omoguci drugi poseban nacin snimanja, Interval Rec
automatski se otpusta.

e Nacin Interval Rec automatski se otpusta nakon promjena
postavki sustava, primjerice formata videozapisa.
Postavke za Interval Rec nije moguce promijeniti
tijekom snimanja, reprodukcije ili tijekom prikaza
zaslona s minijaturama.
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Postavljanje nacina Interval Rec

Postavite nacin Interval Rec (stranica 78)
>Setting u izborniku Project cijelog izbornika na
On i postavite Number of Frames i Interval Time.
Ako upotrebljavate svjetlo za videozapis
HVL-LBPC (u opciji), prije pocetka snimanja po
potrebi s Interval Rec >Pre-Lighting u izborniku
Project postavite vremenski interval za
ukljucenje svjetla za videozapis.

[Napomene]
e Ako svjetlo za videozapis Zelite ukljuciti prije pocetka
snimanja, sklopku za svjetlo za videozapis postavite
na AUTO. Svjetlo za videozapis ukljucuje se i iskljucuje
automatski sukladno postavci za Video Light Set
(stranica 94) u izborniku Technical.
Ako ukljucite sklopku svjetla za videozapis, svjetlo
za videozapis uvijek svijetli (svjetlo za videozapis ne
ukljucuje/iskljucuje se automatski).
e Ako je svjetlo za videozapis konfigurirano tako da
se iskljucuje na pet sekundi ili manje, svjetlo za
videozapis ne iskljucuje se.

Videokamera izlazi iz nacina Interval Rec mode
kada je iskljucite, no postavke za Number of
Frames, Interval Time i Pre-lighting zadrzavaju
se. Pri sljedec¢em snimanju u nacinu Interval
Rec nije ih potrebno ponovno postavljati.

Snimanje s na¢inom Interval Rec

Pritisnite gumb za snimanje START/STOP za
pocletak snimanja. Alternativno, u traZilu se
prikazuje ,Int @Rec” i ,Int @Stby".

Ako upotrebljavate funkciju prethodnog
osvjetljavanja, svjetlo za videozapis ukljucuje
se prije pocetka snimanja.

Prekidanje snimanja

Prekinite snimanje.

Po zavrsetku snimanja podaci videozapisa, koji
su se do tada zapisivali u memoriju, zapisuju
se na medij.

Izlaz iz nacina Interval Rec

Ucinite jedno od sljedeceg.

e Sklopka POWER postavite na Off.

e U nacinu stanja pripravnosti za snimanje
iskljucite Interval Rec >Setting u izborniku
Project postavljanjem na Off.

Nacin Interval Rec takoder se otpusta pri

ponovnom pokretanju videokamere.

Ogranicenja tijekom snimanja

e Zvuk se ne snima.
e Pregled snimke (Rec Review) nije moguc.

Ako je videokamera iskljucena tijekom
snimanja

e Ako je sklopka POWER na videokameri
postavljena u polozaj Off, mediju se pristupa
na nekoliko sekundi radi snimanja slika
spremljenih u memoriju do tog trenutka,

a zatim se napajanje iskljucuje automatski.

e Ako dode do gubitka napajanja zbog
uklanjanja baterije, odspajanja kabela
istosmjernog napajanja ili isklju¢enja
napajanja na izmjeni¢nom adapteru,
podaci videozapisa i zvuka snimaju se
do mogucnosti njihova gubitka (najvise
10 sekundi). Budite pazljivi pri zamjeni
baterije.

Istovremeno snimanje na
memorijsku karticu Ai B
(2-slot Simul Rec)

MoZete istovremeno snimati i na memorijsku
karticu A i memorijsku karticu B postavljanjem
funkcije Simul Rec (stranica 14) na zaslonu
Project status ili funkcije Simul Rec >Setting
(stranica 78) u izborniku Project cijelog
izbornika na On.

Video Signal Monitor

Vrstu videosignala za prikaz na zaslonu trazila
moZete postaviti na valni oblik, vektroskop

ili histogram s Display On/Off >Video

Signal Monitor (stranica 88) u izborniku
Monitoring.

Narancasta linija prikazuje postavljenu
vrijednost funkcije zebra.

Zaslon za pracenje mete

U nacinu Cine El postavka informacije

o prostoru boje (stranica 24) ili postavci LUT
monitora (stranica 76) u gornjem desnom
dijelu monitora za videosignal za prikaz
mete nadzora.

78901284867890123466
ND Clear AEH.T8

Zastavice za isjecak

Isjecku moZete dodati zastavicu za isjecak

OK pritiskom gumba Clip Flag (stranica 5)

i odabirom funkcije Add OK.

Zastavicu za isjeCak moZete izbrisati pritiskom
gumba dva puta i odabirom funkcije

Delete Clip Flag.

[Savjeti]

e Za dodavanje zastavica za isjeCak moZete upotrijebiti
i dodjeljivi gumb kojemu je dodijeljena funkcija
zastavice za isjecak (stranica 48).

MoZete dodati i zastavicu za isjeCak s pomocu
funkcije Set Clip Flag (stranica 92) u izborniku
Thumbnail cijelog izbornika (stranica 65).
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Snimanje proxyja

Ova funkcija omogucuje vam da istovremeno
snimate proxy podatke niske rezolucije

i izvorne podatke videozapisa u visokoj
rezoluciji.

Detalje o podrZzanim memorijskim karticama, formatiranju

memorijskih kartica i provjeri preostalog kapaciteta
pogledajte u odjeljku “Upotreba memorijskih kartica”
(stranica 26).

Konfiguriranje prije snimanja

1 Postavite funkciju Proxy Rec
(stranica 14) na zaslonu Project ili Proxy
Rec >Setting (stranica 78) u izborniku
Project cijelog izbornika na On.

2 Umetnite memorijsku karticu u utor za
CFexpress Type A karticu / SD karticu
(stranica 6).

e Kod CFexpress kartica naljepnica
je okrenuta na lijevu stranu.

e Kod SD kartica naljepnica je okrenuta
na desnu stranu s nakoSenim rubom
na dnu.

[Napomena]

Funkciju Proxy Rec nije moguce postaviti na On u
isto vrijeme kao i funkciju S&Q Motion ili Interval Rec.
Kada se funkcija Proxy Rec ukljuci postavljanjem na
On, ovi drugi nacini snimanja prisilno se isklju¢uju
postavljanjem na Off.

Snimanje proxyja

Pritisnite gumb za snimanje START/STOP za
pocetak snimanja nakon dovrsetka potrebne
postavke za snimanje.

[Napomene]

Ako se tijekom pristupa memorijskoj kartici iskljuci
videokamera ili ukloni memorijska kartica, nije
moguce zajamciti cjelovitost podataka na kartici.

Svi podaci snimljeni na memorijsku karticu mogu biti
odbaceni. Prije iskljucenja videokamere ili uklanjanja
memorijske kartice obavezno provijerite je li indikator
pristupa memorijskoj kartici iskljucen.

Provjerite da memorijska kartica ne iskace kad je
umecete ili uklanjate.

Za izlaz zaustavite snimanje.

Odrediste za spremanje snimljene
datoteke

Snimljena datoteka sprema se u sljededi
direktorij.

Mediji za snimanje Put mape

SDXC /PRIVATE/XDROOT/Sub

CFexpress Type A /XDROOT/Sub

Postavljanje funkcije Audio
Channel za snimanje proxyja

Odaberite funkciju Proxy Rec >Audio Channel
(stranica 78) u izborniku Project cijelog
izbornika i postavite kanal za zvuk za snimanje
proxy podataka.

O snimljenoj datoteci

Nastavak naziva datoteke je ".mp4".
Istovremeno se snima i vremenski kod.

0 nazivu datoteke

Naziv datoteke sastoji se od naziva isjecka
snimljenog na memorijsku karticu i sufiksa
,S03".

Pojedinosti o nazivima isjecaka pogledajte
pod Clip Name Format (stranica 86)
izbornika TC/Media cijelog izbornika.
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Snimanje sa zeljenim izgledom

Kada je videokamera u nac¢inu Custom,

moZete namjestati crnu boju, matricu i druge

parametre za stvaranje ,izgleda” na temelju
temeljnog izgleda.

Matrix

Crni

lzgled —

Temeljni izgled

MoZete i brzo odabrati drugaciji izgled
spremanjem razlicitih kombinacija postavki
u datotekama kadra.

Videokamera dolazi s ukupno Sest unaprijed
postavljenih izgleda.

Odabirizgleda

1 Kada se prikazuje zaslon za snimanje,
pritisnite viSenamjenski kotacic.

2 Odaberite ikonu SCN.
3 Pritisnite viSenamjenski kotacic.

4 Odaberite Zeljeni izgled s izbornika
i pritisnite viSenamjenski kotacic.

[Savjeti]
e Tvornicki su postavljene i konfigurirane sljedece
unaprijed postavljene postavke.

Shooting Mode Custom

Target Display ~ SDR(BT.709) HDR(HLG)
Datoteka kadra1 S-Cinetone HLG Live
Datoteka kadra 2 Standard HLG Natural
Datoteka kadra 3 Still (Nije
registrirano
Datoteka kadra 4 ITU709 (Nije
registrirano
Datoteke kadra  (Nije (Nije

od5do 16 registrirano  registrirano

e Izgled moZete odabrati i s pomocu funkcije Scene File
(stranica 13) na zaslonu Main Status ili Scene File
>Recall (stranica 83) u izborniku Paint/Look cijelog
izbornika. MoZete i opozvati prethodno postavljeni
izgled s pomocu funkcije Scene File >Preset Recall.

Uvoz Zeljenog temeljnog izgleda

MoZete uvesti 3D LUT datoteku stvorenu na
racunalu ili drugom uredaju kao temeljni
izgled. Moguce je uvesti do 16 datoteka.

e Format datoteke: Datoteka CUBE (*.cube)
za 3D LUT datoteku od 17 tocaka ili 33
tocke s pomocu aplikacija Catalyst Browse,
RAW Viewer ili DaVinci Resolve* (tvrtka

Blackmagic Design Pty. Ltd.).
* Provjereno u skladu s Resolve V9.0, V10.0 i V11.0.

e Ulazni prostor boja / gama: S-Gamut3.
Cine/S-Log3ili S-Gamut3/S-Log3

1 Na racunalu ili drugom uredaju spremite
3D LUT datoteku u posebnu mapuili
medij za snimanje.

Mediji za Put mape

snimanje

SDXC /PRIVATE/SONY/PRO/LUT/
CFexpress /SONY/PRO/LUT/

Type A

2 Umetnite medij za snimanje na koji su
spremljene 3D LUT datoteke u utor za
CFexpress Type A karticu / SD karticu (B).

3 Odaberite funkciju Base Look >Import
(stranica 83) u izborniku Paint/Look
cijelog izbornika.

4 Odaberite odrediste za uvoz.

5 Odaberite 3D LUT datoteku za uvoz.
Slijedite upute na zaslonu. Videokamera
upravlja 3D LUT datotekom kao temeljnim
izgledom.

6 Odaberite 3D LUT datoteku s pomocu
funkcije Base Look >Select (stranica 83)
u izborniku Paint/Look cijelog izbornika.

7 Konfigurirajte funkciju Base Look >Input
and Output (stranica 83) u izborniku
Paint/Look cijelog izbornika kako biste
uskladili atribute uvezene 3D LUT
datoteke.

Namjestanje nedovoljne ekspozicije

Ako postoji tendencija za nedovoljnu
ekspoziciju kada je odabrana automatska
ekspozicija pri upotrebi uvezenog temeljnog
izgleda, namjestite funkciju Base Look >AE
Level Offset (stranica 83) u izborniku
Paint/Look.

[Napomene]

e Sami uvoz 3D LUT datoteke ne utjece na sliku. Ucitajte
3D LUT datoteku s pomocu funkcije Base Look
>Select (stranica 83) u izborniku Paint/Look cijelog
izbornika.

e Ako funkcija Input nije ispravno postavljena, necete
dobiti odgovarajuci izgled.

e Postavke stavki izbornika Input, Output i AE Level
Offset primjenjuju se na temeljni izgled s pomocu
funkcije Select. Ako se uveze viSe 3D LUT datoteka,
odaberite Select za svaku 3D LUT datoteku i
konfigurirajte funkcije Input, Output i AE Level Offset
pojedinac¢no za svaku datoteku.

e Konfigurirane postavke Input, Output i AE Level Offset
spremljene su za svaku 3D LUT datoteku.

e Opcije odabira temeljnog izgleda / LUT-a za uvezene
3D LUT datoteke zajednicke su za nacine SDR(BT.709)
/ HDR(HLG) / Cine El, ali konverzija prostora boja
i game ne obavljaju se u skladu s tim nacinima.

e 3D LUT datoteke nisu izbrisane kada je u izborniku
Maintenance odabrana funkcija All Reset >Reset.
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3. Snimanje: Snimanje sa Zeljenim izgledom

Prilagodavanje izgleda

Spremanije izgleda

Brisanje temeljnog izgleda

Izgled mozZete prilagoditi na temelju
temeljnog izgleda s pomocu funkcije Matrix
i drugih stavki za postavljanje u izborniku
Paint/Look cijelog izbornika. Pojedinosti

o svakoj stavci za postavljanje potrazite pod
stranica 83.

PoveZite videokameru s TV-om ili monitorom
i namjestite kvalitetu slike dok gledate sliku
na TV-u ili zaslonu monitora.

[Napomena]

Kada uvozite 3D LUT datoteku i primijenite je na sliku,
Zeljeni izgled definiran u 3D LUT datoteci nece biti
moguce ostvariti ako su postavke funkcije Matrix i druge
postavke osim postavki temeljnog izgleda u izborniku
Paint/Look promijenjene. MoZete ponovno postaviti

sve prilagodene postavke s pomocu funkcije Reset
Paint Settings >Reset without Base Look (stranica 83)

u izborniku Paint/Look cijelog izbornika.

Trenutacni izgled moZete spremiti kao
datoteku kadra u internu memoriju s pomocu
funkcije Scene File >Store (stranica 83)

u izborniku Paint/Look cijelog izbornika.
Mozete brzo spremiti s pomocu operacija

u izravnom izborniku sa zaslona za snimanje.

[Napomenal]
Ako odaberete drugi izgled bez spremanja trenuta¢nog
izgleda, trenutacni izgled se odbacuje.

[Savjet]

MoZete prepisati unaprijed postavljene datoteke kadra.
Za obnovu unaprijed postavljene datoteke kadra ucitajte
izgled koji Zelite obnoviti s pomocu funkcije Scene File
>Preset Recall (stranica 83) u izborniku Paint/Look
cijelog izbornika i zatim spremite datoteku kadra s
pomocu funkcije Scene File >Store.

Brisanje spremljenog izgleda

Datoteku kadra spremljenu u internu memoriju
mozete izbrisati s pomocu funkcije Scene File
>Delete (stranica 83) u izborniku Paint/Look
cijelog izbornika.

[Savjet]

Kada je izbriSete, viSe se nece prikazivati u izravnhom
izborniku.

Uvezenu 3D LUT datoteku moZete izbrisati

s pomocu funkcije Base Look >Delete
(stranica 83) u izborniku Paint/Look cijelog
izbornika.

Sve uvezene 3D LUT datoteke moZete izbrisati
s pomocu funkcije Base Look >Delete All
(stranica 83) u izborniku Paint/Look cijelog
izbornika.

[Napomene]

e Prije brisanja provjerite da se temeljni izgled ne
upotrebljava u bilo kojim datotekama kadra. Ako se
izbriSe temeljni izgled koji se upotrebljava, izgled
odgovarajucih datoteka kadra nece biti tocan.

e Uvezene 3D LUT datoteke nisu izbrisane kada je
odabrana funkcija All Reset >Reset (stranica 99)
u izborniku Maintenance cijelog izbornika.

e |zbrisani temeljni izgled vise se ne moze
upotrebljavati kao LUT u nacinu Cine El
(stranica 54).
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Snimanje s pomocu namjestanja izgleda u postprodukciji

Upotrebom videokamere u nacinu Cine

El i ravnomjernim snimanjem gradacija

od tamnih podru¢ja do svijetlih podrucja
moZete napraviti fine izmjene poput lokalnog
obnavljanja gradacije tamnih podrucja

i svijetlih podrucja u postprodukciji.

Medutim, kada gledate snimljene slike na
konvencionalnom monitoru, cjelokupni
kontrast bit ¢e nizak zbog ¢ega ¢e namjesStanje
fokusa i ekspozicije biti teze.

LUT mozZete primijeniti na metu pracenja na
videokameri kako bi vam pomogao u raznim
namjestanjima tijekom snimanja. LUT mozZete
primijeniti i na reprodukciju videozapisa kako
biste provjerili konacan rezultat.

LUT-ove primjenjuju sljededi sustavi. Medutim,
moguce je primijeniti samo jedan LUT.

e |zlaz za SDliizlaz za HDMI

e Trazilo i proxy slike, emitiranje

e Videozapis snimljen na mediju za snimanje

[Napomene]

e Postavka LUT On/Off funkcije VF primjenjuje se
i na proxy datoteku i videozapis za emitiranje.

e Funkcija Gamma Display Assist dostupna je tijekom
rada povecala za fokusiranje.

[Savjeti]

e MozZete namjestiti i s pomocu funkcije LUT On/
Off >VF/Proxy/Stream (stranica 76) u izborniku
Shooting cijelog izbornika.

e SDI/HDMI mozZe biti postavljen sli¢no kao i VF.

e Kod videozapisa na mediju za snimanje moZete
postaviti s pomocu funkcije LUT On/Off >Internal Rec
(stranica 76) u izborniku Shooting cijelog izbornika.

Promjena LUT-a

Primjena LUT-a na sliku trazila

1 Pritisnite gumb MENU za prikaz zaslona
Monitoring Status.

2 Odaberite stupac Gamut/Gamma
u redu VF.

=3 Monitoring 5/13
Signal Info.Disp. Gamut/Gamma

SDI 1920x1080P(Lvl A) ||Off [SGSC/SLOQS

HDMI 11920x1080P On SG3C/SLog3

Stream Off [MLUT

% MLUT

Base Look / LUT

Gamma Disp. Assist
Off

s709

3 Odaberite On ili Off.

1 Pritisnite gumb MENU za prikaz zaslona

Monitoring Status.

2 Odaberite polje Base Look/LUT.

=Monitoring 5/13

Signal Info.Disp. Gamut/Gamma

SDI  |1920x1080P(LvI A) ||Off [SGSC/SLog3

HDMI 11920x1080P On SG3C/SLog3

Stream Off [MLUT

VF MLUT

Base Look / LUT Gamma Disp. Assist
Off

s709

3 Odaberite LUT koji ¢e se primjenjivati s
popisa temeljnog izgleda.

[Savjeti]

e MoZete uvesti i primijeniti i 3D LUT datoteku. Moguce
je odabrati s709, 709(800%) ili S-Log3 za temeljni
izgled. Pojedinosti potrazite u odjeljku “"Uvoz Zeljenog
temeljnog izgleda” (stranica 52) i “Brisanje
temeljnog izgleda” (stranica 53).

e Temeljni izgled moZete postaviti i s pomocu funkcije
Base Look >Select (stranica 83) u izborniku Paint/
Look cijelog izbornika.

Promjena distribucije tamnih
i svijetlih podrucja u snimljenom
videozapisu

MoZete promijeniti distribuciju tamnih

i svijetlih podrucja, primjerice, ako Zelite
prioritet dati tonu tamnih podrucja u odnosu
na svijetla podrucja promjenom funkcije
Exposure Index iz osnovne osjetljivosti.

1 Primijenite LUT na sliku trazila
(stranica 54).

2 Pritisnite gumb MENU za prikaz zaslona
Camera Status.

3 Postavite polja L/M/H funkcije Exposure
Index.
Pojedinacne postavke dodijeljene su
polozajima L/M/H sklopke ISO/GAIN
(stranica 5).

4 Odaberite vrijednost funkcije Exposure
Index koju cete primijeniti s pomocu
sklopke ISO/GAIN.

5 Namijestite ekspoziciju slike trazila kako
vam odgovara.

[Napomenal]

Funkcija Gamma Display Assist dostupna je tijekom rada
povecala za fokusiranje. Postavka Exposure Index ne
primjenjuje se na funkciju Gamma Display Assist.

[Savjeti]

e Ekspozicija se moZe namjestiti i s pomocu funkcije
1SO/Gain/El >Exposure Index (stranica 72)

u izborniku Shooting cijelog izbornika.

e Druga numericka vrijednost postavke navodi koliko
je koraka informacija o svjetlini dodijeljeno za svijetla
podrucja (svjetlina visa od 18 % sive boje). Podru¢ja
svjetlija od ovih imaju prejaku ekspoziciju.

Primjer: U postavki ,400EI/5.0E,” koraci od 0,5
dodjeljuju se svijetloj strani.

e To moZete upotrebljavati i kao vodic za provjeru
tona tamnih i svijetlih podrucja tijekom snimanja.
Primjerice, ako je M poloZaj temeljna osjetljivost,
L polozaj iznosi minus 2 koraka, a poloZaj H plus 2
koraka, moZete provijeriti prebacivanjem sklopke 1SO/
GAIN. Zapamtite da se trebate vratiti u M poloZaj
nakon provjere ekspozicije.
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3. Shooting

Snimanje RAW videozapisa

MozZete snimiti RAW videosignal iz priklju¢nice
SDI OUT videokamere na podrZani vanjski snimac.

1 Spojite vanjski RAW snimac na prikljucnicu
SDI OUT videokamere.

2 Postavite nacin snimanja s pomocu
zaslona Project status (stranica 14) ili
funkcije Base Setting >Shooting Mode
(stranica 77) u izborniku Project cijelog
izbornika na nacin Cine El.

3 Postavite nacin skeniranja (samo FF)
s pomocu funkcije Imager Scan na
zaslonu Project status ili s pomocu
funkcije Rec Format >Imager Scan
Mode (stranica 77) u izborniku Project
cijelog izbornika.

4 Postavite kodek s pomocu zaslona Project
status ili funkcije Rec Format >Codec
(stranica 77) u izborniku Project cijelog
izbornika na kodek koji ukljuc¢uje RAW.
Odabirom funkcije RAW & XAVC-I
istovremeno ce se snimati RAW
videozapis na vanjski RAW snimac
i videozapis na memorijske kartice
u videokameri.

5 Postavite rezoluciju s pomocu zaslona
Project status ili funkcije Rec Format >RAW
Output Format (stranica 77) u izborniku
Project cijelog izbornika.

6 Provjerite je li vanjski snimac ukljucen i
zatim pritisnite gumb za snimanje START/
STOP na videokameri.

[Napomenal]

Nakon pocetka snimanja na vanjski snimac, bez
upotrebe gumba za snimanje START/STOP na
videokameri, isjecci mozda nece biti ispravno
snimljeni.

PodrZani RAW izlazni formati prikazani
su u nastavku.

Frekvencija Kodek RAW izlazni
sustava format
59,94/ RAW 4096x2160
50/ 3840 x 2160
29,97/ RAW i XAVC-I 4096x2160
25/ 3840 x 2160
23,98
24 RAW 4096x2160
RAW i XAVC-| 4096x2160

Indikator statusa snimanja

Kada je funkcija Display On/Off (stranica 87)
>RAW Output Control Status u izborniku
Monitoring cijelog izbornika postavljena na
On, status RAW snimanja naveden je ikonom
koja se prikazuje na zaslonu traZila.

[Napomena]

Kontrolni signal snimanja jest izlaz iz priklju¢nice

SDI OUT videokamere, no nije moguce dobiti status
vanjskog snimaca. U skladu s navedenim, na videozapisu
moZe biti navedeno da je snimanje RAW videozapisa

u tijeku kada vanjski snimac ustvari ne snima. Provjerite
indikatore na vanjskom snimacu kako biste dobili tocan
status rada.

[Savjet]
Prikazuje se i vrijednost postavke RAW izlaznog formata.

Usporene i ubrzane snimke

Ako je funkcija S&Q Motion >Setting

u izborniku Shooting postavljena na On,
RAW videozapis snima se u nacinu Slow &
Quick Motion.

Pojedinosti o podrzanim brzinama slicica
u sekundi za snimanje potraZzite ovdje
stranica 49.
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4. Mrezne funkcije

Povezivanje s drugim uredajima putem mreze LAN

Videokameru je vezom LAN moguce povezati
s pametnim telefonima, tabletima i drugim
uredajima.

Stvaranje veze LAN izmedu uredaja

i videokamere s pomocu aplikacije ,Content

Browser Mobile” omogucuje sljedece.

e Daljinsko upravljanje putem mreze LAN
Videokamerom mozZete upravljati
s pametnim telefonom, tabletom
ili racunalom povezanim s videokamerom
putem mreZe LAN.

e Prijenos datoteka putem mreze LAN
MoZete prenositi proxy datoteke (niska
rezolucija) ili originalne datoteke (visoka
rezolucija) koje su snimljene na memorijsku
karticu u videokameri na server putem
mreze LAN.

e Pracenje videozapisa putem mreze LAN
MoZete stvoriti usmjeravanje (H.264)

s kamere ili reproducirati videozapis
videokamere te pratiti videozapis
aplikacijom "Content Browser Mobile"
na uredaju putem mreze LAN.

Aplikacija "Content Browser Mobile"

Videokamerom mozZete upravljati daljinski

na zaslonu uredaja dok pratite videozapis

s videokamere s aplikacijom "Content Browser
Mobile".

Za detalje o aplikaciji "Content Browser Mobile" obratite
se prodajnom ili servisnom predstavniku tvrtke Sony.

Postavljanje korisnickog imena
User Name i lozinke Password

Povezivanje s Wireless LAN Access
Point Mode

Za primjenu mreZne funkcije postavite
korisnicko ime i lozinku.

1 Postavite funkciju Access Authentication
>User Name (stranica 95) u izborniku
Network cijelog izbornika.

2 Postavite funkciju Access Authentication
>Password (stranica 95) u izborniku
Network cijelog izbornika.

Videokamera radi kao pristupna tocka
i povezuje se s uredajem putem bezZicne
mreZze LAN.

Pametni telefon/tablet

Povezivanje s uredajem kompatibilnim s

tehnologijom s jednim dodirom

Tehnologija BFC omogucuje povezivanje
uredaja koji podrZavaju NFC (povezivanje
dodirom).

1 Otvorite [Settings] na uredaju, odaberite
More] i u potvrdni okvir za NFC postavite
kvacicu.

2 Ukljucite videokameru.

3 Ukljucite funkciju NFC.
Pritisnite i zadrZite (na 3 sekunde)
dodjeljivi gumb kojem je dodijeljena
funkcija NFC ili odaberite Wireless LAN
>NFC u izborniku Network kako biste
ukljucili nacin za povezivanje
tehnologijom NFC.
Funkcija NFC dostupna je samo dok
se na zaslonu prikazuje N.

4 Uredajem dodirnite videokameru.
Uredaj se povezuje s videokamerom
i pokrece se aplikacija "Content Browser
Mobile".

[Napomene]

e Prethodno onemogudite nacin za automatsko
iskljucivanje i zaklju¢avanje zaslona.

e Dodirnite i drzite uredaj dok se ne pokrene
aplikacija "Content Browser Mobile" (od 1do 2
sekunde).
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4. Mrezne funkcije: Povezivanje s drugim uredajima putem mreze LAN

Povezivanje s uredajem kompatibilnim s

protokolom WPS

Protokol WPS omogucuje povezivanje uredaja
koji podrzavaju protokol WPS.

1 Odaberite funkciju Wireless LAN >Setting
>Access Point Mode u izborniku Network
cijelog izbornika.

2 Odaberite funkciju Wireless LAN >WPS
>Execute u izborniku Network cijelog
izbornika.

3 Otvorite mreZne postavke uredaja ili
postavke za Wi-Fi na uredaju i ukljucite
Wi-Fi.

4 S popisa identifikatora SSID pod Wi-Fl
Network na uredaju odaberite SSID
videokamere, a zatim pod Option na
uredaju odaberite WPS Push Button
kako biste se povezali.

[Napomene]

e Metode rada razlikuju se ovisno o uredaju.

e SSID i lozinku videokamere potraZzite pod AP
Mode Settings >Camera SSID & Password

(stranica 95) u izborniku Network cijelog
izbornika.

5 Povezite putem aplikacije Content
Browser Mobile.

Povezivanje unosom identifikatora SSID
i lozinke u uredaj

Videokameru mozete povezati s uredajem
unosom identifikatora SSID i lozinke u uredaj.

1 Odaberite funkciju Wireless LAN >Setting
>Access Point Mode u izborniku Network
cijelog izbornika.

2

3

Otvorite mrezne postavke uredaja
ili postavke za Wi-Fi na uredaju
i ukljucite Wi-Fi.

Povezite uredaj s videokamerom
odabirom identifikatora SSID videokamere
na popisu identifikatora SSID pod Wi-Fi
Network i unosom lozinke.

SSID i lozinku videokamere potrazite pod
AP Mode Settings >Camera SSID &
Password (stranica 95) u izborniku
Network.

[Napomena]
Metode rada razlikuju se ovisno o uredaju.

PoveZite putem aplikacije Content
Browser Mobile.

Povezivanje s Wireless LAN Station
Mode

Videokamera se kao klijent povezuje

s postojecom pristupnom tockom bezi¢ne
mreze LAN. Videokamera i uredaj povezuju
se putem pristupne tocke.

U povijesti se prikazuje 10 pristupnih tocki

s kojima je ostvarena veza.

Povijest veza sprema se u datoteci ALL,

no pristupne lozinke ne spremaju se. Pri
sliedecem povezivanju nakon unosa datoteke
ALL nuzno je unijeti lozinku.

Pametni Racunalo
telefon/tablet

Pristupna tocka

[

Povezivanje s pristupnom tockom
funkcijom WPS

Ako je pristupna toc¢ka kompatibilna
s funkcijom WPS, s pristupnom tockom
povezuje se s jednostavnim postavkama.

1 Ukljucite pristupnu tocku.
2 Ukljucite videokameru.

3 Odaberite funkciju Wireless LAN >Setting
> Station Mode u izborniku Network
cijelog izbornika.

4 Odaberite funkciju ST Mode Settings
>Camera Remote Control (stranica 95)
>Enable u izborniku Network cijelog
izbornika.

5 Odaberite funkciju Wireless LAN >WPS
>Execute u izborniku Network cijelog
izbornika.

6 Pritisnite gumb WPS na pristupnoj tocki.
ViSe detalja o radu s gumbom WPS
potrazite u uputama za upotrebu
pristupne tocke.

Nakon uspjesSnog povezivanja ikona
indikatora statusa mreZe na zaslonu
trazila prikazuje 1ili vise.
[Napomena]

Ako povezivanje ne uspije, ponovno provedite
korake od prvog koraka.

7 PoveZite uredaj s pristupnom tockom.
Pojedinosti o povezivanju potrazZite
u uputama za upotrebu uredaja.

8 PoveZite putem aplikacije Content
Browser Mobile.



58HR

4. Mrezne funkcije: Povezivanje s drugim uredajima putem mreze LAN

Povezivanje s pristupnom tockom
automatskim ili ru¢nim otkrivanjem
mreze

Vezu za povezivanje sa Zeljenom pristupnom
tockom moguce je konfigurirati u cijelom
izborniku.

Vezu za povezivanje sa Zeljenom pristupnom
tockom moguce je konfigurirati funkcijom
automatskog otkrivanja mreze.

Povezivanje funkcijom automatskog otkrivanja
mreze

1 Provedite korake od 1do 3 pod
"Povezivanje s pristupnom tockom
funkcijom WPS" (stranica 57).

2 Odaberite funkciju ST Mode Settings
>Scan Networks (stranica 96) >Execute
u izborniku Network cijelog izbornika.
Videokamera pocinje traZiti odredista
Za povezivanje.
Pronadena moguca odredista prikazuju
se na popisu.

3 Odaberite odrediste s popisa.
Prikazuje se zaslon se detaljima o mrezi
(pristupnoj tocki). Odabrana veza
prikazuje se pod SSID.

4 Odaberite Password i postavite lozinku
na zaslonu za unos lozinke.
Odabirom identifikatora SSID u povijesti
veza automatski se konfiguriraju postavke,
ukljucujudi lozinku.
Odaberite lozinku za povratak na zaslon
se detaljima o mreZi (pristupnoj tocki).

5 Konfigurirajte sljedece mreZne postavke.

e DHCP
Postavite postavke za DHCP.
Kada ukljucite postavljanjem na On,
IP adresa automatski se dodjeljuje
videokameri.
Za ru¢nu dodjelu IP adrese videokameri
iskljucite postavljanjem na Off.

e |P Address
Unesite IP adresu jedinice.
Postavka je dostupna samo kada
je DHCP isklju¢en s Off.

e Subnet Mask
Unesite masku podmreZe jedinice.
Postavka je dostupna samo kada
je DHCP iskljucen s Off.

e Gateway
Unesite pristupnik za pristupnu tocku.
Postavka je dostupna samo kada je
DHCP iskljucen s Off.

e DNS Auto
Postavljanje automatskog dohvata
sustava DNS.
Kada ukljucite postavljanjem na
On, adresa posluZitelja sustava DNS
automatski se dohvaca. Postavka je
dostupna samo kada je DHCP ukljucen
s On.

e Primary DNS Server
Unesite primarni posluZitelj sustava
DNS za pristupnu tocku.
Postavka je dostupna samo kada je
funkcija DNS Auto isklju¢ena s Off.

e Secondary DNS Server
Unesite sekundarni posluzitelj sustava
DNS za pristupnu tocku.
Postavka je dostupna samo kada je
funkcija DNS Auto iskljucena s Off.

6 Po dovrsetku odaberite Connect kako

biste se povezali s pristupnom tockom.

Rucno povezivanje

Provedite korake od 1 do 3 pod
"Povezivanje s pristupnom to¢kom
funkcijom WPS” (stranica 57).

Odaberite funkciju ST Mode Settings
>Manual Register (stranica 96)
>Execute u izborniku Network cijelog
izbornika.

Trenutacno se prikazuje se zaslon se
detaljima o mreZi (pristupnoj tocki).

Konfigurirajte sljede¢e mreZne postavke.
e SSID

Unesite SSID za pristupnu tocku veze.
e Security

Odaberite metodu Sifriranja.
e Password

Unesite lozinku za pristupnu tocku veze.

e DHCP
Postavite postavke za DHCP.
Kada ukljucite postavljanjem na On,
IP adresa automatski se dodjeljuje
videokameri.
Za ru¢nu dodjelu IP adrese videokameri
iskljucite postavljanjem na Off.

e |P Address
Unesite IP adresu jedinice.
Postavka je dostupna samo kada je
DHCP iskljucen s Off.

e Subnet Mask
Unesite masku podmreze jedinice.
Postavka je dostupna samo kada je
DHCP iskljucen s Off.

e Gateway
Unesite adresu pristupnika.
Postavka je dostupna samo kada je
DHCP iskljucen s Off.

e DNS Auto

Postavljanje automatskog dohvata
sustava DNS.

Kada ukljucite postavljanjem na

On, adresa posluzitelja sustava DNS
automatski se dohvaca. Postavka je
dostupna samo kada je DHCP ukljucen
s On.

Primary DNS Server

Unesite adresu primarnog posluZzitelja
sustava DNS.

Postavka je dostupna samo kada je
funkcija DNS Auto isklju¢ena s Off.
Secondary DNS Server

Unesite adresu sekundarnog posluzitelja
sustava DNS.

Postavka je dostupna samo kada je
funkcija DNS Auto isklju¢ena s Off.

4 Po dovrsetku odaberite Connect kako
biste se povezali s pristupnom tockom.
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Povezivanje s uredajem s kabelom 2
za LAN 3

Povezivanje s uredajem moZete napraviti
povezivanjem Zi¢ne priklju¢nice za LAN Zi¢nog
adaptera za LAN (nije obavezno) koja je 4
spojena na USB-C priklju¢nicu (stranica 7)
videokamere s Wi-Fi usmjerivacem (nije

obavezno) s pomocu kabela za LAN.

Pametni telefon/tablet

E I

Wi-Fi usmjerivac

Veze kabelom za LAN i postavke zi¢ne
mreze LAN

1 Povezite zi¢nu priklju¢nicu za LAN zZi¢nog
adaptera za LAN s Wi-Fi usmjerivacem
s pomocu kabela za LAN.

Ukljucite videokameru.

Postavite funkciju Wired LAN >Setting
(stranica 97) u izborniku Network
cijelog izbornika na On.

Konfigurirajte postavke veze s Wired LAN
>Detail Settings (stranica 97) u
izborniku Network.

DHCP

Postavite postavke za DHCP.

Kada ukljucite postavljanjem na On,
IP adresa automatski se dodjeljuje
videokameri.

Za ru¢nu dodjelu IP adrese videokameri
iskljucite postavljanjem na Off.

IP Address

Unesite IP adresu jedinice.

Postavka je dostupna samo kada je
DHCP iskljucen s Off.

Subnet Mask

Unesite masku podmreze jedinice.
Postavka je dostupna samo kada je
DHCP iskljucen s Off.

Gateway

Unesite adresu pristupnika.

Postavka je dostupna samo kada

je DHCP iskljucen s Off.

DNS Auto

Postavljanje automatskog dohvata
sustava DNS.

Kada ukljucite postavljanjem na On, adresa
posluZitelja sustava DNS automatski se
dohvaca. Postavka je dostupna samo kada
je DHCP ukljucen s On.

Primary DNS Server

Unesite adresu primarnog
posluzitelja sustava DNS.

Postavka je dostupna samo kada je
funkcija DNS Auto iskljuc¢ena s Off.

e Secondary DNS Server
Unesite adresu sekundarnog
posluzitelja sustava DNS.
Postavka je dostupna samo kada je
funkcija DNS Auto iskljucena s Off.

5 Po dovrsetku odaberite Set za primjenu
postavki.

[Napomene]

e Nakon promjena postavki veze uvijek odaberite Set.
Postavke se ne primjenjuju ako ne odaberete Set.

e Upotrijebite Zi¢ni adapter za LAN USB Type C.
Preporucuje se upotreba kompatibilnog adaptera
Gigabit Ethernet. Medutim, rad nije zajamdcen sa svim
uredajima.

e MozZe utjecati na funkciju Wi-Fi komunikacije, ovisno
o modelu Zi¢nog adaptera za LAN (nije obavezno).
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Povezivanje s internetom

Videokameru s internetom mozZete povezati
dijeljenjem putem USB-a, zicnom mreZzom LAN
ili bezicnom mrezom LAN.

Povezivanje dijeljenjem putem USB-a

Jedinicu mozete spojiti s pametnim telefonom
putem USB kabela i zatim je povezati na
internet s pomocu pametnog telefona.

Konfiguracija komunikacije s pametnim
telefonom

Omogucavanje dijeljenja komunikacije

na pametnom telefonu.

Pojedinosti potraZite u uputama za upotrebu
pametnog telefona.

Postavljanje pametnog telefona na
videokameru

Spojite USB kabel na priklju¢nicu USB-C
(stranica 7) videokamere i zatim spojite
pametni telefon.

[Napomene]

e Pametni telefon postavite/uklonite dok je
videokamera iskljucena.

e Dijeljenje putem USB-a nije moguce ako je pametni
telefon spojen putem USB koncentratora.

o Dijeljenje putem USB-a nije moguce ako je racunalo
postavljeno na priklju¢nicu USB/multi (stranica 7).

Spajanje s mrezom
1 Ukljucite videokameru.

2 Postavite funkciju Modem >Setting
(stranica 97) izbornika Network cijelog
izbornika na On.

Omogucavanje rada s pametnog telefona

Za upravljanje videokamerom na daljinu

s pomocu aplikacije Content Browser Mobile na
pametnom telefonu postavite funkciju Modem
>Camera Remote Control (stranica 95) u
izborniku Network cijelog izbornika na Enable.

Povezivanje s Wireless LAN Station
Mode

Videokameru moZete povezati s internetom u
nacinu za stanicu za Wi-Fi s opcionalnim Wi-Fi
usmjerivacem ili dijeljenjem s drugim uredajem.

Pametni Racunalo

telefon/tablet

—

>
S

—

e

Internet

O

Internet

Pametni
telefon/tablet

PoveZite s Wi-Fi usmjerivacem ili uredajem
kako je opisano u odjeljku “Povezivanje s
Wireless LAN Station Mode” (stranica 57).

Povezivanje s kabelom za LAN

Povezivanje na internet moZete napraviti
povezivanjem zi¢ne priklju¢nice za LAN Zi¢nog
adaptera za LAN (nije obavezno) koja je
spojena na USB-C priklju¢nicu (stranica 7)
videokamere s Wi-Fi usmjerivacem (nije
obavezno) s pomocu kabela za LAN.

Pametni Racunalo

telefon/tablet

!
=
SN—V/

Wi-Fi usmjerivac

Internet

Povezite s Wi-Fi usmjerivacem ili uredajem
kako je opisano u odjeljku “Povezivanje s
uredajem s kabelom za LAN" (stranica 59).

[Napomene]

¢ Nije moguce upotrebljavati Zi¢ni USB adapter za LAN
ako je racunalo postavljeno na priklju¢nicu USB/multi
(stranica 7).

e MozZe utjecati na funkciju Wi-Fi komunikacije, ovisno
o modelu Zi¢nog adaptera za LAN (nije obavezno).
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Prijenos datoteka

Datoteku proxy ili originalnu datoteku snimljenu
na videokameru moZete prenijeti na posluZzitelj
na internetu ili posluZitelj u lokalnoj mreZi putem
pametnog telefona ili pristupne tocke.

Pripreme

Spajanje s mrezom

PoveZite videokameru s internetom ili lokalnom
mrezom prateci upute pod “Povezivanje s
internetom” (stranica 60) ili “Povezivanje

s drugim uredajima putem mreze LAN"
(stranica 56).

Registriranje odredista za prijenos
datoteke

Unaprijed registrirajte posluZitelj za prijenos.

1 Odaberite funkciju File Transfer >Server
Settings1 (ili Server Settings2, Server
Settings3) u izborniku Network cijelog
izbornika.

Prikazuje se zaslon za postavljanje
odredista prijenosa.

2 Postavite svaku stavku na zaslonu za
postavljanje odredista prijenosa.
Display Name
Unesite naziv posluZzitelja koji se prikazuje
u popisu za odrediSte prijenosa.
Service
Prikazuje vrstu posluZzitelja.

“FTP": Posluzitelj FTP

Host Name

Unesite adresu posluZitelja.

Port

Unesite broj ulaza na koji se prikljucuje
posluzitelj.

User Name

Unesite korisnic¢ko ime.

Password

Unesite lozinku.

Passive Mode

Ukljucite/iskljucite pasivni nacin rada.
Destination Directory

Unesite naziv mape na odrediSnom
posluzitelju.

[Napomene]

e Priuredivanju, "O0" oznacava znakove koje nije
moguce mijenjati. Pri uredivanju naziva mape koji
sadrzi te znakove ispravan rad nije zajamcen.
Ako trebate urediti, izbrisite sve znakove
i ponovno unesite vrijednost.

e Ako pod Destination Directory unesete znakove
koji nisu valjani na odrediSnom posluZitelju,
datoteke se prenose u pocetnu mapu korisnika.
Znakovi koji nisu valjani razlikuju se ovisno
o posluZitelju.

Using Secure Protocol

Postavljanje provedbe sigurnog prijenosa
FTP.

Root Certificate

Ucitavanje/brisanje certifikata.

e |oad
U 3. koraku odaberite Set za uvoz
certifikata CA.

* Certifikat koji treba ucitati mora biti u PEM
formatu s nazivom datoteke ,certification.pem”
i treba biti zapisan u korijenskom direktoriju
memorijske kartice umetnute u utor za CFexpress
Type A karticu / SD karticu (B).

e Clear
U 3. koraku odaberite Set za brisanje
certifikata CA.

e None

Bez ucitavanja ili brisanja certifikata.

[Napomene]

e Prije uvoza certifikata CA sat videokamere
postavite na to¢no vrijeme.

e Pri snimanju u formatu XAVC-1 4096x2160P/
3840x2160P 59.94/50P funkciju Load nije
moguce odabrati.

e U stanju slabog napajanja za certifikat CA nije
moguce odabrati funkcije Load/Clear.

Root Certificate Status

Prikazuje status ucitavanja certifikata.
Reset

Postavke pod Server Settings ponovno
postavlja na zadane vrijednosti.

Po dovrsetku odaberite Set za primjenu
postavki.

Nakon promjena postavki uvijek odaberite
Set. Postavke se ne primjenjuju ako ne
odaberete Set.

Odabir datoteke i prijenos

MozZete odabrati proxy datoteke ili originalne
datoteke snimljene na memorijske kartice za
prijenos na server.

Ucitavanje proxy datoteke na memorijsku
karticu sa zaslona s minijaturama

1 PoveZite videokameru i uredaj vezom LAN
(stranica 56).

2 Odaberite funkciju Transfer Clip (Proxy)
>Select Clip u izborniku Thumbnail cijelog
izbornika.

Zaslon s prikaza cijelog izbornika prelazi
na zaslon s minijaturama.

Isjecke je moguce prenositi sa zaslona s
minijaturama ili zaslona s minijaturama

filtriranih isjecaka.

3 Odaberite isjecak koji Zelite prenijeti, a
zatim pritisnite gumb MENU.
Na zaslonu se prikazuje potvrda za
prijenos.

4 Odaberite Execute.
Datoteka proxy koja odgovara odabranoj
datoteci registrira se kao zadatak
prijenosa i zapocinje prijenos.
Po uspjesnoj registraciji zadatka prijenosa
prikazuje se zaslon s rezultatima prijenosa.

5 Odaberite OK.

Prijenos svih datoteka

U 2. koraku umjesto Select Clip odaberite All
Clips kako biste prenijeli sve datoteke proxy
koje odgovaraju svim datotekama.

[Napomena]
Moguce je prenijeti do 200 datoteka.
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4. Mrezne funkcije: Prijenos datoteka

Ucitavanje originalne datoteke na
memorijsku karticu sa zaslona
s minijaturama

1 Povezite videokameru i uredaj vezom

LAN (stranica 56).

2 Odaberite funkciju Transfer Clip >Select Clip
u izborniku Thumbnail cijelog izbornika.
Zaslon s prikaza cijelog izbornika prelazi
na zaslon s minijaturama.

Isjecke je moguce prenositi sa zaslona s
minijaturama ili zaslona s minijaturama
filtriranih isjecaka.

3 Odaberite isjecak koji Zelite prenijeti,
a zatim pritisnite gumb MENU.
Na zaslonu se prikazuje potvrda
za prijenos.

4 Odaberite Execute.
Odabrana datoteka registrira se kao
zadatak prijenosa te zapocinje prijenos.
Po uspjednoj registraciji zadatka prijenosa
prikazuje se zaslon s rezultatima
prijenosa.

5 Odaberite OK.

Prijenos svih datoteka
Za prijenos svih datoteka u 2. koraku umjesto
Select Clip odaberite All Clips.

[Napomena]
Moguce je prenijeti do 200 datoteka.

Provjera prijenosa datoteka

Status datoteke mozete provjeriti odabirom
funkcije File Transfer >View Job List

(stranica 97) u izborniku Network cijelog
izbornika.

MoZete i provjeriti status prijenosa datoteke
na zaslonu aplikacije Content Browser Mobile.

[Savjet]

Ako je funkcija File Transfer >Auto Upload (Proxy)
(stranica 97) u izborniku Network cijelog izbornika
postavljena na On, a postoji mrezna veza, po dovrsetku
snimanja datoteke proxy automatski se prenose

na posluzitelj naveden pod Default Upload Server
(stranica 97).

[Napomene]

e Moguce je registrirati do 200 zadataka prijenosa.

e Popis zadataka zadrZava se nakon iskljucenja
videokamere, no do 10 minuta posljednjih informacija
o napretku moze se izgubiti pri uklanjanju kompleta
baterija ili ako se videokamera iskljuci bez prethodnog
postavljanja sklopke napajanja na STANDBY.

e Zadaci dodani nakon stanja niske napunjenosti
baterije ne spremaju se na popis zadataka.

e Ako tijekom prijenosa datoteka dode do pogreske,
ovisno o postavkama i statusu odredisnog posluZitelja
za prijenos, mozda se nece nastaviti prijenos isjecka
s nazivom jednakim onom prenosenog isjecka. U
tom slucaju provjerite postavke i status odrediSnog
posluZitelja za prijenos.

Prijenos sigurnim protokolom FTP

Primjenom funkcije FTPS u nacinu Explicit
(FTPES) za vezu s odredisnim podatkovnim
posluziteljem moZzete prenositi Sifrirane
datoteke.

Postavljanje sigurnog prijenosa FTP

Za sigurni prijenos FTP funkciju Using Secure
Protocol na odrediSnom podatkovnom
posluzitelju ukljucite postavljanjem na

ON i uvezite certifikat.

Detalje o konfiguraciji potraZite pod
“Registriranje odredista za prijenos datoteke”
(stranica 61).
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5. Zaslon Thumbnail

Zaslon Thumbnail

Kada pritisnete gumb THUMBNAIL (stranica 5), isjecci snimljeni na memorijsku karticu na zaslonu prikazuju se kao minijature.

Na zaslonu s minijaturama moZete odabrati isjeCak i pokrenuti njegovu reprodukciju. Reproducirana slika moze se prikazivati na trazilu i na vanjskom monitoru.
Ponovnim pritiskom gumba THUMBNAIL zatvara se zaslon s minijaturama i vraca na sliku kamere.

[Napomena]

Na zaslonu s minijaturama prikazuju se samo isjecci snimljeni u trenuta¢no odabranom formatu snimanja. Ako se ocekivani snimljeni isje¢ak ne prikazuje, provjerite format snimanja. Posebnu paznju na ovo obratite prije formatiranja
(inicijaliziranja) medija.

Raspored na zaslonu

Informacije o isjecku u poloZaju pokazivaca prikazuju se na dnu zaslona.

Trenutac¢no odabran indikator memorijske kartice
(Ako je kartica zasticena, prikazuje se ikona lokota).

Broj isjecka/ukupan broj isjecaka

I
> (#8)[(0001/0060)

Pokazivac (Zuti) —x=¢}

TCR00:00:00:12 TCR00:00:00:15 TCR00:00:00:34

A

-
TCR 00:00:01:56 TCR 00:00:02:35
TCR 00:00:05:21
2 G (27,un 2014 1220 A s
( | ) ( | ) ( | )
3 4 5
1. Minijatura (indeksna slika) Caption u izborniku Thumbnails cijelog 4. Posebne informacije o snimanju
Prikaz indeksne slike isjecka. Kada se snimi izbornika. Prikaz nacina snimanja, samo ako je isjecak

isjecak, prvi kadar automatski se odabire
za indeksnu sliku.

Informacije o isjecku/kadru prikazuju se
ispod minijature. Informacije koje se prikazuju 3. Format snimanja videozapisa

moZete promijeniti s pomocu funkcije Prikaz formata datoteke odabranog isjecka.
Customize View (stranica 92) >Thumbnail 6. Datum izrade

snimljen u posebnom nacinu snimanja.
Brzina prijenosa u bitovima isjecaka Slow &
Quick Motion prikazuje se na desnoj strani.

2. Naziv isjecka
Prikaz naziva odabranog isjecka.

5. Trajanje isjecka
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Reprodukcija isjecaka

Reprodukcija snimljenih isjecaka

Snimljene isjecke moguce je reproducirati
kada je videokamera u nacinu pripravnosti
za snimanje (Stby).

Umetnite memorijsku karticu
za reprodukciju.

2 Pritisnite gumb THUMBNAIL.

3 Primijenite viSestruki birac (stranica 7)
ili viSenamjenski kotaci¢ (stranica 5) za
pomicanje pokazivaca do minijature
isjecka koji zZelite reproducirati.

4 Pritisnite gumb za primjenu visestrukog
biraca ili viSenamjenski kotacic.
Zapocinje reprodukcija od pocetka
odabranog isjecka.

Reprodukcijom moZete upravljati pritiskanjem
sljedecih gumba.
Pritisnite gumb za primjenu visestrukog
biraca ili viSenamjenski kotaci¢:
Pauzira reprodukciju.
Ponovno pritisnite za povratak na
normalnu reprodukciju.
Pritisnite gumbe za lijevo/desno viSestrukog
biraca:
skok na pocetak isjecka/pocetak sljedeceg
isjecka.
Pritisnite i drzite gumbe za lijevo/desno
viSestrukog biraca:
brzo premotavanje natrag/naprijed.
Po otpustanju gumba vracate se na
normalnu reprodukciju.
Gumb CANCEL/BACK:
zaustavljanje reprodukcije i povratak
u nacin pripravnosti za snimanje.

[Napomene]

e Na granici izmedu isjecaka moZe doci do trenutnog
prekida slike ili prikaza fotografije. Tijekom tog
razdoblja nemoguce je upravljati videokamerom.

e Kada odaberete isjecak na zaslonu s minijaturama
i pokrenete reprodukciju, moZe doci do trenutnog
prekida slike na pocetku isjecka. Za gledanje pocetka
isjecka bez prekida, stavite videokameru u nacin rada
za reprodukciju, pauzirajte, upotrijebite gumb za lijevo
viSestrukog biraca za povratak na pocetak isjecka
i ponovno reproducirajte.
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Operacije s isjeccima

Na zaslonu s minijaturama moZete upravljati
isjeccima ili provjeriti svojstva isjecka s
pomocu izbornika Thumbnail cijelog izbornika.
Izbornik Thumbnail (stranica 92) pojavljuje

se kada pritisnete i drzite gumb MENU

i odaberete Thumbnail.

Operacije u izborniku Thumbnail

Pritisnite viSestruki birac (stranica 7) ili
visenamjenski kotacic¢ (stranica 5) za

odabir funkcije, a zatim pritisnite gumb za
primjenu visestrukog biraca ili viSenamjenski
kotacic.

Pritisnite gumb CANCEL/BACK (stranica 5)
za povratak na prethodni zaslon.

[Napomenal]

Ovisno o stanju pri prikazu izbornika, neke stavke
nemoguce je odabrati.

Stavke izbornika za operacije s isje¢cima

Display Clip Properties
Set Clip Flag
Lock/Unlock Clip
Delete Clip

Transfer Clip

Transfer Clip (Proxy)
Filter Clips

Customize View

Detalje o stavkama izbornika s operacije s
isjeccima pogledajte u izborniku Thumbnail
(stranica 92).

Prikaz svojstava isjecka

Za prikaz zaslona sa svojstvima isjecka
odaberite Display Clip Properties
(stranica 92) u izborniku Thumbnail.

Dodavanje zastavica za isjecak

MozZete dodati zastavice za isjecak (oznake OK,
NG ili KP) isjeccima kako biste filtrirali prikaz
isjecaka na temelju zastavica za isjecak.
Odaberite minijaturu isjecka kojemu Zelite
dodati zastavicu za isjecak, a zatim odaberite
zastavicu za isjeCak s pomocu funkcije Set Clip
Flag (stranica 92) u izborniku Thumbnail
cijelog izbornika.

Setting Dodana zastavica za
isjecak

Add OK U redu

Add NG NG

Add KEEP KP

[Savjeti]

e Za dodavanje zastavica za isje¢ak moZete upotrijebiti
i dodjeljivigumb kojemu je dodijeljena funkcija
zastavice za isjecak (stranica 48).

e Zastavicu za isjecak OK moZete dodati minijaturi
odabranog isjecka (stranica 50) pritiskom gumba
Clip Flag (stranica 5).

Prikaz zaslona s minijaturama

s filtriranim isjeccima

Odaberite funkciju Filter Clips (stranica 92)

u izborniku Thumbnail cijelog izbornika

i odaberite vrstu zastavice za isjecak za prikaz
samo onih isjecaka s tom zastavicom.

Za prikaz svih isjecaka odaberite All.

[Savjet]
Takoder moZete redom uklapati filtre gumbom DISPLAY.

Brisanje isjecaka

S memorijske kartice moguce je izbrisati
isjecke.
Odaberite funkciju Delete Clip >Odaberite
Clip ili All Clips u izborniku Thumbnail cijelog
izbornika.
Select Clip:

Brisanje odabranog isjecka. Podrzan

je odabir vide isjecaka.
All Clips:

brisanje svih prikazanih isjecaka.

Promjena informacija koje se prikazuju
na zaslonu s minijaturama

Informacije o isjecku/kadru ispod minijature
mogucde je promijeniti.
Odaberite funkciju Customize View
>Thumbnail Caption u izborniku Thumbnail
cijelog izbornika i odaberite informacije koje
Zelite prikazati.
Date Time:

prikaz datuma i vremena nastanka

i posljednje izmjene isjecka.
Time Code:

prikaz vremenskog koda.
Trajanje:

prikaz trajanja isjecka.
Sequential Number:

prikaz rednog broja na svakoj minijaturi.
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6. Prikaz i postavke izbornika

Konfiguracija i hijerarhija cijelog izbornika

Pritisnite i drzite gumb MENU kako biste na
trazilu prikazali cijeli izbornik i odabrali razli¢ite
stavke za snimanje, spremanje i reprodukciju
(izbornik je takoder moguce prikazati na
vanjskom monitoru). Cijeli izbornik sastoji se
od sljedecih izbornika.

Konfiguracija izbornika

Izbornik User
Obuhvaca stavke izbornika koje
konfigurira korisnik izbornikom Edit User
Menu.
Izbornik Edit User
Obuhvaca stavke izbornika za uredivanje
izbornika User.
Izbornik Shooting
Obuhvaca postavke za snimanje.
Izbornik Project
Obuhvaca osnovne postavke projekta.
Izbornik Paint/Look
Obuhvaca postavke za kvalitetu slike.
Izbornik TC/Media
Obuhvaca postavke za vremenske kodove
i medije za snimanje.
Izbornik Monitoring
Obuhvaca postavke za unos videozapisa i
prikaz na trazilu.
Izbornik Audio
Obuhvaca postavke za zvuk.
Izbornik Thumbnail
Obuhvaca postavke za prikaz minijatura.
Izbornik Technical
Obuhvaca postavke za tehnicke stavke.
Izbornik Network
Obuhvaca postavke za mreze.
Izbornik Maintenance
Obuhvaca postavke uredaja, primjerice sat
i jezik.

Noise Suppression

Flicker Reduce

SteadyShot

isklju¢eno

Marker

Hijerarhija cijelog izbornika Project Base Setting Audio Audio ulaz
Rec Format Audio Output
Cine El Setting Thumbnail Display Clip Properties
User Base Setting Simul Rec (Slicica) Set Clip Flag
(tggtr;\llils Focus Proxy Rec Lock/Unlock Clip
p S&Q Motion Interval Rec Delete Clip
LUT On/Off SDI/HDMI Rec Control Transfer Clip
Simul Rec Gumb za dodjelu Transfer Clip (Proxy)
Proxy Rec Assignable Dial Filter Clips
Interval Rec Multi Function Dial Customize View
Gumb za dodjelu User File Technical Color Bars
Assignable Dial All File ND Dial
Multi Function Dial Paint/Look Scene File Tally
All File Base Look HOLD Switch Setting
Clip Name Format Ponovno postavljanje Touch Operation
Format Media postavki boje Rec Review
VF Setting Crni Zum
Zebra Komprimiranje Handle Zoom
Zum Detalj Menu Settings
Menu Settings Matrix Fan Control
Izbornik Edit User Add Item Multi Matrix Objektiv
Customize Reset TC/Media Timecode Video Light Set
Shooting ISO/Gain/El TC Display APR
ND Filter Users Bit Camera Battery Alarm
Shutter HDMI TC Out Camera DCIN Alarm
Auto Exposure Clip Name Format Network Access Authentication
Bijeli Update Media BeZi¢ni LAN
White Setting Format Media AP Mode Settings
Offset White Monitoring Output On/Off ST Mode Settings
Focus Output Format Wired LAN
S&Q Motion Output Display Modem
LUT On/Off Prikaz - uklju¢eno/

File Transfer

Network Reset

VF Setting

Gamma Display Assist

Peaking

Zebra
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Odrzavanje

Language

Clock Set

All Reset

Hours Meter

Verzija
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Operacije cijelog izbornika

Pritisnite i drzite gumb MENU kako biste

na trazilu prikazali cijeli izbornik i odabrali
detaljne postavke (izbornik je takoder moguce
prikazati na vanjskom monitoru).

Komande izbornika

Gumb MENU (stranica 5)
Pritisnite i drZite za prikaz cijelog
izbornika. Pritisnite ponovno dok je
prikazan cijeli izbornik kako biste sakrili
izbornik.

Visestruki bira¢ (osmosmjerni D-upravljac

i gumbi za primjenu) (stranica 7)
Pritisnite gumbe D-upravljaca kako biste
pokazivac pomaknuli gore/dolje/lijevo/
desno za odabir stavki ili postavki
u izborniku.
Za primjenu odabrane stavke pritisnite
gumb za primjenu visestrukog biraca.

Visenamjenski kotacic¢ (stranica 5)
Okredite visSenamjenski kotacic¢ kako biste
pokazivac pomaknuli gore/dolje za odabir
stavki ili postavki u izborniku.
Za primjenu odabrane stavke pritisnite
viSenamjenski kotacic.

Gumb CANCEL/BACK (stranica 5)
Pritisnite za povratak na prethodni
izbornik. NedovrSena promjena se
odbacuje.

[Napomene]

o Cijeliizbornik nije moguce primijeniti u nacinu
povecanja za fokusiranje (stranica 40).

e Ovisno o stanju pri prikazu izbornika, neke stavke
nemoguce je odabrati.

Stavke izbornika za postavljanje

Unos niza znakova

Zakljucavanije i otkljucavanje izbornika

PritiS¢ite gumbe D-upravljaca ili okrecite
viSenamjenski kotaci¢ za pomicanje
pokazivaca do stavke koju Zelite postaviti,

a zatim pritisnite gumb za primjenu il

viSenamjenski kotaci¢ za odabir stavke.

e U podrucju za odabir stavki izbornika
prikazuje se do osam redaka.

Ako istovremeni prikaz dostupnih opcija
za stavku nije mogug, listajte kroz prikaz
pomicanjem pokazivaca gore/dolje.

e Za podstavke s velikim rasponom
postavljanja (primjerice od -99 do +99),
podrucje za postavljanje ne prikazuje se.
Trenutacna postavka istaknuta je kako bi se
prikazala mogucnost promjene vrijednosti.

e Odabirom [Execute] za funkciju izvodi se
odgovarajuca funkcija.

e Pri odabiru stavke koju je potrebno potvrditi
prije izvodenja privremeno se sakriva
izbornik i prikazuje potvrdna poruka.
Provjerite poruku i zatim odaberite Zelite
li izvesti ili odbaciti funkciju.

Kada odaberete stavku koja zahtjeva unos
znakova, primjerice naziv datoteke, prikazuje
se zaslon sa znakovima.

1

All File:File ID

Kurokawa_Scene 001 a

Bbcdefghi jk I m

n o p qr st

uv wiXxy z

2 3

1 Pritis¢ite gumbe D-upravljaca ili okredite
viSenamjenski kotaci¢ za odabir vrste
znakova, a zatim primijenite postavku.
ABC: velika slova
abc: mala slova
123: numericki znakovi
1#$: posebni znakovi

2 Odaberite znak iz odabrane vrste znakova

i primijenite postavku.

Pokazivac prelazi na sljedece polje.

Space: unos znaka razmaka u poloZzaj
pokazivaca.

«—/—: Promjena poloZaja pokazivaca.

BS: brisanje znaka lijevo od pokazivaca
(backspace).

3 Po dovrsetku odaberite [Done]
za primjenu postavki.
Niz znakova potvrduje se i uklanja
se zaslon za unos znakova.

Cijeli izbornik moguce je zakljucati tako

da se prikazuje samo izbornik User.

U ovom stanju postavke nije moguce mijenjati
s pomocu zaslona sa statusom.

Zakljucavanje izbornika

1 Pritisnite i zadrZite viSenamjenski kotaci¢,
a zatim pritisnite i drzite gumb MENU.

2 Odaberite Menu Settings >User Menu with
Lock u izborniku Technical.

[Napomena]

Kada pritisnete i drZite samo gumb MENU za prikaz
normalnog cijelog izbornika, prikaz User Menu

Only prikazuje se u funkciji Menu Settings izbornika
Technical. Pritisnite i zadrZite viSenamjenski kotacic,
a zatim pritisnite i drZzite gumb MENU za prikaz User
Menu with Lock.

3 Ukljucite postavljanjem na On, a zatim
pritisnite gumb za primjenu il
viSenamjenski kotacic.

Prikaz na zaslonu traZila prelazi na zaslon
za unos broja pristupnog koda.

4 Unesite proizvoljni broj.
Unesite Cetveroznamenkasti broj iz raspona
od 0000 do 9999. Zadana vrijednost je 0000.
Unesite broj i pritisnite gumb za primjenu ili
visenamjenski kotaci¢ kako biste pokazivac
pomaknuli na sljedecu znamenku.
Nakon unosa svih znamenki pomaknite
pokazivac na SET.

5 Pritisnite gumb za primjenu il
viSenamjenski kotacic.
Unos se primjenjuje.
Prikazuje se potvrdna poruka, a zaslon
prelazi na izbornik User.
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OtkljuCavanje izbornika

1

Pritisnite i zadrzite viSenamjenski kotacic,
a zatim pritisnite i drzite gumb MENU.

Odaberite Menu Settings >User Menu with
Lock u izborniku User.

[Napomenal]

Kada pritisnete i drzite samo gumb MENU za prikaz
normalnog cijelog izbornika, prikaz User Menu
Only prikazuje se u funkciji Menu Settings izbornika
Technical. Pritisnite i zadrZite viSenamjenski kotacic,
a zatim pritisnite i drzite gumb MENU za prikaz
User Menu with Lock.

Iskljucite postavljanjem na Off, a zatim
pritisnite gumb za primjenu ili
visenamjenski kotacic.

Prikaz na zaslonu trazila prelazi na zaslon
za unos broja pristupnog koda.

Unesite broj pristupnog koda kojim se
zakljucava izbornik.

Unesite broj i pritisnite gumb za primjenu ili
visenamjenski kotacic kako biste pokazivac
pomaknuli na sljedecu znamenku.

Nakon unosa svih znamenki pomaknite
pokazivac na Set.

Pritisnite gumb za primjenu

ili viSenamjenski kotacic.

Unos se primjenjuje.

Ako uneseni broj pristupnog koda
odgovara broju pristupnog koda kojim
se izbornik zakljucava, izbornik

se otkljucava i prikazuje.

e Ako se izbornik zakljuca bez registriranja stavki cijelog

izbornika iz sljedece tablice u izborniku User, te
funkcije nemoguce je dodijeliti dodjeljivim gumbima.

e Ako su te funkcije ve¢ dodijeljene dodjeljivim

gumbima, dodjeljiva postavka prisilno se
onemogucuje u trenutku zaklju¢avanja izbornika.

Stavke cijelog

Odabir dodjeljivog

Stavke cijelog
izbornika

Odabir dodjeljivog
gumba

Shooting >ISO/Gain/El
>Base Sensitivity,
Shooting >ISO/Gain/El>
Base ISO

Base ISO/Sensitivity

Shooting >Auto
Exposure >AGC

AGC

Auto ND Filter

Shooting >Auto
Exposure >Auto Shutter

Auto Shutter

Shooting >Auto
Exposure >Level

Auto Exposure Level

izbornika gumba
Thumbnail >Set Clip Clip Flag OK
Flag >Add OK

Thumbnail >Set Clip Clip Flag NG
Flag >Add NG

Thumbnail >Set Clip Clip Flag Keep
Flag >Add KEEP

Technical >Color Bars Color Bars
>Setting

Monitoring >Display Lens Info
On/Off >Lens Info

Monitoring >Display Video Signal
On/Off >Video Signal Monitor
Monitor

Monitoring >Marker Marker
>Setting

Monitoring >VF Setting VF Mode

>Color Mode

Shooting >Auto Backlight
Exposure >Mode
Shooting >Auto Reflektor

Exposure >Mode

Monitoring >Gamma
Display Assist >Setting

Gamma Display
Assist

Shooting >White >
Preset White

Preset White Select

Monitoring >Peaking Peaking
>Setting

Monitoring >Zebra Zebra
>Setting

Audio >Audio Output Volume

>Volume

Shooting >Focus > AF Speed/Sens.
AF Transition Speed,

Shooting >Focus >

AF Subj. Shift Sens.

Shooting >Focus > Focus Area

Focus Area

Technical >Touch
Operation >Setting

Touch Operation

Shooting >Focus >
Focus Area(AF-S)

Focus Area(AF-S)

Technical >Handle
Zoom >Setting

Handle Zoom

Shooting >Focus >
Face/Eye Detection AF

Face/Eye Detection
AF

Network >Wireless LAN
>NFC

NFC

Shooting >Focus >
Push AF Mode

Push AF Mode

Network >File Transfer
>Auto Upload (Proxy)

Auto Upload (Proxy)

User

User Menu

Shooting >S&Q Motion S&Q Motion
[Napomene] >Setting
e Ako uneseni broj pristupnog koda ne odgovara broju
pristupnog koda kojim se izbornik zaklju¢ava, izbornik Shooting >SteadyShot ~ SteadyShot
se ne otkljucava. >Setting
e Preporucuje se da u blizini zabiljeZite pristupni kod, Technical >Rec Review  Rec Review
u slucaju da ga zaboravite. Ako zaboravite broj >Setting

pristupnog koda, obratite se servisnom predstavniku
tvrtke Sony.
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lzbornik User

U ovom odjeljku opisana je funkcija i postavke za svaku stavku izbornika.

User

Stavka Opis

Base Setting Stavka Project >Base Setting
Focus Stavka Shooting >Focus

S&Q Motion Stavka Shooting >S&Q Motion
LUT On/Off Shooting >LUT On/Off item
Simul Rec Stavka Project >Simul Rec
Proxy Rec Stavka Project >Proxy Rec
Interval Rec Project >Interval Rec item

Gumb za dodjelu

Stavka Project >Assignable Button

Assignable Dial

Stavka Project >Assignable Dial

Multi Function Dial

Stavka Project >Multi Function Dial

All File

Stavka Project >All File

Clip Name Format

Stavka TC/Media >Clip Name Format

Format Media

Stavka TC/Media >Format Media

VF Setting Stavka Monitoring >VF Setting
Zebra Monitoring >Zebra item
Zum Technical >Zoom item

Menu Settings

Stavka Technical >Menu Settings

Izbornik Edit User

Prikaz zaslona izbornika Edit User.

[Napomena]

S izbornikom Edit User u izbornik User moZete dodavati iz njega uklanjati stavke izbornika. Moguce je konfigurirati do

20 stavki.
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lzbornik Edit User

Kada se u izborniku User odabere Edit User Menu, izbornik Edit User prikazuje se na gornjoj
razini.

Edit User

Stavka Postavka podstavke Opis

Add Item Dodaje stavku izbornika u izbornik

Dodaj stavku izborniku User.

User

Customize Reset Vraca stavke izbornika registriranih

Ponovno postavlja u izborniku User na tvornicke

stavke u izborniku User postavke.

Stavka izbornika Delete BriSe registriranu stavku izbornika

odabrana tijekom iz izbornika User.

uredivanja Move Mijenja raspored registriranih stavki

izbornika unutar izbornika User.

Edit Sub Item Ureduje (registriranje/brisanje)

registriranih podstavki izbornika
u izborniku User.
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6. Prikaz i postavke izbornika

|lzbornik Shooting

U ovom odjeljku opisana je funkcija i postavke za svaku stavku izbornika. Shooting >ISO/Gain/El
Tvornicki zadane postavke prikazuju se podebljane (na primjer 18dB). Postavljanje postavki jacine signala.
Shooting >ISO/Gain/El Stavka Postavka podstavke Opis
Postavljanje postavki jacine signala. Exposure (Iste postavke kao pod Exposure Index<H>) Postavlja vrijednost razine
Stavka Postavka podstavke Opis Index<M> Kada je Base ISO postavljen na ISO 800: ekspozicije <M>.
Mode ISO/dB Odabir nacina za postavljanje jacine 1000E1 / 6.3E

Kada je Base ISO postavljen na ISO 12800:

ISO/Gain<H> Detalj tavk trazit d Is;grlaIaI: jacanje signala <H 16000E1 / 6.3¢
<H> <H>
am N claje o pps av ama"po ra2|.e po - 0% a\./.Ja pOJacanJ.e S|gna.1. a na Exposure (Iste postavke kao pod Exposure Index<H>) Postavlja vrijednost razine
Postavke i zadane vrijednosti ISO/Gain unaprijed postavljenu vrijednost. : ) -
: Index<L> Kada je Base ISO postavljen na ISO 800: ekspozicije <L>.
(stranica 100). 800EI / 6.0E
ISO/Gain<M> Detalje o postavkama potrazite pod Postavlja pojacanje signala <M> na Kada—je Base iSO postavljen na ISO 12800:
"Postavke i zadane vrijednosti ISO/Gain" unaprijed postavljenu vrijednost. 12800EI / 6.0E ’
e (;”arl‘_'ca 100). - o T e Shockless  On / Off Ukljucenje/iskljucenje funkcije
ain<L> L etalje o postav ama”potra2|"te pod . osta\./.Ja pojacanje signala <L>na Gain postupnog pojatanja signala.
Postavke i zadane vrijednosti ISO/Gain unaprijed postavljenu vrijednost. - - - R o
(stranica 100) Base High / Low Postavlja temeljnu osjetljivost za nacin
E Kada je B iSO tavlj ISO 800: Postavlja vrijednost razi k icij Sensitvity SDR/HDR.
xposure adaje Base >4 postavijen na : OStavia vrljednost razine exspoziclie Base SO IS0 12800 / ISO 800 Postavlja temeljnu ISO osjetljivost za
Index<H> 200El / 4.0E <H>. %in Cine El
250El /7 4.3E Dostupno samo u nacinu Cine El. nacin +ine tl.
320El / 4.7E Shooting >ND Filter
400El / 5.0E Postavlja unaprijed postavljenu vrijednost za filtar ND.
500EI / 5.3E Stavka Postavka podstavke Opis
640El / 5.7E - " -
S00EI / 6.0E Presetl 1/4/1/8/1/16 /1/32/1/64 /1/128 Postavlja unaprijed postavljenu
1000El / 6.3F vrijednost 1 za filtar ND.
1250El / 6.7E Preset2 1/4/1/8/1/16 /1/32/1/64 / 1/128 Postavlja unaprijed postavljenu
1600EI / 7.0E vrijednost 2 za filtar ND.
2000EI / 7.3E Preset3 1/4/1/8/1/16 /1/32/1/64 /1/128 Postavlja unaprijed postavljenu
2500El / 7.7E vrijednost 3 za filtar ND.
Kadizjgcélils/eslécgpostavljen na ISO 12800: S =L
3200E| / 4.0F Postavljanje postavki za uvjete rada elektronickog zatvaraca.
4000EI / 4.3E Stavka Postavka podstavke Opis
5000El / 4.7E Mode Speed / Angle Odabir nacina rada elektroni¢kog
6400EIl / 5.0E zatvaraca.
8000EI / 5.3E Upotrebljava se za jasno za snimanje brzih
10000EI / 5.7E objekata. Odabir nacina za postavljanje
12800EI / 6.0E brzine zatvaraca u sekundama (Speed) ili
16000El / 6.3E kao kut zatvaraca (Angle).
20000EI / 6.7E Shutter On / Off Postavlja prati li vrijeme ekspozicije kada
25600E! / 7.0E Speed je odabran nacin Speed vrijednost
32000EI / 7.3E On/Off funkcije Shutter Speed ili je postavljena
40000EI / 7.7E na punu ekspoziciju.

51200EI / 8.0E
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Shooting >Shutter

Postavljanje postavki za uvjete rada elektronickog zatvaraca.

Shooting >Shutter
Postavljanje postavki za uvjete rada elektronickog zatvaraca.

Stavka Postavka podstavke Opis Stavka Postavka podstavke Opis
Brzina 64F to 1/8000 Postavlja brzinu zatvaraca kada je nacin ECS od 23,99 do 8000 Postavlja frekvenciju ECS kada je nacin
zatvaraca Dostupne postavke razlikuju se ovisno Mode postavljen na Speed. Frequency Dostupne postavke razlikuju se ovisno Mode postavljen na ECS.

o frekvenciji kadra odabranog formata

za videozapis.

59.94P:
64F / 32F /16F / 8F / TF / 6F / 5F / 4F /
3F/2F/1/50/1/60 /1/100 /1/120 /
17125 /1/250 /1/500 / 1/1000 /
1/2000 / 1/4000 / 1/8000

50P:
64F / 32F /16F / 8F / TF / 6F / 5F / 4F /
3F /2F /1/50/1/60 /1/100 / 1/120 /
17125 /1/250 /1/500 / 1/1000 /
1/2000 7/ 1/4000 / 1/8000

29.97P:
64F / 32F /16F / 8F / TF / 6F / 5F / 4F /
3F/2F/1/30/1/40 /1/50 /1/60 /
1/100 /17120 /1/125 / 1/250 / 1/500 /
1/1000 /7 1/2000 / 1/4000 / 1/8000

25P:
64F / 32F /16F / 8F / 7TF / 6F / 5F / 4F /
3F/2F/1/25/71/33/1/50/1/60 /
1/100 /17120 7/ 1/125 /1/250 / 1/500 /
1/1000 /7 1/2000 / 1/4000 / 1/8000

24P/23.98P:
64F / 32F /16F / 8F / TF / 6F / 5F / 4F /
3F/2F/1/24/1/32/1/48 /1/50 /
1/60 /1/96 /1/100 /1/120 / 1/125 /
1/250 7 1/500 /7 1/1000 7/ 1/2000 /

o frekvenciji kadra odabranog formata
za videozapis.

Zadane vrijednosti navedene su u nastavku.

59.94P: 60.00
50P: 50.00

29.97P: 30.00
23.98P: 23.99
25P: 25.02

24P: 24,02

Shooting >Auto Exposure
Postavljanje postavki za prilagodbu automatske ekspozicije.

1/4000 / 1/8000
Shutter Angle 64F /32F /16F / 8F / 7TF / 6F / 5F / 4F / Postavlja kut zatvaraca kada je nacin
3F / 2F /360.0° / 300.0° / Mode postavljen na Angle.

270.0° / 240.0° / 216.0° / 210.0° /
180.0° /172.8° /150.0° / 144.0° /
120.0° /7 90.0° / 86.4° / 72.0° / 45.0° /
30.0°/22.5°/11.25°/ 5.6°

ECS On/Off  On / Off

Ukljucenje/iskljucenje funkcije External
Clear Scan.

Stavka Postavka podstavke Opis
Level +3.0/+2.75/+25/+225/+2.0/+1.75/ Postavlja razinu svjetline za automatski
+1.5/+1.25/+1.0/+0.75/+0.5/+0.25 / otkrivenu ekspoziciju.
+0/-0.25/-05/-0.75/-1.0/-1.25/
-1.5/-175/-2.0/-225/-25/-275/-3.0
Mode Backlight / Standard / Spotlight Postavlja nacin rada za automatsko
podesavanje ekspozicije.
Backlight:
nacin za pozadinsko osvjetljenje (nacin
za smanjeno zatamnjenje objekta kada
je objekt pozadinski osvijetljen)
Standardna:
standardni nacin rada
Spotlight:
nacin za reflektor (nacin za smanjenu,
podrezanu bijelu boju kada je objekt
osvijetljen reflektorom)
Speed od -99 do +99 (x0) Postavlja brzinu podesavanja za
automatsko podeSavanje ekspozicije.
AGC On / Off Ukljucenje/iskljucenje funkcije
automatskog pojacanja signala, (AGC,
auto gain control).
Limit AGC-a  Detalje o postavkama potrazite pod Postavlja maksimalno pojacanje signala
"Postavke limita AGC-a i zadane za funkciju AGC.
vrijednosti" (stranica 102).
AGC Point F2.8 /F4 /F5.6 Postavlja vrijednost F-stop irisa kada

zapocinje operacija AGC uz funkciju AGC
ukljucenu postavljanjem na On.
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Shooting >Auto Exposure

Postavljanje postavki za prilagodbu automatske ekspozicije.

Shooting >White
Postavljanje postavki balansa bijele boje.

Stavka Postavka podstavke Opis Stavka Postavka podstavke Opis
Auto Shutter  On / Off Ukljucenje/iskljucenje funkcije Tint<A> od -99 do +99 (x0) Postavlja vrijednost nijanse balansa bijele boje
automatskog upravljanja zatvaracem. koja se sprema u memoriju A.
A.SHT Limit ~ 1/100 /1/150 / 1/200 / 1/250 / 1/2000 Postavlja najvecu brzinu zatvaraca [Napomenal
za funkciju automatskog zatvaraca. Buduci da se nijansa Tint pri operaciji R/B Gain
A.SHT Point  F5.6/F8/F11/F16 Postavlja vrijednost F-stop irisa pri podrezuje na 99, za vrijednost R/B Gain mozZe biti
pokretanju rada automatskog zatvaraca. moguce prikazati ispravnu vrijednost za Tint.
Clip High On / Off Uklju¢enje/isklju¢enje funkcije koja R Gain <A> od -99,0 do +99,0 (x0,0) Postavlja vrijednost pojacanja signala R balansa
light zanemaruje najsvjetlije povrine kako bi bijele boje koja se sprema u memoriju A.
se dobio plosniji odgovor na visoku B Gain <A> od -99,0 do +99,0 (x0,0) Postavlja vrijednost pojacanja signala B balansa
osvijetljenost. bijele boje koja se sprema u memoriju A.
Detect 1/2/3/4/5/6/ Custom Postavlja raspon mjerenja svjetlosti Color Temp od 2000 K do 15.000 K (3200K) Postavlja temperaturu balansa bijele boje koja
Window za automatsko podesavanje ekspozicije <B> se sprema u memoriju B.
su-kla(iino SVJet|InIVObJe|.(ta. (Nedo.s'.(‘upno [Napomena]
pri ruénom podesavanju ekspozicije) Buduci da se temperatura boje Color Temp pri
Detect On / Off Ukljucenje/iskljucenje raspona mjerenja operaciji R/B Gain podrezuje na 2000 K i 15.000 K,
Window svjetlosti. za vrijednost R/B Gain moZe biti moguce prikazati
Indication ispravnu vrijednost za Color Temp.
Custom od 40 do 999 (500) Postavlja &irinu raspona za mjerenje Tint<B> od -99 do +99 (*0) Po.stavlja vrijednost nijan.s.e balansa bijele boje
Width svjetlosti. koja se sprema u memoriju B.
Custom od 70 do 999 (500) Postavlja visinu raspona za mjerenje [Napomena]
Height svjetlosti. Buduci da se nijansa Tint pri operaciji R/B Gain
Custom H od -479 do +479 (x0) Postavlja vodoravni poloZaj raspona za pOdreZ,uJe r.‘; tg?’.za VrUEdno..Sth/B tGame;)ze bt
Position mierenje svjetlosti moguce prikazati ispravnu vrijednost za Tint.
C v 4264 do +464 (=0 b i3 okomiti : Iova R Gain <B> od -99,0 do +99,0 (x0,0) Postavlja vrijednost pojacanja signala R balansa
Pgs_tt(_)m od- o~ (0) QStaV!a o _OE"“tPO 0Ozajraspona za bijele boje koja se sprema u memoriju B.
sttion mjeren)e svjetiost. B Gain <B> od -99,0 do +99,0 (x0,0) Postavlja vrijednost pojacanja signala B balansa

Shooting >White
Postavljanje postavki balansa bijele boje.

bijele boje koja se sprema u memoriju B.

Stavka Postavka podstavke

Opis

Postavlja zadanu vrijednost balansa bijele boje.

Shooting >White Setting
Podesava postavke balansa bijele boje.

Preset White od 2000 K do 15.000 K (3200K)
Color Temp  0od 2000 K do 15.000 K (3200K)
<A>

Postavlja temperaturu balansa bijele boje koja
se sprema u memoriju A.

[Napomena]

Buduci da se temperatura boje Color Temp pri
operaciji R/B Gain podrezuje na 2000 K i 15.000 K,
za vrijednost R/B Gain moze biti moguce prikazati
ispravnu vrijednost za Color Temp.

Stavka Postavka podstavke

Opis

Shockless off/1/2/3 Postavlja brzinu odziva balansa bijele boje pri
White promjeni nacina balansa bijele boje.
Isklju¢eno: uklapa trenutacno.
od 1 do 3: uklapa sporije Sto je broj veci.
ATW Speed 1/72/3/74/5 Postavlja brzinu odziva u nacinu ATW.
1: najveca brzina odziva
White Memory / ATW Odabir nacina za podesavanje balansa bijele
Switch<B> boje koji se odabire pri postavljanju sklopke

WHT BAL na B.
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Shooting >White Setting
Podesava postavke balansa bijele boje.

Shooting >Offset White

Postavljanje postavki pomaka balansa bijele boje.

Stavka Postavka podstavke

Opis

Opis

Filter White
Memory

On / Off

Ukljucenje/iskljucenje funkcije koja postavlja

podrucje memorije balansa bijele boje za svaki

filtar ND.

Ukljuceno: postavlja memoriju balansa bijele
boje za svaki filtar ND.

[Savjet]

U unaprijed postavljenom nacinu cetiri su

postavke (CLEAR /1/ 2/ 3). U promjenjivom

nacinu dvije su postavke (CLEAR / On).
Isklju¢eno: postavlja zajedni¢ku memoriju

balansa bijele boje za sve filtre ND.

Stavka Postavka podstavke
Offset od -99 do +99 (x0)
Tint<ATW>

Postavlja vrijednost nijanse Tint koja se dodaje
balansu bijele boje ATW kada je funkcija Offset
White <ATW> uklju¢ena s On.

Shooting >Focus
Postavljanje postavki za fokusiranje.

Stavka Postavka podstavke

Opis

AF Transition 1(Slow)/2/3/4/5/6/7(Fast)
Speed

Postavlja brzinu pogona za fokusiranje za
promjene objekta tijekom automatskog
fokusiranja.

AF Subj. Shift  1(Locked On)/2/3/4/

Postavlja osjetljivost za promjenjivo

Shooting >Offset White Sens. 5(Responsive) izoétr.avar)je objekta tijekom automatskog
Postavljanje postavki pomaka balansa bijele boje. fokusiranja.
- Podrucje Wide / Zone / Flexible Spot Postavlja ciljno podrucje automatskog
Stavka Postavka podstavke Opis izoStrav. fokusiranja i automatskog fokusiranja
Offset White  On / Off Odabire treba li dodati (On) ili ne treba dodati pritiskanjem (AF) (stranica 37).
<A> (Off) vrijednost pomaka balansu bijele boje Siroko:
u memoriji A. pri fokusiranju traZi objekt kroz Siroki kut
Offset Color  od -99 do +99 (x0) Postavlja pomak temperature boje koji se slike.
Temp<A> dodaje balansu bijele boje u memoriji A kada je Zone:
funkcija Offset White <A> ukljucena s On. automatski pretrazuje toc¢ku za fokusiranje
Offset od -99 do +99 (x0) Postavlja vrijednost nijanse Tint koja se dodaje unutar odredene zone.
Tint<A> balansu bijele boje u memoriji A kada je Fleksibilni spot:
funkcija Offset White <A> uklju¢ena s On. fokusiranje u odredenu tocku na slici.
Offset White  On / Off Odabire treba li dodati (On) ili ne treba dodati Focus Area  Fleksibilni spot Postavlja ciljno podru¢je automatskog
<B> (Off) vrijednost pomaka balansu bijele boje u (AF-S) fokusiranja pritiskanjem (AF-S).
memoriji B. Face/Eye Face/Eye Only AF / Omogucivanje/onemogucivanje automatskog
Offset Color  od -99 do +99 (x0) Postavlja pomak temperature boje koji se Detection AF  Face/Eye Priority AF / Off fokusiranja s otkrivanjem lica.
Temp<B> dodaje balansu bijele boje u memoriji B kada je Push AF AF / Single-shot AF(AF-S) Postavlja nacin za automatsko fokusiranje
funkcija Offset White <B> ukljucena s On. Mode pritiskanjem.
Offset od -99 do +99 (x0) Postavlja vrijednost nijanse Tint koja se dodaje AF Assist On / Off Kada je funkcija postavljena na On, omogucuje
Tint<B> balansu bijele boje u memoriji B kada je privremeno premostenje automatskog
funkcija Offset White <B> ukljucena s On. fokusiranja i ru¢no postavljanje fokusa.
Offset White  On / Off Odabire treba li dodati (On) ili ne treba dodati
<ATW> (Off) vrijednost pomaka balansu bijele boje
ATW.
Offset Color  od-99 do +99 (x0) Postavlja pomak temperature boje koji se
Temp<ATW> dodaje balansu bijele boje ATW kada je funkcija

Offset White <ATW> ukljucena s On.




T6HR

6. Prikaz i postavke izbornika: 1zbornik Shooting

Shooting >S&Q Motion
Postavljanje postavki nacina Slow & Quick Motion (stranica 49).

Stavka Postavka podstavke Opis

Setting On / Off Ukljucenje/iskljucenje nacina Slow & Quick
Motion.
Kada je nacin ukljucen s On, sljedece funkcije su
onemogucene.

® Automatski iris
® Automatsko izoStravanje

Shooting >Noise Suppression

Postavljanje postavki za uklanjanje buke.

[Savjet]

Postavke Setting(Custom) i Level(Custom) odraZavaju se u postavci Target Display (stranica 104).
Stavka Postavka podstavke Opis
Level Low / Mid / High Postavlja razinu uklanjanja buke u nacinu Cine El.
(Cine El)

Frekvencija 0Od 1 fps do 60 fps 7/ 100 fps /120
okvira fps /150 fps /180 fps / 200 fps /
240 fps

Postavlja brzinu prijenosa za snimanja u nacinu
Slow & Quick Motion.

[Napomenal]
Dostupne postavke razlikuju se ovisno o odabranoj
frekvenciji sustava, kodeku i formatu videozapisa.

Shooting >Flicker Reduce

Postavljanje postavki za ispravljanje treperenja.

Shooting >LUT On/Off
Postavljanje postavki za LUT.

Stavka Postavka podstavke Opis
Mode Auto / On / Off Postavljanje nacina za ispravljanje treperenja.
Frekvencija 50Hz / 60Hz Postavljanje frekvencije izvora napajanja za

svjetlo koje uzrokuje treperenje.

Stavka Postavka podstavke Opis

Shooting >SteadyShot
Postavljanje postavki stabilizacije.

Stavka Postavka podstavke

Opis

SDI/HDMI MLUT On / MLUT Off Odabire treba li primijeniti LUT monitor na video

izlaz za SDI i HDMII.

VF/Proxy/ MLUT On / MLUT Off Odabire treba li primijeniti LUT monitor na
Stream trazilo, proxy i video izlaz za emitiranje.

Setting Active / Standard / Off

Postavlja funkciju stabilizacije slike.

[Napomena]
Omogucuje se kada je priklju¢en kompatibilan
objektiv.

Internal Rec  MLUT On / MLUT Off Odabire treba li primijeniti LUT monitor na
interno snimanje videozapisa.

Shooting >Noise Suppression
Postavljanje postavki za uklanjanje buke.

Savjet

Lostjavk]e Setting(Custom) i Level(Custom) odraZavaju se u postavci Target Display (stranica 104).
Stavka Postavka podstavke Opis
Setting On / Off Ukljucenje/iskljucenje funkcije uklanjanja buke
(Custom) u nacinu Custom.
Level Low / Mid / High Postavlja razinu uklanjanja buke u nacinu
(Custom) Custom.
Setting On / Off Ukljucenje/iskljucenje funkcije uklanjanja buke

(Cine EI) u nacinu Cine El.




6. Prikaz i postavke izbornika

|lzbornik Project

U ovom odjeljku opisana je funkcija i postavke za svaku stavku izbornika.
Tvornicki zadane postavke prikazuju se podebljane (na primjer 18dB).

Project >Rec Format
Postavljanje postavki za format snimanja.

Project >Base Setting
Postavljanje osnovnih postavki.

Stavka Postavka podstavke

Opis

Stavka Postavka podstavke Opis

Nacin Custom / Cine El Postavljanje nacina snimanja.
snimanja

Target SDR(BT.709) / HDR(HLG) Postavlja prostor boja snimanja/izlaza
Display u nacinu Cine El.

Project >Rec Format
Postavljanje postavki za format snimanja.

Stavka Postavka podstavke

Opis

Frekvencija 59,94 /50/29.97 /25 /24 /23.98 Odabir frekvencije sustava.

Imager Scan  FF 7/ S35 Postavljanje kombinacije metode

Mode ocitavanja pretraznika (svi pikseli/spajanje
piksela) i postavke veli¢ine pretraznika.

Kodek RAW / RAW & XAVC-1 / XAVC-I / XAVC-L Postavljanje nacina snimanja/reprodukcije.

RAW Output  Dostupne postavke razlikuju se ovisno o Postavlja format snimanja za vanjski RAW

Format postavkama pod Frequency i Codec. snimac.

Frekvencija Kodek Opcije za odabir
59,94 RAW 4096x2160
50 3840 x 2160
29,97 :
e RAW i 4096x2160
23,98 XAVCL 3840 x 2160
24 RAW 4096x2160
RAW i 4096x2160
XAVC-|

[Napomena]

Kada je Codec postavljen na RAW & XAVC-I,
postavka Video Format prebacuje se u vezi s
postavkom RAW Output Format.

Video Format Dostupne postavke razlikuju se ovisno o

postavkama pod Frequency i Codec.

Frekvencija Kodek Opcije za odabir
59,94 RAW -
RAW i 4096x2160P
XAVCL3840x2160P
XAVC-| 4096x2160P
3840x2160P
1920x1080P
XAVC-L 3840x2160P
1920x1080P 50
1920x1080P 35
50 RAW -
RAW i 4096x2160P
XAVCL 3840x2160P
XAVC-| 4096x2160P
3840x2160P
1920x1080P
XAVC-L 3840x2160P
1920x1080P 50
1920x1080P 35
29,97 RAW -
RAW i 4096x2160P
XAVCL3840x2160P
XAVC-| 4096x2160P
3840x2160P
1920x1080P
XAVC-L 3840x2160P
1920x1080P 50

1920x1080P 35

Postavljanje formata snimanja.
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Project >Rec Format
Postavljanje postavki za format snimanja.

Project >Simul Rec
Postavljanje postavki za nacin za istovremeno snimanje (stranica 50).

Stavka Postavka podstavke Opis Stavka Postavka podstavke Opis
Video Format 25 RAW - Postavljanje  On / Off Ukljucenje/iskljucenje funkcije
RAW i 4096x2160P istovremenog snimanja i postavljanje
XAVC-| 382021607 odrediSnog medija za snimanje.
XAVC-|  4096x2160P Project>ProxyRec
Postavljanje postavki za nacin za snimanje proxy.
3840x2160P -
Stavka Postavka podstavke Opis
1920x1080P . - "
Postavljanje  On / Off Ukljucenje/iskljucenje nacina za snimanje
XAVC-L 3840x2160P proxy
1920x1080P 50 Audio CH1/CH2 / CH3/CH4 Odabir zvu¢nog kanala za snimanje
1920x1080P 35 Channel podataka proxy.
23,98 RAW - Project >Interval Rec
RAW i 4096x2160P Postavljanje postavki za nac¢in snimanja s intervalima (stranica 49).
XAVC-| 3840x2160P Stavka Postavka podstavke Opis
XAVC-| 4096x2160P Postavljanje  On / Off Uklju€enje/iskljucenje nacina za snimanje
3840x2160P S mtervghma. (UkIJucenJ.em oyog nacmg
postavljanjem na On svi drugi posebni
1920x1080P nacini iskljucuju se postavljanjem na Off).
XAVC-L 3840x2160P Interval Time 1/2/3/4/5/6/7/8/9/10/15/ Postavljanje intervala izmedu snimanja
1920x1080P 50 20/ 30/ 40/ 50 (sekunde) u nacinu snimanja Interval Rec recording
1/2/3/4/5/6/7/8/9/10/15/720/ (kada je nacin Interval Rec uklju¢en s On).
1920~1080P 35 30 /40 / 50 (minute)
24 RAW - 1/2/3/4/6/12/ 24 (sati)
RAW i 4096x2160P Number of 1frame / 2frames / 3frames / 6frames / Postavljanje broja kadrova po snimanju
XAVC-| Frames 9frames / 12frames u nacinu snimanja Interval Rec recording
XAVC-I 4096x2160P Dostupne postavke razlikuju se ovisno o (kada je nacin Interval Rec uklju¢en s On).
frekvenciji kadra odabranog formata za
Project >Cine El Setting videozapis.
Postavljanje postavki za nacin Cine El. 59.94P/50P:
Stavka Postavka podstavke Opis 2frames / 6frames / 12frames
Color Gamut ~ S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 Postavljanje prostora boje u nacinu Cine El. 29.97P/25P/24P/23.98P:
) 1frame / 3frames / 6frames / 9frames
S-Gamut3/SLog3: —
Pre-Lighting  Off / 2sec / 5sec / 10sec Postavljanje broja sekundi za koje

postavljanje prostora boje u nacinu

Cine El na S-Gamut3.
S-Gamut3.Cine/SLog3:

postavljanje prostora boje u nacinu

Cine El na S-Gamut3.Cine.

se svjetlo za videozapis ukljucuje prije
pocetka snimanja u nacinu snimanja
Interval Rec.

[Savjet]
Dostupno samo pri upotrebi HVL-LBPC
(u opciji).
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Project >SDI/HDMI Rec Control
Postavljanje postavki za upravljanje snimanjem putem SDI/HDMI.

Project >Assignable Button
Postavljanje dodjele funkcija dodjeljivim gumbima.

Stavka Postavka podstavke Opis Stavka Postavka podstavke Opis
Postavljanje  Off / SDI/HDMI Remote I/F / Parallel Rec Postavljanje upravljanja pokretanjem/ <1>to <9>, Off / Base ISO/Sensitivity / AGC /  Dodjela funkcija dodjeljivim gumbima.
zaustavljanjem snimanja vanjskim Gumb za Push AGC / ND Filter Position / Base ISO/Sensitivity:
uredajem putem izlaznog signala zadrZavanje  Auto ND Filter / Push Auto ND / izmjena osnovne osjetljivosti slikovnog
SDI/HDMI. fokusa Auto Iris / Push Auto Iris / Auto senzora.
Isklju¢eno: Shutter / Auto Exposure Level / AGC:
nemojte upotrebljavati daljinski Backlight / Spotlight / Preset Ukljucenje/iskljucenje funkcije AGC.
upravljac. White Select / ATW / ATW Hold /  Push AGC:
SDI/HDMI Remote I/F: AF Speed/Sens. / Focus Setting / omogucuje funkciju AGC dok je gumb
upravljanje pokretanjem/ Focus Area / Focus Area(AF-S) / pritisnut.
zaustavljanjem snimanja vanjskog Face/Eye Detection AF / Push AF ND Filter Position:
priklju¢enog uredaja kada Mode / Push AF/Push MF / Focus zamjena filtara ND.
u videokameru nije umetnut medij. Hold / Focus Magnifier x3/x6 / Auto ND Filter:
Nije sinkronizirano s to¢no3c¢u kadra Focus Magnifier x3 / Focus Ukljucenje/iskljucenje funkcije automatskog
za medij videokamere. Magnifier x6 / S&Q Motion / filtra ND.
Parallel Rec: SteadyShot / Rec / Rec Review / Push Auto ND:
upravljanja pokretanjem/ Clip Flag OK / Clip Flag NG / Clip omogucuje funkciju automatskog filtra ND
zaustavljanjem snimanja vanjskog Flag Keep / Color Bars / Tally dok je gumb pritisnut.
priklju¢enog uredaja kada je [Front] / DURATION/TC/U-BIT / Auto Iris:
u videokameru umetnut medij. Display / Lens Info / Video Signal ukljucenje/iskljucenje funkcije irisa.
Sinkronizirano s to¢noscu kadra Monitor / Marker / VF Adjust / VF  Push Auto Iris:
za medij videokamere. Mode / Gamma Display Assist / omogucuje funkciju automatskog irisa dok je
Peaking / Zebra / Volume / gumb pritisnut.
[Napomena] . .
Za kontrolu s pomocu izlaznog HDMI signala Thumbnail / Touch Operation / Auto Shutter:
postavite funkciju HDMI TC Out >Setting Handle Zoom / NFC / Auto Upload ukljucenje/iskljucenje funkcije automatskog
(stranica 85) u izborniku TC/Media cijelog (Proxy) / Direct Menu / User zatvaraca.
izbornika na On. Menu / Menu Auto Exposure Level:

prikaz/napustanje izravnog izbornika Auto
Exposure Level.
Backlight:
zamjena Backlight i Standard.
Spotlight:
zamjena izmedu opcija Backlight i Standard.
Preset White Select:
promjena vrijednosti nacina zadanog balansa
bijele boje.
ATW:
ukljucenje/iskljucenje funkcije ATW.
ATW Hold:
pauzira rad funkcije ATW.
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Project >Assignable Button
Postavljanje dodjele funkcija dodjeljivim gumbima.

Project >Assignable Button
Postavljanje dodjele funkcija dodjeljivim gumbima.

Stavka Postavka podstavke Opis Stavka Postavka podstavke Opis
<1>to <9>, AF Speed/Sens.: <1>to <9>, Clip Flag OK:
Gumb za Prebacuje postavku brzine prijelaza pri Gumb za izvodi se funkcija Add OK.
zadrzavanje automatskom fokusiranju i postavku zadrzavanje Pritisnite dva puta za izvodenje Delete
fokusa osjetljivosti na zamjenu objekta pri fokusa Clip Flag.

automatskom fokusiranju. Clip Flag NG:

Focus Setting:
postavljanje podrucja fokusiranja.

Focus Area:
postavlja podrucje izoStravanja za automatsko
izoStravanje i automatsko izoStravanje
pritiskom.

Focus Area(AF-S):
postavljanje podrucja fokusiranja za
automatsko fokusiranje pritiskanjem (AF-S).

Face/Eye Detection AF:
Prebacuje postavke otkrivanja lica/oka pri
automatskom fokusiranju.

Push AF Mode:
zamjena postavke nacina Push AF.

Push AF/Push MF:
u nacinu ru¢nog fokusiranja ukljucuje
automatsko fokusiranje dok je gumb pritisnut.
U nacinu automatskog fokusiranja ukljucuje
ru¢no fokusiranje dok je gumb pritisnut.

Focus Hold:
u nacinu automatskog fokusiranja fokus se
fiksira dok je gumb pritisnut.

Focus Magnifier x3/x6:

Focus Magnifier x3:

Focus Magnifier x6:
ukljucenje/iskljucenje funkcije povecanja za
fokusiranje.

S&Q Motion:
ukljucenje/iskljucenje nacina Slow & Quick
Motion.
Postavlja brzinu snimanja slic¢ica kada je
pritisnut i kada se drZzi.

SteadyShot:
zamjena izmedu Active, Standard i Off.

Rec:
pokretanje/zaustavljanje snimanja.

Rec Review:
ukljucenje/iskljucenje funkcije Rec Review.

izvodi se funkcija Add NG.
Pritisnite dva puta za izvodenje Delete
Clip Flag.
Clip Flag Keep:
izvodi se funkcija Add Keep.
Pritisnite dva puta za izvodenje Delete
Clip Flag.
Color Bars:
Ukljucenje/iskljucenje stupaca boje.
Tally [Front]:
ukljucenje/iskljucenje funkcije svijetljenja/
treperenja lampice snimanja/signalizacije.
DURATION/TC/U-BIT:
zamjena izmedu Time Code, Users Bit
i Duration.
Zaslon:
ukljucenje/iskljucenje indikatora na zaslonu.
Lens Info:
uklapa indikator dubine polja.
Video Signal Monitor:
uklapa monitor videosignala (poput monitora
za valne oblike).
Marker:
ukljucenje/iskljucenje funkcije oznacavanja.
VF Adjust:
prikaz stupaca razine za prilagodbu svjetline
zaslona trazila.
VF Mode:
zamjena prikaza u boji i crno-bijelog prikaza
na trazilu.
Gamma Display Assist:
uklapa pomo¢nu funkciju prikaza game.
Peaking:
Ukljucenje/iskljucenje funkcije naglasavanja.
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Project >Assignable Button
Postavljanje dodjele funkcija dodjeljivim gumbima.

Project >Assignable Dial

Postavljanje dodjela funkcije za dodjeljivi kotacic te postavljanje smjera vrtnje.

Stavka Postavka podstavke Opis Stavka Postavka podstavke Opis
<1>to <9>, Zebra: Kotacic¢ na Off /1SO/Gain/El / ND Filter / IRIS / Auto  Dodjela funkcija dodjeljivom kotaci¢u na
Gumb za Ukljucenje/iskljucenje funkcije Zebra. rucki Exposure Level / Audio Input Level / Multi  rucki.
zadrZavanje Volume: Function Dial ISO/Gain/El:
fokusa Namjestanje izlazne razine zvuka monitora na podesavanje pojacanja ili El.
prikljucak za slusalice i ugradeni zvucnik. ND Filter:
Thumbnail: podeSavanije filtra ND.
prikaz/izlaz iz zaslona s minijaturama. IRIS:
Rad dodirom: podesavanje irisa.
Ukljucuje/iskljucuje rad dodirom. Auto Exposure Level:
Handle Zoom: Namjestanje automatske razine
uklapa rad zumiranja s ruc¢kom. ekspozicije.
NFC: Audio Input Level:
Izvodi funkciju NFC. Podesava razinu snimanja zvuka.
Auto Upload (Proxy): Visenamjenski kotacic:
Ukljucenje/iskljucenje automatskog prijenosa Funkcionira kao viSenamjenski kotacic.
datoteke proxy. Smijer Normal / Opposite Postavljanje smjera vrtnje dodjeljivog
Direct Menu: kotacica na kotacica na rucki.
prikaz/izlaz iz izravnog izbornika. rucki Normal: okretanje u normalnom smjeru.
User Menu: Opposite: okretanje u suprotnom smijeru.
prikaz/izlaz iz izbornika User. - - - -
Menu: Project >Multi Function Dial

Prikaz/izlaz iz cijelog izbornika.

Dodjela funkcija viSenamjenskom kotacicu.

Project >Assignable Dial
Postavljanje dodjela funkcije za dodjeljivi kotacic te postavljanje smjera vrtnje.

Stavka Postavka podstavke Opis
Default Off / IRIS / ISO/Gain/El / Auto Exposure Dodjela zadane funkcije viSenamjenskom
Function Level / Audio Input Level kotacicu.

IRIS:
podesavanje irisa.
I1SO/Gain/El:
podesavanje pojacanja ili El.
Auto Exposure Level:
Namjestanje automatske razine
ekspozicije.
Audio Input Level:
Podesava razinu snimanja zvuka.

Stavka Postavka podstavke Opis
Grip/Remote  Off /1ISO/Gain/El / ND Filter / IRIS / Auto  Dodjela funkcija dodjeljivom kotacicu.
Dial Exposure Level / Audio Input Level ISO/Gain/El:
podesavanje pojacanja ili El.
ND Filter:
podesavanije filtra ND.
IRIS:
podeSavanje irisa.
Auto Exposure Level:
Namjestanje automatske razine
ekspozicije.
Audio Input Level:
Podesava razinu snimanja zvuka.
Smijer Normal / Opposite Postavljanje smjera vrtnje dodjeljivog
kotacica na kotacica na drski.
drski Normal: okretanje u normalnom smjeru.

Opposite: okretanje u suprotnom smjeru.
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Project >User File

Postavljanje postavki za operacije s korisnickom datotekom.

Stavka Postavka podstavke Opis

Load Execute / Cancel Ucitava postavke datoteke korisnika

Media(B) s memorijske kartice umetnute u utor za
CFexpress Type A karticu / SD karticu (B).
Execute: izvodenje funkcije.

Save Execute / Cancel Sprema postavke datoteke korisnika na

Media(B) memorijsku karticu umetnutu u utor za
CFexpress Type A karticu / SD karticu (B).
Execute: izvodenje funkcije.

File ID Prikaz zaslona za prikazivanje/uredivanje
ID-ja datoteke za korisnicke datoteke.

Load On / Off Postavljanje ucitavanja prilagodenih

Customize informacija izbornika User kada je

Data izvrSena funkcija Load Media(B).

Load White On / Off Postavljanje ucitavanja informacija

Data o balansu bijele boje kada je izvrSena

funkcija Load Media(B).

Project >All File
Postavljanje postavki za SVE datoteke.

Stavka Postavka podstavke Opis

Load Execute / Cancel Ucitavanje SVIH datoteka

Media(B) Execute: izvodenje funkcije.

Save Execute / Cancel Spremanje SVIH datoteka.

Media(B) Execute: izvodenje funkcije.

File ID Dodjela naziva datoteci.

Load Network On / Off Postavljanje ucitavanja postavki izbornika
Data Network kada je izvrSena funkcija Load

Media(B).
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6. Prikaz i postavke izbornika

|lzbornik Paint/Look

U ovom odjeljku opisana je funkcija i postavke za svaku stavku izbornika.
Tvornicki zadane postavke prikazuju se podebljane (na primjer 18dB).

Paint/Look >Base Look

Postavljanje postavki povezanih s temeljnim izgledom.

Paint/Look >Scene File
Postavljanje postavki za datoteke kadra.

Stavka Postavka podstavke Opis

Ulaz S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3  postavija ulaznu skalu za odabrani
temeljniizgled.

1zlaz BT.709 / HLG Postavlja izlaznu skalu boja za odabrani
temeljniizgled.

AE Level OEV /1/3EV / 2/3EV /1EV / 4/3EV / Postavljanje referentne vrijednosti

Offset 5/3EV / 2EV ekspozicije za odabrani temeljni izgled.

Paint/Look >Reset Paint Settings
Ponovno postavljanje postavki izbornika Paint/Look, bez temeljnog izgleda.

Stavka

Postavka podstavke

Opis

Stavka Postavka podstavke Opis

Pozivanje Ucitavanje datoteke kadra pohranjene u
internu memoriju i primjena postavki kao
trenutacnih postavki za kvalitetu slike.

Spremanje Sprema trenutacno stanje kvalitete slike
kao datoteku kadra u internu memoriju.

Brisanje Brisanje datoteke kadra pohranjene u
internu memoriju.

Pozivanje Kada je nacin snimanja postavljen na Primjenjuje unaprijed postavljene

unaprijed Custom i funkcija Target Display je postavke kvalitete slike (ponovno

postavljene  postavljena na SDR(BT.709): ispisivanje nije moguce) kao trenutacne

postavke S-Cinetone / Standard / Still / ITU709  postavke kvalitete slike.

Kada je nacin snimanja postavljen na
Custom i funkcija Target Display je
postavljena na HDR(HLG):

Ponovno
postavljanje
bez funkcije
Base Look

Execute / Cancel

Ponovno postavljanje postavki izbornika
Paint/Look, bez temeljnog izgleda.
Execute: izvodenje funkcije.

Paint/Look >Black
Postavljanje postavki za crnu boju.

HLG Live / HLG Natural Stavka Postavka podstavke Opis
Paint/Look ~Base Look Master Black  od -99,0 do +99,0 (x0,0) Postavlj.anj.e gla.vne razine crr.1e boje.
Postavljanje postavki povezanih s temeljnim izgledom. R Black 0d -99,0 do +99,0 (x0,0) Postavljanje razine R crne boje.
Stavka Postavka podstavke Opis B Black od -99,0 do +99,0 (x0,0) Postavljanje razine B crne boje.
Select Kada je pacm s'r.wlmanja po.stavlje.n na Odabire temeljni izgled. P
Custom i funkcija Target Display je " . " N
) Postavljanje postavki za korekciju komprimiranja.
postavljena na SDR(BT.709): -
S-Cinetone / Standard / Still / Stavka Postavka podstavke Opis
ITU709 / od User1 do User16 Setting Kada je funkcija Target Display postavljena Uklju¢enje/iskljucenje funkcije korekcije
Kada je nacin snimanja postavljen na na SDR(BT.709): komprimiranja.
Custom i funkcija Target Display je Oon / Off / ---
postavljena na HDR(HLG): Kada je funkcija Target Display postavljena
HLG Live / HLG Natural / od User1 do na HDR(HLG):
User16 On / Off
Kada je nacin snimanja postavljen na Cine El: Auto Knee Kada je funkcija Target Display postavljena Uklju¢enje/isklju¢enje funkcije
5709 /709(800) / S-Log3 / od User na SDR(BT.709): automatskog komprimiranja.
do User16 On/ Off / ---
Brisanje Brise odabrani temeljni izgled. Kada je funkcija Target Display postavljena
IzbriSi sve Brise sve temeljne izglede. na HDR(HLG):
, — On / Off
Uvoz Ucitava datoteku temeljnog izgleda s Point 0d 75 % do 109 % (90 %) postavlja tocku komprimiranja.

medija za snimanje.

Slope

0d -99 do +99 (0)

postavlja nagib komprimiranja.
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Paint/Look >Detail
Postavlja postavke namjestanja detalja.

Paint/Look >Multi Matrix
Postavljanje postavki za korekciju viSestruke matrice.

Stavka Postavka podstavke Opis Stavka Postavka podstavke Opis
Setting On / Off Ukljucenje/iskljucenje funkcije detalja. Setting On / Off Ukljucenje/iskljucenje funkcije korekcije
Level Od -7 do +7 (x0) Postavljanje razine detalja. visestruke matrlc'e. S N
Rucne On / Off UKljuZenje/iskljugenje funkcije ruénog Reset Execute / Cancel Ponovno.post.avljanje nuans“e i za5|c.enja
. ) svake boje osi na zadane vrijednosti.
postavke namjestanja detalja. Axi B/B+/MG-/MG/MG+/R/R+/YL-/  Odabi i
- - - Xis B/ B+ - + + - abir osovine.

Balans V/H 0d -2 do +2 (x0) Pos.tavIJanje balansa |z.medu okorvmtog YL/ Y4/ G/ G/ Gt/ CY /Y4 /B

(V)i vodoravnog detalja (H) za ru¢no — - -

namijeétanje detalja. Hue od -99 do +99 (+0) Postavg?nje nual?se EO.J.e kgvja se )
Balans B/W  Typel/ Type2 / Type3 / Type4 / Type5 Postavlja balans izmedu crnog (B) detalja upotrebljava za korekciju visestruke

za slabo osvijetljena podrucdja i bijelog
(W) detalja za visoko osvijetljena
podrucja za ru¢no namjestanje detalja.

matrice.

Zasicenost od -99 do +99 (x0)

Postavljanje zasi¢enja boje koja se
upotrebljava za korekciju viSestruke
matrice.

Ogranicenje  0od0do7 Postavljanje razine ogranicenja detalja za
ru¢no namjestanje detalja.

Crispening 0d0do7 Postavljanje razine crispeninga za ru¢no
namjestanje detalja.

Visoko O0d0do4 Postavljanje razine detalja visoke

osvijetljeni osvijetljenosti za ru¢no namjestanje

detalj detalja.

Paint/Look Matrix
Postavljanje postavki za korekciju matrice.

Stavka Postavka podstavke Opis

User Matrix On / Off Ukljucenje/iskljucenje funkcije korekcije
korisnicke matrice.

User Matrix od -99 do +99 (x0) Podesavanje zasi¢enja boje na cijeloj slici.

Level

User Matrix ~ od -99 do +99 (x0) Podesavanje tona boje (faze) na

Phase cijeloj slici.

User Matrix ~ od -99 do +99 (x0) Postavljanje korisni¢ki definirane

R-G korisnicke matrice R-G.

User Matrix od -99 do +99 (x0) Postavljanje korisnicki definirane

R-B korisnicke matrice R-B.

User Matrix ~ od -99 do +99 (x0) Postavljanje korisnicki definirane

G-R korisnicke matrice G-R.

User Matrix ~ od -99 do +99 (x0) Postavljanje korisnicki definirane

G-B korisnicke matrice G-B.

User Matrix ~ od -99 do +99 (x0) Postavljanje korisnicki definirane

B-R korisnicke matrice B-R.

User Matrix ~ od -99 do +99 (x0) Postavljanje korisnicki definirane

B-G

korisnicke matrice B-G.
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6. Prikaz i postavke izbornika

lzbornik TC/Media

U ovom odjeljku opisana je funkcija i postavke za svaku stavku izbornika.
Tvornicki zadane postavke prikazuju se podebljane (na primjer 18dB).

TC/Media >Users Bit
Postavljanje postavki za korisnicke informacije.

TC/Media >Timecode

Postavljanje postavki vremenskog koda.

Stavka Postavka podstavke Opis

Stavka

Postavka podstavke

Opis

Setting Postavljanje korisnickih informacija
na proizvoljnu vrijednost.

Mode

Preset / Regen / Clock

Postavljanje nacina izvodenja
vremenskog koda.
Preset:
pokretanje izvodenja od prethodno
zadane vrijednosti.
Regen:
Pokretanje izvodenja od vremenskog
koda do zavrsetka prethodnog isjecka.
Clock:
primjena unutarnjeg sata za
vremenski kod.

TC/Media >HDMI TC Out
Postavljanje postavki za izvoz vremenskog koda pri primjeni priklju¢nice HDMI.

Stavka Postavka podstavke Opis

Postavljanje  On / Off Postavljenja izvoza vremenskog koda na
uredaje za druge svrhe putem
priklju¢nice HDMI.

Pokreni

Rec Run / Free Run

Rec Run: izvodi se samo pri snimanju.
Free Run: izvodi se uvijek, neovisno o
radu videokamere.

Setting

Postavljanje vremenskog koda na
proizvoljnu vrijednost.
SET: postavljanje vrijednosti.

Reset

Execute / Cancel

Ponovno postavljanje vremenskog koda
na 00:00:00:00.
Execute: izvodenje funkcije.

TC Format

Postavljanje formata vremenskog koda.
DF: Drop Frame
NDF: Non-Drop Frame

TC/Media >TC Display

Postavljanje postavki prikaza podataka o vremenu.

Stavka

Postavka podstavke

Opis

Display Select Timecode / Users Bit / Duration

Zamjena prikaza podataka o vremenu.

TC/Media >Users Bit

Postavljanje postavki za korisnic¢ke informacije.

Stavka

Postavka podstavke

Opis

Mode

Fix / Time

Postavljanje nacina za korisnicke informacije.
Fix: upotreba proizvoljne fiksne vrijednosti
u korisnickim informacijama.
Time: upotreba trenutacnog vremena
u korisnic¢kim informacijama.
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TC/Media >Clip Name Format

Postavljanje postavki za dodjelu naziva i brisanje isjecaka.

TC/Media >Update Media

AZuriranje datoteke za upravljanje na memorijskim karticama.

Stavka Postavka podstavke Opis Stavka Postavka podstavke Opis
Title Prefix nnn_ (nnn su posljednje tri znamenke Postavljanje dijela naslova (od 4 do 46 Media(A) Execute / Cancel AZuriranje datoteke za upravljanje
serijskog broja) znakova) u nazivu isjecka. na memorijskoj kartici u utoru A.
(Maks. sedmeroznamenkasti naziv) Otvaranje zaslona za unos niza znakova. Execute: izvodenje funkcije.
Media(B) Execute / Cancel AZuriranje datoteke za upravljanje

Struktura zaslona za unos niza

znakova

Podrucje za odabir znakova (tri retka):
odabir znakova za unos u polozaj
pokazivaca na podrucju Title Prefix.
1#$%()+.-.;=@| ]*_~0123456789
abcdefghijklmnopgrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ

Radno podrucje pokazivaca (jedan redak):
Space: Umetanje znaka razmaka
u poloZaj pokazivaca.
«—: pomak pokazivaca ulijevo.
—: pomak pokazivaca udesno.
BS: brisanje znaka lijevo od poloZaja
pokazivaca.

Podrucje za Title Prefix (jedan redak):

podrucje za unos naslova.

Postavljanje naslova

1. Odaberite znak koji Zelite unijeti na
poloZaj pokazivaca u podrucju Title
Prefix s podrucja za odabir znakova s
pomocu visestrukog biraca
(stranica 7) i pritisnite gumb za
primjenu visestrukog biraca.
(Odabrani znak se umece, a
pokaziva¢ se pomice udesno).

2. Ponovite 1. korak za postavljanje
naslova. (Po potrebi primijenite BS).

3. Nakon postavljanja naslova odaberite
Done kako biste zatvorili zaslon za
unos znakova.

na memorijskoj kartici u utoru B.
Execute: izvodenje funkcije.

TC/Media >Format Media
Vrac¢anje memorijskih kartica.

Stavka Postavka podstavke Opis
Media(A) Full Format / Quick Format / Cancel Formatiranje memorijske kartice u utoru A.
Media(B) Full Format / Quick Format / Cancel Formatiranje memorijske kartice u utoru B.

Number Set  od 0001 do 9999

Postavljanje cetveroznamenkastog
broj¢anog sufiksa za naziv isjecka.
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|Izbornik Monitoring

U ovom odjeljku opisana je funkcija i postavke za svaku stavku izbornika. Monitoring >Display On/Off
Tvornicki zadane postavke prikazuju se podebljane (na primjer 18dB). Postavljanje prikaza postavki za stavke.
Monitoring =Output On/off Stavka Postavka podstavke Opis
Postavljanje postavki videoizlaza. Network On / Off Odabir stavki za prikaz u trazilu.
Stavka Postavka podstavke Opis Status
File Transfer ~ On / Off
SDI On / Off Ukljucenje/iskljucenje izlaza za SDI. Status
HDMI On / Off Ukljucenje/iskljucenje izlaza HDMI. Rec/Play On / Off
Status

Monitoring >Output Format

Postavljanje postavki za izlazni format. RAW Output  On / Off
Control
Stavka Postavka podstavke Opis Status
SDI Pojedinosti o postavkama potraZite pod Postavljanje izlazne razlu¢ivosti za SDI i Tally On / Off
HDMI "Izlazni formati i ograni¢enja” HDMI. Battery On / Off
(stranica 110). Remain
Monitoring >Output Display Focus Mode  On/ Off
Postavljanje postavki za izlazni signal. Focus On / Off
Stavka Postavka podstavke Opis Position
- . — - Focus Area On / Off
SDI On / Off Prikaz ugradivanja izbornika i informacija Indicator
o] étatusu u @Iazrn §|gna| 'SDI.. . “ Focus Area on/ Off
HDMI On / Off Prikaz ugradivanja izbornika i informacija Ind.(AF-S) -
o statusu u izlazni signal HDMI. Face/Eye On/ Off
Detection
Frame
Lens Info On / Off
Imager Scan  On / Off
Mode

Rec Format On / Off
Frame Rate On / Off

Zoom On / Off
Position

UWP RF Level On / Off
SteadyShot  On / Off
Base Look/ On / Off

LUT

SDI/HDMI On / Off
Rec Control

Gamma On / Off

Display Assist
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Monitoring >Display On/Off
Postavljanje prikaza postavki za stavke.

Monitoring >Marker
Postavljanje postavki za oznake za zaslonu.

Stavka Postavka podstavke Opis Stavka Postavka podstavke Opis
Proxy Status  On / Off Setting On / Off Ukljucenje/iskljucenje svih oznaka na
BaseISO/  On/ Off zaslonu.
Sensitivity Color White / Yellow / Cyan / Green / Magenta / Odabir boje signala oznaka.
Media Status  On / Off Red / Blue _ :
Video Signal  Off / Waveform / Vector / Histogram Center 172/73/74/0ff Odabir oznake sredista.
Monitor Marker
Clip Name on / Off Safety Zone  On / Off UkIJucevehJe/lskljucenJe oznake sigurnog
g podrugja.
White On / Off Safety Area  80% / 90% / 92.5% / 95% Odabir veli¢ine oznake sigurnog podrudja
Balance. (kao postotak ukupne veli¢ine zaslona).
Scene File On / Off Aspect Line / Mask / Off Odabir vrste oznake omjera.
Focus On / Off Marker
Indicator Aspect Mask  od 0 do 15 (12) Odabir razine videosignala izvan oznake.
Auto On / Off Aspect Safety On / Off Ukljucenje/iskljucenje oznake omjera u
llzllxpé)sure Zone sigurnom podrudju.
ode Aspect Safety 80% / 90% / 92.5% / 95% Odabir veli¢ine oznake omjera sigurnog
Auto On / Off Area podrucja (kao postotak ukupne veli¢ine
Exposure zaslona).
L.evel Aspect Select 1:1/4:3/13:9/14:9/15:9/16:9/17:9/ Odabir nacin za prikaz oznake omjera.
Timecode  On/Off 1.66:1/1.85:1/ 2.35:1 / 2.39:1/ Custom
ND Filter On / Off Custom Unos proizvoljne vrijednosti (01.00:01.00)  Postavljanje razmijera proporcija na
Blenda On / Off Aspect Ratio proizvoljnu vrijednost.
ISO/Gain/El On / Off [Napomena]
Postavka je omogucena kada je funkcija Aspect
Shutter On / Off Select postavljena na Custom.
Level Gauge On/ Off Guide Frame  On / Off Uklju¢enje/isklju¢enje prikaza okvira za
Audio Level  On / Off navodenje.
Meter 100% Marker On / Off Uklju€enje/iskljucenje oznake za 100 %.
Videq Level  On/ Off User Box On / Off Ukljucenje/iskljucenje oznake korisnicke
Warning kutije.
Clip Number  On / Off User Box od 3 do 479 (240) Postavljanje $irine oznake korisni¢kog
Notice On / Off Width okvira (udaljenost od sredine do lijevog
Message i desnog ruba).
User Box od 3 do 269 (135) Postavljanje visine oznake korisnickog
Height okvira (udaljenost od sredine do gornjeg
i donjeg ruba).
User Box H od -476 do +476 (0) Postavljanje vodoravnog poloZaja sredine
Position oznake korisnickog okvira.
User Box V od -266 do +266 (0) Postavljanje okomitog poloZaja sredine
Position oznake korisnickog okvira.
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Monitoring >VF Setting
Postavljanje postavki trazila.

Stavka Postavka podstavke

Opis

Brightness 0d1do 15 (8)

Podesavanje svjetline slike trazZila.

Nacin boje Color / B&W

Odabir nacina prikaza trazila u nacinu
E-E/recording.

Monitoring >Gamma Display Assist

Postavljanje pomocnih postavki za prikaz game.

Stavka Postavka podstavke

Opis

Setting On / Off

Ukljucivanje/iskljucivanje funkcije
pomocnog prikaza game u nacinu
Custom kada je funkcija Target Display
postavljena na HDR(HLG).

Monitoring >Peaking
Postavljanje postavki naglasavanja.

Stavka Postavka podstavke

Opis

Setting On / Off

Ukljucenje/iskljucenje funkcije
naglasavanja.

Peaking Level High / Mid / Low

Postavljanje razine signala
naglasavanja u boji.

Color B&W / Red / Yellow / Blue

Odabir boje za signal naglasavanju u boji.

Monitoring >Zebra
Postavljanje postavki za uzorak zebre.

Stavka Postavka podstavke

Opis

Setting Off / Zebral / Zebra2

Odabire vrstu uzorka zebre (Off, Zebra 1,
Zebra 2).

ZebralLevel 0Od 0do 109 % (70 %)

Postavljanje razine prikaza za Zebra 1.

Zebral 0d 2 do 20 % (10 %)
Aperture
Level

Postavljanje razine otvora blende za
Zebra 1.

Zebra2 Level od 0% do 109% (100%)

Postavljanje razine prikaza za Zebra 2.
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6. Prikaz i postavke izbornika

lzbornik Audio

U ovom odjeljku opisana je funkcija i postavke za svaku stavku izbornika.
Tvornicki zadane postavke prikazuju se podebljane (na primjer 18dB).
Pogledajte "Blokovski dijagrami” (stranica 124).

Audio >Audio Input
Postavljanje postavki za ulazni zvuk.

Audio >Audio Input
Postavljanje postavki za ulazni zvuk.

Stavka Postavka podstavke Opis

CH1 Input INPUT1 / Internal MIC / Shoe CH1 Uklapanje izvora unosa za snimanje na
Select kanalu 1.

CH2 Input INPUT1 / INPUT2 / Internal MIC / Shoe CH2 Uklapanje izvora unosa za snimanje na
Select kanalu 2.

CH3 Input Off / INPUT1 / Internal MIC / Shoe CH1 Uklapanje izvora unosa za snimanje na
Select kanalu 3.

CH4 Input Off / INPUT1 / INPUT2 / Internal MIC / Uklapanje izvora unosa za snimanje na
Select Shoe CH2 kanalu 4.

INPUT1T MIC -80dB /7 -70dB / -60dB / -50dB / -40dB / Postavljanje referentne razine snimanja
Reference -30dB za ulaz mikrofona XLR s INPUT1.

INPUT2 MIC ~ -80dB / -70dB / -60dB / -50dB / -40dB / Postavljanje referentne razine snimanja
Reference -30dB za ulaz mikrofona XLR s INPUT2.

Line Input +4dB / 0dB / -3dB / EBUL Odabir referentne razine unosa kada je
Reference sklopka INPUT1/INPUT2 postavljena na LINE.
Reference -20dB / -18dB / -16dB / -12dB / EBUL Odabir razine snimanja za referentni
Level tonski signal od 1 kHz.

CH1 Wind On / Off Omogucivanje/onemogucivanje filtar za
Filter smanjenje vjetra za snimanje na kanalu 1.
CH2 Wind On / Off Omogucivanje/onemogucivanje filtar za
Filter smanjenje vjetra za snimanje na kanalu 2.
CH3 Wind On / Off Omogucivanje/onemogucivanje filtar za
Filter smanjenje vjetra za snimanje na kanalu 3.
CH4 Wind On / Off Omogucivanje/onemogucivanje filtar za
Filter smanjenje vjetra za snimanje na kanalu 4.
CH3 Level Auto / Manual Odabir automatske razine ulaza zvuka ili
Control ru¢nog podesavanja za kanal za

snimanje 3.

[Napomena]

Ako su CH3 Input Select i CH4 Input Select
postavljeni na Internal MIC, CH4 se uklapa na
automatski/ru¢no sukladno ovoj postavci.

Stavka Postavka podstavke Opis

CH4 Level Auto / Manual Odabir automatske razine ulaza zvuka ili

Control ru¢nog podesavanja za kanal za snimanje 4.
[Napomena]

Ako su CH3 Input Select i CH4 Input Select
postavljeni na Internal MIC, CH4 se uklapa na
automatski/ru¢no sukladno postavci CH3 Level
Control.

CH3 Input 0Od 0 do 99 (49) Postavljanje razine unosa za snimanje na

Level kanalu 3.

CH4 Input 0d 0 do 99 (49) Postavljanje razine unosa za snimanje na

Level kanalu 4.

Audio Input  od 0 do 99 Postavljanje razine ulaza zvuka.

Level Moze se primijeniti kao glavna jacina
zvuka, sukladno postavkama u rasponu
od CH1 Level do CH4 Level.

Limiter Mode Off /-6dB / -9dB / -12dB / -15dB / -17dB  Odabir karakteristika limitatora za velike
ulazne signale pri ru¢nom podesavanju
razine ulaza zvuka.

CH1&2 AGC Mono / Stereo Postavljanje nacina za automatsko

Mode podesavanje razine za kanal za snimanje
1ikanal 2. Kada je postavljena na Stereo,
funkcija AGC povezuje se izmedu kanala.

CH3&4 AGC  Mono / Stereo Postavljanje nacina za automatsko

Mode podesavanje razine za kanal za snimanje
3ikanal 4. Kada je postavljena na Stereo,
funkcija AGC povezuje se izmedu kanala.

AGC Spec -6dB / -9dB / -12dB / -15dB / -17dB Odabir karakteristika za AGC.

1kHz Tone on  On / Off Ukljucenje/iskljucenje referentnog

Color Bars tonskog signala od 1 kHz pri prikazu

stupaca boje.

[Napomenal]

Kada je ukljucen s On, referentni tonski signal
od 1 kHz postavlja se za snimanje na kanalu 3
i kanalu 4, ¢ak i ako su CH3 Input Select i CH4
Input Select postavljeni na Off.
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Audio >Audio Input
Postavljanje postavki za ulazni zvuk.

Audio >Audio Output
Postavljanje postavki za izlazni zvuk.

Stavka Postavka podstavke Opis Stavka Postavka podstavke Opis
CH1 Level Input without XLR adaptor Postavljanje kombinacije podesavanja Monitor CH CH1/CH2 / CH3/CH4 / MIX ALL / CH1/ Odabir izlaza zvu¢nog kanala na
Audio Input Level / Side / Level+Side  razine ulaza zvuka omogucene za kanal CH2 / CH3 / CH4 priklju¢nicu za slusalice i ugradeni zvucnik.
Input wiFh XLR adaptor (stranica 47) za snimanje 1. [Napomena]
Audio Input Level / Through [Napomena] Ako je zvuk za videstruke kanale postavljen na
"Strana" se odnosi na kotaci¢ AUDIO LEVEL istovremeni izlaz, razina izlaza za svaki kanal za
(CH1) na strani videokamere. Po odabiru izlaz se smanjuje kako bi se sprijecilo rezanje.
Level+Side razina snimanja zvuka odreduje Jacina zvuka  Od 0 do 50 Namjestanje izlazne razine zvuka
_se kombi_nacijovrn funkcijg Audio Input Level monitora na priklju¢ak za slugalice
. i postavlfl k(?taaca (st.ramc.c:a 124). ; : i ugradeni zvuénik.
CH2 Level Input WI.thOUt XLR adaptgr . Po;tavljanje kombinacije p'odesavanja 1zlaz za Mono / Stereo Odabir mono (Mono) ili stereo (Stereo)
Audilo Input Level / Side /. Level+Side razine ulaga zvuka omogucene za kanal sludalice - izlaza na prikljucnicu za sluzalice.
Input with XLR adaptor (stranica 47) za snimanje 2. . - ,
. Alarm Level od 0do7(4) Podesavanje glasnoca alarma.
Audio Input Level / Through [Napomena] — — —
"Strana” se odnosi na kotadic AUDIO LEVEL HDMI CH1/CH2 / CH3/CH4 Pos.tavljanje kombinacije zvucnih kanala
(CH2) na strani videokamere. Po odabiru Output CH na izlazu HDMI.
Level+Side razina snimanja zvuka odreduje
se kombinacijom funkcije Audio Input Level i
postavki kotacica (stranica 124).
CH3 Level Input without XLR adaptor Postavljanje kombinacije podesavanja
Audio Input Level / CH3 Input Level / razine ulaza zvuka omogucene za kanal
Level+CH3 Input Level za snimanje 3.
Input with XLR adaptor (stranica 47)
Audio Input Level / Through
CH4 Level Input without XLR adaptor Postavljanje kombinacije podesavanja

Audio Input Level / CH4 Input Level /
Level+CH4 Input Level

Input with XLR adaptor (stranica 47)
Audio Input Level / Through

razine ulaza zvuka omogucene za kanal
za snimanje 4.




6. Prikaz i postavke izbornika

lzbornik Thumbnail

U ovom odjeljku opisana je funkcija i postavke za svaku stavku izbornika.
Tvornicki zadane postavke prikazuju se podebljane (na primjer 18dB).

Thumbnail (Slicica)

Thumbnail >Transfer Clip (Proxy)
Prijenos isjecaka proxy.

[Napomenal]

Funkcija Transfer Clip (Proxy) ne moZe se konfigurirati kada je funkcija Access Authentication >Password

u izborniku Network nedefinirana.

Stavka Postavka podstavke Opis
Display Clip Prikaz zaslona sa svojstvima isjecka.
Properties

Thumbnail >Set Clip Flag
Postavljanje postavki za zastavice za isjecak.

Stavka Postavka podstavke Opis

Select Clip Prijenos isjecaka proxy koji odgovaraju
odabranim isjeccima.

All Clips Prijenos isjeCaka proxy koji odgovaraju

svim isjeccima.

Stavka Postavka podstavke Opis
- - [Napomena]
Add OK Dodavanje zastavice OK. Moguce je prenijeti do 200 isjecaka.
Add NG Dodavanje zastavice NG. S :
. : Thumbnail >Filter Clips
Add KEEP Dodavanje zastavice Keep. Postavljanje postavki za prikaz isjecaka.
|:Dlelete Clip Brisanje svih zastavica. Siavla Postavka podstavke Opis
ag
’ ’ U redu Prikaz samo isjecaka sa zastavicom OK.
Thumbnall_>l_.ock/UnIo.ck C“pv L NG Prikaz samo isjecCaka sa zastavicom NG.
Postavljanje postavki za zastitu isjecka. : = :
Stavka Postavka podstavke Opis KEEP Prikaz samo isjeCaka sa zastavicom Keep.
Select Clip Odabir i zaklju¢avanje/otkljucavanje isjecka. None Prikaz samo isjecaka bez zastavice.
Lock All Clips Zakljucavanje svih isjecaka. All Prikaz svih isjeCaka, neovisno o zastavicama.
Unlock All Otklju¢avanje svih isjecaka. Thumbnail >Customize View
Clips Zamjena prikaza zaslona s minijaturama.

Thumbnail >Delete Clip
Brisanje isjecaka.

Stavka Postavka podstavke

Opis

Thumbnail Date Time / Time Code / Duration /
Caption Sequential Number

Zamijena informacija koje se prikazuju
ispod minijatura.

Stavka Postavka podstavke Opis
Select Clip Brisanje odabranog isjecka.
All Clips Brisanje svih isjecaka.

Thumbnail >Transfer Clip
Prijenos isjecaka.

[Napomena]

Funkcija Transfer Clip ne mozZe se konfigurirati kada je funkcija Access Authentication >Password u izborniku

Network nedefinirana.

Stavka Postavka podstavke Opis
Select Clip Prijenos odabranih isjecaka.
All Clips Prijenos svih isjecaka.

[Napomenal]
Moguce je prenijeti do 200 isjecaka.
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lzbornik Technical

U ovom odjeljku opisana je funkcija i postavke za svaku stavku izbornika.
Tvornicki zadane postavke prikazuju se podebljane (na primjer 18dB).

Technical >Zoom
Postavljanje postavki zumiranja.

Technical >Color Bars
Postavljanje postavki stupca boje.

Stavka Postavka podstavke Opis
Setting On / Off Ukljucenje/iskljucenje stupaca boje.
Vrsta ARIB 7 100% / 75% / SMPTE Odabir vrste stupca boje.

Technical >ND Dial

Postavljanje postavki za operacije s kotacicem ND VARIABLE.

Stavka Postavka podstavke Opis
Vrsta Optical Zoom Only / On(Clear Image Postavljanje vrste zumiranja.
zumiranja Zoom) Samo opticki zum:

Opticki zum namjesta se radom objektiva.
On(Clear Image Zoom):

Elektronicki zum s malo ili bez

pogorsavanja kvalitete slike.

Technical >Handle Zoom
Postavljanje postavki za zumiranje na rucki.

Stavka Postavka podstavke Opis
CLEAR with On / Off Postavljanje omogucivanja uklopa
Dial statusa ND (CLEAR «— On) radnjom

s kotac¢icem ND VARIABLE.

Stavka Postavka podstavke

Opis

Technical >Tally
Postavljanje postavki lampice snimanja/signalizacije.

Stavka Postavka podstavke

Opis

Prednja On / Off Ukljucenje/iskljucenje funkcije lampice
strana snimanja/signalizacije.

Straznja On / Off Ukljucenje/iskljucenje funkcije lampice
strana snimanja/signalizacije (straznje).

Setting Off / Low / High / Variable Postavljanje brzine zuma na rucki.

High (Visok) od1do 8(8) Odabir brzine zuma na rucki kada je za
brzinu zuma na rucki odabrana funkcija High.

Low (Nizak) od1do8(3) Odabir brzine zuma na rucki kada je za

brzinu zuma na rucki odabrana funkcija Low.

[Napomenal]

Kada je brzina zumiranja postavljena na nisku
vrijednost, moZe doci do neujednacenog
zumiranja.

Technical >HOLD Switch Setting

Technical >Menu Settings
Postavljanje postavki za izbornik.

Postavljanje postavki za sklopku za priviemeni prekid. Stavka Postavka podstavke Opis
Stavka Postavka podstavke Opis User Menu On / Off Postavljanje samo prikaza izbornika User
with Rec On / Off Postavljanje zakljucavanja rada gumba Only (On) |I|.pr|kaza poplsa. |zbo.rn|.ka (Of_f)
Button za snimanje START/STOP. kada videokamera prikazuje izbornik.
h Hand on 7 Off P T e - — User Menu On / Off Postavljanje zakljucavanja prikaza
W'F an =20 os.'.caVJanje za chevanja oPgraC|Ja na with Lock izbornika, prikaza samo izbornika User.
Grip Remote daljinskom upravljacu na rucki.

Technical >Touch Operation
Postavlja postavke povezane s radom dodirom.

Stavka Postavka podstavke

Opis

[Napomena]

U normalnom radu s prikazom izbornika
ova se stavka ne prikazuje. Detalje

o radu s prikazom izbornika potraZite
pod stranica 68.

Setting On / Off

Ukljucuje/iskljucuje rad dodirom.

Technical >Rec Review
Postavljanje postavki za pregled snimanja.

Stavka Postavka podstavke

Opis

Setting 3sec / 10sec / Clip

Odabir vremena za reprodukciju netom

snimljenih isjecaka za pregled snimke.
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Technical >Fan Control

Postavljanje postavki za nacin upravljanja ventilatorom.

Stavka

Postavka podstavke

Opis

Technical >Video Light Set

Postavljanje metode osvjetljavanja svjetlom za videozapis. Dostupno samo pri upotrebi HVL-LBPC

(u opciji).

Setting

Auto / Minimum / Off in Rec

Postavljanje nacina za upravljanje
ventilatorom videokamere.

[Napomena]

Cak i kada je odabrana funkcija Even when Off in
Rec, ventilator radi kada unutarnja temperatura
videokamere prekoraci odredenu vrijednost.

Stavka Postavka podstavke

Opis

Technical >Lens
Postavljanje postavki za objektive.

Stavka

Postavka podstavke

Opis

Smijer prstena

Left(W)/Right(T) / Right(W)/Left(T)

Postavljanje smjera za upotrebu prstena

Video Light Power Link / Rec Link / Rec Link + Stby

Set

Postavljanje metode upravljanja svjetlom
za videozapis postavljenim na nosac za
visSe sucelja.
Veza napajanja:
ukljucenje/iskljucenje svjetla za videozapis
kada je videokamera ukljucena/iskljucena.
Rec Link:
ukljucenje/iskljucenje svjetla za
videozapis kada videokamera
pokrece/zaustavlja snimanje.
Rec Link + Stby:

za zum za zumiranje. o o
uklju€enje/ postavljanje svjetla za

[Napomenal] videozapis u nacin pripravnosti kada
Omoguceno samo pri primjeni objektiva E-mount videokamera pokrece/zaustavlja snimanje.
koji podrZava zamjenu smjera prstena za zumiranje.

Shading Auto / Off Uklju¢enje/isklju¢enje automatske Technical >APR

Compensation kompenzacije sjencanja. Izvodi APR.

Chroma Auto / Off Ukljucenje/iskljucenje automatske Stavka Postavka podstavke Opis

éct;rirranon kompenzacije kromatske aberacije. APR Execute / Cancel Izvodi APR (Automatic Pixel Restoration) za

ik ———— automatsko podesavanje slikovnog senzora.

!(Ol’l.’lp.. . Auto / Off UkIJucenJe/lﬂskI.Jucer?Jve a.utomatske Execute: izvodenje funkcije.

iskrivljenja kompenzacije izoblienja.

Distance Meter / Feet Postavljanje prikazanih jedinica za L'\rlfepg\rg%r;i].a funkciie APR uviiek postavite

Display informacije o objektivu i polozaj fokusa. pojklopac Objjektiva_ ) jekp

Zoom Focal Length / Number / Bar Postavljanje formata prikaza za polozaj

Position Zuma. Technical >Camera Battery Alarm

Display Postavljanje postavki alarma za nizak napon baterije.

Stavka Postavka podstavke

Opis

Low Battery 5% /10% /15% / ... / 45% / 50%

Postavljanje preostale razine baterije
za prikaz alarma za niski napon baterije
(koraci od 5 %).

Battery od 3% do 7%
Empty

Postavljanje preostale razine baterije
za prikaz alarma za praznu bateriju.

Technical >Camera DC IN Alarm

Postavljanje postavki za alarm za ulazni napon.

Stavka Postavka podstavke Opis

DC Low 0d 16,0V do 19,0 V (16,5 V) Postavljanje napona na kojem se prikazuje
Voltagel alarm za nizak ulazni napon na DC IN.

DC Low 0d 155V do18,5V Postavljanje napona na kojem se prikazuje

Voltage2

alarm za nedovoljan ulazni napon na DCIN.
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lzbornik Network

U ovom odjeljku opisana je funkcija i postavke za svaku stavku izbornika.
Tvornicki zadane postavke prikazuju se podebljane (na primjer 18dB).

Network >ST Mode Settings
Postavljanje postavki za veze za nacin za stanicu.

Network >Access Authentication
Postavljanje postavki za provjeru autenti¢nosti.

Stavka Postavka podstavke

Opis

Stavka Postavka podstavke

Opis

Daljinski
upravljac
kamere

Enable / Disable

Postavljanje omogucivanja daljinskog
upravljanja s uredaja povezanog s
videokamerom beZi¢nom vezom LAN
u nacinu za stanicu.

User Name Postavljanje korisnickog imena za
provjeru autenti¢nosti za pristup.
Password Postavljanje lozinke za provjeru

autenticnosti za pristup.

Network >Wireless LAN
Postavljanje postavki za beZi¢ne veze LAN.

Stavka Postavka podstavke

Opis

Setting Access Point Mode / Station Mode / Off Odabir nacina rada beZi¢ne veze LAN.
WPS Execute / Cancel Uspostavljanje veze putem
WPS (Wi-Fi Protected Setup).
Execute: izvodenje funkcije.
NFC Execute / Cancel Uspostavljanje veze putem NFC
(Near Field Communication).
Execute: izvodenje funkcije.
MAC Address Prikaz MAC adrese za beZi¢no sucelje

LAN na videokamere.

Network >AP Mode Settings

Postavljanje postavki za veze za nacin za pristupnu tocku.

Stavka Postavka podstavke Opis

Kanal Auto(5GHz) / Auto / CH1/ CH2 / Postavljanje kanala za bezi¢ni LAN.
CH3 / CH4 / CH5 / CH6 / CH7 / CH8 / CH9 / Auto(5GHz) je dostupan samo na
CH10 /7 CHM ILME-FX6V/VK.

Camera SSID Prikaz identifikatora SSID i lozinke

& Password videokamere.

Regenerate Execute / Cancel Stvaranje nove lozinke.

Password Execute: izvodenje funkcije.

IP Address Prikaz IP adrese videokamere u nacinu

za pristupnu tocku.

Connected
Network

Prikaz povezanih bezi¢nih mreza LAN
(pristupna tocka).

SSID

Prikaz identifikatora SSID pristupne tocke
za povezivanje.

Sigurnost

Prikaz vrste sigurnosti pristupne tocke za
povezivanje.

Password

Prikaz lozinke pristupne tocke za

povezivanje.

Kada je funkcija Security postavljena na
WEP ili WPA: *xxxx

Kada je funkcija Security postavljena na
None: (prazno)

DHCP

Prikaz ukljucenosti/isklju¢enosti
posluZitelja DHCP.

IP Address

Prikaz IP adrese videokamere kada je
DHCP postavljen na Off.

Subnet Mask

Prikaz maske podmreZe videokamere
kada je DHCP postavljen na Off.

Gateway Prikaz zadanog pristupnika videokamere
kada je DHCP postavljen na Off.
DNS Auto Prikaz ukljucenosti/iskljucenosti

dobavljanja sustava DNS.

Primary DNS Server

Prikaz primarnog posluzitelja za DNS
videokamere kada je funkcija DNS Auto
postavljena na Off.

Secondary DNS Server

Prikaz sekundarnog posluzitelja za DNS
videokamere kada je funkcija DNS Auto
postavljena na Off.

Subnet Mask

Prikaz maske podmreze videokamere
u nacinu za pristupnu tocku.
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Network >ST Mode Settings

Postavljanje postavki za veze za nacin za stanicu.

Network >ST Mode Settings

Postavljanje postavki za veze za nacin za stanicu.

Stavka Postavka podstavke Opis Stavka Postavka podstavke Opis
Scan Otkrivanje beZi¢nih mreZa LAN (pristupne Manual Registriranje postavki za ru¢no
Networks tocke) i prikaz popisa. Register povezivanje s pristupnom tockom.

Odabir odrediSta s popisa za povezivanje.

SSID Prikaz identifikatora SSID pristupne tocke
za povezivanje.

Sigurnost Prikaz vrste sigurnosti pristupne tocke za
povezivanje.

Password Unos lozinke za povezivanje
s pristupnom tockom.

DHCP Ukljucenje/iskljucenje posluzitelja DHCP.

On / Off
IP Address Unos IP adrese videokamere kada je

DHCP postavljen na Off.

Subnet Mask

Unos maske podmreZe videokamere
kada je DHCP postavljen na Off.

Gateway Unos zadanog pristupnika videokamere
kada je DHCP postavljen na Off.
DNS Auto Ukljucenje/iskljucenje automatskog
On / Off dobavljanja sustava DNS.

Primary DNS Server

Unos primarnog posluzitelja za DNS
videokamere kada je funkcija DNS Auto
postavljena na Off.

Secondary DNS Server

Unos sekundarnog posluzitelja za DNS
videokamere kada je funkcija DNS Auto
postavljena na Off.

SSID Unos identifikatora SSID pristupne tocke
za povezivanje.
Security Postavljanje vrste sigurnosti pristupne

None / WEP / WPA

tocke za povezivanje. Odaberite WPA ako
je vrsta sigurnosti odredisne pristupne
tocke WPA ili WPA2.

Password Unos lozinke za povezivanje
s pristupnom tockom.
DHCP Ukljucenje/iskljucenje posluzitelja DHCP.
On / Off
IP Address Unos IP adrese videokamere kada je

DHCP postavljen na Off.

Subnet Mask

Unos maske podmreZe videokamere
kada je DHCP postavljen na Off.

Gateway Unos zadanog pristupnika videokamere
kada je DHCP postavljen na Off.
DNS Auto Ukljucenje/iskljucenje automatskog
On / Off dobavljanja sustava DNS.

Primary DNS Server

Unos primarnog posluzitelja za DNS kada
je funkcija DNS Auto postavljena na Off.

Secondary DNS Server

Unos sekundarnog posluzitelja za DNS
kada je funkcija DNS Auto postavljena
na Off.
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Network >Wired LAN
Postavljanje postavki za Zi¢ne veze LAN.

Network >File Transfer
Postavljanje postavki za prijenose.

Stavka Postavka podstavke Opis Stavka Postavka podstavke Opis
Postavljanje  On / Off Ukljucenje/iskljucenje funkcije zi¢ne Auto Upload On / Off Ukljucenje/iskljucenje automatskog
veze LAN. (Proxy) prijenosa datoteke proxy.
Camera Enable / Disable Postavljanje omogucivanja daljinskog Default Odabir posluzitelja za prijenos datoteka.
Remote upravljanja s uredaja povezanog s Upload Ovdje odabran posluzitelj postaje
Control videokamerom zi¢nom vezom LAN. Server automatsko odrediste za prijenos
Detail Konfiguriranje postavki Zi¢ne veze LAN. datoteka proxy, kao i odrediste
Settings DHCP Ukljucenje/isklju¢enje posluZitelja DHCP. za prijenos datoteka sa zaslona
On / Off S minijaturama.
— Prikazuje naziv prikaza konfiguriran
IP Address Unos IP adrese videokamere kada je xazuj zlv prikaz 'gunt
) u postavkama servera od 1do 3.
DHCP postavljen na Off. . . =
. Clear Execute / Cancel Brisanje dovrSene zadatke prijenosa
Subnet Mask Unos maske podmreze videokamere .
. ; Completed S popisa.
kada je DHCP postavljen na Off. L . "
Jobs Execute: izvodenje funkcije.

Gateway Unos zadanog pristupnika videokamere
kada je DHCP postavljen na Off.
DNS Auto Ukljucenje/iskljucenje automatskog
On / Off dobavljanja sustava DNS.

Clear All Jobs  Execute / Cancel

Brisanje svih zadataka prijenosa s popisa.
Execute: izvodenje funkcije.

View Job List

Prikaz popisa sa zadacima prijenosa.

Primary DNS Server

Unos primarnog posluzitelja za DNS kada
je funkcija DNS Auto postavljena na Off.

Secondary DNS Server

Unos sekundarnog posluZitelja za DNS
kada je funkcija DNS Auto postavljena
na Off.

Network >Modem

Postavljanje postavki povezanih s dijeljenjem putem USB-a.

Stavka Postavka podstavke

Opis

Postavljanje  On / Off

Ukljucenje/iskljucenje veze s pametnim
telefonom.

Camera Enable / Disable
Remote
Control

Postavljanje dozvole povezivanja za
pristup s aplikacije Content Browser
Mobile s pomocu pametnog telefona.

Device Name

Prikazuje naziv uredaja pametnog
telefona.

IP Address

Prikazuje IP adresu pametnog telefona.

Subnet Mask

Prikazuje masku podmreze pametnog
telefona.
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Network >File Transfer
Postavljanje postavki za prijenose.

Stavka Postavka podstavke Opis
Server Display Name Postavljanje naziva za prikaz koji se
Settings1 prikazuje u izborniku za postavljanje
odredista za prijenos.
Service Prikaz vrste posluzitelja.
m
Host Name Postavljanje naziva domacina odredisnog

posluZzitelja za prijenos.

Port (od 1 do 65535 (21))

Postavljanje broja ulaza odrediSnog
posluZzitelja za prijenos.

User Name Postavljanje korisnickog imena za
provjeru autenti¢nosti za vezu
s odrediSnim posluZziteljem za prijenos.
Password Postavljanje lozinku za provjeru

autenticnosti veze s odredisnim
posluziteljem.

Passive Mode
On / Off

Ukljucenje/iskljucenje nacina PASV.

Destination Directory

Unos naziva odrediSne mape za prijenos.

Using Secure Protocol
On / Off

Postavljanje primjene (On) ili izostave
primjene (Off) sigurnog prijenosa FTP
(FTPS Explicit Mode: FTPES).

Root Certificate
Load / Clear / None

Ucitavanje korijenskog certifikata za
siguran prijenos FTP te brisanje postavki.

Root Certificate Status
Loaded / No Certificate

Prikaz statusa ucitavanja korijenskog
certifikata za siguran prijenos FTP.

Reset
Execute / Cancel

Ponovno postavljanje postavki pod
Server Settings na zadane vrijednosti.
Execute: izvodenje funkcije.

Server Isto kao Server Settings1.
Settings2
Server Isto kao Server Settings1.
Settings3

Network >Network Reset
Ponovno postavljanje mreznih postavki.

Stavka Postavka podstavke

Opis

Reset Execute / Cancel

Ponovno postavljanje mreznih postavki.
Execute: izvodenje funkcije.
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|zbornik Maintenance

U ovom odjeljku opisana je funkcija i postavke za svaku stavku izbornika.
Tvornicki zadane postavke prikazuju se podebljane (na primjer 18dB).

Maintenance >Hours Meter
Prikaz ukupnog vremena rada.

Maintenance >Language
Postavljanje jezika prikaza.

Stavka Postavka podstavke

Opis

Stavka Postavka podstavke Opis
Hours Prikaz ukupnih radnih sati (nije moguce
(System) ponovno postaviti).

Select

Postavljanje jezika prikaza.
SET: postavljanje jezika.

Hours (Reset)

Prikaz ukupnih radnih sati (moguce je
ponovno postaviti).

Maintenance >Clock Set
Postavljanje postavki unutarnjeg sata.

Reset Execute / Cancel

Ponovno postavljanje prikaza Hours
(Reset) na 0.
Execute: izvodenje funkcije.

Stavka Postavka podstavke

Opis

Time Zone od UTC -12:00 do UTC +14:00

Postavljanje vremenske razlike od UTC
u jedinicama od 30 minuta.

Maintenance >Version
Prikaz informacija o verziji.

Date Mode YYMMDD / MMDDYY / DDMMYY

Odabir formata prikaza datuma.
YYMMDD: godina, mjesec, dan
MMDDYY: mjesec, dan, godina
DDMMYY: dan, mjesec, godina

Stavka Postavka podstavke Opis
Version VXXX Prikaz verzije softvera videokamere.
Number

Version Up Execute / Cancel

AZuriranje videokamere.”

Execute: izvodenje funkcije.

* Ovom funkcijom aZurira se softver
videokamere.

Lens Version  Vxx
Number

Prikaz broja verzije softvera objektiva
E-mount.

12H/24H 12H / 24H Odabir formata prikaza sata.
12H: nacin od 12
24H: nacin od 24

Date Postavljanje trenutacnog datuma.
SET: postavljanje vrijednosti.

Time Postavljanje trenutacnog vremena.

SET: postavljanje vrijednosti.

Maintenance >All Reset

Ponovno postavljanje postavki na tvornicki zadane vrijednosti.

Stavka Postavka podstavke

Opis

Reset Execute / Cancel

Ponovno postavljanje svih postavki na
tvornicki zadane vrijednosti.

Execute: izvodenje funkcije.
[Napomena]

3D LUT datoteka uvezena s pomocu funkcije
Base Look >Import (stranica 83) u izborniku

Paint/Look izbrisana je. Za brisanje svih 3D LUT
datoteka odaberite funkciju Base Look >Delete

All u izborniku Paint/Look (stranica 83).

Reset without Execute / Cancel
Network

Ponovno postavljanje postavki izbornika,

izuzev postavki izbornika Network,
u tvornicki zadano stanje.
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6. Prikaz i postavke izbornika

Postavke | zadane vrijednosti izbornika Shooting

Postavke i zadane vrijednosti ISO/Gain

Raspon postavki i zadane vrijednosti ISO/Gain (stranica 72) variraju ovisno o postavkama funkcija Mode, Target Display, Base Look >Select i Base Sensitivity. Dostupne opcije istaknute
su sivom bojom.

Kada je nacin Mode postavljen na ISO

Target Display

SDR(BT.709)

HDR(HLG)

SDR(BT.709) i HDR(HLG) common

Base Look >Select

S-Cinetone / Standard / ITU709 / Still

HLG Live / HLG Natural

Od User1 do User16

Base Sensitivity

Low (Nizak)

High (Visok)

Low (Nizak)

High (Visok)

Low (Nizak)

High (Visok)

1ISO 320

ISO/Gain<L> default

ISO 400

I1SO 500

ISO 640

ISO/Gain<M> default

1SO 800

1SO/Gain<L> default

1SO/Gain<L> default

1SO 1000

1SO 1250

ISO/Gain<H> default

1SO 1600

1SO/Gain<M> default

1SO/Gain<M> default

1SO 2000

1SO 2500

1SO 3200

1SO/Gain<H> default

1SO/Gain<H> default

ISO 4000

1SO 5000

ISO/Gain<L> default

1SO 6400

ISO 8000

1SO 10000

1SO/Gain<M> default

1SO 12800

ISO/Gain<L> default

I1SO/Gain<L> default

1SO 16000

1SO 20000

1SO/Gain<H> default

1SO 25600

ISO/Gain<M> default

I1SO/Gain<M> default

1SO 32000

1SO 40000

1SO 51200

ISO/Gain<H> default

1SO/Gain<H> default

1SO 64000

I1SO 80000

1SO 102400

1SO 128000

1SO 160000

1SO 204800

1SO 256000

1SO 320000

1SO 409600
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Kada je nacin Mode postavljen na dB

Raspon postavki
-3dB

-2dB

-1dB

0dB ISO/Gain<L> default
1dB

2dB

3dB

4dB

5dB

6dB I1SO/Gain<M> default
7dB

8dB

9dB

10dB

1dB

12dB 1SO/Gain<H> default
13dB

14dB

15dB

16dB

17dB

18dB

19dB

20 dB

21dB

22dB

23dB

24dB

25dB

26dB

27dB

28dB

29dB

30dB
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6. Prikaz i postavke izbornika: Postavke i zadane vrijednosti izbornika Shooting

Postavke limita AG(C-a i zadane vrijednosti

Raspon postavki i zadane vrijednosti limita AGC-a (stranica 73) variraju ovisno o postavkama funkcija Mode, Target Display, Base Look >Select i Base Sensitivity. Dostupne opcije istaknute

su sivom bojom.

Kada je nacin Mode postavljen na ISO

Target Display

SDR(BT.709)

HDR(HLG)

HDR(HLG)

SDR(BT.709) i HDR(HLG) common

Base Look >Select

S-Cinetone / Standard / ITU709 / Still

HLG Live

HLG Natural

Od User1 do User16

Base Sensitivity

Low (Nizak) High (Visok)

Low (Nizak)

High (Visok)

Low (Nizak)

High (Visok)

Low (Nizak) High (Visok)

ISO 400

1SO 500

I1SO 640

I1SO 800

1SO 1000

1SO 1250

1SO 1600

1SO 2000

Default

I1SO 2500

1SO 3200

1SO 4000

I1SO 5000

Default

Default

Default

1SO 6400

1SO 8000

1SO 10000

1SO 12800

1SO 16000

1SO 20000

1SO 25600

1SO 32000

Default

I1SO 40000

1SO 51200

1SO 64000

I1SO 80000

Default

Default

Default

1SO 102400

1SO 128000

1SO 160000

1SO 204800

1SO 256000

1SO 320000

1SO 409600
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Kada je nacin Mode postavljen na dB

Raspon postavki
3dB

6dB

9dB

12dB

15dB Default
18dB

21dB

24dB

27dB

30dB
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6. Prikaz i postavke izbornika

Postavke kvalitete slike spremljene za svaki nacin snimanja

Trenutacni status stavki konfiguracije povezan s kvalitetom slike spremljen za svaki od sljedecih nacina snimanja (stranica 24). Kada promijenite nacin snimanja, odgovarajuce spremljene postavke
primjenjuju se na ciljani nacin snimanja.

e Nacin Custom SDR(BT.709)

e Nacin Custom HDR(HLG)

e Nacin Cine El

Stavke konfiguracije povezane s kvalitetom slike koje su spremljene za svaki nacin snimanja prikazane su u nastavku.

Da: stavka je spremljena.

Ne: stavka nije spremljena.

Stavka konfiguracije Rezim snimanja
Nacin Custom Nacin Cine El
SDR(BT.709) ‘ HDR(HLG)
Izbornik Shooting ISO/Gain/El ISO/Gain Da" Ne
Exposure Index Ne Da
Base Sensitivity Da Ne
Base ISO Ne Da
Bijeli Preset White Da Da
Drugacije od navedenog Da
White Setting Da
Offset White Da Ne
LUT On/Off Ne Da
Noise Suppression Setting(Custom) Da Da Ne
Level(Custom) Da Da Ne
Setting(Cine El) Ne Da
Level(Cine El) Ne Da
Izbornik Paint/Look Base Look Odaberite Da Da Da
Input? Da
Output? Da
AE Level Offset? Da
Crni Da Da Ne
Komprimiranje Auto Knee Da Ne Ne
Drugacije od navedenog Da Da Ne
Detalj Da Da Ne
Matrix Da Da Ne
Multi Matrix Da Da Ne

1) Odvojene postavke ISO osjetljivosti spremljene su i za nacin Custom SDR(BT.709) i HDR(HLG).
2) Postavke su spremljene za svaki temeljni izgled i ne ovise o nacinu snimanja.
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6. Prikaz i postavke izbornika

Spremanje i ucitavanje podataka za konfiguraciju

Podaci za konfiguraciju

MoZete spremiti postavke cijelog izbornika

na memorijsku karticu umetnutu u utor za
CFexpress Type A karticu / SD karticu (B). To
omogucuje brzo pozivanje odgovarajuceg
kompleta postavki za trenutac¢nu situaciju.
Podaci za konfiguraciju spremaju se u sljedece
kategorije.

Korisnicke datoteke

U korisnicke datoteke spremaju stavke

za postavljanje i podaci iz prilagodljivog
izbornika User.

MoZete spremiti do 64 datoteke na
memorijsku karticu.

Ucitavanjem ove datoteke u memoriju
videokamere moguce je prilagoditi postavke
izbornika User.

Datoteke ALL (sve postavke)

U datoteke ALL spremaju se podaci za
konfiguraciju za sve izbornike. MoZete spremiti
do 64 datoteke na memorijsku karticu.

[Napomena]

Posebni podaci uredaja (sjencanje, izlazne razine i drugi
podaci koji zahtijevaju prilagodbu za poseban uredaj) ne
spremaju se.

Spremanije korisnicke datoteke /
datoteke ALL

Ucitavanje korisnicke datoteke /
datoteke ALL

1 Umetnite memorijsku karticu u utor za
CFexpress Type A karticu / SD karticu (B)
(stranica 6).

e Kod CFexpress kartica naljepnica je
okrenuta na lijevu stranu.

e Kod SD kartica naljepnica je okrenuta
na desnu stranu s nakoSenim rubom
na dnu.

2 Za datoteku korisnika odaberite funkciju
User File >Save Media(B) (stranica 82)
>Execute u izborniku Project cijelog
izbornika.

Za SVE datoteke odaberite funkciju All File
>Save Media(B) (stranica 82) >Execute

u izborniku Project cijelog izbornika.
Prikazuje se zaslon s odredistem

za spremanje datoteke.

3 Odaberite redak "No File" na zaslonu
s odredistem za spremanje.
Odabirom retka s unosom File ID prepisuje
se odabrana datoteka.
File ID generira se automatski, no moZete
ga izmijeniti.

4 Odaberite Execute na zaslonu za potvrdu.

1 Umetnite memorijsku karticu na koju je
datoteka spremljena u utor za CFexpress
Type A karticu / SD karticu (B)

(stranica 6).

e Kod CFexpress kartica naljepnica je
okrenuta na lijevu stranu.

e Kod SD kartica naljepnica je okrenuta
na desnu stranu s nakosenim rubom
na dnu.

2 Za datoteku korisnika odaberite funkciju
User File >Load Media(B) (stranica 82)
>Execute u izborniku Project cijelog
izbornika.

Za SVE datoteke odaberite funkciju All File
>Load Media(B) (stranica 82) >Execute

u izborniku Project cijelog izbornika.
Prikazuje se zaslon s popisom datoteka.

3 Odaberite datoteku za ucitavanje.
Prikazuje se zaslon za potvrdu.

4 Odaberite Execute.

[Napomene]

e Nakon ucitavanja podataka za konfiguraciju jedinica
se automatski ponovno pokrece.

e Kada je funkcija All File >Load Network Data
u izborniku Project cijelog izbornika postavljena na
Off, ucitane su sve postavke u SVIM datotekama
osim postavki izbornika Network.

Promjena stavke File ID

1 Za datoteku korisnika odaberite funkciju
User File >File ID (stranica 82) u
izborniku Project cijelog izbornika.
Za SVE datoteke odaberite funkciju All File
>File ID (stranica 82) u izborniku Project
cijelog izbornika.
Prikazuje se zaslon za uredivanje
stavke File ID.

2 Odaberite znak s pomocu viSestrukog
biraca (stranica 7) ili viSenamjenskog
kotacica (stranica 5), zatim pritisnite
gumb za primjenu visestrukog biraca
ili viSenamjenski kotacic.

3 Po potrebi ponovite 2. korak.

4 Po dovrsetku unosa znakova
odaberite Done.
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7. Prikljucenje vanjskog uredaja

Prikljucenje vanjskih monitora i uredaja za snimanje

Za prikaz snimljenih slika/reprodukciju

na vanjski monitor odaberite izlazni signal
videokamere i upotrijebite odgovarajuci

kabel za monitor koji prikljucujete.

Takoder mozete prikljuciti uredaje za snimanje,
poput magnetoskopa, i snimati izlazne signale
s videokamere.

Na vanjskom monitoru moguce je prikazati
iste informacije koje se mogu pregledati

na trazilu, primjerice informacije o statusu

i izbornike. Informacije o postavljanju Zaslon
(stranica 14) na zaslonu Monitoring Status

ili zaslonu Output Display (stranica 87)
izbornika Monitoring cijelog izbornika
postavite na On u skladu sa signalom za izlaz
na monitor.

Istovremeno pokretanje snimanja
videokamerom i vanjskim uredajem

S omogucenim izlazom signala SDI, funkciju
SDI/HDMI Rec Control (stranica 79) >Setting

u izborniku Project cijelog izbornika postavite
na SDI/HDMI Remote I/F ili Parallel Rec kako
biste omogudili izlaz pokretackog signala REC
na vanjski uredaj priklju¢en na priklju¢nicu SDI
OUT. Tako se sinkronizira snimanje na vanjski
uredaj s videokamerom.

[Napomene]

e Ako prikljuceni vanjski uredaj ne podrZzava pokretacki
signal REC, uredaj ne moZe raditi.

e Kada nije umetnut medij, izvozi se samo pokretacki
signal REC.

Priklju¢nica SDI OUT (vrsta BNC)

U izborniku Monitoring (stranica 87)
postavite postavku ukljucenja/iskljucenja
izlaza i izlazni format.

Za povezivanje upotrijebite komercijalno
dostupan koaksijalni kabel od 75 Q.

[Napomenal]
Prije ukljucenja uredaja provijerite je li veza videokamere
i vanjskog uredaja uzemljena.

(Nakon priklju¢enja koaksijalnog kabela od

75 Q preporucuje se ukljuciti videokameru

i vanjski uredaj.)

Ako je vanjski uredaj nuzno prikljuciti dok je
videokamera ukljuc¢ena, koaksijalni kabel od
75 Q prvo prikljucite na vanjski uredaj, a potom
na videokameru.

PrikljuCnica HDMI OUT
(prikljucnica vrste A)

U izborniku Monitoring (stranica 87) cijelog
izbornika postavite postavku uklju¢enja/
iskljuenja izlaza i izlazni format.

Istovremeno pokretanje snimanja
videokamerom i vanjskim uredajem

S omogucenim izlazom signala HDMI, funkciju
HMDI TC Out >Setting (stranica 85) u

izborniku TC/Media cijelog izbornika postavite
na On, a funkciju SDI/HDMI Rec Control
>Setting (stranica 79) u izborniku Project
postavite na SDI/HDMI Remote I/F ili Parallel
Rec kako biste omogucili izlaz pokretackog
signala REC na vanjski uredaj prikljucen na
priklju¢nicu HDMI OUT. Tako se sinkronizira
snimanje na vanjski uredaj s videokamerom.
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7. Prikljucenje vanjskog uredaja

Sinkronizacija vremenskih kodova

Mozete sinkronizirati vremenski kod jedinice
s drugim uredajima.

Zakljucavanje vremenskog koda
za druge uredaje

Jedinicu koja osigurava vremenski kod
postavite u nacin u kojem se vremenski kod
stalno izvozi (poput Free Run ili Clock).

1 Postavite vremenski kod (stranica 85)
u izborniku TC/Media cijelog izbornika
kako slijedi.

Nacin rada: Preset
Run: Free Run

2 Pritisnite dodjeljivi gumb (stranica 48)
kojemu je dodijeljena funkcija DURATION/
TC/U-BIT kako biste vremenski kod
prikazali na zaslonu.

3 Provjerite je li sklopka za odabir TCIN/
OUT (stranica 4) postavljena u poloZaj
IN, zatim unesite referentni vremenski kod
za sinkronizaciju frekvencije sustava
videokamere u TC IN/TC OUT prikljucnicu.

Generator vremenskog koda na videokameri
zakljucava se s referentnim vremenskim
kodom, a na zaslonu se prikazuje "EXT-LK".
Deset sekundi nakon zaklju¢avanja
vremenskog koda vanjsko stanje zaklju¢anosti
odrZava se cak i ako se odspoji vanjski izvor
referentnog vremenskog koda.

[Napomene]

e Tijekom rada s vanjskim zaklju¢avanjem vremenski
kod trenutac¢no se zakljucava na vanjski vremenski
kod, a vrijednost vanjskog vremenskog koda prikazuje
se na podatkovnom dijelu zaslona. Medutim,
nemojte odmah pokrenuti snimanje. Prije snimanje
pricekajte nekoliko sekundi na stabilizaciju generatora
vremenskog koda.

e Ako frekvencija referentnog vremenskog koda
i frekvencija kadra na videokameri nisu jednake,
zakljucavanje je nemoguce postici i videokamera ce
raditi neispravno. Ako se to dogodi, vremenski kod
nece se uspjesno zakljucati na vanjski vremenski kod.

e Vremenski kod mozZe se prebacivati jedan kadar po
satu na temelju referentnog vremenskog koda.

Otpustanje vanjskog zaklju¢avanja

Promijenite postavku vremenskog koda

u izborniku TC/Media cijelog izbornika ili
iskljucite videokameru.

Vanjska sinkronizacija takoder se otpusta
ako se promijenite frekvencija sustava te pri
pokretanju snimanja u posebnom nacinu

snimanja (Slow & Quick Motion ili Interval Rec).

Sinkronizacija vremenskog koda
drugog uredaja s vremenskim
kodom videokamere

Jedinicu koja osigurava vremenski kod
postavite u nacin u kojem se vremenski kod
stalno izvozi (poput Free Run ili Clock).

1 Postavite vremenski kod videokamere
s pomocu vremenskog koda
(stranica 85) u izborniku TC/Media
cijelog izbornika.

2 Provjerite je li sklopka za odabir TC IN/
OUT (stranica 4) postavljena u poloZaj
OUT i spojite TC IN/TC OUT priklju¢nicu za
ulaz vremenskog koda uredaja koji Zelite
sinkronizirati.
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7. Prikljucenje vanjskog uredaja

Upravljanje/uredivanje isjecaka na racunalu

Povezivanje s USB kabelom

Upotreba Citaca kartice (nije obavezno)

Spojite Cita¢ CFexpress kartica ili ¢ita¢ SD
kartica na racunalo s pomocu USB kabela

i unesite memorijsku karticu u utor za ocitanje
kartice. Memorijska kartica prepoznaje se

kao dodani pogon racunala. Na podrzana
racunala moZete velikom brzinom uvoziti
isjecke primjenom nacina rada videokamere
za masovnu pohranu.

Upotreba nacina za masovnu pohranu

[Napomena]

Nacin za masovnu pohranu ne moZze se upotrebljavati
kada je funkcija Modem >Setting u izborniku Network
cijelog izbornika postavljena na On ili kada je funkcija
Wired LAN >Setting u izborniku Network postavljena na
On. Obje funkcije postavite na Off.

Prikljucite videokameru kabelom USB i umetnite
memorijsku karticu u utor A ili B. Memorijska

kartica prepoznaje se kao dodatni pogon racunala.

1 Spojite priklju¢nicu USB-C (stranica 7)
ili priklju¢nicu USB/multi (stranica 7)
na racunalo s pomocu USB kabela.

2 Sklopku videokamere POWER postavite
u polozaj ON.
Na zaslonu trazila prikazuje se poruka s
upitom o omogucivanju priklju¢ka USB.

[Napomena]

Potvrdna poruka za vezu USB ne prikazuje se dok
se prikazuje druga potvrdna poruka ili poruka

o napretku, primjerice pri formatiranju ili oporavku
memorijske kartice.

Potvrdna poruka prikazuje se nakon dovrsetka
formatiranja ili obnavljanja. Potvrdna poruka za
USB takoder se ne prikazuje prikazati kada se
prikazuje zaslon sa svojstvima. Poruka se prikazuje
po dovrsetku obrade ili povratku na zaslon

s minijaturama.

3 Okrenite viSenamjenski kotaci¢ i odaberite
Execute.

4 U prozoru "Moje racunalo" sustava
Windows provijerite je li kartica dodana
kao izmjenjivi disk.

Na racunalu Mac provjerite je li se mapa
,NO NAME" ili ,Untitled” (moZe se
uredivati) stvorila na radnoj povrsini.

[Napomene]

e Ako je pristupni indikator crven, nemojte provoditi
sljedece operacije.
- Iskljucivanje ili odspajanje kabela za napajanje
- Vadenje memorijske kartice.
- Odspajanje kabela USB

e Rad nije zajamcen na svim racunalima.

Upotreba nelinearnih sustava
uredivanja

U nelinearnim sustavima uredivanja potreban
je softver za uredivanje (u opciji) koji podrZava
formate snimljene videokamerom.
Namjenskim aplikacijskim softverom isjecke
koje Zelite uredivati prethodno spremite na
tvrdi disk racunala.
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Mjere opreza pri upotrebi

O kondenzaciji

Ako se jedinica brzo prenese s hladne na
toplu lokaciju, ili ako dode do naglog porasta
okolne temperature, na vanjskoj povrsini i/

ili u unutrasnjosti jedinice moZe se nakupiti
vlaga. Ta pojava naziva se kondenzacija. Ako
dode do kondenzacije, iskljucite jedinicu i
nemojte je upotrebljavati dok se kondenzacija
ne rascisti. Rad s jedinicom na kojoj ima
kondenzata moze uzrokovati njeno ostecenje.

Na LCD zaslonima

LCD zaslon postavljen na jedinicu proizveden
je tehnologijom visoke preciznosti i daje omjer
radnih piksela od najmanje 99,99 %. Stoga se
vrlo mali broj piksela moZe ,zaglaviti”, tako da
uvijek budu iskljuceni (crni), ukljuceni (crveno,
zeleno ili plavo) ili bljeskaju. Osim toga, takvi
se ,zaglavljeni” pikseli, zbog fizickih svojstava
zaslona s tekucim kristalima, mogu spontano
pojaviti nakon dugotrajne upotrebe. Takvi
problemi nisu kvar. Takvi problemi ne utjecu
na snimane podatke.

Pojava na slikovnom senzoru CMOS
kamere

[Napomena]
Na slikama moZe dodi do sljedece pojave, specificne za
slikovne senzore. To se ne smatra neispravnim radom.

Bijele mrlje

Premda se slikovni senzori proizvode
tehnologijom visoke preciznosti, na zaslonu se
u rijetkim slucajevima mogu pojaviti fine bijele
mrlje uzrokovane kozmickim zracenjem itd.

To je povezano s principom slikovnog senzora
i ne smatra se kvarom.

Bijele mrlje posebno su vidljive u sljede¢im
slucajevima:

e tijekom rada na visokim temperaturama
okoline
e pri povecanju jacine signala (osjetljivost).

Treperenje

Ako snimate pod fluorescentnom rasvjetom,
natrijevim svjetiljkama, Zivinim svjetiljkama ili
LED svjetiljkama, zaslon moze treperiti ili se
boje mogu razlikovati.

Potrosni dijelovi

e \entilator i baterija potrosni su dijelovi koje
periodicki treba zamijeniti.

Kada rade na sobnoj temperaturi, uobicajeni
ciklus zamjene je oko pet godina. Medutim,
ovaj ciklus zamjene opca je smjernica i ne
jamdi vijek trajanja ovih dijelova. Za detalje
0 zamjenskim dijelovima obratite se
distributeru.

e QOcekivani vijek trajanja adaptera
za izmjenicnu struju i elektrolitskog
kondenzatora je, pod normalnim radnim
temperaturama i pri normalnoj upotrebi
(8 sati dnevno; 25 dana mjesecno), oko pet
godina. Ako upotreba prekoracuje navedenu
normalnu ucestalost, ocekivani vijek trajanja
smanjuje se sukladno upotrebi.

e Prikljucak za bateriju na ovoj jedinici
(priklju¢nica za komplete baterija i adaptere
za izmjeni¢nu struju) potrosni je dio.

Ako su polovi prikljucka za bateriju izobli¢eni
udarcima ili vibracijama, ili ako su korodirali
tijekom dugotrajne upotrebe na otvorenom,
jedinicu nije moguce pravilno napajati.
Preporucuju se periodicki pregledi radi
odrZavanja jedinice u radnom stanju te
produljenja iskoristivog vijeka trajanja.

Vise informacija i pregledima zatrazite

od servisnog ili prodajnog predstavnika
tvrtke Sony.

Ugradena punjiva baterija

Videokamera ima ugradenu punjivu bateriju za
spremanje datuma, vremena i drugih postavki
Cak i kada je videokamera iskljuc¢ena. Ugradena
punjiva baterija napuni se nakon isteka 24

sata ako je jedinica priklju¢ena na elektri¢nu
uti¢nicu putem adaptera za izmjenicnu struju

ili ako je postavljen potpuno napunjen komplet
baterija, neovisno o tome je li videokamera
ukljucena/isklju¢ena. Punjiva baterija potpuno
se prazni nakon dva mjeseca ako nije prikljucen
adapter za izmjeni¢nu struju ili se videokamera
upotrebljava bez kompleta baterija.
Videokameru upotrebljavajte nakon punjenja
baterije. Medutim, ¢ak i ako punjiva baterija nije
napunjena, to ne utjece na rad videokamere
sve dok ne trebate datum snimanja.

Upotreba i prostor za spremanje

Spremite u ravan, prozracan prostor.

Izbjegavajte upotrebu ili spremanje jedinice na

sljedecim mjestima.

e Na prevelikoj toplini ili hladnodi (raspon
radne temperature: od 0 °C do 40 °C (od
32 °F do 104 °F))
Imajte na umu kako tijekom ljeta u vruc¢im
podrucjima temperature u automobilu sa
zatvorenim prozorima moZe lako prekoraciti
50 °C (122 °F).

e Na vlaznim ili prasnjavim lokacijama. Lokacije
na kojima jedinica moze biti izloZena kisi

e | okacije podloZne snaznim vibracijama

e Blizu jakih magnetskih polja.

e Blizu radijskih ili televizijskih odasiljaca koji
proizvode jaka elektromagnetska polja.

e Dugotrajno na izravnoj suncevoj svjetlosti ili
u blizini grijaca

Napomena o laserskim zrakama
Laserske zrake mogu oStetiti slikovni senzor

CMOS. Ako snimate scenu koja obuhvaca
lasersku zraku, budite pazljivi i nemojte je

usmijeriti izravno u objektiv jedinice. Posebice
snazne laserske zrake medicinskih ili drugih
uredaja mogu uzrokovati oStecenja zbog
reflektiranja i loma svjetlosti.

Sprjecavanje elektromagnetskih smetnji
od prijenosnih komunikacijskih uredaja

Upotreba prijenosnih telefona i drugih
komunikacijskih uredaja u blizini ove
kamere moze uzrokovati kvarove i smetnje
zvucnih signala i videosignala. U blizini
kamere preporucuje se iskljuciti prijenosne
komunikacijske uredaje.

Sigurnosne mjere opreza

e SONY NE SNOSI ODGOVORNOST ZA
BILO KOJU VRSTU STETE PROISTEKLE
IZ NEPOSTIVANJA ODGOVARAJUCIH
SIGURNOSNIH MJERA NA UREDAJIMA
ZA PRIJENOS, NEIZBJEZNOG CURENJA
PODATAKA PROUZROCENOG
SPECIFIKACIJAMA PRIJENOSA NI
SIGURNOSNIH PROBLEMA BILO KOJE VRSTE.

e Qvisno o radnoj okolini, neovlastene trece

strane na mreZi mogu ostvariti mogucnost

pristupa jedinici. Kada jedinicu povezujete

s mrezom, obavezno provjerite je li mreza

pravilno zasticena.

Sadrzaj komunikacije mogu neprimjetno

presresti neovlastene trece strane u blizini

signala. Kada upotrebljavate beZi¢nu
komunikaciju mrezom LAN, pravilno
primijenite sigurnosne mjere kako biste
zastitili sadrzaj komunikacije.

e Kada ovaj proizvod spajate na mrezu,
poveZite ga putem sustava koji pruza
funkciju zaStite poput usmjerivaca ili
vatrozida. Ako je povezan bez takve zastite,
moZe doci do problema sa sigurnoscu.
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1zIazni formati i ogranicenja

Tvornicki zadane postavke prikazuju se podebljane (na primjer 1920x1080P (Level A)). Frekvencija Format Stanje izlaza Izlazni format (Output Format
[Napomene] sustava videozapisa za RAW u izborniku Monitoring)
e Rezolucija izlaznog formata ogranicena je postavkama Rec Format >Frequency, Video Format i Codec u izborniku (Rec Format (Rec Format (Rec Format SDI HDMI
Project cijelog izbornika (stranica 77). >Frequency u >Video Format u >Codec u izborniku
e Rezolucija izlaznog formata ograni¢ena je kombinacijom snimanja broja sli¢ica u sekundi u nacinu S&Q. Izlaz za izborniku Project) izborniku Project)  Project)
HDMI mijenja se u Full HD ako su svi sljedeci uvjeti u cijelom izborniku ispunjeni. .
- Funkcija Rec Format >Video Format postavljena je na 4096x2160 ili 3840x2160 u izborniku Project Bezizlazaza RAW  4096x2160P 4096x2160P
- Funkcija S&Q Motion >Setting u izborniku Shooting postavljena na On 1920x1080P
- Funkcija S&Q Motion >Frame Rate u izborniku Shooting visa je od 60 fps 1920x1080i
- Funkcija Rec Format >Codec u izborniku Project postavljena je na RAW ili RAW & XAVC-l ili je funkcija Output On/ 3840x2160P 3840%2160P
Off >SDI u izborniku Monitoring postavljena na On
e Kada je izlaz za HDMI postavljen na 4096x2160P ili 3840x2160P, izlaz za HDMI mijenja se u 1920x1080P ako su 1920x1080P
ispunjeni prethodni uvjeti. Kada dode do toga, opcije odabira izlaza za HDMI 4096x2160P i 3840x2160P za funkciju 1920x1080i
Output Format >SDI/HDMI (stranica 87) u izborniku Monitoring oznac¢ene su sivom bojom i ne mogu se odabrati. 1920x1080P 1920x1080P
e Ako je izlazna razlucivost videozapisa visa od razlucivosti slike, ne izvozi se slika reprodukcije. .
(razina A) 1920x1080i
1920x1080P 1920x1080P
(razina B) 1920%1080i
|zlazni formati na prikljucnici SDI OUT/HDMI OUT 1920x1080i 1920x1080i
3840 x 2160 Sizlazom za RAW - 3840x2160P
1920x1080P
Frekvencija Format Stanje izlaza Izlazni format (Output Format 1920x1080i
sustava videozapisa za RAW u izborniku Monitoring) 1920x1080P
(Rec Format (Rec Format (Rec Format SDI HDMI 1920x1080i
>Frequency u >Video Format u >Codec u izborniku 1920x1080P
izborniku Project) izborniku Project)  Project) 19201080
59,94 / 50 4096x2160 Sizlazom za RAW - 4096x2160P 1920x1080i
1920x1080P Bez izlaza za RAW  3840x2160P 3840x2160P
1920x1080i 1920x1080P
3840x2160P 1920x1080i
1920x1080P 1920x1080P 1920x1080P
1920x1080i (razina A)
1920x1080P 1920x1080i
1920x1080i 1920x1080P 1920x1080P
1920x1080P (razina B)
1920x1080i 1920x1080i
1920x1080i 1920%1080i 1920%1080i
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Frekvencija Format Stanje izlaza Izlazni format (Output Format Format Stanje izlaza Izlazni format (Output Format
sustava videozapisa za RAW u izborniku Monitoring) videozapisa za RAW u izborniku Monitoring)
(Rec Format (Rec Format (Rec Format SDI HDMI (Rec Format (Rec Format SDI HDMI
>Frequency u >Video Format u >Codec u izborniku >Frequency u >Video Format u >Codec u izborniku
izborniku Project) izborniku Project)  Project) izborniku Project) izborniku Project)  Project)
1920x1080 Bez izlaza za RAW  1920x1080P 1920x1080P 4096x2160 Sizlazom za RAW - 4096x2160P
(razina A) 1920x1080P
1920x1080i Bez izlaza za RAW  4096x2160P 4096x2160P
1920x1080P 1920x1080P 1920x1080P 1920x1080P
(razina B) 4096x2160 Sizlazom za RAW - 4096x2160P
1920x1080i 1920x1080P
1920x1080i 1920x1080i 3840x2160P
- 59,94: 720x480P 1920x1080P
50: 720x576P 1920x1080P
29,97/25 4096x2160 Sizlazom za RAW - 4096x2160P Bez izlaza za RAW  4096x2160P 4096x2160P
1920x1080P 1920x1080P
3840x2160P 3840%2160P 3840x2160P
1920x1080P 1920x1080P
1920x1080P 1920x1080P 1920x1080P
1920x1080i 3840 x 2160 Sizlazom za RAW - 3840x2160P
Bez izlaza za RAW  4096x2160P 4096x2160P 1920x1080P
1920x1080P 1920x1080P
3840x2160P 3840x2160P Bez izlaza za RAW  3840x2160P 3840x2160P
1920x1080P 1920x1080P
1920x1080P 1920x1080P 1920x1080P 1920x1080P
1920x10801 (PsF)  1920x1080i 1920x1080 Bez izlaza za RAW  1920x1080P 1920x1080P
3840 x 2160 Sizlazom za RAW - 3840x2160P
1920x1080P
1920x1080P
1920x1080i
Bez izlaza za RAW  3840x2160P 3840x2160P
1920x1080P
1920x1080P 1920x1080P
1920x1080I (PsF) 1920x1080i
1920x1080 Bez izlaza za RAW  1920x1080P 1920x1080P
1920x10801 (PsF)  1920x1080i
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Rjesavanje problema

lzvor napajanja

Simptom

Uzrok Rjesenje

Isjecak nije moguce
reproducirati.

Simptom

Uzrok

Rjesenje

Videokamera se ne ukljucuje.

Nije postavljen komplet
baterija i nema napajanja na
prikljuc¢nici DC IN.

Postavite komplet baterija

(stranica 17) ili prikljucite na
izmjeni¢no napajanje adapterom za
izmjeni¢nu struju (stranica 18).

Komplet baterija potpuno je
ispraznjen.

Isjecak se ureduje. Isjecke nije moguce reproducirati ako
ste izmijenili nazive ili datoteke, ili ako
se isjeCak upotrebljava na racunalu.

Ne radi se o kvaru.

Isjecak se snima na drugi Isjecke snimljene na druge uredaje

Komplet baterija zamijenite s potpuno
napunjenim (stranica 17).

Elektri¢cno napajanje prekida
se tijekom rada.

Komplet baterija prazni se.

Komplet baterija zamijenite s potpuno

napunjenim (stranica 17).

Komplet baterija vrlo se brzo
prazni.

Okolna temperatura vrlo je
niska.

To uzrokuju karakteristike baterije i ne

smatra se kvarom.

Komplet baterija nepravilno
je napunjen.

Ponovno napunite komplet baterija

(stranica 17).

uredaj. nemoguce je reproducirati ili se
prikazuju u neispravnoj velicini.
Ne radi se o kvaru.
Vanjski uredaji
Simptom Rjesenje

Racunalo ne prepoznaje
videokameru.

Ako se komplet baterija brzo prazni ¢ak
i nakon potpunog praznjenja, mozda je
na kraju vijeka trajanja. Zamijenite je
novom.

Odspojite kabel USB od racunala, a potom ga ponovno c¢vrsto
prikljucite.

Odspojite kabel USB od rac¢unala, ponovno pokrenite racunalo
i ponovno pratite korake ispravnim redoslijedom.

PoveZite racunalo i videokameru umetanjem USB kabela ili
u priklju¢nicu USB-Cili priklju¢nicu USB/multi.

Isjecke nije moguce ucitati na

Snimanje/reprodukcija

racunalo.

Odspojite kabel USB od racunala, ponovno pokrenite videokameru,
a potom je ponovno prikljucite.

Za ucitavanje isjecaka na racunalo mora biti instaliran aplikacijski
softver (stranica 108).

Simptom

Uzrok

Rjesenje

Snimanje ne zapocinje kada
pritisnete gumb za snimanje
START/STOP.

Memorijska kartica je puna.

Zamijenite memorijsku karticu karticom
s dovoljno prostora.

Potreban je oporavak
memorijske kartice.

Oporavite memorijsku karticu
(stranica 33).

Snimanje zvuka nije moguce.

Kotaci¢i AUDIO LEVEL (CH1/
CH2) postavljeni su na
minimalnu razinu.

Namjestite razine za snimanje zvuka
kotacic¢ima AUDIO LEVEL (CH1/CH2)
(stranica 46).

Snimljeni zvuk je izoblicen.

Razina zvuka je previsoka.

Namjestite razine za snimanje zvuka
kotaci¢ima AUDIO LEVEL (CH1/CH2)
(stranica 46).

Snimljeni zvuk ima visoku
razinu Suma.

Razina zvuka je preniska.

Namjestite razine za snimanje zvuka
kotacic¢ima AUDIO LEVEL (CH1/CH2)
(stranica 46).

Kada je odabran vanjski mikrofon,
takoder prilagodite postavku INPUT MIC
Reference pod Audio Input u izborniku
Audio (stranica 90).
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Bezicna LAN veza

[Napomenal]

Prepreke i elektromagnetske smetnje izmedu videokamere i pristupne tocke za bezi¢ni LAN ili priklju¢ni uredaj, ili
okruZenje (poput materijala u zidovima), mogu skratiti domet komunikacije ili ju potpuno onemoguciti. Ako dode do
ovih problema, provjerite status veze/komunikacije nakon prenosenja videokamere na novu lokaciju ili medusobno
priblizite videokameru i pristupnu toc¢ku/priklju¢ni uredaj.

Simptom

Rjesenje

Priklju¢ni uredaj ne moze
pristupiti videokameri.

® Provjerite rad beZi¢ne veze LAN (IP adresa itd.).

® Postavke komunikacije izmedu pristupne tocke i klijenta mozda
nisu valjane. Pojedinosti potrazite u uputama za upotrebu
pristupne tocke.

Nije moguca prijava u
videokameru.

Provjerite postavljeno korisnicko ime i lozinku.

Internetska veza

Simptom

Rjesenje

Prijenos datoteka nije uspio.

Korisnicko ime i lozinka posluzitelja mozda su neispravni.
Unesite ispravno korisni¢ko ime i lozinku.

Prijenos datoteka je nedostupan.

Signal mozZe biti los.
Predite na drugu lokaciju i pokuSajte ponovno.

Pri upotrebi filtra ND

Simptom

Rjesenje

Filtar ND ne pomice se.

Filtar je sljedec¢im postupkom moguce ru¢no pomaknuti u poloZzaj
Clear.

1 Sklopku POWER na videokameri postavite u iskljuceni polozaj.

2 Uklonite okrugli poklopac na donjoj strani.

3 Umetnite odvijac u otvor i okrenite ga u smjeru suprotnom od smjera kazaljke na satu.
e Filtar ND pomice se u poloZaj Clear okretanjem u smjeru suprotnom od smjera kazaljke
na satu. Okrecite do postizanja polozaja Clear.
e Upotrijebite odvija¢ promjera 2.4 mm ili manji. Dubina umetanja odvijaca je priblizno
30cm(13/in.).

|

©00
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:

Otvor za odvijac
(s uklonjenim poklopcem)

4 Sklopku ND PRESET/VARIABLE (stranica 5) postavite u polozaj PRESET, gumbe gore/dolje
za ND FILTER POSITION (stranica 5) u poloZaj CLEAR.

[Napomene]

e Prethodni postupak nemojte primjenjivati tijekom normalnog rada. Postupak primijenite samo kada se filtar ND ne
pomice. Ako postupak primijenite tijekom normalnog rada, moZe do¢i do ostecenja filtra ND.

e Nakon primjene prethodne procedure obratite se servisnom centru tvrtke Sony radi popravka videokamere.

e Ako se i nakon provedbe prethodnog postupka prikazuje poruka o pogresci, snimanje je i dalje moguce.
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Poruke o pogresci/upozorenju

Ako se na videokameri pojavi prikaz upozorenja, opreza ili radnog uvjeta koji zahtjeva potvrdu, na Poruka na trazilu Zvuk Lampica Uzrok i rjegenje
traZilu se prikazuje poruka, lampica snimanja/signalizacije pocinje treperiti i oglasava se zvu¢no upozorenja snimanja/
upozorenje. signalizacije
Ispusta se zvuk upozorenja sa slusalica spojenih na prikljucak za slusalice. Temperature High  Isprekidan Treperi Unutarnja temperatura je visoka.
Iskljucite videokameru i prije ponovnog rada
pricekajte da se ohladi.
Visoka temperatura Isprekidan Treperi Temperatura CFexpress kartice je visoka.
Poruke o pogregkama medija Zamijenite karticu ili prije ponovne upotrebe
pricekajte da se ohladi.
L i . Voltage Low Isprekidan Treperi Napon na DC IN je nizak (1. razina). Provjerite izvor
Videokamera prekida rad kada se prikaze sljedeca vrsta prikaza. napajanja.
Poruka na trazilu Zvuk Lampica Uzrok i rjesenje Insufficient Voltage Kontinuirano  Brzo Napon na DCIN je prenizak (2. razina). Snimanje je
upozorenja snimanja/ treperenje  onemoguceno.
signalizacije Prikljucite drugi izvor napajanja.
E + Sifra pogreske  Kontinuirano  Brzo Prikazuje nepravilnost na videokameri. Snimanje Media Near Full Isprekidan Treperi Preostali kapacitet memorijske kartice je malen.
treperenje  se zaustavlja, ¢ak i ako se na traZilu prikazuje Zamijenite prvom prilikom.
OREC. Media Full Kontinuirano  Brzo Isjecke nije bilo moguce snimiti ili kopirati jer je
Iskljucite videokameru i provjerite ima li problema treperenje  istroSen kapacitet memorijske kartice.
s prikljucenim uredajima, kabelima ili medijima. Odmah zamijenite.
Ako se pogreska i dalje pojavljuje po ponovnom Clips Near Full Isprekidan Treperi Broj dodatnih isje¢aka koje je moguce snimiti na
ukljucenju videokamere, obratite se servisnom memorijsku karticu je malen.
predstavniku tvrtke Sony. Zamijenite prvom prilikom.
(Ako se videokamera ne iskljuci pri postavljanju Clips Full Kontinuirano  Brzo Dosegnut je maksimalan broj dodatnih isjecaka
sklopke POWER na OFF, uklonite bateriju i treperenje  koje je moguce snimiti na memorijsku karticu.
odspojite napajanja na DC IN). Snimanje ili kopiranje dodatnih isje¢aka nije
Ovisn? o statusu videokamere, moze se prikazati moguce. Odmah zamijenite.
pogreska ili oglasiti zvuk upozorenja. Last Clip Recording Isprekidan Treperi Bududi da je dostignut maksimalni broj isjecaka,
trenutacno snimani isjecak posljedniji je isjecak
koji je moguce snimiti.
Pripremite novu memorijsku karticu.
Poruke upozorenja Media(A)" Life Near Isprekidan Treperi PribliZzava se kraj vijeka trajanja memorijske
End kartice. Zamijenite prvom prilikom.
L . . . Media(A)" Life End  Kontinuirano  Brzo Memorijska kartica dosegla je kraj vijeka trajanja.
Ako se prikaze sljedeci zaslon, pratite priloZzene upute. treperenje  Odmah zamijenite.
Poruka na trazilu Zvuk Lampica Uzrok i rjesenje Media(A)" Near Full Isprekidan Treperi Pri upotrebi funkcije Simul Rec
upozorenja snimanja/ Media(A)" Full Kontinuirano  Brzo Pri upotrebi funkcije Simul Rec
signalizacije treperenje
Battery Near End Isprekidan Treperi Preostala napunjenost paketa baterija postaje niska. Media(A)" Clips Isprekidan Treperi Pri upotrebi funkcije Simul Rec
Prvom prilikom ponovno napunite. Near Full
Battery End Kontinuirano  Brzo Komplet baterija je prazan. Snimanje je Media(A)" Clips Full Kontinuirano ~ Brzo Pri upotrebi funkcije Simul Rec
treperenje  onemoguceno. treperenje
Prekinite rad i zamijenite komplet baterija. Media(A) Last Clip Isprekidan Treperi Pri upotrebi funkcije Simul Rec

Rec

1) "(B)" se prikazuje za karticu u utoru B.
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8. Dodatak: Poruke o pogresci/upozorenju

Poruke za oprez i rad

Na sredini zaslona mogu se prikazati sljedece poruke za oprez i rad. Pratite upute za

rjeSavanje problema.

Poruka na zaslonu

Uzrok i rjesenje

Battery Error
Please Change Battery

Otkrivena je pogre$ka na paketu baterija.
Zamijenite normalnim kompletom baterija.

Backup Battery End
Please Change

Preostali kapacitet rezervne baterije je nedovoljan.
Promijenite rezervnu bateriju.

Unknown Media (A)"
Please Change

Umetnuta je particionirana memorijska kartica ili memorijska
koja sadrzi viSe isjecaka no Sto videokamera moze savladati.
Karticu nije moguce upotrebljavati u videokameri i morate

je zamijeniti.

Cannot Use Media (A)"
Unsupported File System

Umetnuta je kartica s drugim podatkovnim sustavom

ili neformatirana kartica.

Karticu nije moguce upotrebljavati u videokameri i morate
je zamijeniti ili formatirati u videokameri.

Media Error
Media (A) Y Needs to be Restored

Doslo je do pogreSke na memorijskoj kartici i karticu je nuzno
oporaviti.
Oporavite memorijsku karticu.

Media Error
Cannot Record to Media (A)"

Memorijska kartica moZda je ostecena i viSe se ne moze
upotrebljavati za snimanje.

Reprodukcija je moguca, stoga se preporucuje napraviti kopiju
i zamijeniti memorijsku karticu.

Media Error
Cannot Use Media (A) "

Memorijska kartica moZzda je oStecena i visSe se ne moze
upotrebljavati za snimanje ili reprodukciju.

Karticu nije moguce upotrebljavati u videokameri

i morate je zamijeniti.

Media (A) " Error
Recording Halted
Playback Halted

Snimanje i reprodukcija zaustavljeni su jer je doslo
do pogreske tijekom upotrebe memorijske kartice.
Ako se problem nastavi pojavljivati, zamijenite
memorijsku karticu.

Media Reached Rewriting Limit
Change Media (A)"

Memorijska kartica dosegla je kraj vijeka trajanja.

Napravite rezervnu kopiju i odmah zamijenite karticu.

Ako nastavite upotrebljavati karticu, snimanje i reprodukcija
mozda nece biti moguci.

Pojedinosti potrazite u uputama za upotrebu

memorijske kartice.

Navedena adresa nije valjana.

Navedena adresa nije valjana.
Provjerite je li postavka ispravna.

Cannot Use Specified Port Number

Navedeni broj ulaza nije valjan.
Provjerite je li postavka ispravna.

Poruka na zaslonu

Uzrok i rjesenje

Fan Stopped

Ugradeni ventilator se zaustavio.
Izbjegavajte upotrebu na visokim temperaturama, odspojite
napajanje i obratite se servisnom predstavniku tvrtke Sony.

Lens I/F Error(xx:xx)

Otkrivena je pogreska objektiva u komunikaciji I/F objektiva
kada je postavljen objektiv E-mount.

Provjerite status veze s objektivom E-mount.

Ako se problem nastavi pojavljivati, sa Sifrom pogreske
obratite se servisnom predstavniku tvrtke Sony

(pet znakova u zagradi).

This Multi Term. acc is not supported
by the device and cannot be used.
Please verify the compatibility.

Otkrivena je nekompatibilna dodatna oprema.
Jedina dodatna oprema za Multi Terminal koju podrzava
ova jedinica je priloZeni daljinski upravljac na drski.

Failed (Nije uspjelo)

Ova se pogreska moze prikazati ako nije moguce dohvatiti
adresu s DHCP postavljenim na On.
Provjerite postavke posluzitelja DHCP.

Cannot add auto upload job of Proxy
file because maximum number of
upload jobs was reached.

Dostignut je maksimalan broj zadataka prijenosa.
Obrisite nepotrebne zadatke. Postavka odredista za
automatski prijenos datoteka proxy takoder moze biti
neispravna. Provjerite je li postavka ispravna.

<SSID>Not found.

MreZu (pristupnu toc¢ku) s navedenim identifikatorom <SSID>
nije moguce pronaci.
Provjerite je li postavka ispravna.

<SSID>Authentication Failed

Provjera autenti¢nosti veze na mrezi (pristupna tocka) s
navedenim identifikatorom <SSID> nije uspjela.
Provjerite jesu li lozinka i druge postavke ispravne.

An IP address conflict has occurred.
Please check the network settings.

Postoji konflikt s mreznom adresom bezi¢ne veze LAN, Zi¢ne
veze LAN ili dijeljenjem putem USB-a.

Rucno promijenite adresu ili promijenite postavke

mreznog usmjerivaca.

The IP address of the Wireless
LAN Access Point Mode has been
changed due to an IP address
conflict.

IP adresa pristupne tocke za bezi¢ni LAN promijenjena je zbog
konflikta u mreznim adresama u nacinu za pristupnu tocku za
beZi¢ni LAN, Zi¢ni LAN ili dijeljenje putem USB-a.

Provjerite postavke IP adrese.

1) "(B)" se prikazuje za karticu u utoru B.



TeHR

8. Dodatak

Stavke spremljene u datotekama

Stavke konfigurirane u Cijelom izborniku RAZIN_A1 RAZINA 2 RAZINA 3 All File Scene File
Shooting Auto Exposure Level Da Ne
) ) Mode Da Ne
Ne. stavka e Spratmiena. Speed Da___ Ne
-: nije spremljeno (priviemena postavka) AGC Da Ne
RAZINA 1 RAZINA 2 RAZINA 3 All File Scene File AGC Limit ba Ne
Shooting ISO/Gain/El Mode Da Ne AGC Point Da Ne
- Auto Shutter Da Ne
e — -
IS0/ Gain<l> Da Ne A.SHT Point Da Ne
Clip High light Da Ne
Exposure Index<H> Da Ne Detect Window Da Ne
Eigzzﬁ:: ::SZ:EA: g: E: Detect Window Indication Da Ne
- Custom Width Da Ne
Shockless .G.a.m ba Ne Custom Height Da Ne
Base Sensitivity ba Ne Custom H Position Da Ne
- Base 150 Da Ne Custom V Position Da Ne
ND Filter Presetf ba Ne Bijeli Preset White Da Ne
Preset2 ba Ne Color Temp <A> Da Ne
Preset3 Da Ne Tint<As Da Ne
Shutter Mode Da Ne R Gain <As Da Ne
zﬁu::er zpeej On/Off ga Ee B Gain <A> Da Ne
Shutter Angle ba e Color Temp <6~ b2 Ne
Tint<B> Da Ne
ECS On/Off Da Ne R Gain <B> Da Ne
ECS Frequency Da Ne B Gain <B> Da Ne
White Setting Shockless White Da Ne
ATW Speed Da Ne
White Switch<B> Da Ne
Filter White Memory Da Ne
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RAZINA 1 RAZINA 2 RAZINA 3 All File Scene File RAZINA 1 RAZINA 2 RAZINA 3 All File Scene File

Shooting Offset White Offset White <A> Da Ne Project Base Setting Shooting Mode Da -
Offset Color Temp<A> Da Ne Target Display Da -

Offset Tint<A> Da Ne Rec Format Frekvencija Da Ne

Offset White <B> Da Ne Imager Scan Mode Da Ne

Offset Color Temp<B> Da Ne Kodek Da Ne

Offset Tint<B> Da Ne RAW Output Format Da Ne

Offset White<ATW> Da Ne Format videozapisa Da Ne
Offset Color Temp<ATW> Da Ne Cine El Setting Color Gamut Da -

Offset Tint<ATW> Da Ne Simul Rec Setting Da Ne

Focus AF Transition Speed Da Ne Proxy Rec Setting Da Ne

AF Subj. Shift Sens. Da Ne Audio Channel Da Ne

Focus Area Da Ne Interval Rec Setting Ne Ne

Focus Area (AF-S) Da Ne Interval Time Da Ne

Face/Eye Detection AF Da Ne Number of Frames Da Ne

Push AF Mode Da Ne Pre-Lighting Da Ne

AF Assist Da Ne SDI/HDMI Rec Control Setting Da Ne

S&Q Motion Setting Da Ne Gumb za dodjelu <1> Da Ne

Frame Rate Da Ne <2> Da Ne

LUT On/Off SDI/HDMI Da Ne <3> Da Ne

VF/Proxy/Stream Da Ne <4> Da Ne

Internal Rec Da Ne <5> Da Ne

Noise Suppression Setting(Custom) Da Ne <6> Da Ne

Level(Custom) Da Ne <7> Da Ne

Setting(Cine El) Da - <8> Da Ne

Level(Cine El) Da - <9> Da Ne

Flicker Reduce Mode Da Ne Gumb Zadrz. izost. Da Ne

Frekvencija Da Ne Assignable Dial Grip/Remote Dial Da Ne

SteadyShot Setting Da Ne Smijer kotacica na drski Da Ne

Kotaci¢ na rucki Da Ne

Smijer kotacica na rucki Da Ne

Multi Function Dial Default Function Da Ne
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RAZINA 1 RAZINA 2 RAZINA 3 All File  Scene File RAZINA 1 RAZINA 2 RAZINA 3 All File  Scene File
Project User File Load Media(B) - - Paint/Look Matrix User Matrix Da Da
Save Media(B) - - User Matrix Level Da Da
File ID Ne Ne User Matrix Phase Da Da
Load Customize Data Da Ne User Matrix R-G Da Da
Load White Data Da Ne User Matrix R-B Da Da
All File Load Media(B) - - User Matrix G-R Da Da
Save Media(B) - - User Matrix G-B Da Da
File ID Da Ne User Matrix B-R Da Da
Load Network Data Ne Ne User Matrix B-G Da Da
Paint/Look Scene File Pozivanje - - Multi Matrix Setting Da Da
Pohrana - - Reset - -
Delete - - Axis Ne Da
Opoziv unaprijed postavljene - - Hue Da Da
postavke Zasicenost Da Da
Base Look Odaberite Da Da TC/Media Timecode Mode Da Ne
Delete - - Pokreni Da Ne
Delete All - B Setting Ne Ne
Uvoz - - Reset - -
Ulaz Da Da TC Format Da Ne
1zlaz Da Da TC Display Display Select Da Ne
AE Level Offset Da Da Users Bit Mode Da Ne
Ponovno postavljanje ~ Ponovno postavljanje bez funkcije - - Setting Ne Ne
postavki boje Base Look HDMI TC Out Setting Da Ne
Crni Master Black Da Da Clip Name Format Title Prefix Da Ne
R Black Da Da Number Set Ne Ne
B Black Da Da Update Media Media(A) - -
Komprimiranje Setting Da Da Media(B) - -
Auto Knee Da Da Format Media Media(A) - -
Point Da Da Media(B) - -
Slope Da Da Monitoring Output On/Off SDI Da Ne
Detalj Setting Da Da HDMI Da Ne
Level Da Da Output Format SDI Da Ne
Rucne postavke Da Da HDMI Da Ne
Balans V/H Da Da Output Display SDI Da Ne
Balans B/W Da Da HDMI Da Ne
Ogranicenje Da Da
Crispening Da Da
Visoko osvijetljeni detalj Da Da
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8. Dodatak: Stavke spremljene u datotekama

RAZINA 1 RAZINA 2 RAZINA 3 All File Scene File RAZINA 1 RAZINA 2 RAZINA 3 All File Scene File
Monitoring Prikaz - ukljuc¢eno/ Network Status Da Ne Monitoring Prikaz - uklju¢eno/ Video Level Warning Da Ne
isklju¢eno File Transfer Status Da Ne iskljuceno Clip Number Da Ne
Rec/Play Status Da Ne Notice Message Da Ne
RAW Output Control Status Da Ne Marker Setting Da Ne
Tally Da Ne Color Da Ne
Battery Remain Da Ne Center Marker Da Ne
Focus Mode Da Ne Safety Zone Da Ne
Focus Position Da Ne Safety Area Da Ne
Focus Area Indicator Da Ne Aspect Marker Da Ne
Focus Area Ind.(AF-S) Da Ne Aspect Mask Da Ne
Face/Eye Detection Frame Da Ne Aspect Safety Zone Da Ne
Lens Info Da Ne Aspect Safety Area Da Ne
Imager Scan Mode Da Ne Aspect Select Da Ne
Rec Format Da Ne Custom Aspect Ratio Da Ne
Frame Rate Da Ne Guide Frame Da Ne
Zoom Position Da Ne 100% Marker Da Ne
UWP RF Level Da Ne User Box Da Ne
SteadyShot Da Ne User Box Width Da Ne
Base Look/LUT Da Ne User Box Height Da Ne
SDI/HDMI Rec Control Da Ne User Box H Position Da Ne
Gamma Display Assist Da Ne User Box V Position Da Ne
Proxy Status Da Ne VF Setting svjetlina Da Ne
Base ISO/Sensitivity Da Ne Nacin boje Da Ne
Media Status Da Ne Gamma Display Assist  Setting Da Ne
Video Signal Monitor Da Ne Peaking Setting Da Ne
Clip Name Da Ne Peaking Level Da Ne
White Balance Da Ne Color Da Ne
Scene File Da Ne Zebra Setting Da Ne
Focus Indicator Da Ne Zebral Level Da Ne
Auto Exposure Mode Da Ne Zebral Aperture Level Da Ne
Auto Exposure Level Da Ne Zebra2 Level Da Ne
Timecode Da Ne
ND Filter Da Ne
Blenda Da Ne
ISO/Gain/El Da Ne
Shutter Da Ne
Level Gauge Da Ne
Audio Level Meter Da Ne




120HR| 8. Dodatak: Stavke spremljene u datotekama

RAZINA 1 RAZINA 2 RAZINA 3 All File Scene File RAZINA 1 RAZINA 2 RAZINA 3 All File Scene File

Audio Audio ulaz CH1 Input Select Da Ne Thumbnail Display Clip Properties - -
CH2 Input Select Da Ne (Slicica) Set Clip Flag Add OK - -
CH3 Input Select Da Ne Add NG - -
CH4 Input Select Da Ne Add KEEP - -
INPUT1 MIC Reference Da Ne Delete Clip Flag - -
INPUT2 MIC Reference Da Ne Lock/Unlock Clip Select Clip - -
Line Input Reference Da Ne Lock All Clips - -
Reference Level Da Ne Unlock All Clips - -
CH1 Wind Filter Da Ne Delete Clip Select Clip - -
CH2 Wind Filter Da Ne All Clips - -
CH3 Wind Filter Da Ne Transfer Clip Select Clip - -
CH4 Wind Filter Da Ne All Clips - -
CH3 Level Control Da Ne Transfer Clip (Proxy) Select Clip - -
CH4 Level Control Da Ne All Clips - -
CH3 Input Level Da Ne Filter Clips U redu - -
CH4 Input Level Da Ne NG - -
Audio Input Level Da Ne KEEP - -
Limiter Mode Da Ne None - -
CH1&2 AGC Mode Da Ne All - -
CH3&4 AGC Mode Da Ne Customize View Thumbnail Caption Da -

AGC Spec Da Ne Technical Color Bars Setting Ne Ne

1kHz Tone on Color Bars Da Ne Vrsta Da Ne

CH1 Level Da Ne ND Dial CLEAR with Dial Da Ne

CH2 Level Da Ne Tally Prednja strana Da Ne

CH3 Level Da Ne Straznja strana Da Ne

CH4 Level Da Ne HOLD Switch Setting with Rec Button Da Ne

Audio Output Monitor CH Da Ne with Hand Grip Remote Da Ne

Volume Ne Ne Touch Operation Setting Da Ne

1zlaz za slusalice Da Ne Rec Review Setting Da Ne

Alarm Level Da Ne Zum Vrsta zumiranja Da Ne

HDMI Output CH Da Ne Handle Zoom Setting Da Ne

High (Visok) Da Ne

Low (Nizak) Da Ne

Menu Settings User Menu Only Da Ne

User Menu with Lock Ne Ne

Fan Control Setting Da Ne
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8. Dodatak: Stavke spremljene u datotekama

RAZINA 1 RAZINA 2 RAZINA 3 All File Scene File RAZINA 3 All File Scene File
Technical Objektiv Zoom Ring Direction Da Ne ST Mode Settings Camera Remote Control Da Ne
Shading Compensation Da Ne Connected Network
Chroma Aberration Comp. Da Ne SSID - -
Komp. iskrivijenja Da Ne Sigurnost - -
Distance Display Da Ne Password - -
Zoom Position Display Da Ne DHCP - -
Video Light Set Video Light Set Da Ne IP Address - -
APR APR - - Subnet Mask - -
Camera Battery Alarm Low Battery Da Ne Gateway - -
Battery Empty Da Ne DNS Auto - -
Camera DCIN Alarm DC Low Voltagel Da Ne Primary DNS Server - -
DC Low Voltage2 Da Ne Secondary DNS Server - -
Network Access Authentication  User Name Ne Ne Scan Networks
Password Ne Ne SSID - B
Bezicni LAN Setting Da Ne Sigurnost - -
WPS - - Password Ne Ne
NFC - - DHCP Da Ne
MAC Address - - IP Address Da Ne
AP Mode Settings Kanal Da Ne Subnet Mask Da Ne
Camera SSID & Password - - Gateway Da Ne
Regenerate Password - - DNS Auto Da Ne
IP Address - - Primary DNS Server Da Ne
Subnet Mask - - Secondary DNS Server Da Ne
Manual Register
SSID Da Ne
Sigurnost Da Ne
Password Ne Ne
DHCP Da Ne
IP Address Da Ne
Subnet Mask Da Ne
Gateway Da Ne
DNS Auto Da Ne
Primary DNS Server Da Ne
Secondary DNS Server Da Ne
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RAZINA 1 RAZINA 2 RAZINA 3 All File Scene File RAZINA 1 RAZINA 2 RAZINA 3 All File Scene File
Network Wired LAN Setting Da Ne Odrzavanje Language Odaberite Da Ne
Camera Remote Control Da Ne Clock Set Time Zone Da Ne
Detail Settings Date Mode Da Ne
DHCP Da Ne 12H/24H Da Ne
IP Address Da Ne Date Ne Ne
Subnet Mask Da Ne Time Ne Ne
Gateway Da Ne All Reset Reset - -
DNS Auto Da Ne Reset without Network - -
Primary DNS Server Da Ne Hours Meter Hours (System) - -
Secondary DNS Server Da Ne Hours (Reset) - -
Modem Setting Da Ne Reset - -
Camera Remote Control Da Ne Verzija Version Number - -
Device Name - - Version Up - -
IP Address - B Lens Version Number - B
Subnet Mask - -
File Transfer Auto Upload (Proxy) Da Ne
Default Upload Server Da Ne

Clear Completed Jobs

Clear All Jobs - -
View Job List - -
Server Settings1/Server Settings2/Server Settings3
Display Name Da Ne
Service Da Ne
Host Name Da Ne
Port Da Ne
User Name Ne Ne
Password Ne Ne
Passive Mode Da Ne
Destination Directory Da Ne
Using Secure Protocol Da Ne
Root Certificate - -
Root Certificate Status - -
Reset - -
Network Reset Reset - -
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8. Dodatak: Stavke spremljene u datotekama

Stavke konfigurirane dodjeljivim gumbima

Da: stavka je spremljena.
Ne: stavka nije spremljena.
-: nije spremljeno (priviemena postavka)

Odabir dodjeljivog gumba All File Scene File
ND Filter Position Da Ne

Auto Iris Da Ne

ATW Da Ne

Focus Setting Da Ne
Display Da -

VF Adjust Da -

Stavke konfigurirane dodjeljivim kotaciem

Da: stavka je spremljena.

Ne: stavka nije spremljena.
-: nije spremljeno (priviemena postavka)

Odabir dodjeljivog kotacica All File Scene File
IRIS Da Ne

ND Filter Da Ne

Audio Input Level Da Ne
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8. Dodatak
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Blokovski d

Pregledajte povezane stavke pod “Postavljanje zvuka za snimanje” (stranica 46) i “Izbornik User” (stranica 70).

Ulaz zvuka (CH1i CH2)

Sljedece prikazuje blokovski dijagram s postavljenom ru¢kom.

* Postavite na Manual kada se zvuk uvozi s adaptera XLR.
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Ulaz zvuka (CH3 i CH4)

Sljedece prikazuje blokovski dijagram s postavljenom ruckom.
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* Postavite na Manual kada se zvuk uvozi s adaptera XLR.
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8. Dodatak: Blokovski dijagrami

Audio Output

CH1 > )

CH2 >

SDI OUT

CH3 >
CH4 — - b y
8}('; > )

, HDMI OUT

T : N y,

[HDMI Output CH]
CH1/CH2, CH3/CH4

N e e e e e

/

- ———

CH1, CH2, CH3, CH4,
CH1/CH2, CH3/CH4,
MIX ALL

NSe——

| -

[Headphone Out]
Mono, Stereo

[
I
1
]
I
I
1

_______

[Alarm Level] [VOLUME]
0~7 0~ 50

A4

Internal Speaker

Headphone
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Azuriranje softvera za objektiv E-mount

Softver objektiva E-mount mogucde je azurirati
pomocu videokamere.

Na web-mjestu s objektivima potraZzite
objektive koje je moguce azurirati i
odgovarajuci softver.

Provjera verzije

1 Postavite objektiv E-mount na
videokameru (stranica 22).

2 Odaberite funkciju Version u izborniku
Maintenance cijelog izbornika za prikaz
Lens Version Number (stranica 99).

Broj verzije softvera objektiva E-mount
prikazuje se sa strane.

AZuriranje softvera

Postavite videokameru u nacin za masovnu
pohranu (stranica 108).

AZurirajte softver prateci postupak isporucen
sa softverom objektiva.
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8. Dodatak

Licence

Licenca portfelja patenta MPEG-4
Visual

OVAJ PROIZVOD LICENCIRAN JE U SKLOPU

LICENCE PORTFELJA PATENTA AVC ZA OSOBNU

| NEKOMERCIJALNU POTROSACKU UPOTREBU

U SVRHU

(i) KODIRANJE VIDEOSADRZAJA U SKLADU S
VIZUALNIM STANDARDOM MPEG-4 ("MPEG-
4 VIDEO") I/ILI

(ii) DEKODIRANIE VIDEO SADRZAJA MPEG-4
KOJI JE KODIRAO KORISNIK ZA OSOBNE |
NEKOMERCIJALNE AKTIVNOSTI I/ILI KOJI
JE NABAVIO DOBAVLIAC VIDEOSADRZAJA
KOJEG JE MPEG LA LICENCIRAO ZA
DOBAVLJANJE VIDEOSADRZAJA MPEG-4.

LICENCA SE NE DAJE NITI CE SE
PODRAZUMIJEVATI NI ZA KOJU DRUGU SVRHU.
DODATNE INFORMACIJE, UKLJUCUIUCI ONE O
PROMOTIVNOJ, INTERNOJ | KOMERCIJALNOJ
UPOTREBI TE LICENCIRANJU, ZATRAZITE OD
TVRTKE MPEG LA, LLC. POGLEDAJTE HTTP://
WWW.MPEGLA.COM

Preuzimanje softvera pod
licencom GPL/LGPL

U proizvodu se upotrebljava softver na kojeg
se primjenjuje GPL/ LGPL. Time vam se daje
do znanja da imate pravo na pristup, izmjenu
i redistribuciju izvornog koda ovih softverskih
programa u skladu s uvjetima GPL-a/LGPL-a.
Izvorni kod dostupan je na internetu.
Pristupite sljede¢em URL-u i pratite upute za
preuzimanje.
http://www.sony.net/Products/Linux/
common/search.html

Cijenili bismo kad nam se ne bi obracali s
pitanjima o sadrZaju izvornog koda.

Licence (na engleskom) snimljene su u
unutarnjoj memoriji proizvoda.

Uspostavite vezu masovne pohrane izmedu
proizvoda i racunala da biste procitali licence u
mapi ,LICENSE” - ,PMHOME".

Ako upotrebljavate Mac, mapa ,PMHOME" -
L,LICENSE" mozda nece biti dostupna.

Za pregled datoteka upotrijebite racunalo koje
nije Mac ili posjetite sljedeci URL.
https://o0ss.sony.net/License/ILME-FX6/

UGOVOR ZA KRAJNJEG KORISNIKA
LICENCE

VAZNO:

PRIJE UPOTREBE SOFTVERA S MEMORIJE BEZ
POKRETNIH DIJELOVA U VIDEOKAMERI PAZLJIVO
PROCITAJTE OVAJ LICENCNI UGOVOR ZA KRAINJEG
KORISNIKA (END USER LICENSE AGREEMENT, "EULA").
UPOTREBOM SOFTVERA PRIHVACATE UVJETE OVOG
UGOVORA EULA. AKO NE PRIHVACATE UVJETE OVOG

UGOVORA EULA, NE SMIJETE UPOTREBLJAVATI SOFTVER.

EULA je pravni sporazum izmedu vas i tvrtke Sony
Corporation (,SONY"). Ovaj ugovor EULA regulira vasa
prava i obveze u vezi sa softverom tvrtke SONY i/ili njenih
davatelja licenci trecih strana (ukljucujuci podruznice
tvrtke SONY) i njihovih podruznica (zajedno ,DOBAVLIACI
TRECE STRANE"), uklju¢ujudi bei¢ni adapter i sva
azuriranja/nadogradnje koje osigurava tvrtka SONY, svu
tiskanu, internetsku ili drugu elektronsku dokumentaciju
za takav softver te sve podatkovne datoteke stvorene
radom takvog softvera (zajedno "SOFTVER").

Bez obzira na gore navedeno, svaki softver u okviru
SOFTVERA koji ima zaseban ugovor za krajnjeg korisnika
licence (ukljucujudi, ali ne ogranicavajuci se na GNU-ovu
Opcu javnu licencu i Nizu/Opcu javnu licencu za

knjiZznice) bit ¢e obuhvacden odgovarajucim zasebnim
ugovorom za krajnjeg korisnika licence umjesto
odredbama ovog ugovora EULA do mjere do koje to
zahtijeva zaseban ugovor za krajnjeg korisnika licence
(,JZUZETI SOFTVER").

LICENCA SOFTVERA

SOFTVER se licencira, a ne prodaje. SOFTVER je zaSticen
zakonima o autorskim pravima i drugim medunarodnim
zakonima i ugovorima o intelektualnom vlasnistvu.

AUTORSKO PRAVO

Sva prava i vlasnicka prava na SOFTVER (ukljucujuci, ali ne
ogranicavajui se na bilo koje slike, fotografije, animacije,
video, audio, glazbene i tekstne sadrZaje te ,aplete”
obuhvacene SOFTVEROM) pripadaju tvrtki SONY ili
jednom ili vise njenih DOBAVLJACA TRECIH STRANA.

ODOBRENIJE LICENCE

SONY dodjeljuje ogranicenu licencu za upotrebu
SOFTVERA iskljucivo s bezinim adapterima i samo za
individualnu upotrebu. SONY i DOBAVLJACI TRECIH
STRANA izricito zadrzavaju sva prava, vlasnistvo i
vlasnicki udio (ukljucujudi, ali ne ogranicavajuci se na sva
prava intelektualnog vlasnistva) u SOFTVERU koja ovaj
ugovor EULA ne dodjeljuje posebno vama.

ZAHTIEVI | OGRANICENJA

Ne smijete kopirati, objavljivati, prilagodavati,
redistribuirati, pokusavati rekonstruirati izvorni kod,
mijenjati, vrsiti obrnuti inZenjering, dekompilirati ili
rastavljati nijedan SOFTVER, bilo u cjelini ili u dijelovima,
ili stvarati bilo kakva izvedena djela iz SOFTVERA ili na
njemu samom, izuzev ako su takva izvedena djela
namjerno omogucena SOFTVEROM. Ne smijete mijenjati
ni preinacavati nijednu od funkcija za upravljanje
digitalnim pravima SOFTVERA. Ne smijete zaobilaziti,
mijenjati, dekonstruirati ni opstruirati nijednu funkciju ili
zastitnu znacajku SOFTVERA ili bilo koji mehanizam
operativno povezan sa SOFTVEROM. Ne smijete odvajati
nijednu pojedinacnu komponentu SOFTVERA radi
upotrebe na viSe od jednog beZi¢nog adaptera, osim
ako za to imate izriCito dopustenje tvrtke SONY. Ne
smijete uklanjati, mijenjati, pokrivati ili uniStavati
nikakve zastitne znakove ili obavijesti o SOFTVERU. Ne
smijete dijeliti, distribuirati, iznajmljivati, davati u zakup,
podlicencirati, dodjeljivati, prenositi ili prodavati

SOFTVER. Softver, mrezne usluge i drugi proizvodi koji
nisu SOFTVER, a o kojima ovisi rad SOFTVERA, mogu biti
prekinuti ili obustavljeni prema diskrecijskom pravu
dobavljaca (dobavljaca softvera, dobavljaca usluga ili
tvrtke SONY). SONY i takvi dobavljaci ne jamce da e
SOFTVER, mrezne usluge, sadrZaiji ili drugi proizvodi i
dalje biti dostupni ili da e raditi bez prekida ili izmjena.

1ZUZETI SOFTVER | KOMPONENTE
OTVORENOG KODA

Bez obzira na gore navedeno odobrenje ograni¢ene
licence, prihvacate da SOFTVER moze sadrzavati IZUZETI
SOFTVER. Odredeni IZUZETI SOFTVER moZe biti
obuhvacen licencama za softver otvorenog koda
(,Komponente otvorenog koda"), Sto podrazumijeva sve
softverske licence koje su odobrene kao licence za
otvoreni kdd od strane Inicijative za otvoreni kod ili sve u
znacajnoj mjeri sli¢ne licence, ukljucujudi ali ne
ograniavajuci se na bilo koju licencu koja, kao preduvjet
za distribuciju softvera licenciranog u okviru takve
licence, zahtijeva da distributer ucini softver dostupnim
u formatu izvornog koda. Da biste saznali postoji li
obveza objavljivanja informacija i u kojoj mjeri, posjetite
web-mjesto www.sony.com/linux ili neko drugo
odgovarajuce web-mjesto tvrtke SONY i s vremena na
vrijeme potraZzite popis odgovarajucih KOMPONENTI
OTVORENOG SOFTVERA obuhvacenih SOFTVEROM te
odgovarajuce odredbe i uvjete koji reguliraju njegovu
upotrebu. Odgovarajuda treca strana moze promijeniti
takve odredbe i uvjete bez ikakvih obveza prema vama.
U mijeri u kojoj to zahtijevaju licence koje obuhvacaju
IZUZETI SOFTVER, umjesto odredbi ovog ugovora EULA
primjenjivat ce se odredbe takvih licenci. U mjeri u kojoj
odredbe licenci koje se odnose na IZUZETI SOFTVER
zabranjuju bilo kakva ogranicenja u ovom ugovoru EULA
s obzirom na takav IZUZETI SOFTVER, takva ogranicenja
nece se odnositi na IZUZETI SOFTVER. U mjeri u kojoj
licence primjenjive na Komponente otvorenog koda
zahtijevaju da SONY ponudi pruzanje izvornog koda u
vezi s ovim SOFTVEROM, on se ovdje nudi.

UPOTREBA SOFTVERA S MATERIJALOM
ZASTICENIM AUTORSKIM PRAVIMA

Ovaj SOFTVER moZete upotrebljavati za pregledavanje,
pohranjivanje, obradu i/ili upotrebu sadrzaja koji ste
stvorili vi i/ili trece strane. Takav sadrzaj moze biti
zasticen zakonima o autorskim pravima, drugim


http://www.sony.net/Products/Linux/common/search.html
http://www.sony.net/Products/Linux/common/search.html
http://https://oss.sony.net/License/ILME-FX6/
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zakonima o intelektualnom vlasnistvu i/ili sporazumima.
SlaZete se da Cete se sluziti SOFTVEROM samo u skladu
sa svim takvim zakonima i sporazumima koji se odnose
na spomenuti sadrzaj. Prihvacate i slazete se da SONY
moze poduzeti odgovarajuce mjere radi zastite autorskih
prava nad sadrZajem koji pohranjuje, obraduje ili
upotrebljava SOFTVER. Takve mjere ukljucuju, ali ne
ogranicavaju se na prebrojavanje ucestalosti vasih
postupaka sigurnosnog kopiranja i vracanja podataka
putem odredenih znacajki SOFTVERA, odbijanje
prihvacanja vaseg zahtjeva za omogucivanje vracanja
podataka te ponistenje ovog ugovora EULA u sluaju
vase nelegitimne upotrebe SOFTVERA.

USLUGA SADRZAJA

ISTO TAKO, IMAJTE NA UMU DA SOFTVER MOZE BITI
NAMIJENJEN ZA UPOTREBU SA SADRZAJEM DOSTUPNIM
PUTEM JEDNE ILI VISE USLUGA SADRZAJA (,USLUGA
SADRZAJA"). UPOTREBA USLUGE | TAKVOG SADRZAJA
PODLIJEZE UVJETIMA PRUZANJA USLUGE TAKVE USLUGE
SADRZAJA. AKO ODBIJETE PRIHVATITI TE UVJETE, VASA
UPOTREBA SOFTVERA BIT CE OGRANICENA. Prihvacate

i slaZete se da odredene sadrZaje i usluge koji su
dostupni putem SOFTVERA mogu pruZati trece strane
nad kojima tvrtka SONY nema nadzor. UPOTREBA
USLUGE SADRZAJA ZAHTIJEVA INTERNETSKU VEZU.
USLUGA SADRZAJA MOZE BITI PREKINUTA U BILO KOJEM
TRENUTKU.

MOGUCNOST INTERNETSKE VEZE | USLUGE
TRECE STRANE

Prihvacate i slaZete se da pristup odredenim znacajkama
SOFTVERA moZe zahtijevati internetsku vezu za koju ste
iskljucivo vi odgovorni. Nadalje, vi ste iskljucivo
odgovorni za placanje bilo kakvih naknada koje
zahtijevaju trece strane povezane s vasom internetskom
vezom, ukljuujuci ali ne ogranicavajuci se na naknade
pruzatelja internetskih usluga ili naknade za emitiranje.
Rad SOFTVERA moze biti ogranicen ovisno o
mogucnostima, Sirini pojasa ili tehnickim ogranicenjima
vade internetske veze i usluge. Omogucavanje, kvaliteta i
sigurnost takve internetske veze iskljuciva su
odgovornost trece strane koja pruza takvu uslugu.

1ZVOZNI | DRUGI PROPISI

SlaZete se da Cete se pridrZavati svih vaZecih ogranicenja
i propisa u vezi s izvozom i ponovnim izvozom koja su
na snazi u podrudju ili drZavi u kojoj Zivite te da necete
prenositi ili davati ovlastenje za prijenos SOFTVERA

u drzavu u koju je izvoz zabranjen ili onu koja na drugi
nacin krsi ogranicenja ili propise.

AKTIVNOSTI VISOKOG RIZIKA

SOFTVER nije otporan na pogreske i nije dizajniran,
proizveden ili namijenjen za koristenje ili preprodaju kao
mrezna kontrolna oprema u opasnim okoliSima koji
zahtijevaju izvedbu bez kvarova, primjerice u nuklearnim
postrojenjima, sustavima za upravljanje zrakoplovima ili
komunikacijskim sustavima, sustavima za kontrolu leta,
uredajima za odrzavanje na zivotu ili sustavima oruzja u
kojima bi kvar SOFTVERA mogao dovesti do smrti,
ozljeda ili teskih tjelesnih ostecenja (,AKTIVNOSTI
VISOKOG RIZIKA"). SONY, svi DOBAVLJACI TRECIH
STRANA i sve njihove podruznice posebno se odricu bilo
kakvog izri¢itog ili podrazumijevanog jamstva, obveze ili
uvjeta prikladnosti za AKTIVNOSTI VISOKOG RIZIKA.

1ZUZECE 1Z JAMSTVA ZA SOFTVER
Prihvacate i slazete se da cete SOFTVER upotrebljavati
iskljucivo na vlastiti rizik i da ste vi odgovorni za
upotrebu SOFTVERA. SOFTVER se isporucuje ,KAKAV
JEST", bez jamstva, obveze ili uvjeta bilo koje vrste.

SONY i SVI DOBAVLIACI TRECIH STRANA (za potrebe
ovog odjeljka SONY i svi DOBAVLIACI TRECIH STRANA
zajednicki se nazivaju ,SONY") IZRICITO SE ODRICU SVIH
JAMSTAVA, OBVEZA ILI UVJETA, IZRICITIH ILI
PODRAZUMIJEVANIH, UKLJUCUJUCI ALI NE
OGRANICAVAJUCI SE NA PODRAZUMIJEVANA JAMSTVA
UTRZIVOSTI, NEPOVREDIVOSTI ZAKONA | PRIKLADNOSTI
ZA POSEBNU SVRHU. SONY NE JAMCI | NE TVRDI DA CE
(A) FUNKCIJE SADRZANE U BILO KOJEM SOFTVERU
ZADOVOLJAVATI VASE ZAHTJEVE ILI DA CE BITI
AZURIRANE, (B) DA CE RAD BILO KOJEG SOFTVERA BITI
ISPRAVAN ILI BEZ GRESKE ILI DA CE BILO KOJI
NEDOSTACI BITI ISPRAVLIENI, (C) DA SOFTVER NECE
OSTETITI BILO KOJI DRUGI SOFTVER, HARDVER ILI
PODATKE, (D) DA CE BILO KOJI SOFTVER, MREZNE
USLUGE (UKLJUCUJUCI INTERNET) ILI PROIZVODI (IZUZEV
SOFTVERA) O KOJIMA OVISI RAD SOFTVERA BITI | DALJE
DOSTUPNI, NEPREKINUTI I NEIZMIJENJENI | (E) NE 1ZNOSI

TVRDNJE U VEZI S UPOTREBOM ILI REZULTATIMA
UPOTREBE SOFTVERA U SMISLU NJEGOVE ISPRAVNOST],
TOCNOSTI, POUZDANOSTI ILI DRUGOGA.

NITI JEDNA USMENA ILI PISANA INFORMACIJA ILI SAVIET
DOBIVEN OD TVRTKE SONY ILI OVLASTENOG
PREDSTAVNIKA TVRTKE SONY NECE SLUZITI KAO
JAMSTVO, OBVEZA ILI UVJET NITI CE NA BILO KOJI DRUGI
NACIN POVECATI OPSEG OVOG JAMSTVA. POKAZE LI SE
DA JE SOFTVER MANJKAV, VI PREUZIMATE SVE
TROSKOVE SVIH POTREBNIH SERVISIRANJA, POPRAVAKA
LI ISPRAVLJANJA. NEKE DRZAVE NE DOPUSTAJU
1ZUZECE PODRAZUMIJEVANIH JAMSTAVA PA SE
NAVEDENA 1ZUZECA MOZDA NECE ODNOSITI NA VAS.

OGRANICENJE ODGOVORNOSTI

SONY 1 SVI DOBAVLJACI TRECIH STRANA (za potrebe
ovog odjeljka SONY i svi DOBAVLJACI TRECIH STRANA
zajednicki se nazivaju ,SONY") NECE SNOSITI
ODGOVORNOST ZA SLUCAINU ILI POSLJEDICNU STETU
NASTALU ZBOG KRSENJA UVJETA BILO KOJEG
PODRAZUMIJEVANOG ILI IZRICITOG JAMSTVA, KRSENJA
UGOVORA, NEMARA TE NECE SNOSITI ODGOVORNOST
PREMA PROPISIMA O STROGOJ ODGOVORNOSTI ILI
DRUGIM ZAKONIMA, UKLJUCUJUCI ALI NE
OGRANICAVAJUCI SE NA BILO KAKVU STETU NASTALU
USLIJED GUBITKA PROFITA, GUBITKA PRIHODA, GUBITKA
PODATAKA, GUBITKA MOGUCNOSTI UPOTREBE
SOFTVERA ILI BILO KOJEG POVEZANOG HARDVERA,
PREKIDA U RADU | GUBITKA KORISNIKOVOG VREMENA,
CAK | AKO JE ITKO OD NJIH BIO OBAVIJESTEN O
MOGUCNOSTI NASTANKA TAKVIH STETA. U SVAKOM
SLUCAJU, NJIHOVA UKUPNA ODGOVORNOST PREMA
BILO KOJOJ ODREDBI OVOG UGOVORA EULA BIT CE
OGRANICENA NA IZNOS KOJI JE STVARNO PLACEN ZA
PROIZVOD. NEKE DRZAVE NE DOPUSTAJU IZUZECE ILI
OGRANICENJE SLUCAINIH ILI POSLJEDICNIH STETA PA SE
GORE NAVEDENI IZUZETAK MOZDA NECE ODNOSITI NA
VAS.

PRISTANAK NA UPOTREBU INFORMACIA
KOJE NISU OSOBNI PODACI, PODATAKA O
LOKACHI | SIGURNOST PODATAKA

Prihvacate i slaZete se da tvrtka SONY i njene podruznice,
partneri i agenti mogu Citati, prikupljati, prenositi,
obradivati i pohranjivati odredene informacije prikupljene
putem SOFTVERA, ukljucujuci ali ne ogranicavajuci se na

informacije o (i) SOFTVERU i ii) softverskim aplikacijama,
sadrZajima i perifernim uredajima koji stupaju u interakciju
s vasim bezicnim adapterom i SOFTVEROM ("Informacije").
Informacije obuhvadaju, ali ne ogranicavaju se na sljedece:
(1) jedinstvene identifikatore za beZi¢ni adapter i njegove
komponente; (2) performanse beZi¢nog adaptera,
SOFTVERA i njihovih komponenti; (3) konfiguracije
bezitnog adaptera, SOFTVER i softverske aplikacije,
sadrzaje i periferne uredaje koji stupaju u interakciju s
bezicnim adapterom i SOFTVEROM:; (4) upotrebu i
ucestalost upotrebe funkcija (x) SOFTVERA i (y) softverskih
aplikacija, sadrZaja i perifernih uredaja koji stupaju u
interakciju sa SOFTVEROM:; i (5) podatke o lokaciji, kako je
prikazano u nastavku. Tvrtka SONY i njene podruznice,
partneri i agenti mogu upotrebljavati i otkrivati Informacije,
u skladu s vaze¢im zakonima, kako bi poboljsale svoje
proizvode i usluge ili vama pruzale proizvode i usluge.
Takve upotrebe obuhvacaju, ali ne ogranicavaju se na
sliedece: (a) administriranje funkcionalnosti SOFTVERA; (b)
poboljSavanje, servisiranje, azuriranje ili nadogradnja
SOFTVERA,; (c) poboljsavanje, razvijanje i unaprjedenje
postojecih i buducih proizvoda i usluge tvrtke SONY i
drugih strana; (d) obavjestavanje vas kao korisnika o
proizvodima i uslugama koje nude tvrtka SONY i druge
strane; (e) postivanje vazecih zakona i propisa; i (f) do mjere
u kojoj se to nudi, pruzanje usluga tvrtke SONY i drugih
strana koje se zasnivaju na podacima o lokaciji, kao Sto je
navedeno u nastavku. Osim toga, tvrtka SONY zadrzava
pravo na upotrebu Informacija kako bi zastitila sebe i trece
strane od nezakonitog, kriminalnog i Stetnog postupanja.

Odredene usluge dostupne putem SOFTVERA mogu se
zasnivati na podacima o lokaciji, ukljucujudi ali ne
ogranicavajudi se na zemljopisnu lokaciju beZicnog
adaptera. Prihvacate da u svrhu pruzanja takvih usluga
turtka SONY, DOBAVLIACI TRECIH STRANA ili njihovi
partneri mogu prikupljati, arhivirati, obradivati i
upotrebljavati takve podatke o lokaciji te da su takve usluge
regulirane pravilima o zastiti privatnosti tvrtke SONY ili trece
strane. Pregledom pravila o privatnosti primjenjivim na
takve usluge i pristankom na takve aktivnosti.

Turtka SONY, njene podruznice, partneri i agenti nece
namjerno upotrebljavati informacije kako bi otkrili
identitet vlasnika ili korisnika SOFTVERA bez vaseg
znanja ili pristanka. Svaka upotreba Informacija bit ¢e u
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skladu s pravilima o zastiti privatnosti tvrtke SONY ili
trece strane.

Obratite se na odgovarajucu adresu za kontakt u
pojedinom podrudju ili drzavi kako biste saznali o
trenutnim pravilima za zastitu privatnosti tvrtke SONY.
Obratite se odgovarajucim tre¢im stranama da biste
saznali o pravilima za zastitu privatnosti koja se odnose
na informacije koje otkrivaju identitet i ostale
informacije koje pruzate kada upotrebljavate softver ili
usluge trece strane ili im pristupate.

Informacije mogu biti obradene, pohranjene ili
prenesene tvrtci SONY, njenim podruznicama ili
agentima koji se nalaze u drzavama izvan drzave u kojoj
Zivite. Zakoni o zastiti podataka i privatnosti informacija
u nekim drzavama mozda nece nuditi istu razinu zastite
koja je omogucena u drZavi u kojoj Zivite i vaSa zakonska
prava koja se odnose na obradu i pohranjivanje
Informacija u takvim drzavama, ili prijenos u njih, mogu
biti manja. Tvrtka SONY u razumnoj e se mjeri potruditi
poduzeti odgovarajuce tehnicke i organizacijske korake
radi sprjecavanja neovlastenog pristupa ili otkrivanja
Informacija, ali ne jam¢i da ce ukloniti svaki rizik od
zloupotrebe takvih Informacija.

ZNACAJKA AUTOMATSKOG AZURIRANJA

S vremena na vrijeme, SONY ili DOBAVLJACI TRECE
STRANE mogu automatski azurirati ili na neki drugi nacin
izmijeniti SOFTVER, ukljucujuci ali ne ogranicavajuci se na
svrhe unaprjedenja sigurnosnih funkcija, ispravljanja
pogresaka i poboljSanja funkcija u trenucima dok stupate
u interakciju s posluziteljima tvrtke SONY ili trecih strana,
ili na druge nacine. Takva azuriranja ili izmjene mogu
izbrisati ili promijeniti prirodu znacajki ili druge aspekte
SOFTVERA, ukljucujudi ali ne ogranicavajudi se na funkcije
na koje se mozda oslanjate. Prihvacate i slaZete se da se
takve aktivnosti mogu odvijati prema iskljucivom
diskrecijskom pravu tvrtke SONY i da tvrtka SONY moze
uvjetovati nastavak upotrebe SOFTVERA time da u
potpunosti instalirate ili prihvatite takvo azuriranje ili
izmjene. Za potrebe ovog ugovora EULA sva azuriranja/
izmjene trebaju se smatrati dijelom SOFTVERA i bit e
njegov dio. Prihvacanjem ovog ugovora EULA pristajete
na takvo aZuriranje/izmjenu.

POTPUNI UGOVOR, ODRICANIJE,
SALVATORNA KLAUZULA

Ovaj ugovor EULA i pravila o zastiti privatnosti tvrtke
SONY, oboje u skladu s povremenim dopunama i
izmjenama, zajedno predstavljaju potpuni ugovor
izmedu vas i tvrtke SONY u vezi sa SOFTVEROM. Propust
tvrtke SONY da ostvari ili provede bilo koje pravo ili
odredbu iz ovog ugovora EULA ne predstavlja odricanje
od takvog prava ili odredbe. Ako se utvrdi da je neki dio
ovog ugovora EULA nevaljan, nezakonit ili neprovediv, ta
Ce se odredba provoditi u najvecoj mogucoj mjeri koja
omogucuje zadrzavanje svrhe ovog ugovora EULA, dok
Ce ostali dijelovi ostati potpuno na snazi.

NADLEZNI ZAKON I JURISDIKCIJA

Na ovaj ugovor EULA ne primjenjuje se Konvencija
Ujedinjenih naroda o ugovorima o medunarodnoj
prodaji robe. Ovaj ugovor EULA bit ¢e reguliran u skladu
s japanskim zakonima, bez obzira na moguce sukobe u
zakonskim odredbama. Svi sukobi u vezi ovog ugovora
EULA rjesavaju se iskljucivo u nadleznosti japanskog
Okruznog suda u Tokiju u Japanu, a strane ovime
pristaju na mjesto i nadleznost tih sudova.

PRAVNI LIJEKOVI

Bez obzira na bilo koji dio ovog ugovora EULA koji bi se
mogao protumaciti drugacije, prihvacate i slazete se da
Ce bilo kakvo krsenje ili nepostivanje ovog ugovora EULA
s vase strane prouzrociti nenadoknadivu Stetu tvrtki
SONY za koju ¢e nov¢ana odsteta biti nedovoljna te
pristajete da tvrtka SONY ishodi sudsku kaznuiili
pravicnu naknadu koju tvrtka SONY smatra
odgovarajucom u takvim slucajevima. Osim toga, SONY
moZze poduzeti sve zakonske ili tehnicke mjere kako bi
sprijecio krSenje ovog ugovora EULA i/ili nametnuo
njegovu provedbu, ukljuCujudi ali ne ograniavajuci se
na trenutacnu obustavu upotrebe SOFTVERA ako tvrtka
SONY odludi, po vlastitom diskrecijskom pravu, da krsite
ili imate namjeru prekrsiti ovaj ugovor EULA. Ti pravni
lijekovi dodatak su svim drugim pravnim lijekovima na
koje SONY moze imati pravo po zakonu, obicajnom
pravu ili prema ugovoru.

PONISTAVANJE

Ne dovodedi u pitanje bilo koje svoje drugo pravo, tvrtka
SONY moze ponistiti ovaj ugovor EULA u slucaju da se
ne pridrZavate bilo koje njegove odredbe. U slucaju

takvog ponistavanja morate: (i) u potpunosti prestati
upotrebljavati SOFTVER i unistiti sve njegove primjerke;
(ii) pridrZavati se zahtjeva navedenih u odjeljku ,Obveze
u vezi s vasim ra¢unom” u nastavku teksta.

IZMJENE | DOPUNE

TVRTKA SONY ZADRZAVA PRAVO DA PO VLASTITO)
DISKRECIJSKOJ ODLUCI IZMIJENI | DOPUNI BILO KOJU
ODREDBU OVOG UGOVORA EULA POSTAVLJANJEM
OBAVIJESTI NA ODGOVARAJUCE WEB-MJESTO TVRTKE
SONY, SLANJEM OBAVIJESTI U PORUCI E-POSTE NA
ADRESU KOJU STE SAMI DALI, OBAVJESTAVANJEM U
OKVIRU POSTUPKA U KOJEMU VAM SE ISPORUCUJU
NADOGRADNJE/AZURIRANJA ILI BILO KOJIM DRUGIM
ZAKONSKI PRIZNATIM NACINOM OBAVJESTAVANJA. Ako
ne pristajete na izmjene i dopune, trebate se odmah
obratiti tvrtki SONY radi dobivanja uputa. Nastavak
upotrebe SOFTVERA nakon datuma stupanja na snagu
takve obavijesti smatrat ce se vasim pristankom da
budete obvezani navedenim dopunama i izmjenama.

KORISNICI TRECE STRANE

Svaki DOBAVLIAC TRECE STRANE izriciti je korisnik trece
strane i imat Ce sva prava na provedbu svake odredbe
ovog ugovora EULA u vezi sa SOFTVEROM takve strane.

U slucaju da imate bilo kakva pitanja u vezi s ovim
ugovorom EULA, mozZete se obratiti tvrtki SONY pisuci
tvrtki SONY na odgovarajucu adresu za kontakt u
pojedinom podrudju ili drzavi.

Copyright © 2012 Sony Corporation.

Licence za softver otvorenog koda

Temeljem licencnih ugovora izmedu tvrtke
Sony i nositelja autorskih prava na softver, ovaj
proizvod upotrebljava softver otvorenog koda.
Kako bi ispunila zahtjeve nositelja autorskih
prava na softver, tvrtka Sony obvezna je
informirati vas o sadrZaju tih licenci.

Licence (na engleskom) snimljene su u
unutarnjoj memoriji proizvoda.

Uspostavite vezu masovne pohrane izmedu
proizvoda i racunala da biste procitali licence u
mapi ,LICENSE” - ,PMHOME".

Ako upotrebljavate Mac, mapa ,PMHOME" -
,LICENSE" mozda nece biti dostupna.

Za pregled datoteka upotrijebite racunalo koje
nije Mac ili posjetite sljedeci URL.
https://0ss.sony.net/License/ILME-FX6/


https://oss.sony.net/License/ILME-FX6/
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8. Dodatak

Specifikacije

Opcenito

TeZina

Priblizno 890 g (11b 15 0z) (samo kuciste)

Priblizno 2,59 kg (5 Ib 11 0z) (ukljucujuci
objektiv SEL24105G, poklopac
objektiva, bateriju (BP-U35),
traZilo, rucku, drsku)

Dimenzije

pogledajte odjeljak stranica 133.
Zahtjevi za napajanje

19,5V DC (18,0 V do 20,5 V)
Potrosnja energije

Pribl. 18,0 W (kuciste, objektiv, XAVC-I QFHD
59.94P snimanje, ukljuceno
trazilo, bez povezanog vanjskog
uredaja)

Pribl. 36,0 W (kuciste, objektiv, XAVC-1 QFHD
59.94P snimanje (S&Q 120 fps),
ukljuceno trazilo, HDMI, SDI,
povezani vanjski uredaj)

Radna temperatura

od 0 °C do 40 °C (od 32 °F do 104 °F)
Temperatura pohrane

-20 °C do +60 °C (-4 °F do +140 °F)
Neprekidno vrijeme rada

Pribl. 105 minute (s BP-U35)

(kuciste, objektiv, snimanje XAVC-I
QFHD s 59,94P, ukljuceno trazilo,
bez priklju¢enih vanjskih uredaja)
Format za snimanje (videozapis)
XAVC Intra

Nacin XAVC-1 4K/QFHD:
CBG, brzina prijenosa u bitovima
600 Mbps (maks.), MPEG-4
AVC/H.264

Nacin XAVC-I HD:
CBG, brzina prijenosa u bitovima
223 Mbps (maks.), MPEG-4
AVC/H.264

XAVC Long
Nacin XAVC-L QFHD:
VBR, brzina prijenosa u bitovima
150 Mbps (maks.), MPEG-4 H.264/AVC
Nacin XAVC-L HD 50:
VBR, brzina prijenosa u bitovima
50 Mbps (maks.), MPEG-4 H.264/
AVC
Nacin XAVC-L HD 35:
VBR, brzina prijenosa u bitovima
35 Mbps (maks.), MPEG-4 H.264/
AVC
Format za snimanje (zvuk)
LPCM 24-bit, 48 kHz, 4-kanalni
Brzina slicica za snimanje
XAVC Intra
Nacin XAVC-1 4K:
4096x2160/59.94P, 50P, 29.97P,
25P, 24P, 23.98P
Nacin XAVC-l QFHD:
3840x2160/59.94P, 50P, 29.97P,
25P, 23.98P
Nacin XAVC-1 HD:
1920x1080/59.94P, 50P, 29.97P,
25P, 23.98P
XAVC Long
Nacin XAVC-L QFHD:
3840x2160/59.94P, 50P, 29.97P,
25P, 23.98P
Nacin XAVC-L HD 50:
1920x1080/59.94P, 50P, 29.97P,
25P, 23.98P
Nacin XAVC-L HD 35:
1920x1080/59.94P, 50P, 29.97P,
25P, 23.98P
Vrijeme snimanja/reprodukcije
XAVC Intra
Nacin XAVC-l QFHD:
59.94P
Pribl. 30 minuta
(koristec¢i CEA-G160T)

Nacin XAVC-I HD:
59.94p
Pribl. 78 minuta
(koristec¢i CEA-G160T)
XAVC Long
Nacin XAVC-L QFHD:
59.94p
Pribl. 115 minuta
(koristec¢i CEA-G160T)
Nacin XAVC-L HD 50:
59.94p
Pribl. 155 minuta
(koristec¢i CEA-G8O0T)
Nacin XAVC-L HD 35:
59.94p
Pribl. 210 minuta
(koristec¢i CEA-G8O0T)
[Napomenal]
Vrijeme snimanja/reprodukcije moZe se razlikovati
ovisno o uvjetima upotrebe i znacajkama memorije.

Vremena snimanja i reprodukcije odnose se na
neprekidno snimanje jednog isjecka. Stvarna vremena

mogu se razlikovati ovisno o broju snimljenih isjecaka.

Odjeljak fotoaparata

Uredaj za fotografiranje (vrsta)
Istovrijedno cijelom kadru s 35 mm, CMOS
slikovni senzor s jednim ¢ipom
Broj piksela
12,9 M (ukupno)
10,2 M (efektivno)
Automatsko izoStravanje
Nacin otkrivanja: Otkrivanje faze/otkrivanje
kontrasta

Interni ND filtri
CLEAR: OFF
1: 1/4ND
2:1/16ND
3:1/64ND
Linearly variable ND: 1/4ND to 1/128ND
ISO osjetljivost
ISO 800712800 (nacin rada Cine EI mode,
izvor svjetlosti D55)
Element za montazu objektiva
E-mount nosac
Zemljopisna Sirina
15+ stanica
Shutter speed (Brzina okidanja)
od 64 F do 1/8000 s. (23,98P)
Kut okidaca
od 5,6° do 360°, od 2 do 64 slicice
Usporene i ubrzane snimke
XAVC QFHD: Od 1 fps do 120 fps
XAVC HD: od 1 fps do 240 fps
XAVC 4K: od 1 fps do 60 fps
XAVC HD (S35): od 1 fps do 120 fps
White balance (Podesavanje bijele boje)
od 2000 K do 15.000 K
Razina signala
od -3 dB do +30 dB (u koracima od 1 dB)
Osnovni izgled
S-Cinetone, Standard, Still, ITU709, s709,
709(800%), S-Log3, HLG Live,
HLG Natural



132HR

8. Dodatak: Specifikacije

Odjeljak za zvuk

Frekvencija uzorkovanja
48 kHz
Kvantizacija
24-bitni
Frekvencijski odziv
XLR ulaz, nac¢in MIC: od 20 Hz do 20 kHz
(3 dB ili manje)
XLR ulaz, nacin LINE: od 20 Hz do 20 kHz
(3 dB ili manje)
Dinamicki raspon
XLR ulaz, nacin MIC: 80 dB (Typical)
XLR ulaz, nacin LINE: 90 dB (Typical)
Izoblicenje
XLR ulaz, nacin MIC: 0,08 % ili manje (ulazna
razina -40 dBu)
XLR ulaz, nacin LINE: 0,08 % ili nize (ulazna
razina +14 dBu)
Ugradeni zvucnik
mono
Unutarnji mikrofon
mono
Rucka unutarnjeg mikrofona
Electret kondenzatorski stereo mikrofon
[Napomenal]

Samo rucka unutarnjeg mikrofona postaje aktivna kada
je postavljena rucka.

Odjeljak za ulaz/izlaz

Ulazi

INPUT 1/2:
vrste XLR, 3-pinski, Zenski
LINE / MIC / MIC+48V, moZze se prebacivati
MIC: Reference od -30 dBu do -80 dBu

TCIN:
vrste BNC

zlazi
SDI OUT:
BNC vrsta, 12G-SDI, 6G-SDI, 3G-SDI (razina
A/B), HD-SDI
Slusalice (stereo mini utikac):
-16 dBu (izlaz referentne razine, maksimalna
glasnoca nadzora, opterecenje od
16 Q)
HDMI:
vrste A (19-pinski)
TC OUT:
vrste BNC

Ostalo
DCIN:

kompatibilno s EIAJ, od 18 V do 20,5V DC
PodnozZje za viSe sucelja:

namjensko (21-pinsko)
Daljinski upravljac:

vrste 3-polni sub-mini od 2,5 mm
Priklju¢nica za daljinski upravljac s drSkom:

3,5 mm 4-polni stereo mini utikac (ukljuceni

priklju¢ak za daljinski upravljac s

drskom)
USB-C:
USB 3.2 Gen1
USB/muilti:

Kompatibilno sa standardom USB 2.0, vrste
micro B za masovnu pohranu (1)
VF:
namjensko (40-pinsko)

Odjeljak za zaslon

Punjac baterija (BC-CU1)

Trazilo (LCD)
Velicina zaslona
dijagonala od 8,8 cm (3,5")
Omjer Sirine i visine
16:9
Broj piksela
1280 (H) x 720 (V)

Odjeljak za medijske utore

Utor za CFexpress Type A karticu / SD karticu (2)

Bezicni LAN

PodrZani standardi

IEEE 802.11 a/b/g/n/ac (ILME-FX6V/VK)

IEEE 802.11 b/g/n (ILME-FX6T/TK)
Frekvencijski pojas

2,4 GHz

5 GHz (samo ILME-FX6V/VK)
Podrzani sigurnosni protokoli

WEP/WPA-PSK/WPA2-PSK
Nacin povezivanja

Wi-Fi Protected Setup™ (WPS)/ru¢no
Nacin pristupa

infrastrukturni nacin

TeZina
Priblizno 60 g (2,1 0z)
Dimenzije
Pribl. 57 x 26 x 101 mm
(2/4x1"16x 4 in)
(Sirina/visina/dubina)
Ulaz
19.5V DC, 26 W
Izlaz
16,4VDC14A
Radna temperatura
od 0 °C do 40 °C(od 32 °F do 104 °F)
Temperatura pohrane
-20 °C do +60 °C (-4 °F do +140 °F)

PriloZzena dodatna oprema

Adapter za izmjeni¢nu struju (1)

Strujni kabel (1)

Punja¢ za baterije (1)

Komplet baterija (1)

Drzac (1)

LCD monitor (1)

USB-C kabel (1)

Daljinski upravljac s drza¢em (1)

Poklopac za LCD (1)

Komplet prikljuc¢aka bez elektri¢ne veze (1)
(Prikljucak bez elektri¢ne veze (1), opruga nosaca
(1), vijci (4))

Poklopac za montazu objektiva (1)

Zastitni poklopac za priklju¢ak na drzacu (1)
Prije upotrebe ovog uredaja (1)

KnjiZica s jamstvom (1)

Dizajn i specifikacije podloZni su izmjenama
bez prethodne najave.
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8. Dodatak: Specifikacije

Napomene

e Uvijek snimite testnu snimku i provjerite
je li pravilno snimljena. SONY NE SNOSI
ODGOVORNOST NI ZA KAKVE STETE
, UKLJUCUIUCI, BEZ OGRANICENJA,
KOMPENZACIU ILI POVRAT NOVCA USLIJED
KVARA OVOG UREDAJA ILI NJEGOVIH
MEDIJA ZA SNIMANIJE ILI BILO KAKVIH
MEDIJA ILI SUSTAVA ZA POHRANU RADI
SNIMANJA SADRZAJA BILO KOJE VRSTE.

® Prije upotrebe obavezno provjerite

funkcionira li jedinica pravilno. SONY

NE ODGOVARA NI ZA KAKVE STETE,

UKUUCUJUCI, BEZ OGRANICENJA,

KOMPENZACIU ILI POVRAT NOVCA

USLIJED GUBITKA SADASNIEG ILI

MOGUCEG PRIHODA NASTALOG

ZBOG KVARA OVE JEDINICE TIJEKOM

JAMSTVENOG RAZDOBLIJA ILI NAKON

NJEGOVA ISTEKA KAO NI ZBOG BILO KOJEG

DRUGOG RAZLOGA.

SONY NE ODGOVARA NI ZA KAKVE 1ZJAVE

KORISNIKA OVE JEDINICE NI TRECIH

STRANA.

SONY NE ODGOVARA NI ZA KAKAV

GUBITAK, POPRAVAK ILI REPRODUKCIJU

BILO KAKVIH PODATAKA SNIMLIENIH NA

INTERNI SUSTAV ZA POHRANU, MEDIJE

ZA SNIMANIJE NI BILO KAKVE MEDIJE ILI

SUSTAVE ZA POHRANU.

SONY NE ODGOVARA ZA OBUSTAVLJANJE

NI UKIDANJE BILO KOJE USLUGE POVEZANE

S OVOM JEDNICOM NASTALO USLIJED BILO

KAKVIH OKOLNOSTI.

Vanjske dimenzije

143 (5%/,)

UNC '/,-20

2-UNCY/,-20

60

25 (1)
258(107/,)

O @O

HI2B |0

9l
e
8 ' _ o

UNC'/,-20 MNC /.16

e
28(1/,)

Navedene dimenzije su priblizne vrijednosti.

Jedinica: mm (inci)

8-UNC'/,-20

(23/,)| 4 (47,)

2-UNC'/,-20 UNC'/,-20

CD
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8. Dodatak: Specifikacije

Zastitni znaci

e (X je zasdtitni znak tvrtke Sony Corporation.

e XAVCi registrirani su zastitni znaci
tvrtke Sony Corporation.

® |zrazi HDMI i HDMI High-Definition Multimedia
Interface te logotip HDMI zastitni su znakovi
ili registrirani zastitni znakovi tvrtke HDMI
Licensing Administrator, Inc u Sjedinjenim
Americkim Drzavama i drugim drZzavama.

e Microsoft i Windows registrirani su zastitni
znakovi ili reqgistrirani zastitni znakovi
tvrtke Microsoft Corporation u Sjedinjenim
Ameri¢kim Drzavama i/ili drugim zemljama.

e Mac i Mac OS registrirani su zastitni znakovi
tvrtke Apple Inc. u SAD-u i drugim drZzavama.

e | ogotipi ,Catalyst Browse,” ,Content
Browser Mobile,” i ,Content Browser Mobile
zastitni su znakovi ili registrirani zastitni
znakovi tvrtke Sony Corporation.

e jOS je registrirani zastitni znak ili zastitni

znak tvrtke Cisco Systems, Inc. i/ili njenih

podruznica u Sjedinjenim DrZzavama i

odredenim drugim drzavama.

Android i Google Play zastitni su znakovi

tvrtke Google Inc.

e Wi-Fi, logotip Wi-Fi i Wi-Fi PROTECTED
SETUP zastitni su znakovi ili registrirani
zastitni znakovi tvrtke Wi-Fi Alliance.

e Oznaka N zastitni je znak ili registrirani
zastitni znak tvrtke NFC Forum, Inc. u
Sjedinjenim Americ¢kim Drzavama i drugim
drzavama.

"

Logotipi CFexpress i CFexpress Type A zastitni
su znakovi tvrtke CompactFlash Association.

Svi drugi nazivi tvrtki i nazivi proizvoda
registrirani su zastitni znakovi ili zastitni
znakovi u vlasnistvu svojih vlasnika. U ovom
dokumentu stavke s zastitnim znakovima nisu
oznacene sa simbolom ™ ilj ©.

Logotip SDXC zastitni je znak tvrtke SD-3C, LLC.

Exmoar ld

CMOS Sensor

HuoITil

S Vo
X 11

Xpress

N\
&
7 A
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1. Pregled

Konfiguracija sistema

==n ’

UWP-D21 SMAD-P5 URX-PO3D SMAD-P3D
. . Adapter

UWP-D22 Adapter za Sprejemnik 73 vedvmesniiki
UWP-D26 vecdvmesniski brezZi¢nega nastavek
Paket nastavek mikrofona
brezzi¢nega
mikrofona |

Pomnilniske kartice

XLR-K2M SDXC
ﬁtﬁgﬁe'\t" HVL-LBPC i
Video luc
adapterja XLR 1aeofuc D D et
| | Pomnilniéke Bralnik kartic CFexpress tipa A/
kartice CFexpress bralnik kartic SD

MCX-500
Multi Camera Live
Producer

LA-EA3

LA-EA4

Adapter za
objektive serije A

o

©

Objektiv serije E

tipa A

BP-U35, BP-U60,

am
—
am

ECM-VG1
ECM-MS2
Mikrofon

RM-30BP
Daljinski upravljalnik

BC-CUT
BP-U6OT, BP-U70, Polnilnik bateri ini i
BP-U90, BP-U100 J (Pri'ijg';e'ﬁ)bate”l

Paket baterij

ILME-FX6V/ILME-FX6VK
ILME-FX6T/ILME-FX6TK

Omrezni napajalnik
(prilozen)

Drzalo z daljinskim
upravljalnikom (priloZzeno)



1. Pregled

Lokacije in funkcije delov

Leva stran in sprednja stran

O O~NOUID W IN —

1. Kavelj za merilni trak

Kavelj za merilni trak se nahaja v enaki

ravnini kot slikovni senzor. Kavelj uporabite
kot referen¢no tocko za natan¢no merjenje
razdalje med videokamero in subjektom. Na
kavelj lahko zataknete konec merilnega traku,
da izmerite razdaljo do subjekta.

2. Priklju¢ek za iskalo (stran 19)

3. Prezralevalna reza

[Opombal]
Ne pokrivajte prezracevalne reze.

4. Izbirno stikalo TC IN/OUT (stran 34,
107)

5. Prikljucek drzala z daljinskim
upravljalnikom (stran 20)

S GNEA
o/

13

&
15

j 16

BT 12
)
G
Q

6. N (oznaka N) (stran 56)

e S pametnim telefonom, opremljenim
s funkcijo NFC, se dotaknite enote, da
vzpostavite brezzi¢no povezavo.
Nekateri pametni telefoni, ki podpirajo
brezzi¢ne sisteme placevanja, morda
ne podpirajo NFC. Za podrobnosti glejte

navodila za uporabo pametnega telefona.

e NFC (Near Field Communication) je
mednarodni komunikacijski protokol za
brezzi¢no komunikacijo med bliznjimi
napravami.

7. Prikljucitev drzala z daljinskim

upravljalnikom (stran 20)

8. Gumb za sprostitev drzala z daljinskim
upravljalnikom (stran 20)

9. Antena Wi-Fi

10. Indikator snemanja (spredaj) (stran 34)
Utripa, ko je preostala kapaciteta
pomnilniSkega medija ali baterije nizka.

11. Stikalo FOCUS (stran 37)
12. Slikovni senzor
13. Gumb PUSH AUTO FOCUS (stran 40)

14. Kontakti za signal objektiva

[Opombal]
Izogibajte se neposrednemu stiku z rokami.

15. Gumb WB SET (nastavitev beline)
(stran 45)

16. Gumb za sprostitev objektiva (stran 22)
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Desna stran (spredaj/zgoraj/spodaj)

1415117 |19
16 18

1. Gumb Clip Flag (stran 50, 65)
2. Stikalo HOLD (stran 93)

3. Gumb za snemanje START/STOP

(stran 34)
Za zacetek snemanja pritisnite gumb za
snemanje START/STOP. Med snemanjem sveti
rdec indikator LED.

Desna stran (zadaj)
(stran 6)

. Kolesce ND VARIABLE (stran 43)
5. Stikalo ND PRESET/VARIABLE (stran 43)
. Smerna gumba ND FILTER POSITION

(stran 43)
Indikator ND CLEAR (stran 43)

8. Gumb ND VARIABLE AUTO (stran 43)
Pritisnite gumb ND VARIABLE AUTO za zacetek
samodejne nastavitve gostote filtra ND. Ob
vklopu sveti zelen indikator LED.

9. Vedfunkcijsko kolesce (stran 48)
Pritisnite, ko gledate skozi iskalo, Ce Zelite
odpreti in uporabljati neposredni meni.

Ko je v iskalu prikazan meni, zavrtite kolesce,
da premaknete kazalec gor/dol za izbiro
elementov menija ali nastavitev. Pritisnite za
potrditev izbranega elementa.

Ko meni ni prikazan, lahko kolesce sluzi tudi
kot dodeljivo kolesce.

10. Funkcijski gumb IRIS (stran 42)
11. Gumb CANCEL/BACK (stran 64)
12. Gumb THUMBNAIL (stran 63)

13. Gumb MENU (13, 68)

Pritisnite gumb MENU, da se prikaze zaslon
stanja. Pritisnite gumb MENU in ga pridrzite,
da se prikaZe zaslon glavnega menija.
Pritisnite gumb med prikazom zaslona stanja
ali zaslona glavnega menija, Ce se Zelite vrniti
v prikaz prejSnjega zaslona.

14. Funkcijski gumb ISO/GAIN (stran 42)

15. Stikalo ISO/GAIN (izbira ojacitve)
(stran 42)

16. Funkcijski gumb WHT BAL (belina)
(stran 45)

17. Stikalo WHT BAL (izbira pomnilnika
beline) (stran 45)

18. Funkcijski gumb SHUTTER (stran 43)
19. Prikljucek za slu3alke (stran 34)
20.Stikalo POWER (stran 34)
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Desna zadnja stran in reza za kartice
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Antena Wi-Fi
Kolesce AUDIO LEVEL (CH1) (stran 46)
Stikalo CH1 (AUTO/MAN) (stran 46)

Gumbi ASSIGN (dodeljivi) od 1 do 3
(stran 48)

Awon o

5. Notranji mikrofon (stran 46)
Vokalni mikrofon za snemanje ambientalnega
zvoka.

[Nasvet]
Mikrofon je onemogocen, ko je pritrieno drzalo, in
aktivira se notranji mikrofon v drzalu (stran 7).

6. Gumb DISPLAY (stran 11)

7. Vagrajeni zvo¢nik (stran 34)

10.
1.
12.
13.

14.

15.

Indikator POWER (stran 34)

Gumb SLOT SELECT (izbira reze za
pomnilnisko kartico (A)/(B)) (stran 34)

Stikalo CH2 (AUTO/MAN) (stran 46)
Kolesce AUDIO LEVEL (CH2) (stran 46)
Indikator dostopa A (stran 26)

ReZa za kartico A/SD tipa CFexpress (A)
(stran 26)

ReZa za kartico A/SD tipa CFexpress (B)
(stran 26)

Indikator dostopa B (stran 26)



75t

1. Pregled: Lokacije in funkcije delov

Drzalo, hrbtna stran in prikljucni blok

r—h)

0000

Lt -wra
@ 26

1. Stikalo HOLD na drzalu
Uporablja se za izklop drugih stikal na rocaju.

2. Gumb za snemanje START/STOP na drzalu

3. Notranji mikrofon v drzalu

4. Vedvmesniski nastavek

® Multi
7 interface Shoe

Za podrobnosti o dodatni opremi, ki jo podpira
vecdvmesniski nastavek, se obrnite na svojega
prodajnega predstavnika.

5. Dodeljiv gumb v drzalu (stran 48)

6. Rocica za zoom na drZalu (stran 93)

7. Gumbi ASSIGN (dodeljivi) od 7 do 8
(stran 48)

8. Vedéfunkcijski gumb (8-smerna D-plos¢ica
in gumbi za potrditev)

9. Nastavek za dodatno opremo
(stran 7)

10. Odprtine za vijake za pritrditev dodatne
opreme (1/4 palca)

Zdruzljive z vijaki 1/4-20 UNC (dolZine 6 mm

ali manj).

[Opombal]

Ce uporabite vijake, daljse od 6 mm, lahko po$kodujete

zunanjo povrsino.

11. Indikator snemanja (zadaj) (stran 34)

12. Gumb BATT RELEASE (stran 17)

13. Vhodna odprtina za zrak

[Opombal]
Ne pokrivajte vhodne odprtine za zrak.

14. Pritrdisce za paket baterij (stran 17)
15. Priklju¢ek USB-C (stran 60)

16. Priklju¢ek INPUT2 (avdio vhod 2)
(stran 46)

17. Priklju¢ek INPUT1 (avdio vhod 1)
(stran 46)

18. Stikalo INPUT2 (LINE/MIC/MIC+48V)
(stran 46)

19. stikalo INPUT1 (LINE/MIC/MIC+48V)
(stran 46)

20.0dprtine za vijake za zunanje naprave
ZdruZzljive z vijaki M3 (dolZine 4 mm ali krajsi).

[Opombal]
Ce uporabite vijake, daljse od 4 mm, lahko poskodujete
zunanjo povrsino.

21. Priklju¢ek HDMI OUT (stran 106)
22.Priklju¢ek SDI OUT (stran 106)

23. Priklju¢ek TC IN/TC OUT (vhod/izhod
casovne kode) (stran 107)

24 Priklju¢ek REMOTE
Priklopite sploSen pripomocek s priklju¢kom
LANC.

25. Priklju¢ek USB/multi (stran 108)
26.Priklju¢ek DC-IN (standardni vti¢ DC)
(stran 18)

Namestitev nastavka za dodatno
opremo

1 Dvignite sprednji rob vzmeti nastavka in
povlecite vzmet v nasprotno smer puscice,
vgravirane na vzmeti.

Vzmet nastavka
§
‘/é
\ b
\ ‘9
1
Nastavek za dodatno opremo

2 Nastavek za dodatno opremo poloZite na
pritrdiS¢e nastavka za dodatno opremo,
poravnajte izbokline nastavka z ustreznimi
tockami na pritrdiScu in privijte Stiri vijake.
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3 Vstavite vzmet nastavka v smeri puscice,
tako da del v obliki ¢rke U nalega na rob
nastavka za dodatno opremo.

Nastavek za dodatno opremo

B

(|

E N 3@@
Q Vzmet
nastavka

Odstranjevanje nastavka za dodatno
opremo

Odstranite vzmet nastavka, kot je opisano
v 1. koraku razdelka »Namestitev dodatka
za dodatno opremo«. Odvijte Stiri vijake in
odstranite nastavek za dodatno opremo.

Namestitev drzala

Drzalo namestite tako, da bo prikljucek drzala
poravnan z odprtinama za vijaka, potisnite in
obrnite vijaka za pritrditev drZala v desno, da
pritrdite drzalo na enoto.

Vijaka za pritrditev drzala lahko privijete v
desno tudi z imbus klju¢em (4 mm).

7

S

=)

[Opombal]

Pred uporabo drZala preverite, da sta vijaka za pritrditev
drzala dobro privita. Ce vijaka nista dobro privita, se
lahko drZalo sname z videokamere.

Odstranitev drzala

Odstranite ga po istem postopku v obratnem
vrstnem redu.

Namestitev zascitnega pokrovcka
prikljucka drzala (prilozeno)
Ko uporabljate videokamero z odstranjenim

drzalom, zascitite prikljucek s prilozenim
zascitnim pokrovckom.

[Nasvet]
Ko namestite drZalo, pospravite priloZen zascitni
pokrovcek na dno drzala.

Zas(ita terminalov prikljuckov

Namestite pokrov na neuporabljene prikljucke,

da zas(itite terminale prikljuckov.

Zgornja stran

1. Prikljucek drzala

2. Odprtine za vijake za pritrditev dodatne
opreme (1/4 palca)

ZdruZljive z vijaki 1/4-20 UNC (dolzine 6 mm

ali manj).

[Opombal]

Ce uporabite vijake, daljse od 6 mm, lahko poskodujete

dele zunanjega ohisja.
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Spodnja stran Iskalo Drzalo z daljinskim upravljalnikom
Za podrobnosti o namesc¢anju iskala Za podrobnosti o namestitvi drzala z
3 (prilozeno) glejte stran 19. daljinskim upravljalnikom (priloZzeno) glejte
stran 20.
o= =) (@)
- 1—3
(]
@o® 2—8
a&‘) 0 ﬁ ) 3—9
(]II]:['TEI]:ID
5 I;Ej I
4 5
1 2 1. Gumb PEAKING
1. Vija¢ne odprtine za stojalo (1/4 palca, 2. Gumb ZEBRA
3/8 palca) .
Zdruzljive z vijaki 1/4-20 UNC in vijaki 3/8-16 3. Gumb ASSIGN 9 (dodeljiv gumb)
UNC. Pritrdite na trinoZno stojalo (moZnost, (stran 48)
vijaki dolzine 5,5 mm ali krajsi). 4. Plo%éa na dotik
2. Odprtina za izhod zraka Upravljanje na dotik lahko izklopite z
dodeljivim gumbom ali prek menija
[Opombal]

Ne pokrivajte odprtine za izhod zraka. (Stran 10)'

5. Stikalo MIRROR

1. Rodica za zoom

2. Gumb ASSIGN 4 (dodeljiv gumb)
(stran 48)

3. Dodeljiv gumb na drzalu (stran 48)

4. Gumb ASSIGN 6 (dodeljiv gumb)
(stran 48)

5. Rocica za vrtenje drZala (stran 21)

6. Gumb za snemanje START/STOP
Vecfunkcijski gumb (8-smerna D-ploscica
in gumbi za potrditev)

8. Gumb ASSIGN 5 (dodeljiv gumb)
(stran 48)
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Uporaba plosce na dotik

Previdnostni ukrepi glede uporabe Gibi na plosdi na dotik Konfiguracija plosce na dotik
plosce na dotik
Dotaknite se Upravljanje zaslona na dotik lahko vklopite/
Iskalo enote ie plota na dotik ki io S prstom se rahlo dotaknite elementa, kot sta izklopite s funkc?J:o Touch.Operation
1€ b K1 na primer ikona ali moznost v meniju, nato pa (stran 93) v meniju Technical.

uporabljate neposredno z dotikom s prstom.
e Plosca na dotik je zasnovana tako, da se
odziva na rahle dotike s prstom. Plos¢e ne

pritiskajte mocno oziroma se je ne dotikajte Povleu’_[e ) ) 5 )
z ostrimi ali koni¢astimi predmeti (nohtom Dotaknite se zaslona in prst povlecite na zeleni
kemiénim svinénikom, iglo ipd.). poloZaj na zaslonu, nato pa odmaknite prst.

prst takoj odmaknite.

¢ V naslednjih okolis¢inah se plosca na dotik
morda ne bo odzvala na dotik. Te okoliscine
lahko povzrocijo tudi okvaro:
e (e uporabite konice nohtov;
e (e jo upravljate, ko se povrSine dotikajo
drugi predmeti;
e (e je na njej zascitna folija ali nalepka;
e (e so na zaslonu vodne kapljice ali
kondenz.
e (e jo upravljate z mokrimi ali potnimi
prsti. Frcnite/podrsajte
Dotaknite se zaslona in s prstom hitro frcnite/
podrsajte navzgor, navzdol, v levo ali v desno.

[Nasvet]

Ce se vsebina zaslona nadaljuje prek robov zaslona,
lahko s prstom podrsate ali frcnite in zaslon se bo
premaknil ter pokazal preostalo vsebino.
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Zaslonski prikaz

Med snemanjem (snemanje/stanje pripravljenosti) in predvajanjem so podatki o stanju in
nastavitvah videokamere vstavljeni v sliko, prikazano v iskalu.
Podatke lahko prikaZete/skrijete z gumbom DISPLAY. Tudi ko je skrit, se bo prikazal, ¢e izvedete

neposredne operacije v meniju (stran 48).

Za vsak element lahko tudi posebej izberete, ali ga Zelite prikazati/skriti (stran 87).

Podatki, prikazani na zaslonu med snemanjem

(v _8600keHold) (sen04), ([ow Light ND Clees)
:00:00:00)ERETT6)| @F5:8

18 19202122 23 242526 27 28

1. Indikator stanja omreZzja (stran 13)
V obliki ikone prikaze stanje omrezne
povezave.

2. Indikator nalaganja/indikator preostalih
datotek (stran 61)

3. Indikator obmo¢ja ostrenja (stran 37)
Prikaze obmocje ostrenja samodejnega
ostrenja.

4. Indikator na¢ina snemanja, reze A/B,
intervala nacina snemanja Interval Rec
(stran 49)

Display Pomen
®Rec Recording (5-sekundno snemanje)
Stby Stanje pripravljenosti snemanja

5. Indikator globinske ostrine

6. Indikator nacina zajemanja slike
(stran 24)

Ob neujemaniju velikosti kroga slike objektiva

in efektivne velikosti slike v nastavljenem

nacinu zajemanja slike, je prikazana oznaka 1.

Ko je nastavitev Imager Scan Mode

nastavljena na FF, se v nacinih z ozjim zornim

kotom prikaze oznaka »C« (obrezano).

Do obrezovanja pride v naslednjih nacinih.

e Ko je format zapisovanja 3840x2160 in je
hitrost sli¢ic S&Q Motion 100 ali 120 sli¢ic na
sekundo.

e Ko je nastavitev Codec nastavljena na RAW
ali RAW & XAVC-l in je izhodni format RAW
3840x2160.

7. Indikator stanja delovanja izhodnega
formata RAW (stran 55)
Prikazuje izhodno stanje signala RAW.

8. Indikator stanja serije UWP-D (stran 13)
V obliki ikone prikaze moc signala ravni RF,
ko je naprava serije UWP-D priklju¢ena na
nastavek MI, konfiguriran za digitalni prenos
zvoka.

9. Indikator hitrosti sli¢ic pri snemanju
pocasnih in hitrih posnetkov (stran 49)

10. Preostala napolnjenost baterije/indikator
napetosti DC IN (stran 17)

13. Indikator nacina stabilizacije slike

14. Indikator stanja izhoda SDI/funkcije Rec
Control izhoda HDMI (stran 106)
PrikaZe izhodno stanje signala REC control.

15. Indikator ostrenja (stran 40)

16. Indikator preostalega prostora na
pomnilniskem mediju

17. Indikator nacina beline

11. Indikator nacina ostrenja (stran 41) Display Pomen
Pomen Display Nacin Auto
Nacin Focus Hold Focus Hold Hold Nacin Auto zacasno prekinjen
Na?n rocvnega ostrenj.a MF w:P Prednastavljeni nacin
'l;l\scm rocnega.ostregja ol AF W:A Nacin pomnilnika A
z zaznavanjem obrazov/oci WB Nagin pomnilnika B
(AF/®1/0nly/ & /) P
Ikona zaznavanja obrazov/ 18. Indikator zunanjega zaklepa ¢asovne
odi kode/prikaz podatkov o casu (stran 34)
Ikona AF z zaznavanjem Only Ob zaklepu na ¢asovno kodo zunanje naprave
obrazov/oci prikazuje »EXT-LK«.
lkona registriranega ® 19. Indikator filtra ND (stran 43)
obraza

Ikona zacasne prekinitve  [1]
AF med AF z zaznavanjem
obrazov/oci"

1) Prikazana je, ko ni registriranega obraza in obraz
ni zaznan ali, ko je prisoten registriran obraz in
registriran obraz ni zaznan.

12. Indikator poloZaja zooma (stran 36)
Prikaze poloZaj zooma v razponu od O (Siroki
kot) do 99 (telefoto) (¢e je namescen objektiv,
ki podpira prikaz nastavitve zooma).

Prikaz je mogoce spremeniti v ¢rtni indikator
ali indikator razdalje ostrenja (stran 94).

Ko je vklopljena funkcija Clear Image Zoom, so
na zaslon dodani naslednji elementi.

Display Pomen

@ Funkcija Clear Image Zoom je
vklopljena

Vrednost Uporaba funkcije Clear Image

povecave Zoom

20.Indikator scenske datoteke (stran 105)

21. Indikator zaslonke

PrikaZe poloZaj zaslonke (vrednost F) (Ce
je namescen objektiv, ki podpira prikaz
nastavitve zaslonke).

22.0pozorilni indikator ravni videa

23.Indikator ojacitve (stran 42)
PrikaZe vrednost El v nacinu Cine El
(stran 24).

Display Pomen

Nacin Auto

Nacin Preset H

Nacin Preset M

Nacin Preset L

é?'_iI@

Nacin zacasne
prilagoditve
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24 .Prikaz imena posnetka (stran 63)
25.Indikator zaklopa (stran 43)
26.Nacin AE/indikator ravni AE (stran 42)

27. Indikator izravnanosti
Prikaze vodoravno izravnanost do +15° v
korakih po #1°.

28.Merilnik ravni zvoka

Prikaze raven zvoka za kanala CH1in CH2.
Kanalov CH3 in CH4 ni mogoce nadzorovati na
zaslonu stanja.

29.Nadzor video signala (stran 50)

Prikaze valovno obliko, vektorskop in
histogram.

OranZna ¢rta oznacuje nastavljeno vrednost
na ravni Zebra.

V nacinu Cine El (stran 24) prikazuje vrsto
signala LUT, ki je pod nadzorom.

30.Indikator Base Sensitivity/indikator Base
ISO (stran 42)

V nacinu Custom (stran 24) prikazuje

osnovno obcutljivost, nastavljeno z moznostjo

ISO/Gain/El, na zaslonu Main status ali

nastavitev ISO/Gain/El > Base Sensitivity v

meniju Shooting glavnega menija.

V nacinu Cine El (stran 24) prikazuje

osnovno obcutljivost ISO, nastavljeno z

moznostjo ISO/Gain/El, na zaslonu Main

status ali nastavitev ISO/Gain/El > Base ISO v

meniju Shooting glavnega menija.

31. Pomo¢nik za gammo zaslona/indikator
LUT monitorja

PrikaZe stanje pomoc¢nika za gammo zaslona.

Funkcijo pomocnika za gammo zaslona lahko

vklopite/izklopite z dodelitvijo moZnosti

Gamma Display Assist dodeljivemu gumbu

(stran 48).

V nacinu Cine El (stran 24) prikazuje

nastavitev funkcije Monitor LUT (stran 76).

32.Indikator Base Look (stran 52)

Prikazuje nastavitev osnovnega videza.

V nacinu Cine El (stran 24) prikazuje
nastavitev LUT za snemanje videoposnetkov
na pomnilniske kartice (stran 76).

33.Indikator stanja proxyja

34.Indikator formata snemanja (kodeka)
(stran 77)

Prikaze ime formata za snemanje na

pomnilniske kartice.

35.Indikator formata snemanja (hitrost sli¢ic
in nacin zajema)

36.Indikator formata snemanja (velikosti
slike) (stran 77)

Prikaze velikost slike za snemanje na

pomnilniske kartice.

Podatki, prikazani na zaslonu med predvajanjem

Sledeci podatki so dodani predvajani sliki.

i
(Cpssiston )

(Clip Name 012845678901284567890128456 )

1 (I
2 I,

1. Indikator stanja omreZja

2. Indikator nalaganja/indikator preostalih
datotek

3. Stevilka posnetka/skupno $tevilo
posnetkov

4. Indikator stanja predvajanja

5. Indikator formata predvajanja (hitrost
sli¢ic in nacin zajemanja)

6. Indikator formata predvajanja (velikosti
slike)

7. Preostala napolnjenost baterije/indikator
napetosti DCIN

8. Indikator formata predvajanja (kodeka)

9. Indikator pomnilnidkega medija
lkona ( se prikaze, ¢e je pomnilnika kartica
zascitena pred zapisovanjem.

10. Prikaz podatkov o ¢asu

11. Prikaz imena posnetka

M

— .
w o

12 14

12. Indikator pomo¢nika za gammo zaslona

13. Merilnik ravni zvoka
PrikaZe raven zvoka pri predvajanju.

14. Indikator Base Look



1. Pregled: Zaslonski prikaz

Prikaz ikon

Zaslon stanja Glavni zaslon stanja

Prikaz ikon omrezne povezave

PrikaZe glavne funkcije videokamere in prazen

Na zaslonu stanja lahko preverite nastavitve in ~ Prostor na pomnilniskih medijih.

Nacin omrezja Stanje povezave Ikona
Nacin dostopovne tocke Delovanje kot dostopovna tocka

Napaka v delovanju dostopovne tocke

Nacin postaje

Povezava Wi-Fi
Ikona se spremeni glede na moc¢
signala (4 koraki)

LI I W

Prekinjena povezava Wi-Fi
(tudi pri vzpostavljanju povezave)

Napaka povezave Wi-Fi

Povezava USB

Povezava USB vzpostavljena

OF

Povezava USB prekinjena

Or

Napaka pri povezavi USB

Ow

Prikaz ikon serije UWP-D

Stanje oddajnika

Stanje sprejemanja

lkona

Izklopljen

Ne sprejema

W

Normalno stanje oddajanja

Sprejemanje

W) W

|
(raven sprejemanja (4
stopnje))

Stanje utiSanja

Sprejemanje (utisano)

Vel

Stanje opozorila preostale napolnjenosti  Sprejemanje

baterije

w
dl (ikona utripa)

Utisanje in stanje opozorila preostale

napolnjenosti baterije

Sprejemanje

M (ikona utripa)

stanje videokamere. Nastavitve elementov, ki
so oznaceni z zvezdico (*), lahko spreminjate.
Zaslon stanja podpira upravljanje na dotik.

Prikaz zaslona stanja
e Pritisnite gumb MENU.

Preklop zaslona stanja

e Zavrtite vecfunkcijsko kolesce.

e Potisnite vecfunkcijski gumb navzgor/
navzdol

e Podrsajte navzgor/navzdol po zaslonu
stanja.

Skritje zaslona stanja
e Pritisnite gumb MENU.

Spreminjanje nastavitve

Ko je prikazan zaslon stanja, pritisnite
vecfunkcijsko kolesce ali vecfunkcijski gumb,
da omogocite izbiro elementa nastavitve na
strani. Izberite Stevilko strani in nato pritisnite
za obracanje strani.

Elemente lahko izbirate tudi z neposrednim
dotikom.

[Opombal]

Spremembe na zaslonu stanja lahko omogocite tako,

da vklopite moZnost Menu Settings > User Menu Only
(stran 93) v meniju Technical glavnega menija.

Element
prikaza

Opis

S&Q Frame Rate

Nastavitev hitrosti slicic za
snemanje pocasnih in hitrih
posnetkov

Frequency/
Scan*

Nastavitev sistemske
frekvence in nacina zajema
slike

Imager Scan*

Nacin, kako slikovni senzor
zajema sliko

Media Remain

Preostali prostor na

(A) pomnilniskem mediju v rezi A

ND Filter Nastavitev filtra ND

ISO/Gain/El Nastavitev ISO/Gain/
Exposure Index

Base I1SO/ Nastavitev Base ISO/Base

Sensitivity* Sensitivity

Codec* Nastavitev kodeka za
snemanje

Media Remain

(B)

Preostali prostor na
pomnilniskem mediju v rezi B

Scene File*

Scenska datoteka v uporabi in
njena nastavitev File ID

Base Look/LUT*

Nastavitev funkcije Monitor
LUT

Zaklop Nastavitev hitrosti zaklopa ali
kota zaklopa
Iris Nastavitev zaslonke

Video Format*

Velikost slike za snemanje na
pomnilniske kartice

Izhodni format
RAW*

Velikost slike izhodnega
formata RAW

White Balance

Nastavitev beline




14 st

1. Pregled: Zaslonski prikaz

Zaslon stanja videokamere

Prikazuje stanje razli¢nih prednastavitev

videokamere.

Element prikaza

Opis

Zaslon stanja zvoka

Za vsak kanal prikaZe nastavitev vhoda,
merilnik ravni zvoka in nastavitev nadzora
glasnosti.

White Switch<B>

Nastavitev pomnilnika B za
belino

Element prikaza Opis

White Switch<A>

Nastavitev pomnilnika A za
belino

CH1 Regulacija Stanje Auto adjustment On/
stopnje Off

Merilnik Merilnik ravni zvoka

Element prikaza

Opis

Audio Input
Level*

Nastavitev ravni vhoda
(glavna nastavitev glasnosti)

HDMI Output CH*

Nastavitev avdio kanala
izhoda HDMI

Zaslon Monitoring Status

Prikazuje nastavitve izhodov SDI in HDMI.

Element prikaza

Opis

Glasnost* Nastavitev glasnosti slusalk/
vgrajenega zvocnika
Monitor CH* Nastavitev kanala monitorja

Zaslon stanja projekta

Prikazuje osnovne nastavitve, ki so povezane s

snemalnim projektom.

Element prikaza

Opis

Frequency/Scan* Nastavitev sistemske
frekvence in nacina zajema
slike

Codec* Nastavitev kodeka za

snemanje

Rec Function

Omogocen poseben format
snemanja in nastavitve

Simul Rec* Stanje On/Off socasnega
snemanja na 2 rezah
Title Prefix Naslovni del imena posnetka

Imager Scan*

Nacin, kako slikovni senzor
zajema sliko

SDI Signal*  Velikost izhodne slike
Info. Nastavitev On/Off prikaza
Disp.* izhoda
Color Nastavitev barvnega
Gamut*  prostora/stanje monitorja
LUT
HDMI Signal*  Velikost izhodne slike
Info. Nastavitev On/Off prikaza
Disp.* izhoda
Color Nastavitev barvnega
Gamut*  prostora/stanje monitorja
LUT
Pretaka- Signal Velikost izhodne slike
nje Info. Prikaz izhoda (izklopljeno
Disp. (fiksno))
Color Nastavitev barvnega
Gamut*  prostora/stanje monitorja
LUT
VF Color Nastavitev Gamma display
Gamut*  assist/nastavitev Color

space/stanje Monitor LUT

Base Look/LUT*

Nastavitev Base Look/LUT

Video Format*

Velikost slike za snemanje
na pomnilniske kartice

Gamma Display
Assist*

Nastavitev vklopa/izklopa
Gamma Display Assist

Number

Stevil¢na pripona imena
posnetka

Shooting Mode*

Nastavitev nacina snemanja

Izhodni format
RAW*

Velikost slike izhodnega
formata RAW

Proxy Rec*

Stanje On/Off in nastavitev
funkcije snemanja proxy

White Switch<P> Prednastavljena nastavitev stopnje
beline Vir* Vhodni vir
ND<Preset> Nastavitve Preset1 do 3 filtra Ref./Sens.* Referencna raven vhoda
ND Wind Nastavitev filtra za
ISO / Gain<L>* Nastavitev ISO/Gain<L> Filter* zmanjSevanje Suma vetra v
ISO / Gain<M>* Nastavitev ISO/Gain<M> mikrofonu
I1SO / Gain<H>* Nastavitev ISO/Gain<H> CH2 Regulacija Stanje Auto adjustment On/
Base ISO/ Nastavitev Base ISO/Base stopnje Off
Sensitivity* Sensitivity Merilnik Merilnik ravni zvoka
Zebral Nastavitev On/Off in ravni za stopnje
Zebral Vir* Vhodni vir
Zebra2 Nastavitev On/Off in ravni za Ref./Sens.* Referencna raven vhoda
Zebra2 Wind Nastavitev filtra za
VF Gamma/ Kategorija in krivulja gamme Filter* zmanjSevanje Suma vetra v
Gamma mikrofonu
Scene File* Scenska datoteka v uporabi CH3 Level Stanje Auto adjustment On/
in njena nastavitev File ID Control* Off
Level Merilnik ravni zvoka
Meter*
Vir* Vhodni vir
Ref./Sens.* Referencna raven vhoda
Wind Nastavitev filtra za
Filter* zmanjSevanje suma vetra v
mikrofonu
CH4 Level Stanje Auto adjustment On/
Control* Off
Level Merilnik ravni zvoka
Meter*
Vir* Vhodni vir
Ref./Sens.* Referencna raven vhoda
Wind Nastavitev filtra za
Filter* zmanjsevanje Suma vetra v

mikrofonu
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1. Pregled: Zaslonski prikaz

Zaslon stanja dodeljivih gumbov

PrikaZe funkcije, dodeljene vsakemu od
dodeljivih gumbov.

Zaslon stanja baterije

Prikazuje podatke o bateriji in viru napajanja

DCIN.

Zaslon stanja pomnilniskih medijev

PrikaZe preostali prostor in preostali ¢as
snemanja pomnilniskin medijev.

Element prikaza

Opis

Element prikaza

Opis

Element prikaza

Opis

Zaslon stanja omrezja

Prikazuje stanje omrezne povezave.

Element prikaza

Opis

1

Funkcija, dodeljena gumbu
ASSIGN 1

Detected Battery

Tip baterije

Media A

Prikaze ikono pomnilniskega

BrezZi¢ni LAN

Nastavitve brezzi¢nega
omreZja in stanje povezave

information medija, ko je pomnilniski Wired LAN Nastavitve Zicnega omreZzja
medij vstavljen v rezo A. LAN in stanje povezave

Media A Prikaze preostali prostor na Modem Nastavitve brezzi¢nega

remaining pomnilniskem mediju, omreZja in stanje povezave

capacity meter

vstavljenem v rezo A, izrazen
kot odstotek na ¢rtnem
grafu.

UsB

Remaining Preostala zmogljivost (%)

Charge Count Stevilo ponovnih polnjen;

Capacity Preostala zmogljivost (Ah)

Voltage Napetost baterije (V)

Manufacture Datum izdelave baterije

Date

Video Light Prikazuje preostalo

Remaining napolnjenost baterije za
video luc.

Power Source Vir napajanja

Supplied Voltage

Napetost vira napajanja

2 Funkcija, dodeljena gumbu
ASSIGN 2

3 Funkcija, dodeljena gumbu
ASSIGN 3

4 Funkcija, dodeljena gumbu
ASSIGN 4

5 Funkcija, dodeljena gumbu
ASSIGN 5

6 Funkcija, dodeljena gumbu
ASSIGN 6

7 Funkcija, dodeljena gumbu
ASSIGN 7

8 Funkcija, dodeljena gumbu
ASSIGN 8

9 Funkcija, dodeljena gumbu
ASSIGN 9

Focus Hold Funkcija, dodeljena gumbu

Button Focus Hold na objektivu

Multi Function
Dial

Funkcija, dodeljena
vecfunkcijskemu kolescu

Kolesce na drzalu

Funkcija, dodeljena
dodeljivemu kolescu na
drzalu

Kolesce na rocaju

Funkcija, dodeljena
dodeljivemu kolescu na
rocaju

Media A
remaining
recording time

Prikaze ocenjen preostali as
snemanja na pomnilniski
medij, vstavljen v rezo A,
izraZzen v minutah,
upostevaje trenutne razmere
snemanja.

Zaslon stanja prenosa datotek

PrikaZe podatke o prenosu datotek.

Element prikaza

Opis

Auto Upload
(Proxy)

Stanje On/Off funkcije Auto
Upload (Proxy)

Job Status
(Remain / Total)

Preostalo Stevilo nalaganj in
skupno Stevilo nalaganj

Media B Prikaze ikono pomnilniskega
information medija, ko je pomnilniski
medij vstavljen v reZo B.
Media B Prikaze preostali prostor na
remaining pomnilniskem mediju,

capacity meter

vstavljenem v reZo B, izraZen
kot odstotek na crtnem
grafu.

Total Transfer
Progress

Napredek prenosa vseh
nalaganj

Default Upload
Server

Ime ciljnega streznika za
Auto Upload (Proxy)

Media B
remaining
recording time

Prikaze ocenjen preostali ¢as
snemanja na pomnilniski
medij, vstavljen v reZzo B,
izraZzen v minutah,
upostevaje trenutne razmere
snemanja.

Current File
Transfer Progress

Napredek prenosa
trenutnega prenosa
datoteke

Current
Transferring File
Name

Ime datoteke, ki se trenutno
prenasa

Server Address Naslov ciljnega streznika za
prenos datotek

Destination Ciljna mapa ciljnega

Directory streznika za prenos datotek
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Uporaba zaslonov z nastavitvami na dotik

Postavitev zaslona

Element

INPUT1
MIC +48V

INPUT2
MIC +48V

Int MIC

INPUT2
MIC +48V

CH1/CH2

Ime elementa

Gumb Set (uporabi)

Oznaka trenutne nastavitve

Izbirnik nastavitve
(oranzen okvircek)

MoZnosti izbire

Operacija
1 Tapnite element nastavitve.

INPUT1
MIC +48V

INPUT2
MIC +48V

Int MIC

CH1/CH2 CH1/CH2

Dotaknite se

(0)i

Off

Off

(0)i

2 Povlecite ali frcnite nastavitev, da izberete
vrednost.

CH4 Input Sel.

INPUT1
MIC +48V

INPUT2
MIC +48V

Off

Int MIC

INPUT2
MIC +48V
Internal

CH1/CH2 0 4

PrikaZejo se izbirne moZnosti za vrednost. Frcnite

3 Tapnite gumb Set ali izbirnik vrednosti.
Vrednost je dodeljena in znova se prikaze
prejsnji zaslon.

[Nasveti]

e Zavrnitev na prejsnjo vrednost pritisnite gumb
CANCEL/BACK.

e Uporabite lahko tudi vec¢funkcijsko kolesce ali
vecfunkcijski gumb.

e Upravljanje na dotik lahko tudi izklopite (stran 93).
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2 Priprava

Napajanje

Uporabite lahko paket baterij ali napajanje iz
omreznega napajalnika.

Iz varnostnih razlogov uporabljajte samo
pakete baterij Sony in omreZne napajalnike, ki
so navedeni spodaj.

Paketi litij-ionskih baterij
BP-U35 (priloZzeno)
BP-U60

BP-U60T

BP-U70

BP-U90

BP-U100

Polnilnika baterij
BC-CU1 (priloZzeno)
BC-U1A

BC-U2A

OmreZni napajalnik (prilozen)

[OPOZORILO]

Paketov baterij ne shranjujte na mestih,
izpostavljenih neposredni soncni svetlobi,
plamenu ali visoki temperaturi.

[Opombe]

e Za napajanje iz omreZnega vira uporabljajte samo
priloZen omrezni napajalnik.

e Pred priklopom baterije ali omreznega napajalnika
vedno prestavite stikalo POWER v poloZaj Off. Ce
priklapljate, ko je stikalo POWER v poloZaju On, se
videokamera v nekaterih primerih morda ne bo
mogla zagnati. Ce se videokamera ne more zagnati,
prestavite stikalo POWER v poloZaj Off in zacasno
odklopite paket baterij ali omrezno napajanje. Pred
ponovnim priklopom pocakajte priblizno 30 sekund.
(Ce Zelite prikljuciti omrezni napajalnik medtem, ko
se videokamera napaja iz paketa baterij, lahko to brez
teZav storite tudi, ko je stikalo POWER v poloZaju On.)

Uporaba paketa baterij

Za priklop paketa baterij, vstavite paket baterij

v lezisce (stran 7) vse do konca, dokler gre.
Nato ga potisnite navzdol, da se zaklene.

Za odstranitev paketa baterij pritisnite in
zadrzite gumb BATT RELEASE (stran 7),
potisnite paket baterij navzgor in ga nato
povlecite iz leZisca.

Gumb BATT
RELEASE

[Opombe]

e Pred priklopom paketa baterij, napolnite baterijo z
namenskim polnilnikom baterij BC-CU1, BC-U1A ali
BC-U2A.

o (e paket baterij polnite, ko je topel (na primer
takoj po uporabi), se baterija morda ne bo povsem
napolnila.

Preverjanje preostale napolnjenosti
baterije
Ko snemate/predvajate z uporabo paketa

baterij, je preostala napolnjenost baterije
prikazana v iskalu (stran 11).

lkona Pomen

8/ ///] 91 % do 100 %
Y/ /] 71 % do 90 %
{ 20 51 % do 70 %
{ Z 31 % do 50 %
{4 11 % do 30 %
] 0% do 10 %

Videokamera prikazuje preostalo napolnjenost
baterije tako, da izracunava razpoloZljiv ¢as
uporabe s paketom baterij, ¢e bo poraba
energije Se naprej takSna, kot je pri trenutni
uporabi videokamere.

Ce raven napolnjenosti paketa baterij
postane nizka

Ce preostala raven napolnjenosti baterije med
delovanjem pade pod doloc¢eno raven (stanje
Low Battery), vas na to opozorita sporocilo za
nizko raven napolnjenosti baterije in utripajo¢
svetlobni indikator snemanja.

Ce preostala raven napolnjenosti baterije pade
pod raven, pri kateri je $e mogoce delovanje
(stanje Battery Empty), se pojavi sporocilo za
izpraznjeno baterijo.

Zamenjajte paket baterij z napolnjenim
paketom baterij.

Spreminjanje ravni opozoril

Tovarnisko privzeto je raven Low Battery
nastavljena na 10 % povsem napolnjene
baterije in raven Battery Empty na 3 %.

Nastavitve ravni opozoril lahko spremenite
z uporabo moznosti Camera Battery Alarm
(stran 94) v meniju Technical glavnega
menija.

Polnjenje paketa baterij s priloZzenim
polnilnikom baterij (BC-CU1)

1 Omrezni napajalnik (priloZen) priklopite na
polnilnik baterij. Napajalni kabel (priloZen)
povezite z elektri¢no vti¢nico.

2 Vstavite baterijo v prostor za baterijo in jo
potisnite v smeri puscice.
Lucka za polnjenje CHARGE zasveti
oranzno in polnjenje se zacne.

Ze
-

o
<

CHARGE, lucka

:

— OmreZni napajalnik

?0— Napajalni kabel
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2 Priprava: Napajanje

Lucka CHARGE (oranzna)

Sveti:Polnjenje

Utripa:Napaka pri polnjenju ali pa je
temperatura zunaj delovnega razpona
in se polnjenje zacasno prekine

e Ko je baterija polna, lucka CHARGE na

polnilniku baterij ugasne.
e Uporabljate samo originalne baterije Sony.

¢as polnjenja
Priblizen c¢as (v minutah) polnjenja, ko polnite
popolnoma izpraznjen paket baterij.

Paket baterij Celoten c¢as polnjenja

BP-U35 120 min

[Opombal]

Ce omreZni napajalnik odklopite iz polnilnika baterij in
baterija ostane priklopljena na polnilnik baterij, se bo
baterija zacela prazniti.

Uporaba omreznega napajanja

Priklop videokamere na omreZno napajanje
vam omogoca uporabo brez skrbi glede
potrebe po polnjenju paketa baterij.

S

od [
09 7
O

Napajalni [
kabel Priklju¢ek DC IN

.
1l
\

OmreZni napajalnik
OmreZni napajalnik priklopite na priklju¢ek DC
IN na videokameri. Napajalni kabel (prilozen)
poveZite z elektri¢no vti¢nico.

Ce se izhodna napetost omreznega
napajalnika zniza

Ce izhodna napetost omreZznega napajalnika
med delovanjem pade pod doloceno raven
(stanje DC Low Voltagel), se pojavi sporocilo,
ki vas obvesti, da se je izhodna napetost
omreZznega napajalnika znizala. Hkrati zacne
utripati svetlobni indikator snemanja.

Ce izhodna napetost omreZnega napajalnika
pade na raven, pri kateri videokamera ne
more vec delovati (stanje DC Low Voltage2), se
pojavi sporocilo, ki vas obvesti, da je izhodna
napetost omreZznega napajalnika prenizka.
Ce se to zgodi, pomeni, da je omrezni
napajalnik lahko okvarjen. Preverite omrezni
napajalnik.

Spreminjanje opozorilnih napetosti

Tovarnisko privzeto je raven DC Low Voltagel
nastavljena na 16,5 V in raven DC Low Voltage2
na 15,5 V. Nastavitve ravni za opozorila lahko
spremenite z uporabo moznosti Camera DCIN
Alarm (stran 94) v meniju Technical.

OmreZni napajalnik

e OmreZnega napajalnika ne priklopite in
ne uporabljajte v omejenem prostoru, na
primer med zidom in pohistvom.

e Omrezni napajalnik priklopite v najblizjo
elektri¢no vti¢nico. Ce se med delovanjem
pojavi tezava, takoj izvlecite napajalni kabel
iz elektri¢ne vti¢nice.

e Ne povzrocite kratkega stika na kovinskih
delih vtica omreznega napajalnika. To bi
lahko povzrocilo okvaro.

e Baterije ni mogoce polniti, ko je priklopljena
na videokamero, tudi ce je priklopljen
omrezni napajalnik.

e Ko omreZni napajalnik odklopite z enote,
primite vti¢ in ga izvlecite naravnost. Ce
boste vlekli kabel, lahko pride do okvare.
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2 Priprava

Namestitev naprav

Pritrditev mikrofona
(naprodaj posebej)

1 Namestite mikrofon v drzalo za mikrofon.

2 Prikljucite kabel mikrofona v prikljucek
INPUT1 ali INPUT2.

= — Mikrofon

Drzalo za
mikrofon

Q/—

INPUT1  INPUT2

3 Namestite kabel mikrofona v drzalo kabla,
kot je prikazano na skici.

Nosilec za kabel

[Nasveti]

o Ce mikrofona ne uspete trdno namestiti, uporabite
priloZeni distancnik.

e Od vrste namescenega objektiva je odvisno, ali bo na
sliki videokamere vidna konica mikrofona. Nastavite
poloZaj mikrofona.

Namestitev iskala

[Opombal]
Iskalo namestite/odstranite, ko je videokamera
izklopljena.

Namestitev iskala na sprednji del drzala

1 Adapter z objemko za namestitev iskala
vstavite v nastavek za iskalo na drzalu ()
in privijte (priloZeni) vijak v desno, da ga
pritrdite na poloZaj (®).

Adapter z objemko za namestitev lahko
premikate v korakih po 45°, toda
priporo¢amo poloZaj, pri katerem bo tocka
namestitve to¢no nad vijakom.

Vijak
Adapter z objemko
za namestitev iskala

2 Objemko iskala namestite na adapter z
objemko za namestitev iskala (D) in
obrnite zaklepni gumb v desno, da ga
pritrdite v poloZaj (®).

[Opombal]
Dobro zategnite zaklepni gumb, ko uporabljate iskalo.
Ce ni dobro zategnjen, se lahko iskalo sname.

3 Poravnajte oznako A na videokameri z
oznako ¥ na prikljucku iskala in vstavite
kabel.

Poskrbite, da je oznaka ¥ na zunanji
strani, preden vstavite prikljucek.

4 Namestite kabel v drzalo kabla, kot je
prikazano na skici.




20t

2 Priprava: Namestitev naprav

Namestitev iskala na zadnji del drzala

Na zadnji strani drzala (D) in na zadnji strani
videokamere (@) sta po dve tocki za pritrditev
iskala. Pritrdite iskalo na nacin, ki je opisan v
razdelku »Namestitev iskala na sprednji del
drzala«.

Prilagajanje polozZaja iskala

Nagnite iskalo navzgor/navzdol, da nastavite
kot iskala.

S stikalom MIRROR lahko obrnete sliko,

ko jo na primer gledate s sprednje strani
videokamere.

[Nasvet]

Ko enote ne uporabljate ali jo prevazate, vam
priporo¢amo, da iskalo zascitite tako, da ga premaknete
v poloZaj, ki je prikazan na skici.

Odstranitev iskala

Odvijte zaklepni gumb iskala in sledite
postopku za namestitev iskala v obratnem
vrstnem redu.

Namestitev sencila iskala

1 Odpnite kovinske sponke na sencilu
iskala.

2 Namestite kovinsko sponko na vrhu
sencila iskala na kljuko na vrhu iskala in
namestite kovinsko sponko na spodnji
strani sencila iskala na kovinsko sponko
na spodniji strani iskala.

Kljuke za pritrditev

3 Potisnite zaklepno ploscico na spodnji
strani sencila iskala v smeri puscice, da
zaklenete sencilo iskala na svoje mesto.

Zaklepna
ploscica

Odpiranje sencila iskala

Povlecite srednji spodnji del sencila iskala k

sebi, nato pa ga povlecite, da odprete sencilo.

[Opombal]
Ko Zelite premakniti iskalo, primite ohisje iskala, nato pa
ga premaknite Ne drZite sencila iskala.

Odstranjevanje sencila iskala

Odpnite zaklep sencila iskala in ga snemite z
iskala.

Namestitev drzala z daljinskim
upravljalnikom

[Opombal]
Drzalo z daljinskim upravljalnikom namestite/odstranite,
ko je videokamera izklopljena.

1 Prikljucite kabel v prikljucek drzala z
daljinskim upravljalnikom.
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2 . N . . [Opombal]

Poravr?ajte._* nastayek za drzal(_) z daljinskim Ce kabel ni napeljan pod reZo, bo ob spremembi kota
upravljalnikom videokamere in oznako za nastavka za drzalo nanj delovala prevelika sila ali pa se
namestitev na drzalu ((®), pritrdite drzalo bo zataknil v obracalni mehanizem.
na videokamero in ga pocasi privijte v ) . )
levo (®). Nastavitev kota drzala z daljinskim
Ko se zaklene v poloZaj, klikne. upravljalnikom

Oznaka

Kot drzala z daljinskim upravljalnikom lahko
nastavite v razponu, ki je prikazan na skici,
tako, da bo ustrezal vasemu slogu snemanja.

Obrnjeno nazaj (najvec 83°)

[Opombe]

1 Rocico za vrtenje drzala premaknite v o PokTprgmembi p(_)loiajalvtved.no preverite, ali je drZalo
s . . . zaklenjeno v svojem poloZaju.

poJozaJ, ki je pr.lka_zgn na Skvl_c" in obrnite e Kot nastavitve drZala je omejen. Pri obracanju drzala
drzalo, ne da bi pritisnili rocico. ne uporabljajte pretirane sile.

Drzanje drzala (priporo¢ena metoda)

Ni pravil za drZzanje drzala, toda na tem
primeru lahko vidite, kako ga lahko enostavno

uporabljate.
[Opombal] Ly .
Ce ga ne morete pravilno pritrditi, ga pritrdite znova Uporaba gumba ASSIGN 5 ali VECfunkuJSkeQa
brez pretiranega pritiskanja na drzalo z daljinskim gumba
upravljalnikom ali videokamero.
3 Vstavite kabel, ki ste ga prikljucili v 2.
koraku, pod reZo na drZalu z daljinskim 2 _ . o
upravljalnikom, kot je prikazano na skici. Odmaknite prst z rocice za vrtenje drzala, &
ko je blizu zelenega poloZaja.
3 Drzalo rahlo premaknite, da klikne, kar C A B
pomeni, da je namesceno v poloZaju. A: S kazalcem upravljajte dodeljivo kolesce na
Ko je drzalo v svojem poloZaju, se rocica drzalu.
za vrtenje drzala vrne v prvotni poloZaj. B: S palcem upravljajte ve&funkcijski gumb in

gumb ASSIGN 5.
C: S sredincem, prstancem in mezincem trdno
drzite drzalo.
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Uporaba zooma

A: Rocico zooma upravljajte s kazalcem in
sredincem.

B: S palcem trdno drZite drzalo.

C: S prstancem in mezincem trdno drzite
drzalo.

Odstranjevanje drzZala

[Opombal]
Pri odstranjevanju drZala postavite videokamero na
ravno povrsino, na primer na mizo.

1 Odklopite kabel s prikljucka drzala z
daljinskim upravljalnikom.

2 Pritisnite in pridrzite gumb za sprostitev
drzala z daljinskim upravljalnikom na
videokameri in odvijte drzalo v desno,

dokler se ne sname.
= O,

Gumb za sprostitev drzala z
daljinskim upravljalnikom

[Nasvet]
Na pritrdiSce za drZalo na enoti in na ustrezno pritrdisce
na drzalu lahko namestite rozeto.
Za informacije o nakupu rozet se obrnite na prodajalca
izdelkov Sony.
- Na videokameri: 4-546-932- (dodatna moZnost)
- Na drzalu: 4-547-089- (dodatna moznost)
- Vijaki za pritrditev*
Na videokameri: 7-627-556- (dodatna moznost)
Na drzalu: 7-627-556- (dodatna moznost)
* Za vsako rozeto potrebujete $tiri vijake (odprtine
za vijake so na skici oznacene s krozci). Ce
uporabite druge vijake namesto priporocenih, lahko
poskodujete zunanjo povrsino.

—

Na drzalu
videokameri
Namestitev objektiva
[OPOZORILO]

Objektiva ne puscajte obrnjenega proti soncu.

Neposredna soncna svetloba lahko vstopi
skozi objektiv, se zbere v tocki v videokameri
in povzrodi pozar.

[Opombe]

e Objektiv namestite/odstranite, ko je videokamera
izklopljena.

o Objektiv je zelo natancen izdelek. Objektiva ne
polagajte na povrsino obrnjenega z nastavkom
navzdol. Namestite priloZen pokrovcek za objektiv.

[Nasvet]
Za podrobnosti o podprtih objektivih se obrnite na
servisnega predstavnika podjetja Sony.

Namestitev objektiva serije E

1

Snemite pokrovcek objektiva in pokrov z
videokamere in objektiva.

Poravnajte oznako za namestitev
objektiva (belo) z videokamero in
previdno nataknite objektiv, nato pa ga
zasukajte v desno.

Ko se zaklene v polozaj, klikne.

Namestitvene oznake (bele barve)

[Opombal]
Pri namescanju objektiva ne pritisnite gumba za
sprostitev objektiva.

Namestitev objektiva serije A

Za uporabo objektiva serije A namestite
adapter z nastavkom za objektiv (moZnost) in
nato namestite objektiv serije A.

[Opombal]

Pri uporabi objektiva serije A se zaslonka nastavlja ro¢no
in ostrenje je nastavljeno na ro¢no ostrenje.

Odstranitev objektiva

Objektiv odstranite po slede¢em postopku.

1 Pritisnite in pridrzite gumb za sprostitev
objektiva in zasukajte objektiv v levo,
medtem ko ga drZite.

2 Izvlecite objektiv v smeri naprej.

[Opombe]

e Ko odstranjujete objektiv, poravnajte namestitveno
oznako na obrocu za zaklepanje objektiva z
namestitveno oznako na videokameri.

e Zroko Cvrsto drZite objektiv, da preprecite njegov
padec.

o (e ne boste takoj namestili drugega objektiva, vedno
namestite pokrovcek ohisja.

Prilagajanje zaslonke pri objektivih s
stikalom Auto Iris

e Ko je stikalo Auto Iris na objektivu
nastavljeno na AUTO, se zaslonka prilagaja
samodejno, lahko pa jo tudi prilagajate
rocno na videokameri.

e Ko je stikalo Auto Iris na objektivu
nastavljeno na MANUAL, lahko zaslonko
nastavljate samo z obrocem na objektivu.
Upravljanje zaslonke na videokameri nima
ucinka.
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Prilagajanje ostrenja pri objektivih s
stikalom ostrenja

e Ko je stikalo ostrenja na objektivu
nastavljeno na AF/MF ali AF, se ostrenje
prilagaja samodejno, lahko pa ga prilagajate
tudi ro¢no z daljinskim upravljalnikom.

e Ko je stikalo ostrenja na objektivu
nastavljeno na MF, lahko ostrenje prilagajate
z obro¢em na objektivu ali prav tako ro¢no z
daljinskim upravljalnikom.

[Opombal]
Ob uporabi objektiva serije A ro¢no prilagajanje z
daljinskim upravljalnikom morda ne bo na voljo.

e Ko je stikalo ostrenja na objektivu
nastavljeno na Full MF, lahko ostrenje
prilagajate samo z obrocem za ostrenje.
Upravljanje ostrenja na videokameri nima
ucinka.

Namestitev stojala

Pri namescanju videokamere na stojalo
uporabite vija¢ne odprtine za stojalo na
videokameri. Uporaba nosilca za stojalo na
objektivu lahko povzroci poskodbe.
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Nastavitev osnovnih funkcij videokamere

Prvi¢, ko vklopite videokamero ali po popolni
izpraznitvi pomozZne baterije, se v iskalu
prikaZe zaslon zacletnih nastavitev.

Na tem zaslonu nastavite datum in cas
vgrajene ure.

Time Zone

Z moznostjo Time Zone nastavite razliko do
¢asa UTC (univerzalni koordinirani ¢as). Po
potrebi spremenite nastavitev.

Nastavitev datuma in Casa

Z vecfunkcijskim gumbom (stran 7) ali
vecfunkcijskim kolescem (stran 5) izberite
elemente in nastavitve, nato pa pritisnite
gumb na sredini vecfunkcijskega gumba ali

vecfunkcijskega kolesca, da potrdite nastavitve

in sproZzite uro.

Ko se zaslon nastavitev zapre, lahko datum,
cas in ¢asovni pas spremenite z uporabo
moznosti Clock Set (stran 99) v meniju
Maintenance.

[Opombe]

o Ce se nastavitev ure izbride, ker se pomozna baterija

popolnoma izprazni, do Cesar pride ob daljsem
odklopu napajanja (priklopljen ni niti paket baterij,

niti omreZno napajanje), se bo ob naslednjem vklopu

videokamere prikazal zaslon zacetnih nastavitev.

e Ko je prikazan zaslon zacetnih nastavitev, ne morete
uporabljati videokamere - lahko jo le izklopite -
dokler ne opravite nastavitev na tem zaslonu.

e Videokamera ima vgrajeno akumulatorsko baterijo za

shranjevanje datuma, ¢asa in ostalih nastavitev, tudi
ko je videokamera izklopljena.

Pred snemanjem nastavite osnovno delovanje

videokamere na zaslonu Project status, da bo
ustrezalo namenu uporabe.

& Project
Frequency/Scan
59.94P

Codec Video Format

XAVC-| 3840x2160P

ustom (709)

tput Format

Simul Rec

Number

0001

Shooting Mode

Izbirate lahko med nacinom snemanja
»Custom mode« za fleksibilno ustvarjanje
posnetkov na mestu snemanja in na¢inom
snemanja »Cine El« (v katerem videokamera
deluje podobno kot filmska kamera, kjer se
‘razvijanje' posnetega materiala izvede v
postprodukciji).

Nastavite nacin snemanja s funkcijo Shooting
Mode (stran 14) na zaslonu Project status.
[Nasvet]

Nacin snemanja lahko nastavite tudi z nastavitvijo Base

Setting > Shooting Mode (stran 77) v meniju Project
glavnega menija.

Nacin Custom

V nacinu snemanja Custom lahko izberete

video standard.

Video standard lahko nastavite z nastavitvijo

Base Setting > Target Display (stran 77) v

meniju Project glavnega menija.

e SDR(BT.709): Snemanje v skladu s
standardom oddajanja v visoki lo¢ljivosti

e HDR(HLG): Snemanje v skladu s standardom

oddajanja v locljivosti 4K naslednje
generacije
Za podrobnosti glejte razdelek 52.

Nacin Cine El

Ko je nacin snemanja nastavljen na nacin Cine

El, izberite barvni prostor za signal snemanja

in izhodni signal. Tukaj izbran barvni prostor

je barvni prostor video izhoda, ko je MLUT
nastavljen na Off.

Barvni prostor lahko nastavite s funkcijo Cine

El Setting > Color Gamut (stran 78) v meniju

Project glavnega menija.

e S-Gamut3.Cine/SLog3: Enostavno nastavljiv
barvni obseg za digitalni kino (DCI-P3).

e S-Gamut3/SLog3: Sonyjeva Siroka barvna
lestvica, ki zajema barvni prostor ITU-R
BT.2020.

Za podrobnosti glejte razdelek 54.

[Opombe]
e Nacin Cine El ima sledece omejitve.
o Funkcije, ki jih ni mogoce prilagoditi samodejno
(sledenje)
- White balance (Nastavitev beline)
- Ojacitev
- Zaklop
e Funkcije, ki jih ni mogoce konfigurirati
- Obcutljivost ISO/ojacitev (nastavljeno na
osnovno obcutljivost ISO (fiksno))
- Nastavitve menija Paint/Look (razen Base
Look)
- Scenska datoteka (onemogoceno)
o Naslednje funkcije so na voljo samo v nacinu Cine El
(stran 54).
e Indeks osvetlitve
e Monitor LUT

Sistemska frekvenca

Nastavite frekvenco sistema z nastavitvijo
Frequency/Scan (stran 14) na zaslonu
Project status. Videokamera se lahko po
preklopu samodejno ponovno zazene, kar je
odvisno od izbrane vrednosti.

[Nasvet]

Frekvenco sistema lahko nastavite tudi z nastavitvijo
Rec Format > Frequency (stran 77) v meniju Project
glavnega menija.

[Opombal]
Sistemske frekvence ne morete spremeniti med
snemanjem ali predvajanjem.

Imager Scan Mode

Nastavite lahko efektivno velikost slike in
locljivost slikovnega senzorja.

Nacin skeniranja nastavite z nastavitvijo
Imager Scan (stran 14) na zaslonu Project
status.

e FF: Velikost polnega formata.

e S35: Velikost Super 35 mm.

[Nasvet]

Nacin skeniranja lahko nastavite tudi z nastavitvijo
Rec Format > Imager Scan Mode (stran 77) v meniju
Project glavnega menija.

[Opombe]

e Nacina zajemanja slike ne morete spreminjati med
snemanjem ali predvajanjem.

e Ko je nastavljen na S35, je video format omejen na
locljivost 1920x1080.

Kodek

Nastavite kodek z moZnostjo Codec
(stran 14) na zaslonu Project status.

[Nasvet]
Kodek lahko nastavite tudi z nastavitvijo Rec Format >
Codec (stran 77) v meniju Project glavnega menija.

[Opombal]
Kodeka ne morete spreminjati med snemanjem ali
predvajanjem.
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Video Format

Nastavite lahko video format za snemanje.
Nastavite video format z moZnostjo Video
Format (stran 14) na zaslonu Project status.

[Nasvet]

Video format lahko nastavite tudi z nastavitvijo Rec
Format > Video Format (stran 77) v meniju Project
glavnega menija.

[Opombe]

e Video formata ne morete spreminjati med
snemanjem ali predvajanjem.

e Pri signalu na prikljuckih SDI OUT in HDMI OUT lahko
obstajajo omejitve, kar je odvisno od nastavljenega
video formata.
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Uporaba pomnilniskih kartic

Videokamera snema zvok in video na pomnilniske kartice CFexpress

tipa A (naprodaj posebej) ali pomnilniske kartice SDXC (naprodaj posebej), ki jih vstavite v reze
za kartice. PomnilniSke kartice se uporabljajo tudi za proxy snemanje in shranjevanje/nalaganje
nastavitev ter pri nadgradnji (posodobitvi programske opreme).

Vec o pomnilniskih karticah CFexpress tipa A

Uporabljajte pomnilniske kartice Sony CFexpress tipa A*, ki so navedene »Priporoc¢eni mediji«
(stran 27) v videokameri.
Za podrobnosti o delovanju s pomnilniskimi karticami drugih proizvajalcev glejte navodila za

uporabo konkretnega pomnilniSkega medija ali poiscite proizvajalceve podatke.
*V tem dokumentu se uporablja izraz »CFexpress cards«.

Vec o pomnilniskih karticah SDXC

Uporabljajte pomnilniske kartice SDXC*, ki so navedene »Priporoceni mediji« (stran 27) v

videokameri.
*V tem dokumentu se uporablja izraz »SD cards«.
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Priporoceni mediji

Zagotovljeni pogoji delovanja se razlikujejo glede na format snemanja in nastavitev snemanja.

Da: Podprto delovanje
Ne: Normalno delovanje ni zagotovljeno

Format zapisovanja CFexpress SDXC
Type A

VPG400 Class10 U1 u3 VSC VSC VSC VSC
V10 V30 V60 Vo0
RAW Out & 4096x2160 Nacin Normal 59,94pP Da Ne Ne Ne Ne Ne Ne Da
XAVC-| Class300 50P Da Ne Ne Ne Ne Ne Ne Da
29,97P Da Ne Ne Ne Ne Ne Da Da
25P Da Ne Ne Ne Ne Ne Da Da
24p Da Ne Ne Ne Ne Ne Da Da
23,98P Da Ne Ne Ne Ne Ne Da Da
3840x2160 Nacin Normal 59,94P Da Ne Ne Ne Ne Ne Ne Da
Class300 50P Da Ne Ne Ne Ne Ne Ne Da
29,97P Da Ne Ne Ne Ne Ne Da Da
25P Da Ne Ne Ne Ne Ne Da Da
23,98P Da Ne Ne Ne Ne Ne Da Da
S&Q (60 sli¢ic na sekundo ali manj) 59,94P Da Ne Ne Ne Ne Ne Ne Da
50P Da Ne Ne Ne Ne Ne Ne Da
29,97P Da Ne Ne Ne Ne Ne Ne Da
25P Da Ne Ne Ne Ne Ne Ne Da
23,98P Da Ne Ne Ne Ne Ne Ne Da
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Format zapisovanja CFexpress SDXC
Type A

VPG400 Class10 U1 U3 VSC VSC VSC VSC
V10 V30 V60 V90
XAVC-| 4096x2160 Nacin Normal 59,94pP Da Ne Ne Ne Ne Ne Ne Da
Class300 50P Da Ne Ne Ne Ne Ne Ne Da
29,97P Da Ne Ne Ne Ne Ne Da Da
25P Da Ne Ne Ne Ne Ne Da Da
24P Da Ne Ne Ne Ne Ne Da Da
23,98P Da Ne Ne Ne Ne Ne Da Da
S&Q (60 slic¢ic na sekundo ali manj) 59,94P Da Ne Ne Ne Ne Ne Ne Da
50P Da Ne Ne Ne Ne Ne Ne Da
29,97P Da Ne Ne Ne Ne Ne Ne Da
25P Da Ne Ne Ne Ne Ne Ne Da
24P Da Ne Ne Ne Ne Ne Ne Da
23,98P Da Ne Ne Ne Ne Ne Ne Da
3840x2160 Nacin Normal 59,94P Da Ne Ne Ne Ne Ne Ne Da
Class300 50P Da Ne Ne Ne Ne Ne Ne Da
29,97P Da Ne Ne Ne Ne Ne Da Da
25P Da Ne Ne Ne Ne Ne Da Da
23,98P Da Ne Ne Ne Ne Ne Da Da
S&Q (60 slicic na sekundo ali manj) 59,94P Da Ne Ne Ne Ne Ne Ne Da
50P Da Ne Ne Ne Ne Ne Ne Da
29,97P Da Ne Ne Ne Ne Ne Ne Da
25P Da Ne Ne Ne Ne Ne Ne Da
23,98P Da Ne Ne Ne Ne Ne Ne Da
S&Q (100 sli¢ic na sekundo, 59,94P Da Ne Ne Ne Ne Ne Ne Ne
120 slicic na sekundo) 50P Da Ne Ne Ne Ne Ne Ne Ne
29,97P Da Ne Ne Ne Ne Ne Ne Ne
25P Da Ne Ne Ne Ne Ne Ne Ne
23,98P Da Ne Ne Ne Ne Ne Ne Ne
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Format zapisovanja CFexpress SDXC
Type A

VPG400 Class10 U1 U3 VSC VSC VSC VSC
V10 V30 V60 V90
XAVC-| 1920x1080 Nacin Normal 59,94pP Da Ne Ne Ne Ne Ne Da Da
Class100 50P Da Ne Ne Ne Ne Ne Da Da
29,97P Da Ne Ne Da Ne Da Da Da
25P Da Ne Ne Da Ne Da Da Da
23,98P Da Ne Ne Da Ne Da Da Da
S&Q (60 slicic na sekundo ali manj) 59,94P Da Ne Ne Ne Ne Ne Da Da
50P Da Ne Ne Ne Ne Ne Da Da
29,97P Da Ne Ne Ne Ne Ne Da Da
25P Da Ne Ne Ne Ne Ne Da Da
23,98P Da Ne Ne Ne Ne Ne Da Da
S&Q (100 slicic na sekundo, 59,94P Da Ne Ne Ne Ne Ne Ne Da
120 slicic na sekundo) 50P Da Ne Ne Ne Ne Ne Ne Da
29,97P Da Ne Ne Ne Ne Ne Ne Da
25P Da Ne Ne Ne Ne Ne Ne Da
23,98P Da Ne Ne Ne Ne Ne Ne Da
S&Q (150 sli¢ic na sekundo, 59,94P Da Ne Ne Ne Ne Ne Ne Ne
180 slic¢ic na sekundo) 50P Da Ne Ne Ne Ne Ne Ne Ne
29,97P Da Ne Ne Ne Ne Ne Ne Ne
25P Da Ne Ne Ne Ne Ne Ne Ne
23,98P Da Ne Ne Ne Ne Ne Ne Ne
S&Q (200 slicic na sekundo, 59,94P Da Ne Ne Ne Ne Ne Ne Ne
240 slicic na sekundo) 50P Da Ne Ne Ne Ne Ne Ne Ne
29,97P Da Ne Ne Ne Ne Ne Ne Ne
25P Da Ne Ne Ne Ne Ne Ne Ne
23,98P Da Ne Ne Ne Ne Ne Ne Ne
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Format zapisovanja CFexpress SDXC
Type A

VPG400 Class10 U1 U3 VSC VSC VSC VSC
V10 V30 V60 V90
XAVC-L 3840x2160 Nacin Normal 59,94pP Da Ne Ne Da Ne Da Da Da
420 50P Da Ne Ne Da Ne Da Da Da
29,97P Da Ne Ne Da Ne Da Da Da
25P Da Ne Ne Da Ne Da Da Da
23,98P Da Ne Ne Da Ne Da Da Da
S&Q (60 slicic na sekundo ali manj) 59,94P Da Ne Ne Da Ne Da Da Da
50P Da Ne Ne Da Ne Da Da Da
29,97P Da Ne Ne Ne Ne Ne Da Da
25P Da Ne Ne Ne Ne Ne Da Da
23,98P Da Ne Ne Ne Ne Ne Ne Da
S&Q (100 slicic na sekundo, 59,94P Da Ne Ne Ne Ne Ne Da Da
120 slicic na sekundo) 50P Da Ne Ne Ne Ne Ne Da Da
29,97P Da Ne Ne Ne Ne Ne Ne Da
25P Da Ne Ne Ne Ne Ne Ne Da
23,98P Da Ne Ne Ne Ne Ne Ne Ne
1920x1080 Nacin Normal 59,94P Da Ne Ne Da Ne Da Da Da
HD50 50P Da Ne Ne Da Ne Da Da Da
29,97P Da Ne Ne Da Ne Da Da Da
25P Da Ne Ne Da Ne Da Da Da
23,98P Da Ne Ne Da Ne Da Da Da
S&Q (60 slicic na sekundo ali manj) 59,94P Da Da Da Da Da Da Da Da
50P Da Da Da Da Da Da Da Da
29,97P Da Ne Ne Da Ne Da Da Da
25P Da Ne Ne Da Ne Da Da Da
23,98P Da Ne Ne Da Ne Da Da Da
S&Q (100 sli¢ic na sekundo, 59,94P Da Ne Ne Da Ne Da Da Da
120 sli¢ic na sekundo) 50P Da Ne Ne Da Ne Da Da Da
29,97P Da Ne Ne Ne Ne Ne Da Da
25P Da Ne Ne Ne Ne Ne Da Da
23,98P Da Ne Ne Ne Ne Ne Da Da
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Format zapisovanja CFexpress SDXC
Type A

VPG400 Class10 U1 U3 VSC VSC VSC VSC
V10 V30 V60 V90
XAVC-L 1920x1080 S&Q (150 slicic na sekundo, 59,94P Da Ne Ne Ne Ne Ne Da Da
HD50 180 sli¢ic na sekundo) 50P Da Ne Ne Ne Ne Ne Da Da
29,97P Da Ne Ne Ne Ne Ne Ne Da
25P Da Ne Ne Ne Ne Ne Ne Da
23,98P Da Ne Ne Ne Ne Ne Ne Da
S&Q (200 sli¢ic na sekundo, 59,94P Da Ne Ne Ne Ne Ne Da Da
240 slicic na sekundo) 50P Da Ne Ne Ne Ne Ne Da Da
29,97P Da Ne Ne Ne Ne Ne Ne Da
25P Da Ne Ne Ne Ne Ne Ne Da
23,98P Da Ne Ne Ne Ne Ne Ne Da
1920x1080 Nacin Normal 59,94P Da Da Da Da Da Da Da Da
HD35 50P Da Da Da Da Da Da Da Da
29,97P Da Da Da Da Da Da Da Da
25P Da Da Da Da Da Da Da Da
23,98P Da Da Da Da Da Da Da Da
S&Q (60 slicic na sekundo ali manj) 59,94P Da Da Da Da Da Da Da Da
50P Da Da Da Da Da Da Da Da
29,97P Da Ne Ne Da Ne Da Da Da
25P Da Ne Ne Da Ne Da Da Da
23,98P Da Ne Ne Da Ne Da Da Da
S&Q (100 sli¢ic na sekundo, 59,94P Da Ne Ne Da Ne Da Da Da
120 sli¢ic na sekundo) 50P Da Ne Ne Da Ne Da Da Da
29,97P Da Ne Ne Da Ne Da Da Da
25P Da Ne Ne Da Ne Da Da Da
23,98P Da Ne Ne Ne Ne Ne Da Da
S&Q (150 sli¢ic na sekundo, 59,94P Da Ne Ne Da Ne Da Da Da
180 slicic na sekundo) 50P Da Ne Ne Da Ne Da Da Da
29,97P Da Ne Ne Ne Ne Ne Da Da
25P Da Ne Ne Ne Ne Ne Da Da
23,98P Da Ne Ne Ne Ne Ne Da Da
S&Q (200 sli¢ic na sekundo, 59,94P Da Ne Ne Da Ne Da Da Da
240 slicic na sekundo) 50P Da Ne Ne Da Ne Da Da Da
29,97P Da Ne Ne Ne Ne Ne Da Da
25P Da Ne Ne Ne Ne Ne Da Da
23,98P Da Ne Ne Ne Ne Ne Ne Da
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Vstavljanje pomnilniske kartice

1 Odprite pokrov reze za pomnilnisko
kartico.

2 Vstavite pomnilnisko kartico.
e Pri karticah CFexpress mora biti nalepka
na levi strani.

==y
/

Oznaka

e Pri karticah SD mora biti nalepka na
desni strani, z zaobljenim vogalom na
dnu.
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Zaobljen vogal

Indikator dostopa (stran 6) zasveti v
rdedi barvi in Ce je kartica uporabna, se
barva spremeni v zeleno.

[Opombal]

Ce indikator dostopa neprekinjeno utripa rdece
in ne preklopi na zeleno, zacasno izklopite
videokamero in odstranite ter ponovno vstavite
pomnilnisko kartico.

3 Zaprite pokrov reze za pomnilnisko
kartico.

[Opombe]

o (e poskugate pomnilnigko kartico vstaviti v
nepravilnem polozaju in s silo, se pomnilniska kartica,
reza za pomnilnisko kartico in podatki na pomnilniski
kartici lahko poskodujejo.

e Ko snemate na pomnilniski kartici, vstavljeni v rezi A
in B za kartice CFexpress tipa A/SD, v obe reZi vstavite
taksni kartici, kot sta priporoceni za snemanje v
izbranem formatu.

Odstranjevanje pomnilniske kartice

Odprite pokrov reze za pomnilnisko kartico in
rahlo pritisnite na pomnilnisko kartico, da jo
izvrZete.

[Opombe]

e Celovitost podatkov na kartici ne bo zagotovljena,
Ce izklopite videokamero ali odstranite pomnilnisko
kartico medtem, ko je dostop do kartice Se v teku.
Vsi podatki, zapisani na kartici, bodo lahko zavrzeni.
Vedno se prepricajte, da je indikator dostopa
izklopljen preden izklopite videokamero ali odstranite
pomnilnisko kartico.

o Ce pomnilnisko kartico odstranite takoj po
zaklju¢enem snemanju, je pomnilniska kartica lahko
Se vroca, kar ni znak teZav.

Formatiranje (ponastavitev)
pomnilniskih kartic

Ce vstavite neformatirano pomnilnigko kartico
ali pomnilnisko kartico, ki je bila formatirana z
drugacnimi specifikacijami, se v iskalu pojavi
sporocilo »Media Needs to be Formatted«.

Kartico formatirajte po naslednjem postopku.

1 Izberite moznost Format Media
(stran 86) v meniju TC/Media glavnega
menija.

2 Izberite moZnost Media(A) (reza A) ali
Media(B) (reza B), nato pa izberite nacin

formatiranja (Full Format ali Quick Format).

PrikaZe se potrditveno sporocilo.

e Full Format: Popolna ponastavitev
medija, vklju¢no z informacijami o regiji
podatkov in upravljanju podatkov.

e Quick Format: Samo ponastavitev
informacij o upravljanju podatkov
medija.

3 I1zberite Execute.

Ko je formatiranje v teku, je prikazano
sporocilo. Indikator dostopa sveti rdece.
Ko je formatiranje zakljuceno, se prikaze
sporocilo o zakljucku. Pritisnite
vecfunkcijsko kolesce, da zaprete
sporocilo.

[Opombe]

e Formatiranje pomnilniske kartice izbrise vse
podatke, vklju¢no z videoposnetki in nastavitvenimi
datotekami.

e Med izvajanjem se lahko izpisejo sporocila, kar je
odvisno od trajanja postopka formatiranja.

Ce formatiranje ne uspe

Pomnilniskih kartic, ki jih videokamera ne
podpira, ni mogoce formatirati.

PrikaZe se opozorilno sporocilo. Sledite
navodilom in zamenjajte kartico s podprto
pomnilnisko kartico.

Uporaba kartice SD, formatirane v
videokameri, v rezi druge naprave
Najprej naredite varnostno kopijo kartice, nato

ponovno formatirajte kartico v napravi, v kateri
bo uporabljena.

Preverjanje preostalega (asa
snemanja

Med snemanjem (snemanje/stanje
pripravljenosti) lahko nadzorujete preostali
prostor na pomnilniski kartici v vsaki rezi. To
storite z uporabo indikatorjev preostalega ¢asa
snemanja za rezo A/B v iskalu (stran 11).
Preostali ¢as snemanja se izracunava na
podlagi preostalega prostora na pomnilniskem
mediju v vsaki rezi in trenutnega video
formata (bitna hitrost snemanja). Prikazan je v
obliki minut.

Kdaj zamenjati pomnilnisko kartico

e Ko preostali ¢as snemanja na obeh
pomnilniskih karticah pade pod 5 minut, se
izpiSe sporocilo »Media Near Full«. Dodatno
zacne utripati svetlobni indikator snemanja
in zaslisi se zvo¢no opozorilo (na izhodu za
slusalke).

Zamenjajte pomnilniski medij s praznim.

o Ce nadaljujete s snemanjem dokler preostali
¢as snemanja ne doseZe nicle, se sporocilo
spremeni v »Media Full« in snemanje se
ustavi.

[Opombal]

Na eno pomnilnisko kartico je mogoce posneti do

priblizno 600 posnetkov.
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Obnovitev pomnilniskih kartic

Ce pride iz kateregakoli vzroka do napake
na pomnilniski kartici, morate kartico pred
uporabo obnoviti.

Ko vstavite pomnilnisko kartico, ki jo je treba
obnoviti, se v iskalu izpiSe sporocilo, ki vas
vprasa, ali jo Zelite obnoviti.

Obnovitev kartice

Obrnite vecfunkcijsko kolesce (stran 5), da
izberete moZnost Execute, nato pa pritisnite
vecfunkcijsko kolesce.

Ko je formatiranje v teku, sta prikazana
sporocilo in stanje napredka (%). Indikator
dostopa sveti rdece.

Ko je obnovitev zakljucena, se prikaze
sporocilo o zakljucku.

Ce obnovitev ne uspe

e Pomnilniskih kartic, na katerih je priSlo do
pomnilniskih napak, ni mogoce obnoviti.
PrikaZe se opozorilno sporocilo. Sledite
navodilom za zamenjavo pomnilniske
kartice.

e PomnilniSke kartice, na katerih je prislo
do pomnilniskih napak, lahko postanejo
uporabne, e jih ponovno formatirate.

e V nekaterih primerih je nekatere posnetke
mogoce obnoviti, drugih ne. Obnovljene
posnetke je mogoce normalno predvajati.

[Opombe]

e Prepricajte se, da za obnovitev pomnilniskih medijev
uporabljate videokamero, s katero so bili ti posneti.

e Pomnilniskih medijev, posnetih z drugo napravo ali z
videokamero drugac¢ne razli¢ice (celo istega modela),
morda ne bo mogoce obnoviti s to videokamero.

e Posnetkov, ki so krajsi od 2 sekund, ni mogoce
obnoviti.



3 Snemanje

Postopek osnovnega upravljanja

Osnovno snemanje izvedete po sledecem
postopku.

1 Priklopite potrebne naprave in preverite,
da je prisotno napajanje.

2 Vstavite pomnilnisko kartico.

3 Stikalo POWER prestavite v poloZaj za
vklop.
Vklopi se indikator POWER in v iskalu se
prikaze slika kamere.

4 Pritisnite gumb za snemanje START/STOP
(stran 5).
Svetlobni indikator, ki oznacuje snemanje,
zasveti in snemanje se zacne.

5 ¢ selite zaustaviti snemanje, zhova

pritisnite gumb za snemanje START/STOP.

Snemanje se ustavi in videokamera
preklopi v nacin STBY (stanje
pripravljenosti).

[Opombal]

Ce gumb za snemanje START/STOP pritisnete v nekaj
sekundah po vklopu videokamere, svetlobni indikator,
ki oznacuje snemanje, zasveti, kar oznacuje, da poteka
snemanje. Toda zapisovanje na pomnilniski medij lahko
v tem primeru zakasni za nekaj sekund, odvisno od
izbranega snemalnega formata.

Preklapljanje med pomnilniSkima
karticama

Ko sta vstavljeni dve pomnilniski kartici,
pritisnite gumb SLOT SELECT (stran 6), da
preklopite med karticama.

Zapisovanje se samodejno preklopi na

drugo pomnilnisko kartico tik preden se

prva pomnilniska kartica zapolni (preklopno
snemanje). Z neprekinjenim snemanjem lahko
nadaljujete z zamenjavo pomnilniSke kartice,
tako da polno pomnilnisko kartico zamenjate
Z novo.

[Opombal]

Med pomnilniskima karticama ne morete preklapljati v
nacinu predvajanja. Dodatno, neprekinjeno predvajanje
posnetka, ki se delno nahaja na pomnilniski kartici v rezi
A in delno na pomnilniski kartici v reZi B, ni podprto.

Posnetki (posneti podatki)

Ko ustavite snemanje, se video, zvocni in
spremljajoci podatki od zacetka do konca
snemanja shranijo v en sam »posnetek« na
pomnilniski kartici.

Imena posnetkov

Ime vsakega posnetka, ki ga posname
videokamera, je samodejno ustvarjeno s
formatom, kot je nastavljen v razdelku Clip
Name Format (stran 86) v meniju TC/Media
glavnega menija.

NajdaljSe trajanje posnetka

Do 6 ur na posnetek.

NajdaljSe trajanje neprekinjenega snemanja
je enako najdaljSemu trajanju posnetka.

Ce ¢as snemanja preseZe najdalj$e trajanje
posnetka, se samodejno ustvari nov posnetek
in snemanje se nadaljuje. Nov posnetek se na
zaslonu slicic prikaZe kot lo¢en posnetek.

Med preklopnim snemanjem se posname vecje
Stevilo posnetkov, kljub temu pa se bo snemanje
samodejno ustavilo po priblizno 24 urah.

[Opombe]

o Ne odstranjujte pomnilniske kartice medtem, ko
poteka snemanje. Med snemanjem lahko zamenjate
pomnilniske kartice samo v tistih rezah, katerih
indikator dostopa je izklopljen.

e Ko preostala kapaciteta pomnilniske kartice, na katero
se trenutno snema, znasa manj kot minuto, ter je v
drugi reZi vstavljena prazna pomnilniska kartica, se
prikaze sporocilo »Will Switch Slots Soon«. Sporocilo
izgine po preklopu med reZama za pomnilniske
kartice.

e Preklopno snemanje morda ne bo delovalo, ¢e
zacnete snemati, ko preostala kapaciteta pomnilniske
kartice znasa manj kot minuto. Da bo preklopno
snemanje potekalo pravilno, pred zacetkom snemanja
preverite, da preostala kapaciteta pomnilniske kartice
znasa vec kot minuto.

e Videa, ki ga ustvarite s funkcijo preklopnega
snemanja v videokameri, ni mogoce neprekinjeno
predvajati na videokameri.

e Za zdruzitev videoposnetkov, ustvarjenih s funkcijo
preklopnega snemanja, uporabite programsko
opremo »Catalyst Browse«.

Nadzor zvoka

Zvok, ki ga snemate, lahko nadzirate z
uporabo slusalk.

Priklop slusalk v vti¢nico za slusalke

(stran 5) vam omogoca, da nadzirate

zvok, ki ga snemate. Zvok lahko nadzirate tudi
med predvajanjem (stran 64) z uporabo
vgrajenega zvocnika (stran 6) ali slusalk.
Nastavite lahko glasnost zvoka, ki ga
nadzirate, s funkcijo Volume (stran 14)

na zaslonu Audio Status ali Audio Output
>Volume (stran 92) v meniju Audio
glavnega menija.

Izberete lahko kanal, ki ga nadzirate, s
funkcijo Monitor CH (stran 14) na zaslonu
Audio Status ali Audio Output >Monitor CH
(stran 91) v meniju Audio glavnega menija.

Dolocanje podatkov o ¢asu

Nastavitev casovne kode

Nastavite ¢asovno kodo za snemanje s
funkcijo Timecode (stran 85) v meniju TC/
Media glavnega menija.

Nastavitev uporabniskih bitov

Posneti sliki lahko dodate 8-mestno
Sestnajstisko Stevilo kot uporabniske bite.
Uporabniske bitne podatke lahko nastavite
tudi trenutnemu casu. Uporabo uporabniskih
bitov nastavite (stran 85) v meniju TC/
Media.

Prikaz podatkov o ¢asu

Nastavite prikaz ¢asovne kode z uporabo
funkcije TC Display (stran 85) >Display
Select v meniju TC/Media.

S pritiskom na dodeljiv gumb (stran 48)

z dodeljeno funkcijo DURATION/TC/U-BIT,
preklopite med prikazom ¢asovne kode,
uporabniskih bitov in trajanjem v sekvenci.

Preklop med vhodom/izhodom ¢asovne
kode

Med vhodom/izhodom ¢asovne kode lahko
preklopite z izbirnim stikalom TC IN/OUT
(stran 4).

Za podrobnosti glejte razdelek page 107.
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Ogled posnetka (Rec Review)

Zadnji posneti videoposnetek si lahko
ogledate na zaslonu (recording review).
[Opombal]

Funkcija ogleda posnetka ne deluje, ¢e po snemanju
posnetka spremenite video format.

Kako si ogledati posnetek

Najprej enemu od dodeljivih gumbov dodelite
funkcijo Rec Review za ogled posnetka.

Ko je snemanje ustavljeno, pritisnite dodeljivi
gumb (stran 48), ki ste mu dodelili funkcijo
Rec Review za ogled posnetka. Za¢ne se
predvajanje zadnjega videoposnetka.
Videoposnetek se predvaja do konca, ogled
posnetka se zakljuci in videokamera se vrne v
nacin STBY (stanje pripravljenosti).

Za zaustavitev ogleda posnetka

Pritisnite dodeljiv gumb, ki ste mu dodelili
funkcijo Rec Review za ogled posnetka ali
pritisnite gumb CANCEL/BACK.

Nastavitve ogleda posnetka

Zacetek predvajanja pri ogledu posnetka lahko

nastavite na eno od sledecih moZnosti. To

storite z nastavitvijo Rec Review (stran 93) v

meniju Technical.

e Predvajanje zadnjih 3 sekund videoposnetka

e Predvajanje zadnjih 10 sekund
videoposnetka

e Predvajanje od zacletka videoposnetka

[Nasvet]

Ce si Zelite ogledati to¢no dolo¢en videoposnetek
po tem, ko ste posneli ve¢ videoposnetkov, pritisnite
tipko THUMBNAIL za prikaz zaslona slicic in izberite
videoposnetek za zacetek predvajanja.
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Nastavitev zooma

Zoom lahko prilagajate glede na razmere
snemanja.

Ko je namescen objektiv s samodejnim
zoomom, lahko zoom prilagajate z rocico za
zoom na drzalu z daljinskim upravljalnikom ali
rocCaju. Hitrost zooma je odvisna od pritiska na
rocico.

Videokamera je opremljena s funkcijo zooma,
ki uporablja obdelavo signala slike, ki se
imenuje Clear Image Zoom. Ko je vklopljena
funkcija Clear Image Zoom, zoom podpirajo
tudi objektivi s fiksno gori$¢no razdaljo.
Uporablja se lahko tudi za vedji razpon, ki je
vedji od opti¢nega razpona na objektivu s
samodejnim zoomom.

Najvecje razmerje zooma s funkcijo Clear
Image Zoom se razlikuje in je odvisno od
locljivosti snemanja.

e Zalodljivost snemanja QFHD/4K: 1,5 x

e Zalodljivost snemanja v visoki loc¢ljivosti: 2 x

Izbiranje vrste zooma

Nastavite vrsto zooma z nastavitvijo Zoom
>Zoom Type (stran 93) v meniju Technical
glavnega menija.

Vrsta zooma bo odvisna od vrste
namescenega objektiva.

Namescen Nastavitev Zoom Type

objektiv Samo opti¢ni On (Clear
zoom Image Zoom)

Objektiv s Upravljanje Funkcija Clear

fiksno goris¢no zooma z Image Zoom je

razdaljo/ rocico ni podprta.

objektiv z podprto.

ro¢nim

zoomom

Namescen Nastavitev Zoom Type
objektiv Samo opti¢ni  On (Clear
zoom Image Zoom)
Objektiv z Optical zoom Opti¢ni zoom
zoomom only in funkcija
Power Clear Image
Zoom sta
podprta.
[Opombe]
e Funkcija Clear Image Zoom ni na voljo v naslednjih
primerih.

- Ko je nastavitev S&Q Motion >Frame Rate
(stran 76) v meniju Shooting glavnega menija
vi$ja od 60 slicic na sekundo.

- Ko je nastavitev Rec Format >Codec (stran 77)
v meniju Project glavnega menija nastavljena na
RAW ali na moznost, ki vklju¢uje RAW.

e Zizbirnim stikalom SERVO/MANUAL na objektivu
ponastavite povecavo funkcije Clear Image Zoom na
1%,

e Med delovanjem funkcije Clear Image Zoom
je obmocje ostrenja nastavljeno na Wide in je
izklopljena funkcija samodejnega ostrenja z
zaznavanjem obrazov/odi.

Nastavitev funkcije Handle Zoom

Nastavite nastavitev zooma na drzalu s
funkcijo Handle Zoom (stran 93) v meniju
Technical glavhega menija.

Nastavitev smeri obracanja obroca
za zoom

Na nekaterih objektivih E-mount lahko obrnete
smer obracanja obroca za zoom.

Nastavite smer obrac¢anja z nastavitvijo Lens

> Zoom Ring Direction (stran 94) v meniju
Technical glavnega menija.
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Prilagajanje ostrenja

Ostrenje lahko prilagajate samodejno ali ro¢no
glede na razmere snemanja.

Rocno prilagajanje ostrenja
(Rocno ostrenje)

Za roc¢no prilagajanje ostrenja, prestavite

stikalo FOCUS (stran 4) v poloZaj »MAN«.

To vam omogoca rocno prilagajanje ostrenja

glede na razmere snemanja.

Rocno ostrenje je primerno za naslednje tipe

subjektov.

e Subjekti na oddaljeni strani okna, ki je
prekrito z vodnimi kapljicami

e Subjekti z nizkim kontrastom glede na
ozadje

e Subjekti, ki so glede na bliznje subjekte bolj
oddaljeni

[Nasvet]

V naslednjih primerih lahko uporabite tudi samodejno

ostrenje, ko je ro¢na nastavitev glavna metoda

upravljanja.

e Ko je obcutljivost samodejnega ostrenja pri prehodu
med subjekti nastavljena na 1 (zaklenjena).

e Ko je stikalo FOCUS nastavljeno v poloZaj »AF«.

e Ko uporabljate obroc za ostrenje (AF Assist, 39).

Samodejno prilagajanje ostrenja
(Samodejno ostrenje)

Videokamera uporablja samodejno ostrenje
s faznim zaznavanjem za hitro ostrenje ter
samodejno ostrenje z zaznavanjem kontrasta
za visoko natancnost ostrenja.

Kombinacija teh dveh na¢inov omogoca
samodejno ostrenje, ki je hitro in zelo
natancno.

Za samodejno prilagajanje ostrenja prestavite
stikalo FOCUS (stran 4) na videokameri

v poloZaj »AUTO«. Ce je objektiv opremljen s
stikalom za izbiro nacina ostrenja, prestavite
stikalo v poloZaj »AF/MF« ali »AF«. Ce je
stikalo v poloZaju »Full MF« ali »MF«, ostrenja
objektiva ni mogoce upravljati z videokamere
(stran 23).

[Nasvet]

Ko je moZnost Focus >AF Assist (stran 75) v meniju

Shooting glavnega menija vklopljena, lahko med

samodejnim ostrenjem Se vedno tudi ro¢no prilagajate

ostrenje z obro¢em za ostrenje na objektivu.

[Opombe]

e Zahtevan je objektiv, ki podpira samodejno ostrenje.

e Glede na razmere snemanja morda ne bo dosezena
Zelena natancnost ostrenja.

e Ostrenja ni mogoce prilagajati samodejno na
objektivih serije A.

Nastavitev obmocja/polozaja
samodejnega ostrenja (Obmocje
ostrenja)

Cilino obmocje samodejnega ostrenja lahko
nastavite prek moznosti Focus >Focus Area

(stran 75) v meniju Shooting glavnega
menija.

Flexible Spot:

Ostri na dolo¢eno mesto v sliki.

Ko je izbrana ta moZnost, dolocite poloZaj z
vecfunkcijskim gumbom (stran 7).

Na osrednji poloZaj se lahko vrnete tako, da
pritisnete in pridrzite ve¢funkcijski gumb.

AF
r A
L J
Zone:

Samodejno i$¢e mesto ostrenja znotraj
dolocenega obmogja.

Ko je izbrana ta moZnost, dolocite poloZaj z
vecfunkcijskim gumbom (stran 7).

Na osrednji poloZaj se lahko vrnete tako, da
pritisnete in pridrzite ve&funkcijski gumb.

AF
r A
L J
Wide:

Med ostrenjem iSCe subjekt na Sirokem
obmodju slike. Okvir ni prikazan.

AF

[Nasvet]

Enako upravljanje je mogoce tudi z uporabo dodeljivega

gumba (stran 48), ki mu dodelite moZnost upravljanja

z obmocjem ostrenja.

Okvir obmocja ostrenja lahko prikazete/skrijete z

uporabo moznosti Display On/Off >Focus Area Indicator

(stran 87) v meniju Monitoring glavnega menija.

[Opombe]

e Okvir obmocja ostrenja ni skrit, ko uporabljate gumb
DISPLAY.

e Obmocje ostrenja je nastavljeno na Wide med
delovanjem funkcije Clear Image Zoom.

Hitra sprememba obmocdja ostrenja
(Nastavitev ostrenja)

Polozaj in velikost obmocja samodejnega
ostrenja lahko hitro spremenite med samim
snemanjem, ¢e dodeljivemu gumbu dodelite
moznost nastavitve ostrenja (stran 48).
Delovanje je odvisno od nastavitve obmocja
ostrenja.

Ko je moznost Focus >Focus Area (stran 75) v
meniju Shooting glavnega menija nastavljena
na Flexible Spot ali Zone.

Mesto obmocja ostrenja lahko spremenite
tako, da pritisnete dodeljiv gumb, ki ste mu
dodelili funkcijo Focus Setting in uporabite
vecfunkcijski gumb (stran 7).

Medtem ko prilagajate mesto obmocja
ostrenja, lahko tega vrnete v sredisce tako, da
pritisnete vecfunkcijski gumb.

Velikost obmocja ostrenja lahko spremenite
tako, da pritisnete in zadrZite dodeljiv gumb, ki
ste mu dodelili nastavitev ostrenja.

Po spreminjanju velikosti nastavite mesto
obmocja ostrenja tako, da pritisnete
vecfunkcijski gumb.

Ko ste zakljucili, pritisnite dodeljiv gumb, ki ste
mu dodelili nastavitev ostrenja, da se vrnete
na izvorni zaslon.
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Ko je moznost Focus >Focus Area (stran 75) v
meniju Shooting glavnega menija nastavljena

na Wide.

Spremenite lahko samo velikost obmocja
ostrenja, tako da pritisnete in zadrZite dodeljiv
gumb, ki ste mu dodelili nastavitev ostrenja.
Mesto ostrenja lahko spremenite, e najprej
spremenite tip ostrenja na Flexible Spot ali
Zone.

[Nasveti]

e Ko je moznost Focus >Push AF Mode (stran 75)

v meniju Shooting glavnega menija nastavljena na
Single-shot AF(AF-S) in je stikalo FOCUS (stran 4)

v poloZaju MF, lahko spremenite mesto obmocja
ostrenja Focus Area(AF-S) (stran 75).

e Med uporabo funkcije Clear Image Zoom je nastavitev
velikosti obmocja ostrenja izklopljena in se aktivira
samodejno ostrenje s prioriteto na sredis¢nem
obmodju.

e Okvir obmocja ostrenja je oranzne barve, ko je mesto
obmocja ostrenja mogoce spreminjati.

Premikanje okvirja obmocja ostrenja z
upravljanjem na dotik (dotaknite se
obmodja ostrenja)

Mesto obmocja ostrenja lahko spremenite
tako, da pritisnete dodeljiv gumb (stran 48)

z dodeljeno funkcijo Focus Setting in
spremenite prikaz obmocja ostrenja v oranzno
barvo, nato pa ga premaknete z upravljanjem
na dotik.

Tapnite zaslon, da premaknete obmocje
ostrenja tako, da bo srediS¢e obmocje ostrenja
na mestu, ki ste ga tapnili. Povlecite po
zaslonu, da premaknete obmocje ostrenja na
mesto, kamor povleclete prst (stran 10).

[Nasvet]

Upravljanje ostrenja z dotikom lahko vklopite/izklopite
na zaslonu za snemanje z dodeljivim gumbom z
dodeljeno funkcijo Focus Setting.

Tapnite poljubno mesto

U

Obmocdje ostrenja se premakne tako, da je
na sredini mesta, ki ste ga tapnili.

U

Povlecite po zaslonu, da premaknete obmocje
ostrenja na mesto, kamor povlecete prst.

e

[Opombe]

o (e tapnete mesto ali povle¢ete obmodje ostrenja na
mesto zunaj obmocdja nastavitve, bo obmocje ostrenja
nastavljeno na vrhu/dnu/levem robu/desnem robu
obmocja nastavitve.

e Ta funkcija ni na voljo v naslednjih okolisc¢inah.

- Ko je moznost Touch Operation (stran 93) v
meniju Technical glavnega menija izklopljena.

- Ko je obmocje ostrenja prikazano s sivo barvo ali
pa sploh ni prikazano.

Izostreno na oddaljeni subjekt

[

Nastavitev dejanja samodejnega
ostrenja (hitrost prehoda samodejnega
ostrenja, obCutljivost samodejnega
ostrenja pri prehodu med subjekti).
Med spremembo:

1(Pocasi): Ostrenje deluje
pocasi

Hitrost prehoda samodejnega ostrenja
Nastavite lahko hitrost pogona ostrenja za
primere, ko se subjekt spremeni. To omogoca
moZnost Focus >AF Transition Speed

(stran 75) v meniju Shooting glavnega
menija.

Ko se subjekt, na katerega naj bi ostrili,
spremeni, vam izbrana nizka hitrost omogoca
snemanje navdusujocih posnetkov.

Ko je izbrana visoka hitrost, ostrenje hitro
preklopi med subjektoma. Subjekt, ki vstopi v
sliko, je takoj izostren. S tem je ta nastavitev
idealna za dokumentarno snemanje, ki
zahteva hitro ostrenje.

7 (Hitro): Ostrenje deluje hitro

\V

Izostreno na bliZnji subjekt

A 4 4

Fl
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Obcutljivost samodejnega ostrenja pri

prehodu med subjekti

Obcutljivost za prehajanje med subjekti lahko
spremenite z moznostjo Focus >AF Subj. Shift
Sens. (stran 75) v meniju Shooting glavnega
menija.

Ko je izbrana nizka obcutljivost, ostrenje ne
preide takoj na drug subjekt, tudi ¢e se drug
subjekt giblje pred izostrenim subjektom. Ko je
izbrana visoka obcutljivost, ostrenje preide na
subjekt, ki se giblje v ospredju.

[vNasvet]

Ce je funkcija AF Speed/Sens. dodeljena dodeljivemu
gumbu, so vrstice ravni za prilagajanje vrednosti ob
vsakem pritisku gumba prikazane v naslednjem vrstnem
redu. Tako lahko spremenite nastavitev hitrosti prehoda
samodejnega ostrenja in nastavitev obcutljivosti
samodejnega ostrenja pri prehodu med subjekti.

Hitrost prehoda samodejnega ostrenja — Obcutljivost
samodejnega ostrenja pri prehodu med subjekti — Brez
prikaza ...

AF Subj. Shift Sens.: 1(Zaklenjeno na)

[mmm

Pocasi spremenite izostritev na drug subjekt

AF Subj. Shift Sens.: 5 (Odzivno)

i

Hitro spremenite izostritev na drug subjekt

Rocno spreminjanje cilja ostrenja
(AF Assist)

Ko je moznost Focus > AF Assist (stran 75) v

meniju Shooting glavnega menija vklopljena,

lahko med samodejnim ostrenjem Se vedno

tudi ro¢no prilagajate ostrenje z obrocem za

ostrenje na objektivu.

Ko prenehate uporabljati obro¢ za ostrenje,

funkcija samodejnega ostrenja nadaljuje

Z izostritvijo subjekta, ki ste ga izostrili z

obrocem za ostrenje (stanje AF assist).

Po uporabi obroca za ostrenje je premik

izostritve na drug subjekt nekoliko tezji, ne

glede na nastavitev Focus > AF Subj. Shift

Sens. (stran 75) v meniju Shooting glavnega

menija.

Stanje AF assist lahko izklopite na nasledniji

nacin.

e Ko subjekt, ki ste ga izostrili z obrocem za
ostrenje, ni vec viden.

e Ko preklopite na rocno ostrenje.

e Ko sistem registrira obraz.

[Nasveti]

e Stanje AF assist lahko hitro izklopite z dodeljivim
gumbom (stran 48) z dodeljeno funkcijo Push AF/
Push MF.

e Z obroCem za ostrenje pocistite izbiro registriranih
obrazov.

e V nacinu Face/Eye Only AF funkcija samodejnega
ostrenja izostri obraz, ki je najbliZzje mestu ostrenja, ki
ste ga nastavili z obro¢em za ostrenje.
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Zacasna uporaba ro¢nega ostrenja
(Push Manual Focus)

Zacasna uporaba samodejnega
ostrenja (Push Auto Focus)

V nacinu samodejnega ostrenja pritisnite
gumb PUSH AUTO FOCUS (stran 4) za

roCno ostrenje medtem, ko drzite pritisnjen
gumb.

Ostrenje se povrne na samodejno ostrenje, ko
spustite gumb.

To vam omogoca, da zac¢asno ustavite
samodejno ostrenje in ro¢no ostrite, kar je
uporabno v primerih, ko nekaj, kar ni subjekt
snemanja, precka sliko pred subjektom.

[Nasvet]

Enako delovanje omogoca tudi uporaba dodeljivega
gumba (stran 48) z dodeljeno funkcijo Push AF/Push
MF.

Ko je moZnost Focus >Push AF mode

(stran 75) v meniju Shooting glavnega
menija nastavljena na AF, pritisnite gumb
PUSH AUTO FOCUS (stran 4), medtem ko

ste v nacinu ro¢nega ostrenja, da omogocite

samodejno ostrenje, dokler je gumb pritisnjen.

Do ostrenja pride znotraj obmocdja ostrenja,

ki je nastavljeno z moZnostjo Focus >Focus
Area (stran 75) v meniju Shooting glavnega
menija.

Ostrenje se povrne na ro¢no ostrenje, ko
spustite gumb.

To je uporabno, kadar Zelite med ro¢nim
ostrenjem pocasi premakniti ostrenje z enega
na drug subjekt.

[Nasvet]

Enako delovanje omogoca tudi uporaba dodeljivega
gumba (stran 48) z dodeljeno funkcijo Push AF/Push
MF.

[Opombal]
Funkcija Push Auto Focus ne deluje, Ce je objektiv
nastavljen na ro¢no ostrenje.

Uporaba enkratnega
samodejnega ostrenja (Push Auto
Focus (AF-S))

Nastavite moZnost Focus >Push AF Mode

(stran 75) v meniju Shooting glavnega

menija na Single-shot AF(AF-S). Nato nastavite

obmocje ostrenja z mozZnostjo Focus >Focus

Area(AF-S) (stran 75) v meniju Shooting

glavnega menija.

V nacinu ro¢nega ostrenja pritisnite gumb

PUSH AUTO FOCUS za samodejno hitro

izostritev. Ostrenje se ustavi takoj, ko spustite

gumb.

Stanje ostrenja prikazuje indikator ostrenja.

e Sveti: Izostritev je fiksirana na mesto
ostrenja.

e Utripa: Ni izostreno. Ker ostrenje ni
samodejno, spremenite kompozicijo in
nastavitve ostrenja, da doseZete izostritev.

Ostrenje se povrne na ro¢no ostrenje, ko

spustite gumb.

Ta moznost je uporabna, ko Zelite hitro izostriti

subjekt preden zacnete snemati.

[Nasveti]

e Enako delovanje omogoca tudi uporaba dodeljivega
gumba (stran 48) z dodeljeno funkcijo Push AF/
Push MF.

e MoZnost Push AF Mode lahko dodelite tudi
dodeljivemu gumbu (stran 48).

e Dodeljivemu gumbu lahko dodelite tudi funkcijo
Focus Area(AF-S) (stran 48).

e Okvir obmocja ostrenja lahko prikaZete/skrijete z
uporabo moznosti Display On/Off > Focus Area Ind.
(AF-S) (stran 87) v meniju Monitoring glavnega
menija.

e Med povecavo ostrenja se ostrenje prilagodi, da
ustreza mestu povecanega prikaza.

[Opombe]

e Funkcija Push Auto Focus ne deluje, Ce je objektiv
nastavljen na ro¢no ostrenje.

e Okvir obmocja ostrenja ni skrit, ko uporabljate gumb
DISPLAY.

Ostrenje z uporabo povecave
ostrenja (Focus Magnifier)

Privzeta tovarniSka nastavitev je, da je funkcija

Focus Magnifier x3/x6 dodeljena gumbu

ASSIGN 4 na drzalu z daljinskim upravljalnikom

in gumbu ASSIGN 7 na rocaju (stran 48).

Pritisnite gumb ASSIGN 4 ali gumb ASSIGN

7, da preklopite iskalo na zaslon povecave

ostrenja, kjer je osrednji del zaslona povecan

za priblizno trikrat. Pritisnite gumb Se enkrat

za Se vedjo, priblizno Sestkratno povecavo. Ta

funkcija je uporabna za preverjanje izostritve.

Za vrnitev na obicajen zaslon ponovno

pritisnite gumb.

Mesto, ki ga Zelite povecati, lahko med

povecavo ostrenja premikate z vecfunkcijskim

gumbom (stran 7). S pritiskom

vecfunkcijskega gumba se vrnete na sredino

slike.

Ko je med povecavo ostrenja uporabljena

funkcija Push Auto Focus (AF), se ostrenje

izvrSi znotraj obmocja ostrenja, ki je

nastavljeno z nastavitvijo Focus > Focus Area

(stran 75) v meniju Shooting glavnega

menija.

Ce je med povecavo ostrenja uporabljena

funkcija Push Auto Focus (AF-S), se izostritev

prilagodi mestu povecave ostrenja.

[Opombe]

e Posneta slika ali slika na izhodu SDI/HDMI se pri
povecavi ostrenja ne poveca.

e Med povecavo ostrenja so onemogoceni gumb MENU
in druge operacije.

e Ko ugasnete videokamero, se mesto povecave vrne
na osrednji del zaslona.
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Ostrenje s funkcijo zaznavanja
obrazov/oci (Face/Eye Detection AF)

Videokamera lahko zazna obraze in odi

ljudi ter prilagodi izostritev obrazov in oci v
obmocju ostrenja.

Ta funkcija je na voljo le v samodejnem nacinu
ostrenja in pri uporabi funkcije Push Auto
Focus.

Ko videokamera zazna obraze, se prikazejo sivi
okvirji zaznavanja obrazov/odi. Ko je mogoce
samodejno ostrenje, okvirji postanejo beli. Ko
videokamera zazna oci in prilagodi izostritev,
se okvir zaznavanja obrazov/oci prikaze

na oleh. Ko videokamera zazna vec oseb,
samodejno dolodi glavni subjekt.

[Nasveti]

e Ko je obmocje ostrenja nastavljeno na Zone ali
Flexible Spot in obrazi ali oci prekrivajo izbrano
obmocje ostrenja, se barva okvirjev zaznavanja
obrazov/oci spremeni v belo, videokamera pa izvede
ostrenje teh obrazov/oci.

e Ob uporabi funkcije Push Auto Focus (AF-S) se barva
okvirjev zaznavanja obrazov/odi, ki so izostreni,
spremeni v zeleno.

Nastavite samodejno ostrenje z zaznavanjem
obrazov/odi z nastavitvijo Focus > Face/Eye
Detection AF (stran 75) v meniju Shooting.

Face/Eye Only AF:

Videokamera zazna obraze/odi subjektov
(ljudi) in izostri samo njihove obraze/

o¢i. Ce videokamera ne zazna obraza/

odi, se samodejno ostrenje za¢asno ustavi
(MF) in prikaZe se ikona [ (stran 11), ki
oznacuje, da je nacin samodejnega ostrenja

z zaznavanjem obrazov Face/Eye Only AF
zacasno ustavljen. Ta nacin je koristen takrat,
ko Zelite samodejno izostriti samo obraze/oci.

Face/Eye Priority AF:

Videokamera zaznava obraze/oci subjektov
(ljudi) in prednostno izostri obraze/o¢i. Ce
videokamera ne zazna obraza ali odi, izostri
v nacinu samodejnega ostrenja (privzeta
nastavitev).

Off:

Funkcija samodejnega ostrenja z zaznavanjem

obrazov/odi je onemogocena.

[Opombe]

e Med uporabo funkcije Push Auto Focus, je nacin Face/
Eye Priority AF aktiviran, tudi Ce je trenutno izbran
nacin Face/Eye Only AF.

e Ko je stikalo FOCUS nastavljeno na MAN, je samodejno
ostrenje z zaznavanjem obrazov/oc¢i onemogoceno
(razen med uporabo funkcije Push Auto Focus).

o (e izklopite videokamero medtem, ko je izbran nacin
Face/Eye Only AF, bo videokamera ob naslednjem vklopu
samodejno preklopila v nacin Face/Eye Priority AF.

e Med uporabo funkcije Clear Image Zoom
videokamera ne podpira nacina Face/Eye AF. Vklopi
se obicajno samodejno ostrenje.

Skrivanje okvirjev za zaznavanje
obrazov/o(i

Okvirje za zaznavanje obrazov/oci lahko
prikaZete/skrijete z moznostjo Display On/

Off > Face/Eye Detection Frame (stran 87) v
meniju Monitoring glavnega menija.

[Opombal]

Zeleni okvirji za zaznavanje obrazov/o¢i so prikazani za
obraze in odi, ki so izostreni z uporabo funkcije Push Auto
Focus (AF-S), in niso skriti z uporabo gumba DISPLAY ali
kadar je okvir zaznavanja obrazov/oci izklopljen.

Ostrenje na registrirani obraz

Med delovanjem samodejnega ostrenja z
zaznavanjem obrazov/oci lahko registrirate
obraz subjekta (osebe) za ostrenje tega obraza.
Registrirate lahko samo en obraz. Registriranje
obraza prepise trenutno registrirani obraz.

Ko je obraz registriran, se okvir za zaznavanje
obrazov/oci spremeni v dvojni okvir (okvir
registriranega obraza) in prikaZe se ikona
registriranega obraza & (stran 11).

V nacinu samodejnega ostrenja z
zaznavanjem obrazov/oci se glede na
kombinacijo registriranega obraza in
nacina delovanja samodejnega ostrenja z
zaznavanjem obrazov/oci, zgodi naslednje.

V nacinu Face/Eye Priority AF:

Ce videokamera zazna registrirani obraz,
izostri ta obraz. Ce videokamera ne zazna
obraza, se vklopi samodejno ostrenje z
zaznavanjem obrazov/odi.

V nacinu Face/Eye Only AF:

Ce videokamera zazna samo registrirani obraz,
izostri ta obraz/o¢i. Ce ne zazna registriranega
obraza, se samodejno ostrenje zacasno ustavi
(MF) in prikaZe se ikona [ (stran 11), ki

oznacuje, da je nacin samodejnega ostrenja z
zaznavanjem obrazov/oci Face Only AF zacasno
ustavljen. Ta nacin je koristen takrat, ko Zelite
samodejno ostriti samo registrirano osebo.

Nastavitev registriranega obraza
Z velfunkcijskim gumbom (stran 7)
premaknite kazalec za izbiro obraza (oranzni
podcrtaj) na obraz, ki ga Zelite registrirati, in
nato pritisnite vecfunkcijski gumb.

Drugi okvirji za zaznavanje obrazov/

odi (sivi)

Registriran
okvir obraza
(dvojni bel
okvir)

Kazalec za izbiro obraza (oranzen)

Brisanje registriranega obraza

Z vecfunkcijskim gumbom (stran 7)
premaknite kazalec za izbiro obraza na

okvir registriranega obraza, in nato pritisnite
vecfunkcijski gumb.

Registrirani obraz je izbrisan, okvir za
zaznavanje obraza/oci postane enojni okvir in
ikona registriranega obraza izgine.

Ko videokamera zazna obraze/oci in okvir
registriranega obraza ni prikazan, prikazan pa
je kazalec za izbiro obraza (oranzne barve),
lahko izbriSete registrirani obraz tako, da
dvakrat pritisnete vecfunkcijski gumb.

[Opombe]

e V stanju AF assist (stran 39) se izbira registriranega
obraza izbrise.

e Ko uporabljate funkcijo Clear Image Zoom, ne morete
uporabljati samodejnega ostrenja z zaznavanjem
obrazov/odi.

e Videokamera obrazov/oci morda ne bo zaznala, kar
je odvisno od snemalnega okolja, razmer subjekta ali
nastavitev.

e \/ nekaterih snemalnih okoljih morda ne boste
mogli doseci pravega ucinka. Zgodi tudi se lahko,
da bo kaksen drug objekt prepoznan kot ¢loveski
obraz. V tem primeru izklopite samodejno ostrenje z
zaznavanjem obrazov/odi.

e Priporo¢amo, da registracijo obraza Zelene osebe
izvedete pred snemanjem.

e Registracija obraza morda ne bo uspesna, na kar

lahko vplivajo stil priceske, licila ali ¢e oseba ne gleda

neposredno proti videokameri. V tem primeru se

lahko okvir za zaznavanje obrazov/o¢i spremeni v

dvojni okvir, vendar se ikona registriranega obraza ne

prikaZe in obraz ni registriran.

Ce je bil obraz 7e registriran, priporo¢amo, da izbridete

obstojeci obraz in opravite novo registracijo obraza.

Preklapljanje samodejnega ostrenja z
zaznavanjem obrazov/odi z uporabo
dodeljivega gumba

Dodelite samodejno ostrenje z zaznavanjem
obrazov/o¢i dodeljivemu gumbu

(stran 48). Zdaj lahko z vsakim pritiskom

na gumb preklapljate med nacini delovanja
samodejnega ostrenja z zaznavanjem

obrazov/oci v naslednjem vrstnem redu: Face/
Eye Priority AF, Face/Eye Only AF in Off.

Nastavljanje z uporabo neposrednega
menija
Delovanje samodejnega ostrenja z

zaznavanjem obrazov/oci lahko nastavite tudi
z uporabo neposrednega menija (stran 48).
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Prilagajanje svetlosti
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Svetlost lahko prilagodite s prilagajanjem
zaslonke, ojacitve in hitrosti zaklopa ter s
prilagajanjem kolicine svetlobe z uporabo
filtrov ND. Prilagoditve lahko opravite tudi
samodejno.

Ciljno raven za samodejno prilagajanje
svetlosti nastavite z moznostjo Auto Exposure
(stran 73) > Level v meniju Shooting

glavnega menija. Raven samodejne osvetlitve
lahko dodelite tudi dodeljivemu gumbu ali
dodeljivemu kolescu (stran 48).

[Opombal]

Ojacanja ne morete prilagajati v nacinu Cine El. Osnovna
obcutljivost je fiksna. Svetlosti ni mogoce samodejno
prilagajati z uporabo hitrosti zaklopa. Podprta je

samodejna prilagoditev svetlosti z uporabo zaslonke in
filtra ND.

Izbira osnovne obCutljivosti

Izbirate lahko med dvema tipoma osnovne
obcutljivosti.

V nacinu Custom lahko nastavite osnovno
obcutljivost na High ali Low s funkcijo Base
ISO/Sensitivity na zaslonu Main Status
(stran 13) ali zaslonu Camera Status

(stran 14) ali pa nastavite moznost ISO/
Gain/El >Base Sensitivity (stran 72) v meniju
Shooting glavnega menija.

V nacinu Cine El lahko nastavite osnovno
obcutljivost ISO na ISO 12800 ali ISO 800

s funkcijo Base ISO/Sensitivity na zaslonu
Main Status (stran 13) ali zaslonu Camera
Status (stran 14) ali pa nastavite moZnost
ISO/Gain/El >Base ISO (stran 72) v meniju
Shooting glavnega menija.

Priporocamo, da izberete nastavitev Low ali
ISO 800 v normalnih svetlobnih pogojih in

nastavitev High ali ISO 12800 ob Sibki svetlobi.

* Konfiguracija je mogoca tudi na zaslonu stanja.

[Nasvet]
Tudi funkcijo Base ISO/Sensitivity lahko dodelite
dodeljivemu gumbu (stran 48).

Prilagajanje zaslonke

S prilagajanjem zaslonke lahko prilagodite
svetlost.

Samodejno prilagajanje zaslonke

Ta funkcija prilagodi svetlost glede na subjekt.

Zahtevan je objektiv, ki podpira samodejno
zaslonko.

1 Ce je names$cen objektiv s stikalom Auto
Iris, prestavite stikalo v poloZaj AUTO.

2 Pritisnite in zadrZite funkcijski gumb IRIS
(E) za prikaz neposrednega menija
(stran 48) in izberite mozZnost Auto.

[Nasvet]

Funkcijo samodejnega prilagajanja zaslonke
Auto Iris lahko dodelite tudi dodeljivemu gumbu
(stran 48).

[Opombal]
Zaslonke ni mogoce samodejno prilagajati na
objektivih serije A.

Rocno prilagajanje zaslonke

1 Pritisnite in zadrZite funkcijski gumb IRIS
(E) za prikaz neposrednega menija
(stran 48) in izberite moZnost Manual.

2 Pritisnite funkcijski gumb IRIS (E), da je
vrednost zaslonke prikazana na belem
ozadju.

3 Zavrtite vecfunkcijsko kolesce, da
prilagodite vrednost.

[Nasveti]

o Vecfunkcijsko kolesce lahko uporabljate tudi
kot kolesce IRIS (stran 48) tako, da dodelite
funkcijo IRIS vec¢funkcijskemu kolescu.

e Funkcijo IRIS lahko dodelite tudi dodeljivemu
kolescu (stran 48).

Zacasno samodejno prilagajanje

Pritisnite dodeljiv gumb (stran 48), ki je
dodeljen funkciji Push Auto Iris za zacasno
samodejno prilagajanje zaslonke, medtem ko
je gumb pritisnjen.

Ko spustite gumb, se zaslonka vrne na prejsnjo
nastavitev.

[Opombal]

Ko je stikalo samodejne prilagoditve zaslonke na
objektivu nastavljeno na MANUAL, funkciji Auto Iris in

Push Auto Iris na videokameri nimata ucinka. Prav tako
nima ucinka ro¢no prilagajanje zaslonke na videokameri.

Prilagajanje ojacitve

V nacinu Custom lahko prilagodite ojacitev, da
prilagodite svetlost.

Samodejno prilagajanje ojacitve

Pritisnite funkcijski gumb ISO/GAIN (H) za
prikaz neposrednega menija (stran 48) in
izberite moZnost Auto.

[Nasveti]

e |sto lahko doseZete tako, da nastavite moZnost Auto
Exposure (stran 73) >AGC v meniju Shooting na On.

e Samodejno prilagajanje ojacitve AGC lahko dodelite
tudi dodeljivemu gumbu (stran 48).

Rocno prilagajanje ojaitve

Ojacitev lahko nadzorujete kadar Zelite
prilagoditi osvetlitev med uporabo fiksne
nastavitve zaslonke ali kadar Zelite prepreciti
povecanje ojacitve zaradi funkcije AGC.

1 Pritisnite in zadrZite funkcijski gumb ISO/
GAIN (H) za prikaz neposrednega menija
(stran 48) in izberite moznost Manual.

2 Stikalo ISO/GAIN (1) nastavite na H, M ali L.

[Nasveti]

e Funkcijo pritisk za AGC lahko dodelite dodeljivemu
gumbu in zacasno vklopite AGC tako, da pritisnete in
zadrZite gumb.

e Prednastavljeno vrednost vsakega poloZaja
stikala lahko spreminjate z moznostjo I1SO /
Gain<L>/<M>/<H> (stran 14) na zaslonu
Camera Status ali z moZnostjo ISO/Gain/El >ISO/
Gain<H>/<M>/<L> (stran 72) v meniju Shooting
glavnega menija.
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Upravljanje ojacitve (natancno
prilagajanje)

1 Pritisnite funkcijski gumb ISO/GAIN (H), da
je vrednost ojacitve prikazana na belem
ozadju.

2 Zavrtite vecfunkcijsko kolesce, da
prilagodite vrednost.

[Nasvet]
Prednastavljeno vrednost ojacitve spremenite v skladu z
nastavitvijo stikala ISO/GAIN ().

Zacasno upravljanje ojacitve (natancno
prilagajanje)

Zavrtite dodeljivo kolesce (stran 48) z
dodeljeno funkcijo ISO/Gain/El, da prilagodite
vrednost ojacitve, nastavljeno s stikalom ISO/
GAIN (1).

To je uporabno, kadar Zelite prilagoditi
osvetlitev za eno stopnjo brez spreminjanja
globinske ostrine.

Prilagojeno vrednost ojacitve preklicete s
preklopom stikala ISO/GAIN (J), spremembo
osnovne obcutljivosti, vklopom funkcije AGC
ali z izklopom videokamere.

[Nasveti]

e To funkcijo lahko dodelite tudi vecfunkcijskemu
kolescu (stran 48).

e Funkcijo pritisk za AGC lahko dodelite dodeljivemu
gumbu in zacasno vklopite AGC tako, da pritisnete in
zadrZite gumb.

Prilagajanje indeksa osvetlitve
(Exposure Index)

V nacinu Cine El se domneva, da je video izhod
z izklopljenim MLUT posnet kot glavni signal.

S spreminjanjem svetlosti slike z vklopljenim
MLUT, da ustreza vrednosti El, lahko med
snemanjem preverite rezultat prilagoditve
obcutljivosti osvetlitve za postprodukcijo.
Vrednost El lahko spremenite tako, da stikalo
ISO/GAIN (I) nastavite na H, M ali L.

[Nasvet]

Vrednost El vsakega poloZaja stikala lahko spreminjate
z moznostjo ISO/Gain/El (stran 14) na zaslonu

Camera Status ali z moZnostjo ISO/Gain/El >Exposure
Index<H>/<M>/<L> (stran 72) v meniju Shooting
glavnega menija.

Natancno prilagajanje indeksa osvetlitve

1 Pritisnite funkcijski gumb ISO/GAIN (H), da
je vrednost El prikazana na belem ozadju.

2 Zavrtite vecfunkcijsko kolesce, da
prilagodite vrednost.
[Nasvet]

Prednastavljeno vrednost El spremenite v skladu z
nastavitvijo stikala ISO/GAIN (I).

Prilagajanje zaklopa

S prilagajanjem zaklopa lahko prilagodite
svetlost.

Samodejno prilagajanje zaklopa

Pritisnite in zadrzite funkcijski gumb
SHUTTER (F) za prikaz neposrednega menija
(stran 48) in izberite moznost Auto za
samodejno prilagoditev hitrosti zaklopa ali
kota zaklopa glede na svetlost slike.

[Nasvet]

Isto lahko dosezete tako, da nastavite mozZnost Auto

Exposure >Auto Shutter (stran 74) v meniju Shooting
glavnega menija.

Rocno prilagajanje zaklopa

1 Pritisnite in zadrZite funkcijski gumb
SHUTTER (F) za prikaz neposrednega
menija (stran 48) in izberite moZnost
Speed ali Angle.

2 Pritisnite funkcijski gumb SHUTTER (F), da
se vrednost zaklopa prikaZe na belem
ozadju.

3 Zavrtite vecfunkcijsko kolesce, da
prilagodite hitrost zaklopa.

[Nasveti]

e Za nastavitev Casa osvetlitve, ki se ujema z intervalom
slicice, v koraku 1 izberite Off.

e Nastavite lahko tudi kot in prilagodite frekvenco
(stran 72).

Prilagajanje koli¢ine svetlobe
(filter ND)

V razmerah, ko je svetlobe preve¢, lahko
primerno svetlost nastavite z uporabo filtra
ND.

Videokamera ima dva nacina filtra ND. Med
njima lahko preklapljate s stikalom ND
PRESET/VARIABLE.

Prilagajanje v prednastavljenem nacinu

Prestavite stikalo (A) ND PRESET/VARIABLE v
polozaj PRESET in s smernima gumboma (B)
ND FILTER POSITION izberite eno od sledecih
nastavitev.

Clear: Brez filtra ND

1: Prepustnost svetlobe, nastavljena z
moznostjo ND Filter >Preset1 (stran 72) v
meniju Shooting glavnega menija.

2: Prepustnost svetlobe, nastavljena z
moznostjo ND Filter >Preset2 (stran 72) v
meniju Shooting glavnega menija.

3: Prepustnost svetlobe, nastavljena z
moznostjo ND Filter >Preset3 (stran 72) v
meniju Shooting glavnega menija.

Prilagajanje v variabilnem nacinu

Prestavite stikalo (A) ND PRESET/VARIABLE v
polozaj VARIABLE. S smernima gumboma (B)
ND FILTER POSITION izberite CLEAR ali On.

Samodejno prilagajanje koli¢ine svetlobe

Za vklop samodejnega prilagajanja osvetlitve
z uporabo filtra ND nastavite moznost Auto ND
Filter na On.

1 Pritisnite gumb [+] izmed smernih
gumbov ND FILTER POSITION (B) za vklop
filtra ND.
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2 Pritisnite in zadrzite gumb (C) ND
VARIABLE AUTO, dokler ni izbran nacin
Auto.

Rocno prilagajanije koli¢ine svetlobe

1 Pritisnite gumb [+] izmed smernih
gumbov ND FILTER POSITION (B) za vklop
filtra ND.

2 Pritisnite in zadrZite gumb (C) ND
VARIABLE AUTO, dokler ni izbran nacin
Manual.

3 Zavrtite kolesce (D) ND VARIABLE in
nastavite prepustnost filtra.

[Nasvet]
Funkcijo filtra ND lahko dodelite tudi dodeljivemu
kolescu (stran 48).

Zacasno samodejno prilagajanje

Funkcijo Push Auto ND lahko dodelite
dodeljivemu gumbu (stran 48) in zacasno
vklopite filter ND tako, da pritisnete in zadrZite
gumb. Ko spustite gumb, se samodejni filter
ND izklopi.

Pritisnite gumb [+] izmed smernih gumbov ND
FILTER POSITION (B) za vklop filtra ND.

[Opombal]

Ce filter ND med snemanjem preklopite v ali iz poloZaja
CLEAR, se okvir filtra ND prikaZe na sliki. Posname se tudi
zvok, ki ga povzroci izklop/vklop filtra ND.

[Nasveti]

e V poloZaj CLEAR lahko preklopite tako, da zavrtite
kolesce ND VARIABLE (D) nizje od ND1/4. Ce zavrtite
kolesce visje od poloZaja CLEAR, nastavite filter na
vrednost ND1/4. Taksno delovanje lahko onemogocite
z uporabo moZnosti ND Dial >CLEAR with Dial
(stran 93) v meniju Technical glavnega menija.

e Funkcijo ND Filter Position lahko tudi dodelite
dodeljivemu gumbu (stran 48) in namesto, da za
spremembo nastavitve uporabljate gumba navzgor/
navzdol ND FILTER POSITION, pritisnete ta gumb.
Prednastavljeni nacin: Clear — Preset1 — Preset2 —
Preset3 — Clear...

Variabilni nacin: Clear — On — Clear ...

e Samodejni filter ND lahko dodelite dodeljivemu
gumbu (stran 48) in s pritiskom nanj vklapljate in
izklapljate samodejni filter ND.

e Pri snemanju moc¢no osvetljenih subjektov lahko
preveliko zapiranje zaslonke privede do difrakcije
in s tem zamegljenosti slike, kar ustvarja vtis slabe
izostritve (tipi¢en pojav pri videokamerah). Ta u¢inek
lahko zmanjsate in dobite boljse rezultate snemanja z
uporabo filtra ND.
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Prilagajanje za naravne barve (White Balance)
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Izberete lahko prilagoditveni nacin, ki ustreza
razmeram snemanja.

=

ATW (Auto Tracing White Balance)

Ta funkcija samodejno prilagodi belino, tako
da je ta ustrezna.

Ko se temperatura svetlobe spremeni, se
belina samodejno prilagodi.

Pritisnite in zadrzite funkcijski gumb WHT
BAL (G) za prikaz neposrednega menija
(stran 48) in izberite moZnost ATW.
Izberete lahko hitrost prilagajanja (pet
korakov) z uporabo moZnosti White Setting
> ATW Speed (stran 74) v meniju Shooting
glavnega menija.

[Nasvet]

Trenutno nastavitev beline lahko zamrznete tako,
da dodeljivemu gumbu dodelite funkcijo ATW Hold
(stran 48) in pritisnete dodeljivi gumb za zacasno
prekinitev nac¢ina ATW.

[Opombe]
e Funkcije ATW ni mogoce uporabljati v nacinu Cine El.
e Glede na osvetlitev in razmere subjekta s funkcijo
ATW morda ne bo mogoce nastaviti primerne barve.
Primeri:
- Kadar prevladuje ena barva subjekta, kot na primer
pri nebu, morju, zemlji ali roZah.
- Kadar je temperatura barve izjemno visoka ali
izjemno nizka.
Ce ne morete dosedi Zelenega ucinka, ker je hitrost
samodejnega sledenja ATW prenizka ali zaradi drugih
razlogov, zaZenite samodejno nastavitev beline.

Rocno prilagajanje beline

1 Ko je nastavitev beline nastavljena na
nacin ATW, pritisnite in zadrzite funkcijski
gumb WHT BAL (G) za prikaz
neposrednega menija (stran 48) in
izberite moznost W:P, W:A, or W:B.

2 S stikalom WHT BAL (J) izberite B, A ali
PRESET.
B: Nacin pomnilnika B
A: Nacin pomnilnika A
PRESET: Prednastavljeni nacin
[Nasvet]
ATW lahko omogocite za pomnilnik B tako, da nastavite

moznost White Setting > White Switch<B> (stran 74) v
meniju Shooting glavnega menija na ATW.

Nacin Memory A/Memory B
Ta nacin prilagodi belino na nastavitey, ki je
shranjena v pomnilniku A ali B.

Prednastavljeni nacin

Ta nacin prilagodi temperaturo barve na
prednastavljeno vrednost (tovarnisko privzeta
vrednost je 3200 K).

Spreminjanje privzete prednastavljene
vrednosti

V prednastavljenem nacinu lahko neposredno
spremenite obstojeco prednastavljeno
vrednost.
Pritisnite in zadrzite funkcijski gumb WHT BAL
(G) in izberite eno od naslednjih mozZnosti v
neposrednem meniju.
Nacin Custom: — 3200K, — 4300K,

— 5600K, — 6300K
Nacin Cine El: — 3200K, — 4300K, — 5500K

[Nasvet]

Prednastavljeno izbiro beline lahko tudi dodelite

dodeljivemu gumbu (stran 48) in nato pritisnete

gumb za spremembo nastavitve.

Nacin Custom: 3200K — 4300K — 5600K — 6300K
— 3200K...

Nacin Cine El: 3200K — 4300K — 5500K — 3200K...

Spreminjanje temperature barve

1 Pritisnite funkcijski gumb WHT BAL (G), da
se vrednost temperature barve prikaze na
belem ozadju.

2 Zavrtite vecfunkcijsko kolesce, da
prilagodite vrednost.

[Nasveti]

e V prednastavljenem nacinu lahko nastavljate vrednost
v korakih po 100 K.

e V pomnilniskem nacinu lahko nastavljate vrednost
v korakih po 20 K v razponu od 2000 K do 5600 K.
Vrednosti nad 5600 K lahko nastavite v intervalih,
ki so ustrezajo koli¢ini barvne spremembe (mired)
od 5580 K do 5600K. Nastavite lahko tudi vrednost
odtenka z uporabo moznosti White (stran 74) > Tint
v meniju Shooting glavnega menija.

Potek samodejne nastavitve belin

Nastavitev beline, ki se shrani v nac¢inu
pomnilnika A/pomnilnika B, se opravi
samodejno.

1 Izberite pomnilniski nacin A ali
pomnilniski nacin B.

2 PoloZite bel list papirja (ali drug bel
predmet) na mesto z enakim virom
svetlobe in enakimi svetlobnimi
razmerami, kot veljajo za subjekt. Nato z
objektivom pribliZajte papir, tako da
zapolnjuje sliko na zaslonu.

3 Prilagodite svetlost.
Prilagodite zaslonko z uporabo postopka,
opisanega v razdelku »Ro¢no prilagajanje
zaslonke« (stran 42).

4 Pritisnite gumb WB SET (stran 4).

o Ce nastavitev beline opravljate v
pomnilniskem nacinu, se vrednost
nastavitve shrani v pomnilnik (A ali B),
izbran v 1. koraku.

e Ce nastavitev beline opravljate v
nacinu ATW, se po opravljeni nastavitvi
videokamera vrne nazaj v nacin
nastavljanja beline ATW.

[ppomba]

Ce prilagoditev ni uspesna, se na zasloqu za priblizno
tri sekunde prikaZe sporocilo o napaki. Ce se sporocilo
o napaki prikaZe vsakokrat tudi po ve¢ ponovljenih

poskusih nastavitve beline, stopite v stik s servisnim
predstavnikom podjetja Sony.
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Nastavitev zvoka, ki ga zelite posneti

Zvok, ki ga Zelite posneti, lahko izberete z
uporabo vhodnih priklju¢koy, stikal in kolesc

na videokameri.

Zunanji vhodni avdio prikljucki in izbirna

stikala

Prikljucek INPUT1 (stran 7)

Priklju¢ek INPUT2 (stran 7)
Vecvmesniski nastavek (stran 7)
Stikalo INPUT1 (LINE/MIC/MIC+48 V)
(stran 7)

Stikalo INPUT2 (LINE/MIC/MIC+48 V)
(stran 7)

Stikala za nastavitev ravni zvoka

Stikalo CH1 (AUTO/MAN) (stran 6)
Stikalo CH2 (AUTO/MAN) (stran 6)
Kolesce AUDIO LEVEL (CH1) (stran 6)
Kolesce AUDIO LEVEL (CH2) (stran 6)

Zaslon stanja zvoka

INPUT1
MIC +48V

INPUT2
MIC +48V

Int MIC

INPUTA

MIC +48V @i

CH1/CH2 0

CH1/CH2

Izbira vhodne avdio naprave

Nastavite zvoc¢ni vhod z moznostjo CH1/
CH2/CH3/CH4 >Source (stran 14) na
zaslonu Audio Status ali moZnostjo Audio
Input >CH1 Input Select na CH4 Input
Select (stran 90) v meniju Audio
glavnega menija.

Ce uporabljate mikrofon, ki se namesti na
veCvmesniski nastavek, adapter XLR ali
napravo UWP (brezZi¢ni mikrofon UHF), na
enak nacin izberite SHOE CH1 ali SHOE
CH2. Za podrobnosti o adapterju XLR,
glejte razdelek »Dodajanje vhodnih avdio
prikljuckov« (stran 47).

[Opombe]

e Zvok se ne snema v nacinu Interval Rec ali v
nacinu Slow & Quick Motion.

e Videokamera ima vgrajen vokalni mikrofon za
snemanje ambientalnega zvoka. Uporabite ga
lahko za ¢asovno sinhronizacijo z ostalo opremo.
V taksnih primerih izberite moznost Internal MIC.

e Ko pritrdite drZalo, se za snemanje zvoka vklopi
samo notranji mikrofon v drzalu (stran 7).

Ko drZalo ni pritrjeno, lahko uporabite vokalni
mikrofon (stran 6) za snemanje zvoka v
okolici.

e Ko sta mozZnosti CH1 Input Select in CH2 Input
Select nastavljeni na Internal MIC, raven
snemanja zvoka CH1in CH2 prilagajate s
kolescem AUDIO LEVEL(CH1) (stran 6). Ko sta
moznosti CH3 Input Select in CH4 Input Select
nastavljeni na Internal MIC, raven snemanja zvoka
CH3 in CH4 prilagajate z moZnostjo CH3 Input
Level (stran 90).

2 Izberite vhodni vir zvoka.
Nastavite stikali INPUT1/INPUT2 (LINE/
MIC/MIC+48V) tako, da nastavitve
ustrezajo napravam, priklopljenim na
prikljuc¢ka INPUT1/INPUT2.

Povezana naprava Polozaj stikala

Zunaniji vir zvoka (npr. LINE
mesalna miza)
Dinami¢ni mikrofon, MIC

baterijski mikrofon

Mikrofon z +48 V
fantomskim napajanjem

MIC+48V

® 7 izbiro MIC+48 V in priklopom
mikrofona, ki ni zdruZljiv z napetostjo
+48 V, lahko poskodujete prikljuc¢eno
napravo. Pred priklopom naprave
preverite nastavitev.

o Ce se Zelite izogniti Sumu na prikljucku,
na katerega ni priklopljena nobena
naprava, nastavite ustrezno stikalo
INPUTT/INPUT2 (LINE/MIC/MIC+48 V) na
LINE.

Samodejno prilagajanje ravni
zvoka pri snemanju

Za kanal, za katerega Zelite samodejno
prilagajanje, nastavite stikalo CH1/CH2 (AUTO/
MAN) na AUTO.

Za CH3/CH4 nastavite uravnavanje ravni zvoka
na zaslonu Audio Status (stran 14) ali pa
nastavite moznost Audio Input >CH3 Level
Control in CH4 Level Control v meniju Audio
glavnega menija na Auto (stran 90).

Rocno prilagajanje ravni zvoka pri
snemanju

Uporabite sledec postopek za prilagoditev
ravni zvoka za CH1/CH2.

1

Za kanal, za katerega Zelite ro¢no
prilagoditi raven zvoka, nastavite stikalo
CH1/CH2 (AUTO/MAN) na MAN.

Med snemanjem ali v stanju
pripravljenosti zavrtite kolesce AUDIO
LEVEL (CH1)/(CH2) ustreznega kanala in
nastavite raven zvoka.

e Za CH3/CH4 nastavite uravnavanje
ravni zvoka z CH3/CH4 (stran 14) na
zaslonu Audio Status ali pa nastavite
moznost Audio Input >CH3 Level Control
ali CH4 Level Control v meniju Audio
glavnega menija na Manual, nato pa
prilagodite raven snemanja zvoka z
moznostjo CH3 Input Level ali CH4 Input
Level.

e Ravni zvoka za kanale CH1 do CH4 lahko
nastavite skupinsko. Raven snemanja
lahko nastavite z dodeljivim kolescem
(stran 48), ki ste mu dodelili funkcijo
Audio Input Level, zaslonom Audio
Status ali z uporabo moznosti Audio
Input >Audio Input Level v meniju Audio
glavnega menija.

[Nasvet]
Zaslon Audio Status je priroCen za preverjanje ravni
vhodnega zvoka (stran 14).

[Opombe]

Nastavitev ravni zvoka je lahko onemogocena, kar je
odvisno od kombinacije nastavitev v meniju Audio. Za
podrobnosti glejte diagram na 124.

Videokamera podpira kombinacije razli¢nih
nastavitev. Za podrobnosti glejte diagram na 124.
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Dodajanje vhodnih avdio
prikljuckov

Na videokamero lahko z uporabo adapterja
XLR XLR-K2M (ni priloZzen) ali adapterja XLR
XLR-K3M (ni priloZen) isto¢asno priklopite do
Stiri kanale zvoc¢nih naprav XLR.

Namestite adapter XLR na ve¢vmesniski

nastavek in na zaslonu Audio Status

(stran 14) nastavite moZnost CH3 >Source

na Shoe CH1in CH4 >Source na Shoe CH2. Ali

pa nastavite moznost Audio Input > CH3 Input

Select na Shoe CH1in CH4 Input Select na

Shoe CH2 v meniju Audio glavnega menija.

Funkcije videokamere, ki se prekrivajo,

bodo onemogocdene za kanale, na katerih

je kot vhod izbran adapter XLR. Za izvedbo

prilagoditev uporabite stikala in kolesca na

adapterju XLR.

[Opombe]

e Videokamera podpira digitalni 2-kanalni zvo¢ni
\{mesnik XLR-K3M.

e (e sta moZnosti Audio Input > CH3 Level in CH4
Level v meniju Audio nastavljeni na Audio Input
Level, bo moZnost Audio Input Level na videokameri
nastavljena tako, da bo ustrezala ravni, nastavljeni na
adapterju XLR.

Raven avdio vhoda je omogocena tudi, ko je stikalo

adapterja XLR nastavljeno na AUTO.

Ko je izbrana moznost »Through, bo zvok posnet z

ravnjo, ki je nastavljena na adapterju XLR (stran 125).
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Uporabne funkcije

Upravljanje z neposrednim
menijem

Stanje in nastavitve videokamere lahko
preverite na zaslonu iskala in tam neposredno
izbirate in spreminjate nastavitve.
Nastavite lahko naslednje elemente.
e AF z zaznavanjem obrazov/oci
SteadyShot

White Mode

Color Temp

Scene File

ND Filter Position/Auto ND Filter
ND Filter Value

Auto Iris

Iris Value

AGC

Gain Value

ISO Value

El Gain Value

Auto Shutter

Shutter Value

Auto Exposure Mode

Auto Exposure Level

S&Q Motion Frame Rate

_—) @ 0 0 O O O o 0 o o o o o o o o

Pritisnite vecfunkcijsko kolesce ali dodeljiv
gumb z dodeljeno funkcijo neposrednega
menija.

Z oranznim kazalcem lahko izberete samo
tiste moznosti, ki jih je mogoce nastavljati
z uporabo neposrednega menija.

2 Zavrtite vecfunkcijsko kolesce, da
premaknete kazalec na moznost v meniju,
ki jo Zelite nastaviti in nato pritisnite
vecfunkcijsko kolesce.

PrikaZe se meni ali izbrana moZnost na
belem ozadju.

3 Zavrtite vecfunkcijsko kolesce, da izberete
nastavitev in nato pritisnite vecfunkcijsko
kolesce.

Meni ali belo ozadje izgine in nova
nastavitev se prikaze z oranznim
kazalcem.

Za izhod iz neposrednega menija
ponovno pritisnite dodeljiv gumb z
dodeljeno funkcijo neposrednega menija
ali pocakajte 3 sekunde.

[Nasveti]

e Neposredne nastavitve lahko nastavljate tudi
tako, da pritisnete in zadrZite vsakega od
funkcijskih gumbov (stran 5).

e Ko se na belem ozadju prikazejo moznosti, lahko
uporabite vecfunkcijsko kolesce kot dodeljivo
kolesce.

e Zaizbiro moZnosti lahko uporabite tudi
vecfunkcijski gumb (stran 9).

Dodeljivi gumbi/kolesca

Na videokameri je devet dodeljivih gumbov
(6,7,9), ki jim lahko dodelite funkcije.

Funkcije lahko dodelite tudi vefunkcijskemu
kolescu na videokameri (stran 5),
dodeljivemu kolescu na rocaju (stran 7)

in dodeljivemu kolescu na drzalu z daljinskim
upravljalnikom (stran 9).

Spreminjanje funkcije gumba

Uporabite moznost Assignable Button
(stran 79) v meniju Project glavnega menija.
Dodeljene funkcije lahko vidite na zaslonu
Assignable Button Status (stran 15).

Tovarnisko privzeta dodelitev funkcij
dodeljivim gumbom

Gumb 1 S&Q Motion

Gumb 2 AF Speed/Sens.
Gumb 3 Focus Setting

Gumb 4 Focus Magnifier x3/x6
Gumb 5 Direct Menu

Gumb 6 Off

Gumb 7 Focus Magnifier x3/x6
Gumb 8 Direct Menu

Gumb 9 Video Signal Monitor

Gumb Focus Hold  Focus Hold

Dodeljive funkcije

Off

Base ISO/Sensitivity
AGC

Push AGC

ND Filter Position
Auto ND Filter

Push Auto ND

Auto Iris

Push Auto Iris

Auto Shutter

Auto Exposure Level
Backlight

Spotlight

Preset White Select
ATW

ATW Hold

AF Speed/Sens.
Focus Setting

Focus Area

Focus Area(AF-S)

AF z zaznavanjem obrazov/oci
Push AF Mode

Push AF/Push MF
Focus Hold

Focus Magnifier x3/x6
Focus Magnifier x3
Focus Magnifier x6
S&Q Motion
SteadyShot

Rec

Rec Review

Clip Flag OK

Clip Flag NG

Clip Flag Keep

Color Bars

Tally [Front]
DURATION/TC/U-BIT
Display

Lens Info

Video Signal Monitor
Marker

VF Adjust

VF Mode

Gamma Display Assist
Peaking

Zebra

Glasnost

Thumbnail (Slic¢ica)
Touch Operation
Handle Zoom

NFC

Auto Upload (Proxy)
Direct Menu

Meni User

Menu

Spreminjanje funkcije kolesca

Spremenite lahko funkcijo vecfunkcijskega
kolesca na videokameri, dodeljivega kolesca
na drzalu in dodeljivega kolesca na rocaju.

Funkcijo vecfunkcijskega kolesca nastavite
z uporabo moznosti Multi Function Dial
(stran 81) >Default Function v meniju
Project.

Tovarnisko privzeta nastavitev je izklopljeno.
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Funkcije, ki jih lahko dodelite vecfunkcijskemu

kolescu

e Off

ISO/Gain/El

IRIS

Auto Exposure Level
Audio Input Level

[Opombal]
Nastavitev je onemogocena med prikazom menija.

Za dodeljivo kolesce uporabite moznost
Assignable Dial (stran 81) v meniju Project
glavnega menija.

Funkcija IRIS je tovarnisko privzeto dodeljena
vsem.

[Nasvet]
Dodeljivo kolesce RM-30BP (dodatna moznost) uposteva
nastavitve kolesca na drZalu/daljinskem upravljalniku.

Funkcije, ki so dodeljive dodeljivemu kolescu
na rocaju

Off

ISO/Gain/El

ND Filter

IRIS

e Auto Exposure Level

e Audio Input Level

e Multi Function Dial

Funkcije, ki so dodeljive dodeljivemu kolescu
na drzalu

Off

ISO/Gain/El

ND Filter

IRIS

Auto Exposure Level

e Audio Input Level

Dodeljene funkcije lahko vidite na zaslonu
Assignable Button Status (stran 15).

Pocasni in hitri posnetki

Ko je format snemanja (stran 77) nastavljen na sledece vrednosti, lahko dolocite drugacne
vrednosti za hitrost slicic pri snemanju in hitrost slicic pri predvajanju.

Format zapisovanja

Hitrost slicic

Sistemska Nacin zajema Kodek video format
frekvenca slike
59.94/50/29.97/ FF RAW 3840x2160P 1-60
25/23.98 RAW & XAVC-I 3840x2160P 1-60
XAVC-| 4096x2160P 1-60
3840x2160P 1-60, 100, 120
1920x1080P 1-60, 100, 120, 150,
180, 200, 240
XAVC-L 3840x2160P 1-60, 100, 120
1920x1080P 1-60, 100, 120, 150,
180, 200, 240
S35 XAVC-| 1920x1080P 1-60, 100, 120
XAVC-L 1920x1080P 1-60, 100, 120
24 FF XAVC-I 4096x2160P 1-60

Nacin hitrih in pocasnih posnetkov lahko
vklopite/izklopite s pritiskom dodeljivega
gumba (stran 48) z dodeljeno funkcijo hitrih

in pocasnih posnetkov.

Hitrost slicic za snemanje lahko nastavite tako,
da pritisnete in zadrzite gumb.

[Opombe]

e Hitrega in po¢asnega snemanja ne morete nastaviti
med snemanjem, predvajanjem ali kadar je prikazan
zaslon slicic.

e V nacinu hitrih in pocasnih posnetkov ni podprto
snemanje zvoka.

e V nacinu hitrih in pocasnih posnetkov so
onemogocene funkcije samodejnega ostrenja,
samodejne zaslonke in samodejnega zaklopa.
Funkcijo samodejnega ostrenja lahko uporabite, ko je
hitrost sli¢ic nastavljena na naslednje vrednosti.

Sistemska frekvenca Hitrost slicic

59,94/29,97/23,98 30, 60, 120, 240

50/25 25,50, 100, 200

e Podrobnosti o uporabi izhodnega formata RAW si
oglejte v 55.

Video snemanje s prekinitvami
(intervalno snemanje)

Funkcija intervalnega snemanja vam omogoca,
da zajamete videoposnetek s ¢asovnim
preskokom na notranji pomnilnik videokamere.
Ta funkcija predstavlja uc¢inkovit nacin za
snemanje pocasi premikajocih se subjektov.
Ko zacnete snemati, videokamera samodejno
posname doloceno Stevilo slic¢ic na dolocen
casovni interval.

Interval snemanja (dolZina intervala)

!—‘—\

e

§}evi|o sli¢ic v enem posnetku
(Stevilo slicic)

Ko je intervalno snemanje vklopljeno, se pred
zaCetkom snemanja samodejno vklopi video
lu¢ HVL-LBPC (moZnost), kar vam omogoca, da
posnamete video v stabilni svetlobi s stabilno
temperaturo barve (funkcija predosvetlitve).
[Opombe]
e Naenkrat lahko uporabljate samo eno funkcijo
posebnega nacina snemanja, kot je intervalno snemanje.
o Ce med intervalnim snemanjem vklopite drugo
funkcijo posebnega nacina snemanja, se intervalno
snemanje samodejno izklopi.
Nacin intervalnega snemanja se samodejno izklopi,
Ce spremenite sistemske nastavitve, kot je na primer
video format.
Intervalnega snemanja ne morete nastaviti med
snemanjem, predvajanjem ali kadar je prikazan zaslon
slicic.
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Nastavitev intervalnega snemanja

Vklopite moznost Interval Rec (stran 78)

>Setting v meniju Project glavnega menija

in nastavite moznosti Number of Frames in

Interval Time.

Ce uporabljate video lu¢ HVL-LBPC (moZnost),

nastavite ¢asovni interval za vklop video luci

pred zacetkom snemanja. To storite z uporabo
moznosti Interval Rec >Pre-Lighting v meniju

Project, kot je zahtevano.

[Opombe]

o (e 7elite vklopiti video lu¢ pred zacetkom snemanja,
nastavite stikalo video luci na AUTO. Video luc se
vklopi in izklopi samodejno glede na nastavitev
moznosti Video Light Set (stran 94) v meniju
Technical.

o Ce vklopite stikalo video Iu¢i, bo video lu¢ vedno
svetila (video lu¢ se ne bo vklopila/izklopila
samodejno).

o (e je video lu¢ nastavljena tako, da se izklopi za 5
sekund ali manj, se ne bo izklopila.

Ko videokamero izklopite, se nacin
intervalnega snemanja izklopi, medtem pa
nastavljeno Stevilo slic¢ic in ¢asovni interval

ter nastavitve predosvetlitve ostanejo
shranjene. Tako vam jih naslednji¢, ko snemate
v intervalnem nacinu snemanja, ni treba
ponovno nastavljati.

Snemanje z uporabo funkcije
intervalnega snemanja

Za zaCetek snemanja pritisnite gumb za
snemanje START/STOP. V iskalu se izmenjaje
prikazujeta oznaki »Int @Rec« in »Int @Stby«.
Ce uporabljate funkcijo predosvetlitve, se pred
zacCetkom snemanija vklopi video luc.

Zaustavitev snemanja

Ustavite snemanje.

Ko je snemanje zakljuc¢eno, se video posnetki,
ki so se do tega trenutka shranili v pomnilnik,
zapisejo na pomnilniski medij.

Izhod iz naCina intervalnega snemanja

Naredite nekaj od sledecega.

e Prestavite stikalo POWER v polozaj za izklop.

e Ko je videokamera v stanju pripravljenosti,
nastavite moznost set Interval Rec >Setting
v meniju Project na izklopljeno.

Nacin intervalnega snemanja ostane izklopljen

tudi, ko ponovno zazenete videokamero.

Omejitve med snemanjem

e Zvok se ne posname.
e Ogled posnetka (Rec Review) ni mogoc.

Ce med snemanjem izklopite
videokamero

o (e stikalo POWER na videokameri prestavite
v poloZaj izklopljeno, videokamera Se nekaj
sekund dostopa do pomnilniskega medija,
da nanj zapiSe posnetke, ki so se do tistega
trenutka shranili v notranji pomnilnik. Nato
se samodejno izklopi.

e Ce pride do prekinitve napajanja zaradi
odstranitve baterije, odklopa napajalnega
kabla DC ali izklopa napajanja na omreznem
napajalniku, se video in zvoc¢ni posnetki,
narejeni do tega trenutka, lahko izgubijo
(najvec 10 sekund). Menjavo baterije
opravite pazljivo.

Socasno snemanje na pomnilniski
kartici A in B (2-slot Simul Rec)

Socasno lahko snemate na obe pomnilniski
kartici, A in B, ¢e vklopite moznost Simul Rec
(stran 14) na zaslonu Project status ali Simul
Rec > Setting (stran 78) v meniju Project
glavnega menija.

Video Signal Monitor

Nastavite lahko tip video signala za prikaz

v iskalu - valovna oblika, vektorskop ali
histogram. To storite z uporabo moznosti
Display On/Off >Video Signal Monitor
(stran 88) v meniju Monitoring.

Oranzna ¢rta oznacuje nastavljeno vrednost
na ravni Zebra.

Nadzorovanje ciljnega zaslona

V nacinu Cine El je podatek o nastavitvi
barvnega prostora (stran 24) ali nastavitvi

LUT (stran 76) prikazan v zgornjem desnem
delu zaslona video signala, s ¢imer je oznacen
cilj nadzorovanja.

LUT 709

78901284667890123466
ND Clear ANEX.T8 A

Clip Flags

Zastavico posnetka OK lahko dodate posnetku,
Ce pritisnete gumb Clip Flag (stran 5) in
izberete moznost Add OK.

Zastavico posnetka lahko izbrisete tako, da
dvakrat pritisnete gumb in izberete moZnost
Delete Clip Flag.

[Nasveti]

e Za dodajanje zastavic posnetkov lahko uporabite

tudi dodeljiv gumb, ki je dodeljen funkciji zastavice
posnetka (stran 48).

Zastavico posnetka lahko dodate tudi z moZnostjo Set
Clip Flag (stran 92) v meniju Thumbnail glavnega
menija (stran 65).



57st

3 Snemanje

Snemanje proxy

Ta funkcija vam omogoca, da hkrati
posnamete podatke proxy z nizko locljivostjo
in videoposnetek z izvornimi podatki v visoki
locljivosti.

Za podrobnosti o podprtih pomnilniskih karticah,
formatiranju pomnilniskih kartic in preverjanju preostale

kapacitete glejte razdelek »Uporaba pomnilniskih kartic«
(stran 26).

Konfiguriranje pred snemanjem

1 Vklopite moZnost Proxy Rec (stran 14)
na zaslonu Project ali moznost Proxy Rec >
Setting (stran 78) v meniju Project
glavnega menija.

2 Vstavite pomnilnisko kartico v reZo za

kartice CFexpress tipa A/SD (stran 7).

e Pri karticah CFexpress mora biti nalepka
na levi strani.

e Pri karticah SD mora biti nalepka na
desni strani, z zaobljenim vogalom na
dnu.

[Opombal]
Funkcije Proxy Rec ne morete vklopiti hkrati s funkcijama

S&Q Motion ali Interval Rec. Ko je snemanje proxy
vklopljeno, se ti nacini snemanja prisilno izklopijo.

Snemanje posnetka proxy

Pritisnite gumb za snemanje START/STOP, Ce
Zelite zaceti snemati po dokoncanju potrebnih
nastavitev za snemanje.

[Opombe]

e Celovitost podatkov na kartici ne bo zagotovljena,
Ce izklopite videokamero ali odstranite pomnilnisko
kartico medtem, ko je dostop do kartice Se v teku. Vsi
podatki, zapisani na kartici, se lahko zavrzejo. Vedno
se prepricajte, da je indikator dostopa do pomnilniske
kartice izklopljen preden izklopite videokamero ali
odstranite pomnilnisko kartico.

e Pazite, da pomnilniska kartica ne izskoci, ko jo vstavite
ali odstranite.

Za izhod ustavite snemanje.

Mesto shranjevanja posnete
datoteke

Zapisana datoteka se shrani v naslednji
imenik.

Zapisovalni medij Pot mape
SDXC /PRIVATE/XDROOT/Sub
CFexpress Type A /XDROOT/Sub

Nastavitev moznosti Audio
Channel za proxy snemanje

Izberite mozZnost Proxy Rec > Audio Channel
(stran 78) v meniju Project glavnega menija
in nastavite avdio kanal za proxy zapisovanje
podatkov.

O posneti datoteki

Koncnica imena datoteke je ». mp4«.
Socasno se posname tudi ¢asovna koda.

O imenu datoteke

Ime datoteke je sestavljeno iz imena posnetka,
shranjenega na pomnilnisko kartico, in
pripone »S03«.

Za podrobnosti o imenih posnetkov glejte
moznost Clip Name Format (stran 86) v

meniju TC/Media glavnega menija.
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Snemanje s funkcijo Desired Look

Ko je videokamera v nacinu Custom, lahko

dodate prilagoditve parametrom black, matrix

in drugim ter tako ustvarite »videz, ki temelji
na osnovnem videzu.

Matrix

Videz — it

Osnovni videz

Hitro lahko tudi izberete drugacen videz tako,
da shranite razli¢cne kombinacije nastavitev v
datotekah s prizorom.

V videokameri je privzeto na voljo Sest
prednastavljenih videzov.

Izbiranje videza

1 Ko je prikazan zaslon za snemanje,
pritisnite vecfunkcijsko kolesce.

2 Izberite ikono SCN.
3 Pritisnite vecfunkcijsko kolesce.

4 V meniju izberite Zeleni videz in pritisnite
vecfunkcijsko kolesce.

[Nasveti]
e Naslednje prednastavitve so tovarnisko privzeto

nastavljene.

Shooting Mode Custom

Target Display ~ SDR(BT.709) HDR(HLG)
Scene file 1 S-Cinetone HLG Live
Scene file 2 Standard HLG Natural
Scene file 3 Fotografije (Not
registered)
Scene file 4 ITU709 (Not
registered)
Scene files (Not (Not
5to 16 registered) registered)

e Videz lahko izberete tudi z moznostjo Scene File

(stran 13) na zaslonu Main Status ali z moZnostjo
Scene File > Recall (stran 83) in v meniju Paint/Look
glavnega menija. Prednastavljen videz lahko priklicete
tudi z moznostjo Scene File > Preset Recall.

Uvoz Zelenega osnovnega videza

Kot osnovni videz lahko tudi uvozite datoteko

3D LUT, ki ste jo ustvarili v racunalniku ali drugi

napravi. Uvozite lahko najvec 16 datotek.

e Oblika zapisa datoteke: Datoteka CUBE
(*.cube) za 17-tockovno ali 33-tockovno
datoteko 3D LUT, ki ste jo ustvarili z
mozZnostjo Catalyst Browse, RAW Viewer
ali DaVinci Resolve* (avtorjev Blackmagic

Design Pty. Ltd.).
* Preverjeno z Resolve V9.0, V10.0 in V11.0.

e |nput color space/Gamma: S-Gamut3.
Cine/S-Log3 or S-Gamut3/S-Log3

1 V racunalniku ali drugi napravi shranite
datoteko 3D LUT v dolo¢eno mapo ali na
zapisovalni medij.

Zapisovalni  Pot mape

medij

SDXC /PRIVATE/SONY/PRO/LUT/
CFexpress /SONY/PRO/LUT/

Type A

2 Vstavite zapisovalni medij, na katerem so
shranjene datoteke 3D LUT, v reZo za
kartice CFexpress tipa A/SD (B).

3 Izberite moZnost Base Look > Import
(stran 83) v meniju Paint/Look
glavnega menija.

4 Izberite ciljno mesto uvoza.

5 Izberite datoteko 3D LUT, ki jo zelite
uvoziti.
Upostevajte navodila na zaslonu.
Videokamera obravnava datoteko 3D LUT
kot osnovni videz.

6 Izberite uvozeno datoteko 3D LUT z
mozZnostjo Base Look > Select (stran 83)
v meniju Paint/Look glavnega menija.

7 Konfigurirajte moznost Base Look > Input
and Output (stran 83) v meniju Paint/
Look glavnega menija, da se bo ujemala z
lastnostmi uvoZene datoteke 3D LUT.

Prilagajanje presibki osvetlitvi

V primeru nagibanja k preSibki osvetlitvi, ko
izberete samodejno osvetlitev ob uporabi
uvoZenega osnovnega videza, prilagodite
mozZnost Base Look > AE Level Offset

(stran 83) v meniju Paint/Look.

[Opombe]

e Sam uvoz datoteke 3D LUT ne vpliva na sliko. NaloZite
uvozeno datoteko 3D LUT z mozZnostjo Base Look >
Select (stran 83) v meniju Paint/Look glavnega
menija.

e Ce vnos ni pravilno nastavljen, ne boste dobili
ustreznega videza.

e Nastavitve elementov menijev Input, Output in AE
Level Offset se uporabijo pri osnovnem videzu, ki ste
ga izbrali z moznostjo Select. Ce uvozite ve¢ datotek
3D LUT, izberite mozZnost Select za vsako datoteko 3D
LUT in konfigurirajte Input, Output in AE Level Offset
posamezno za vsako datoteko.

e Konfigurirane nastavitve Input, Output in AE Level
Offset se shranijo za vsako datoteko 3D LUT.

e |zbirne moZnosti osnovnega videza/LUT za uvoZene
datoteke 3D LUT so skupne na¢inom SDR(BT.709)/
HDR(HLG)/Cine El, toda barvni prostor in pretvorba v
gamo nista izvedena v skladu s temi nacini.

o Datoteke 3D LUT se ne izbrisejo, ko izberete moznost
All Reset > Reset v meniju Maintenance.
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Prilagajanje videza

Shranjevanje videza

Brisanje osnovnega videza

Videz lahko prilagajate glede na osnovni
videz z uporabo elementa Matrix in drugih
nastavitvenih elementov v meniju Paint/

Look glavnega menija. Podrobnosti vseh
nastavitvenih elementov si oglejte v 83.
Videokamero prikljucite na televizor ali zaslon,
nato pa med opazovanjem slike na televizorju
ali zaslonu prilagodite kakovost slike.
[Opombal]

Ko uvozite datoteko 3D LUT in jo uporabite na sliki, ne
boste dosegli Zelenega videza, ki je dolocen v datoteki
3D LUT, e spremenite element Matrix in nastavitve, ki
ne sodijo med nastavitve osnovnega videza v meniju
Paint/Look. Vse prilagojene nastavitve lahko ponastavite
z moznostjo Reset Paint Settings > Reset without Base
Look (stran 83) v meniju Paint/Look glavnega menija.

Trenutni videz lahko shranite v notranji
pomnilnik kot datoteko s prizorom z
moznostjo Scene File > Store (stran 83) v
meniju Paint/Look glavnega menija.

Hitro lahko shranite z operacijami v
neposrednem meniju v zaslonu za snemanje.
[Opombal]

Ce izberete drug videz, ne da bi shranili trenutni videz,
bo trenutni videz zavrZen.

[Nasvet]

Prednastavljene datoteke s prizori lahko prepisete.

Ce Zelite obnoviti prednastavljeno datoteko s prizorom,
naloZite videz, ki ga Zelite obnoviti, z moznostjo Scene
File >Preset Recall (stran 83) v meniju Paint/Look
glavnega menija, nato pa shranite datoteko s prizorom z
moZznostjo Scene File > Store.

Brisanje shranjenega videza

Datoteko s prizorom, ki je shranjena v
notranjem pomnilniku, lahko izbrisete z
moznostjo Scene File > Delete (stran 83) v
meniju Paint/Look glavnhega menija.

[Nasvet]
Ko je izbrisana, ni vec prikazana v neposrednem meniju.

UvoZeno datoteko 3D LUT lahko izbriSete z
moznostjo Base Look > Delete (stran 83) v
meniju Paint/Look glavnega menija.

Vse uvoZene datoteke 3D LUT lahko izbriSete z
moznostjo Base Look > Delete All (stran 83)

v meniju Paint/Look glavnega menija.

[Opombe]

e Pred izbrisom preverite, da osnovni videz ni
uporabljen v kateri koli datoteki s prizorom. Ce
izbriSete osnovni videz, ki je v uporabi, bo videz
ustreznih datotek s prizori nepravilen.

e UvoZene datoteke 3D LUT se ne izbriSejo, ko izberete
moznost All Reset > Reset (stran 99) v meniju
Maintenance glavnega menija.

e |zbrisanega osnovnega videza ne morete vec
uporabiti kot datoteko LUT v nacinu Cine El
(stran 54).
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Snemanje s prilagajanjem videza v postprodukciji

Ce uporabite videokamero v nacinu Cine El

in snemate enakomerne prehode iz temnih
obmocij v svetla obmogja, lahko opravite
natancne popravke, na primer lokalno
obnovite prehode temnih in svetlih obmocij v
postprodukciji.

Ce posnete slike gledate na obi¢ajnem
monitorju, bo skupni kontrast Sibek, zato bodo
popravki ostrenja in osvetlitve tezavni.
Datoteko LUT lahko uporabite na cilju
monitorja v videokameri, kar vam bo

v pomoc pri razli¢nih popravkih med
snemanjem. Datoteko LUT lahko uporabite
tudi pri predvajanju videoposnetkov, ko Zelite
pregledati koncni izdelek.

Datoteke LUT uporabljajo naslednji sistemi.
Toda uporabite lahko samo eno datoteko LUT.
e |zhod SDI in izhod HDMI

e |skalo in proxy slike, pretakanje

e Videoposnetek, posnet na zapisovalni medij

Uporaba datoteke LUT na sliki v
iskalu

1 Pritisnite gumb MENU, da se prikaze
zaslon Monitoring Status.

2 Izberite stolpec Gamut/Gamma v vrstici
VF.

3 Monitoring 5/13
Signal Info.Disp. Gamut/Gamma

SDI 1920x1080P(Lvl A) ||Off [SG3C/SL093

HDMI 11920x1080P On SG3C/SLog3

Stream Off [ MLUT

VF MLUT

Base Look / LUT Gamma Disp. Assist

s709

3 Izberite On ali Off.

[Opombe]

e Nastavitev LUT On/Off pri VF se uporabi tudi na proxy
datoteki in pretakanju videoposnetka.

e |zboljsan prikaz game je na voljo med uporabo
povecevala ostrenja.

[Nasveti]

e Nastavite lahko tudi s funkcijo LUT On/Off > VF/Proxy/
Stream (stran 76) v meniju Shooting glavnega
menija.

e SDI/HDMI je mogoce nastaviti podobno kot VF.

e Zavideoposnetek na zapisovalnem mediju lahko
nastavite z moznostjo LUT On/Off > Internal Rec
(stran 76) v meniju Shooting glavnega menija.

Spreminjanje datoteke LUT

1 Pritisnite gumb MENU, da se prikaZze
zaslon Monitoring Status.

2 Izberite polje Base Look/LUT.

=Monitoring 5/13

Signal Info.Disp. Gamut/Gamma

SDI  |1920x1080P(LvI A) ||Off [SGSC/SLog3

HDMI 11920x1080P On SG3C/SLog3

Stream Off [MLUT

VF MLUT

Base Look / LUT Gamma Disp. Assist
Off

s709

3 Izberite datoteko LUT, ki jo Zelite uporabiti,
s seznama osnovnih videzov.

[Nasveti]

e Uvozite in uporabite lahko tudi datoteko 3D LUT.
s709, 709(800%) ali S-Log3 lahko izberete za osnovni
videz. Podrobnosti najdete v razdelkih »Uvoz
Zelenega osnovnega videza« (stran 52) in »Brisanje
osnovnega videza« (stran 53).

e Osnovni videz lahko nastavite tudi s funkcijo Base
Look > Select (stran 83) v meniju Paint/Look
glavnega menija.

Spreminjanje porazdelitve temnih
in svetlih obmocij na videoposnetku

Porazdelitev temnih in svetlih obmocij
lahko spreminjate, Ce Zelite na primer dati
prednost tonu temnih obmodij, in sicer tako,
da spremenite nastavitev Exposure Index v
osnovni obcutljivosti.

1 Uporaba datoteke LUT na sliki v iskalu
(stran 54).

2 Pritisnite gumb MENU, da se prikaze
zaslon Camera Status.

3 Nastavite polja L/M/H moznosti Exposure
Index.
Posamezne nastavitve so dodeljene
polozajem L/M/H stikala ISO/GAIN
(stran 5).

4 Izberite vrednost Exposure Index, ki jo
boste uporabili s stikalom ISO/GAIN.

5 Ustrezno prilagodite osvetlitev slike v
iskalu.

[Opombal]

IzboljSan prikaz game je na voljo med uporabo
povecevala ostrenja. Nastavitev Exposure Index se ne
uporablja pri izboljSanem prikazu game.

[Nasveti]

e Osvetlitev lahko prilagodite tudi s funkcijo ISO/Gain/
El > Exposure Index (stran 72) v meniju Shooting
glavnega menija.

e Druga Stevilska vrednost nastavitve oznacuje,
koliko korakov informacij o svetlobi je dodeljenih
svetlim obmocjem (svetlost, vecja kot pri 18 % sivini).
Obmogja, ki so svetlejsa od teh, so presvetljena.
Primer: V »400EI/5.0E« je dodeljenih 5.0 korakov na
svetli strani.

e S tem si lahko med snemanjem tudi pomagate pri
preverjanju odtenka temnih in svetlih obmocij.

Ce je na primer polozaj M osnovna ob¢utljivost,
poloZaj L ima 2 koraka manj in poloZaj H 2 koraka

ve¢, lahko preverite s preklopom stikala ISO/GAIN.
Po preverjanju osvetlitve se ne pozabite vrniti v
poloZaj M.
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3 Snemanje

Snemanje videoposnetka RAW

Posnamete lahko video signal RAW, ki gre iz
priklju¢ka SDI OUT na videokameri v podprt
zunanji snemalnik.

1 Prikljucite zunanji snemalnik RAW v
priklju¢ek SDI OUT na videokameri.

2 Nastavite nacin snemanja na zaslonu
Project status (stran 14) ali pa nastavite
moZnost Base Setting > Shooting Mode
(stran 77) v meniju Project glavnega
menija na Cine EI

3 Nastavite nacin skeniranja (samo FF) s
funkcijo Imager Scan na zaslonu Project
status ali pa nastavite moZnost Rec
Format > Imager Scan Mode (stran 77)
v meniju Project glavnega menija.

4 Nastavite kodek na zaslonu Project status
ali pa nastavite moZnost Rec Format >
Codec (stran 77) v meniju Project
glavnega menija na kodek, ki vkljucuje
RAW.

Ce izberete RAW & XAVC-1, boste so¢asno
posneli videoposnetek RAW na zunanji
snemalnik RAW in na pomnilniSke kartice
v videokameri.

5 Nastavite locljivost na zaslonu Project ali
pa nastavite moznost Rec Format > RAW
Output Format (stran 77) v meniju
Project glavnega menija.

6 Preverite, ali je zunanji snemalnik
vklopljen, nato pa pritisnite gumb za
snemanje START/STOP na videokameri.

[Opombal]

Ko se snemanje z zunanjim snemalnikom zacne,
ne da bi uporabili gumb za snemanje START/STOP
na videokameri, videoposnetki ne bodo ustrezno
posneti.

Podprti izhodni formati RAW so prikazani
spodaj.

Sistemska Kodek RAW Output
frekvenca Format
59,94/ RAW 4096x%2160
50/ 3840x%2160
29,97/ RAW & XAVC-l  4096x2160
25/ 3840%2160
23,98
24 RAW 4096x2160
RAW & XAVC-I 4096x2160

Indikator stanja snemanja

Ko je vklopljena nastavitev Display On/Off
(stran 87) > RAW Output Control Status v
meniju Monitoring glavnega menija, stanje
snemanja RAW oznacuje ikona, ki je prikazana
na zaslonu iskala.

[Opombal]

Nadzorni signal snemanja pride iz priklju¢ka SDI OUT

na videokameri, stanja zunanjega snemalnika pa ni
mogoce pridobiti. Zato lahko videokamera daje znak,

da snemanje videoposnetka RAW poteka, medtem ko
zunanji snemalnik v resnici ne bo snemal. Pravilno stanje
si oglejte prek indikatorja na zunanjem snemalniku.

[Nasvet]
Prikazana je tudi vrednost nastavitve izhodnega formata
RAW.

Snemanje pocasnih in hitrih
posnetkov

Ce je nastavitev S&Q Motion > Setting v meniju
Shooting vklopljena, bo videoposnetek RAW
posnet v nacinu Slow & Quick Motion.
Podrobnosti o podprtih hitrostih slicic za
snemanje si oglejte v razdelku 49.



4 Omrezne funkcije

Povezovanje z ostalimi napravami prek povezave LAN

Videokamero lahko prek povezave LAN
poveZete s pametnimi telefoni, tabli¢nimi
racunalniki in drugimi napravami.
Vzpostavitev povezave LAN med videokamero
in drugo napravo omogoci sledece z uporabo
aplikacije »Content Browser Mobile«.

e Daljinsko upravljanje prek povezave LAN
Videokamero lahko upravljate s pametnim
telefonom, tabli¢nim racunalnikom ali
racunalnikom, ki je na videokamero
priklopljen prek povezave LAN.

e Prenos datotek prek povezave LAN
Prek povezave LAN lahko v streznik
prenesete datoteko proxy (v nizki locljivosti)
ali originalno datoteko (v visoki locljivosti),
ki je zapisana na pomnilniski kartici v
videokameri.

e Nadzor videa prek povezave LAN
Ustvarite lahko video podatkovni tok (H.264)
s kamere ali predvajate video s kamere
in nadzorujete video z uporabo aplikacije
»Content Browser Mobile« na napravi, ki je
povezana prek povezave LAN.

Aplikacija »Content Browser Mobile«

Z aplikacijo »Content Browser Mobile«

lahko daljinsko upravljate z videokamero in
spreminjate nastavitve videokamere prek
zaslona druge naprave ter nadzorujete video,
ki ga snema videokamera.

Za podrobnosti o aplikaciji »Content Browser Mobile« se

obrnite na prodajnega ali servisnega predstavnika podjetja
Sony.

Nastavitev uporabniskega imena
in gesla

Povezovanje z uporabo nacina
dostopovne tocke za brezzi¢ni LAN

Za uporabo omrezZne funkcije nastavite
uporabnisko ime in geslo videokamere.

1 Nastavite Access Authentication > User
Name (stran 95) v meniju Network
glavnega menija.

2 Nastavite Access Authentication >
Password (stran 95) v meniju Network
glavnega menija.

Videokamera deluje kot dostopovna tocka
in se poveZe z drugo napravo prek brezzicne
povezave LAN.

Pametni telefon/tabli¢ni racunalnik

Vzpostavljanje povezave z napravo,
zdruzljivo s funkcijo NFC, z enim dotikom

Naprave, ki podpirajo NFC, lahko poveZete
(povezava z enim dotikom) z uporabo funkcije
NFC.

1 Odprite nastavitve [Settings] na napravi,
izberite vec [More] in postavite kljukico v
polje za vklop funkcije NFC.

2 Vklopite videokamero.

3 Aktivirajte funkcijo NFC.
Za aktiviranje nacina povezave NFC
pritisnite in zadrzite (za 3 sekunde)
dodeljiv gumb z dodeljeno funkcijo NFC
ali izberite moznost Wireless LAN >NFC v
meniju Network.
Funkcija NFC je na voljo samo takrat, ko je
na zaslonu prikazana ikona N.

4 Z napravo se dotaknite videokamere.
Naprava se poveze z videokamero in
zazene se aplikacija »Content Browser
Mobile«.

[Opombe]

e Pred tem onemogocite nacin mirovanja in
zaklep zaslona.

e Z napravo se dotaknite videokamere in jo drZite
pri miru, dokler se ne zaZene aplikacija »Content
Browser Mobile« (1 do 2 sekundi).
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Povezovanje z napravo, zdruzljivo z WPS

Naprave, ki podpirajo WPS, lahko poveZete z
uporabo funkcije WPS.

1 Izberite moznost Wireless LAN > Setting >
Access Point Mode v meniju Network
glavnega menija.

2 Izberite moZnost Wireless LAN > WPS >
Execute v meniju Network celovitega
menija.

3 Odprite nastavitve omreZja na napravi ali
nastavitve za Wi-Fi na napravi in vklopite
Wi-Fi.

4 S seznama omrezij Wi-Fi v napravi izberite
SSID videokamere. Nato v moznostih na
napravi pritisnite gumb WPS za
vzpostavitev povezave.

[Opombe]

e Nacin uporabe se med razli¢nimi napravami
razlikuje.

e Za SSID in geslo videokamere si oglejte AP Mode

Settings > Camera SSID & Password (stran 97)
v meniju Network glavnega menija.

5 Povezite z uporabo aplikacije Content
Browser Mobile.

Povezovanje z vnosom SSID-ja in gesla
na napravi

Videokamero lahko povezete z napravo
tako, da na napravi vnesete SSID in geslo
videokamere.

1 Izberite moznost Wireless LAN > Setting >
Access Point Mode v meniju Network
glavnega menija.

2 Odprite nastavitve omreZja na napravi ali
nastavitve za Wi-Fi na napravi in vklopite
Wi-Fi.

3 PoveZite napravo na videokamero tako, da
s seznama brezzi¢nih omreZzij na napravi
izberete SSID videokamere in vnesete
geslo.

Za SSID in geslo videokamere uporabite
moZznost AP Mode Settings >Camera SSID
& Password (stran 97) v meniju

Network.

[Opombal]

Nacin uporabe se med razli¢nimi napravami
razlikuje.

4 Povezite z uporabo aplikacije Content
Browser Mobile.

Povezovanje z uporabo nacina
Wireless LAN Station

Videokamera se kot odjemalec poveZze na
obstojeCo dostopovno tocko brezzi¢nega
LAN-a. Videokamera in naprava se povezeta
prek dostopovne tocke.

Zadnjih 10 povezanih dostopovnih tock je
prikazanih v zgodovini.

Zgodovina povezav je shranjena v datoteki
ALL. Gesla za dostop se ne shranijo. Ko
nalozite datoteko ALL, je ob naslednjem
povezovanju potreben vnos gesla.

Pametni telefon/  racunalnik

tabli¢ni racunalnik

.Q =)

Dostopovna tocka

[

Povezovanje na dostopovno tocko z
uporabo funkcije WPS

Ce je dostopovna toc¢ka zdruZljiva s funkcijo
WPS, lahko videokamero poveZete na
dostopovno tocko z nekaj enostavnimi
nastavitvami.

1 Vklopite dostopovno tocko.
2 Vklopite videokamero.

3 Izberite mozZnost Wireless LAN > Setting >
Station Mode v meniju Network glavnega
menija.

4 Izberite moznost ST Mode Settings >
Camera Remote Control (stran 95) >
Enable v meniju Network glavnega
menija.

5 Izberite moznost Wireless LAN > WPS >
Execute v meniju Network glavnega
menija.

6 Pritisnite gumb WPS na dostopovni tocki.
Za podrobnosti o delovanju gumba WPS
glejte navodila za uporabo dostopovne
tocke.

Ko je povezava uspesno vzpostavljena,
indikator stanja omrezja na zaslonu iskala
prikazuje jakost 1 ali visjo.

[ppomba]

Ce povezava ne uspe, ponovite navedene korake
od 1. koraka.

7 PoveZite napravo na dostopovno tocko.
Za podrobnosti o povezovanju glejte
navodila za uporabo naprave.

8 PoveZite z uporabo aplikacije Content
Browser Mobile.
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Povezovanje na dostopovno tocko z
uporabo samodejnega zaznavanja
omrezja ali rono

Povezavo na zeleno dostopovno tocko lahko
nastavite v glavnega meniju.

Povezavo na Zeleno dostopovno tocko lahko
nastavite z uporabo funkcije samodejnega
zaznavanhja omreZja.

Povezovanje z uporabo funkcije samodejnega
zaznavanja omrezja

1

Opravite korake od 1 do 3 v razdelku
»Povezovanje na dostopovno tocko z
uporabo funkcije WPS« (stran 57).

Izberite moznost ST Mode Settings > Scan
Networks (stran 96) > Execute v meniju
Network glavnega menija.

Videokamera zazene zaznavanje ciljev
povezovanja.

Najdeni mozni cilji se prikaZzejo na
seznamu.

Izberite cilj s seznama.

Pojavi se zaslon s podrobnostmi omrezja
(dostopovne tocke). Izbrana povezava je
prikazana v SSID-ju.

Izberite geslo in nastavite geslo na
zaslonu za vnos gesla.

Izbira SSID-ja v zgodovini povezav
samodejno prilagodi nastavitve, vklju¢no
z geslom.

Vnesite geslo, da se vrnete na zaslon s
podrobnostmi o omrezju (dostopovni
tocki).

5 Prilagodite naslednje nastavitve povezave.

e DHCP
Dolocite nastavitve DHCP.
Ko je DHCP vklopljen, se videokameri
samodejno dodeli naslov IP.
Ce Zelite naslov IP videokamere dolo¢iti
ro¢no, izklopite DHCP.

e |P Address
Vnesite IP naslov enote.
Ta moznost je na voljo samo, Ce je DHCP
izklopljen.

e Subnet Mask
Vnesite masko podomrezja enote.
Ta moznost je na voljo samo, ¢e je DHCP
izklopljen.

e Gateway
Vnesite prehod za dostopovno tocko.
Ta moznost je na voljo samo, Ce je DHCP
izklopljen.

e DNS Auto
Nastavite, ali naj se DNS pridobi
samodejno.
Ko je samodejni DNS vklopljen, se naslov
streznika DNS pridobi samodejno. Ta
nastavitev je na voljo samo, ¢e je DHCP
vklopljen.

e Primary DNS Server
Vnesite primarni streznik DNS za
dostopovno tocko.
Ta nastavitev je na voljo samo, Ce je
samodejni DNS izklopljen.

e Secondary DNS Server
Vnesite sekundarni streznik DNS za
dostopovno tocko.
Ta nastavitev je na voljo samo, Ce je
samodejni DNS izklopljen.

6 Ko zakljucite, izberite moZnost Connect za

vzpostavitev povezave na dostopovno
tocko.

Ro¢no povezovanje

1

Opravite korake od 1 do 3 v razdelku
»Povezovanje na dostopovno tocko z
uporabo funkcije WPS« (stran 57).

Izberite moznost ST Mode Settings >
Manual Register (stran 96) > Execute v
meniju Network glavnega menija.

Za trenutek se prikaze zaslon s
podrobnostmi o omrezju (dostopovni
tocki).

Prilagodite naslednje nastavitve povezave.

e SSID
Vnesite SSID za povezavo na
dostopovno tocko.
e Security
Izberite nacin Sifriranja.
e Password
Vnesite geslo za povezavo na
dostopovno tocko.
e DHCP
Dolocite nastavitve DHCP.
Ko je DHCP vklopljen, se videokameri
samodejno dodeli naslov IP.
Ce Zelite naslov IP videokamere dolo¢iti
rocno, izklopite DHCP.
IP Address
Vnesite IP naslov enote.
Ta moznost je na voljo samo, Ce je DHCP
izklopljen.
Subnet Mask
Vnesite masko podomrezja enote.
Ta moznost je na voljo samo, ¢e je DHCP
izklopljen.
e Gateway
Vnesite naslov prehoda.
Ta mozZnost je na voljo samo, ce je DHCP
izklopljen.

e DNS Auto
Nastavite, ali naj se DNS pridobi
samodejno.
Ko je samodejni DNS vklopljen, se naslov
streznika DNS pridobi samodejno. Ta
nastavitev je na voljo samo, ¢e je DHCP
vklopljen.

e Primary DNS Server
Vnesite naslov primarnega streznika
DNS.
Ta nastavitev je na voljo samo, Ce je
samodejni DNS izklopljen.

e Secondary DNS Server
Vnesite naslov sekundarnega streznika
DNS.
Ta nastavitev je na voljo samo, Ce je
samodejni DNS izklopljen.

4 Ko zakljucite, izberite moznost Connect za

vzpostavitev povezave na dostopovno
tocko.
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i Povezovanje s kablom LAN in nastavitve * Primary DNS Server
POVGZOVEane ZNapravo s kablom viv Vnesite naslov primarnega streznika
zicne povezave LAN DNS
LAN o _ -
Ta nastavitev je na voljo samo, Ce je
1 S kablom LAN povefZite prikljucek Zi¢nega samodejni DNS izklopljen.
Z napravo se lahko povezete tako, da s kablom omreZja LAN na adapterju Zi¢cnega e Secondary DNS Server
LAN povezete prikljucek zicnega omrezja LAN omreZja LAN z usmerjevalnikom omreZzja Vnesite naslov sekundarnega streznika
na adapterju Zicnega omreZja LAN (dodatna Wi-Fi. DNS.
moznost), ki je povezan s priklju¢kom USB-C Ta nastavitev je na voljo samo, Ce je
(stranv_7) vigiec_;kamere, z usrr;erjevalnikom 2 Vklopite videokamero. samodejni DNS izklopljen.
omreZja Wi-Fi (dodatna moZnost).
_ o _ 3 Vklopite moZnost Wired LAN > Setting 5 Ko ste zakljucili, izberite moZnost Set, da
Pametni telefon/tablicni racunalnik (stran 97) v meniju Network glavnega shranite nastavitve.
= menija. [Opombe]
g e Po spreminjanju nastavitev povezave vedno izberite
4 .. . moznost Set. Ce ne izberete moZnosti Set, se
Dolocite nastavitve povezave z uporabo nastavitve ne uporabijo.
moznosti Wired LAN >Detail Settings e Uporabite adapter Zi¢nega omreZja LAN s priklju¢kom
(stran 97) v meniju Network. USB tipa C. Priporo¢amo uporabo adapterja, ki je
e DHCP zdruZzljiv z gigabitnim ethernetom. Ne zagotavljamo,
v. . da bo deloval z vsemi napravami.
Usmerjevalnik Wi-Fi DoI_ocne nastawtvg DHCP‘_ ) e Od modela adapterja ?i¢nega omrezja LAN (dodatna
Ko je DHCP vklopljen, se videokameri moZnost) je odvisno, ali vpliva na vgrajeno funkcijo
samodejno dodeli naslov IP. komunikacije prek omrezja Wi-Fi.

Ce Zelite naslov IP videokamere dolo¢iti
ro¢no, izklopite DHCP.

e |P Address
Vnesite IP naslov enote.
Ta moznost je na voljo samo, Ce je DHCP
izklopljen.

e Subnet Mask
Vnesite masko podomrezja enote.
Ta moznost je na voljo samo, Ce je DHCP
izklopljen.

e Gateway
Vnesite naslov prehoda.
Ta moznost je na voljo samo, Ce je DHCP
izklopljen.

e DNS Auto
Nastavite, ali naj se DNS pridobi
samodejno.
Ko je samodejni DNS vklopljen, se naslov
streZznika DNS pridobi samodejno. Ta
nastavitev je na voljo samo, ¢e je DHCP
vklopljen.
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4 Omrezne funkcije

Povezovanje z internetom

Videokamero lahko povezete z internetom
prek povezave USB, Zicnega omreZja LAN ali
brezZicnega omreZja LAN.

Povezava prek USB

Enoto lahko s pametnim telefonom poveZete s
kablom USB, nato pa jo poveZete z internetom
prek pametnega telefona.

Konfiguracija komunikacije s pametnim
telefonom

Omogocite komunikacijsko povezavo v
pametnem telefonu.

Za podrobnosti glejte navodila za uporabo
pametnega telefona.

Prikljucitev pametnega telefona na
videokamero

Kabel USB poveZite s priklju¢kom USB-C

(stran 7) videokamere, nato pa poveZite

pametni telefon.

[Opombe]

e Pametni telefon prikljucite/odstranite, ko je
videokamera izklopljena.

e Povezave USB ne morete uporabiti, e je pametni
telefon priklju¢en prek zvezdiS¢a USB.

e Povezave USB ne morete uporabiti, ¢e je racunalnik
prikljuc¢en na priklju¢ek USB/multi (stran 7).

Vzpostavljanje povezave z omrezjem
1 Vklopite videokamero.

2 Vklopite moznost Modem > Setting
(stran 97) v meniju Network glavnega
menija.

Omogocanje delovanja v pametnem
telefonu

Ce Zelite videokamero upravljati na daljavo
prek aplikacije Content Browser Mobile v
pametnem telefonu, omogocite moZnost
Modem > Camera Remote Control (stran 95)
v meniju Network glavnega menija.

Povezovanje z uporabo nacina
Wireless LAN Station

Videokamero lahko v nacinu Wi-Fi station
povezete z internetom prek usmerjevalnika
omrezja Wi-Fi ali prek povezave z drugo
napravo.

Pametni telefon/ racunalnik

tabli¢ni racunalnik

————\

>
S

N’

= e

Internet

O

Internet

="] Pametni
telefon/
tabli¢ni

racunalnik

Povezite z usmerjevalnikom omrezja Wi-

Fi ali napravo, kot je opisano v razdelku
»Povezovanje z uporabo nacina Wireless LAN
Station« (stran 57).

Povezovanje s kablom LAN

Z internetom se lahko poveZete tako, da s
kablom LAN poveZete prikljucek Zi¢nega
omrezja LAN na adapterju Zicnega omrezja
LAN (dodatna moZnost), ki je povezan s
priklju¢kom USB-C (stran 7) videokamere,

z usmerjevalnikom omreZja Wi-Fi (dodatna
moZnost).

Pametni telefon/

oo i racunalnik
tabli¢ni racunalnik
N
N—/

Usmerjevalnik Wi-Fi

Internet

Povezite z usmerjevalnikom omreZja Wi-Fi, kot
je opisano v razdelku »Povezovanje z napravo
s kablom LAN« (stran 59).

[Opombe]

o Adapterja Zicnega omreZzja LAN s prikljuckom USB
(dodatna moZnost) ne morete uporabiti, Ce je racunalnik
priklju¢en na priklju¢ek USB/multi (stran 7).

e Od modela adapterja Zicnega omreZja LAN (dodatna
moznost) je odvisno, ali vpliva na vgrajeno funkcijo
komunikacije prek omrezja Wi-Fi.
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4 Omrezne funkcije

Nalaganje datotek

Datoteko proxy ali originalno datoteko, ki

je posneta z videokamero, lahko naloZite v
streznik na internetu ali v streznik v lokalnem
omrezZju prek pametnega telefona ali
dostopovne tocke.

Priprave

Vzpostavljanje povezave z omrezjem

PoveZite videokamero z internetom ali
lokalnim omreZjem, kot je opisano v razdelkih
»Povezovanje z internetome« (stran 60)

in »Povezovanje z ostalimi napravami prek
povezave LAN« (stran 56).

Registriranje cilja za prenos datoteke

Streznik za nalaganje datoteke lahko
registrirate vnaprej.

1 Izberite moznost File Transfer > Server
Settings1 (ali Server Settings2, Server
Settings3) v meniju Network glavnega
menija.

Pojavi se zaslon za nastavitev cilja
prenosa.

2 Nastavite vse elemente na zaslonu za
nastavitev cilja prenosa.
Display Name
Vnesite ime streZznika, ki bo prikazano na
seznamu ciljev prenosa.
Service
PrikaZe tip streznika.
»FTP«: Streznik FTP
Host Name
Vnesite naslov streznika.
Port
Vnesite Stevilko vrat streznika, s katerim
Zelite vzpostaviti povezavo.

User Name

Vnesite uporabnisko ime.

Password

Vnesite geslo.

Passive Mode

Vklopite/izklopite pasivni nacin.
Destination Directory

Vnesite ime mape na ciljnem strezniku.

[Opombe]

e Simbol »O« med urejanjem oznacuje znake, ki
jih ni mogoce spremeniti. Pri urejanju imena
mape, ki vsebuje te znake, ni mogoce zagotoviti
pravilnega delovanja.

Ce Zelite urediti, izbrisite vse znake in ponovno
vnesite vrednost.

o Ce so znaki, ki so neveljavni na ciljnem strezniku,
vneseni v ciljino mapo, bodo datoteke prenesene
v uporabnikovo domaco mapo. Neveljavni znaki
se razlikujejo glede na streznik.

Using Secure Protocol

Nastavite, Ce Zelite izvesti varen prenos
FTP.

Root Certificate

NaloZite/izbrisite potrdilo.

e |oad
Za uvoz potrdila CA v koraku 3 izberite
Set.

* Potrdilo, ki ga Zelite naloziti, mora biti v formatu
PEM z imenom datoteke »certification.pem«in
mora biti zapisano v korenski mapi pomnilniske
kartice, ki je vstavljena v reZo za kartice CFexpress
tipa A/SD (B).

e Clear
Za brisanje potrdila CA v 3. koraku 3
izberite moznost Set.

e None
Potrdilo se ne naloZi in ne izbrise.

[Opombe]

e Pred uvozom potrdila CA nastavite uro
videokamere na pravilen cas.

e Ko snemate v formatu XAVC-1 4096x2160P/
3840x2160P 59,94/50P, ni mogoce izbrati
moZnosti Load.

e V/ stanju nizke napetosti ni mogoce izbrati
mozZnosti Load/Clear za potrdilo CA.

Root Certificate Status

PrikaZe stanje nalaganja potrdila.
Ponastavitev

Ponastavite nastavitve Server Settings na
privzete vrednosti.

Ko ste zakljucili, izberite mozZnost Set, da
shranite nastavitve.

Po spreminjanju nastavitev vedno izberite
moznost Set. Ce ne izberete moZnosti Set,
se nastavitve ne uporabijo.

Izbira datoteke in nalaganje

Za prenos v streznik lahko izberete datoteke
proxy ali izvirne datoteke, zapisane na
pomnilniskih karticah.

Nalaganje datoteke proxy na
pomnilniski kartici z zaslona slicic

1 PoveZite videokamero in napravo z
uporabo povezave LAN (stran 56).

2 Izberite moznost Transfer Clip (Proxy) >
Select Clip v meniju Thumbnail glvnega
menija.

Na zaslonu se namesto glavnega menija
prikaZze meni slicic.

Posnetke lahko prenesete z zaslona slicic
ali zaslona slicic filtriranih posnetkov.

3 Izberite posnetek, ki ga Zelite prenesti, in
nato pritisnite gumb MENU.
PrikaZe se potrditveni zaslon prenosa.

4 Izberite Execute.
Datoteka proxy, ki ustreza izbrani datoteki,
se registrira za opravilo prenosa in prenos
se zacne.
Ko se opravilo prenosa uspesno registrira,
se prikaZze zaslon z rezultatom prenosa.

5 Izberite OK.

Nalaganje vseh datotek

V 2. koraku izberite moznost Select All Clips
namesto Select Clip za prenos datotek proxy,
ki ustrezajo vsem datotekam.

[Opombal]
Prenesti je mogoce do 200 datotek.
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Nalaganje izvirne datoteke na
pomnilniski kartici z zaslona slicic

1 PoveZite videokamero in napravo z
uporabo povezave LAN (stran 56).

2 Izberite moznost Transfer Clip > Select Clip
v meniju Thumbnail glavnega menija.
Na zaslonu se namesto glavnega menija
prikaZe meni slicic.
Posnetke lahko prenesete z zaslona slicic
ali zaslona slicic filtriranih posnetkov.

3 Izberite posnetek, ki ga Zelite prenesti, in
nato pritisnite gumb MENU.
PrikaZe se potrditveni zaslon prenosa.

4 Izberite Execute.
Izbrana datoteka se registrira kot opravilo
prenosa in nalaganje se zacne.
Ko se opravilo prenosa uspesno registrira,
se prikaZe zaslon z rezultatom prenosa.

5 Izberite OK.

Nalaganje vseh datotek
Za prenos vseh datotek v 2. koraku namesto
moznosti Select Clip izberite moznost All Clips.

[Opombal]
Prenesti je mogoce do 200 datotek.

Preverjanje prenosa datotek

Stanje prenosa datotek lahko preverite tako,
da izberete mozZnost File Transfer > View Job
List (stran 97) v meniju Network glavnega
menija.

Stanje prenosa datotek lahko preverite tudi na
zaslonu aplikacije Content Browser Mobile.

[Nasvet]

Ce je moznost File Transfer >Auto Upload (Proxy)
(stran 97) v meniju Network glavnega menija
vklopljena in je vzpostavljena omrezna povezava, se
datoteke proxy po zaklju¢ku zapisovanja samodejno
prenesejo v streznik, dolocen z uporabo moznosti
Default Upload Server (stran 97).

[Opombe]

e Registrirati je mogoce do 200 opravil prenosa.

e Ko videokamero izklopite, se seznam opravil ohrani.
Podatki o trenutnem napredku za zadnjih 10 minut
se lahko izgubijo, ¢e odstranite baterijo ali izklopite
videokamero, ne da bi stikalo POWER najprej
prestavili v poloZaj STANDBY.

e Opravila, ki jih dodate, ko je napetost baterije Ze nizka,
se ne shranijo na seznam opravil.

o Ce pride med prenosom datotek do napake, se
prenos posnetka z enakim imenom, kot ga ima
preneseni posnetek, morda ne bo zacel znova. To je
odvisno od nastavitev in stanja ciljnega streznika.

V tem primeru preverite nastavitve in stanje ciljnega
streznika prenosa.

Nalaganje z uporabo Secure FTP

Datoteke naloZite prek Sifrirane povezave s
ciljnim streznikom, tako da uporabite FTPS v
nacinu Explicit (FTPES).

Nastavitev varnega prenosa FTP

Za varen prenos FTP na ciljnem strezniku
vklopite uporabo varnega protokola in uvozite
certifikat.

Za podrobnosti o konfiguraciji glejte razdelek
»Registriranje cilja za prenos datoteke«

(stran 61).
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5 Zaslon slicic

Zaslon slicic

Ko pritisnete gumb THUMBNAIL (stran 5), se posnetki, ki so posneti na pomnilnisko kartico, prikaZejo kot sli¢ice na zaslonu.
Na zaslonu slicic lahko izberete posnetek in zaZzenete njegovo predvajanje. Predvajana slika je lahko prikazana v iskalu in na zunanjem zaslonu.
Ponovni pritisk gumba THUMBNAIL zapre zaslon slic¢ic in na zaslon vrne sliko kamere.

[Opombal]

Na zaslonu slicic so prikazani samo posnetki, posneti v trenutno izbranem formatu snemanja. Ce posnetek, ki ste ga pri¢akovali, ni prikazan, preverite format snemanja. Na to bodite posebej pozorni pred formatiranjem (inicializiranjem)

pomnilniskih medijev.

Postavitev zaslona

Podatki o posnetku, na katerega je usmerjen kazalec, so prikazani na dnu zaslona.

Indikator trenutno izbrane pomnilniske kartice
(Ce je kartica zascitena, je prikazana ikona kljucavnice.)

Kazalec (rumene barve)

1. Sli¢ica (slika kazala)

Prikaze sliko kazala posnetka. Ko je posnetek
posnet, se njegova prva sli¢ica samodejno
nastavi kot slika kazala.

Podatki o posnetku/sli¢ici so prikazani

pod sli¢ico. Z mozZnostjo Customize View
(stran 92) > Thumbnail Caption v meniju
Thumbnail glavnega menija lahko spremenite
prikazane informacije.

Stevilka posnetka/skupno $tevilo posnetkov

I
~—— (& &)0001/0060)

8 2

TCR00:00:00:12 TCR00:00:00:15

A

2. Ime posnetka
PrikaZe ime izbranega posnetka.

3. Video format snemanja

Prikaze datotecni format izbranega posnetka.

TCR00:00:00:34

TCR00:00:02:35

TCR00:00:05:21

( ) (( )

4. Posebni podatki o snemanju

PrikaZe nacin snemanja, a samo, e je bil
posnetek posnet s posebnim nacinom
snemanja.

Hitrost sli¢ic pocasnih in hitrih posnetkov je
prikazana na desni strani.

5. Trajanje posnetka

6. Datum, ko je bil posnetek ustvarjen
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Predvajanje posnetkov

Predvajanje posnetih posnetkov

Posnete posnetke lahko predvajate, ko je
videokamera v nacinu stanja pripravljenosti za
snemanje (Stby).

Vstavite pomnilnisko kartico, ki jo Zelite
predvajati.

2 Pritisnite gumb THUMBNAIL.

3 Z vecfunkcijskim gumbom (stran 7) ali
vecfunkcijskim kolescem (stran 5)
premaknite kazalec na sli¢ico posnetka, ki
ga Zelite predvajati.

4 Pritisnite gumb za potrditev na
vecfunkcijskem gumbu ali ve&funkcijsko
kolesce.

Predvajanje se zac¢ne od zacletka
izbranega posnetka.

Predvajanje lahko nadzorujete s pritiski na

sledeCe gumbe.

Pritisnite gumb za potrditev na
vecfunkcijskem gumbu ali vecfunkcijsko
kolesce:

Premor predvajanja.
Pritisnite ponovno za vrnitev v obicajno
predvajanje.

Pritisnite levo/desno stran vecfunkcijskega
gumba:

Skok na zacetek posnetka/zacetek
naslednjega posnetka.

Pritisnite in zadrzite levo/desno stran
vecfunkcijskega gumba:

Hitro premikanje nazaj/naprej.
Ko spustite gumb, se predvajanje vrne na
normalno.

Gumb CANCEL/BACK:

Ustavi predvajanje in vrne videokamero v
nacin pripravljenosti za snemanje.

[Opombe]

e Na lo¢nici med posnetkoma se lahko pojavi zacasna
prekinitev slike ali ustavljena slika. Med tem ¢asom ne
morete uporabljati videokamere.

e Ko izberete posnetek s seznama slicic in ga zacnete
predvajati, se lahko na zacetku posnetka pojavi
zacasna prekinitev slike. Ce si Zelite ogledati zacetek
posnetka brez prekinitve, preklopite videokamero v
nacin predvajanja, prekinite predvajanje, z levo stranjo
vecfunkcijskega gumba se vrnite na zacetek posnetka
in znova zacnite predvajati.
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5 Zaslon slicic

Upravljanje s posnetki

Na zaslonu s slicicami lahko v meniju
Thumbnail glavnega menija upravljate s
posnetki ali si ogledate lastnosti posnetkov.
Meni Thumbnail (stran 92) se prikaZze,

ko pritisnete gumb MENU in ga zadrzite ter
izberete moznost Thumbnail.

Uporaba menija Thumbnail

Z vecfunkcijskim gumbom (stran 7) ali
vecfunkcijskim kolescem (stran 5) izberite
funkcijo, nato pritisnite gumb za potrditev
na vecfunkcijskem gumbu ali vecfunkcijsko
kolesce.

Za vrnitev na prejsnji zaslon pritisnite gumb
CANCEL/BACK (stran 5).

[Opombal]

Nekaterih elementov ni mogoce izbrati, kar je odvisno
od stanja, ko je bil meni prikazan.

Elementi menija za upravljanje s
posnetki

Display Clip Properties
Set Clip Flag
Lock/Unlock Clip
Delete Clip

Transfer Clip

Transfer Clip (Proxy)
Filter Clips

Customize View

Za podrobnosti o elementih menija za
upravljanje s posnetki glejte meni Thumbnail
(stran 92).

Prikaz lastnosti posnetka

Za prikaz zaslona lastnosti posnetka izberite
moznost Display Clip Properties (stran 92) v
meniju Thumbnail.

Dodajanje zastavic posnetkov

Posnetkom lahko dodate zastavice (oznake
OK, NG ali KP), Ce Zelite filtrirati prikaz
posnetkov glede na zastavice posnetkov.
Izberite slicico za posnetek, ki mu Zelite
dodati zastavico posnetka, nato pa izberite
zastavico posnetka z moznostjo Set Clip Flag
(stran 92) v meniju Thumbnail glavnega
menija.

Setting Dodana zastavica posnetka
Add OK OK (Uspesno)

Add NG NG

Add KEEP KP

[Nasveti]

e Za dodajanje zastavic posnetkov lahko uporabite
tudi dodeljiv gumb, ki je dodeljen funkciji zastavice
posnetka (stran 48).

e Slicici izbranega posnetka lahko dodate zastavico
posnetka OK (stran 50) tako, da pritisnete gumb
Clip Flag (stran 5).

Prikaz zaslona slicic filtriranih posnetkov

V meniju Thumbnail glavnega menija izberite
moznost Filter Clips (stran 92), nato pa

izberite vrsto zastavice posnetka, Ce Zelite,

da se prikaZejo samo posnetki z doloc¢eno
zastavico.

Za prikaz vseh posnetkov izberite moZnost All.
[Nasvet]

Med filtri lahko preklapljate tudi v sekvenci zgumbom
DISPLAY.

Brisanje posnetkov

IzbriSete lahko posnetke s pomnilniskih kartic.
V meniju Thumbnail glavnega menija izberite
moznost Delete Clip > Select Clip ali All Clips.
Select Clip:
Izbrise izbrani posnetek. Izberete lahko vel
posnetkov.
All Clips:
Izbrise vse prikazane posnetke.

Spreminjanje podatkov, prikazanih na
zaslonu slicic

Spremenite lahko podatke o posnetku/slicici,
ki so prikazani pod slicico.
V meniju Thumbnail glavnega menija izberite
moznost Customize View > Thumbnail
Caption, nato pa izberite informacije, ki naj se
prikaZejo.
Date Time:
Prikaze datum in cas, ko je bil posnetek
ustvarjen in nazadnje spremenjen.
Time Code:
Prikaze ¢asovno kodo.
Trajanje:
PrikaZe trajanje posnetka.
Sequential Number:
PrikaZe sekvencno Stevilko vsake slicice.
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6. Prikaz in nastavitve menijev

Konfiguracija in hierarhija glavhega menija

Pritisnite in pridrzite gumb MENU za prikaz
glavnega menija v iskalu, da nastavite

Hierarhija glavnega menija

razli¢cne elemente za snemanje, zapisovanje

in predvajanje (meni je lahko prikazan tudi na User Base Setting

zunanjem monitorju). Glavni meni sestavljajo

o (tovarniske Focus
naslednji meniji.

nastavitve) S&Q Motion

LUT On/Off

Simul Rec

Konfiguracija menijev Proxy Rec

Interval Rec

Meni User Assignable Button

Vsebuje elemente, ki jih nastavi uporabnik Assignable Dial

v meniju Edit User. Multi Function Dial

Meni Edit User All File
Vsebuje elemente menija za urejanje Clip Name Format
menija User. Format Media

Meni Shooting VF Setting
Vsebuje nastavitve povezane s Zeb
snemanjem. ebra

Meni Project Zoom .
Vsebuje osnovne nastavitve projekta. Menu Settings

Meni Paint/Look Meni Edit User Add Item
Vsebuje nastavitve, povezane s Customize Reset
kakovostjo slike. Shooting ISO/Gain/El

Meni TC/Media ND Filter
Vsebuje nastavitve, povezane s ¢asovnimi h
kodami in pomnilniskimi mediji. utter

Meni Monitoring Auto Exposure
Vsebuje nastavitve, povezane z video White
izhodom in prikazom iskala. White Setting

Meni Audio Offset White
Vsebuje nastavitve, povezane z zvokom. Focus

I\/IeanhumbnalI . ' 5&Q Motion
Vsebuje nastavitve, povezane s prikazom

LUT On/Off

slicic.

Meni Technical Noise Suppression

Vsebuje nastavitve za tehni¢ne elemente. Flicker Reduce

Meni Network SteadyShot

Vsebuje nastavitve, povezane z omrezji.
Meni Maintenance

Vsebuje nastavitve naprave, kot sta ura in

jezik.

Project Base Setting Avdio Audio Input
Rec Format Avdio izhod
Cine El Setting Thumbnail Display Clip Properties
Simul Rec Set Clip Flag
Proxy Rec Lock/Unlock Clip
Interval Rec Delete Clip
SDI/HDMI Rec Control Transfer Clip
Assignable Button Transfer Clip (Proxy)
Assignable Dial Filter Clips
Multi Function Dial Customize View
User File Technical Color Bars
All File ND Dial
Paint/Look Scene File Tally
Base Look HOLD Switch Setting
Reset Paint Settings Touch Operation
Black Rec Review
Knee Zoom
Detail Handle Zoom
Matrix Menu Settings
Multi Matrix Fan Control
TC/Media Timecode Lens
TC Display Video Light Set
Users Bit APR
HDMI TC Out Camera Battery Alarm
Clip Name Format Camera DCIN Alarm
Update Media Network Access Authentication
Format Media Wireless LAN
Monitoring Output On/Off AP Mode Settings

Output Format

Output Display

Display On/Off

ST Mode Settings

Wired LAN

Modem

Marker File Transfer
VF Setting Network Reset
Gamma Display Assist

Peaking

Zebra
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Maintenance Language
Clock Set
All Reset
Hours Meter
Version
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6. Prikaz in nastavitve menijev

Funkcije glavhega menija

Pritisnite in pridrzite gumb MENU za prikaz
glavnega menija v iskalu, da nastavite
podrobne nastavitve (meni je lahko prikazan
tudi na zunanjem monitorju).

Upravljanje menija

Gumb MENU (stran 5)
Za prikaz glavnega menija ga pritisnite in
pridrzite. Ko je glavni meni prikazan, ga
znova pritisnite, da ga skrijete.
Vecfunkcijski gumb (8-smerna D-ploscica in
gumbi za potrditev) (stran 7)
Pritisnite gumbe D-ploscice, da
premaknete kazalec navzgor/navzdol/v
levo/v desno, da izberete elemente ali
nastavitve menija.
Pritisnite gumb za potrditev na
vecfunkcijskem gumbu, da potrdite
izbrani element.
Vecfunkcijsko kolesce (stran 5)
Zavrtite vecfunkcijsko kolesce, da
premaknete kazalnik gor/dol, da izberete
element menija ali nastavitev.
Pritisnite vecfunkcijsko kolesce za
potrditev izbire izbranega elementa.
Gumb CANCEL/BACK (stran 5)
Pritisnite za vrnitev v prejSnji meni.
Nedokoncana sprememba je preklicana.
[Opombe]
e Glavnega menija ne morete uporabljati v nacinu
povecevalnika za ostrenje (stran 40).

e Nekaterih elementov ni mogoce izbrati, kar je odvisno
od stanja, ko je bil meni prikazan.

Nastavljanje elementov menija

\V/nos niza znakov

Zaklepanje in odklepanje menija

Uporabite gumbe D-ploscice ali obrnite

vecfunkcijsko kolesce, da premaknete kazalec

na element menija, ki ga Zelite nastaviti. Nato
pritisnite gumb za potrditev ali vec¢funkcijsko
kolesce, da izberete element.

e Obmodje za izbor elementov menija prikaze
do osem vrstic. Ce vseh razpoloZljivih
moznosti za element ni mogoce prikazati
hkrati, se s kazalcem pomaknite po zaslonu
navzgor/navzdol.

e Obmocje nastavitev se ne prikaZe pri
podelementih z velikim razponom
nastavitev (na primer -99 do +99). Trenutna
nastavitev je poudarjena, s ¢imer je
oznacena vrednost, ki jo lahko spremenite.

e |zbira moZnosti [Execute] za funkcijo bo
izvrSila ustrezno funkcijo.

® |zbira elementa, ki zahteva potrditev
pred izvrsitvijo, bo za¢asno skrila meni in
prikazala potrditveno sporocilo. Preverite
sporocilo in izberite ali Zelite izvrsiti ali
preklicati funkcijo.

Ko izberete element, kot je ime datoteke, ki
zahteva vnos znakov, se pojavi zaslon za vnos
znakov.

All File:File ID
Kurokawa_Scene 001 a

Pritisnite gumbe D-ploscice ali obrnite
vecfunkcijsko kolesce, da izberete tip
znaka, in nato potrdite nastavitev.
ABC: Veliki abecedni znaki

abc: Mali abecedni znaki

123: Stevil¢ni znaki

1#$: Posebni znaki

Izberite znak s seznama izbranega tipa

znakov, nato potrdite vnos.

Kazalec se premakne na naslednje polje.

Space: Vstavi presledek na poloZaju
kazalca.

«—/—: Spremeni poloZaj kazalca.

BS: Izbrise znak na levi strani kazalca
(funkcija backspace).

Ko ste koncali, izberite [Done] in potrdite
vnos.

Niz znakov je potrjen in zaslon za vnos
znakov izgine.

Glavni meni lahko zaklenete tako, da je
prikazan samo meni User.

V tem stanju ne morete spreminjati nastavitev
z zasloni stanja.

Zaklepanje menija

1 Pritisnite in pridrZite vecfunkcijsko kolesce
in pritisnite ter pridrzite gumb MENU.

2 V meniju Technical izberite Menu Settings
>User Menu with Lock.
[Opombal]
Ko pritisnete in pridrZite samo gumb MENU za
prikaz normalnega glavnega menija, je pod
moznostjo Menu Settings v meniju Technical
prikazana moznost User Menu Only. Za prikaz
menija User Menu with Lock pritisnite in pridrzite
vecfunkcijsko kolesce ter pritisnite in pridrzite gumb
MENU.

3 Nastavite na On in pritisnite gumb za
potrditev ali ve¢funkcijsko kolesce.
Zaslon v iskalu preklopi na zaslon za vnos
Stevilskega gesla.

4 Vnesite poljubno sStevilko.
Vnesite 4-mestno Stevilko v razponu od
0000 do 9999. Privzeta vrednost je 0000.
Vnesite Stevilko in pritisnite gumb za
potrditev ali ve¢funkcijsko kolesce, da
premaknete kazalec na naslednjo Stevilko.
Ko ste vnesli vse stevilke, premaknite
kazalec na SET.

5 Pritisnite gumb za potrditev ali
vecfunkcijsko kolesce.
Vnos se shrani.
PrikaZe se potrditveno sporocilo in zaslon
preklopi na prikaz menija User menu.
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6. Prikaz in nastavitve menijev: Funkcije glavhega menija

Odklepanje menija

1

Pritisnite in pridrzite vec¢funkcijsko kolesce
in pritisnite ter pridrzite gumb MENU.

o Ce je meni zaklenjen brez registracije elementov

glavnega menija z naslednje tabele v meniju User, teh

funkcij ni mogoce dodeliti dodeljivim gumbom.
o (e so te funkcije Ze bile dodeljene dodeljivim

Element glavnega
menija

Izbira dodeljivega
gumba

gumbom, se dodeljiva nastavitev na silo onemogoci
na tocki, ko je meni zaklenjen.

2 V meniju User izberite Menu Settings
>User Menu with Lock.
[Opombal]
Ko pritisnete in pridrzite samo gumb MENU za
prikaz normalnega glavnega menija, je pod
moznostjo Menu Settings v meniju Technical
prikazana mozZnost User Menu Only. Za prikaz
menija User Menu with Lock pritisnite in pridrzite
vecfunkcijsko kolesce ter pritisnite in pridrzZite
gumb MENU.

3 Nastavite na Off in pritisnite gumb za
potrditev ali ve¢funkcijsko kolesce.
Zaslon v iskalu preklopi na zaslon za vnos
Stevilskega gesla.

4 Vnesite Stevilsko geslo, da odklenete
meni.
Vnesite Stevilko in pritisnite gumb za
potrditev ali vecfunkcijsko kolesce, da

premaknete kazalec na naslednjo Stevilko.

Ko ste vnesli vse Stevilke, premaknite
kazalec na SET.

5 Pritisnite gumb za potrditev ali
vecfunkcijsko kolesce.
Vnos se shrani.
Ce vneseno $tevilsko geslo ustreza
Stevilskemu geslu, ki je bilo uporabljeno
za zaklepanje menija, se ta odklene in
prikaze.

[OQombe]

e (e vneseno Stevilsko geslo ne ustreza stevilskemu
geslu, ki je bilo uporabljeno za zaklepanje menija, se
ta ne odklene.

e Priporocljivo je, dasi §tevi|sko geslo zapisete za
primer, ¢e bi ga pozabili. Se pozabite Stevilsko geslo,
se obrnite na servisnega predstavnika podjetja Sony.

Element glavnega
menija

Izbira dodeljivega
gumba

Shooting >ISO/Gain/El
>Base Sensitivity,
Shooting >ISO/Gain/El>
Base ISO

Base ISO/Sensitivity

Shooting >Auto
Exposure >AGC

AGC

Auto ND Filter

Shooting >Auto
Exposure >Auto Shutter

Auto Shutter

Shooting >Auto
Exposure >Level

Auto Exposure Level

Thumbnail >Set Clip Clip Flag OK
Flag >Add OK

Thumbnail >Set Clip Clip Flag NG
Flag >Add NG

Thumbnail >Set Clip Clip Flag Keep
Flag >Add KEEP

Technical >Color Bars Color Bars
>Setting

Monitoring >Display Lens Info
On/Off >Lens Info

Monitoring >Display Video Signal
On/Off >Video Signal Monitor
Monitor

Monitoring >Marker Marker
>Setting

Monitoring >VF Setting VF Mode

>Color Mode

Shooting >Auto Backlight
Exposure >Mode
Shooting >Auto Spotlight

Exposure >Mode

Monitoring >Gamma
Display Assist >Setting

Gamma Display
Assist

Shooting >White >
Preset White

Preset White Select

Monitoring >Peaking Peaking
>Setting

Monitoring >Zebra Zebra
>Setting

Audio >Audio Output Glasnost

>Volume

Shooting >Focus > AF Speed/Sens.
AF Transition Speed,

Shooting >Focus >

AF Subj. Shift Sens.

Shooting >Focus > Focus Area

Focus Area

Technical >Touch
Operation >Setting

Touch Operation

Shooting >Focus >
Focus Area(AF-S)

Focus Area(AF-S)

Technical >Handle
Zoom >Setting

Handle Zoom

Shooting >Focus >
Face/Eye Detection AF

Face/Eye Detection
AF

Network >Wireless LAN
>NFC

NFC

Shooting >Focus >
Push AF Mode

Push AF Mode

Network >File Transfer
>Auto Upload (Proxy)

Auto Upload (Proxy)

User

Meni User

Shooting >S&Q Motion S&Q Motion
>Setting
Shooting >SteadyShot  SteadyShot
>Setting
Technical >Rec Review  Rec Review

>Setting
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6. Prikaz in nastavitve menijev

Meni User

Ta razdelek opisuje funkcije in nastavitve vsakega elementa menija.

User

Element Opis

Base Setting Project >element Base Setting
Focus Shooting >element Focus

S&Q Motion Shooting >element S&Q Motion
LUT On/Off Shooting >LUT On/Off item
Simul Rec Project >element Simul Rec
Proxy Rec Project >element Proxy Rec
Interval Rec Project >Interval Rec item

Assignable Button

Project >element Assignable Button

Assignable Dial

Project >element Assignable Dial

Multi Function Dial

Project >element Multi Function Dial

All File

Project >element All File

Clip Name Format

TC/Media >element Clip Name Format

Format Media

TC/Media >element Format Media

VF Setting Monitoring >element VF Setting
Zebra Monitoring >Zebra item
Zoom Technical >Zoom item

Menu Settings

Technical >element Menu Settings

Meni Edit User

PrikaZe zaslon menija Edit User.

[Opombal]

Elemente menija lahko dodajate in odstranjujete z uporabo menija Edit User v meniju User. Nastaviti je mogoce do

20 elementov.
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6. Prikaz in nastavitve menijev

Meni Edit User

Ko je v meniju User izbran meni Edit User, je slednji prikazan na vrhnji ravni.

Edit User

Element Nastavitev podelementa Opis

Add Item Meniju User doda element menija.
Dodaj element meniju

User

Customize Reset
Ponastavi elemente v
meniju User

Elemente menija, registrirane v
meniju User, ponastavi na privzete
tovarniske nastavitve.

Element menija izbran Delete
med urejanjem

IzbriSe registriran meni iz menija
User.

Move Prerazporedi registrirane elemente
menija v meniju User.
Edit Sub Item Uredi (registracija/brisanje)

registrirane podelemente menija v
meniju User.
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6. Prikaz in nastavitve menijev

Meni Shooting

Ta razdelek opisuje funkcije in nastavitve vsakega elementa menija.
Tovarnisko privzete nastavitve so prikazane s krepko pisavo (na primer 18dB).

Shooting >ISO/Gain/El
Nastavi ojacanje.

Shooting >ISO/Gain/El
Nastavi ojacanje.

Element

Nastavitev podelementa

Opis

Mode

ISO/dB

Izbere nacin nastavitve ojacanja.

I1SO/Gain<H>

Za podrobnosti o nastavitvah glejte razdelek »ISO/
Gain Settings and Default Values« (stran 100).

Nastavi privzeto vrednost ojacitve
<H>.

I1SO/Gain<M>

Za podrobnosti o nastavitvah glejte razdelek »ISO/
Gain Settings and Default Values« (stran 100).

Nastavi privzeto vrednost ojacitve
<M->.

I1SO/Gain<L>

Za podrobnosti o nastavitvah glejte razdelek »ISO/
Gain Settings and Default Values« (stran 100).

Nastavi privzeto vrednost ojacitve
<|>.

Exposure
Index<H>

Ko je moznost Base ISO nastavljena na ISO 800:

200El 7 4.0E
250El 7 4.3E
320El / 4.7E
400El / 5.0E
500El / 5.3E
640El / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250El / 6.7E
1600El / 7.0E
2000El 7 7.3E
2500El 7 7.7E
3200EIl / 8.0E

Ko je mozZnost Base ISO nastavljena na ISO 12800:

3200El /7 4.0E
4000El 7 4.3E
5000El / 4.7E
6400El / 5.0E
8000EI 7/ 5.3E
10000El / 5.7E
12800El / 6.0E
16000EI / 6.3E
20000EI / 6.7E
25600E! / 7.0E
32000El 7 7.3E
40000EI / 7.7E
51200EI / 8.0E

Nastavi indeksno vrednost
osvetlitve <H>.
Na voljo samo v nacinu Cine El.

Element Nastavitev podelementa Opis
Exposure (Enake nastavitve kot Exposure Index<H>) Nastavi indeksno vrednost
Index<M> Ko je moZnost Base ISO nastavljena na ISO 800: osvetlitve <M>.
1000EI / 6.3E
Ko je moznost Base ISO nastavljena na ISO 12800:
16000EI / 6.3E
Exposure (Enake nastavitve kot Exposure Index<H>) Nastavi indeksno vrednost
Index<L> Ko je moznost Base ISO nastavljena na ISO 800: osvetlitve <L>.
800EI / 6.0E
Ko je mozZnost Base ISO nastavljena na ISO 12800:
12800EI / 6.0E
Shockless On / Off Vklopi/izklopi funkcijo shockless
Gain gain.
Base High / Low Nastavi osnovno obcutljivost za
Sensitivity nacin SDR/HDR.
Base ISO 1SO 12800 7 1SO 800 Nastavi osnovno obcutljivost ISO

za nacin Cine El.

Shooting >ND Filter
Nastavi prednastavljene vrednosti za filter ND.

Element Nastavitev podelementa Opis

Preset1 1/4/1/8/1/16 /1/32 /1/64 /1/128 Nastavi prednastavljeno vrednost 1 za
filter ND.

Preset2 1/4/1/8/71/16 /1/32 /1/64 / 1/128 Nastavi prednastavljeno vrednost 2 za
filter ND.

Preset3 1/4/1/8/71/16 /1/32/1/64 /1/128 Nastavi prednastavljeno vrednost 3 za

filter ND.

Shooting >Shutter
Prilagodi nastavitve za pogoj delovanja elektronskega zaklopa.

Element Nastavitev podelementa Opis
Mode Speed / Angle Izbere nacin delovanja elektronskega
zaklopa.
Uporablja se za jasno snemanje hitro
premikajocih se subjektov. Izbere nacin
za nastavitev hitrosti zaklopa v sekundah
(Speed) ali v obliki kota zaklopa (Angle).
Shutter On / Off Nastavi ali naj Cas osvetlitve ob izbranem
Speed nacinu Speed sledi vrednosti Shutter
On/Off Speed, ali pa je nastavljen za polno

osvetlitev.
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6. Prikaz in nastavitve menijev: Meni Shooting

Shooting >Shutter
Prilagodi nastavitve za pogoj delovanja elektronskega zaklopa.

Shooting >Shutter

Prilagodi nastavitve za pogoj delovanja elektronskega zaklopa.

Element Nastavitev podelementa Opis Element Nastavitev podelementa Opis
Shutter 64F do 1/8000 Nastavi hitrost zaklopa, ko je moznost ECS 23,99 do 8000 Nastavi frekvenco ECS, ko je mozZnost
Speed RazpoloZljive nastavitve se lahko Mode nastavljena na Speed. Frequency RazpoloZljive nastavitve se lahko Mode nastavljena na ECS.

razlikujejo glede na frekvenco slicic

izbranega video formata.

59,94P:
64F / 32F /16F / 8F / TF / 6F / 5F / 4F /
3F/2F/1/50/1/60 /1/100 /1/120 /
1/125 /1/250 /1/500 / 1/1000 /
1/2000 / 1/4000 / 1/8000

50P:
64F / 32F /16F / 8F / 7TF / 6F / 5F / 4F /
3F/2F /1/50/1/60 /1/100 /1/120 /
1/125 /1/250 /1/500 / 171000 /
1/2000 7/ 1/4000 / 1/8000

29,97P:
64F / 32F /16F / 8F / TF / 6F / 5F / 4F /
3F/2F/1/30/1/40/1/50 /1/60 /
1/100 /17120 /1/125 / 1/250 / 1/500 /
1/1000 / 1/2000 / 1/4000 / 1/8000

25P:
64F / 32F /16F / 8F / 7TF / 6F / 5F / 4F /
3F/2F/1/25/71/33/1/50/1/60 /
1/100 /17120 / 1/125 /1/250 / 1/500 /
1/1000 /1/2000 / 1/4000 / 1/8000

24P/23.98P:
64F / 32F /16F / 8F / TF / 6F / 5F / 4F /
3F/2F/1/24/1/32/1/48 /1/50 /
1/60 /1/96 /1/100 7/ 1/120 / 1/125 /
1/250 7 1/500 /7 1/1000 7/ 1/2000 /
1/4000 / 1/8000

razlikujejo glede na frekvenco slicic
izbranega video formata.

Privzete vrednosti so prikazane spodaj.
59,94P: 60,00

50P: 50,00

29,97P: 30,00

23,98P: 23,99

25P: 25,02

24P: 24,02

Shooting >Auto Exposure
Nastavi prilagoditev samodejne osvetlitve.

Shutter Angle

64F / 32F /16F / 8F / TF / 6F / 5F / 4F /
3F / 2F /360,0° / 300,0° /

270,0° / 240,0° / 216,0° / 210,0° /
180,0° /172,8° /150,0° / 144,0° /
120,0°/90,0° 7 86,4° / 72,0° / 45,0° /
30,0°/22,5°/1,25°/5,6°

Nastavi kot zaklopa, ko je mozZnost Mode
nastavljena na Angle.

ECS On/Off

On / Off

Vklopi/izklopi funkcijo Extended Clear
Scan.

Element Nastavitev podelementa Opis
Level +3,0/+2,75/+25/+225/+2,0/ 1,75/ Nastavi raven svetlosti za samodejno
+1,5/+1,25/+1,0/+0,75/+0,5/ +0,25 / zaznano osvetlitev.
+0/-0,25/-0,5/-0,75/-1,0/-1,25/
-15/-175/-20/-225/-25/-275/
-3,0
Mode Backlight /7 Standard / Spotlight Nastavi nacin delovanja prilagoditve
samodejne osvetlitve.
Backlight:
Nacin Backlight (nacin za zmanjsano
temnost subjekta, ko je osvetljen iz
ozadja)
Standard:
Nacin Standard
Spotlight:
Nacin Spotlight (nacin za zmanjsano
prezganost bele barve, ko je subjekt
osvetljen s to¢kovnim virom svetlobe)
Speed -99 do +99 (x0) Nastavi hitrost prilagoditve za
prilagoditev samodejne osvetlitve.
AGC On / Off Vklopi/izklopi funkcijo AGC (auto gain
control).
AGC Limit Za podrobnosti 0 nastavitvah glejte Nastavi najvecje ojacanje funkcije AGC.
razdelek »AGC Limit Settings and Default
Values« (stran 102).
AGC Point F2.8/F4/F56 Nastavi vrednost zaslonke, kjer se zacne

delovanje AGC, ko je vklopljena funkcija
AGC.
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6. Prikaz in nastavitve menijev: Meni Shooting

Shooting >Auto Exposure

Nastavi prilagoditev samodejne osvetlitve.

Shooting >White
Prilagodi nastavitve beline.

Element Nastavitev podelementa

Opis

Auto Shutter On / Off

Vklopi/izklopi kontrolno funkcijo
samodejnega zaklopa.

Element Nastavitev podelementa

Opis

A.SHT Limit 17100 / 1/150 7 1/200 / 1/250 / 1/2000

Nastavi najkrajsi cas zaklopa pri funkciji
samodejnega zaklopa.

A.SHT Point ~ F5.6/ F8/ F11/ F16

Nastavi vrednost zaslonke, kjer se zacne
delovanje samodejnega zaklopa.

Tint<A> -99 do +99 (*0)

Nastavi odtenek za belino, shranjeno v
pomnilniku A.

[Opombal]

Ker je odtenek med delovanjem R/B Gain pri
vrednosti +99 prezgan, morda ne bo mogoce
prikazati pravilne vrednosti odtenka za
vrednost R/B Gain.

R Gain <A> -99,0 do +99,0 (x0,0)

Nastavi vrednost ojacitve R za belino,
shranjeno v pomnilniku A.

B Gain <A> -99,0 do +99,0 (x0,0)

Nastavi vrednost ojacitve B za belino,
shranjeno v pomnilniku A.

ColorTemp 2000 K do 15000 K (3200K)

<B>

Nastavi temperaturo barve za belino,
shranjeno v pomnilniku B.

[Opombal]

Ker je temperatura barve med delovanjem R/B
Gain pri 2000 K in 15000 K prezgana, morda
ne bo mogoce prikazati pravilne vrednosti
temperature barve za vrednost R/B Gain.

Clip High On / Off Vklopi/izklopi funkcijo, ki ignorira

light najsvetlejSe dele, da omogoci manj
izrazito reakcijo na visoko osvetljenost.

Detect 1/2/3/4/5/6/ Custom Nastavi razpon merjenja za samodejno

Window prilagajanje osvetlitve glede na svetlost
subjekta. (Ni na voljo pri ro¢nem
prilagajanju osvetlitve)

Detect On /7 Off Vklopi/izklopi indikacijo merjenja ravni

Window osvetljenosti.

Indication

Custom 40 do 999 (500) Nastavi Sirino razpona merjenja svetlobe.

Width

Custom 70 do 999 (500) Nastavi visino razpona merjenja svetlobe.

Height

Custom H -479 do +479 (x0) Nastavi vodoravni poloZaj razpona

Position merjenja svetlobe.

Custom V -464 do +464 (x0) Nastavi navpi¢ni poloZaj razpona

Position merjenja svetlobe.

Tint<B> -99 do +99 (0)

Nastavi odtenek za belino, shranjeno v
pomnilniku B.

[Opombal]

Ker je odtenek med delovanjem R/B Gain pri
vrednosti +99 prezgan, morda ne bo mogoce
prikazati pravilne vrednosti odtenka za
vrednost R/B Gain.

Shooting >White
Prilagodi nastavitve beline.

RGain<B>  -99,0 do +99,0 (x0,0)

Nastavi vrednost ojacitve R za belino,
shranjeno v pomnilniku B.

Element Nastavitev podelementa

Opis

BGain<B>  -99,0 do +99,0 (x0,0)

Nastavi vrednost ojacitve B za belino,
shranjeno v pomnilniku B.

Preset White 2000 K do 15000 K (3200K)

Nastavi privzeto vrednost beline.

Color Temp 2000 K do 15000 K (3200K)
<A>

Nastavi temperaturo barve za belino,
shranjeno v pomnilniku A.

[Opombal]

Ker je temperatura barve med delovanjem R/B
Gain pri 2000 K in 15000 K preZgana, morda
ne bo mogoce prikazati pravilne vrednosti
temperature barve za vrednost R/B Gain.

Shooting >White Setting
Prilagodi nastavitve beline.

Element Nastavitev podelementa Opis
Shockless off/1/72/3 Nastavi hitrost odziva beline pri
White preklapljanju med nacini beline.

Off: Preklop se zgodi takoj.
1do 3: Visja kot je Stevilka, pocasnejsi je
preklop.

ATW Speed 1/2/3/4/5

Nastavi hitrost odziva v nacinu ATW.
1: Najvisja hitrost odziva

White Memory / ATW
Switch<B>

Izbere nacin prilagoditve beline, ki je izbran,
ko je stikalo WHT BAL nastavljeno na B.
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6. Prikaz in nastavitve menijev: Meni Shooting

Shooting >White Setting
Prilagodi nastavitve beline.

Shooting >Offset White
Prilagodi nastavitve odmika beline.

Element Nastavitev podelementa Opis
Filter White On / Off Vklopi/izklopi funkcijo, ki nastavi pomnilnik
Memory obmocja beline za vsak filter ND.

Sveti: Nastavi pomnilnik beline za vsak
filter ND.

[Nasvet]

V prednastavljenem nacinu so Stiri

nastavitve (CLEAR /1/ 2/ 3).V variabilnem

nacinu sta dve nastavitvi (CLEAR /7 On).
Off: Nastavi pomnilnik beline, skupen

vsem filtrom ND.

Element Nastavitev podelementa Opis
Offset -99 do +99 (0) Nastavi odmik vrednosti odtenka, ki bo
Tint<ATW> dodan belini ATW, ko je mozZnost Offset

White <ATW> nastavljena na On.

Shooting >Focus
Prilagodi nastavitve ostrenja.

Element

Nastavitev podelementa

Opis

AF Transition
Speed

1(Slow) /2 /3/4/5/6/7(Fast)

Nastavi hitrost pogona ostrenja za
primere, ko se med samodejnim
ostrenjem spremeni subjekt.

Shooting >Offset White AF Subj. Shift 1(Locked On)/ 2/ 3/ 4 /5(Responsive) NasFavi obc“.utljivost za spremipjgnje
Prilagodi nastavitve odmika beline. sens. ostrlng subjekta med samodejnim
- - ostrenjem.
Element Nastavitev podelementa Opis Focus Area Wide / Zone / Flexible Spot Nastavi ciljno obmocje za samodejno
Offset White  On / Off Nastavi, ali naj se doda (On) ali ne doda ostrenje in samodejno ostrenje s
<A> (Off) vrednost odmika belini v pritiskom (AF) (stran 37).
pomnilniku A. Wide:
Offset Color  -99 do +99 (x0) Nastavi odmik temperature barve, ki bo Med ostrenjem is¢e subjekt na
Temp<A> dodan belini v pomnilniku A, ko je Sirokem obmocju slike.
moznost Offset White <A> nastavljena Zone:
na On. Samodejno is¢e tocko ostrenja
Offset -99 do +99 (x0) Nastavi odmik vrednosti odtenka, ki bo znotraj dolo¢enega obmogja.
Tint<A> dodan belini v pomnilniku A, ko je Flexible Spot:
moznost Offset White <A> nastavljena Ostri na dolo¢eno mesto v sliki.
na On. Focus Area Flexible Spot Nastavi ciljno obmocje ostrenja za
Offset White  On / Off Nastavi, ali naj se doda (On) ali ne doda (AF-S) samodejno ostrenje s pritiskom (AF-S).
<B> (Off) vrednost odmika belini v Face/Eye Face/Eye Only AF / Face/Eye Priority AF / Omogoci/onemogoci samodejno
pomnilniku B. Detection AF  Off ostrenje z zaznavanjem obrazov.
Offset Color  -99 do +99 (x0) Nastavi odmik temperature barve, ki bo Push AF AF / Single-shot AF(AF-S) Nastavi nacin pritiska za samodejno
Temp<B> dodan belini v pomnilniku B, ko je Mode ostrenje.
moZnost Offset White <B> nastavljena AF Assist On / Off Ko je moZnost nastavljena na On, vam
na On. omogoca, da zacasno preglasite
Offset -99 do +99 (x0) Nastavi odmik vrednosti odtenka, ki bo samodejno ostrenje in ostrite ro¢no.
Tint<B> dodan belini v pomnilniku B, ko je

moznost Offset White <B> nastavljena
na On.

Offset White  On / Off

Nastavi, ali naj se doda (On) ali ne doda

<ATW> (Off) vrednost odmika belini ATW.
Offset Color  -99 do +99 (x0) Nastavi odmik temperature barve, ki bo
Temp<ATW> dodan belini ATW, ko je moznost Offset

White <ATW> nastavljena na On.
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6. Prikaz in nastavitve menijev: Meni Shooting

Shooting >S&Q Motion
Prilagodi nastavitve nacina za pocasne in hitre posnetke (stran 49).

Element Nastavitev podelementa Opis
Setting On / Off Vklopi/izklopi nacin za pocasne in hitre
posnetke.

Ko je moZnost nastavljena na On, sta
slededi funkciji onemogoceni.

® Samodejna zaslonka

® Samodejno ostrenje

Shooting >Noise Suppression

Prilagodi nastavitve zmanjSevanja Suma.

[Nasvet]

Nastavitvi Setting(Custom) in Level(Custom) sta vidni v nastavitvi Target Display (stran 104).
Element Nastavitev podelementa Opis
Level Low / Mid / High Nastavi raven zmanjsevanja Suma v
(Cine El) nacinu Cine El.

Frame Rate 0d 1 do 60 slicic na sekundo /7 100 slicic na  Nastavi hitrost slicic za pocasne in hitre
sekundo /120 slic¢ic na sekundo /150 sli¢ic posnetke.
na sekundo /180 sli¢ic na sekundo /

Shooting >Flicker Reduce

Prilagodi nastavitve popravljanja migetanja.

Element Nastavitev podelementa

Opis

Mode Auto / On / Off

Nastavi nacin popravljanja migetanja.

Frequency 50Hz / 60Hz

Nastavi frekvenco vira napajanja
razsvetljave, ki povzro¢a migetanje.

Shooting >SteadyShot
Prilagodi nastavitve stabilizacije slike.

Element Nastavitev podelementa

Opis

Setting Active / Standard / Off

Nastavi funkcijo stabilizatorja slike.

[Opombal]
Moznost je omogocena, ko je namescen
zdruzljiv objektiv.

[Opomba]
200 slicic na sekundo / 240 slicic na RazpoloZljive nastavitve se lahko razlikujejo
sekundo glede na sistemsko frekvenco, kodek in video
format.
Shooting >LUT On/Off
Nastavi nastavitve LUT.
Element Nastavitev podelementa Opis
SDI/HDMI MLUT On / MILUT Off Izbere, ali dodati LUT monitorja
izhodnemu video signalu SDI in HDMI.
VF/Proxy/ MLUT On / MILUT Off Izbere, ali dodati LUT monitorja iskalu,
Stream proxyju in pretakati izhodni video signal.
Internal Rec  MLUT On / MILUT Off Izbere, ali dodati LUT monitorja

notranjemu videoposnetku.

Shooting >Noise Suppression
Prilagodi nastavitve zmanjSevanja Suma.

Nasvet

E\Iastavitlli Setting(Custom) in Level(Custom) sta vidni v nastavitvi Target Display (stran 104).
Element Nastavitev podelementa Opis
Setting On / Off Vklopi/izklopi funkcijo zmanjSevanja
(Custom) Suma v nacinu Custom.
Level Low / Mid / High Nastavi raven zmanjSevanja Suma v
(Custom) nacinu Custom.
Setting On / Off Vklopi/izklopi funkcijo zmanjSevanja

(Cine El) Suma v nacinu Cine El.
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6. Prikaz in nastavitve menijev

Meni Project

Ta razdelek opisuje funkcije in nastavitve vsakega elementa menija.
Tovarnisko privzete nastavitve so prikazane s krepko pisavo (na primer 18dB).

Project >Rec Format
Prilagodi nastavitve formata snemanja.

Element Nastavitev podelementa Opis

Project >Base Setting

Video format RazpoloZljive nastavitve se razlikujejo Nastavi format snemanja.

Prilagodi osnovne nastavitve.
glede na frekvenco in nastavitve kodeka.

El t Nastavit | t i
emen CEENIEY [P EEmEE O Frekvenca  Kodek MoZnosti izbire
Shooting Custom / Cine El Nastavi nacin snemanja (stran 24).
Mode I 59,94 RAW -
Target SDR(BT.709) / HDR(HLG) Nastavi barvni prostor posnetka/izhoda v RAW & 4096x2160P
Display nacinu Cine EL. XAVCl3840x2160P
Project >Rec Format XAVC-| 4096x2160P
Prilagodi nastavitve formata snemanja. 3840x2160P
Element Nastavitev podelementa Opis 1920x1080P
Frequency 59,94 / 50/ 29,97 /25 /24 /2398 Izbere sistemsko frekvenco. XAVC-L 3840x2160P
Imager Scan  FF 7/ S35 Nastavi kombinacijo metode branja s 1920x1080P 50
Mode sI|k0\V/neg§ senzorj.a (vse togke/ . . 1920x1080P 35
zdruZevanje tock) in nastavitve velikosti
slike s slikovnega senzorja. 50 RAW -
Kodek RAW / RAW & XAVC-1 / XAVC-I / XAVC-L Nastavi nacin snemanja/predvajanja. RAW &  4096x2160P
RAW Output  RazpoloZljive nastavitve se razlikujejo Nastavi format zapisovanja za zunanji XAVC-| 3840x2160P
Format glede na frekvenco in nastavitve kodeka. ~ snemalnik RAW. XAVC-| 4096x2160P
Frekvenca  Kodek Moznosti izbire [Opombal] 3840x2160P
59,94/ RAW 4096x2160 Ko je moZnost Codec nastavljena na RAW
50/ & XAVC-I, nastavitev Video Format zamenja 1920x1080P
2997/ 3840x2160 povezavo z nastavitvijo RAW Output Format. XAVC-L 3840x2160P
25/ Qﬁ\\j\é&; 4096x2160 1920x1080P 50
23,98 3840x2160 1920x1080P 35
iﬁ\‘;"cg; 4096x2160 RAW &  4096x2160P
XAVCL3840x2160P
XAVC 4096x2160P
3840%x2160P
1920x1080P
XAVC-L 3840x2160P

1920x1080P 50

1920x1080P 35




78St

6. Prikaz in nastavitve menijev: Meni Project

Project >Rec Format
Prilagodi nastavitve formata snemanja.

Project >Simul Rec
Prilagodi nastavitve nacina so¢asnega snemanja (stran 50).

Element Nastavitev podelementa Opis Element Nastavitev podelementa Opis
Video format 25 RAW - Setting On / Off Vklopi/izklopi funkcijo socasnega
RAW & 4096x2160P snemanja in nastavi ciljni pomnilniski
XAVC-| 3840x2160P medij za snemanje.
XAVC-|  4096x2160P Project >Proxy Rec
Prilagodi nastavitve nacina snemanja proxy.
3840x2160P - -
Element Nastavitev podelementa Opis
1920x1080P -
Setting On / Off Vklopi/izklopi nac¢in snemanja proxy.
XAVC-L 3840x2160P - - -
Audio CH1/CH2 / CH3/CH4 Izbere avdio kanal za snemanje podatkov
1920x1080P 50 Channel proxy.
1920x1080P 35 2
Project >Interval Rec
23,98 RAW - Prilagodi nastavitve nacina intervalnega snemanja (stran 49).
RAW & 4096x2160P Element Nastavitev podelementa Opis
XAVCL 3840x2160P - i ina i
Setting On / Off Vklop/izklop nacina intervalnega
XAVC-| 4096x2160P snemanja. (Vklop tega nacina bo izklopil
3840x2160P vse ostale posebne nacine.)
1920x1080P Interval Time 1/2/3/4/5/6/7/8/9/10/15/ Nastavi interval med snemanji v nacinu
20/30/40/50(s) snemanja Interval Rec (ko je moZnost
XAVC-L  3840x2160P 1/2/3/4/5/6/7/8/9/10/15/20/ Interval Rec nastavljena na On).
1920x1080P 50 30/ 40 / 50 (min)
1920<1080P 35 1/2/3/4/6/12/24 (ur)
Number of 1frame / 2frames / 3frames / 6frames / Nastavi Stevilo slicic, ki se posnamejo v
24 RAW - o A
Frames 9frames / 12frames enem posnetku v nacinu snemanja
RAW & 4096x2160P RazpoloZljive nastavitve se lahko Interval Rec (ko je moZnost Interval Rec
XAVC-| razlikujejo glede na frekvenco slicic nastavljena na On).
XAVC-I 4096x2160P izbranega video formata.
- - - 59.94P/50P:
PrOJec.t >C|n.e El Set.tlng . ) 2frames / 6frames / 12frames
Pr|lagod| nastavitve nacina Cine El. 29,97P/25P/24P/23,98P:
Element Nastavitev podelementa Opis 1frame / 3frames / 6frames / 9frames
Color Gamut  S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 Nastavi barvni prostor v nacinu Cine El. Pre-Lighting  Off / 2sec / 5sec / 10sec Nastavi koliko sekund pred zacetkom

S-Gamut3/SLog3:
Nastavi barvni prostor v nacinu Cine
El na S-Gamut3.
S-Gamut3.Cine/SLog3:
Nastavi barvni prostor v nacinu Cine
El na S-Gamut3.Cine.

snemanja v nacinu IntervalRec se vklopi
video luc.

[Nasvet]
Na voljo samo z uporabo video luci HVL-LBPC
(moznost).
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6. Prikaz in nastavitve menijev: Meni Project

Project >SDI/HDMI Rec Control

Prilagodi nastavitve upravljanja snemanja SDI/HDMI.

Project >Assignable Button

Dodeljivim gumbom nastavi dodeljive funkcije.

Element Nastavitev podelementa Opis Element Nastavitev podelementa Opis

Setting Off / SDI/HDMI Remote I/F / Parallel Rec Nastavi upravljanje zacetka/zaustavitve <1>do <9>, Off / Base ISO/Sensitivity / Dodeli funkcije dodeljivim gumbom.
snemanja na zunanji napravi prek Focus Hold AGC / Push AGC / ND Filter Base ISO/Sensitivity:
izhodnega signala SDI/HDMI. Button Position / Auto ND Filter / Push Preklopi osnovno obcutljivost slikovnega

Off:
Ne uporabljajte daljinskega
upravljalnika.

SDI/HDMI Remote I/F:
Upravljanje zacetka/zaustavitve
snemanja na povezani zunanji
napravi, ko v videokameri ni
vstavljenega pomnilniskega medija.
S pomnilniskim medijem v
videokameri ni sinhronizirano na
sli¢ico natan¢no.

Parallel Rec:
Upravljanje zacetka/zaustavitve
snemanja na povezani zunanji
napravi, ko je v videokameri vstavljen
pomnilniski medij. S pomnilniskim
medijem v videokameri je
sinhronizirano na sli¢ico natancno.

[Opombal]

Za upravljanje z izhodnim signalom HDMI
vklopite moZnost HDMI TC Out > Setting
(stran 85) v meniju TC/Media glavnega
menija.

Auto ND / Auto Iris / Push Auto
Iris / Auto Shutter / Auto
Exposure Level / Backlight /
Spotlight / Preset White

Select / ATW / ATW Hold / AF
Speed/Sens. / Focus Setting /
Focus Area / Focus Area(AF-S) /
Face/Eye Detection AF / Push
AF Mode / Push AF/Push MF /
Focus Hold / Focus Magnifier
x3/x6 / Focus Magnifier x3 /
Focus Magnifier x6 / S&Q
Motion / SteadyShot / Rec /
Rec Review / Clip Flag OK / Clip
Flag NG / Clip Flag Keep / Color
Bars / Tally [Front] / DURATION/
TC/U-BIT / Display / Lens Info /
Video Signal Monitor / Marker /
VF Adjust / VF Mode / Gamma
Display Assist / Peaking /
Zebra / Volume / Thumbnail /
Touch Operation / Handle
Zoom / NFC / Auto Upload
(Proxy) / Direct Menu / User
Menu / Menu

senzorja.
AGC:
Vklopi/izklopi funkcijo AGC.
Push AGC:
Omogodi funkcijo AGC med pritiskom gumba.
ND Filter Position:
Preklopi filtre ND.
Auto ND Filter:
Vklopi/izklopi funkcijo samodejnega filtra ND.
Push Auto ND:
Omogodi funkcijo samodejnega filtra ND med
pritiskom gumba.
Auto Iris:
Vklopi/izklopi funkcijo zaslonke.
Push Auto Iris:
Omogodi funkcijo samodejne zaslonke med
pritiskom gumba.
Auto Shutter:
Vklopi/izklopi funkcijo samodejnega zaklopa.
Auto Exposure Level:

Prikaze/zapusti neposredni meni Auto Exposure

Level.
Backlight:

Preklopi med mozZnostma Backlight in Standard.

Spotlight:

Preklopi med mozZnostma Spotlight in Standard.

Preset White Select:

Preklopi privzeto vrednost beline.
ATW:

Vklopi/izklopi funkcijo ATW.
ATW Hold:

Zacasno ustavi delovanje funkcije ATW.
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6. Prikaz in nastavitve menijev: Meni Project

Project >Assignable Button

Dodeljivim gumbom nastavi dodeljive funkcije.

Project >Assignable Button
Dodeljivim gumbom nastavi dodeljive funkcije.

Element Nastavitev podelementa Opis Element Nastavitev podelementa Opis

<1>do <9>, AF Speed/Sens.: <1>do <9>, Clip Flag OK:

Focus Hold Preklopi nastavitev hitrosti prehoda Focus Hold Izvede funkcijo Add OK.

Button samodejnega ostrenja in nastavitev obcutljivosti Button Pritisnite dvakrat za izvedbo ukaza Delete Clip

samodejnega ostrenja pri prehodu med subjekti.
Focus Setting:
Nastavi obmocje ostrenja.
Focus Area:
Nastavi obmocje ostrenja za samodejno ostrenje
in samodejno ostrenje s pritiskom.
Focus Area(AF-S):
Nastavi obmocje ostrenja za samodejno ostrenje
s pritiskom (AF-S).
Face/Eye Detection AF:
Preklopi med nastavitvami samodejnega
ostrenja z zaznavanjem obrazov/oci.
Push AF Mode:
Preklopi nastavitev nacina Push AF.
Push AF/Push MF:
V nacinu ro¢nega ostrenja med pritiskom gumba
aktivira samodejno ostrenje.
V nacinu samodejnega ostrenja med pritiskom
gumba aktivira ro¢no ostrenje.
Focus Hold:
V nacinu samodejnega ostrenja se med
pritiskom gumba izostritev ne spreminja.
Focus Magnifier x3/x6:
Focus Magnifier x3:
Focus Magnifier x6:

Vklopi/izklopi funkcijo povecevalnika za ostrenje.

S&Q Motion:
Vklopi/izklopi nacin za pocasne in hitre
posnetke.
Ob pritisku in pridrzanju nastavi hitrost slicic pri
snemanju.
SteadyShot:
Preklopi med moZnostmi Active, Standard in Off.
Rec:
Zacne/zaustavi snemanje.
Rec Review:
Vklop/izklopi funkcijo Rec Review.

Flag.
Clip Flag NG:
Izvede funkcijo Add NG.
Pritisnite dvakrat za izvedbo ukaza Delete Clip
Flag.
Clip Flag Keep:
Izvede funkcijo Add Keep.
Pritisnite dvakrat za izvedbo ukaza Delete Clip
Flag.
Color Bars:
Vklopi/izklopi barvne vrstice.
Tally [Front]:
Vklopi/izklopi funkcijo svetenja/utripanja
indikatorja snemanja.
DURATION/TC/U-BIT:
Preklopi med moznostmi Time Code, User Bit in
Duration.
Zaslon:
Vklopi/izklopi indikatorje na zaslonu.
Lens Info:
Preklopi indikator globinske ostrine.
Video Signal Monitor:
Preklopi monitor video signala (kot je monitor
valovne oblike).
Marker:
Vklopi/izklopi funkcijo oznacbe.
VF Adjust:
Prikaze Crte za prilagajanje svetlosti zaslona
iskala.
VF Mode:
Preklopi med barvnim in ¢rno-belim prikazom
slike na zaslonu iskala.
Gamma Display Assist:
Preklopi funkcijo pomoci za gammo zaslona.
Peaking:
Vklopi/izklopi funkcijo peaking.
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6. Prikaz in nastavitve menijev: Meni Project

Project >Assignable Button

Dodeljivim gumbom nastavi dodeljive funkcije.

Project >Assignable Dial

Nastavi dodelitve funkcij dodeljivemu kolescu in nastavi smer vrtenja.

Element Nastavitev podelementa Opis Element Nastavitev podelementa Opis
<1>do <9>, Zebra: Kolesce na Off / ISO/Gain/El / ND Filter / IRIS / Auto  Dodeli funkcije dodeljivemu kolescu na
Focus Hold Vklopi/izklopi funkcijo Zebra. rocaju Exposure Level / Audio Input Level / Multi  rocaju.
Button Volume: Function Dial ISO/Gain/El:

Prilagodi izhodno raven zvoka monitorja na Prilagodi ojacanje ali El.

prikljucek za slusalke in vgrajen zvocnik. ND Filter:

Thumbnail: Prilagodi filter ND.
Prikaze/zapusti zaslon slicic. IRIS:

Touch Operation:

Vklopi/izklopi upravljanje na dotik.
Handle Zoom:

Preklopi delovanje zooma na drzalu.
NFC:

Izvede funkcijo NFC.
Auto Upload (Proxy):

Vklopi/izklopi samodejni prenos datoteke proxy.

Direct Menu:

PrikaZe/zapusti neposredni meni.
User Menu:

Prikaze/zapusti meni User.
Menu:

Prikaze/zapre glavni meni.

Prilagodi zaslonko.
Auto Exposure Level:

Prilagodi raven samodejne osvetlitve.
Audio Input Level:

Prilagodi glasnost snemanja zvoka.
Vecfunkcijsko kolesce:

Deluje kot vecfunkcijsko kolesce.

Smer kolesca Normal / Opposite
na rocaju

Nastavi smer vrtenja dodeljivega kolesca
na rocaju.

Normal: Vrtenje v normalni smeri.
Opposite: Vrtenje v nasprotni smeri.

Project >Multi Function Dial
Dodeli funkcije vecfunkcijskemu kolescu.

Project >Assignable Dial

Nastavi dodelitve funkcij dodeljivemu kolescu in nastavi smer vrtenja.

Element Nastavitev podelementa Opis
Kolesce na Off / 1SO/Gain/El / ND Filter / IRIS / Auto  Dodeli funkcije dodeljivemu kolescu.
drzalu/ Exposure Level / Audio Input Level ISO/Gain/El:
daljinskem Prilagodi ojacanje ali El.
upravljalniku ND Filter:
Prilagodi filter ND.
IRIS:

Prilagodi zaslonko.
Auto Exposure Level:

Prilagodi raven samodejne osvetlitve.

Audio Input Level:

Prilagodi glasnost snemanja zvoka.

Element Nastavitev podelementa Opis
Default Off / IRIS / ISO/Gain/El / Auto Exposure Vecfunkcijskemu kolescu dodeli privzeto
Function Level / Audio Input Level funkcijo.
IRIS:
Prilagodi zaslonko.
ISO/Gain/El:

Prilagodi ojacanje ali El.
Auto Exposure Level:

Prilagodi raven samodejne osvetlitve.
Audio Input Level:

Prilagodi glasnost snemanja zvoka.

Smer kolesca Normal / Opposite
na drzalu

Nastavi smer vrtenja dodeljivega kolesca.

Normal: Vrtenje v normalni smeri.
Opposite: Vrtenje v nasprotni smeri.
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6. Prikaz in nastavitve menijev: Meni Project

Project >User File

Prilagodi nastavitve, povezane z upravljanjem uporabniske datoteke.

Element Nastavitev podelementa Opis

Load Execute/Cancel NalozZi nastavitve uporabniske datoteke s

Media(B) pomnilniske kartice, ki je vstavljena v rezo
za kartice CFexpress tipa A/SD (B).
Execute: Izvedite funkcijo.

Save Execute/Cancel Shrani nastavitve uporabniske datoteke

Media(B) na pomnilnisko kartico, ki je vstavljena v
rezo za kartice CFexpress tipa A/SD (B).
Execute: Izvedite funkcijo.

File ID Prikaze zaslon za prikaz/urejanje ID-ja
datoteke uporabniskih datotek.

Load On / Off Nastavi, ali naj se naloZijo prilagojeni

Customize podatki menija User, ko je izveden ukaz

Data Load Media(B).

Load White On / Off Nastavi, ali naj se naloZijo podatki o

Data nastavitvi belin, ko je izveden ukaz Load

Media(B).

Project >All File

Prilagodi nastavitve, povezane z datotekami ALL.

Element Nastavitev podelementa Opis

Load Execute/Cancel NaloZi datoteko ALL.

Media(B) Execute: Izvedite funkcijo.

Save Execute/Cancel Shrani datoteko ALL.

Media(B) Execute: Izvedite funkcijo.

File ID Datoteki dodeli ime.

Load Network On / Off Nastavi, ali naj se naloZijo informacije o
Data nastavitvah menija Network, ko je

izveden ukaz Load Media(B).
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6. Prikaz in nastavitve menijev

Meni Paint/Look

Ta razdelek opisuje funkcije in nastavitve vsakega elementa menija.
Tovarnisko privzete nastavitve so prikazane s krepko pisavo (na primer 18dB).

Paint/Look >Base Look

Nastavi nastavitve, ki so povezane z osnovnim videzom.

el 00k =5 = Element Nastavitev podelementa Opis
aint/Look >Scene File -
. . . . . Vhod S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3  Nastavi vhodno barvno lestvico za
Prilagodi nastavitve, povezane s scenskimi datotekami. . . S
X X izbrani osnovni videz.
Element Nastavitev podelementa Opis
. - - Izhod BT.709 / HLG Nastavi izhodno barvno lestvico za
Recall NaloZi datoteko s prizorom, ki je A . ) S
. . L izbrani osnovni videz.
shranjena v notranjem pomnilniku, in
uporabi nastavitve kot nastavitve AE Level OEV /1/3EV / 2/3EV /1EV / 4/3EV / Nastavi referen¢no vrednost osvetlitve
kakovosti trenutne slike. Offset 5/3EV / 2EV za izbrani osnovni videz.
Store Shrani stanje kakovosti trenutne slike kot Paint/Look > Reset Paint Settings
datoteko s prizorom v notranji pomnilnik. Ponastavi nastavitve menija Paint/Look z izjemo osnovnega videza.
Brisanje IzbriSe datoteko s prizorom iz notranjega Element Nastavitev podelementa Opis
pomnilnika. Reset Execute/Cancel Ponastavi nastavitve menija Paint/Look z

Preset Recall Ko je nastavitev Shooting Mode

nastavljena na Custom in je nastavitev

Target Display nastavljena na SDR(BT.709):
S-Cinetone / Standard 7 Still / ITU709

Ko je nastavitev Shooting Mode

nastavljena na Custom in je nastavitev

Target Display nastavljena na HDR(HLG):
HLG Live / HLG Natural

Uporabi nastavitve kakovosti
prednastavljene slike (zapisljive) kot
nastavitve kakovosti trenutne slike.

without Base

Look

izjemo osnovnega videza.
Execute: Izvedite funkcijo.

Paint/Look > Black
Prilagodi nastavitve Crnine.

Paint/Look >Base Look
Nastavi nastavitve, ki so povezane z osnovnim videzom.

Element Nastavitev podelementa Opis

Master Black -99,0 do +99,0 (+0,0) Nastavi raven master ¢rnine.
R Black -99,0 do +99,0 (x0,0) Nastavi raven ¢rnine R.

B Black -99,0 do +99,0 (x0,0) Nastavi raven ¢rnine B.

Element Nastavitev podelementa Opis

Select Ko je nastavitev Shooting Mode Izbere osnovni videz.
nastavljena na Custom in je nastavitev
Target Display nastavljena na SDR(BT.709):
S-Cinetone / Standard / Still /
ITU709 / User1 to User16
Ko je nastavitev Shooting Mode
nastavljena na Custom in je nastavitev
Target Display nastavljena na HDR(HLG):
HLG Live / HLG Natural / User1 to
User16
Ko je nastavitev Shooting Mode
nastavljena na Cine El:
s709 / 709(800) / S-Log3 / Userl to

User16

Paint/Look >Knee
Prilagodi nastavitve popravkov kolena.

Element

Nastavitev podelementa

Opis

Setting

Ko je moznost Target Display nastavljena
na SDR(BT.709):

On / Off / ---
Ko je moznost Target Display nastavljena
na HDR(HLG):

On / Off / ---

Vklopi/izklopi funkcijo popravkov kolena.

Brisanje IzbriSe izbrani osnovni videz.

Auto Knee

Ko je mozZnost Target Display nastavljena
na SDR(BT.709):

On / Off / ---
Ko je mozZnost Target Display nastavljena
na HDR(HLG):

On / Off / ---

Vklopi/izklopi funkcijo samodejnih
popravkov kolena.

Delete All IzbriSe vse osnovne videze.

Point

75 % do 109 % (90 %)

Nastavi tocko kolena.

Nalozi datoteko z osnovnim videzom z
zapisovalnega medija.

Import

Slope

-99 do +99 (0)

Nastavi naklon kolena.




84 5L| 6. Prikaz in nastavitve menijev: Meni Paint/Look

Paint/Look > Detail
Nastavi nastavitve prilagajanja podrobnosti.

Paint/Look > Matrix
Prilagodi nastavitve popravkov matrice.

Element Nastavitev podelementa Opis Element Nastavitev podelementa Opis
Setting on / Off Vklopi/izklopi funkcijo podrobnosti. User Matrix ~ -99 do +99 (0) Nastavi uporabnisko dolo¢eno
— - . B-G uporabnisko matrico B-G.

Level -7 do +7 (x0) Nastavi raven podrobnosti.

Manual On / Off / --- Vklopi/izklopi funkcijo ro¢ne nastavitve Paint/Look > Multi Matrix

Setting podrobnosti. Prilagodi nastavitve popravkov multi matrice.

V/H Balance -2 do +2 (x0) Nastavi razmerje med navpi¢nimi (V) in Element Nastavitev podelementa Opis
\:;S;rjli\tlg:/rrgo(glr)oit:]cérsciibnostm| arocno Setting On / Off Vklopi/izklopi funkcijo popravkov multi

- - R matrice.

B/W Balance  Typel/Type2/ Type3 /Type4 / Types gsztrz\gr:zz{nmei”zzr;:gcfrc:];\?;ltije)na Ponastavitev  Execute/Cancel Ponastavi odtenek in nasicenost za vsako
obmodja in belimi (W) podrobnosti za . osno barvo na privzete vrednosti.
mocno osvetljena obmodja za roéno Axis B/B+/MG-/MG/MG+/R/R+/YL-/ lIzbere os.
nastavitev podrobnosti YL/YL+/G-/G/G+/CY/CY+/B-

Limit Oto7 Nastavi raven omejitve podrobnosti za Hue 99 do +99 (20) Nastavi odtenek barve, uporabljene za
rocno nastavitev podrobnosti. - poprav.ke m_Lth' matrice. -

Crispening 0to7 Nastavi raven izrazitosti barve za roéno Saturation -99 do +99 (x0) Nastavi nasi¢enost barve, uporabljene za
nastavitev podrobnosti. popravke multi matrice.

High Light Oto4 Nastavi raven podrobnosti moc¢no

Detail osvetljenih obmocij za ro¢no nastavitev

podrobnosti.

Paint/Look > Matrix
Prilagodi nastavitve popravkov matrice.

Element Nastavitev podelementa Opis

User Matrix On / Off Vklopi/izklopi funkcijo popravkov
uporabniske matrice.

User Matrix -99 do +99 (x0) Prilagodi nasicenost barv celotne slike.

Level

User Matrix ~ -99 do +99 (x0) Prilagodi ton barv (fazo) celotne slike.

Phase

User Matrix ~ -99 do +99 (0) Nastavi uporabnisko dolo¢eno

R-G uporabnisko matrico R-G.

User Matrix ~ -99 do +99 (x0) Nastavi uporabnisko doloc¢eno

R-B uporabnisko matrico R-B.

User Matrix ~ -99 do +99 (x0) Nastavi uporabnisko doloc¢eno

G-R uporabnisko matrico G-R.

User Matrix ~ -99 do +99 (x0) Nastavi uporabnisko dolo¢eno

G-B uporabnisko matrico G-B.

User Matrix ~ -99 do +99 (x0) Nastavi uporabnisko dolo¢eno

B-R uporabnisko matrico B-R.
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6. Prikaz in nastavitve menijev

Meni TC/Media

Ta razdelek opisuje funkcije in nastavitve vsakega elementa menija.
Tovarnisko privzete nastavitve so prikazane s krepko pisavo (na primer 18dB).

TC/Media >HDMI TC Out
Prilagodi nastavitve povezane z izhodom ¢asovne kode ob uporabi izhoda HDMI.

TC/Media >Timecode
Prilagodi nastavitve casovne kode.

Element

Nastavitev podelementa

Opis

Element

Nastavitev podelementa

Opis

Mode

Preset / Regen / Clock

Nastavi nacin, kako tece ¢asovna koda.
Preset:
Teci zacne od prednastavljene
vrednosti.
Regen:
Teci zacne od ¢asovne kode na
zakljucku prejSnjega posnetka.
Clock:
Kot ¢asovno kodo uporabi notranjo
uro.

Setting

on / Off

Nastavi, ali naj se posilja ¢asovna koda na
naprave za druge namene z uporabo
izhoda HDMI.

Run

Rec Run / Free Run

Rec Run: TeCe samo med snemanjem.
Free Run: Tece vedno ne glede na
delovanje videokamere.

Setting

Casovno kodo nastavi na poljubno
vrednost.
SET: Nastavite vrednost.

Ponastavitev  Execute/Cancel Ponastavi ¢asovno kodo na 00:00:00:00.
Execute: Izvedite funkcijo.
TC Format DF / NDF Nastavi format casovne kode.

DF: Drop Frame
NDF: Non-Drop Frame

TC/Media >TC Display

Prilagodi nastavitve prikaza podatkov o casu.

Element

Nastavitev podelementa

Opis

Display Select Timecode / Users Bit / Duration

Switches the time data display.

TC/Media >Users Bit

Prilagodi nastavitve povezane z uporabniskimi biti.

Element

Nastavitev podelementa

Opis

Mode

Fix / Time

Nastavi nacin uporabniskih bitov.

Fix: V uporabniskih bitih uporabi
poljubno fiksno vrednost.

Time: V uporabniskih bitih uporabi
trenuten cas.

Setting

Uporabniske bite nastavi na poljubno
vrednost.
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TC/Media >Clip Name Format

Prilagodi nastavitve povezane s poimenovanjem in brisanjem posnetkov.

TC/Media >Update Media

Na pomnilniskih karticah posodobi datoteko za upravljanje.

Element

Nastavitev podelementa

Opis

Element Nastavitev podelementa

Opis

Title Prefix

nnn_ (nnn so zadnje 3 Stevilke serijske

Stevilke)

(Najvec 7-Stevil¢ni zaslon)

Nastavi naslovni del (4 do 46 znakov)
imena posnetka.
Odpre zaslon za vnos niza znakov.

Struktura zaslona za vnos niza znakov
Obmocje za izbiro znakov (3 vrstice):

Izbere znake, ki bodo vstavljeni na
poloZaju kazalca v obmocju Title
Prefix.

1#$%()+.-.;=@| ]*_~0123456789
abcdefghijkimnopqrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ

Obmocje delovanja kazalca (1 vrstica):

Space: Na polozaju kazalca vstavi
presledek.

<—: Premakne kazalec na levo.
—: Premakne kazalec na desno.
BS: IzbriSe znak levo od kazalca.

Obmodje Title Prefix (1 vrstica):

Obmocje za vnos naslova.

Za nastavitev naslova

1

V obmocju za izbiro znakov z
vecfunkcijskim gumbom (stran 7)
izberite znak, ki ga Zelite vstaviti na
mesto kazalca v obmocju Title Prefix,
in pritisnite gumb za potrditev na
vecfunkcijskem gumbu. (Vstavi se
izbrani znak in kazalec se premakne v
desno.)

Za nastavitev naslova ponovite 1.
korak. (Uporabite BS kot je
zahtevano.)

Ko nastavite naslov, izberite moZnost
Done, da zaprete zaslon za vnos
znakov.

Media(A) Execute/Cancel

Posodobi datoteko za upravljanje na
pomnilniski kartici v rezi A.
Execute: Izvedite funkcijo.

Media(B) Execute/Cancel

Posodobi datoteko za upravljanje na
pomnilniski kartici v rezi B.
Execute: Izvedite funkcijo.

TC/Media >Format Media
Inicializira pomnilniske kartice.

Element Nastavitev podelementa

Opis

Media(A) Full Format / Quick Format / Cancel

Formatira pomnilnisko kartico v rezi A.

Media(B) Full Format / Quick Format / Cancel

Formatira pomnilnisko kartico v rezi B.

Number Set

0001 do 9999

Imenu posnetka nastavi 4-mestno
Stevil¢no pripono.




6. Prikaz in nastavitve menijev

Meni Monitoring

Ta razdelek opisuje funkcije in nastavitve vsakega elementa menija.
Tovarnisko privzete nastavitve so prikazane s krepko pisavo (na primer 18dB).

Monitoring >Display On/Off
Prilagodi nastavitve elementov zaslona.

Monitoring >Output On/Off
Prilagodi nastavitve video izhoda.

Element Nastavitev podelementa Opis
SDI On / Off Vklopi/izklopi izhod SDI.
HDMI On / Off Vklopi/izklopi izhod HDMI.

Monitoring >Output Format
Prilagodi nastavitve izhodnega formata.

Element Nastavitev podelementa Opis
SDI Za podrobnosti o nastavitvah glejte Nastavi izhodno locljivost izhodov SDI in
HDMI razdelek »lzhodni formati in omejitve« HDMI.

(stran 110).

Monitoring >Output Display
Prilagodi nastavitve izhodnega signala.

Element Nastavitev podelementa Opis

SDI On / Off PrikazZe, ali so meni in podatki o stanju
dodani izhodnemu signalu SDI.

HDMI On / Off PrikazZe, ali so meni in podatki o stanju

dodani izhodnemu signalu HDMI.

Element Nastavitev podelementa Opis
Network On / Off Izbere elemente za prikaz v iskalu.
Status

File Transfer ~ On / Off
Status

Rec/Play On / Off
Status

RAW Output  On / Off
Control

Status

Tally On / Off
Battery On / Off
Remain

Focus Mode  On / Off
Focus On / Off
Position

Focus Area On / Off
Indicator

Focus Area On / Off
Ind.(AF-S)

Face/Eye On / Off
Detection

Frame

Lens Info On / Off
Imager Scan  On / Off
Mode

Rec Format On / Off
Frame Rate On / Off
Zoom On / Off
Position

UWP RF Level On / Off
SteadyShot  On / Off
Base Look/ On / Off
LUT

SDI/HDMI On / Off
Rec Control

Gamma On / Off

Display Assist
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Monitoring >Display On/Off
Prilagodi nastavitve elementov zaslona.

Monitoring >Marker
Prilagodi nastavitve prikaza oznacb.

Element Nastavitev podelementa Opis Element Nastavitev podelementa Opis
Proxy Status  On / Off Setting On / Off Vklopi/izklopi prikaz vseh oznacb.
Base ISO/ On / Off Color White / Yellow / Cyan / Green / Magenta / Izbere oznacevalno barvo oznacbe.
Sensitivity Red / Blue
Media Status  On / Off Center 1727374/ 0Off Izbere osrednjo oznacbo.
Video Signal  Off / Waveform / Vector / Histogram Marker
Monitor Safety Zone  On / Off Vklopi/izklopi oznacbo varnega obmogja.
Clip Name On / Off Safety Area 80% / 90% / 92.5% / 95% Izbere velikost oznacbe varnega obmocja
White On / Off (kot odstotek velikosti celotne slike).
Balance o Aspect Line / Mask / Off Izbere tip oznacbe razmerja.
SceneFile  On/ Off Marker _ S _
Focus on/ Off Aspect Mask  0do 15 (12) Nastavw raven video signala izven
) - oznacbe.
Indicator A Safi On / Off Vklopi/izklopi do) j
Auto On / Off spect Safety On / Off oplwlz opi oznacbo razmerja varnega
Exposure - Zone obmogja.
Mode Aspect Safety 80% / 90% / 92.5% / 95% Izbere velikost oznacbe razmerja varnega
AUTO On / Off Area g)lti)krz)oqa (kot odstotek velikosti celotne
Exposure — p
Level Aspect Select 1:1/4:3/13:9/14:9/15:9/16:9/17:9/ Nastavi nacin pri prikazu oznacbe
Timecode on / Off 1.66:1/ 1.?5:1 /2.35:1/ 2.39:1/ Custom razmer!a. ' ' .
- Custom Enter arbitrary value (01.00:01.00) Nastavi razmerje med stranicami na
ND Filter On / Off Aspect Ratio poljubno vrednost.
Iris On / Off [Opomba]
ISO/Gain/El On / Off Ta nastavitev je mogoca, ko je nastavitev
Zaklop On / Off Aspect Select nastavljena na Custom.
Guide Frame On / Off Vklopi/izklopi prikaz vodilnega okvirja.
Level Gauge On/ Off — : "
- 100% Marker On / Off Vklopi/izklopi 100 % oznacbo.
Audio Level  On / Off
Meter User Box On / Off Vklopi/izklopi prikaz oznacbe
Video Level on / Off uporabnvlskega pra\iokotnlka. _
Warning User Box 3 do 479 (240) Nastavi Sirino oznacbe uporabnisSkega
Clip Number  On / Off Width pravokgtnlka (razdaljo od sredine do
- — levega in desnega roba).
Notice On / Off User Box 3 do 269 (135) Nastavi visino oznac¢be uporabniskega
Message Height pravokotnika (razdaljo od sredine do
zgornjega in spodnjega roba).
User Box H -476 do +476 (0) Nastavi vodoravni polozaj sredisca
Position oznacbe uporabniskega pravokotnika.
User Box V -266 do +266 (0) Nastavi navpicni poloZaj sredisca
Position oznacbe uporabniskega pravokotnika.
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Monitoring >VF Setting
Prilagodi nastavitve iskala.

Element Nastavitev podelementa

Opis

Brightness 1t015(8)

Prilagodi svetlost slike v iskalu.

Color Mode Color/B&W

Izbere nacin prikaza iskala v nacinu E-E/
snemanje.

Monitoring >Gamma Display Assist

Prilagodi nastavitve pomoci za gammo zaslona.

Element Nastavitev podelementa

Opis

Setting On / Off

Vklopi/izklopi funkcijo za izboljSan prikaz
game v nacinu Custom, ko je mozZnost
Target Display nastavljena na HDR(HLG).

Monitoring >Peaking
Prilagodi nastavitve za funkcijo Peaking.

Element Nastavitev podelementa Opis

Setting On / Off Vklopi/izklopi funkcijo peaking.

Peaking Level High / Mid / Low Nastavi raven signala barvnega peakinga.
Color B&W / Red / Yellow / Blue Izbere barvo signala barvnega peakinga.

Monitoring >Zebra
Prilagodi nastavitve vzorca zebra.

Element Nastavitev podelementa

Opis

Setting Off / Zebral / Zebra2

Izbere tip vzorca zebra (Off, Zebra 1, Zebra
2).

Zebral Level 0 % do 109 % (70 %)

Nastavi raven prikaza za Zebra 1.

Zebral 2% do 20 % (10%)
Aperture
Level

Nastavi raven odprtosti za Zebra 1.

Zebra2 Level 0 % do 109 % (100 %)

Nastavi raven prikaza za Zebra 2.
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Meni Audio

Ta razdelek opisuje funkcije in nastavitve vsakega elementa menija.
Tovarnisko privzete nastavitve so prikazane s krepko pisavo (na primer 18dB).
Glejte »Sheme delovanja« (stran 124).

Audio >Audio Input
Prilagodi nastavitve avdio vhoda.

Audio >Audio Input
Prilagodi nastavitve avdio vhoda.

Element Nastavitev podelementa Opis

CH1 Input INPUT1 / Internal MIC / Shoe CH1 Preklopi vhodni vir za snemanje na

Select kanalu 1.

CH2 Input INPUT1 / INPUT2 / Internal MIC / Shoe CH2 Preklopi vhodni vir za snemanje na

Select kanalu 2.

CH3 Input Off / INPUT1 / Internal MIC / Shoe CH1 Preklopi vhodni vir za snemanje na

Select kanalu 3.

CH4 Input Off / INPUT1 / INPUT2 / Internal MIC / Preklopi vhodni vir za snemanje na

Select Shoe CH2 kanalu 4.

INPUT1T MIC -80dB / -70dB / -60dB / -50dB / -40dB / Nastavi referenc¢no raven snemanja za

Reference -30dB mikrofonski vhod XLR na vhodu INPUT1.

INPUT2 MIC  -80dB / -70dB / -60dB / -50dB / -40dB / Nastavi referencno raven snemanja za

Reference -30dB mikrofonski vhod XLR na vhodu INPUT2.

Line Input +4dB / 0dB / -3dB / EBUL Nastavi referencno raven vhoda, ko je

Reference stikalo INPUT1/INPUT2 nastavljeno na
LINE.

Reference -20dB / -18dB / -16dB / -12dB / EBUL Nastavi raven snemanja 1 kHz

Level referenénega tonskega signala.

CH1 Wind On / Off Omogoci/onemogoci zmanjSevanje

Filter Suma vetra na kanalu 1.

CH2 Wind On / Off Omogoci/onemogoci zmanjsevanje

Filter Suma vetra na kanalu 2.

CH3 Wind On / Off Omogoci/onemogoci zmanjsevanje

Filter Suma vetra na kanalu 3.

CH4 Wind On / Off Omogoci/onemogoci zmanjsevanje

Filter Suma vetra na kanalu 4.

CH3 Level Auto / Manual Nastavi samodejno ali ro¢no prilagajanje

Control ravni avdio vhoda na kanalu 3.

[Opombal]
Ce sta tako moznost CH3 Input Select kot
moznost CH4 Input Select nastavljeni na

Internal MIC, se CH4 v povezavi s to nastavitvijo

preklopi na automatic/manual.

Element Nastavitev podelementa Opis

CH4 Level Auto / Manual Nastavi samodejno ali ro¢no prilagajanje

Control ravni avdio vhoda na kanalu 4.
[ppomba]

Ce sta tako moZnost CH3 Input Select kot
moZnost CH4 Input Select nastavljena na
Internal MIC, se CH4 v povezavi z nastavitvijo
CH3 Level Control preklopi na automatic/
manual.

CH3 Input 0to 99 (49) Nastavi vhodno raven za snemanje na

Level kanalu 3.

CH4 Input 0to 99 (49) Nastavi vhodno raven za snemanje na

Level kanalu 4.

Audio Input  0do 99 Nastavi raven avdio vhoda.

Level Glede na nastavitve moZnosti CH1 Level
do CH4 Level, se lahko uporabi kot glavna
nastavitev glasnosti.

Limiter Mode Off / -6dB /-9dB / -12dB / -15dB / -17dB  Izbere lastnosti omejevalnika za velike
vhodne signale, ko ro¢no nastavljate
raven avdio vhoda.

CH1&2 AGC Mono / Stereo Nastavi samodejni nacin prilagajanja

Mode ravni za kanal 1in kanal 2. Pri nastavitvi
Stereo je AGC povezan med kanaloma.

CH3&4 AGC  Mono / Stereo Nastavi samodejni nacin prilagajanja

Mode ravni za kanal 3 in kanal 4. Pri nastavitvi
Stereo je AGC povezan med kanaloma.

AGC Spec -6dB / -9dB / -12dB / -15dB / -17dB Izbere lastnosti AGC-ja.

1kHz Tone on  On / Off Vklopi/izklopi 1 kHz referencni tonski

Color Bars signal ob prikazu barvnih vrstic.

[Opombal]

Ko je mozZnost nastavljena na On, je 1 kHz
referencni tonski signal nastavljen za snemanje
na kanalu 3 in kanalu 4, tudi ¢e sta moznosti
CH3 Input Select in CH4 Input Select nastavljeni
na Off.




91st

6. Prikaz in nastavitve menijev: Meni Audio

Audio >Audio Input
Prilagodi nastavitve avdio vhoda.

Audio >Audio Output
Prilagodi nastavitve avdio izhoda.

Element Nastavitev podelementa Opis Element Nastavitev podelementa Opis
CH1 Level Vhod brez adapterja XLR Nastavi kombinacijo prilagoditev ravni Monitor CH CH1/CH2 / CH3/CH4 / MIX ALL / CH1/ Izbere izhod avdio kanala na prikljucek za
Audio Input Level / Side / Level+Side  avdio vhoda, omogocenih za kanal 1. CH2 / CH3 / CH4 slusalke in vgrajen zvocnik.
Vhod z a.dapterjem XLR (stran 47) [Opombal [Opomba]
Audio Input Level / Through »Side« se nanasa na kolesce AUDIO LEVEL (CH1) Ce je avdio za ve¢ kanalov nastavijen na
na stranskem delu videokamere. Ko je izbrana socasni izhod, se izhodna raven vsakega kanala
moznost Level+Side, je raven snemanja zvoka na izhodu zmanjsa, da se prepreci kliping.
dolocena s kombinacijo nastavitev Audio Input Glasnost 0to 50 Prilagodi izhodno raven zvoka monitorja
: Level in .nastawt.ev kc.J.Iesca.(stran ‘.124). : na prikljucek za slualke in vgrajen
CH2 Level Vhod brez adapterja XLR Nastavi kombinacijo prilagoditev ravni 2voenik.
Vh gudn():I Ingut. Lev)e(IL/RSu:e / :c;veHSlde avdio vhoda, omogocenih za kanal 2. Headphone  Mono / Stereo Izbere, ali je izhod na prikljucku za
oAjdaioalz el?telr_];vel /(;:f;u h) [Opombal] Out slusalke mono (Mono) ali stereo (Stereo).
Audio Input Level »Side« 3 :
9 Side«se nanasa na kolesce AUDIO LEVEL Alarm Level  0do7(4) Nastavi glasnost alarma.
(CH2) na stranskem delu videokamere. Ko je
izbrana moznost Level+Side, je raven snemanja HDMI Output CH1/CH2 / CH3/CH4 Nastavi kombinacijo avdio kanalov na
zvoka dolocena s kombinacijo nastavitev Audio CH izhodu HDMI.
Input Level in nastavitev kolesca (stran 124).
CH3 Level Vhod brez adapterja XLR Nastavi kombinacijo prilagoditev ravni
Audio Input Level / CH3 Input Level /  avdio vhoda, omogocenih za kanal 3.
Level+CH3 Input Level
Vhod z adapterjem XLR (stran 47)
Audio Input Level / Through
CH4 Level Vhod brez adapterja XLR Nastavi kombinacijo prilagoditev ravni

Audio Input Level / CH4 Input Level /

Level+CH4 Input Level

Vhod z adapterjem XLR (stran 47)
Audio Input Level / Through

avdio vhoda, omogocenih za kanal 4.
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Meni Thumbnail

Ta razdelek opisuje funkcije in nastavitve vsakega elementa menija.
Tovarnisko privzete nastavitve so prikazane s krepko pisavo (na primer 18dB).

Thumbnail (Slicica)

Thumbnail >Transfer Clip (Proxy)
Prenese posnetke proxy.

[Opombal]

Moznosti Transfer Clip (Proxy) ni mogoce konfigurirati, ko moZnost Access Authentication > Password v meniju

Network ni dolocena.

Element Nastavitev podelementa Opis
Display Clip Prikaze zaslon z lastnostmi posnetka.
Properties

Thumbnail > Set Clip Flag

Prilagodi nastavitve zastavice posnetka.

Element Nastavitev podelementa Opis

Select Clip Prenese posnetke proxy, ki ustrezajo
izbranim posnetkom.

All Clips Prenese posnetke proxy, ki ustrezajo

vsem posnetkom.

[Opombal]
Prenesti je mogoce do 200 posnetkov.

Element Nastavitev podelementa Opis

Add OK Doda zastavico OK.
Add NG Doda zastavico NG.
Add KEEP Doda zastavico Keep.
Delete Clip Izbrise vse zastavice.
Flag

Thumbnail >Filter Clips

Prilagodi nastavitve posnetkov za prikaz.

Thumbnail >Lock/Unlock Clip
Prilagodi nastavitve zascite posnetka.

Element Nastavitev podelementa Opis

Select Clip Izbere in zaklene/odklene posnetek.
Lock All Clips Zaklene vse posnetke.

Unlock All Odklene vse posnetke.

Clips

Thumbnail >Delete Clip
Izbrise posnetke.

Element Nastavitev podelementa Opis

OK (Uspesno) Prikaze samo posnetke, ki imajo zastavico
OK.

NG Prikaze samo posnetke, ki imajo zastavico
NG.

KEEP Prikaze samo posnetke, ki imajo
zastavico Keep.

None Prikaze samo posnetke, ki nimajo
zastavice.

Vse PrikaZe vse posnetke ne glede na

zastavice.

Thumbnail >Customize View
Preklopi pogled zaslona slicic.

Element Nastavitev podelementa Opis
Select Clip Izbrise izbrani posnetek.
All Clips Izbrise vse posnetke.

Thumbnail >Transfer Clip
Prenese posnetke.

Element Nastavitev podelementa Opis
Thumbnail Date Time / Time Code / Duration / Preklopi podatke, prikazane pod
Caption Sequential Number slicicami.

E\Aoogi?stt)iaT]ransfer Clip ni mogoce konfigurirati, ko moZnost Access Authentication > Password v meniju Network
ni dolocena.

Element Nastavitev podelementa Opis

Select Clip Prenese izbrane posnetke.

All Clips Prenese vse posnetke.

[Opombal]
Prenesti je mogoce do 200 posnetkov.
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6. Prikaz in nastavitve menijev

Meni Technical

Ta razdelek opisuje funkcije in nastavitve vsakega elementa menija.
Tovarnisko privzete nastavitve so prikazane s krepko pisavo (na primer 18dB).

Technical >Zoom
Nastavi nastavitve zooma.

Technical >Color Bars
Prilagodi nastavitve barvnih vrstic.

Element Nastavitev podelementa Opis
Setting On / Off Vklopi/izklopi barvne vrstice.
Tip ARIB 7 100% / 75% / SMPTE Izbere tip barvne vrstice.

Technical >ND Dial

Prilagodi nastavitve, povezane z delovanjem kolesca ND VARIABLE.

Element Nastavitev podelementa Opis
Zoom Type Optical Zoom Only / On(Clear Image Nastavi vrsto zooma.

Zoom)

Optical Zoom Only:
Opti¢ni zoom prilagajate z
upravljanjem objektiva.

On(Clear Image Zoom):
Elektronski zoom z minimalnim ali
ni¢nim poslabsanjem kakovosti slike.

Element Nastavitev podelementa Opis
CLEAR with On / Off Nastavi, ali naj bo omogoceno
Dial preklapljanje stanja ND (CLEAR «— On) z

uporabo kolesca ND VARIABLE.

Technical >Handle Zoom
Prilagodi nastavitve zooma na drzalu.

Technical >Tally
Prilagodi nastavitve indikatorja snemanja.

Element Nastavitev podelementa Opis

Spredaj On / Off Vklopi/izklopi sprednji (Front) indikator
snemanja.

Zadaj On / Off Vklopi/izklopi zadnji (Rear) indikator

snemanja.

Technical >HOLD Switch Setting
Prilagodi nastavitve stikala zadrzanja.

Element Nastavitev podelementa Opis

Setting Off / Low / High / Variable Nastavi hitrost zooma na drzalu.

Visok 1do 8(8) Nastavi hitrost zooma na rocici za zoom
na drzalu, ko je izbrana visoka (High)
hitrost zooma na drZalu.

Nizek 1do 8(3) Nastavi hitrost zooma na rocici za zoom

na drzalu, ko je izbrana nizka (Low)
hitrost zooma na drzalu.

[Opombal]

Ko je hitrost zooma nastavljena na nizko
vrednost, lahko pride do neenakomernega
zoomiranja.

Technical >Menu Settings
Prilagodi nastavitve v povezavi z menijem.

Element Nastavitev podelementa Opis

with Rec On / Off Nastavi, ali naj se zaklene delovanje
Button gumba za snemanje START/STOP.
with Hand On / Off Nastavi, ali naj se zaklene delovanje
Grip Remote drzala z daljinskim upravljalnikom.

Technical >Touch Operation

Nastavi nastavitve, ki so povezane z upravljanjem na dotik.

Element Nastavitev podelementa

Opis

Setting On / Off

Vklopi/izklopi upravljanje na dotik.

Technical >Rec Review
Prilagodi nastavitve ogleda posnetka.

Element Nastavitev podelementa Opis

User Menu On / Off Nastavi, ali naj bo prikazan samo meni

Only User (On) ali seznam menijev (Off), ko
videokamera prikazuje meni.

User Menu On / Off Nastavi, ali naj se prikaz menija zaklene

with Lock in prikazuje samo meni User.

[Opombal]

Ta element ni prikazan v normalnem delovanju
prikaza menija. Za podrobnosti o delovanju
prikaza menija glejte 68.

Element Nastavitev podelementa

Opis

Setting 3sec / 10sec / Clip

Izbere ¢as predvajanja pravkar posnetih
posnetkov za funkcijo ogleda posnetka.
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Technical >Fan Control
Prilagodi nastavitve upravljanja ventilatorja.

Technical >Video Light Set

Nastavi nacin osvetljevanja video luci. Na voljo samo z uporabo video luci HVL-LBPC (moZnost).

Element Nastavitev podelementa

Opis

Element Nastavitev podelementa

Opis

Setting Auto / Minimum / Off in Rec

Nastavi nacin upravljanja ventilatorja
videokamere.

[Opombal]

Tudi Ce je izbrana moznost Off in Rec, bo
ventilator deloval, e notranja temperatura
videokamere preseZe dolo¢eno vrednost.

Technical >Lens
Prilagodi nastavitve povezane z objektivi.

Video Light Power Link / Rec Link / Rec Link + Stby

Set

Nastavi nacin osvetljevanja za video luc,
namesceno na vecvmesniski nastavek.
Power Link:
Video luc se vklopi/izklopi, ko
vklopite/izklopite videokamero.
Rec Link:
Video luc se vklop/izklopi, ko
videokamera zacne/prekine s snemanjem.
Rec Link + Stby:

Element Nastavitev podelementa Opis Video luc se vklopi/gre v stanje
Zoom Ring Left(W)/Right(T) / Right(W)/Left(T) Nastavi smer delovanja obro¢a za zoom. priPravaenosti, ko videokamera
Direction zacne/prekine s snemanjem.
[Opombal]
Omogoceno samo pri uporabi objektiva serije Technical >APR
E, ki podpira preklop smeri obroca za zoom. Izvede funkcijo APR.
Shading ' Auto / Off Vklovpi/jzklopi samodejno kompenzacijo Elammani Nastavitev podelementa Opis
Compensation sencenja. . — :
Chroma Auto / Off Vklopi/izklopi samodejno kompenzacijo APR Execute/Cancel Zazene APB (Autgmatlc. Pler.Restoratlon)
Aberration kromatske aberacije. za samodejno prilagoditev slikovnega
Comp. senzorja.
Distortion Auto / Off Vklopi/izklopi samodejno kompenzacijo Execute: Izvedite funkcijo.
Comp. popacenja. [Opomba]
Distance Meter / Feet Nastavi mersko enoto za prikaz podatkov P’ekd Za?inog‘ T(‘:_”kc”e APR vedno namestite
Display o objektivu in polozaju ostrenja. pokrovcek objektiva.
Zoom Focal Length / Number / Bar Nastavi format prikaza poloZaja zooma. Technical >Camera Battery Alarm
Position Prilagodi nastavitve opozorila za izpraznjeno baterijo.
Display

Element Nastavitev podelementa

Opis

Low Battery 5% /10% /15% / .../ 45% / 50%

Nastavi preostalo napolnjenost baterije,
pri kateri se prikaZe opozorilo za nizko
napetost baterije (v korakih po 5 %).

Battery 3%do7%
Empty

Nastavi preostalo napolnjenost baterije,
pri kateri se prikaze opozorilo za
izpraznjeno baterijo.

Technical >Camera DC IN Alarm

Prilagodi nastavitve opozoril za vhodno napetost.

Element Nastavitev podelementa Opis

DC Low 16,0V do 19,0 V (16,5 V) Nastavi napetost, pri kateri se prikaze
Voltagel opozorilo za nizko vhodno napetost.
DC Low 15,5V do18,5V Nastavi napetost, pri kateri se prikaze
Voltage2 opozorilo za prenizko vhodno napetost.
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Meni Network

Ta razdelek opisuje funkcije in nastavitve vsakega elementa menija.
Tovarnisko privzete nastavitve so prikazane s krepko pisavo (na primer 18dB).

Network >ST Mode Settings
Prilagodi nastavitve povezane s povezavami nacina postaje.

Network >Access Authentication
Prilagodi nastavitve, povezane z avtentikacijo.

Element Nastavitev podelementa Opis

Nastavi, ali naj bo omogoceno daljinsko
upravljanje z naprave, povezane z
videokamero prek brezZi¢ne povezave
LAN v nacinu postaje.

Camera
Remote
Control

Enable / Disable

Element Nastavitev podelementa Opis

User Name Nastavi uporabnisko ime za avtentikacijo
dostopa.

Password Nastavi geslo za avtentikacijo dostopa.

Network >Wireless LAN
Prilagodi nastavitve povezane z brezzicnimi povezavami LAN.

Element Nastavitev podelementa Opis

Setting Access Point Mode / Station Mode / Off Izbere nacin delovanja brezzi¢ne
povezave LAN.

WPS Execute/Cancel Vzpostavi povezavo z uporabo WPS
(Wi-Fi Protected Setup).
Execute: Izvedite funkcijo.

NFC Execute/Cancel Vzpostavi povezavo z uporabo NFC (Near
Field Communication).
Execute: Izvedite funkcijo.

MAC Address Prikaze naslov MAC brezzi¢nega

vmesnika LAN v videokameri.

Network >AP Mode Settings
Prilagodi nastavitve povezane s povezavami v nacinu dostopovne tocke.

Element Nastavitev podelementa Opis

Channel Auto(5GHz) / Auto / CH1/ CH2 / Nastavi kanal brezzi¢ne povezave LAN.
CH3 / CH4 / CH5 / CH6 / CH7 / CH8 / CH9 / Auto(5GHz) je na voljo samo pri modelu
CH10 /7 CHM ILME-FX6V/VK.

Camera SSID Prikaze SSID in geslo videokamere.

& Password

Regenerate Execute/Cancel Ustvari novo geslo.

Password Execute: Izvedite funkcijo.

IP Address PrikaZe naslov IP videokamere v nacinu

dostopovne tocke.

PrikaZe povezano brezzi¢no omrezje LAN
(dostopovna tocka).

Connected
Network

SSID Prikaze SSID dostopovne tocke za

povezavo.

Varnost Prikaze tip varnosti dostopovne tocke za

povezavo.

Prikaze geslo dostopovne tocke za

povezavo.

Ko je moZnost Security nastavljena na
WEP ali WPA; ***xxxx

Ko je moznost Security nastavljena na
None: (prazno)

Password

DHCP Prikaze, ali je moznost DHCP vklopljena/

izklopljena.

IP Address Prikaze naslov IP videokamere, ko je

moznost DHCP nastavljena na Off.

Subnet Mask Prikaze masko podomrezja videokamere,

ko je moZnost DHCP nastavljena na Off.

Gateway Prikaze privzeti prehod videokamere, ko
je moZnost DHCP nastavljena na Off.
DNS Auto Prikaze, ali je pridobivanje DNS

vklopljeno/izklopljeno.

Prikaze primarni streznik DNS
videokamere, ko je moznost DNS Auto
nastavljena na Off.

Primary DNS Server

Prikaze sekundarni streznik DNS
videokamere, ko je moznost DNS Auto
nastavljena na Off.

Secondary DNS Server

Subnet Mask Prikaze masko podomrezja videokamere

v nacinu dostopovne tocke.
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6. Prikaz in nastavitve menijev: Meni Network

Network >ST Mode Settings

Prilagodi nastavitve povezane s povezavami nacina postaje.

Network >ST Mode Settings

Prilagodi nastavitve povezane s povezavami nacina postaje.

Element Nastavitev podelementa Opis Element Nastavitev podelementa Opis
Scan Zazna brezzi¢na omrezja LAN Manual Registrira nastavitve ro¢ne povezave na
Networks (dostopovne tocke) in prikaze njihov Register dostopovno tocko.
seznam. SSID Vnesite SSID dostopovne tocke za
Izberite cilj s seznama za povezavo. povezavo.
SSID PrikaZe SSID dostopovne tocke za Security Nastavite tip varnosti dostopovne tocke
povezavo. None / WEP / WPA za povezavo. Ce je tip varnosti
Varnost Prikaze tip varnosti dostopovne tocke za dostopovne tocke WPA ali WPA2, izberite
povezavo. WPA.
Password Vnesite geslo dostopovne tocke za Password Vnesite geslo dostopovne tocke za
povezavo. povezavo.
DHCP Vklopi/izklopi DHCP. DHCP Vklopi/izklopi DHCP.
On / Off On / Off
IP Address Vnesite naslov IP videokamere, ko je IP Address Vnesite naslov IP videokamere, ko je

moznost DHCP nastavljena na Off.

Subnet Mask

Vnesite masko podomrezja videokamere,
ko je moZnost DHCP nastavljena na Off.

Gateway Vnesite privzeti prehod videokamere, ko
je moznost DHCP nastavljena na Off.
DNS Auto Vklopi/izklopi samodejno pridobivanje
On / Off DNS.

Primary DNS Server

Vnesite primarni streznik DNS
videokamere, ko je moznost DNS Auto
nastavljena na Off.

Secondary DNS Server

Vnesite sekundarni streznik DNS
videokamere, ko je moZnost DNS Auto
nastavljena na Off.

moznost DHCP nastavljena na Off.

Subnet Mask

Vnesite masko podomrezja videokamere,
ko je moZnost DHCP nastavljena na Off.

Gateway Vnesite privzeti prehod videokamere, ko
je moZnost DHCP nastavljena na Off.
DNS Auto Vklopi/izklopi samodejno pridobivanje
On / Off DNS.

Primary DNS Server

Vnesite primarni streznik DNS, ko je
moznost DNS Auto nastavljena na Off.

Secondary DNS Server

Vnesite sekundarni streznik DNS, ko je
moznost DNS Auto nastavljena na Off.
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Network >Wired LAN

Prilagodi nastavitve povezane z Zicno povezavo LAN.

Network >File Transfer
Prilagodi nastavitve povezane s prenosi datotek.

Element Nastavitev podelementa Opis Element Nastavitev podelementa Opis

Setting On / Off Vklopi/izklopi funkcijo Zi¢ne povezave Auto Upload On / Off Vklopi/izklopi samodejni prenos datoteke
LAN. (Proxy) proxy.

Camera Enable / Disable Nastavi, ali naj bo omogoceno daljinsko Default Izbere streznik za nalaganje datotek.

Remote upravljanje z naprave, povezane z Upload Tukaj izbran streznik postane cilj za

Control videokamero prek Zi¢ne povezave LAN. Server samodejno nalaganje datotek proxy in

Detail Nastavi lastnosti Zicne povezave LAN. cilj za nalaganje datotek z zaslona slicic.

Settings DHCP Vklopi/izklopi DHCP. Prikaig prikazno ime, ki. je nastavljeno v

on / Off nastavitvah Server Settings 1to 3.
IP Address Vnesite naslov IP videokamere, ko je Clear Execute/Cancel S seznama |zb.r|se zakIJHcene prenose.

moZnost DHCP nastavljena na Off. JCoobn;pleted Execute: Izvedite funkcijo.

Subnet Mask

Vnesite masko podomrezja videokamere,
ko je moznost DHCP nastavljena na Off.

Clear All Jobs  Execute/Cancel

S seznama izbriSe vse prenose.
Execute: Izvedite funkcijo.

View Job List

Prikaze seznam prenosov.

Gateway Vnesite privzeti prehod videokamere, ko
je moznost DHCP nastavljena na Off.
DNS Auto Vklopi/izklopi samodejno pridobivanje
On / Off DNS.

Primary DNS Server

Vnesite primarni streznik DNS, ko je
moznost DNS Auto nastavljena na Off.

Secondary DNS Server

Vnesite sekundarni streznik DNS, ko je
moznost DNS Auto nastavljena na Off.

Network >Modem
Nastavi nastavitve, ki so povezane s povezavo USB.

Element Nastavitev podelementa Opis

Setting On / Off Vklopi/izklopi povezavo s pametnim
telefonom.

Camera Enable / Disable Omogocitev povezave za dostop s

Remote pametnim telefonom prek aplikacije

Control Content Browser Mobile.

Device Name PrikaZe ime naprave pametnega telefona.

IP Address PrikaZe naslov IP pametnega telefona.

Subnet Mask

Prikaze masko podomrezja pametnega
telefona.
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Network >File Transfer

Prilagodi nastavitve povezane s prenosi datotek.

Element Nastavitev podelementa Opis
Server Display Name Nastavi prikazno ime, prikazano v meniju
Settings1 za nastavitev cilja prenosa.
Service Prikaze tip streznika.
m
Host Name Nastavi ime gostitelja ciljnega streznika

Za prenos.

Port (1 do 65535 (21))

Nastavi Stevilko vrat ciljnega streznika za
prenos.

User Name Nastavi uporabnisko ime za avtentikacijo
povezave ciljnega streznika za prenos.
Password Nastavi avtentikacijsko geslo povezave

cilinega streznika za prenos.

Passive Mode
On / Off

Vklopi/izklopi nacin PASV.

Destination Directory

Vnesite ime ciljne mape za prenos.

Using Secure Protocol
On / Off

Nastavi, ali naj se uporabi (On) ali ne
uporabi (Off) varen prenos FTP (FTPS
Explicit Mode: FTPES).

Root Certificate
Load / Clear / None

NalozZi korenski certifikat za varen prenos
FTP in izbriSe nastavitve.

Root Certificate Status
Loaded / No Certificate

PrikaZe stanje nalaganja korenskega
certifikata za varen prenos FTP.

Reset Ponastavi nastavitve Server Settings na
Execute/Cancel privzete vrednosti.
Execute: Izvedite funkcijo.
Server Enako kot Server Settings1.
Settings2
Server Enako kot Server Settings1.
Settings3

Network >Network Reset
Ponastavi nastavitve omrezja.

Element Nastavitev podelementa

Opis

Ponastavitev  Execute/Cancel

Ponastavi nastavitve omreZja.
Execute: Izvedite funkcijo.
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Meni Maintenance

Ta razdelek opisuje funkcije in nastavitve vsakega elementa menija.
Tovarnisko privzete nastavitve so prikazane s krepko pisavo (na primer 18dB).

Maintenance >Hours Meter
Prikaze akumulirani ¢as delovanja.

Nastavitev podelementa

Opis

Prikaze akumulirane ure uporabe
(ponastavitev ni mogoca).

: Elemen
Maintenance >Language ement
Nastavi jezik prikaza. Hours
Element Nastavitev podelementa Opis (System)
Hours (Reset)
Select Nastavi jezik prikaza.

PrikaZze akumulirane ure uporabe
(ponastavitev je mogoca).

SET: Nastavite jezik. Ponastavitev

Maintenance >Clock Set
Prilagodi nastavitve notranje ure.

Execute/Cancel

Ponastavi prikaz Hours (Reset) na 0.
Execute: Izvedite funkcijo.

Maintenance >Version

Element Nastavitev podelementa Opis PrikaZe podatke o razlicici.
Time Zone UTC -12:00 do UTC +14:00 Nastavi razliko do ¢asa UTC v korakih po Element Nastavitev podelementa Opis
30 minut. Version VX.XX PrikaZe razli¢ico programske opreme
Date Mode YYMMDD / MMDDYY / DDMMYY Izbere format prikaza datuma. Number videokamere.
YYMMDD_: Leto, m(ejsec,ldan Version Up Execute/Cancel Posodobi videokamero.”
MMDDYY'_ Mesec, dan, leto Execute: Izvedite funkcijo.
DDMMYY: Dan, mesec, leto * Ta funkcija posodobi programsko opremo
12H/24H 12H / 24H Izbere format prikaza ure. videokamere.
12H: 12-urni nacin Lens Version  Vxx PrikaZe stevilko razli¢ice programske
24H: 24-urni nadin Number opreme objektiva serije E.
Datum Nastavi trenutni datum.
SET: Nastavite vrednost.
Time Nastavi trenutni Cas.

SET: Nastavite vrednost.

Maintenance >All Reset
Ponastavi nastavitve na tovarnisko privzete.

Element Nastavitev podelementa

Opis

Reset Execute/Cancel

Ponastavi vse nastavitve na tovarnisko
privzete vrednosti.
Execute: Izvedite funkcijo.

[Opombal]

Datoteka 3D LUT, uvoZena s funkcijo Base Look
>lmport (stran 83) v meniju Paint/Look,

je izbrisana. Ce Zelite izbrisati vse uvozene
datoteke 3D LUT, izberite nastavitev Base Look
> Delete All v meniju Paint/Look (stran 83).

Reset without Execute/Cancel
Network

Ponastavi nastavitve menija, razen
nastavitev menija Network, na privzeto
tovarnisko stanje.
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Shooting Menu Settings and Default Values

ISO/Gain Settings and Default Values

Razpon nastavitev ISO/Gain (stran 72) in privzetih vrednosti se razlikuje glede na nastavitve Mode, Target Display, Base Look >Select in Base Sensitivity. RazpoloZljive moznosti so oznacene s sivo
barvo.

Ko je nastavitev Mode nastavljena na I1SO

Target Display SDR(BT.709) HDR(HLG) SDR(BT.709) in HDR(HLG) common

Base Look > Select S-Cinetone / Standard / ITU709 / Still

HLG Live / HLG Natural

User1 to User16

Base Sensitivity

Nizek

Visok

Nizek

Visok

Nizek

Visok

1ISO 320

ISO/Gain<L> default

ISO 400

I1SO 500

ISO 640

ISO/Gain<M> default

1SO 800

1SO/Gain<L> default

1SO/Gain<L> default

1SO 1000

1SO 1250

ISO/Gain<H> default

1SO 1600

1SO/Gain<M> default

1SO/Gain<M> default

1SO 2000

1SO 2500

1SO 3200

1SO/Gain<H> default

1SO/Gain<H> default

ISO 4000

1SO 5000

ISO/Gain<L> default

1SO 6400

ISO 8000

1SO 10000

1SO/Gain<M> default

1SO 12800

ISO/Gain<L> default

I1SO/Gain<L> default

1SO 16000

1SO 20000

1SO/Gain<H> default

1SO 25600

ISO/Gain<M> default

I1SO/Gain<M> default

1SO 32000

1SO 40000

1SO 51200

ISO/Gain<H> default

1SO/Gain<H> default

1SO 64000

I1SO 80000

1SO 102400

1SO 128000

1SO 160000

1SO 204800

1SO 256000

1SO 320000

1SO 409600
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Ko je moznost Mode nastavljena na dB

Obmocje nastavitev
-3dB

-2dB

-1dB

0dB ISO/Gain<L> default
1dB

2dB

3dB

4dB

5dB

6dB I1SO/Gain<M> default
7dB

8dB

9dB

10dB

1dB

12dB 1SO/Gain<H> default
13dB

14dB

15dB

16dB

17dB

18dB

19dB

20 dB

21dB

22dB

23dB

24dB

25dB

26dB

27dB

28dB

29dB

30dB
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AGC Limit Settings and Default Values

Obmocje nastavitev AGC Limit (stran 73) in privzetih vrednosti se razlikuje glede na nastavitve Mode, Target Display, Base Look >Select in Base Sensitivity. RazpoloZljive mozZnosti so oznacene s

sivo barvo.

Ko je nastavitev Mode nastavljena na I1SO

Target Display

SDR(BT.709)

HDR(HLG)

HDR(HLG)

SDR(BT.709) in HDR(HLG) common

Base Look >Select

S-Cinetone / Standard / ITU709 / Still

HLG Live

HLG Natural

User1 to User16

Base Sensitivity

Nizek Visok

Nizek

Visok

Nizek

Visok

Nizek Visok

ISO 400

1SO 500

I1SO 640

I1SO 800

1SO 1000

1SO 1250

1SO 1600

1SO 2000

Privzeta

I1SO 2500

1SO 3200

1SO 4000

I1SO 5000

Privzeta

Privzeta

Privzeta

1SO 6400

1SO 8000

1SO 10000

1SO 12800

1SO 16000

1SO 20000

1SO 25600

1SO 32000

Privzeta

I1SO 40000

1SO 51200

1SO 64000

I1SO 80000

Privzeta

Privzeta

Privzeta

1SO 102400

1SO 128000

1SO 160000

1SO 204800

1SO 256000

1SO 320000

1SO 409600
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Ko je moznost Mode nastavljena na dB

Obmodje nastavitev
3dB

6dB

9dB

12dB

15dB Privzeta
18dB

21dB

24dB

27dB

30dB
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6. Prikaz in nastavitve menijev

Image Quality Settings Saved for Each Shooting Mode

Elementi trenutnega stanje konfiguracije, ki so povezani s kakovostjo slike, se shranijo za vsakega od naslednjih snemalnih nacinov (stran 24). Ko spremenite snemalni nacin, se ustrezne
nastavitve, ki so shranjene, uporabijo za ciljni snemalni nacin.

e Custom mode SDR(BT.709)

e Custom mode HDR(HLG)

e Nacin Cine El

Konfiguracijski elementi, ki so povezani s kakovostjo slike in so shranjeni za vsak snemalni nacin, so prikazani spodaj.

Da: Element je shranjen.

Ne: Element ni shranjen.

Konfiguracijski element Nacin zajemanja posnetkov
Nacin Custom Nacin Cine El
SDR(BT.709) ‘ HDR(HLG)
Meni Shooting ISO/Gain/El ISO/Gain Da" Ne
Indeks osvetlitve Ne Da
Base Sensitivity Da Ne
Base ISO Ne Da
Bel Preset White Da Da
Drugo Da
White Setting Da
Offset White Da Ne
LUT On/Off Ne Da
Noise Suppression Setting(Custom) Da Da Ne
Level(Custom) Da Da Ne
Setting(Cine El) Ne Da
Level(Cine El) Ne Da
Meni Paint/Look Base Look izberite Da Da Da
Input? Da
Output? Da
AE Level Offset? Da
Crn Da Da Ne
Knee Auto Knee Da Ne Ne
Drugo Da Da Ne
Detail Da Da Ne
Matrix Da Da Ne
Multi Matrix Da Da Ne

T) Locene nastavitve obcutljivosti ISO so shranjene za nacin Custom SDR(BT.709]) in HDR{HLG).
2) Nastavitve se shranijo za vsak osnovni videz in niso odvisne od snemalnega nacina.
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6. Prikaz in nastavitve menijev

Shranjevanje in nalaganje konfiguracijskih podatkov

Konfiguracijski podatki Shranjevanje datoteke User File/

ALL File

Nalaganje datoteke User File/
ALL file

Spreminjanje ID-ja datoteke

Nastavitve glavnega menija lahko shranite
na pomnilnisko kartico, ki je vstavljena v
rezo za kartice CFexpress tipa A/SD (B). To
vam omogoca, da hitro priklicete primerne
nastavitve menija za trenutno situacijo.

Konfiguracijski podatki so shranjeni v sledecih

kategorijah.

Uporabniske datoteke

Uporabniske datoteke hranijo elemente
nastavitev in podatke prilagodljivega menija
User.

Na pomnilnisko kartico lahko shranite do 64
datotek.

Z nalaganjem te datoteke v pomnilnik
videokamere lahko prilagodite nastavitev
menija User.

VSE datoteke (vse nastavitve)

Datoteke ALL hranijo konfiguracijske podatke

vseh menijev. Na pomnilnisko kartico lahko
shranite do 64 datotek.

[Opombal]

Podatki, specifi¢ni za napravo (sencenje, izhodne ravni
in ostali podatki, ki zahtevajo prilagoditev za specifi¢no

napravo), se ne shranijo.

Vstavite pomnilnisko kartico v reZo za

kartice CFexpress tipa A/SD (B)

(stran 6).

e Pri karticah CFexpress mora biti nalepka
na levi strani.

e Pri karticah SD mora biti nalepka na
desni strani, z zaobljenim vogalom na
dnu.

Za uporabnisko datoteko izberite moznost
User File > Save Media(B) (stran 82) >
Execute v meniju Project glavnega menija.
Za datoteko ALL izberite moznost All File >
Save Media(B) (stran 82) > Execute v
meniju Project glavnega menija.

Pojavi se ciljni zaslon za shranitev
datoteke.

Izberite vrstico »No File« na ciljnem
zaslonu za shranitev datoteke.

Izbira vrstice z vnosom File ID bo prepisala
izbrano datoteko.

File ID se generira samodejno, a ga lahko
spremenite.

Izberite ukaz Execute na potrditvenem
zaslonu.

1 Vstavite pomnilnisko kartico, na kateri je
shranjena datoteka, v rezo za kartice
CFexpress tipa A/SD (B) (stran 6).

e Pri karticah CFexpress mora biti nalepka
na levi strani.

e Pri karticah SD mora biti nalepka na
desni strani, z zaobljenim vogalom na
dnu.

2 Za uporabnisko datoteko izberite moznost
User File > Load Media(B) (stran 82) >
Execute v meniju Project glavnega menija.
Za datoteko ALL izberite moznost All File >
Load Media(B) (stran 82) > Execute v
meniju Project glavnega menija.

Pojavi se zaslon s seznamom datotek.

3 Izberite datoteko za nalaganje.
PrikaZe se potrditveni zaslon.

4 Izberite Execute.

[Opombe]

e Enota se po nalaganju konfiguracijskih podatkov
samodejno znova zazZene.

e Ko je moznost All File > Load Network Data v meniju
Project glavnega menija izklopljena, so naloZene vse
nastavitve v datoteki ALL, razen nastavitev menija
Network.

Za uporabnisko datoteko izberite User File
> File ID (stran 82) v meniju Project
glavnega menija.

Za datoteko ALL izberite moznost All File >
File ID (stran 82) v meniju Project
glavnega menija.

Pojavi se zaslon za urejanje File ID-ja.

Izberite znak z vecfunkcijskim gumbom
(stran 7) ali z vec¢funkcijskim kolescem
(stran 5), nato pa pritisnite gumb za
potrditev na vec¢funkcijskem gumbu ali
vecfunkcijsko kolesce.

Po potrebi ponovite 2. korak.

Ko ste zakljucili z vnasanjem znakov,
izberite Done.
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7. Povezovanje zunanjih naprav

Povezovanje zunanjih monitorjev in snemalnih naprav

Za prikaz snemane/predvajane slike na
zunanjem monitorju izberite izhodni signal
videokamere in uporabite primeren kabel za
monitor, ki ga Zelite priklopiti.

Priklopite lahko tudi snemalne naprave,
kot je VTR, in posnamete izhodni signal iz
videokamere.

Iste podatke, ki so vidni v iskalu, kot so
podatki o stanju in menijih, lahko prikazete
na zunanjem monitorju. Vklopite prikaz
informacij (stran 14) na zaslonu Monitoring
Status ali prikaz na zaslonu (stran 87) v
meniju Monitoring glavnega menija v skladu s
signalom, ki je poslan v monitor.

Priklju¢ek SDI OUT (tip BNC)

V meniju Monitoring (stran 87) izberite
nastavitev on/off in izhodni format.

Za povezavo uporabite komercialno dostopen
koaksialni kabel z upornostjo 75 Q.

[Opombal]

Pred vklopom naprav preverite, da je povezava med
videokamero in zunanjo napravo ozemljena.

(Priporociljivo je, da videokamero in zunanjo
napravo vklopite po tem, ko ste ju povezali s
koaksialnim kablom z upornostjo 75 Q.)

Ce morate zunanjo napravo priklopiti na
videokamero, ko je videokamera vklopljena,
priklopite koaksialni kabel z upornostjo 75

Q najprej na zunanjo napravo in nato na
videokamero.

Za socasen zacetek snemanja na
videokameri in zunanji napravi

Ob omogocenem izhodu signala SDI nastavite

moznost SDI/HDMI Rec Control (stran 79) >

Setting v meniju Project glavnega menija na

SDI/HDMI Remote I/F ali Parallel Rec. S tem

boste omogocili prenos sproZilnega signala

REC v zunanjo napravo, povezano na prikljuc¢ek

SDI OUT. S tem boste snemanje na zunanji

napravi sinhronizirali z videokamero.

[Opombe]

o (e povezana zunanja naprava ne podpira sproZilnega
signala REC, je na ta nac¢in ne morete upravljati.

o Ce pomnilniski medij ni vstavljen, se na izhod pogilja
samo sproZilni signal REC.

Priklju¢ek HDMI OUT
(prikljucek tipa A)

V meniju Monitoring (stran 87) glavnega
menija izberite nastavitev On/Off izhoda in
izhodni format.

Za soCasen zacetek snemanja na
videokameri in zunanji napravi

Ob omogocenem izhodu signala HDMI
vklopite TC Out > Setting (stran 85) v meniju
TC/Media glavnega menija in nastavite SDI/
HDMI Rec Control > Setting (stran 79) v

meniju Project na SDI/HDMI Remote I/F ali
Parallel Rec. S tem boste omogocili prenos
sprozilnega signala REC na zunanjo napravo,
povezano na priklju¢ek HDMI OUT. S tem boste
snemanje na zunanji napravi sinhronizirali z
videokamero.
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7. Povezovanje zunanjih naprav

Sinhronizacija casovnih kod

Casovno kodo enote lahko sinhronizirate z
drugimi napravami.

Zaklep casovne kode na ostale
naprave

Enoto, ki dovaja ¢asovno kodo, nastavite tako,
da ¢asovna koda na izhodu neprestano tece
(kot na primer Free Run ali Clock).

1 Nastavite moznost Timecode (stran 85)
v meniju TC/Media glavnega menija na
naslednji nacin.

Mode: Preset
Run: Free Run

2 Pritisnite dodeljiv gumb (stran 48) z
dodeljeno funkcijo DURATION/TC/U-BIT,
da se na zaslonu prikaze ¢asovna koda.

3 Preverite, da je izbirno stikalo TC IN/OUT
(stran 4) v polozaju IN. Nato posljite
referen¢no ¢asovno kodo za sinhronizacijo
sistemske frekvence videokamere v
priklju¢ek TC IN/TC OUT.

Generator ¢asovne kode v videokameri se
zaklene z referen¢no ¢asovno kodo in na
zaslonu se pojavi »EXT-LK«.

Ko mine priblizno deset sekund od zaklepa
casovne kode, ostane ¢asovna koda
zaklenjena na zunanjo ¢asovno kodo tudi,
Ce odklopite vir zunanje referenéne ¢asovne
kode.

[Opombe]

e Ob uporabi zaklepa na zunanjo ¢asovno kodo se
casovna koda videokamere takoj zaklene na zunanjo
casovno kodo. Na obmocju za prikaz podatkov se
pojavi vrednost zunanje ¢asovne kode. Kljub temu ne
zacnite takoj snemati. Pocakajte nekaj sekund, da se
generator ¢asovne kode pred snemanjem stabilizira.

o (e frekvenca referen¢ne ¢asovne kode in frekvenca
sli¢ic na videokameri nista enaki, ne more priti do
zaklepa in videokamera ne bo delovala pravilno.

Ce pride do tega, se ¢asovna koda ne bo uspeino
zaklenila na zunanjo ¢asovno kodo.

o Casovna koda se lahko v primerjavi z referen¢no
casovno kodo zamakne za eno slicico na uro.

Za sprostitev zunanjega zaklepa

Spremenite nastavitev Timecode v meniju
TC/Media glavnega menija ali izklopite
videokamero.

Zunanja sinhronizacija se sprosti tudi v
primeru, ¢e spremenite sistemsko frekvenco
ali e zacnete snemati v posebnem nacinu
snemanja (pocasni in hitri posnetki ali
intervalno snemanje).

Sinhronizacija casovne kode
druge naprave s ¢asovno kodo
videokamere

Enoto, ki dovaja ¢asovno kodo, nastavite tako,
da ¢asovna koda na izhodu neprestano tece
(kot na primer Free Run ali Clock).

1 Nastavite ¢asovno kodo videokamere z
uporabo mozZnosti Timecode (stran 85)
v meniju TC/Media glavnega menija.

2 Preverite, da je izbirno stikalo TC IN/OUT
(stran 4) v poloZaju OUT. Nato
povezite priklju¢ek TC IN/TC OUT z
vhodnim prikljuckom ¢asovne kode na
napravi, ki jo Zelite sinhronizirati.
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7. Povezovanje zunanjih naprav

Upravljanje/urejanje posnetkov z racunalnikom

Povezovanje s kablom USB

Uporaba bralnika kartic (moznost)

Povezite bralnik kartic CFexpress ali bralnik
kartic SD z racunalnikom prek kabla USB

in vstavite pomnilnisko kartico v rezo
bralnika kartic. Rac¢unalnik pomnilnisko
kartico prepozna kot razsiritveni pogon. Na
podprtih racunalnikih lahko z visoko hitrostjo
uvozite posnetke tako, da uporabite nacin
videokamere masovno shranjevanje.

Uporaba nacina masovnega
shranjevanja

[Opombal]

Nacina masovnega shranjevanja ni mogoce uporabiti,
ko je vklopljena mozZnost Modem > Setting v meniju
Network glavnega menija ali ko je vklopljena mozZnost
Wired LAN > Setting v meniju Network. Izklopite obe
moznosti.

Povezite videokamero s kablom USB in
vstavite pomnilnisSko kartico v rezo A ali B.
Racunalnik pomnilnisko kartico prepozna kot
razSiritveni pogon.

1 Povezite prikljuc¢ek USB-C (stran 7) ali
priklju¢ek USB/multi (stran 7) z
racunalnikom prek kabla USB.

2 Stikalo POWER na videokameri prestavite
v polozZaj ON.
Na zaslonu se pojavi sporocilo, ki vas
vprasa ali Zelite omogociti povezavo USB.
[Opombal]
Potrditveno sporocilo povezave USB se ne

prikaZe v Casu, ko je prikazano drugo potrditveno
sporocilo ali sporocilo o napredku, na primer med

formatiranjem ali obnavljanjem pomnilniske kartice.

Potrditveno sporocilo se prikaze, ko se formatiranje
ali obnavljanje zakljuci. Potrditveno sporocilo se
tudi ne prikaze, ko je prikazan zaslon lastnosti
posnetka. Sporocilo se prikaZe, ko se procesiranje
zakljuci ali, ko se vrnete na zaslon slicic.

3 Zavrtite vecfunkcijsko kolesce, da izberete
Execute.

4 V operacijskem sistemu Windows v oknu
»Moj racunalnik« preverite, da je kartica
dodana kot odstranljiv disk.

V ra¢unalniku Mac preverite, da je na
namizju ustvarjena mapa z imenom
»NO NAME« ali »Untitled« (z moZnostjo
urejanja).

[Opombe]

e Ne izvajajte naslednjih opravil, ¢e indikator dostopa

sveti v rdeci barvi.

- lzklop napajanja ali odklop napajalnega kabla
- Odstranjevanje pomnilniske kartice

- Odklop kabla USB

e Pravilno delovanje z vsemi racunalniki ni

zagotovljeno.

Uporaba nelinearnega sistema za
urejanje

Pri nelinearnem sistemu za urejanje mora
programska oprema za urejanje (moznost)
podpirati formate, v katerih snema
videokamera.

Uporabite namensko uporabnisko programsko
opremo, da posnetke, ki jih Zelite urediti, pred
tem shranite na trdi disk racunalnika.
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8. Dodatek

Previdnostni ukrepi

Kondenzacija

Ce enoto prenesete s hladnega na toplo
mesto ali ¢e se temperatura okolice nenadoma
zvisa, se lahko na zunanji povrsini enote in/

ali znotraj enote ustvari vlaga. Temu pravimo
kondenzacija. Ce pride do kondenzacije,
izklopite enoto in pred ponovno uporabo
pocakajte, da se kondenzacija posusi. Ko je
prisotna kondenzacija, lahko uporaba enote
poskoduje enoto.

0 zaslonih LCD

Zaslon LCD, namescen na to enoto, je izdelan z
visoko natan¢no tehnologijo. To mu zagotavlja
razmerje delujocih tock, ki znasa najmanj
99,99 %. Obstaja lahko zelo majhen delez
tock, ki so »zataknjene«, tako da so vedno
izklopljene (¢rne), vedno vklopljene (rdece,
zelene ali modre) ali utripajo. Poleg tega se
zaradi fizi¢nih lastnosti zaslona s tekocimi
kristali take »zataknjene« slikovne tocke v
daljSem obdobju uporabe lahko pojavijo same
od sebe. Te teZave ne pomenijo, da gre za
okvaro. Upostevajte, da takSne teZzave nimajo
ucinka na posnete podatke.

Pojavi slikovnega senzorja CMOS
kamere

[Opombal]
Sledeci pojavi, ki se lahko pojavijo na slikah, so znacilni
za slikovne senzorje. V teh primerih ne gre za okvaro.

Beli madezi

Ceprav so slikovni senzorji izdelani z visoko
natanc¢nimi tehnologijami, se lahko v redkih
primerih na zaslonu pojavijo beli madezi, ki jih
povzrocijo kozmicni Zarki ipd.

To je povezano z nac¢inom delovanja slikovnih
senzorjev in ne predstavlja okvare.

Bele madeZe je mogoce opaziti predvsem v
naslednjih primerih:

e Pri delovanju pri visoki delovni temperaturi
e Kadar povecate ojacitev (obcutljivost)

Migetanje

Pri snemanju s svetlobo fluorescencnih ludi,
natrijevih svetilk, Zivosrebrnih svetilk ali svetilk
LED se lahko pojavi utripanje zaslona ali
nepravilne barve.

Deli, ki so potrosni material

e Ventilator in baterija sta potrosni material, ki
zahteva obcasno zamenjavo.

Pri uporabi pri sobni temperaturi bo
obicajen cikel zamenjave znas3al priblizno
5 let. Cikel zamenjave predstavlja splosno
vodilo in ne pomeni, da je taksna tudi
zagotovljena Zivljenjska doba teh delov. Za
podrobnosti o menjavi delov se obrnite na
prodajalca.

e Pri¢akovana zivljenjska doba omreZznega
napajalnika in elektrolitskega kondenzatorja
znasa priblizno 5 let pri normalnih
temperaturah in normalnem casu uporabe
(8 ur na dan; 25 dni na mesec). Ce uporaba
presega zgoraj navedeno normalno
uporabo, se lahko pri¢akovana Zivljenjska
doba ustrezno zmanjsa.

e Prikljucek za baterijo na tej enoti (priklju¢ek
za pakete baterij in omreZne napajalnike) je
potrosni material.

Napajanje enote morda ne bo pravilno, ¢e
so kontakti prikljuc¢ka za baterijo zviti ali
deformirani zaradi udarcev ali tresljajev
ali Ce zaradi dolgotrajnejSe uporabe na
prostem korodirajo.

Priporo¢amo vam periodi¢ne preglede
enote, da zagotovite njeno pravilno
delovanje in podaljSajte njeno zivljenjsko
dobo. Za vec informacij o pregledih se
obrnite na prodajnega ali servisnega
predstavnika podjetja Sony.

Vgrajena akumulatorska baterija

Videokamera ima vgrajeno akumulatorsko
baterijo za shranjevanje datuma, ¢asa in ostalih
nastavitev, tudi ko je videokamera izklopljena.
Vgrajena akumulatorska baterija se napolni, ko
pretece 24 ur od priklopa na omreZno napajanje
ali priklopa polno napolnjenega paketa baterij,
ne glede na to, ali je videokamera vklopljena

ali izklopljena. Akumulatorska baterija se
popolnoma izprazni v priblizno 2 mesecih, ce
videokamera v tem ¢asu ni priklopljena na
omrezno napajanje in nima namescenega
paketa baterij. Videokamero uporabljajte

po tem, ko ste napolnili baterijo. Tudi ¢e
akumulatorska baterija ni napolnjena, delovanje
videokamere ne bo prizadeto, razen Ce boste
potrebovali snemanje datuma.

Lokacije uporabe in shranjevanja

Shranjujte na ravnem, prezratevanem mestu.
Izogibajte se uporabi in shranjevanju enote na
sledecih mestih.

e Na Cezmerni vrocini ali mrazu (temperaturni
razpon za delovanje: 0 °C do 40 °C (od 32 °F
do 104 °F))

Ne pozabite, da lahko poleti v toplejsih
podnebnih pasovih temperatura v
avtomobilu z zaprtimi stekli zlahka preseze
50 °C (122 °F).

e Na vlaznih ali prasnih lokacijah Na lokacijah,
kjer bi bila enota lahko izpostavljena dezju

e Na lokacijah, ki so izpostavljene mocnim
vibracijam

e V/ blizini mo¢nih magnetnih polj

e Blizu radijskih ali TV oddajnikov, ki ustvarjajo
mocna elektromagnetna polja.

e Dalj ¢asa na neposredni soncni svetlobi ali
blizu grelnih teles

Opomba glede laserskih Zarkov

Laserski zarki lahko poskodujejo slikovni
senzor CMOS. Ce snemate prizor, ki vklju¢uje
laserski Zarek, bodite pozorni, da laserski Zarek

ni usmerjen v objektiv enote. Poleg tega lahko
laserski Zarki visoke moci na medicinskih ali
drugih napravah povzrocijo poSkodbe z odbito
ali razprSeno svetlobo.

Za preprecitev elektromagnetnih moten;
s strani prenosnih komunikacijskih
naprav

Uporaba prenosnih telefonov in drugih
komunikacijskih naprav v blizini kamere lahko
povzroci nepravilno delovanje ter motnje
avdio in video signalov. Priporocljivo je, da

so prenosne komunikacijske naprave v bliZini
videokamere izklopljene.

Varnostni ukrepi

e DRUZBA SONY NI ODGOVORNA ZA
NIKAKRSNO SKODO, KI JE POSLEDICA
NEUPOSTEVANJA USTREZNIH VARNOSTNIH
UKREPOV NA PRENOSNIH NAPRAVAH, ZA
NEIZOGIBNO RAZKRITIE PODATKOV, KI JE
POSLEDICA SPECIFIKACI PRENOSA, ALI ZA
KAKRSNEKOLI VARNOSTNE TEZAVE.

e Odvisno od okolja uporabe bodo morda
nepoobladcene tretje osebe v omreZju lahko
dostopale do enote. Pri povezovanju enote
v omrezje se prepricajte, da je omrezje
ustrezno zavarovano.

e Vsebino komunikacij lahko nevede
prestreZejo neavtorizirane tretje osebe, ki se
nahajajo v blizini signalov. Pri komunikacijah
prek brezzicnega omrezja LAN uporabite
ustrezne varnostne ukrepe, da zascitite
vsebino komunikacij.

e Ko izdelek poveZete z omreZjem, ga
poveZite prek sistema z zasc¢itno funkcijo,
kot je na primer usmerjevalnik ali poZarni
zid. Ce ga poveZete brez zai¢ite, lahko pride
do teZav z varnostjo.
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8. Dodatek

|lzhodni formati in omejitve

Tovarnisko privzete nastavitve so prikazane s krepko pisavo (na primer 1920x1080P (Level A)).

[Opombe]

e Locljivost izhodnega formata je omejena z nastavitvijo Rec Format > Frequency, Video Format in Codec v meniju
Project glavnega menija (stran 77).

e Locljivost izhodnega formata je omejena s kombinacijo hitrosti sli¢ic S&Q. Izhod HDMI se spremeni v Full HD, e so
izpolnjeni vsi pogoji v glavhem meniju.

- Nastavitev Rec Format > Video Format je nastavljena na 4096x2160 ali 3840x2160 v meniju Project.

- Ko je nastavitev S&Q Motion >Setting v meniju Shooting vklopljena.

- Nastavitev S&Q Motion > Frame Rate v meniju Shooting je visja od 60 sli¢ic na sekundo.

- Nastavitev Rec Format > Codec v meniju Project je nastavljena na RAW ali RAW & XAVC-I ali pa je nastavitev
Output On/Off >SDI v meniju Monitoring vklopljena.

e Ko je izhod HDMI nastavljen na 4096x2160P ali 3840x2160P, se izhod HDMI spremeni v 1920x1080P, ¢e so zgornji
pogoji izpolnjeni. Ko se to zgodi, sta mozZnosti izbire izhoda HDMI 4096x2160P in 3840x2160P za nastavitev Output
Format >SDI/HDMI (stran 87) v meniju Monitoring zasenceni in ju ni mogoce izbrati.

e Na izhodu ni predvajane slike, ¢e je locljivost video izhoda visja od locljivosti slike.

Izhodni formati prikljuckov SDI OUT/HDMI OUT

Sistemska Video format Stanje izhodnega  Izhodni format (Output Format v

frekvenca (Rec Format formata RAW meniju Monitoring)

(Rec Format >Video Format v (Rec Format SDI HDMI

>Frequency v meniju Project) >Codec v meniju

meniju Project) Project)

59,94/50 4096x2160 Zizhodnim - 4096x2160P

formatom RAW 1920x1080P

1920x1080i
3840x2160P
1920x1080P
1920x1080i
1920x1080P
1920x1080i
1920x1080P
1920x1080i
1920x1080i

Sistemska Video format Stanje izhodnega  Izhodni format (Output Format v
frekvenca (Rec Format formata RAW meniju Monitoring)
(Rec Format >Video Format v (Rec Format SDI HDMI
>Frequency v meniju Project) >Codec v meniju
meniju Project) Project)
Brez izhodnega 4096x2160P 4096x2160P
formata RAW 1920x1080P
1920x1080i
3840x2160P 3840x2160P
1920x1080P
1920x1080i
1920x1080P 1920x1080P
(Level A) 1920x1080i
1920x1080P 1920x1080P
(Level B) 1920x1080i
1920x1080i 1920x1080i
3840x2160 Z izhodnim - 3840x2160P
formatom RAW 1920x1080P
1920x1080i
1920x1080P
1920x1080i
1920x1080P
1920x1080i
1920x1080i
Brez izhodnega 3840x2160P 3840x2160P
formata RAW
1920x1080P
1920x1080i
1920x1080P 1920x1080P
(Level A)
1920x1080i
1920x1080P 1920x1080P
(Level B)
1920x1080i
1920x1080i 1920x1080i
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Sistemska Video format Stanje izhodnega  Izhodni format (Output Format v Sistemska Video format Stanje izhodnega  Izhodni format (Output Format v
frekvenca (Rec Format formata RAW meniju Monitoring) frekvenca (Rec Format formata RAW meniju Monitoring)
(Rec Format >Vlideo Formatv ~ (Rec Format SDI HDMI (Rec Format >\/ideo Formatv ~ (Rec Format SDI HDMI
>Frequency v meniju Project) >Codec v meniju >Frequency v meniju Project) >Codec v meniju
meniju Project) Project) meniju Project) Project)
1920x1080 Brez izhodnega 1920x1080P 1920x1080P 24 4096x2160 Z izhodnim - 4096x2160P
formata RAW (Level A) formatom RAW
1920x1080i 1920x1080P
1920x1080P 1920x1080P Brez izhodnega 4096x2160P 4096x2160P
(Level B) formata RAW
1920x1080i 1920x1080P 1920x1080P
1920x1080i 1920x1080i 23,98 4096x2160 Zizhodnim - 4096x2160P
- 59,94: 720x480P formatom RAW
50: 720x576P 1920x1080P
29,97/25 4096x2160 Zizhodnim - 4096x2160P 3840x2160P
formatom RAW 1920x1080P
1920x1080P 1920x1080P
3840x2160P Brez izhodnega 4096x2160P 4096x2160P
1920x1080P formata RAW
1920x1080P 1920x1080P
1920x1080i 3840x2160P 3840x2160P
Brez izhodnega 4096%2160P 4096x2160P 1920x1080P
formata RAW 1920x1080P 1920x1080P
1920x1080P 3840x2160 Zizhodnim - 3840x2160P
3840x2160P 3840x2160P formatom RAW
1920x1080P 1920x1080P
1920x1080P 1920x1080P 1920x1080P
1920x10801 (PsF)  1920x1080i Brez izhodnega 3840x2160P 3840x2160P
3840x2160 Z izhodnim - 3840x2160P formata RAW
formatom RAW 1920x1080P
1920x1080P 1920x1080P 1920x1080P
1920x1080P 1920x1080 Brez izhodnega 1920x1080P 1920x1080P
1920x1080i formata RAW
Brez izhodnega 3840x2160P 3840x2160P
formata RAW
1920x1080P
1920x1080P 1920x1080P
1920x10801 (PsF)  1920x1080i
1920x1080 Brez izhodnega 1920x1080P 1920x1080P

formata RAW

1920x1080I (PsF)  1920x1080i
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8. Dodatek

Odpravljanje tezav

Vzrok

Resitev

Napajanje Tezava . ;
Posnetkov ni mogoce
predvajati.

TeZava Vzrok Resitev

Videokamera se ne vklopi.

Ni namescenega paketa
baterij in ni napajanja na

Posnetek se ureja.

Posnetkov ni mogoce predvajati, Ce ste
spremenili imena datotek ali map ali ce
je posnetek v uporabi na racunalniku.
Ne gre za okvaro.

Namestite paket baterij (stran 17) ali
priklopite omreZzno napajanje prek

Posnetek se snema na drugi

Posnetkov, posnetih na drugih

Med delovanjem se prekine
napajanje.

Paket baterij se zelo hitro
izprazni.

prikljucku DC IN. omreZnega napajalnika (stran 18). napravl. n:iﬁvarrk'avzcaa;;r\l :eymr‘;f/ri]lﬁip\)/réll(iif)z?i all:e
Paket baterij je popolnoma Paket baterij zamenjajte s povsem gre zapokvaro. P '
izpraznjen. napolnjenim (stran 17).
Paket baterij se je izpraznil. ~ Paket baterij zamenjajte s povsem

napolnjenim (stran 17).
Temperatura okolice je zelo  To se zgodi zaradi lastnosti baterij in ne .
nizka. predstavlja okvare. Zunanje naprave
Paket baterij ni dovolj Paket baterij napolnite (stran 17).
napolnjen. Ce se paket baterij hitro izprazni tudi, ko

TeZava Resitev

ga popolnoma napolnite, je morda

Racunalnik ne prepozna
videokamere.

dosegel konec svoje Zivljenjske dobe.
Zamenjajte jo z novo.

Snemanje/predvajanje

Odklopite kabel USB z racunalnika in ga ponovno zanesljivo
priklopite.

Odklopite kabel USB z racunalnika, ponovno zaZenite racunalnik in
ponovno sledite korakom v pravilnem vrstnem redu.

PovezZite racunalnik in videokamero tako, da vstavite kabel USB v
priklju¢ek USB-C ali priklju¢ek USB/multi.

Posnetkov ni mogoce naloZiti na
racunalnik.

Tezava

Vzrok

Resitev

Snemanje se s pritiskom
gumba za snemanje START/
STOP ne zacne.

Pomnilniska kartica je polna.

Odklopite kabel USB z racunalnika, znova zaZenite racunalnik in ga
nato ponovno priklopite.

Za nalaganje posnetkov na vas racunalnik mora biti namescena
uporabniska programska oprema (stran 108).

Zamenjajte pomnilnisko kartico z drugo,
na kateri je dovolj prostora.

Pomnilnisko kartico je treba
obnoviti.

Obnovite pomnilnisko kartico
(stran 33).

Ni mogoce snemati zvoka.

Kolesca AUDIO LEVEL (CH1/
CH2) so nastavljena na
najnizjo raven.

Prilagodite ravni snemanja zvoka s
kolesci AUDIO LEVEL (CH1/CH2)
(stran 46).

Posneti zvok je popacen.

Raven zvoka je previsoka.

Prilagodite ravni snemanja zvoka s
kolesci AUDIO LEVEL (CH1/CH2)
(stran 46).

Posneti zvok ima visoko
raven suma.

Raven zvoka je prenizka.

Prilagodite ravni snemanja zvoka s
kolesci AUDIO LEVEL (CH1/CH2)
(stran 46).

Ko je izbran zunanji mikrofon,
prilagodite tudi nastavitev INPUT MIC
Reference v razdelku Audio Input v
meniju Audio (stran 90).
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3 V odprtino vstavite izvijac in ga zavrtite v nasprotni smeri urinega kazalca.
e Z vrtenjem v nasprotni smeri urinega kazalca se filter ND premakne v poloZaj Clear.
Nadaljujte z vrtenjem, dokler ne doseZete poloZaja Clear.
e Uporabite izvija¢ s premerom @ 2,4 mm ali manjsSim. Globina vstavitve izvijaca znasa

BrezZi¢na povezava LAN

[Opombal]

Ovire in elektromagnetne motnje med videokamero in dostopovno tocko za brezzi¢ni LAN ali terminalno napravo ter
lastnosti okolja (na primer material, iz katerega so izdelani zidovi) lahko skrajsajo doseg povezave ali celo preprecijo
povezavo. Ce opazite te teZave, premaknite videokamero na novo lokacijo in preverite stanje povezave/komunikacije
ali premaknite videokamero in dostopovno toc¢ko/terminalno napravo blize drugo drugi.

Tezava

Resitev

Terminalna naprava ne more
dostopati do videokamere.

® Preverite brezZi¢no povezavo LAN (naslov IP itd.).

® Nastavitve za komunikacijo med dostopovno tocko in
odjemalcem so morda neveljavne. Za podrobnosti glejte
navodila za uporabo dostopovne tocke.

Ne morete se prijaviti v
videokamero.

Preverite nastavljeno uporabnisko ime in geslo.

Internetna povezava

Tezava

Resitev

Datotek ni mogoce naloZiti.

Uporabnisko ime in geslo streznika morda nista pravilna.
Vnesite pravilno uporabnisko ime in geslo.

Nalaganje datoteke ni na voljo.

Stanje signala je morda Sibko.

)

priblizno 3,0 cm (13/, palca

|

o=

©00

o @@@] O

000000000000

:

Odprtina za izvijac
(z odstranjenim pokrovckom)

4 Nastavite stikalo ND PRESET/VARIABLE (stran 5) v poloZaj PRESET in nastavite smerna

gumba ND FILTER POSITION (stran 5) v polozaj CLEAR.
[Opombe]

e Zgoraj opisanega postopka ne izvajajte med normalnim delovanjem. Ta postopek uporabite samo, e se filter ND

noce premakniti. Filter ND se lahko poskoduje, ¢e ta postopek izvedete med normalnim delovanjem.
e Po izvedbi zgoraj opisanega postopka se obrnite na servisni center podjetja Sony, kjer bodo popravili videokamero.
e Snemanje je mogoce, tudi Ce se po izvedbi zgoraj opisanega postopka Se vedno prikazuje sporocilo o napaki.

Premaknite se na drugo lokacijo in poskusite znova.

Pri uporabi filtra ND

Tezava Resitev
Filter ND se ne premakne. Po sledecem postopku lahko filter ro¢no premaknete v polozaj
Clear.

1 Stikalo POWER na videokameri prestavite v poloZaj za izklop.

2 Odstranite okrogel pokrovcek na spodnji strani.
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8. Dodatek

Sporocila o napakah/opozorilna sporocila

Ce se na videokameri pojavi opozorilo ali pride do dogodka, ki zahteva potrditev, se v iskalu

Sporocilo v iskalu Opozorilni Indikator Vzrok in odprava
prikaZe sporocilo, indikator snemanja zac¢ne utripati in predvaja se opozorilni zvok. zvok snemanja
Opozorilni zvok se predvaja iz slusalk, povezanih na prikljucek za slusalke. Media Temperature  V presledkih  Utripa Temperatura kartice CFexpress je visoka.
High Zamenjajte kartico ali pocakajte, da se ohladi,
preden jo znova uporabite.
Voltage Low V presledkih  Utripa Napetost omreZnega napajanja je nizka (level 1).
SporoEiIa 0 napakah Preverite vir napajanja.
Insufficient Voltage neprekinjeno Hitro utripa  Napetost omreznega napajanja je prenizka
. o . ) . (level 2). Snemanje je onemogoceno.
Ce se pojavi sledece, bo videokamera prenehala delovati. Priklopite drug vir napajanja.
Sporocilo v iskalu Opozorilni Indikator Vzrok in odprava Media Near Full V presledkih  Utripa Zmanjkuje preostalega prostora na pomnilniski
zvok snemanja kartici.
Koda napake E + neprekinjeno Hitro utripa  Oznacuje neobi¢ajno delovanje videokamere. Cim prej zamenjajte.
Snemanje se ustavi, tudi Ce je v iskalu prikazan Media Full neprekinjeno Hitro utripa  Posnetkov ni mogoce posneti ali kopirati, saj ni
simbol REC @. vec prostora na pomnilniski kartici.
Izklopite videokamero in preverite morebitne Takoj zamenjajte.
teZave s povezanimi napravami, kabli in Clips Near Full V presledkih  Utripa Stevilo dodatnih posnetkov, ki jih je mogoce
pomnilnigkimi mediji. Ce je po ponovnem vklopu posneti na pomnilnisko kartico, se zmanjsuje.
videokamere napaka Se vedno prisotna, se Cim prej zamenjajte.
obrnite na servisnega predstavnika podjetja Sony. Clips Full neprekinjeno Hitro utripa DoseZeno je bilo najvecje $tevilo posnetkov, ki jih
(Ce se videokamera ne izklopi, ko ste stikalo je mogoce posneti na pomnilnisko kartico.
POWER prestavili v poloZaj OFF, odstranite Snemanije ali kopiranje novih posnetkov ni
baterijo ali odklopite omrezno napajanje.) mogoce. Takoj zamenjajte.
Glede na stanje videokamere se morda ne bo Last Clip Recording  V presledkih  Utripa Posnetek, ki se trenutno snema, je zadniji
izpisalo sporocilo o napaki ali predvajal posnetek, ki ga je mogoce posneti, saj je bilo
opozorilni zvok. doseZeno najvedje tevilo posnetkov.
Pripravite novo pomnilnisko kartico.
Media(A)" Life Near  V presledkih  Utripa Pomnilniska kartica se priblizuje koncu svoje
End Zivljenjske dobe. Cim prej zamenjajte.
Opozorilna Sporofila Media(A)" Life End neprekinjeno Hitro utripa  Pomnilniska kartica je dosegla konec svoje
Zivljenjske dobe. Takoj zamenjajte.
. avi sledete sledi dnii il Media(A)" Near Full V presledkih  Utripa Pri uporabi funkcije Simul Rec
Ce se pojavi sledece, sledite spodnjim navodilom. Media(A)" Full neprekinjeno Hitro utripa  Pri uporabi funkcije Simul Rec
Sporocilo v iskalu Opozorilni Indikator Vzrok in odprava Media(A)" Clips Near V presledkih  Utripa Pri uporabi funkcije Simul Rec
zvok snemanja Full
Battery Near End V presledkih  Utripa Preostala napolnjenost paketa baterij je nizka. Media(A)" Clips Full  neprekinjeno Hitro utripa  Pri uporabi funkcije Simul Rec
Cim prej napolnite. Media(A)" Last Clip V presledkih  Utripa Pri uporabi funkcije Simul Rec
Battery End neprekinjeno Hitro utripa  Paket baterij je prazen. Snemanje je Rec
onemogoceno. 1) Zakartico v rezi B je prikazano »(B)«.
Prekinite uporabo in zamenjajte paket baterij.
Temperature High V presledkih  Utripa Notranja temperatura je visoka.

Izklopite videokamero in pred ponovno uporabo
pocakajte, da se ohladi.
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8. Dodatek: Sporocila o napakah/opozorilna sporocila

Previdnostna sporocila in sporocila o delovanju

Sledeca previdnostna sporocila in sporocila o delovanju se lahko pojavijo sredi zaslona. Za
razresSitev teZave sledite spodnjim navodilom.

Sporocilo na zaslonu Vzrok in odprava

Sporocilo na zaslonu

Vzrok in odprava

Cannot Use Specified Port Number

Navedena Stevilka vrat ni veljavna.
Preverite, ali je nastavitev pravilna.

Fan Stopped

Vgrajeni ventilator se je ustavil.

Izogibajte se uporabi pri visokih temperaturah, odklopite
napajanje in stopite v stik s servisnim predstavnikom podjetja
Sony.

Battery Error
Please Change Battery

Zaznana je bila napaka paketa baterij.
Zamenijajte z normalnim paketom baterij.

Backup Battery End
Please Change

Preostala napolnjenost pomoZne baterije je nezadostna.
Napolnite pomozno baterijo.

Unknown Media (A)"
Please Change

Vstavljena je bila pomnilniSka kartica, ki vsebuje particije ali
pomnilniska kartica, ki vsebuje vec posnetkov, kot jih lahko
obravnava videokamera.

Kartice ni mogoce uporabljati v videokameri in jo je treba
zamenjati.

Cannot Use Media (A) "
Unsupported File System

Vstavljena je bila neformatirana kartica ali kartica, ki uporablja
drugacen datotecni sistem.

Kartice ni mogoce uporabljati v videokameri in jo je treba
zamenijati ali formatirati z videokamero.

Media Error
Media (A) " Needs to be Restored

Na pomnilniski kartici je prislo do napake in jo je treba
obnoviti.
Pomnilnisko kartico obnovite.

Media Error
Cannot Record to Media (A) "

Pomnilniska kartica je morda poskodovana in je ni vec
mogoce uporabljati za snemanje.

Predvajanje je mogoce, zato je priporocljivo, da naredite
kopijo in zamenjate pomnilnisko kartico.

Media Error
Cannot Use Media (A) "

Pomnilniska kartica je morda poskodovana in je ni vec
mogoce uporabljati za snemanje ali predvajanje.

Kartice ni mogoce uporabljati v videokameri in jo je treba
zamenijati.

Media (A) " Error
Recording Halted
Playback Halted

Snemanje in predvajanje sta bila ustavljena, ker je med
uporabo pomnilniske kartice prislo do napake.

Ce teZave ne morete odpraviti, pomnilnigko kartico
zamenjajte.

Media Reached Rewriting Limit
Change Media (A) "

Pomnilniska kartica je dosegla konec svoje Zivljenjske dobe.
Naredite varnostno kopijo in takoj zamenjajte kartico. Ce
nadaljujete z uporabo kartice, snemanje ali predvajanje morda
ne bo mogoce.

Za podrobnosti glejte navodila za uporabo pomnilniske
kartice.

Navedeni naslov ni veljaven. Navedeni naslov ni veljaven.

Preverite, ali je nastavitev pravilna.

Lens I/F Error(xx:xx)

Ob namestitvi objektiva serije E je bila zaznana napaka v
komunikaciji objektiva I/F.

Preverite stanje povezave z objektivom serije E.

Ce je tezava prisotna $e naprej, se obrnite na servisnega
predstavnika podjetja Sony in mu sporocite kodo napake (pet
znakov v oklepaju).

This Multi Term. acc is not supported
by the device and cannot be used.
Please verify the compatibility.

Zaznan je bil nezdruZljiv dodatek.
Edini dodatek Multi Terminal, ki ga enota podpira, je priloZzeno
drzalo z daljinskim upravljalnikom.

Failed (Neuspesno)

Ta napaka se lahko pojavi, ¢e ni mogoce pridobiti naslova, ko
je DHCP nastavljen na On.
Preverite nastavitve streznika DHCP.

Cannot add auto upload job of Proxy
file because maximum number of
upload jobs was reached.

DoseZeno je bilo najvecje Stevilo prenosov.

Izbrisite nezelene prenose. Morda je tudi napacno nastavljen
cilj samodejnega nalaganja datotek proxy. Preverite, ali je
nastavitev pravilna.

<SSID>Not found.

OmreZja (dostopovne tocke) z navedenim imenom <SSID> ni
bilo mogoce najti.
Preverite, ali je nastavitev pravilna.

<SSID>Authentication Failed

Avtentikacija povezave v omreZje (na dostopovno tocko) z
navedenim imenom <SSID> je spodletela.
Preverite, ali so geslo in ostale nastavitve pravilni.

An IP address conflict has occurred.
Please check the network settings.

Obstaja spor med omreznimi naslovi brezZi¢nega omreZzja
LAN, Zi¢cnega omreZja LAN ali povezave USB.

Rocno spremenite naslov ali spremenite nastavitve
omreznega usmerjevalnika.

The IP address of the Wireless LAN
Access Point Mode has been
changed due to an IP address
conflict.

Naslov IP nacina dostopovne tocke za brezzi¢cno omrezje LAN
je bil spremenjen zaradi spora med omreznimi naslovi nacina
dostopovne tocke brezzi¢cnega omrezja LAN, Zicnega omrezja
LAN ali povezave USB.

Preverite nastavitev naslova IP.

1) Za kartico v reZi B je prikazano »(B)«.
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Elementi, shranjeni v datotekah

Elementi, konfigurirani Vv gIavnem meniju RAVEN 1 RAVEN 2 RAVEN 3 All File Scene File
Shooting Auto Exposure Level Da Ne
. ) Mode Da Ne
Ne.Element i hranjen. Speed Da e
—: Ni shranjen (za¢asna nastavitev) AGC Da Ne
RAVEN 1 RAVEN 2 RAVEN 3 All File Scene File AGC Lirr.1it Da Ne
Shooting ISO/Gain/El Mode Da Ne AGC Point Da Ne
- Auto Shutter Da Ne
:282::::;2 g: E: A.SHT Limit Da Ne
IS0/ Gain<l> Da Ne A.SHT Point Da Ne
Exposure Index<H> Da Ne Clip High light Da Ne
Exposure Index<M> Da Ne Detect W?ndow . Da Ne
Exposure Index<L> Da Ne Detect Window Indication Da Ne
- Custom Width Da Ne
Shockless .G.a.m ba Ne Custom Height Da Ne
222: ISSegsmwty gz E: Custom H Position Da Ne
ND Filter Presetl Da Ne Custom V Position Da Ne
Bel Preset White Da Ne
E;::g g: E: Color Temp <A> Da Ne
Zaklop Mode Da Ne Tint<A> Da Ne
R Gain <A> Da Ne
zﬁu::er zpeej On/Off ga Ee B Gain <A> Da Ne
e - T—
Tint<B> Da Ne
ECS On/Off Da Ne R Gain <B> Da Ne
ECS Frequency Da Ne B Gain <B> Da Ne
White Setting Shockless White Da Ne
ATW Speed Da Ne
White Switch<B> Da Ne
Filter White Memory Da Ne
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RAVEN 1 RAVEN 2 RAVEN 3 All File Scene File RAVEN 1 RAVEN 2 RAVEN 3 All File Scene File
Shooting Offset White Offset White <A> Da Ne Project Base Setting Shooting Mode Da -
Offset Color Temp<A> Da Ne Target Display Da -
Offset Tint<A> Da Ne Rec Format Frekvenca Da Ne
Offset White <B> Da Ne Imager Scan Mode Da Ne
Offset Color Temp<B> Da Ne Kodek Da Ne
Offset Tint<B> Da Ne Izhodni format RAW Da Ne
Offset White<ATW> Da Ne Video Format Da Ne
Offset Color Temp<ATW> Da Ne Cine El Setting Color Gamut Da -
Offset Tint<ATW> Da Ne Simul Rec Setting Da Ne
Focus AF Transition Speed Da Ne Proxy Rec Setting Da Ne
AF Subj. Shift Sens. Da Ne Audio Channel Da Ne
Focus Area Da Ne Interval Rec Setting Ne Ne
Focus Area (AF-S) Da Ne Interval Time Da Ne
AF z zaznavanjem obrazov/oci Da Ne Number of Frames Da Ne
Push AF Mode Da Ne Pre-Lighting Da Ne
AF Assist Da Ne SDI/HDMI Rec Control Setting Da Ne
S&Q Motion Setting Da Ne Assignable Button <1> Da Ne
Frame Rate Da Ne <2> Da Ne
LUT On/Off SDI/HDMI Da Ne <3> Da Ne
VF/Proxy/Stream Da Ne <4> Da Ne
Internal Rec Da Ne <5> Da Ne
Noise Suppression Setting(Custom) Da Ne <6> Da Ne
Level(Custom) Da Ne <7> Da Ne
Setting(Cine El) Da - <8> Da Ne
Level(Cine El) Da - <9> Da Ne
Flicker Reduce Mode Da Ne Focus Hold Button Da Ne
Frekvenca Da Ne Assignable Dial Kolesce na drzalu/daljinskem Da Ne
SteadyShot Setting Da Ne upravljalniku
Smer kolesca na drzalu Da Ne
Kolesce na rocaju Da Ne
Smer kolesca na rocaju Da Ne
Multi Function Dial Default Function Da Ne
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RAVEN 1 RAVEN 2 RAVEN 3 All File Scene File RAVEN 1 RAVEN 2 RAVEN 3 All File Scene File
Project User File Load Media(B) - - Paint/Look Matrix User Matrix Da Da
Save Media(B) - - User Matrix Level Da Da
File ID Ne Ne User Matrix Phase Da Da
Load Customize Data Da Ne User Matrix R-G Da Da
Load White Data Da Ne User Matrix R-B Da Da
All File Load Media(B) - - User Matrix G-R Da Da
Save Media(B) - - User Matrix G-B Da Da
File ID Da Ne User Matrix B-R Da Da
Load Network Data Ne Ne User Matrix B-G Da Da
Paint/Look Scene File Recall - - Multi Matrix Setting Da Da
Shranjevanje - - Ponastavitev - -
Delete - - Axis Ne Da
Preset Recall - - Hue Da Da
Base Look izberite Da Da Saturation Da Da
Delete - - TC/Media Timecode Mode Da Ne
Delete All - - Run Da Ne
Import . - Setting Ne Ne
Vhod Da Da Ponastavitev - -
1zhod Da Da TC Format Da Ne
AE Level Offset Da Da TC Display Display Select Da Ne
Reset Paint Settings Ponastavitev brez Base Look - - Users Bit Mode Da Ne
¢ Master Black Da Da Setting Ne Ne
R Black Da Da HDMI TC Out Setting Da Ne
B Black Da Da Clip Name Format Title Prefix Da Ne
Knee Setting Da Da Number Set Ne Ne
Auto Knee Da Da Update Media Media(A) - -
Point Da Da Media(B) - -
Slope Da Da Format Media Media(A) - -
Detail Setting Da Da Media(B) - -
Level Da Da Monitoring Output On/Off SDI Da Ne
Manual Setting Da Da HDMI Da Ne
V/H Balance Da Da Output Format SDI Da Ne
B/W Balance Da Da HOMI Da Ne
Limit Da Da Output Display SDI Da Ne
Crispening Da Da HOMI Da Ne
High Light Detail Da Da
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RAVEN 1 RAVEN 2 RAVEN 3 All File Scene File RAVEN 1 RAVEN 2 RAVEN 3 All File Scene File

Monitoring Display On/Off Network Status Da Ne Monitoring Display On/Off Video Level Warning Da Ne
File Transfer Status Da Ne Clip Number Da Ne
Rec/Play Status Da Ne Notice Message Da Ne
RAW Output Control Status Da Ne Marker Setting Da Ne
Tally Da Ne Color Da Ne
Battery Remain Da Ne Center Marker Da Ne
Focus Mode Da Ne Safety Zone Da Ne
Focus Position Da Ne Safety Area Da Ne
Focus Area Indicator Da Ne Aspect Marker Da Ne
Focus Area Ind.(AF-S) Da Ne Aspect Mask Da Ne
Face/Eye Detection Frame Da Ne Aspect Safety Zone Da Ne
Lens Info Da Ne Aspect Safety Area Da Ne
Imager Scan Mode Da Ne Aspect Select Da Ne
Rec Format Da Ne Custom Aspect Ratio Da Ne
Frame Rate Da Ne Guide Frame Da Ne
Zoom Position Da Ne 100% Marker Da Ne
UWP RF Level Da Ne User Box Da Ne
SteadyShot Da Ne User Box Width Da Ne
Base Look/LUT Da Ne User Box Height Da Ne
SDI/HDMI Rec Control Da Ne User Box H Position Da Ne
Gamma Display Assist Da Ne User Box V Position Da Ne
Proxy Status Da Ne VF Setting osvetlitev Da Ne
Base I1SO/Sensitivity Da Ne Color Mode Da Ne
Media Status Da Ne Gamma Display Assist  Setting Da Ne
Video Signal Monitor Da Ne Peaking Setting Da Ne
Clip Name Da Ne Peaking Level Da Ne
White Balance Da Ne Color Da Ne
Scene File Da Ne Zebra Setting Da Ne
Focus Indicator Da Ne Zebral Level Da Ne
Auto Exposure Mode Da Ne Zebral Aperture Level Da Ne
Auto Exposure Level Da Ne Zebra2 Level Da Ne
Timecode Da Ne
ND Filter Da Ne
Iris Da Ne
ISO/Gain/El Da Ne
Zaklop Da Ne
Level Gauge Da Ne
Audio Level Meter Da Ne
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RAVEN 1 RAVEN 2 RAVEN 3 All File Scene File RAVEN 1 RAVEN 2 RAVEN 3 All File Scene File

Avdio Audio Input CH1 Input Select Da Ne Thumbnail Display Clip Properties - -
CH2 Input Select Da Ne Set Clip Flag Add OK - -
CH3 Input Select Da Ne Add NG - -
CH4 Input Select Da Ne Add KEEP - -
INPUT1 MIC Reference Da Ne Delete Clip Flag - -
INPUT2 MIC Reference Da Ne Lock/Unlock Clip Select Clip - -
Line Input Reference Da Ne Lock All Clips - -
Reference Level Da Ne Unlock All Clips - -
CH1 Wind Filter Da Ne Delete Clip Select Clip - -
CH2 Wind Filter Da Ne All Clips - -
CH3 Wind Filter Da Ne Transfer Clip Select Clip - -
CH4 Wind Filter Da Ne All Clips - -
CH3 Level Control Da Ne Transfer Clip (Proxy) Select Clip - -
CH4 Level Control Da Ne All Clips - -
CH3 Input Level Da Ne Filter Clips oK - -
CH4 Input Level Da Ne NG - -
Audio Input Level Da Ne KEEP - -
Limiter Mode Da Ne None - -
CH1&2 AGC Mode Da Ne All - -
CH3&4 AGC Mode Da Ne Customize View Thumbnail Caption Da -

AGC Spec Da Ne Technical Color Bars Setting Ne Ne

1kHz Tone on Color Bars Da Ne Tip Da Ne

CH1 Level Da Ne ND Dial CLEAR with Dial Da Ne

CH2 Level Da Ne Tally Front Da Ne

CH3 Level Da Ne Rear Da Ne

CH4 Level Da Ne HOLD Switch Setting with Rec Button Da Ne

Avdio izhod Monitor CH Da Ne with Hand Grip Remote Da Ne

Volume Ne Ne Touch Operation Setting Da Ne

Headphone Out Da Ne Rec Review Setting Da Ne

Alarm Level Da Ne Zoom Zoom Type Da Ne

HDMI Output CH Da Ne Handle Zoom Setting Da Ne

High Da Ne

Low Da Ne

Menu Settings User Menu Only Da Ne

User Menu with Lock Ne Ne

Fan Control Setting Da Ne
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8. Dodatek: Elementi, shranjeni v datotekah

RAVEN 1 RAVEN 2 RAVEN 3 All File Scene File RAVEN 3 All File Scene File
Technical Lens Zoom Ring Direction Da Ne ST Mode Settings Camera Remote Control Da Ne
Shading Compensation Da Ne Connected Network
Chroma Aberration Comp. Da Ne SSID - -
Distortion Comp. Da Ne Security - -
Distance Display Da Ne Password - -
Zoom Position Display Da Ne DHCP - -
Video Light Set Video Light Set Da Ne IP Address - -
APR APR - - Subnet Mask - -
Camera Battery Alarm Low Battery Da Ne Gateway - -
Battery Empty Da Ne DNS Auto - -
Camera DCIN Alarm DC Low Voltagel Da Ne Primary DNS Server - -
DC Low Voltage2 Da Ne Secondary DNS Server - -
Network Access Authentication  User Name Ne Ne Scan Networks
Password Ne Ne SSID - B
Wireless LAN Setting Da Ne Security - -
WPS - - Password Ne Ne
NFC - - DHCP Da Ne
MAC Address - - IP Address Da Ne
AP Mode Settings Channel Da Ne Subnet Mask Da Ne
Camera SSID & Password - - Gateway Da Ne
Regenerate Password - - DNS Auto Da Ne
IP Address - - Primary DNS Server Da Ne
Subnet Mask - - Secondary DNS Server Da Ne
Manual Register
SSID Da Ne
Security Da Ne
Password Ne Ne
DHCP Da Ne
IP Address Da Ne
Subnet Mask Da Ne
Gateway Da Ne
DNS Auto Da Ne
Primary DNS Server Da Ne
Secondary DNS Server Da Ne




12251 8. Dodatek: Elementi, shranjeni v datotekah

RAVEN 1 RAVEN 2 RAVEN 3 All File Scene File RAVEN 1 RAVEN 2 RAVEN 3 All File Scene File
Network Wired LAN Setting Da Ne Maintenance  Language Select Da Ne
Camera Remote Control Da Ne Clock Set Time Zone Da Ne
Detail Settings Date Mode Da Ne
DHCP Da Ne 12H/24H Da Ne
IP Address Da Ne Datum Ne Ne
Subnet Mask Da Ne Time Ne Ne
Gateway Da Ne All Reset Reset - -
DNS Auto Da Ne Reset without Network - -
Primary DNS Server Da Ne Hours Meter Hours (System) - -
Secondary DNS Server Da Ne Hours (Reset) - -
Modem Setting Da Ne Reset - -
Camera Remote Control Da Ne Version Version Number - -
Device Name - - Version Up - -
IP Address - B Lens Version Number - B
Subnet Mask - -
File Transfer Auto Upload (Proxy) Da Ne
Default Upload Server Da Ne

Clear Completed Jobs

Clear All Jobs - -
View Job List - -
Server Settings1/Server Settings2/Server Settings3
Display Name Da Ne
Service Da Ne
Host Name Da Ne
Port Da Ne
User Name Ne Ne
Password Ne Ne
Passive Mode Da Ne
Destination Directory Da Ne
Using Secure Protocol Da Ne
Root Certificate - -
Root Certificate Status - -
Reset - -
Network Reset Reset - -
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8. Dodatek: Elementi, shranjeni v datotekah

Elementi, konfigurirani z dodeljivimi gumbi

Da: Element je shranjen.
Ne: Element ni shranjen.
-: Ni shranjen (zacasna nastavitev)

Izbira dodeljivega gumba All File Scene File
ND Filter Position Da Ne

Auto Iris Da Ne

ATW Da Ne

Focus Setting Da Ne
Display Da -

VF Adjust Da -
Elementi, konfigurirani z dodeljivim kolescem

Da: Element je shranjen.

Ne: Element ni shranjen.
-: Ni shranjen (zacasna nastavitev)

Izbira dodeljivega kolesca All File Scene File
IRIS Da Ne

ND Filter Da Ne

Audio Input Level Da Ne
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Sheme delovanja

Glejte povezane elemente v razdelkih »Nastavitev zvoka, ki ga Zelite posneti« (stran 46) in »Face/Eye Detection AF« (stran 69).

Avdio vhod (CH1in CH2)

S¢enim rocajem.

Na naslednji sliki je prikazana shema delovanja z name
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* Nastavljeno na Manual, ko vhodni zvok prihaja iz adapterja XLR.
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Avdio vhod (CH3 in CH4)

Scenim rocajem.

Na naslednji sliki je prikazana shema delovanja z name
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8. Dodatek: Sheme delovanja

Avdio izhod
CH1 > A
CH2 >
SDI OUT
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CH4 ~ - > J
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Posodabljanje programske opreme objektiva serije E

Programsko opremo objektiva serije E lahko
posodobite prek videokamere.

Na spletni strani za objektive poglejte, katere
objektive je mogoce posodobiti in katera je
ustrezna programska oprema.

Preverjanje razlicice

1 Na videokamero namestite objektiv
serije E (stran 22).

2 Izberite moznost Version v meniju
Maintenance glavnega menija, da
prikaZete oznako razlicice objektiva Lens
Version Number (stran 99).

Oznaka razli¢ice programske opreme
objektiva serije E je prikazana ob strani.

Posodabljanje programske
opreme

Videokamero nastavite v nac¢in masovnega
shranjevanja (stran 108).

Programsko opremo posodobite po postopku,
ki je priloZen programski opremi za objektiv.
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8. Dodatek

Licence

Licenca MPEG-4 Visual Patent
Portfolio

TA IZDELEK JE LICENCIRAN V OKVIRU

LICENCE PORTFELJA ZA PATENT AVC ZA

OSEBNO UPORABO POTROSNIKA ALI DRUGE

UPORABE, PRI KATERIH POTROSNIK NE PREJME

FINANCNEGA NADOMESTILA ZA

(i) KODIRANJE VIDEOVSEBIN V SKLADU S
STANDARDOM MPEG-4 VISUAL (»MPEG-4
VIDEO«) IN/ALI

(if) ODKODIRANJE VIDEOVSEBIN MPEG-4, KI JIH
JE POTROSNIK KODIRAL V OKVIRU OSEBNE
IN NEKOMERCIALNE DEJAVNOSTI IN/ALI
PRIDOBIL OD PONUDNIKA VIDEOVSEBIN,
LICENCIRANEGA S STRANI MPEG LA ZA
DISTRIBUCIIO VIDEOVSEBIN MPEG-4.

LICENCA SE NE DODELJUJE IN NI NAMENJENA
ZA KAKRSNO KOLI DRUGO UPORABO.
DODATNE INFORMACIJE, VKLIUCNO Z
INFORMACIJAMI GLEDE UPORABE V
REKLAMNE, INTERNE IN KOMERCIALNE
NAMENE IN GLEDE PRIDOBITVE LICENC, SO
NA VOLIO PRI DRUZBI MPEG LA, LLC. OBISCITE
HTTP://WWW.MPEGLA.COM

Uporaba programske opreme pod
licenco GPL/LGPL

Ta izdelek uporablja programsko opremo, za
katero velja licenca GPL/LGPL. To pomeni,

da imate pravico do dostopa, spreminjanja

in nadaljnje distribucije izvorne kode za to
programsko opremo, in sicer v skladu s pogoji
licence GPL/LGPL.

Izvorna koda je na voljo na spletu. Uporabite
sledec naslov URL in sledite navodilom za
prenos.

http://www.sony.net/Products/Linux/
common/search.html

Zelimo, da se v zvezi z vsebino izvorne kode
ne obracate na nas.

Licence (v anglescini) so shranjene v
notranjem pomnilniku izdelka.

Vzpostavite povezavo za koli¢insko
shranjevanje med izdelkom in racunalnikom za
branje licenc v mapi »PMHOME« — » LICENSE«.

Ce uporabljate ra¢unalnik Mac, mapa
»PMHOME« - »LICENSE« morda ne bo
dostopna.

Za ogled datotek uporabite racunalnik, ki ni
Mac, ali obiscite ta naslov URL.
https://0ss.sony.net/License/ILME-FX6/

LICENCNA POGODBA ZA
KONCNEGA UPORABNIKA

POMEMBNO:

PRED UPORABO PROGRAMSKE OPREME, KI JO VSEBUJE
VIDEOKAMERA S POMNILNIKOM SSD, PROSIMO,
POZORNO PREBERITE TO POGODBO ZA KONCNEGA
UPORABNIKA (»EULA«). Z UPORABO PROGRAMSKE
OPREME SPREJEMATE DOLOCILA TE POGODBE EULA. CE
NE SPREJMETE DOLOCIL TE POGODBE EULA, NE SMETE
UPORABLJATI TE PROGRAMSKE OPREME.

Ta pogodba EULA je pravna pogodba med vami in
druzbo Sony Corporation (»SONY«). Ta pogodba EULA
doloca vase pravice in obveznosti v povezavi s
programsko opremo druzbe SONY in/ali drugih
povezanih izdajateljev licenc (vklju¢no s podruznicami
druzbe SONY) in njihovih podruznic (s skupnim imenom
»DRUGI DOBAVITELJI«), ki jo vsebuje brezzi¢ni adapter,
skupaj vsemi posodobitvami/nadgraditvami, ki jih
zagotavlja druzba SONY, vso tiskano, spletno ali
elektronsko dokumentacijo za tako programsko opremo
in vsemi podatkovnimi datotekami, ustvarjenimi z
uporabo take programske opreme (s skupnim imenom
»PROGRAMSKA OPREMA).

Ne glede na navedeno se za vso programsko opremo v
PROGRAMSKI OPREMI, ki ima loceno licencno pogodbo za
kon¢nega uporabnika (vklju¢no z, vendar ne omejeno na
GNU General Public License in Lesser/Library General Public
License), namesto doloil te pogodbe EULA uporablja
taksna locena veljavna licencna pogodba za koncnega
uporabnika v obsegu, ki ga zahteva taka locena licencna
pogodba za koncnega uporabnika (»IZVZETA PROGRAMSKA
OPREMA«).

LICENCA ZA PROGRAMSKO OPREMO

Druzba SONY vam odobri licenco za uporabo (in vam ne
prodaja) PROGRAMSKE OPREME. PROGRAMSKA OPREMA je
zas(itena z zakoni in mednarodnimi pogodbami o avtorskih
pravicah in drugih pravicah intelektualne lastnine.

AVTORSKE PRAVICE

Vsi pravice in pravni naslovi v povezavi s PROGRAMSKO
OPREMO (vklju¢no z, vendar ne omejeno na kakr$ne koli
slike, fotografije, animacijo, videoposnetke, glasbo, besedilo
in »programcke«) so last druzbe SONY ali enega ali vec
DRUGIH DOBAVITELJEV.

ODOBRITEV LICENCE

SONY vam podeljuje omejeno licenco za uporabo
PROGRAMSKE OPREME samo v povezavi z brezzi¢nim
adapterjem in samo za vaso individualno uporabo. Druzba
SONY in DRUGI DOBAVITELJI si izrecno pridrZujejo vse
pravice, pravne naslove in interese (vkljucno z vsemi
pravicami intelektualne lastnine, vendar ne omejeno nanje)
v povezavi s PROGRAMSKO OPREMO, ki vam jih ta pogodba
EULA izrecno ne podeljuje.

ZAHTEVE IN OMEJITVE

Kopiranje, objavljanje, prilagajanje, nadaljnja distribucija,
poskusi pridobitve izvorne kode, spreminjanje, obratni
inZeniring, povratno prevajanije ali obratno zbiranje katere
koli PROGRAMSKE OPREME, v celoti ali njenih delov, ali
izpeljave iz ali od PROGRAMSKE OPREME niso dovoljeni,
razen ¢e PROGRAMSKA OPREMA namerno olajsa take
izpeljave. Spreminjanje ali poseganije v kakrsne koli
funkcionalnosti za upravljanje digitalnih pravic
PROGRAMSKE OPREME ni dovoljeno. Ni dovoljeno obiti,
spremeniti, onesposobiti ali zaobiti katere koli funkcije ali
zasCite PROGRAMSKE OPREME ali katerih koli mehanizmov,
ki so povezani z delovanjem PROGRAMSKE OPREME. Ni
dovoljeno razdvajiti katerih koli individualnih komponent

PROGRAMSKE OPREME za uporabo z ve¢ kot enim
brezzi¢nim adapterjem, razen z izrecnim dovoljenjem
druzbe SONY. Odstranjevanje, spreminjanje, prekrivanje ali
unicenje katerih koli blagovnih znamk ali obvestil na
PROGRAMSKI OPREMI ni dovoljeno. Skupna raba,
distribucija, najem, zakup, podlicenciranje, dodeljevanje,
prenos ali prodaja PROGRAMSKE OPREME ni dovoljena.
Programska oprema, omrezne storitve ali drugi izdelki,
razen PROGRAMSKE OPREME, od katerih je odvisno
delovanje PROGRAMSKE OPREME, je lahko prekinjeno ali
ukinjeno po presoji dobaviteljev (dobaviteljev programske
opreme, storitev ali druzbe SONY). Druzba SONY in taksni
dobavitelji ne jamijo, da bodo PROGRAMSKA OPREMA,
omrezne storitve, vsebina ali drugi izdelki Se naprej na voljo
ali da bodo delovali brez prekinitev ali sprememb.

1ZVZETA PROGRAMSKA OPREMA IN
ODPRTOKODNE KOMPONENTE

Ne glede na navedeno omejeno podeljeno licenco se
strinjate, da lahko PROGRAMSKA OPREMA vkljucuje
IZVZETO PROGRAMSKO OPREMO. Dolocena IZVZETA
PROGRAMSKA OPREMA je lahko zajeta z licencami
odprtokodne programske opreme (»odprtokodne
komponente«), kar pomeni vse licence za programsko
opremo, ki jih je kot odprtokodne licence potrdila
organizacija Open Source Initiative, ali kakrsne koli
vsebinsko podobne licence, vklju¢no z licencami, vendar ne
omejeno nanje, pri katerih mora kot pogoj za distribucijo
programske opreme, licencirane v okviru tak$ne licence,
distributer omogo(iti dostop do izvorne kode programske
opreme. Ce je potrebno razkritje, obiscite www.sony.com/
linux ali drugo s strani druzbe SONY doloceno spletno
mesto za seznam veljavnih ODPRTOKODNIH KOMPONENT,
obcasno vklju¢enih v PROGRAMSKO OPREMO, in veljavne
pogoje, ki urejajo njeno uporabo. Te pogoje lahko zadevne
tretje osebe kadar koli spremenijo, in sicer brez
odgovornosti do vas. V obsegu, ki ga zahtevajo licence, ki
zajemajo 1ZVZETO PROGRAMSKO OPREMO, bodo pogoji
taksnih licenc veljali namesto pogojev te pogodbe EULA. V
kolikor pogoji licenc, ki veljajo za 1ZVZETO PROGRAMSKO
OPREMO, prepoveduijejo kakrsne koli omejitve v tej pogodbi
EULA v zvezi s tako 1ZVZETO PROGRAMSKO OPREMO, te
omejitve ne bodo veljale za tako 1ZVZETO PROGRAMSKO
OPREMAO. V kolikor mora druzba SONY v skladu s pogoji
licenc, ki veljajo za odprtokodne komponente, podati
ponudbo za prikaz izvorne kode v zvezi s PROGRAMSKO
OPREMO, je taka ponudba s tem podana.


http://www.sony.net/Products/Linux/common/search.html
http://www.sony.net/Products/Linux/common/search.html
http://https://oss.sony.net/License/ILME-FX6/
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UPORABA PROGRAMSKE OPREME Z
AVTORSKO ZASCITENIMI MATERIALI
PROGRAMSKO OPREMO boste morda lahko uporabili za
ogledovanje, shranjevanje obdelovanje in/ali uporabo
vsebine, ki ste jo ustvarili sami ali pa so jo ustvarile druge
osebe. Taka vsebina je morda zascitena na podlagi zakonov
o avtorskih pravicah, zakonov o drugih pravicah intelektualne
lastnine in/ali sporazumov. Soglasate, da boste
PROGRAMSKO OPREMO uporabljali samo v skladu z vsemi
takimi zakoni in sporazumi, ki veljajo za takSne vsebine.
Priznavate in se strinjate, da lahko SONY sprejme ustrezne
ukrepe za zascito avtorskih pravic vsebin, ki so shranjene,
obdelane ali uporabljene s PROGRAMSKO OPREMO. Taki
ukrepi vkljucujejo, vendar niso omejeni na Stetje pogostosti
izdelave varnostnih kopij in obnavljanja prek dolocenih
funkcij PROGRAMSKE OPREME, zavrnitev vase zahteve za
obnovitev podatkov in prekinitev te pogodbe EULA v primeru
nezakonite uporabe PROGRAMSKE OPREME.

VSEBINSKA STORITEV

UPOSTEVAJTE, DA JE PROGRAMSKA OPREMA LAHKO
ZASNOVANA ZA UPORABO Z VSEBINO, KI JE NA VOLJO PREK
ENE ALI VEC VSEBINSKIH STORITEV (»VSEBINSKA
STORITEV«). UPORABA STORITVE IN TE VSEBINE JE V
SKLADU Z DOLOCILI STORITVE ZA TO VSEBINSKO STORITEV.
CE ZAVRNETE TA DOLOCILA, BO VASA UPORABA TE
PROGRAMSKE OPREME OMEJENA. Priznavate in se strinjate,
da nekatero vsebino in storitve, ki so na voljo prek
PROGRAMSKE OPREME, lahko zagotovijo tretje stranke, nad
katerimi SONY nima nadzora. UPORABA VSEBINSKE
STORITVE ZAHTEVA INTERNETNO POVEZAVO. VSEBINSKA
STORITEV JE LAHKO KADAR KOLI PREKINJENA.

INTERNETNA POVEZLJIVOST IN STORITVE
TRETJIH STRANK

Priznavate in se strinjate, da je lahko za dostop do nekaterih
funkcij PROGRAMSKE OPREME potrebna internetna
povezava, za katero ste odgovorni sami. Poleg tega ste sami
odgovorni za placilo vseh pristojbin tretjim strankam,
povezanih z vaso internetno povezavo, vklju¢no z, vendar
ne omejeno na ponudnika internetnih storitev ali stroSke
Casa predvajanja. Delovanje PROGRAMSKE OPREME je lahko
omejeno ali onemogoceno, kar je odvisno od zmogljivosti,
pasovne Sirine ali tehni¢nih omejitev vase internetne
povezave in storitve. Zagotavljanje, kakovost in varnost take
internetne povezave je izkljuna odgovornost tretje stranke,
ki ponuja tako storitev.

1ZVOZ IN DRUGI PREDPISI

Soglasate, da boste upostevali vse veljavne omejitve in
predpise v zvezi z uvozom in ponovnim uvozom na
obmodju ali drzavi, v katerih prebivate, in da ne boste
prenesli ali dovolili prenosa PROGRAMSKE OPREME v
prepovedane drZave ali ravnali kako drugace v nasprotju s
temi omejitvami ali predpisi.

UPORABA Z VISOKIM TVEGANJEM

PROGRAMSKA OPREMA ni brez napak in ni zasnovana,
izdelana ali namenjena za uporabo ali nadaljnjo prodajo kot
oprema za nadzor v nevarnih okoljih, v katerih se zahteva
visoka zanesljivost (na primer v jedrskih elektrarnah ter
zrakoplovnih in komunikacijskih sistemih, pri nadzoru
zra¢nega prometa, upravljanju medicinskih naprav za
ohranjanje Zivljenja ali v vojaskih kompleksih z oroZjem) in v
katerih lahko okvara pri delovanju PROGRAMSKE OPREME
povzrodi smrt, telesne poskodbe ali resno fizi¢no ali okoljsko
Skodo (»UPORABA Z VISOKIM TVEGANJEM«). Druzba SONY,
vsi DRUGI DOBAVITELJI in vse podruznice se izrecno
odpovedujejo kakrsnim koli izrecnim ali naznacenim
jamstvom, dolZnostim ali pogojem za primernost opreme
za UPORABO Z VISOKIM TVEGANJEM.

1ZKLJUCITEV JAMSTVA ZA PROGRAMSKO
OPREMO

Soglasate in se strinjate, da PROGRAMSKO OPREMO
uporabljate na lastno odgovornost in da ste odgovorni za
uporabo PROGRAMSKE OPREME. PROGRAMSKA OPREMA je
na voljo »taksna, kot je«, brez kakrsnih koli jamstev,
dolZnosti ali pogojev.

Druzba SONY in vsi DRUGI DOBAVITELJI (za namene tega
razdelka so poimenovani s skupnim imenom »SONY«)
IZRECNO ZAVRACAJO VSA JAMSTVA, DOLZNOSTI ALI
POGOJE, IZRECNE ALI NAZNACENE, VKLJUCNO Z, VENDAR
NE OMEJENO NA NAZNACENA JAMSTVA O PRIMERNOSTI ZA
PRODAJO IN DOLOCEN NAMEN TER NEKRSITVI. DRUZBA
SONY NE JAMCI ALI ZAGOTAVLIA KAKRSNIH KOLI POGOJEV
ALI NAVEDB (A) DA BODO FUNKCIJE KATERE KOLI
PROGRAMSKE OPREME IZPOLNILE VASE ZAHTEVE ALI DA
BODO POSODOBLIJENE, (B) DA BO DELOVANJE KATERE KOLI
PROGRAMSKE OPREME PRAVILNO ALI BREZ NAPAK ALI DA
BODO KATERE KOLI NAPAKE ODPRAVLIENE, (C) DA
PROGRAMSKA OPREMA NE BO POSKODOVALA KATERE KOLI
DRUGE PROGRAMSKE ALI STROJNE OPREME ALI PODATKOV,
(D) DA BO KATERA KOLI PROGRAMSKA OPREMA, OMREZNA

STORITEV (VKLJUCNO Z INTERNETOM) ALI IZDELEK (RAZEN
PROGRAMSKE OPREME), NA KATEREM TEMELJI DELOVANJE
PROGRAMSKE OPREME, NA VOLJO SE NAPREJ,
NEPREKINJENO ALI NESPREMENJENO IN (E) V POVEZAVI Z
UPORABO ALI REZULTATI UPORABE PROGRAMSKE OPREME
V SMISLU NJENE PRAVILNOSTI, NATANCNOSTI,
ZANESLJIVOSTI ALl DRUGACE.

NOBENE INFORMACIJE ALI NASVETI PODJETJA SONY ALl
NJEGOVIH POOBLASCENIH PREDSTAVNIKOV V USTNI ALI
PISNI OBLIKI NE POMENIO JAMSTVA, DOLZNOSTI ALI
POGOJA ALI NA KAKRSEN KOLI NACIN POVECUJEJO OBSEG
TEGA JAMSTVA. CE JE PROGRAMSKA OPREMA OKVARJENA,
PREVZEMATE CELOTNE STROSKE VSEH POTREBNIH
SERVISOV ALI POPRAVIL. NEKATERE PRAVNE UREDITVE NE
DOVOLJUJEJO 1ZKLJUCITVE NAZNACENIH JAMSTEV, ZATO TE
IZKLJUCITVE MORDA NE VELJAJO ZA VAS.

OMEJITEV ODGOVORNOSTI

DRUZBA SONY IN VSI DRUGI DOBAVITELJI (za namene tega
razdelka so poimenovani s skupnim imenom »SONY«) NISO
ODGOVORNI ZA KAKRSNO KOLI NAKLJUCNO AL
POSLEDICNO SKODO ZARADI KRSITVE IZRECNEGA AL
NAZNACENEGA JAMSTVA, KRSITVE POGODBE,
MALOMARNOSTI, OBJEKTIVNE ODGOVORNOSTI ALI NA
PODLAGI DRUGEGA PRAVNEGA NACELA, POVEZANEGA S
PROGRAMSKO OPREMO, VKLJUCNO Z, VENDAR NE
OMEJENO NA SKODO, KI NASTANE ZARADI IZGUBE
DOBICKA, 1ZGUBO PRIHODKOV, IZGUBO PODATKOV, IZGUBO
UPORABE PROGRAMSKE OPREME ALI KATERE KOLI
POVEZANE STROJNE OPREME, CASA IZPADA IN
UPORABNIKOVEGA CASA, CEPRAV SO BILI OBVESCENI O
MOZNOSTI NASTANKA TAKSNE SKODE. VSAKA IN VSE
SKUPNE ODGOVORNOSTI V OKVIRU DOLOCIL TE POGODBE
EULA JE V VSAKEM PRIMERU OMEJENA NA DEJANSKI
ZNESEK, PLACAN ZA IZDELEK. NEKATERE PRAVNE UREDITVE
NE DOVOLJUJEJO IZKLJUCITVE ALI OMEJITVE NAKLJUCNE
ALI POSLEDICNE SKODE, ZATO ZGORAJ NAVEDENE
1ZKLJUCITVE ALI OMEJITVE MORDA NE VELJAJO ZA VAS.

SOGLASIJE ZA UPORABO NEOSEBNIH
PODATKOV, PODATKOV O LOKACUI, VARNOSTI
PODATKOV

Soglasate in se strinjate, da druzba SONY in njene
podruzZnice, partnerji in agenti lahko berejo, zbirajo,
prenasajo, obdelujejo in shranjujejo nekatere podatke,
zbrane s pomo¢jo PROGRAMSKE OPREME, vklju¢no z, a ne

omejeno na informacije o (i) PROGRAMSKI OPREMI in (ii)
programskih aplikacijah, vsebini in perifernih napravah, ki
komunicirajo z vasim brezzi¢nim adapterjem in
PROGRAMSKO OPREMO (»Informacije«). Informacije
zajemajo, vendar niso omejene na: (1) edinstvene
identifikatorje, vezane na vas brezzi¢ni adapter in njegove
komponente; (2) delovanje brezzi¢nega adapterja,
PROGRAMSKE OPREME in njihovih komponent; (3)
konfiguracije vasega brezzinega adapterja, PROGRAMSKE
OPREME in programskih aplikacij, vsebin in perifernih
naprav, ki komunicirajo z brezzi¢nim adapterjem in
PROGRAMSKO OPREMO; (4) uporabo in frekvenco uporabe
funkcij (x) PROGRAMSKE OPREME in (y) programskih
aplikacij, vsebin in perifernih naprav, ki komunicirajo s
PROGRAMSKO OPREMO; in (5) lokacijskih podatkov, kot je
oznaceno spodaj. Druzba SONY in njene podruZnice,
partnerji in agenti lahko uporabljajo in razkrivajo
informacije v skladu z veljavno zakonodajo, da bi izbolj3ali
svoje izdelke in storitve ali vam zagotovili produkte in
storitve. Taka uporaba zajema, vendar ni omejena na: (a)
upravljanje funkcionalnosti PROGRAMSKE OPREME, (b)
izboljsanje, servisiranje, posodabljanje ali nadgradnjo
PROGRAMSKE OPREME, (c) izboljsanje in razvijanje sedanjih
in prihodnjih izdelkov in storitev druzbe SONY in drugih
strank, (d) zagotavljanje informacij o izdelkih in storitvah, ki
jih ponujajo druzba SONY in druge stranke, (e) skladnost z
veljavnimi zakoni ali predpisi in (f) v obsegu, v katerem je na
razpolago, zagotavljanje lokacijske storitve druzbe SONY in
drugih strank, kot je navedeno spodaj. Poleg tega si druzba
SONY pridrZuje pravico do uporabe informacij za svojo
zas(ito in zasCito tretjih strank pred nezakonitim, kazenskim
ali skodljivim ravnanjem.

Nekatere storitve, ki so na voljo prek PROGRAMSKE
OPREME, se lahko zanaSajo na lokacijske informacije, med
drugim na geografsko lokacijo brezzi¢nega adapterja.
Soglasate, da za namen zagotavljanja takih storitev druzba
SONY, DRUGI DOBAVITELJI ali njihovi partnerji lahko zbirajo,
arhivirajo, obdelujejo in uporabljajo take lokacijske podatke
in da taksSne storitve ureja pravilnik o zasebnosti druzbe
SONY ali tretjih oseb. Preglejte pravilnik o varovanju
zasebnosti, ki velja za te storitve, in sprejemate te
dejavnosti.

Druzba SONY, njene podruznice, partnerji in agenti ne bodo
namenoma uporabljali informacij za osebno identifikacijo
lastnika ali uporabnika PROGRAMSKE OPREME brez vase
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vednosti ali soglasja. Vsaka uporaba informacij bo v skladu
s pravilniki o varstvu zasebnosti druzbe SONY ali tretjih
oseb.

Za informacije o sedanjem pravilniku o varstvu zasebnosti
druzbe SONY uporabite kontaktni naslov vsakega obmogja
ali drzave. Za pravilnike o varstvu zasebnosti v zvezi z
osebnimi in drugimi podatki, ki jih posredujete, ko
uporabljate ali dostopate do programske opreme ali storitev
tretjih strank, se obrnite na te tretje stranke.

Podatki bodo morda obdelani, hranjeni ali preneseni v
druzbo SONY, njene podruznice ali agente, ki se nahajajo v
drZavah zunaj drZave vasega stalnega prebivalisca.
Varovanje podatkov in zakoni o zasebnosti podatkov v
nekaterih drZavah morda ne nudijo enake ravni zascite kot
drzava vasega stalnega prebivalis¢a in morda boste imeli v
teh drZavah manj zakonskih pravic v zvezi z obdelavo,
hranjenem in posiljanjem podatkov. Druzba SONY se bo v
okviru razumnih prizadevanj trudila sprejeti ustrezne
tehnine in organizacijske ukrepe, da prepreci nepooblascen
dostop do informacij ali njihovo razkritje, vendar ne jamdi,
da bo odpravila vsa tveganja zlorabe tak$nih informacij.

FUNKCIJA SAMODEJNE POSODOBITVE

Druzba SONY ali DRUGI DOBAVITELJI obcasno samodejno
posodobijo ali kako drugace spremenijo PROGRAMSKO
OPREMO, vklju¢no za, vendar ne omejeno na namene
izboljSanja varnostnih funkcij, odpravljanje napak in
izboljSanje funkij v Casu, ko ste povezani s strezniki druzbe
SONY ali strezniki tretjih strank ali drugace. Te posodobitve
ali spremembe lahko izbriSejo ali spremenijo naravo funkcij
ali drugih vidikov PROGRAMSKE OPREME, vkljucno s
funkcijami, ki jih potrebujete, vendar ne omejeno nanje.
Potrjujete in se strinjate, da se lahko tak$ne dejavnosti
zgodijo po lastni presoji druzbe SONY in da druzba lahko
pogojuje nadaljnjo uporabo PROGRAMSKE OPREME s
popolno namestitvijo ali sprejetjem teh posodobitev ali
sprememb. Za namene te pogodbe EULA se Steje, da so
kakr3ne koli posodobitve/spremembe sestavni del
PROGRAMSKE OPREME. S sprejetjem te pogodbe EULA
soglasate s takimi posodobitvami/spremembami.

CELOTNA POGODBA, ODPOVEDNA KLAVZULA,
LOCITVENA KLAVZULA

Ta pogodba EULA in pravilnik o zasebnosti druzbe SONY,
kakor je oboje obcasno spremenjeno, skupaj predstavljata
celotno pogodbo med vami in druzbo SONY v zvezi s
PROGRAMSKO OPREMO. Neuspeh druzbe SONY pri izvedbi
ali uveljavitvi kakr$ne koli pravice ali dolocila te pogodbe
EULA ne pomeni opustitve takéne pravice ali dolo¢ila. Ce je
katerikoli del te pogodbe EULA neveljaven, nezakonit ali
neizvrsljiv, se ta dolocba izvrsi do najvecje mogoce mere, da
se ohrani namen te pogodbe EULA, drugi deli pa ostanejo v
polni veljavi.

ZAKONODAJA IN PRISTOJNOST

Konvencija ZdruZenih narodov o pogodbah o mednarodni
prodaji blaga ne velja za to pogodbo EULA. To pogodbo
EULA ureja in uveljavlja japonska zakonodaja, razen
kolizijskih dolocb. Za kakrsne koli spore, ki bi nastali na
podlagi te pogodbe EULA, je pristojno okrozno sodisce v
Tokiu na Japonskem. Stranki soglasata s krajem in
pristojnostjo teh sodisc.

PRAVICNA PRAVNA SREDSTVA

Ne glede na vsebino te pogodbe EULA soglasate in se
strinjate, da bo vsaka krsitev ali nespostovanje te pogodbe
EULA z vase strani povzrocilo nepopravljivo skodo druzbi
SONY, za katero denarna odskodnina ne bo zados¢ala, in
soglasate, da druzba SONY pridobi kakrsen koli ukrep
pravnega varstva s prepovedjo in pravi¢nim nadomestilom,
za katerega meni, da je nujen ali primeren glede na
okolis¢ine. Druzba SONY lahko sprejme tudi kakrsne koli
pravne in tehnicne ukrepe za preprecevanje krsitev te
pogodbe EULA ali njeno uveljavljanje, vkljucno z, vendar ne
omejeno na takojsnje prenehanje uporabe PROGRAMSKE
OPREME z vasSe strani, e druzba SONY po lastni presoji
meni, da krsite ali nameravate krsiti to pogodbo EULA. Ti
ukrepi so dodatni k drugim pravnim sredstvom, s katerimi
druzba SONY razpolaga v skladu z zakonom, kapitalom ali
na podlagi pogodbe.

ODPOVED

V primeru krsitve katerih koli dolocil te pogodbe EULA lahko
druzba SONY brez poseganja v katere koli druge pravice to
pogodbo prekine. V primeru take odpovedi morate: (i)
prenehati uporabljati PROGRAMSKO OPREMO in uniciti vse
njene kopije; (i) uposStevati zahteve v razdelku z naslovom
»0dgovornosti, povezane z vasim ratunome.

SPREMEMBE

DRUZBA SONY SI PRIDRZUJE PRAVICO, DA SPREMENI
KATERI KOLI POGOJ TE POGODBE EULA PO LASTNI PRESOJI,
TAKO DA OBJAVI OBVESTILO NA DOLOCENEM SPLETNEM
MESTU, Z E-POSTNIM OBVESTILOM, POSLANIM NA VAS
NASLOV, Z OBVESTILOM KOT DELOM POSTOPKA
NADGRADNJE/POSODOBITVE ALI NA KATERI KOLI DRUG
PRAVNO DOPUSTEN NACIN OBVESCANJA. Ce se ne strinjate
s spremembo, se ¢im prej obrnite na druzbo SONY za
navodila. Nadaljnja uporaba PROGRAMSKE OPREME po
datumu uveljavitve takSnega obvestila pomeni, da se
strinjate s spremembo.

UPRAVICENE TRETJE STRANKE

Vsak DRUG DOBAVITELJ je izrecna upravicena tretja stranka
vsake dolocbe te pogodbe EULA v zvezi z njegovo
PROGRAMSKO OPREMO in ima pravico uveljavljati
pogodbene dolocbe.

(e imate kakréno koli vpraganje v zvezi s to pogodbo EULA,
se lahko pisno obrnete na druzbo SONY na veljaven

kontaktni naslov vsake regije ali drzave.

Copyright © 2012 Sony Corporation.

Licence za odprtokodno
programsko opremo

Ta izdelek uporablja odprtokodno programsko
opremo na temelju licen¢nih pogodb med
druzbo Sony in imetniki avtorskih pravic za
programsko opremo.

Za izpolnitev zahtev imetnikov avtorskih
pravic na programski opremi, je druzba Sony
zavezana, da vas obvesti o vsebini teh licenc.
Licence (v angles¢ini) so shranjene v
notranjem pomnilniku izdelka.

Vzpostavite povezavo za koli¢insko
shranjevanje med izdelkom in rac¢unalnikom za
branje licenc v mapi »PMHOME« — » LICENSE«.

Ce uporabljate racunalnik Mac, mapa
»PMHOME« - »LICENSE« morda ne bo
dostopna.

Za ogled datotek uporabite racunalnik, ki ni
Mac, ali obiscite ta naslov URL.
https://0ss.sony.net/License/ILME-FX6/


https://oss.sony.net/License/ILME-FX6/
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Specifikacije

Splosno

Teza

Priblizno 890 g (11b 15 oz) (samo glavno
ohisje)

Priblizno 2,59 kg (5 Ib 11 0z) (vklju¢no z
objektivom SEL24105G, sencilom
objektiva, baterijo (BP-U35),
iskalom, rocajem, drzalom)

Mere

Glejte razdelek 133.
Napajanje

19,5V DC (18,0 V do 20,5V)
Poraba energije

Pribl. 18,0 W (ohisje, objektiv, snemanje
XAVC-1 QFHD 59,94P, iskalo
vklopljeno, brez priklopljenih
zunanjih naprav)

Pribl. 36,0 W (ohisje, objektiv, snemanje
XAVC-1 QFHD 59,94P (S&Q
120 slicic na sekundo), iskalo
vklopljeno, HDMI, SDI, s
priklju¢eno zunanjo napravo)

Delovna temperatura
od 0 do 40 °C
Temperatura shranjevanja
od -20 do +60 °C
Neprekinjen cas delovanja

Priblizno 105 minut (z uporabo BP-U35)
(ohisje, objektiv, snemanje XAVC-I
QFHD 59,94P, iskalo vklopljeno,
brez priklopljenih zunanjih
naprav)

Format snemanja (video)
XAVC Intra

Nacin XAVC-1 4K/QFHD:
CBG, 600 Mb/s (najvecja) bitna
hitrost, MPEG-4 AVC/H.264

Nacin XAVC-I HD:
CBG, 223 Mb/s (najvecja) bitna
hitrost, MPEG-4 AVC/H.264

XAVC Long
Nacin XAVC-L QFHD:
VBR, 150 Mb/s (najvecja) bitna
hitrost, MPEG-4 H.264/AVC
Nacin XAVC-L HD 50:
VBR, 50 Mb/s (najvecja) bitna
hitrost, MPEG-4 H.264/AVC
Nacin XAVC-L HD 35:
VBR, 35 Mb/s (najvecja) bitna
hitrost, MPEG-4 H.264/AVC
Format snemanja (zvok)
LPCM, 24-bitni, 48 kHz, 4-kanalni
Hitrost slicic pri snemanju
XAVC Intra
Nacin XAVC-1 4K:
4096x2160/59,94P, 50P, 29,97P,
25P, 24P, 23,98P
Nacin XAVC-1 QFHD:
3840x2160/59,94P, 50P, 29,97P,
25P, 23,98P
Nacin XAVC-1 HD:
1920x1080/59,94P, 50P, 29,97P,
25P, 23,98P
XAVC Long
Nacin XAVC-L QFHD:
3840x2160/59,94P, 50P, 29,97P,
25P, 23,98P
Nacin XAVC-L HD 50:
1920x1080/59,94P, 50P, 29,97P,
25P, 23,98P
Nacin XAVC-L HD 35:
1920x1080/59,94P, 50P, 29,97P,
25P, 23,98P
Cas snemanja/predvajanja
XAVC Intra
Nacin XAVC-1 QFHD:
59,94P
Priblizno 30 minut
(z uporabo CEA-G160T)

Nacin XAVC-I HD:
59,94P
Priblizno 78 minut
(z uporabo CEA-G160T)
XAVC Long
Nacin XAVC-L QFHD:
59,94P
Priblizno 115 minut
(z uporabo CEA-G160T)
Nacin XAVC-L HD 50:
59,94P
Priblizno 155 minut
(z uporabo CEA-G80T)
Nacin XAVC-L HD 35:
59,94P
Priblizno 210 minut
(z uporabo CEA-GS80T)
[ppomba]
Cas snemanja/predvajanja se lahko razlikL{je glede na
razmere uporabe in lastnosti pomnilnika. Casi snemanja
in predvajanja so navedeni za neprekinjeno snemanje

enega posnetka. Dejanski Casi so lahko krajsi, odvisno
od Stevila posnetih posnetkov.

Podrocje kamere

Slikovna naprava (tip)
35 mm slikovni senzor CMOS polnega
formata z enim ¢ipom
Stevilo slikovnih pik
12,9 M (skupaj)
10,2 M (efektivno)
Samodejno ostrenje
Metoda zaznavanja: Fazno zaznavanje/
zaznavanje kontrasta

Notranji filtri ND

CLEAR: OFF

1: 1/4ND

2:1/16ND

3:1/64ND

Linearno spremenljivi ND: 1/4ND do 1/128ND
Obcutljivost ISO

ISO 800712800 (nacin Cine El, svetlobni

vir D55)
Nastavek za objektiv
Serija E
Razpon

15+ stopen;j
Shutter speed (Hitrost zaklopa)
Od 64F do 1/8000 s (23,98P)
Kot zaklopa
0d 5,6° do 360°, od 2 do 64 slicic
Pocasni in hitri posnetki
XAVC QFHD: Od 1 do 120 sli¢ic na sekundo
XAVC HD: Od 1 do 240 slic¢ic na sekundo
XAVC 4K: Od 1 do 60 sli¢ic na sekundo
XAVC HD (S35): Od 1 do 120 sli¢ic na sekundo
White balance (Nastavitev beline)
2000 K do 15000 K
Ojacitev
Od -3 dB do +30 dB (v korakih po 1 dB)
Osnovni videz
S-Cinetone, Standard, Still, ITU709, s709,
709 (800 %), S-Log3, HLG Live,
HLG Natural
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Podrocje zvoka

Podprta frekvenca vzorcenja
48 kHz
Kvantizacija
24-bitna
Frekvencni odziv
Nacin MIC vhoda XLR: 20 Hz do 20 kHz
(+3 dB ali manj)
Nacin LINE vhoda XLR: 20 Hz do 20 kHz
(+3 dB ali manj)
Dynamic range (Dinamicni razpon)
Nacin MIC vhoda XLR: 80 dB (tipi¢no)
Nacin LINE vhoda XLR: 90 dB (tipi¢no)
Popacenje
Nacin MIC vhoda XLR: 0,08 % ali niZje (raven
vhoda -40 dBu)
Nacin LINE vhoda XLR: 0,08 % ali niZje (raven
vhoda +14 dBu)
Vgrajeni zvocnik
Mono
Notranji mikrofon
Mono
Notranji mikrofon v drzalu
Vsesmerni stereo elektretni kondenzatorski
mikrofon
[Opombal]

Ko pritrdite drzalo, se vklopi samo interni mikrofon v
drzalu.

Podrocje vhodov/izhodov

Vhodni prikljucki

INPUT 1/2:
Tip XLR, 3-pinski, Zenski
LINE/MIC/MIC+48V preklopno
MIC: Referenca -30 dBu do -80 dBu

TCIN:
Tip BNC

Izhodni prikljucki
SDI OUT:
Tip BNC, 12G-SDI, 6G-SDI, 3G-SDI (Level A/B),
HD-SDI
Slusalke (stereo mini vtic¢):
-16 dBu (referencna raven izhoda, najvecja
glasnost monitorja, 16 Q breme)
HDMI:
Tip A, 19-pinski
TC OUT:
Tip BNC

Drugo
DCIN:
Skladno s standardom EIAJ,18 V do 20,5V DC
Vecnamenski nastavek:
Namenski (21-pinski)
REMOTE:
2,5 mm 3-polni, tip sub-mini
Priklju¢ek drZala z daljinskim upravljalnikom:
4-polni stereo mini vti¢ 3,5 mm (prilozen
prikljucek za drZalo z daljinskim
upravljalnikom)
USB-C:
USB3.2Gen1
USB/multi:
Skladen s standardom USB 2.0, tip micro B za
koli¢insko shranjevanje (1)
VF:
Namenski (40-pinski)

Podrocje zaslona

Polnilnik baterij (BC-CU1)

Iskalo (LCD)
Velikost zaslona
8,8 cm (3,5 palca) po diagonali
Razmerje stranic
16:9
Stevilo slikovnih pik
1280 (V) x 720 (N)

Podrocje rez za kartice

Reza za kartico A/SD tipa CFexpress (2)

Brezzicni LAN

Podprti standardi
IEEE 802.11 a/b/g/n/ac (ILME-FX6V/VK)
IEEE 802.11 b/g/n (ILME-FX6T/TK)
Frekvencni pas
2,4 GHz
5 GHz (samo ILME-FX6V/VK)
Podprti varnostni protokoli
WEP/WPA-PSK/WPA2-PSK
Nacin povezave
Wi-Fi Protected Setup™ (WPS)/ro¢no
Nacin dostopa
infrastrukturni nacin

Teza
Pribl. 60 g (2,1 0z)
Mere
Pribl. 57 x 26 x 101 mm
(2174 %116 x 4 palcev)
(8irina/visina/globina)
Vhod
19,5V DC, 26 W
Izhod
16,4VDC14A
Delovna temperatura
od 0 do 40 °C
Temperatura shranjevanja
od -20 do +60 °C

PriloZzena dodatna oprema

OmreZni napajalnik (1)

Napajalni kabel (1)

Polnilnik baterij (1)

Paket baterij (1)

Drzalo (1)

LCD-zaslon (1)

Kabel USB-C (1)

Daljinski upravljalnik za drzalo (1)
Sencilo za LCD (1)

Nastavek za opremo brez napajanja (1)
(nastavek brez napajanja (1), vzmet nastavka (1),
vijaki (4))

Pokrovcek nastavka za objektiv (1)
Zascitni pokrovcek prikljucka drzala (1)
Pred uporabo tega izdelka (1)
Garancijska knjizica (1)

Oblika in tehni¢ni podatki se lahko spremenijo
brez obvestila.
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Opombi

Vedno naredite testni posnetek in se
prepricajte, da je bil uspesno posnet.
DRUZBA SONY NI ODGOVORNA ZA
NIKAKRSNO SKODO, MED DRUGIM ZA
NADOMESTILO ALI POVRACILO 1ZGUBE
SEDANJEGA ALI PRICAKOVANEGA
DOBICKA ZARADI NAPAKE TE ENOTE ALI
SNEMALNEGA MEDIJA ALI KATEREGAKOLI
MEDIA ALI POMNILNISKEGA SISTEMA
KATEREKOLI VRSTE ZA SNEMANJE KAKRSNE
KOLI VSEBINE.

Pred uporabo enote vedno preverite,

ali deluje pravilno. DRUZBA SONY NI
ODGOVORNA ZA NIKAKRSNO SKODO, MED
DRUGIM ZA NADOMESTILO ALI POVRACILO
IZGUBE SEDANJEGA ALI PRICAKOVANEGA
DOBICKA ZARADI NAPAKE TE ENOTE, TAKO
V GARANCIJISKEM ROKU KOT PO POTEKU
GARANCIJE ALI ZARADI KAKRSNEGA KOLI
DRUGEGA RAZLOGA.

DRUZBA SONY NI ODGOVORNA ZA
KAKRSNEKOLI ZAHTEVKE UPORABNIKOV TE
ENOTE ALI TRETJIH OSEB.

DRUZBA SONY NI ODGOVORNA ZA
IZGUBO, POPRAVILO ALI REPRODUKCIJO
PODATKOV, POSNETIH NA NOTRANIJI
POMNILNISKI SISTEM, SNEMALNE MEDIJE
ALl KATEREKOLI DRUGE MEDIJE ALI
POMNILNISKE SISTEME.

DRUZBA SONY NI ODGOVORNA ZA
PREKINITEV ALI KONCANJE KATERIHKOLI
STORITEV, VEZANIH NA TO ENOTO, Kl BI
BILE POSLEDICA KAKRSNIHKOLI OKOLISCIN.

Zunanje dimenzije

143 (5%/,)

UNC '/,-20

2-UNCY/,-20

60

25 (1)
258(107/,)

2-UNC/,-20

O @O

HI2B |0

9l
e
8 ' _ o

UNC'/,-20 MNC /.16

e
28(1/,)

Dimenzije so priblizne vrednosti.

Enota: mm (palci)

8-UNC'/,-20

(23/,)| 4 (47,)

UNC/,-20

CD
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Blagovne znamke

e (X je blagovna znamka druzbe Sony

Corporation.

XAVC in sta za$¢iteni blagovni znamki

podjetja Sony Corporation.

e |zraza HDMI in vecpredstavnostni vmesnik
visoke locljivosti HDMI ter logotip HDMI
so blagovne znamke ali zas¢itene
blagovne znamke druzbe HDMI Licensing
Administrator, Inc. v ZDA in drugih drzavah.

e Microsoft in Windows sta blagovni znamki
ali zasciteni blagovni znamki druzbe
Microsoft Corporation v ZDA in/ali drugih
drzavah.

e Mac in MacOS sta zasciteni blagovni znamki

druzbe Apple Inc. v ZDA in drugih drZzavah.

»Catalyst Browse«, »Content Browser

Mobile«in logotip »Content Browser Mobile«

so blagovne znamke ali zas¢itene blagovne

znamke druzbe Sony Corporation.

e jOS je zascitena blagovna znamka oziroma

blagovna znamka podjetja Cisco Systems,

Inc. in/ali njegovih podruznic v ZDA in

dolocenih drugih drzavah.

Android in Google Play sta blagovni znamki

druzbe Google Inc.

e Wi-Fi, logotip Wi-Fi in Wi-Fi PROTECTED
SETUP so blagovne znamke ali zascitene
blagovne znamke zdruzenja Wi-Fi Alliance.

e Oznaka N je blagovna znamka ali
registrirana blagovna znamka druzbe NFC
Forum, Inc. v ZDA in v drugih drZavah.

e | ogotip SDXC je blagovna znamka podjetja
SD-3C, LLC.

e | ogotipa CFexpress in CFexpress Type A
sta blagovni znamki zveze CompactFlash
Association.

Vsa druga imena podjetij in izdelkov so

zascitene blagovne znamke ali blagovne ‘gggl;lgnlgjﬂrrm XAVC \

znamke njihovih lastnikov. Elementi, ki so CF
blagovna znamka, v tem dokumentu niso express

oznateni s simbolom ™ ali . HuoImil ==2r A
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